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Before Reading This Manual 
Thank you for purchasing the IMAGECHECKER PV200. 

This manual describes information on the hardware such as how to install and wire and the software such as how 
to set the functions. Read this User’s Manual carefully before use. 

Safety Precautions 
To ensure that you use this product correctly, read this User’s Manual thoroughly before use. Make sure that you 
fully understand the product and information on safe. 

 

 WARNING 
Critical situations that could lead to user’s death or serious injury are assumed by mishandling of the product: 

 Do not use this product in areas with inflammable gas. It could lead to an explosion. 

 Exposing this product to excessive heat or open flames could lead to damage to the lithium battery or 
other electronic parts. 

 Do not store a lens in the locations subject to direct sunlight. It could lead to smoke generation. 

 Do not look at the sun through a lens. It could lead to blindness. 

 Always take precautions to ensure the overall safety of your system, so that the whole system 
remains safe in the event of failure of this product or other external factor. 

 CAUTION 
Critical situations that could lead to user’s injury or only property damage are assumed by mishandling of the 
product: 

 Do not dismantle or remodel the product. It could lead to excessive exothermic heat or smoke 
generation. 

 Do not touch the terminal while turning on electricity. It could lead to an electric shock. 

 Do not allow foreign matters such as liquid, flammable materials, metals to go into the inside of the 
product. It could lead to excessive exothermic heat or smoke generation. 

 Do not bend the cables forcibly, place a heavy object on them or bring them close to a thermal 
appliance. It could lead to an electric shock or smoke generation. 

 To prevent excessive exothermic heat or smoke generation, use this product at the values less than 
the maximum of the characteristics and performance that are assured in these specifications. 

 Use the external devices to function the emergency stop and interlock circuit. 

 Connect the wires or connectors securely. The loose connection could lead to excessive exothermic 
heat or smoke generation. 

 Do not undertake construction (such as connection and disconnection) while the power supply is on. It 
could lead to an electric shock. 
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Precautions before Use 

Installation Environment 
Avoid installing and operating the PV200 in the following locations: 
 Location with direct sunlight or environmental temperatures that exceed a range of the “operating 

ambient temperature” for each product. 

 Locations with a relative humidity exceeding a range of the “operating ambient humidity” for each 
product or with a condensing due to a sharp temperature change. 

 Locations with an atmosphere containing corrosive gases or flammable gases. 

 Locations subject the main unit to direct vibration or impact. 

 Locations with a lot of fine particles, iron filings or salt. 

 Locations where the product can become wet with water, oil or chemicals. 

 Locations with an atmosphere likely to contain organic solvents (such as benzene, paint thinner, and 
alcohol) or strongly alkaline materials (such as ammonia and caustic soda). 

 Locations where a load applies onto the unit. 

 Locations near the devices that generate large switching surges, high-voltage wires and devices, 
power-driven lines and devices, and transmitting devices, such as radios. 

Static Electricity 
 In dry environment, high voltages of static electricity might be generated. When you touch the product, 

you should always discharge the accumulated static electricity through your body by touching a 
grounded metal surface. 

Cleaning 
 Never use thinners or similar solvents, as they may dissolve the board and lead to colors to run. 

Power Supply Unit and Power Sequence 
 Use an insulated power supply with a built-in protection circuit. Applying an abnormal voltage might 

damage the internal circuit. If you use a power supply unit without a protection circuit, supply power 
through a protective device such as a fuse. 

 Consider the power supply sequence so that the power supply unit for the PV200 can be turned off 
before the one for the input/output is turned off. 
If you turn the input/output power off before turning off PV200, the device will detect a change in the 
input signal level and may malfunction. 

Before Turning on the PV200 
 Pay attentions to the followings when turning on the PV200 for the first time: 

- Confirm no wiring waste or especially any conductive substance is on the printed circuit board. 
- Confirm that the power wiring, input/output wiring and power supply voltage are correct. 
- Confirm that the fixing and terminal screws are securely tightened. 

General Cautions 
 Use the keypad, camera, camera cables, monitor and a monitor cable of the product numbers specified 

by Panasonic Industrial Devices SUNX Co., Ltd. A breakdown, damage or destruction by using any 
other than the specified will not be covered by our guarantee. 

 Do not change or set items that should not be as described in the manuals or the specifications. 
Breakdown, damage or destruction resulting from changing or setting them will not be covered by our 
guarantee. 

 Do not perform a test of insulation resistance or withstand voltage between the power source or 
input/output signals and the metallic part of connectors or camera cases. 

 To avoid loss of data by accident, also save the setting data stored in PV200 into a PC or an external 
storage media. 
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Details of PV200/PV200 MC version upgrade 

Version Upgrade of Ver.2.0 (Jul, 2016 Update) 
1. Added "Circle/Feature Rot." to "Rotation Adjustment". 

2. Added FTP Client function. 

3. Added the switching function between SETUP menu and RUN menu. 

4. Added the display switch function between raw images and preprocess images. 

5. Added "Camera Type" to "Type Setting" in "TYPE". 

Added the function to change displayed font colors to Data R/W. 

 

Version Upgrade of Ver.1.9 (Feb, 2016 Update)  

1. Added the arbitrary point and arbitrary line for quote of Geometry Calculation. 

2. Added the additional information of JRC/JDC(Result) to output images in Image Output. 

 

Version Upgrade of Ver.1.8 (Apr, 2015 Update)  

1. Added Account function (operation restriction for each account). 

2. Changed the camera capture adjustment parameter (the change of the maximum camera gain and the 
addition of the RGB offset setting). 
－Added “Hardgain”,and changing old name of “Cameragain” to “Softwaregain” 

 

Version Upgrade of Ver.1.7 (Aug, 2014 Update) 
1. Added "Auto Area Setting" and "Auto Mask Area Setting". 

2. Added the FTP Server function. 

3. Added "Flaw Detection (2 checkers)" to "Pos/Rot Adjustment". 

4. Added "Flaw Detection (Ellipse)" to "Rotation Adjustment ". 

5. Added "A Series Compatible" mode. 

6. Changed to 999 folders on "Image Memory in SD". 

7. Supported "Print Screen View" of Select Folder. 

8. Supported copying of the following data between the Type data.Position Adj., Area Size Adj., Checker, 
Geometry Calc., Num. Calcu., Judgment, Draw Char/Fig. 

9. Supported outputting "Date/Time" for all output of "General Output". 

 

Version Upgrade of Ver.1.6 
1. PV200 debug function 

2. Trapezoid adjustment function 

3. Communication data monitor and save function 

4. Smart Edge (Circle) - Position Rotation Adjustment 

5. Flaw Detection - Addition of Counterclockwise inspection 

6. Add comment for setting data in SD card 

7. Read function for setting data in SD card at startup 

8. Read function for images in folders in SD card 

9. Print screen image display function 

10. Add Camera - Capture offset 

11. Supports the output of color camera Ethernet RGB images (bmp format). 

12. Supports to simultaneous using [Trapezoid adjustment] and [Partial Imaging]. 

13. Supports [Display Global Coordinate] of [Calibration] when using [Trapezoid adjustment]. 
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 Version Upgrade of Ver.1.50 

1. Supported to use a compact color camera. 

2. Supported Ethernet communication of Yokogawa Electric Corporation PLC: FA-M3/e-RT3. 

3. Added the intersection point checker "Circle - Line" in Geometry Calculation. 

4. Added the function to read inspection images in a SD card. 

5. Added the function to output images by each camera in accordance with judgment setting. 

6. Improved the display fonts of Korean and Traditional Chinese. 

 

 

Version Upgrade of Ver.1.4 

1. Added the multiple result detection function in Contour Matching checker. 

2. Added the compression function of output images in Image Output. 

3. Improved the operability of color extraction setting. 

4. Added the function to set the Ready signal OFF time when switching types. 

5. Added the function to calculate the total area value of results of Feature Extraction or Connector (Binary 
Window) checker in Numerical Calculation. 

6. Added the extended display function to the drawing patterns of Feature Extraction. 

 

Version Upgrade of Ver.1.3  

1. Supported Gray: 0.3M Compact Camera. 

2. Added menu customizing function "Select Menu" in sub menu "Type". 
3. Added new checker type "Contour Matching" which creates a template from the outline of the object, and 
detects the object with that template. 
4. Renewed the "Calibration" function. 
5. Added layout presets. 
6. Added a time notation of capturing or saving when displaying images saved in PV200's memory or SD card. 

7. Added the function to delete folder and file saved in SD card. 

8. Added the function to load Type data extracted from setting data saved in SD card. 

9. Added checker No. notation in title bar when setting checkers. 

10. Added the function to check the status of PLC communication. 

 
Version Upgrade of Ver.1.2 

1. Supported PLC communication commands. 

2. Adding the setting item listed below to correct the occasional errors that Error signal is outputted improperly 
when an error signal is set ON by inspection error and set OFF by a command from external device and vice 
versa. 
  - ERR ON Min. (ms) 
  - ERR Sign 

 

Version Upgrade of Ver.1.1 
1. Supported to use two color cameras including 2-Mega color camera at the same time. 
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List of Menu Options 

Language selecting window (Displayed only at the first startup after delivery) 
Language selecting 
window 
▶ p.40 

┳ 
┃ 

┃ 

Language ━ Japanese / English / Simplified Chinese / Korean / Traditional 
Chinese 

 ┗ Do not show this window at the next start-up. 

SETUP MENU 
OPERATION ┳ To RUN Menu      

        
ENVIRONMENT ┳ System Settings ┳ Startup Setting ┳ Layout No. ▶ p.429 
 ┃  ┃  ┣ Type No. ▶ p.430 
 ┃  ┃  ┣  Setting Data Info. View ▶ p.430 
 ┃ 

┃ 
 ┃ 

┃ 
 ┗ Setting Data Info. View ▶ 430 

 ┃  ┣ Operation ┳ Inspection Process  
 ┃  ┃  ┣ Parallel I/O Output Reset Condition ▶ p.431 
 ┃  ┃  ┣ Continuous Inspection ▶ p.432 
 ┃  ┃  ┣ Contour Matching Exe. Mode ▶ p.432 
 ┃  ┃  ┣ Type Switch Guarantee Time (ms) ▶ p.432 
 ┃  ┃  ┣ Template Registration ▶ p.188 
 ┃  ┃  ┣ Template Setting ▶ p.191 
 ┃  ┃  ┣ Matching Performance ▶ p.187 
 ┃  ┃  ┣ Menu Display Priority ▶ p.523 
 ┃  ┃  ┗ Date/Time of General Output ▶ p.592  
 ┃  ┗ System Register ━ SYS: Register 0-7 Default ▶ p.432 
 ┃       
 ┣ 

┃ 
Input/Output ┳ 

┃ 
PLC 
Communication 

┳ 
┃ 

Communication Type ▶ p.586 

 ┃  ┃  ┣ PLC Type ━ PV Station No./IP 
Address/Port 
No./Specify 
Station No./ 
Station No./ 
CPU No. 

▶ p.635 
 ┃ 

┃ 
┃

┃ 

 ┃ 
┃ 
┃ 
┃ 

┃ 
┃ 
┃ 
┃ 

▶ p.628   

 ┃  ┃  ┣ Timeout (ms) ▶ p.632 
 ┃  ┃  ┣ No. of Error Retries ▶ p.632 
 ┃  ┃  ┣ Result Output ━ Data Output Register/Bit 

Width (bit)/Data Output 
Completion 
Notice/Register/Bit 

 ┃ 
┃ 
┃ 

 ┃ 
┃ 
┃ 

 ┃ 
┃ 
┃ 

▶ p.633  

 ┃  ┃  ┣ Command Read Type ▶ p.634 
 ┃ 

┃ 
 ┃ 

┃ 
 ┗ Communication 

Command 
━ Control 

Register/Command Input 
Register/Command 
Output Register/Polling 
Time (ms)/Start Bit Off 
Timeout/Watch Dog 
Timer/WD Time (ms) 
 

 ┃ 
┃ 
┃ 
┃ 
┃ 

 ┃ 
┃ 
┃ 
┃ 
┃ 

  ▶ p.634  

 ┃  ┣ Parallel I/O ┳ REND OFF Min. (ms) ▶ p.436  
 ┃  ┃  ┣ ERR Signal Off Timing ▶ p.436  
 ┃  ┃  ┣ ERR ON Min. (ms) ▶ p.436  
 ┃  ┃  ┣ Set Signal ASSIGN0 to 1 ▶ p.436 ▶ p.551 
 ┃  ┃  ┗ Set EXTRA0 to 2 ▶ p.436 ▶ p.551 
 ┃

┃

┃ 
┃ 

 ┣

┃

┃ 
┃ 

Parallel I/O 
Output 

┳

┃

┃ 
┃ 

Output Data/ Handshake/ Scan Count/ 
Judgement/ Numerical Calculation/ Bit Width/ 
Output Signal Guarantee Time (ms)/ Timeout 
(ms) 

▶ p. 357 

 ┃  ┣ Serial ┗ Baud Rate (bps)/ Bit Length/ Stop Bit/ Parity 
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┃

┃ 
┃

┃ 
▶ p.586 Check/ Flow Control / A Series Compatible / 

Capture End / Inspection End 
 ┃

┃ 

┃ 
┃ 
┃ 

 ┣

┃ 

┃ 
┃ 
┃ 

General Output ┳

┃ 

┃ 
┃ 
┃ 

Serial ━ Output/ Operation/ Protocol/ 
Scan Count/ Total Judgement/ 
Judgement/ Numerical 
Calculation/ BCC/ No. of 
Digits/ Decimal Digit/ Unused 
Digit 

▶ p.364 

 ┃

┃ 
┃ 
┃ 

 ┃

┃ 
┃ 
┃ 

 ┣

┃ 
┃ 
┃ 

Ethernet 
(PLC Com.) 

━ Output/ Operation/ Scan 
Count/ Total Judgement/ 
Judgement/ Numerical 
Calculation 

 ┃

┃ 

┃ 
┃ 
┃ 

 ┃

┃ 

┃ 
┃ 
┃ 

 ┣

┃ 

┃ 
┃ 
┃ 

Ethernet 
(General 
Com.) 

━ Output/ Operation/ Date/Time/ 
Scan Count/ Total Judgement/ 
Judgement/ Numerical 
Calculation/ BCC/ No. of 
Digits/ Decimal Digit/ Unused 
Digit/ Error Output 

 ┃

┃ 

┃ 
┃ 
┃ 

 ┃

┃ 

┃ 
┃ 
┃ 

 ┗ SD Card ━ Output/ Operation/ Date/Time/ 
Scan Count/ Total Judgement/ 
Judgement/ Numerical 
Calculation/ No. of Digits/ 
Decimal Digit/ Unused Digit/ 
Error Output 

 ┃

┃

┃

┃ 
┃ 

 ┣ 
┃

┃

┃ 
┃ 

Image Output ━ Destination/ Output Conditions/ Interval/ 
Camera No.0-1 Output/ Image File Setting / 
Compression / Color Image Format / Overwrite/ 
No. of Folders/ ERR Signal ON at Output Error/ 
Forced Outage at Output Error 

▶ p.367 

 ┃  ┣ Image Memory ━ Saving Condition/ Overwrite ▶ p.375 
 ┃  ┣ Print Screen ━ Destination ▶ p.68 
 ┃  ┣ SD Card Setting ━ Write When Cover is Open ▶ p.438 
 ┃  ┗ FTP Settings    
 ┃    ▶ p.439    
 ┃       
 ┣ Camera ┳ Camera ━ Type of Camera No.0–1 ▶ p.79 
 ┃  ┗ FLASH Polarity ━ FLASH Polarity 0-1 ▶ p.80 
 ┣ 

┃ 
┃ 

Transparence ━ Window 
Transparency 
(SETUP Menu) 

 ▶ p.447  

 ┣ Password ▶ p.448     
 ┗ Initialize ▶ p.449     

 
        
TYPE ┳ Select Type ▶ p.76     
 ┣ Type Setting ┳ Execution Condition ┳ Execution Mode ▶ p.113 
 ┃  ┃  ┣ Number of Blocks  
 ┃  ┃  ┗ Timeout Contour Matching (ms) ▶ p.203 
 ┃  ┣ Camera ┳ Common Setting ▶ p.80 
 ┃  ┃ ▶ p.79 ┣ Camera Trigger ▶ p.81 
 ┃  ┃  ┣ Error if Checker Area outside Image ▶ p.111 
 ┃  ┃  ┣ Camera No. to Set ▶ p.82 
 ┃  ┃  ┣ Connected Camera ▶ p.79 
 ┃  ┃  ┣ Shutter Speed ▶ p.83 
 ┃  ┃  ┣ Capture Delay (ms) ▶ p.89 
 ┃  ┃  ┣ FLASH Signal Delay (ms) ▶ p.91 
 ┃  ┃  ┣ FLASH Span (ms) ▶ p.91 
 ┃  ┃  ┣ Partial Imaging ▶ p.92 
 ┃  ┃  ┣ Trapezoid Adjustment ▶ p.94 
 ┃  ┃  ┣ Calibration ▶ p.99 
 ┃  ┃  ┣ White Balance ▶ p.84 
 ┃  ┃  ┗ Gain Setting ▶ p.83 
 ┃  ┗ Color Extraction ┳ Color Extraction Mode ▶ p.112 
 ┃    ┣ Extraction Display Mode ▶ p.57 
 ┃    ┗ Color for Single Color ▶ p.57 



 

x 

 ┣ Marker Display  ▶ p.406    
 ┣ Data R/W  ▶ p.386    
 ┣ Select Menu  ▶ p.502    
 ┗ Initialize  ▶ p.78    
      
 
 

     
      INSPECTION ┳ Position Adjustment ▶ p.268    
 ┣ Area Size Adjustment ▶ p.282    
 ┣ Checker ┳ Line  ▶ p.150  
 ┃  ┣ Binary Window  ▶ p.154  
 ┃  ┣ Gray Window  ▶ p.157  
 ┃  ┣ Binary Edge  ▶ p.160  
 ┃  ┣ Gray Edge  ▶ p.164  
 ┃  ┣ Feature Extraction ▶ p.169  
 ┃  ┣ Smart Matching  ▶ p.176  
 ┃  ┣ Contour Matching  ▶ p.193  
 ┃  ┣ Flaw Detection  ▶ p.188  
 ┃  ┣ Connector (Binary Window) ▶ p.214  
 ┃  ┣ Connector (Gray Window) ▶ p.214  
 ┃  ┣ Connector (Gray Edge) ▶ p.220 
 ┃  ┣ Smart Edge (Circle) ▶ p.231 
 ┃  ┣ Smart Edge (Line) ▶ p.250 
 ┃  ┗ Color Window ▶ p.265 
 ┣ Geometry Calculation  ▶ p. 286    
 ┣ Preprocess ┳ Grayscale Conversion ▶ p.125  
 ┃  ┣ Color Extraction  ▶ p.127  
 ┃  ┗ Grayscale Preprocess ▶ p.130  
 ┣ Slice Level  ▶ p.124    
 ┣ Numerical Calculation ▶ p.307   
 ┣ Judgement  ▶ p.324    
 ┣ Char./Fig. Drawing  ▶ p.339    
 ┣ Checker List  ▶ p.354    
 ┗ Group Move  ▶ p.149    

 
 

        
SAVE/READ ┳ Save Setting Data  ▶ p.381    
 ┣ Read Setting Data  ▶ p.383    
 ┣ Save Image Memory ▶ p.375   
 ┗ Clear Image Memory ▶ p.604   
         
TOOL ┳ PC Communication  ▶ p.709   
 ┣ General ┳ Startup Setting ▶ p.453  
 ┃  ┳ Network ▶ p.453  
 ┃  ┣ Calendar ▶ p.455  
 ┃  ┣ Language ▶ p.455  
 ┃  ┣ Account Setting ▶ p.456  
 ┃  ┗ Initialize ▶ p.456  
 ┣ SD Property  ▶ p.467   
 ┣ Eject SD Card  ▶ p.467   
 ┣ Information  ▶ p.473   
 ┣ Setting Help  ▶ p.468   
 ┗ Update ┳ Firmware ▶ p.474  
   ┗ Splash Screen ▶ p.475  

 
F1 ┳ Select Camera      
(Image Menu) ┣ 

┃ 

┃ 

Switch Display ━ Memory/Live/ Trapezoid Adjustment / NG Image / Binary/ 
Grayscale/Color/ Converted Gray Image/ Extracted Color 
Image/ Extract Display Mode/ Grayscale Preprocess/ Step 

 

 ┣ Pattern Display ━ Pattern Display / Scan Direction / Geometry Calculation / 



xi 

┃ ▶ p.420 Character/Figure Drawing / Calibration Scale / Coordinate Axis  
 ┣ Scroll  ▶ p.62    
 ┣ Magnification  ▶ p.61    
 ┣ Full Screen  ▶ p.62    
 ┣ Save Image  ▶ p.380    
 ┣ Read Image  ▶ p.376    
 ┣ Print Screen View  ▶ p.69    
 ┗ Window 

Transparency 
(SETUP Menu) 

 ▶ p.447    

F2 ━ Switch Select Menu / Normal Menu ▶ p.501  
     
F3 ━ Switch pattern display (Hide Patterns / Display 

Patterns) 
▶ p.146  

RUN MENU 
OPERATION ┳ Select Type ▶ p.412    
 ┣ Reset Statistics ▶ p.412    
 ┣ Start RUN Mode ▶ p.410    
 ┣ Stop RUN Mode     
 ┗ To SETUP Menu     
       
VIEW ┳ Data R/W ▶ p.390    
 ┗ Window Transparency (RUN menu) ▶ p.419  
 ┣ Command Communication Log ▶ p.691   
 ┗ Error Log ▶ p.561  
       
LAYOUT ━ Layout ▶ p.415    

       
DEBUG ┳ Debug Start ▶ p.483    
p.477 ┣ Reset ▶ p.498    
 ┣ Result ▶ p.499    

 ┣ Folder select ▶ p.486    

 ┣ Setting ▶ p.494    

 ┗ Debug Exit ▶ p.485    

       
TOOL ┳ Eject SD     
p.451 ┣ Save Setting Data     
 ┣ Save Image Memory     
 ┣ Clear Image Memory     
 ┗ Information     
     

Account ┣ Switch User ▶ p.48    

▶ p,47 ┣ Users Information ▶ p.49    
 ┗ Logout ▶ p.50    

       
F1 
(Select Window) 

┳ Screen 0-1 
▶ p.52 
▶ p.417 

┳ Select Camera  
┃ 
┃ 
┃ 
┃ 

┣ 
┃ 
┃ 
┃ 

Switch 
Display 

━ Memory/Live/ Trapezoid Adj./ NG Image / Binary/ 
Grayscale/Color/ Grayscale Conversion / Extracted 
Color / Extract Display Mode / Preprocess 

 ┃

┃

┃ 
┃ 

 ┣ 
┃ 
┃ 
┃ 

Pattern Display ━ Area / Scan Direction / Detect Position / Display 
Condition / Geometry Calculation / Character/Figure 
Drawing / Marker / Calibration Scale / Coordinate 
Axis 

 ┃  ┣ Scroll    
 ┃  ┣ Magnification    
 ┃  ┗ Full Screen    
 ┣ Data R/W 0-1 ▶ p.390     
 ┗ Print Screen View ▶ p.69    
       
F2 ━ Switch Layout ▶ p.424    



 

xii 
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1.1 PV200 

 

 
 

1 USB Port USB 2.0 supported. (Exclusive for PVWIN200 communication) 

2 Ethernet Port Connects an Ethernet cable. When connecting an Ethernet cable, either 
one of two LEDs lights. (The LED to light and the color varies depending 
on baud rate.) 

3 CAMERA 0 Connect Port Connects a camera 0. 
(PV200 MC can only be connected with ANPVC5030 or ANPVC6030 .) 

4 CAMERA 1 Connect Port Connects a camera 1. 
(PV200 MC can only be connected with ANPVC5030 or ANPVC6030 .) 

5 MONITOR Analog RGB output terminal. (Connects a monitor.) 

6 Power Input Terminal Supply a voltage of 24 V DC (capacity: 3 A or more). 
The power terminal is located on the input terminal block. 

7 I/O Terminal Block An external input terminal. 

8 COM Port Connects to an external device via RS-232C. 
The COM port terminal is located on the output terminal block. 

9 Keypad Connector Connects a keypad (ANPVP03 / ANPVP10). 

10 Cover Cover to protect a SD memory card and backup battery. 
Data can be saved in a SD memory card even when the cover is open by 
default. 

11 Operating LEDs Displays the status of the following signals and communication ports. 
POWER / READY / ERROR / COM / SD 

12 Battery connector Connects a backup battery. 

13 Battery holder Attaches the battery retaining the following information. 
See the next page and attach the battery before use. 
- Built-in calendar 
- Type No. and Layout No. when turning off the power 
- Status of keypad operation 

14 SD Memory Card Slot Complies with SD memory card (SDHC) with up to 32 GB of memory.  
During accessing to a SD memory card, the LED above the slot flashes. 

15 DIN rail attachment lever 
(one-touch hook) 

To attach to DIN rail with a single touch. 
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Conformity to the EMC Directive 
PV200 complies with the EMC standards in the following EMC Directive:  

 EMC Directive 

 EN 61000-6-4 

 EN 61000-6-2 

 

 
Note the following compatibility conditions; 
 No USB port must be used. 

 Ferrite cores (equivalent products to RFC-5 produced by Kitagawa Industries. Co., Ltd.) must be 
attached to the both ends of a monitor cable. 

Connecting Backup Battery 

1. Cut the power of PV200. 

2. Open the cover on the front side. 

A battery is initially installed in the holder. 

3. Connect the connector of the battery 
with the connector of PV200. 

 
Make sure not to connect  in the wrong 
orientation. 

4. Put the cover back in place. 

 

 
 Backup battery life is approximately 10 years at 25 °C of ambient temperature. If the battery is running 

out, a message saying “Change Battery!” appears in the information display area. Replace with a new 
one then. (Battery product No.: AFPX-BATT) 

 To replace the battery, before the procedure described above, turn on the power of PV200 a minute or 
more and replace it in two minutes after turning off the power. 

 Even if the battery has run out, type data and environment data are not discarded.  The data 
discarded when the battery has run out is as follows. 

- Built-in calendar 
- Type No. and Layout No. when turning off the power 
- Status of keypad operation 

Rebooting PV200 
You can reboot PV200 without turning off the power. 

 

1. Hold down the F1, F2, F3 and SHIFT keys at the same time for 5 seconds or more. 

PV200 is rebooted. 
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1.2 Camera 

1.2.1 Camera Type and Precautions for Use 

Camera Type 
Seven types of cameras listed below are provided. Choose to use them depending on your usage. 

However, PV200 MC can only be connected with 0.3-Mega Compact Gray Camera (ANPVC5030) or 
0.3-Mega Compact Color Camera (ANPVC6030). 

 
 4-Mega Gray 

Camera 
(ANPVC1470) 

2-Mega Gray 
Camera 
(ANPVC1210) 

2-Mega 
Color 
Camera 
(ANPVC2260) 

0.3-Mega 
Quad-speed 
Color 
Camera 
(ANPVC2040) 

0.3-Mega 
Quad-speed 
Gray 
Camera 
(ANPVC1040) 

0.3-Mega 
Compact 
Gray Camera 
(ANPVC5030) 

0.3-Mega 
Compact 
Color Camera 
(ANPVC6030) 

Number of 
Pixels 

4 million 
pixels 2 million pixels 300 thousand pixels 

Image 
transfer Time 

Approximately 
63 ms Approximately 34 ms* Approximately 9 ms Approximately 11 ms 

Dimension 
44x 44x 
54mm 29 x 29 x 58 mm 22 x 22 x 37mm 

Image sensor 
Size 2/3 inch 1 /1.8 inch 1/3 inch 1/3 inch 

Pixel Size 3.45x3.45 m 4.4 x 4.4 m 7.4 x 7.4 m 6.0x6.0 m 

Image sensor 
type 

CCD CMOS 

Applicable 
camera cable 

ANPVC8103 
ANPVC8103R 

ANPVC81**, ANPVC81**R  
(**=03, 05, 10) 

ANPVC82** 
(**=03, 05, 10) 

*1) When a 2-Mega color camera is connected together with another camera, the image transfer time of 
2-Mega color camera is approximately 40 ms. 

Precautions for Use 
 Use only the camera and the camera cable with the proper product numbers specified by Panasonic 

Industrial Devices SUNX Co., Ltd. 

 Do not bend the camera cables forcibly or apply load to the connector joints. 

 Do not touch the image sensor or the lens surface of the camera. Attach the lens cap or sticker to keep 
off dust when not in use. 

 When inserting/removing the cable into/from the connector, be sure to hold it by its plug to prevent 
excess force applying on the cable. 

 Do not touch the terminals inside the connector of cameras and camera cables and take care not to 
allow foreign objects to come into the connectors. 

 A lens whose projection from the C-mount face is larger than 4.5 mm cannot be attached to 
0.3-Mega compact gray camera (ANPVC5030) and 0.3-Mega compact color camera (ANPVC6030) 
structurally. 
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1.2.2 Names and Descriptions 

Product No.: 
0.3-Mega Quad-speed Gray Camera (ANPVC1040), 0.3-Mega Quad-speed Color Camera (ANPVC2040), 
2-Mega Gray Camera (ANPVC1210), 2-Mega Color Camera (ANPVC2260) 

 
 

1 Lens Attach a C-mount lens with adapter rings as necessary. 

2 Lens fixture C-mount 

3 Mounting Plate Insulation type plate. The plate can be attached to four sides of a camera. 

4 Cable connector Connects a camera cable.  
Connect the connector labeled the product number of the cable to a camera. 

 

 

 

Product No.: 
0.3-Mega Compact Gray Camera (ANPVC5030), 0.3-Mega Compact Color Camera (ANPVC6030) 

 
 

1 Lens Attach a C-mount lens with adapter rings as necessary. 

2 C-mount adapter C-mount 
It becomes NF-mount when removing the C-mount adapter, and the C-mount 
lens cannot be attached. 

3 Mounting Plate Insulation type plate. The plate can be attached to four sides of a camera. 
(The positions to screw the plate differ between the lateral, bottom and top 
sides.) 

4 Cable connector Connects a camera cable.  
Connect the connector labeled the product number of the cable to a camera. 
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Product No.: 
4-Mega Gray Camera (ANPVC1470) 

 
 

1 Lens Attach a C-mount lens with adapter rings as necessary. 

2 Lens fixture C-mount 

3 Mounting Plate Insulation type plate. The plate can be attached to the bottom and top sides of 
a camera. 
(The positions to screw the plate differ between the bottom and top sides.)  
For attaching the plate on the side of a camera, attach separately sold camera 
attachment brackets ANPVH005) to the camera in advance. 

4 Cable connector Connect a camera cable to the connector D.OUT1. Connect the connector 
labeled the product number of the cable to a camera. 

 
 

1.2.3 Camera Cable 

Product No.: ANPVC81XX, ANPVC81XXR (XX=03, 05, 10) 

Applicable camera: 4-Mega Gray Camera (Only the cable whose length is 3 m can be used.), 2-Mega Gray 
Camera, 2-Mega Color Camera, 0.3-Mega Gray Camera, 0.3-Mega Color Camera 

(0.3-Mega Compact Gray Camera (ANPVC5030) and 0.3-Mega Compact Color Camera (ANPVC6030) 
cannot be used.) 

 
Camera-side  PV200-side 

 

1 Camera-side connector Connects to a camera. 

2 Product number label The label indicates product number of the camera cable. 

3 Ferrite core Attach this whenever you use the product. (ZCAT2035-0930A produced by 
TDK) 

4 PV200-side connector Connect the CAMERA connector of PV200. 

 
The camera cable has directionality. Be sure to connect the cable at the connector with a product number 
sticker to the camera, and the connector with a ferrite core to the PV200. 
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Product No.: ANPVC82XX (XX=03, 05, 10) 

Applicable camera: 0.3-Mega Compact Gray Camera (ANPVC5030), 0.3-Mega Compact Color Camera 
(ANPVC6030) 

 
Camera-side  PV200-side 

 

1 Camera-side connector Connects to a camera. 

2 Product number label The label indicates product number of the camera cable. 

3 PV200-side connector Connect the CAMERA connector of PV200. 
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1.3 Keypad 
Typical operations of the keypad are described below. 

 
 

1 ENTER key Cursor Operation 
To select the menu, input letters and 
move the start and end points of areas. 

 

Determination Operation 
To determine the settings or select menu. 

 

2 TRIG Key 
(TRIGGER) 

To start an inspection or run a test. 

3 CANCEL Key To return to the previous window or operation while setting.  

4 F1 Key To display the image menu. 

5 F2, F3 Key Use these keys when key guide is displayed in the bottom of the window. 

6 OPE/SET Switch  To switch windows between SETUP menu and RUN menu. 
This is a snap type switch and the window switches every time you snap it.  
(However, if a user is not allowed to move to "SETUP menu" to "RUN menu" when 
the account setting is used, the screen will not switched even if this switch is 
snapped.) 

7 FUNC Key 
(FUNCTION) 

To display pop-up menu. 
Pressing the key two seconds or more captures the screen. (Print Screen) 

8 SHIFT Key Use when green SHIFT sign is shown on the screen. 
Mainly, to make the cursor move faster combining with cursor operation.  

9 LOCK Switch To lock or disable the 1 - 8 keys by setting in “LOCK” side. 
The switch prevents undesired operation of the keys by mistake. 

 
The operation from the keypad may be off on the PV200. Refer to page 448 for details. For information on 
"Rebooting PV200), see page 15. For information on "Start with Default Settings", see page 381. 
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1.4  XGA Monitor 
Product No.: ANPVM11021 

 

 
 

 

1 Mounting hole 
for mounting bracket 

Attach the included mounting brackets. 

2 Adjustment volume The following adjustments are available. 
BRIGHT Brightness Adjusts the brightness.  

(Brightness: approx. 20 to 100%) 
V-POS. Vertical Position Adjusts the screen vertical position (in 

16 lines). 
H-POS. Horizontal Position Adjusts the screen horizontal position 

(in 16 pixels). 
PHASE Phase Adjusts the screen flickering. 

CONT. Contrast Adjusts the contrast. 
 

3 Mounting hole 
VESA mount 

4-M4 (depth: 7mm), 75 x 75 mm 

4 RGB input connector A connector for RGB signal input. To connect to the monitor with the VGA monitor 
cable -ANMX8331X. (Connector: Mini D-sub, 15 pins, female) 

 

R Image signal: Red 
G Image signal: Green 
B Image signal: Blue 
GND Signal ground 
HS Horizontal synchronizing signal 
VS Vertical synchronizing signal 

 

5 Power terminal Acceptable input voltage: 24V DC 
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2.1 Basic System Configurations 

An example of basic system configuration when connecting two cameras 
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2.2 PV200 Installation 

2.2.1 Mounting Arrangement 

There are the two ways to mount the PV200, by using screws or by hooking on the DIN rail.  

 
Before mounting PV200, attach a backup battery to it. Refer to page 15 on how to attach the battery. 

Back Side Mount 
Mount PV200 using two mounting holes (5). Use M4 screws (length of 10 mm or more) to mount. 

 

Mounting PV200 on the DIN rail 
PV200 can be mounted on or removed from a 35 mm wide DIN rail (DIN EN50022) with a single easy 
operation. 

 Mounting 

1. Hook PV200 onto the DIN rail. 

2. Press the lower part of PV200 to fit it 
into position. 

 
 Removing 

1. Insert the slot-head screwdriver into 
the mounting lever. 

2. Press the mounting lever downward. 

3. Lift and detach PV200. 
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2.2.2 Note on Mounting 

Mounting Direction 
Install PV200 in the correct direction (see the figures below) for heat radiation. Do not mount it sideways or 
upside down. 

Correct Wrong 

 

About Mounting Space 
Keep more than 50 mm of space around PV200 for ventilation. In addition, to wire cables safely, keep more 
than 100 mm of space in front of PV200. 

 
When installing another PV200 next to it, keep more than 50mm of space between PV200s. 

 

 
• Do not block the ventilators on the four sides of the unit.  It might lead to a malfunction due to the 

internal heat retaining. 
• When installing PV200 on a control board, take some measures such as attaching a cooling system 

(a fan motor, etc.) to lower the operation ambient temperature into the specified range (0 - 45 °C). 
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2.3 Mounting a Camera 

2.3.1 Selecting a Lens (View Range Table) 

Select a lens according to the capturing range (view range). 
Depending on the size of object, decide the capturing range (view 
range). And then, referring to the view range table of each camera, 
confirm the distance from the object to the camera (WD: work 
distance) and select a suitable lens. 

 
 The values in the tables are just guidelines. Adjust them 

while checking an image on the actual device when you 
mount a camera. 

 Adapter rings may be needed in some cases. When you use 
adapter rings, fix them between the lens and the camera. 

 

View Range Table - 0.3-Mega Quad-speed Gray Camera: ANPVC1040 / 0.3-Mega 
Quad-speed Color Camera:ANPVC2040  

Lens 
ANM88501 
f=50 mm 

ANB847L 
f=50 mm 

ANB846NL 
ANM88251 
f=25 mm 

ANB845NL 
ANM88161*1 

f=16 mm 

ANB 843L 
f=8.5 mm 

ANB 842NL 
f=6 mm 

Resolution 
µm/pixel View range 

(mm) 

Ver. Hor. WD Adapter 
ring WD Adapter 

ring WD Adapter 
ring WD Adapter 

ring WD Adapter 
ring WD Adapter 

ring Ver. Hor. 

1 1.3 59 177.5 48 177.5         2.1 2.1 
2 2.7 73 88.5 62 88.5         4.2 4.2 
3 4.0 87 59 76 59         6.3 6.3 
4 5.3 101 44 90 44         8.3 8.3 
5 6.7 115 35.5 104 35.5 31 17.5       10.4 10.4 

7.5 10.0 150 23.5 139 23.5 49 11.5       15.6 15.6 
10 13.3 186 17.5 175 17.5 66 8.5 31 5.5     20.8 20.8 

12.5 16.7 221 14 210 14 84 7 42 2     26.0 26.0 
15 20.0 256 11.5 245 11.5 101 5.5 53 2(*2)     31.3 31.3 
20 26.7 326 8.5 315 8.5 137 2(*2) 76 2(*3) 30 1.5   41.7 41.7 
30 40.0 467 5.5 456 5.5 207 2(*3) 121 1.5 54 1 32 0.5 62.5 62.5 
40 53.3 608 2(*2) 597 2(*2) 277 2 166 1 78 0.5 49 0.5 83.3 83.3 
50 66.7 749 2(*3) 738 2(*3) 348 1.5 211 1 102 0.5 66 0.5 104.2 104.2 
75 100.0 1101 2 1090 2 524 1 323 0.5 162 0 108 0.5 156.3 156.3 
100 133.3 1452 1.5 1441 1.5 700 0.5 436 0.5 221 0 150 0 208.3 208.3 
150 200.0 2156 1 2145 1 1052 0.5 661 0 341 0 235 0 312.5 312.5 
200 266.7 2860 0.5 2849 0.5 1403 0 886 0 461 0 319 0 416.7 416.7 
250 333.3 3564 0.5 3553 0.5 1755 0 1112 0 580 0 404 0 520.8 520.8 
300 400.0 4268 0.5 4257 0.5 2107 0 1337 0 700 0 488 0 625.0 625.0 
350 466.7 4972 0.5 4961 0.5 2459 0 1562 0 820 0 573 0 729.2 729.2 
400 533.3 5675 0 5664 0 2811 0 1787 0 939 0 657 0 833.3 833.3 
450 600.0 6379 0 6368 0 3163 0 2013 0 1059 0 741 0 937.5 937.5 
500 666.7 7083 0 7072 0 3515 0 2238 0 1179 0 826 0 1041.7 1041.7 
600 800.0 8491 0 8480 0 4219 0 2688 0 1418 0 995 0 1250.0 1250.0 
700 933.3 9898 0 9887 0 4923 0 3139 0 1657 0 1164 0 1458.3 1458.3 
800 1066.7 11306 0 11295 0 5626 0 3589 0 1897 0 1333 0 1666.7 1666.7 
900 1200.0 12714 0 12703 0 6330 0 4040 0 2136 0 1502 0 1875.0 1875.0 

1000 1333.3 14121 0 14110 0 7034 0 4490 0 2375 0 1671 0 2083.3 2083.3 

WD = The distance from the front of the lens to the object. 
The values in the table are around the focal point of ∞, except as otherwise noted. 
*1: WD=+4 mm  *2: Lens focal position is in the closest position. *3: Lens focal position is in the middle position. 
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View Range Table - 0.3-Mega Compact Gray Camera :ANPVC5030 / 0.3-Mega 
Compact Color Camera :ANPVC6030 

Lens 
ANM88501 
f=50 mm 

ANB847L 
f=50 mm 

ANB846NL 
f=25 mm 

ANB845NL 
f=16 mm 

ANB 842NL 
f=6 mm 

Resolution 
µm/pixel View range 

(mm) 

Ver. Hor. WD Adapter 
ring WD Adapter 

ring WD Adapter 
ring WD Adapter 

ring WD Adapter 
ring Ver. Hor. 

1 1.3 62 144 51 144       2.1 2.1 
2 2.7 80 72 69 72       4.2 4.2 
3 4.0 97 48 86 48       6.3 6.3 

4.5 6.0 123 32 112 32 35 16     9.4 9.4 
5 6.7 132 29 121 29 39 14.5     10.4 10.4 

7.5 10.0 175 19 164 19 61 9.6     15.6 15.6 
10 13.3 218 14.5 207 14.5 83 7     20.8 20.8 

12.5 16.7 262 11.5 251 11.5 104 6     26.0 26.0 
15 20.0 305 9.5 294 9.5 126 5     31.3 31.3 
20 26.7 392 7 381 7.0 175 2(*2) 97 2(*3)   41.7 41.7 
30 40.0 566 5 555 5.0 265 2(*3) 152 1.5 45 0.5 62.5 62.5 
40 53.3 721 2(*2) 710 2(*2) 343 2 208 1 66 0.5 83.3 83.3 
50 66.7 911 2(*3) 900 2(*3) 430 1.5 263 1 88 0.5 104.2 104.2 
75 100.0 1347 2.0 1336 2.0 647 1 402 0.5 143 0.5 156.3 156.3 
100 133.3 1781 1.5 1770 1.5 864 0.5 541 0.5 197 0.5 208.3 208.3 
150 200.0 2649 1 2638 1 1298 0.5 819 0.5 300 0.5 312.5 312.5 
200 266.7 3517 0.5 3506 0.5 1732 0.5 1097 0 405 0 416.7 416.7 
250 333.3 4385 0.5 4374 0.5 2166 0.5 1374 0 512 0 520.8 520.8 
300 400.0 5253 0.5 5242 0.5 2600 0 1652 0 616 0 625.0 625.0 
350 466.7 6121 0.5 6110 0.5 3034 0 1930 0 725 0 729.2 729.2 
400 533.3 6989 0.5 6978 0.5 3468 0 2208 0 827 0 833.3 833.3 
450 600.0 7857 0.5 7846 0.5 3902 0 2486 0 933 0 937.5 937.5 
500 666.7 8725 0.5 8714 0.5 4336 0 2763 0 1,040 0 1041.7 1041.7 
600 800.0 10461 0 10450 0 5204 0 3319 0 1,250 0 1250.0 1250.0 
700 933.3 12198 0 12187 0 6072 0 3874 0 1,459 0 1458.3 1458.3 
800 1066.7 13934 0 13923 0 6940 0 4430 0 1,663 0 1666.7 1666.7 
900 1200.0 15670 0 15659 0 7808 0 4986 0 1,873 0 1875.0 1875.0 

1000 1333.3 17406 0 17395 0 8676 0 5541 0 2,088 0 2083.3 2083.3 

WD = The distance from the front of the lens to the object. 
The values in the table are around the focal point of ∞, except as otherwise noted. 
*1: WD=+4 mm  *2: Lens focal position is in the closest position. *3: Lens focal position is in the middle position. 
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View Range Table - 2-Mega Gray Camera: ANPVC1210 / 2-Mega Color 
Camera:ANPVC2260 

Lens 
ANPVL502 
f=50 mm 

ANPVL252 
f=25 mm 

ANPVL162 
f=16 mm 

Resolution 
µm / Pixel View Range 

(mm) 

Ver. Hor. WD Adapter 
ring WD Adapter 

ring WD Adapter 
ring Ver. Hor. 

1 1.3 30 264     0.8 0.8 
2 2.7 40 132     1.7 1.7 
3 4.0 49 88     2.5 2.5 
4 5.3 59 66     3.3 3.3 
5 6.7 68 52.5     4.2 4.2 

7.5 10.0 92 35     6.3 6.3 
10 13.3 115 26 30 13.0   8.3 8.3 

12.5 16.7 139 21 41 10.5   10.4 10.4 
15 20.0 163 17.5 53 8.5   12.5 12.5 
20 26.7 210 13 77 6.5   16.7 16.7 
30 40.0 305 8.5 124 2(*1) 74 2(*1) 25.0 25.0 
40 53.3 399 6.5 172 2(*2) 104 2 33.3 33.3 
50 66.7 494 5 219 2(*3) 135 1.5 41.7 41.7 
75 100.0 731 2(*4) 337 1.5 210 1 62.5 62.5 
100 133.3 968 2 456 1.0 286 0.5 83.3 83.3 
150 200.0 1441 1.5 693 0.5 438 0.5 125.0 125.0 
200 266.7 1915 1 929 0.5 589 0 166.7 166.7 
250 333.3 2388 1 1166 0.5 741 0 208.3 208.3 
300 400.0 2862 0.5 1403 0 892 0 250.0 250.0 
350 466.7 3335 0.5 1639 0 1044 0 291.7 291.7 
400 533.3 3809 0.5 1876 0 1195 0 333.3 333.3 
450 600.0 4282 0.5 2113 0 1347 0 375.0 375.0 
500 666.7 4756 0.5 2350 0 1498 0 416.7 416.7 
600 800.0 5703 0 2823 0 1801 0 500.0 500.0 
700 933.3 6649 0 3297 0 2104 0 583.3 583.3 
800 1066.7 7596 0 3770 0 2407 0 666.7 666.7 
900 1200.0 8543 0 4244 0 2710 0 750.0 750.0 

1000 1333.3 9490 0 4717 0 3013 0 833.3 833.3 

WD = The distance from the front of the lens to the object 
The values in the table are around the focal point of ∞, except as otherwise noted. 

 
 Lens focal position 

*1 : Around 0.3 

*2 : Around 0.5 

*3 : Around 1 

*4 : Around 2 
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View Range Table – 4-Mega Gray Camera: ANPVC1470  

Lens 
ANPVL502 
f=50 mm 

ANPVL252 
f=25 mm 

ANPVL162 
f=16 mm 

Resolution 
µm / Pixel View Range 

(mm) 

Ver. Hor. WD Adapter 
ring WD Adapter 

ring WD Adapter 
ring Ver. Hor. 

1 1       0.5 0.5 
2 2 35 176.5     1.0 1.0 
3 3 42 118     1.5 1.5 
4 4 49 88.5     2.0 2.0 
5 5 56 70.5     2.4 2.4 

7.5 7.5 74 47     3.7 3.7 
10 10 91 35.5     4.9 4.9 

12.5 12.5. 109 28.5     6.1 6.1 
15 15 127 23.5 35 12   7.3 7.3 
20 20 162 17.5 53 9   9.8 9.8 
30 30 233 12 88 6 51 2 (*1) 14.6 14.6 
40 40 304 9 124 2 (*2) 74 2 (*2) 19.5 19.5 
50 50 375 7 159 2 (*2) 96 2 (*3) 24.4 24.4 
75 75 551 2 (*3) 248 2 (*3) 153 1.5 36.6 36.6 
100 100 728 2 (*3) 336 2 210 1 48.8 48.8 
150 150 1082 2 (*3) 513 1 323 1 73.2 73.2 
200 200 1436 2 690 1 436 0.5 97.7 97.7 
250 250 1790 1.5 867 0.5 549 0.5 122.1 122.1 
300 300 2144 1 1044 0.5 662 0.5 146.5 146.5 
350 350 2497 1 1221 0.5 776 0.5 170.9 170.9 
400 400 2851 1 1398 0.5 889 0.5 195.3 195.3 
450 450 3205 1 1575 0.5 1002 0.5 219.7 219.7 
500 500 3559 0.5 1751 0.5 1115 0 244.1 244.1 
600 600 4267 0.5 2105 0.5 1342 0 293.0 293.0 
650 650 4620 0.5 2282 0.5 1455 0 317.4 317.4 
700 700 4974 0.5 2459 0.5 1568 0 341.8 341.8 
800 800 5682 0.5 2813 0 1795 0 390.6 390.6 
900 900 6390 0.5 3167 0 2021 0 439.5 439.5 

1000 1000 7097 0.5 3521 0 2248 0 488.3 488.3 

WD = The distance from the front of the lens to the object 
The values in the table are around the focal point of ∞. 
*1: Lens focal position is in the closest position.  *2: Lens focal position is in the middle position. 
*3:Lens focal position is in the far position. 
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2.3.2 Mounting a Camera 

1. Attach a lens to a camera. 

Remove the camera cap or sticker and attach the 
selected lens. 

 
 

・ Protect the image sensor from dust. And do 
not touch the glass surface of image sensor. 

 
 

For the 0.3-Mega compact gray camera and 
0.3-Mega compact color camera, please note 
the following two points. 
- Attach the adapter ring and lens after 

attaching the C-mount adapter supplied 
with the camera. 

- A lens whose projection from the C-mount 
face is larger than 4.5 mm cannot be 
attached structurally. 

 

2.3.3 Note on Mounting 

Mounting a Camera 
 Use the mounting plate (insulation type) initially attached on the camera to mount it in an electrically 

insulated way. 
Without insulation, the internal circuit might be damaged because the camera case connects GND of 
the internal circuit if the electric potentials of the mounting point and the camera case are different. 

 When you directly screw the camera without a mounting plate, do not screw into the bottom of the 
camera over 3 mm. 

 The side of the plate mounted (the side of the face where the plate is attached before shipment) is 
the bottom of capturing images displayed on the screen. 

Camera cables 
 When extending the cable, make it straight using a tool such as a rotating table to prevent the 

torsion of the cable. 

 To prevent loading the cable, support the cable around the camera attachment and around the 
connector. 

 When additional force is supposed to be applied to the camera and camera cable, fix the cable 
close to the camera to suppress the swing of the connector so that the vibration when the camera 
cable and camera vibrates is uniform. 

 Note on the followings when bending the cable. 
- Do not bend at least 100-mm part of the cable from the base of the connector of the camera. 
- The bend radius should be as below. 
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Cable product No. 
Bend 

a b 
ANPVC81**,  
ANPVC81**R   
(**=03, 05, 10) 

100mm 200mm 

ANPVC82**  
(**=03, 05) 

57mm 114mm 

ANPVC8210 70mm 140mm 
 

 When performing the bending (sliding) motion of a camera cable, use the camera cable ANPVC81**R. 
Install the camera cable not to tightly bind and twist the bending (sliding) part tightly. When binding the 
cable, do not bind the moving part and the parts close to it. Bind the connector at the position that is far 
enough from the moving part and that does not move (at least 100 mm far from the end of the moving part). 

 

Example of binding a camera cable when performing the bending motion 

 
 

Example of binding a camera cable when performing the sliding motion 
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2.4 XGA Monitor Installation 
Install a XGA monitor: ANPVM11021 as below. 

 
Never block the ventilation slits of the XGA monitor. 

1. Prepare a panel to attach a monitor. 

Applicable panel thickness: 1 - 5 mm 

 

2. Insert the monitor into the panel. 

 

3. Attach the included attachment brackets to the monitor. 
(4 places) 

4. Screw the attachment brackets to fix the monitor to the 
panel. 

Tightening torque: 0.5 to 0.6 N/m 

 
Keep 50 mm spaces around the XGA monitor to prevent the 
cables from being damaged and to increase work efficiency. 
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2.5 Connecting Cables 

2.5.1 Connecting Peripherals 

 
Be sure to turn off the power source for PV200 before connecting peripherals. 

1. Connect a camera to PV200. 

Connect a camera cable with a camera 
connector. 
The camera cable has polarity. Connect the 
cable at the end with a product number 
sticker to the camera, and the end with a 
ferrite core to the PV200. 
No ferrite core is attached to the camera 
cable for the 0.3-Mega Compact Camera 
(Gray: ANPVC5030, Color: ANPVC6030). 

  
 When you use just one camera, be sure 

to connect it to "CAMERA 0". 

 Keep the camera cable more than 100 mm 
away from a power cable and a power 
source cable. 

 Tighten the screw of the camera cable 
during its use. 

 

2. Connect a monitor to PV200. 

Connect a monitor cable to “MONITOR” connector. 

 

3. Connect a keypad. 

Connect the designated keypad to “KEYPAD” 

connector. 
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2.5.2 Connecting Power to XGA Monitor 

Connect the power of 24 V DC to the terminal on the back side. 

 
Use an insulated power supply with a built-in protection circuit as a power supply device to supply 24 V DC. 

 

 
 

Rated voltage: 24 V DC 

Operating voltage range: 21.6 to 26.4 V DC 

Power consumption: 0.5 A (Max. 1A) 
 
 

Applicable Solderless Terminal 

 Terminal screws are M3. 

 Screw the terminal block with tightening torque of 0.8 Nm. 
Failure to do so might damage to the product. 

 It is advisable to use solderless terminals to wire. 
Use wires of 0.5 mm2 to 1.25 mm2 diameter if you do not use a solderless terminal. 

 

Manufacturer Shape Model No. Applicable wire Tightening torque 

JST Mfg. Co., Ltd. 

R-type 1.25-MS3 0.25 mm2 to 1.65 mm2 0.5 to 0.6 N/m 

A-type 1.25-B3A   

R-type 2-MS3 1.04 to 2.63 mm2  

A-type 2-N3A   

2.5.3 Connecting Power to PV200 

24V DC electric power is supplied through the +/- terminals on the input terminal block. 

Twist the electric wires for noise reduction. 
 

 Appropriate wire size: AWG#24 to 16, 0.2 to 1.5 mm2 

 Uncovered wire length: 10 mm 

 
Do not supply power until every connection has completed. 
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Wiring Power 

1. Prepare a power supply unit which fulfills the following conditions and connect to the 
POWER(+/-) on the input terminal block. 

Conditions for power supply 
- Power voltage: 24 V DC +/- 10 % 
- Current capacity: 3.0A or more 
- Insulated power supply with a built-in protection circuit 

 
 

• Ensure to use the separate power supply for the PV200 from the power supply for power devices. 
• Turn ON/OFF the power supply at the primary side. If you turn ON/OFF it at the secondary side, the 

fuses of PV200 may melt down. 
 

 

2. Connect an earthing conductor. 

• Do not share the grounding system with other devices. 
• Install the PV200 as close to the ground point as possible and keep the ground wire short.  

 

 
 

• The power circuit of PV200 is insulated and you can ground the positive (+) terminal of 24V DC 
power supply without fault. 

• When connecting PV200 with the other devices such as PLC, do not ground the positive terminal of 
the power supply of the device. If the power supply circuit of the device is not insulated, the 
connection between the outer shell of the PC and the 0V-power supply may cause a short-circuit 
condition and burnout. 
 

 

3. Connect the input terminal of PV200. 

• Connect other input terminals if necessary before connecting the terminal block. 
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2.6 Supplying Power 

Confirming Start 

1. Supply the power after confirming that the all connections are correct. 

The splash screen appears and then the default screen of RUN menu is displayed. 
 

 
 

When you start the very first time after delivery, the dialog to select interface language appears. 
Refer to the next chapter for more details. 

 

 

 
If the monitor screen displays nothing, confirm the following statuses. 

 Is power supplied to PV200 correctly? 

 Is the power switch of the monitor ON? 

 Does the monitor cable connect correctly? 

 
You can change splash screen. Refer to page 475 for details. 
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Chapter 3 
 Basic Operation 
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3.1 About Windows 

3.1.1 Language Selecting Window 

When you start the very first time after delivery, the English dialog to select interface language appears. You 
can display multiple languages with PV200. Select an appropriate language in this dialog. 

Since the language can be changed in SETUP menu later as well, select your most accessible language for 
now. 

 
Switching Language: see page 455. 

1. Turn on the power. 

After the splash screen appears, the English dialog to select language is displayed. 

2. Press the Enter key. 

Settable languages are displayed. 
 

Japanese 
English 
Simplified Chinese 
Korean 
Traditional Chinese 

3. Tilt the ENTER key up/down to move the cursor onto 
the language you want to use and press the ENTER 
key. 

4. Tilt the ENTER key up/down to move the cursor onto 
the lower message and press the ENTER key. 

The message says "Do not show this window at the next 
start-up." 
Pressing the ENTER key checks the check box and the 
window does not appear from the next startup. 

 

 

 
 

 

 
The English dialog is shown also at the next startup if you do not check it.  

5. Tilt the ENTER key up/down to select “OK” and then press the ENTER key. 

RUN menu is displayed on the screen. 
 

 
If you make an operation not to display the language selecting window such as selecting "Do not show this 
window at the next start-up.", you cannot display it again. In this case, make setting from “TOOL” > 
"General" > "Language" in SETUP menu to switch language. 
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3.1.2 SETUP Menu and RUN Menu 

About windows 
PV200 has two windows; RUN menu for performing inspections and SETUP menu for making settings such as 
inspection conditions. 

Two menus are available in "SETUP Menu", "Normal Menu" in which all the settings can be changed and 
"Select Menu" in which only registered settings can be changed. 

When power is turned on, RUN menu is displayed. To make a configuration, switch to SETUP menu with 
Ope/Set Switch of the keypad. Switching to SETUP menu stops operation. (However, if a user is not allowed to 
move to "SETUP menu" to "RUN menu" when the account setting is used, the screen will not switched even if 
this switch is snapped.) 

RUN menu 
Two layouts are available in RUN Menu, the normal layout displaying the information display area and  the 
full-screen layout displaying the screen window only. In either layout, you can change the type of displayed 
image and its magnification. 

Normal layout: Preset layout No.0-6 For the details of preset layout, refer to page 416. 

Full-screen layout: Preset layout No.7-9 
 
Normal layout (The following screen is when selecting Layout No.00.)  

 
 

1 Menu bar Displays the menu to set in RUN menu. 

2 Information display area  

  a Information Displays the current area number, setting data comment 
information, type, layout number, the status of the PV200, 
and the logged-in account name when the account setting is 
used.. 

  b Total judgement result Displays the result of judgement formula registered as Total 
Judgement. 

  c Output terminal status Displays the status of output terminals. ON: Green, OFF: 
Black 

  d Operation Status Displays the status operating (RUN) or pausing (STOP). 

  e Time Displays inspection time and cycle in ms unit. 
(For details of each time, see page 411.) 

3 Message area Displays the message to inform. 
Example) 
• The setting was updated. 
• The voltage of the attached battery became lower. 
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4 Display type Displays "RUN MENU". 
(Indicates the current window is RUN menu.) 

5 Screen window This is a window to display an image. 

6 Key guide Displays the operations of each key on the keypad. 

 
Full-screen layout  
The following screen is when selecting Layout No.09 (Top&Bottom(Full)).  
This is the layout displaying an image using the full screen without displaying the menu bar, information 
display area, message area, display type and key guide shown in the previous page. 

 

 
1 Menu bar You cannot see the menu bar behind the screen window although the same 

menu bar is displayed as the normal layout. 
Pressing the ENTER key or down arrow key displays the selected menu. 
(The above is when selecting "OPERATION".) 
Tilting the ENTER key left/right moves the cursor between the menu bar items. 
Press the CANCEL key to return to the full-screen display. 

2 Screen window This is a window to display an image. 
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SETUP menu（Normal menu） 
In SETUP menu, the display changes depending on operation.  

 

 
 
 

1 Main menu Displays the menu to set in SETUP menu. 

2 Sub menu Displays a submenu of the menu selected in the main menu. 

3 Setting windows Setting windows displayed in the upper left of the screen. The above 
image is an example of screen displaying the checker setting window 

4 Message display area Displays the message to inform. 
Example) 
The setting was updated. 
The voltage of the attached battery became lower. 

5 Display type Displays "SETUP MENU". 
(Indicates the current window is SETUP menu".) 

6 Information display area • Type number 
• Total Judg. 
• Inspection time (unit: ms) 
• Logged-in account name when using the account setting 

7 Screen window navigator Displays the thumbnails of captured images and displays the area 
currently shown on the screen window in light blue frame. 

8 Screen window Displays a camera image. 

9 Key guide Guide for the keypad. 
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SETUP menu（Select menu） 
In Select menu, you can register buttons for any items you want to operate such as checker area setting or 
change of max./min. value. With this feature, you can limit operations performed by an operator and make 
settings easier. 

 
9.1 Select Menu: Page 502 

 

 
 

1 Select menu Displays the menus registered in Select menu. 

2 Page name of Select 
menu 

Displays the page name of Select menu. 

3 Display type Displays "SETUP MENU". 
(Indicates the current window is SETUP menu".) 

4 Information display area • Type number 
• Total Judg. 
• Inspection time (unit: ms) 
• Logged-in account name when using the account setting 

5 Screen window 
navigator 

Displays the thumbnails of captured images and displays the area currently 
shown on the screen window in light blue frame. 

6 Screen window Displays a camera image. 

7 Key guide Guide for the keypad. 
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Switch between RUN Menu and SETUP Menu 
(OPE/SET Switch) 

To switch the window from RUN menu (default window) to SETUP menu, operate the OPE/SET switch on the 
keypad. Operate in the same way to return to RUN menu. 

RUN Menu (default) SETUP Menu 

 

Switch between Normal menu and Select menu 
Pressing the F2 key switches between Normal menu and Select menu. However, you cannot switch the menu 
when the F2 key is not displayed in the key guide or from the hierarchy under the submenu in Normal menu. 

When switching from RUN menu to SETUP menu, you can select either menu to display. It can be changed in 
"ENVIRONMENT" > "System Settings" > "Operation" > "Menu Display Priority”. See page 523 for information 
on how to switch the menu. 

Normal menu Select menu 

 

When nothing is set in Select menu 

Switching Normal menu to Select menu with the F2 key when nothing is set in Select menu (such as when a 
new type is set) displays the message "No select menu setting. / To RUN Menu". Press the F2 key again to 
return to Normal menu. 

Normal menu Select menu 
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Entering a Password 

When switching from RUN menu to SETUP menu or from Select menu to Normal menu, a password may 
be requested to enter. 

This is the function that prevents undesired setting changes by mistake. A password can be set from 
ENVIRONMENT menu in SETUP menu. 

 

 
For the information of setting a password to switch to SETUP menu, refer to page 448. 

 
The password is also requested when reading password-protected setting data. 

1. Password window is 
displayed. 

The password window 
appears depending on 
password settings in the 
following cases. 
 
When switching from RUN 
menu to SETUP menu; 
Snap the OPE/SET switch 
in RUN menu. 
When switching from Select 
menu to Normal menu; 
Press the F2 key in SETUP 
menu. 

2. Enter a password. 

Use the software keyboard. 

3. Select "Login". 

Entering the correct 
password will switch the 
window to SETUP menu. 

 

 

 
“Do not request a password every time.” 
Check this item to switch to SETUP menu or Normal menu without entering a password.  
Set the switch in "LOCK" side to change to request a password after that. (As the keys on the keypad are 
disabled when the switch is set to "Lock" side, set it back.) 
Also, after you reboot PV200, it requests a password again. 

4. If you forget the password, select "Initialize All Setting Data" to switch to SETUP menu. 

Note that all the setting data will be initialized when selecting this menu.  
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Operation by "Account" Setting at Startup  
PV200 has a "Account Setting" function which limits available operations individually for each operator 
(account user). 

As this function is not set at the time of purchase, PV200 starts in the status that all menus can be 
operated. When "Account Setting" is set to "Use", only items that are allowed to be accessed are displayed 
and the items that are not allowed are not displayed. Therefore, the menu displayed in RUN Menu or 
SETUP Menu at startup may differ from that described on page 41. 

When "Account Setting" is used, the user automatically logs in the account "Start User" at PV200 startup. At 
this time, only the items which "Start User" is allowed to access are displayed on the monitor. Operate PV200 
switching users as necessary after the startup. When "Account Setting" is used, PV200 is in a state that always 
logs in any of users while PV200 is powered on. 

 
 The account limit is applied when setting "TOOL" > "General" > "Account Setting" > "Account 

Setting" to "Use". Specify menus of PV200 allowed to be operated individually for each users. For 
details, refer to page 456. 

 This function controls the operation level of each user by limiting the PV200 operations for each 
registered account. However, the account setting can be changed or initialized freely from 
PVWIN200. 

Operation when specifying "Account Setting" 

 Account Setting: Use Account Setting: Not use 

 

 
Displays the menus which "Start User" is 
allowed to access. 

 
Display all menus. 

D
isp

lay 
at 
startu

p
 

Displays the menus which "Start User" is 
allowed to access at startup. All items can be accessed. 

   

S
w

itch
 acco

u
n

t 

Operate PV200 switching accounts as 
necessary. * 

 

 

If the following operation* is 
performed during the setting, 
PV200 will become a logout 
status immediately, and it will 
not belong to any user. 

   

 

  

 The setting of PV200 completed.  

A
fter 

settin
g

 

PV200 becomes a logout status after the 
operation. 

The account is automatically switched to "Start 
User" after the logout. 

 

* - Initialize from "SETUP Menu" > "TOOL" > "General" > "Initialize". 

- Initialize accounts from PVWIN200. 

- Read the account data in which "Account Setting" is set to "Not Use" from PVWIN200 or an SD memory 
card. 
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When changing account data by the following operations while using "Account Setting", the changes 
become valid when PV200 is rebooted after executing "Switch User" or "Logout" or saving the changes in 
the account data. Until then, login users or menus allowed to be accessed will not be replaced.  

Operation for changing account data: 1) Edit from "SETUP Menu" > "TOOL" > "General" > "Account 
Setting". 

2) Read account data from an SD memory card. 

3) Read account data from PVWIN200.  

 

"Account" Menu in RUN Menu 
The following functions are available in "Account Menu" in RUN Menu. ("Account" is not displayed when 
"Account Setting" is set to "Not Use".) 

 
Switch User To switch account user (operation authority). Enter "User Name" and "Password" for login. 

Settings which "Start User" is allowed to access are available at startup.  For using functions 
which the current user is not allowed to access, switch to the user who has that authority.  
Use "Switch User". 

Users 
Information 

Displays logged-in user information (user name and access authority ("Admin", "Start User" 
or "General User")). 

Logout Select to finish the operation by the selected account. The account is switched to "Start 
User" after logout. 

Switching User (Switch User)  
This function is used for switching to another user. 
When "Account Setting" is used, the user automatically logs in the account "Start User" at PV200 startup. 
Operate as follows if you want to switch the login user from "Start User" to another user, or switch to 
another user from the status that an arbitrary user logs in. 
 

1. Select "Account" > "Switch User" in RUN Menu and 
press the ENTER key. 

 
 

2. Enter a user name and password. 

When "Login time user name display" is set to "Display" 
in Account Setting, enter the password for login after 
selecting a user name from the list displayed in the 
pull-down menu. 
 

 
 All user names are displayed in the pull-down 

menu. This is the same as the cases that account 
data is read from an SD memory card or 
PVWIN200. 

[Appearance of user name entry 
menu] 

When "Login time user name 
display" is "Display" 
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 If you forget the administrator password, please take 

any of the following steps. (For details, see page 
462.) 

- Reset the password of the account with PVWIN200. 
- "Initialize" by a user who can access "SETUP Menu" 

> "TOOL" > "General" > "Initialize". 
- The account can be also initialized totally with 

PVWIN200. 

When "Login time user name 
display" is "Hide" 

 

3. Log in PV200. 

Press the ENTER key on "Login". 
The account is switched. 
The logged-in user name is displayed in the information 
display area. 

 
 

4. Make necessary settings. 

Make the settings for the items which the logged-in user is allowed to access. 

5. Save the setting data as necessary. 

When the setting data can be saved by "SAVE/READ", save it as necessary. The "SAVE/READ" 
operation may not be executed according to the authority set for the logged-in user. 

6. After the setting, log out. 

Log out after the setting. 
Select "Account" > "Logout" to finish the access to PV200 using the current account. 
The account is automatically switched to "Start User" after the logout. 

 
It is possible to switch to another account by "Switch User" without logging out. 

 

Confirming Users Information 

The window for confirming the logged-in user name 
and access authority. 
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Logout 

 

After finishing the PV200 operation as the 
logged-in user, log out and switch the account 
to "Start User". When "Start User" is not 
allowed to perform "Saving setting data", 
please save edited setting data before logging 
out as necessary. If the power is removed 
without saving, edited data will be cleared. 

 

 

 
 Logging out after reading account data from an SD car or PVWIN200 switches the user to "Start 

User" of the read account data. 

 Once "Yes" is selected for the message "Logout and change the settings. Do you want to continue?" 
which is displayed when "Account Setting" has been changed to "Not Use" in SETUP Menu, the 
normal PV200 menu (all items) will be displayed and all operations will be enabled.  At that time, 
PV200 does not belong to any user. 

3.1.3 Switching the Screen Currently Being Set to RUN Menu 

From Ver.2.0, it is possible to switch the screen currently being set to RUN menu using the OPE/SET key.  

 
 In the default condition, the settings specified right before the switching to RUN menu from the 

currently set screen are not saved. For displaying a confirmation message of saving before transiting 
to RUN menu, set "Show saving dialog" to "Yes" under "ENVIRONMENT" > "System Settings" > 
"Operation". The default setting is "No". 

When setting it to "Yes", the right message 
appears before switching SETUP menu to 
RUN menu. 

 
 When saving setting data when transiting to RUN menu, the storage location of the setting data 

differs according to the read source of the setting data as follows.  

Read source of setting data Storage destination 

New, memory in PV200, PVWIN  Storage space in PV200 

SD card SD card (Area number of read source) 

 The screens of the following functions during setting cannot be switched to RUN menu. 
・While changing the area in Area 
Setting 

・While displaying a message box 
・While registering a user name in 
FTP server 

・Environment initialization screen ・Calibration > Display Global 
Coordinate screen 

・Screen when referring items in 
Data R/W 

・Sort/Preset screen of Select Menu ・Initialize screen 
・Grayscale Preprocess > 
Grayscale Preprocess setting 
screen 

・Numerical Calculation > Expression 
setting, Item reference screen 

・Judgement ・Draw Char./Fig. 

・General setting screen ・Setting Help screen  
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3.2 Basic Key Operation 

3.2.1 Selecting Items and Inputting Values or Characters 

Selecting an Item 
To select a menu or a value of an item, follow the instructions below. This manual describes this operation as 
“select xx”. 

1. Move the cursor to the menu or value you want to set 
by tilting the ENTER key on the keypad 
upward/downward/left/right. 

2. Press the ENTER key. 
The highlighted menu or value at the step 1 is selected. 

 

Inputting Values 

1. Select a box to Input value. 

2. Tilt the ENTER key on the keypad upward/downward to 
change and specify the value. 

By tilting the ENTER key left/right, you can change the digit 
position of the inputting value. 

3. Press the ENTER key. 

The value that you specified at the step 2 is fixed. 

 

Inputting Characters 
Input characters in a title or comment of items such as Type, Checker, Layout, Numerical Calculation, or 
Judgement and a text of items such as Data R/W using the software keyboard.  

 
With the setting simulation software “PVWIN200”, you can input the characters that are not on the software 
keyboard. 

1. Select a box to Input characters. 

A software keyboard is displayed.  
 

 
In some cases such as entering a title, you need to press the FUNC key to show pop-up menu and 
select the item to input them. 
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2. Input character one by one. 

To select characters, move the cursor onto the 
character to input and press the ENTER key. 

 
To input a space, select a blank key at the lower left. 

 
 
To collect (delete) characters, select the right/left arrows and move the cursor onto the character to 
correct (delete). 
Selecting “DEL” deletes the character. 
Selecting “BS” deletes the previous character. 

3. After inputting is completed, press the ENTER key. 

The specified characters are determined. 

3.2.2 Selecting a Display Image (Image Menu) 

An image captured with the connecting camera is displayed on the Screen window. You can choose a camera 
image and an image type to display. Select them from Image Menu. The selection of screen windows or the 
status of displayed images in RUN menu should be operated using "Layout". Refer to Chapter 5.3 (page 415) 
for details. 

 
The information including camera number or type of the image displayed on the screen windows are displayed 
in the screen window bar. As you change the camera number or image type, the display of the bar is updated. 

Displaying Image Menu 
In SETUP Menu 

1. Press the F1 key of the keypad. 

In SETUP menu, Image menu is 
displayed. 

 
Whenever “F1: Image Menu” is shown in 
the key guide, Image Menu can be 
activated. 
But, some items of Image Menu may be 
grayed out to limit changing the settings 
depending on windows. 

 
The transparency of the background of 
setting dialog window can be changed. 
Refer to page 439 for details.  

 

In RUN Menu 

1. Press the F1 key of the keypad. 

The screen number list is displayed to select window. 

2. Select a screen number to set. 

Image menu is displayed. 
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Selecting a Camera Image 

1. Select “Select Camera” from Image 

menu. 

Settable camera No.s are displayed. 

2. Select the camera No. to display. 

The image on the screen window is 
replaced. 

 

 
In the screen window bar, the information of 
the displayed image is updated. 

 

Selecting an Image Type 
Select how display the image captured by a camera on the screen window. 

 

Connecting a gray camera (ANPVC1040, ANPVC5030, ANPVC1210, ANPVC1470) 

SETUP Menu 
Camera No. ┬ 

│ 
Memory ┬ 

│ 
Grayscale Preprocess: 
No 

─ 
 

───── ┬ 
│ 

Slice Level: No 

 │  │    └ Slice Level: A-P 
 │  │      
 │ 

│ 
 └ Grayscale Preprocess: 

(A-P) 
─ 
 

Step: 1st - 10th ┬ 
│ 

Slice Level: No 

 │      └ Slice Level: A-P 
 └ Live ─ Same as “Memory”     

 

RUN Menu 
 

Camera No. ┬ 
│ 

Memory ┬ 
│ 

Trapezoid Adj.:  
Not Available 

┬ 
│ 

Grayscale 
Preprocess: No 

─── ┬ 
│ 

Slice Level: No 

 │  │  │   └ Slice Level: A-P 
 │  │  │     
 │ 

│ 
 │ 

│ 
 └ Grayscale 

Preprocess: (A-P) 
─── ┬ 

│ 
Slice Level: No 

 │  │     └ Slice Level: A-P 
 │

│ 
 └ Trapezoid Adj.: 

Available 
┬ 
│ 

Grayscale 
Preprocess: No 

─── ┬ 
│ 

Slice Level: No 

 │    │   └ Slice Level: A-P 
 │    │     
 │

│ 
   └ Grayscale 

Preprocess: (A-P) 
─── ┬ 

│ 
Slice Level: No 

 │       └ Slice Level: A-P 
 │          
 ├ Live ─ Same as “Memory”     
 └ NG Image ─ Latest / Previous ─ Same as “Memory”   
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Connecting a color camera (ANPVC2040, ANPVC6030, ANPVC2260) 

SETUP Menu 
Camera 
No. 

┬ 
│

│ 

Memory ┬ 
│

│ 

Trapezoid 
Adjustment : 
Not set 

┬ 
│

│ 

Grayscale / Color: No (Color image) 

 │ 
│ 

 │

│ 
  ├ 

│ 
Converted 
Gray Img. 

┬ 
│ 

Grayscale 
Preprocess: No 

───── ┬ 
│ 

Slice Level: No 

 │ 
│ 

 │ 
│ 

  │ 
│ 

 │ 
│ 

   └ Slice Level: A-P 

 │ 
│ 

 │ 
│ 

 │ 
│ 

 └ Grayscale 
Preprocess:  

─ Step: 1st - 
10th 

┬ 
│ 

Slice Level: No 

 │ 
│ 

 │ 
│ 

 │ 
│ 

  (A-P)   └ Slice Level: A-P 

 │ 
│

│

│ 

 │ 
│

│

│ 

 └ Extracted 
Color Img. 

─ Extracted 
Color (Color 
Select / Bulk 
/ Individual) 

┬ 
│

│

│ 

White (Black 
BG) 

┬ 
│

│

│ 

Grayscale 
Preprocess: No 

┐ 
│ 
│ 
│ 

 │  │      │  │ ┌ ─────── ┘ 
 │ 

│ 
 │ 

│ 
     │ 

│ 
 │ 

│ 
└ ── ┬ 

│ 
Slice Level: No 

 │

│ 
 │ 

│ 
     │

│ 
 │

│ 
 └ Slice Level: A-P 

 │ 
│ 

 │ 
│ 

     │ 
│ 

 └ Grayscale 
Preprocess: (A-P) 

┐ 
│ 

 │  │      │  ┌ ──────── ┘ 
 │ 

│

│ 

 │ 
│

│ 

     │ 
│

│ 

 └ Step: 
1st - 
10th 

┬ 
│

│ 

Slice Level: No 

 │

│ 
 │

│ 
     │

│ 
   └ Slice Level: A-P 

 │  │      ├ Extracted Color(Gray BG) 
 │  │      └ Single Color (Color BG) 
 │  │    
 │

│ 
 └ Trapezoid 

Adjustment : Set 
─ Trapezoid Adjustment Display (Gray image)  

 │

│ 
      ├ 

│ 
Grayscale 
Preprocess: No 

───── ┬ 
│ 

Slice Level: No  

 │

│ 
      │ 

│ 
  └ Slice Level: A-P  

 │

│ 
      └ Grayscale 

Preprocess:  
─Step: 1st - 
10th 

┬ 
│ 

Slice Level: No 

 │

│ 
       (A-P)  └ Slice Level: A-P 

 └ Live ─ Same as “Memory”       
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RUN Menu 
Camera 
No. 

┬ 
│

│

│ 

Memory ┬ 
│

│

│ 

Trapezoid 
Adjustment 
: 
Not set 

┬ 
│ 
│ 
│ 

Grayscale / Color: No (Color image) 

 │ 
│ 

 │ 
│ 

 ├ 
│ 

Converted 
Gray Img. 

┬ 
│ 

Grayscale 
Preprocess: No 

──── ┬ 
│ 

Slice Level: No 

 │ 
│ 

 │ 
│ 

 │ 
│ 

 │ 
│ 

  └ Slice Level: A-P 

 │ 
│ 

 │ 
│ 

 │ 
│ 

 └ Grayscale 
Preprocess:(A-P) 

──── ┬ 
│ 

Slice Level: No 

 │ 
│ 

 │ 
│ 

 │ 
│ 

    └ Slice Level: A-P 

 │ 
│

│ 

 │ 
│

│ 

 └ Extracted 
Color Img. 

─ Extracted Color 
(Bulk / Individual) 

┬ 
│

│ 

White  
(Black 
BG) 

┬ 
│

│ 

Grayscale Preprocess: No 
 │ 

│ 
  

 │

│ 
 │

│ 
     │

│ 
 │

│ 
 ├ 

│ 
Slice Level: No 

 │ 
│ 

 │ 
│ 

     │ 
│ 

 │ 
│ 

 └ Slice Level: A-P 

 │  │      │  └ Grayscale Preprocess: (A-P) 
 │ 

│ 
 │ 

│ 
     │ 

│ 
   ├ 

│ 
Slice Level: No 

 │  │      │    └ Slice Level: A-P 
 │  │      │  
 │  │      ├ Extracted Color(Gray BG) 
 │  │      └ Single Color (Color BG) 
 │

│ 
│ 

 └ Trapezoid 
Adjustment 
:Set 

─ Gray image ┬ 
│ 
│ 

Trapezoid Adjustment 
Display:Yes 

┬ 
│

│ 

Grayscale Preprocess: No 
 │  
 ├ Slice Level: No 

 │      │  │  └ Slice Level: A-P 
 │      │  │    
 │      │  └ Grayscale Preprocess: (A-P) 
 │      │    ├ Slice Level: No 
 │      │    └ Slice Level: A-P 
 │      │    
 │ 

│ 
     └ Trapezoid Adjustment 

Display:No 
─ Same as “Yes” for Trapezoid 

Adjustment Display 
 │          
 ├ Live ─ Same as “Memory” 
 └ NG Image ─ Latest / 

Previous 
─ Same as “Memory”   
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Options 
Memory/Live • Memory: An image stored in a memory for inspection. The image does not change 

even if you cover the lens or uncover it. 
If you want to run a test using the image memory of PV200 or images in 
a SD card in SETUP menu, switch to Memory. 

 • Live: An image changes in real-time. When you cover the lens with your hand, a 
captured image will be darker, while it will be lighter when you uncover it. 
When displaying a live image in RUN menu, the following delay time 
occurs during the time from the input of STRT (inspection) signal to the 
start of image capture. Use "Memory" for objects such as a moving 
object for which the delay in capture timing is not good. 
4-Mega Camera: Max. 63 msec + Shutter speed 
2-Mega Camera: Max. 40 msec + Shutter speed 
0.3-Mega Camera: 

Quad-speed camera (Color, Gray): Max. 9 msec + shutter speed 
Compact camera (Color, Gray): Max. 12 msec + shutter speed 

 
Trapezoid 
Adjustment 
(Available in RUN 
menu only) 
 

You can select this item when performing Trapezoid Adjustment for images.  
 No: Displays an image before executing Trapezoid Adjustment.  

 Yes: Displays an image after executing Trapezoid Adjustment.  
 

For details, refer to “4.3.5 Performing Trapezoid Adjustment (page 
94)”. 

 
Binary You can select this item for an image which contains no color elements and contains 

grayscale information. You may not be able to select this when connecting a color 
camera. 

 • No: When connecting a gray camera, displays an image in 256 gray 
levels captured by the camera. 
When connecting a color camera, displays a grayscale image 
converted from a color image or a color extracted image that 
grayscale preprocess has done. 

 • Slice Level: A binarized image in black and white based on a gray scale image 
displayed when selecting "No". 

 
For details, refer to Chapter 4.6.2 “Binarizing an Image (Slice Level)”, 
page 124. 

 
Grayscale / Color You can select this item when connecting a color camera. However, images on a 

camera for which Trapezoid Adjustment has been set are displayed as gray images in 
SETUP menu. The following switching cannot be performed.  

 • No: Displays a color image captured by a color camera. 

 • Converted 
Gray Img.: 

Converts a color image to a gray scale image in a range of 0 to 255 
using RGB values for each pixel. Changing RGB coefficients enables 
to convert a color image to various gray scale images. 

 • Extracted 
Color Img.: 

Converts RGB values of each pixel to HSV (hue, saturation and 
value) that is better fitted to human sense and extracts colors in a 
specified area. The image will be a gray scale image with the 
extracted colors converted to 255 and the other colors converted to 
0. 

 
Extracted Color You can select this item when selecting "Extracted Color Img." with a color camera.  
 • Color 

Select 
Displays an image extracted by the extraction number that is 
selected by the highlighted checker when the checker list is 
displayed. 

 • Bulk: Displays an image extracted by a specified extraction number of 
eight or sixteen consecutive colors. The number of consecutive 
colors varies depending on the number of connected color cameras. 

 • Individual: Displays an image extracted by a single extraction number.  

 
 

Although a maximum of eight desired extraction numbers can be specified in Checker, the image that is 
inspected in Checker may not be displayed by selection of Bulk or Individual. However, the image that is 
actually inspected can be displayed in each checker setting window. 
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Extraction Display 
Mode 

You can select this item when selecting "Extracted Color Img." with a color camera. 

 • White (Black BG): An image will be a gray scale image with the extracted colors 
converted to 255 and the other colors converted to 0. Gray 
Preprocess can be selected when selecting this mode. 

 • Extracted 
Color(Gray BG): 

Displays extracted colors as a color image on the gray scale 
image converted from a color image (standard). 

 • Single Color 
(Color BG): 

Displays extracted colors on a color image in "Color for Single 
Color". The default color is pink. 

 For details, refer to Chapter 4.3.6 "Selecting Color 
Extraction Mode ”, page112 

 
NG Image  
(only for RUN 
Menu) 

Displays a memory image when the result of a judgement formula registered as Total 
Judgement is "NG". Select from "Latest", "Previous", and "Before the Previous". 

• Latest: Displays an image of the latest NG total judgement. 

• Previous: Displays an image of the previous NG total judgement. 

 
Grayscale 
Preprocess 

A preprocessed image can be displayed when using the function.  When using a color 
camera, it may not be selected depending on the combination of the displays.  

 • No: Displays an image before preprocess. 

 • A to P: To select a Preprocess Group. 

 • Step: 1st to 10th 
(only for SETUP 
Menu) 

Displays an image preprocessed by the set step of the selected 
preprocess group. 
Example) When 10 steps are set in preprocess group A 
 
Selecting "3rd" for preprocess step displays the image 
preprocessed by the 3rd step, and inspects on the image 
preprocessed by the 10th step. 

Selecting Image to Display on Screen Window in SETUP 
Menu (For Gray Camera) 

1. Select “Switch Disp.” from Image menu. 

The selection screen is displayed. 

2. Select Memory or Live in “Memory / Live”. 

3. Select "No" or "Slice Level" in “Binary". 

4. Select "Preprocess". 

The preprocess selecting screen is displayed. 

5. Select a Preprocess group in “Preprocess”. 

Set "Step" under the item when you selected A to P for 
"Preprocess". 

6. Press the CANCEL key. 

 
Now you completed selecting a type of image to display 
in SETUP menu. 

 

 

 

 
When Trapezoid Adjustment has been set for the target camera, an image after trapezoid adjustment 
is displayed. 
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Selecting Image to Display on Screen Window in SETUP 
Menu (For Color Camera) 

1. Select “Switch Disp.” from Image menu. 

The selection screen is displayed. 

2. Select Memory or Live in “Memory / Live”. 

3. Select "No", "Converted Gray Img." or "Extracted Color Img." 
in "Grayscale/Color". 

 
When Trapezoid Adjustment has been set for the target camera, 
an image after trapezoid adjustment is displayed. The following 
items cannot be selected. 

 

The display changes according to the selection in Step 3.  
 No 4. Press the CANCEL key. 

Now you completed selecting a type of image to 
display in SETUP menu. 

 

 Converted Gray Img.  
 

 
4. Select one of the groups A to P in "Grayscale 

Conv.". 

 
 

 5. Select "No" or "Slice Level" in “Binary".  

 

 
6. Select "Preprocess". 

The preprocess selecting screen is displayed. 

7. Select a Preprocess group in “Preprocess”. 

Set "Step" under the item when you selected A to P 
for "Preprocess". 

8. Press the CANCEL key. 

Now you completed selecting a type of image to 
display in SETUP menu. 

 

 Extracted Color Img.  

  
4. Select "Color Select", "Bulk" or "Individual" in 

"Extracted Color". 

5. Select "White (Black BG)", "Extracted Color 
(Gray BG)" or "Single Color (Color BG)" in 
"Extract Display Mode". 

6. When selecting "White (Black BG)" in "Extract 
Display Mode", a preprocess group and a step 
can be set. 
A slice level can be also selected. 

 

 

  
7. Press the CANCEL key. 

Now you completed selecting a type of image to display in SETUP menu.  
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Selecting Image to Display on Screen Window in RUN Menu 
(For Gray Camera) 

1. Select “Switch Disp.” from Image menu. 

The selection screen is displayed. 

2. Select Memory, Live, or NG Image in “Memory / Live”. 

When you selected “NG Image”, then select when the 

NG of the image occurred from “Latest “and “Previous”.  

3. Select "Not Available or "Available" in "Trapezoid 
Adj.". 

 

4. Select "No" or "Slice Level" in “Binary". 
 

5. Select “Preprocess” to set a preprocess group. 
 

6. Press the CANCEL key. 

Now you completed selecting a type of image to display 
in RUN menu. 
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Selecting Image to Display on Screen Window in RUN Menu 
(For Color Camera) 

1. Select “Switch Disp.” from Image menu. 

The selection screen is displayed. 

2. Select Memory, Live, or NG Image in “Memory / Live”. 

When you selected “NG Image”, then select when the NG of the 
image occurred from “Latest “and “Previous”. 
 

3. Select "Not Available or "Available" in "Trapezoid Adj.".  

4. Select "No", "Converted Gray Img." or "Extracted Color Img." 
in "Grayscale/Color". 

An image with the camera for which Trapezoid Adjustment has 
been set is displayed in the screen window as a gray image, and 
the following items cannot be set. 

 

The display changes according to the selection in Step 3.  
 

No 5. Press the CANCEL key. 

Now you completed selecting a type of image to display in RUN menu. 
 

Converted Gray Img. 
 

 5. Select one of the groups A to P in "Grayscale Conv.". 

 

 6. Select "No" or "Slice Level" in “Binary". 

 

 7. Select a Preprocess group in “Preprocess”. 

The preprocess selecting screen is displayed. 

8. Press the CANCEL key. 

Now you completed selecting a type of image to 
display in RUN menu. 

 

 Extracted Color Img. 

  4. Select "Bulk" or "Individual" in "Extracted Color". 

5. Select "White (Black BG)", "Extracted Color (Gray BG)" or "Single Color (Color 
BG)" in "Extract Display Mode". 

6. When selecting "White (Black BG)" in "Extract Display Mode", a preprocess group 
can be set. 
A slice level can be also set. 

7. Press the CANCEL key. 

Now you completed selecting a type of image to display in RUN menu. 
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3.2.3 Zooming In/out Image (Image Menu) 

Displayed camera image can be zoomed in/out. In RUN menu, you can change the size and position of the 
screen. 

 
The magnification and scroll position in RUN menu can be saved as layout information.  

Specifying Magnification (Zoom In/out) 
You can change Magnification between 2% and 400% by 1%. 

Magnification 100% indicates the status displayed in the following size. 
 When using 0.3-Mega Camera: 640 x 480 pixels 

(0.3-Mega Quad-speed Gray Camera / 0.3-Mega Color Camera / 0.3-Mega Compact Gray Camera) 

 When using 0.3-Mega Compact Color Camera: 640 x 478 pixels  

 When using 2-Mega-pixel Camera: 1600 x 1200 pixels 
(2-Mega Gray Camera / 2-Mega Color Camera) 

 When using 4-Mega Camera: 2048 x 2048 pixels 
(4-Mega Gray Camera) 

 

1. Select “Magnification” from Image menu. 

The screen of magnification setting is displayed. 

 
 

 
 

 

2. Tilt the ENTER key up/down to change the 
magnification and then press the ENTER key. 

Pressing the ENTER key displays the image in 
the specified magnification. 
To change the magnification again, press the 
ENTER key. 

3. After setting is completed, press the 
CANCEL key. 



 

62 

B
asic O

peration 
     

C
h. 3 

 

Scrolling 
When displaying a zoomed in image, only a part of image can be shown. To show the nondisplayed part, use 
the scroll function. 

1. Select "Scroll". 

The SHIFT key is activated. 

 
 

 
 

 

2. Tilt the ENTER key to scroll the image. 

The position of the current image in the whole 
image is displayed in the upper screen. Use it to 
make the setting. 

 
 

Pressing the SHIFT key while you operate 
makes the scrolling speed faster. 

3. After displaying a desired image, press the 
ENTER key. 

Displaying Image Full-screen (Full Screen) 
This is the setting to display an image full-screen regardless of size of a screen window. 

1. Select "Full Screen". 

In SETUP menu, the image is displayed in 60% for 0.3-Mega camera, in 24% for 2-Mega camera and 
in 15% for 4-Mega camera. 

 
 

In RUN menu, because the size of screen window varies depending on the layout, the aspect ratio of a 
window might be different from the ratio of an image. In this case, the image will be displayed adjusting to 
the smaller side. 
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3.2.4 Specifying Checker Area 

Set an inspection range and a range excluded from inspection with “Area” function. The inspection range is 
"Inspection area” and the range excluded from inspection is “Mask area”. Area can be set in the following 
shapes. 

Rectangle  
(Plane scan) 

Ellipse Circle Polygon 

  
 

 
(Triangle to 64-gon) 

Line (Line Scan) Broken line Arc  

 
 

 

 

Depending on checker type, some shapes cannot be set. 

Specifying an Inspection Area 

Rectangle (Plane scan) 

1. Select “Rectangle” or “Plane” from “Change Shape” menu. 

2. Select "Change". 

Now you can draw an area. 

3. Move the whole rectangle. 

Tilt the ENTER key to move the whole rectangle. 
Tilt the ENTER key pressing the SHIFT key to move the area by 10-pixel.  
(You can use the SHIFT key also in setting of a start/end point.) 
After moving is completed, press the ENTER key.  

4. Set the start point (a square mark) of the rectangle. 

Move the start point by tilting the ENTER key and press it to determine the 
position. 

 

5. Set the end point (a filled square mark) of the rectangle. 

Move the end point by tilting the ENTER key and press it to determine the 
position. 

 

6. Set the angle of the area. 

Set the angle combining the following methods. 
- ENTER key: Up/Down = Rotates by 1 degree. 
- SHIFT key + ENTER key = Rotates by 0.01 degree. 

 
Press the ENTER key to determine the angle. Now, area setting is completed.  
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Circle/ Ellipse 
To draw a circle, set a start point and an end point of the circumscribed rectangle of the circle. 

1. Select “Circle” or “Ellipse” from “Change Shape” menu. 

2. Select "Change". 

Now you can draw an area. 

3. Move the area. 

Tilt the ENTER key to move the area. 
Tilt the ENTER key pressing the SHIFT key to move the area by 10-pixel. (You 
can use the SHIFT key also in setting of a start/end point.) 

 
After moving is completed, press the ENTER key. 

4. Set the start point (a square mark). 

Move the start point by tilting the ENTER key and press it to determine the 
position. 

5. Set the end point (a filled square mark). 

Move the end point by tilting the ENTER key and press it to determine the 
position. 

 
Now you completed drawing a circle. 

6. Set the angle of the ellipse. 

Set the angle combining the following methods. 
- ENTER key: Up/Down = Rotates by 1 degree. 
- SHIFT key + ENTER key = Rotates by 0.01 degree. 

 
Press the ENTER key to determine the angle. Now, ellipse area setting is 
completed. 

 

 

 

 

Polygon 
To draw a polygon, add vertices to a rectangle. 

Up to 64 vertices can be set. 

1. Select “Polygon” from “Change Shape” menu. 

2. Select "Change". 

Now you can draw an area. A rectangle is displayed when you set an area for the first time. 

3. Move the area. 

Tilt the ENTER key to move the area. 
Tilt the ENTER key pressing the SHIFT key to move the area by 10-pixel. (You 
can use the SHIFT key also in vertex setting.) 
After moving is completed, press the ENTER key. 

 

4. Set the position of a vertex. 

The vertex in a square can be modified. Move the vertex by tilting the ENTER 
key and press it to determine the position. 
The square mark shifts to the next vertex and now you can set the next vertex. 
Repeat this operation until the final vertex.  
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Increasing the Number of Polygon Vertices 

1. Select "Change". 

2. Press the FUNC key at the point where you want 
to add a vertex. 

The menu adding/deleting vertices is displayed. 

3. Select "Add Vertex". 

A new vertex is added about the middle position 
between the currently selected vertex and the next 
vertex. 

 

 

4. Adjust the position of the added vertex. After adjusting is completed, 
press the ENTER key. 

The square mark shifts to the next vertex and now you can set the next 
vertex. Repeat this operation until the final vertex.  

5. Adjust the position of the added vertex. 

Deleting a Vertex of Polygon 

1. Select "Change". 

2. Press the ENTER key repeatedly until the vertex you want to delete turns to be modifiable (the 
square is on the vertex). 

3. Press the FUNC key. 

The menu adding/deleting vertices is displayed. 

4. Select "Delete Vertex". 

The vertex you selected is deleted. 
 

The square mark shifts to the previous vertex. Press the 
ENTER key and adjust vertices  
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Line Scan 

1. Select “Line” from “Change Shape” menu. 

2. Select "Change". 

Now you can draw an area. 

3. Move the area. 

Tilt the ENTER key to move the area. 
Tilt the ENTER key pressing the SHIFT key to move the area by 10-pixel.  
(You can use the SHIFT key also in setting of a start/end point.) 

 

4. Set the start point (a square mark). 

Move the start point by tilting the ENTER key and press it to determine the 
position. 

 

5. Set the end point (a filled square mark). 

Move the end point by tilting the ENTER key and press it to determine the 
position. 

 

 
 
 
 

Modifying an Inspection Area (when adding a mask 
area) 

When a mask area is set, the inspection area to edit is needed to select. 

1. Select "Change". 

The inspection area is displayed in orange. 
Tilt the ENTER key upward/downward to display the area you want to edit in orange and press the ENTER 
key. The area will be modifiable. 

2. Press the ENTER key to select the inspection area. 

3. Edit the inspection area. 

4. After editing is completed, press the CANCEL key. 
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Setting a Mask Area 
Up to 16 mask areas, where checker does no inspection, can be set in an inspection area. (Some checkers 
cannot set a mask area. For details, see the descriptions of each checker.) 

 Setting a Mask Area  Inside mask area is 
excluded from inspection. 

 

Adding a Mask Area 

1. Select "Add Mask" in “Area Setting”. 

2. Select a mask shape to add. 

3. Select "Change". 

The inspection area is displayed in orange. 

4. Tilt the ENTER key upward/downward to display the area in orange. 

5. Draw a Mask Area 

For details, refer to page 63, “Drawing an Inspection Area”. 

6. After drawing is completed, press the CANCEL key. 

Editing a Mask Area 

1. Select “Change” in “Area Setting” window. 

The inspection area is displayed in orange. 

2. Tilt the ENTER key upward/downward to display the area in orange and press the ENTER key. 

3. Edit a Mask Area. 

For details, refer to page 63 “Drawing an Inspection Area”. 

4. After drawing is completed, press the CANCEL key. 

Deleting a Mask Area 

1. Select "Delete Mask" in “Area Setting”. 

The mask area is displayed in orange. 

2. Tilt the ENTER key upward/downward to display the area to delete in orange. 

3. Press the ENTER key. 

The mask area will be deleted. To delete plural mask areas, repeat this operation. 
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3.2.5 Copying the Screen Display (Print Screen) 

In almost screens, whether RUN menu or SETUP menu, the contents displayed on the entire screen can be 
copied and output to a SD card. The images are saved as bitmap. 

Destination can be changed to Ethernet to save the images directly into a PC. 

1. Display an image to copy. 

2. Hold down the FUNC key for two seconds or more. 

In the key guide field, a message of “PRINT SCREEN” appears and the screen is copied. 
When the message disappears, printing the screen is complete. 

 
 

If the message does not appear in the key guide area, an image cannot be copied in the current screen. 
When an image is copied in the full-screen layout, you cannot see the result as the key guide area is not 
displayed. Note that the copied image may not be saved due to the condition of the destination to output 
(SD memory card or Ethernet). 

About Image File Name 

Example of file name: 071215_150848_0.bmp 
 

Saving image file name consists of date; 6-digit (YYMMDD), time; 6-digit (HHMMSS), and image number; 
1-digit (N). Between each of the information, “_” (underscore) is inserted. 

 Date and Time: 
Calendar data of PV200 

 Image number:  
0 to 9. Numbered consecutively within the same second 

About Image File Format 

File format: Bitmap 

Image size: 640 x 480 pixels 

Color depth: 24 bits 

About Save Folder of Image Files 

For SD card: /Panasonic-EW SUNX Vision/PV200/Screen 

For Ethernet: Specify with Image Receiver. 

Changing Destination of Image Files 

1. Select “ENVIRONMENT” >  “INPUT / OUTPUT” from the menu bar. 

The screen of communication setting is displayed. 

2. Select "Print Screen". 

3. Select "Destination". 

SD card (default): Saves in the SD card inserted in PV200. 
Ethernet: Outputs to Ethernet. Saves in devices such as a PC connected with an Ethernet cable. 
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3.2.6 Displaying Print Screen Images on Monitor 

Captured print screen images and images which meet the following conditions are displayed on th e 
monitor when the operation stops. The print screen images can be displayed and confirmed from a SD 
card in the PV without a PC. The order of display depends on the file system. 

 

File that can be displayed 
File format: Bitmap 
Image size: 640 x 480 pixels 
Color depth: 24 bits 
Source folder name: Arbitrary (Two-byte and one-bytes characters are possible.) 
Displayed file name: Arbitrary (Two-byte and one-bytes characters are possible.) 

[Reference] 
Folder in which PV200 captures screen shots and saves: ¥Panasonic-EW SUNX Vision ¥P200/Screen 
Image name which PV200 captures the screen shot: YYMMDD_HHMMSS_N.bmp (Refer to the 
previous page.) 

 

The monitor when a screen shot is displayed 

 
 

1 File Name Displays the file name of a print screen image. 
 

Height of display area: 38 
pixels 

 

2 No. of counts Displays the number of images which are currently 
displayed and the total number of images. 

 

 

3 Key guide Displays the operation keys when a print screen image 
is displayed. 

: 41 pixels 
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In SETUP menu 

1. Press the F1 key and select "Print Screen 
View". 

 

   

2. Select a folder in which images are saved. 

The list of the folders and files in the SD card is 
displayed. See the key guide on the bottom of 
the monitor for information on how to use the key 
pad. 
Highlight the target folder with the cursor, 
and press the F1 key. 
The location of the folder currently selected is 
displayed in "Path" field. 
Folder selected when the print screen view is 
opened for the first time: ¥Panasonic-EW SUNX 
Vision¥PV200¥Screen 
 
- To go up to the upper hierarchy, 

select “..”. 
The <dir> in "Size(KB)" column indicates that it 
is a folder. 
 
- If the ENTER key is pressed after 

selecting a file, that image will be 
displayed. (The right figure shows the case 
when the ENTER was pressed. The image 
names in the Screen folder are displayed in 
the list.) 

 
 

PV200 memorizes the path at the time Print 
Screen View was opened, therefore, the path 
previously selected is selected when opening the 
"Print Screen View" window. At that time, the 
cursor is located on the first line "." of the list. 
This indicates "Folder that is currently selected". 
I the read image is saved in this folder, press the 
F1 key. Pressing the ENTER key on "." also does 
not change the path. 
Press the "Update" button to update the list. 
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3. Print screen images are displayed on the monitor. 

F1 key Auto play images and stop. 

The time interval for auto play is two seconds. It will automatically stop 
after the last image is displayed. 

F2 key Go to the next image. 

F3 key Back to the previous image. 

CANCEL key Exit Print Screen View, and back the "Select Folder" window. 
 

 
 When no print screen image exist in the 

folder, the right error message appears. 

 

 When a file that cannot be read is selected at 
the above step 2, the right error message 
appears. 

 
In RUN menu 

1. Stop the operation when it is operating. 
Select "OPERATION" > "Stop RUN Mode" to 
stop the operation. 

 

2. Press the F1 key and select "Print Screen 
View". 

 

 
 

 
The print screen view is only available when 
operation stops. 
The right error message appears by executing 
the print screen view during the operation.  

3. Select a folder in which images are saved. 

See the step 2 in the case of SETUP menu. 

 

4. Print screen images are displayed on the monitor. 

F1 key Auto play images and stop. 

The time interval for auto play is two seconds. It will automatically stop 
after the last image is displayed. 

F2 key Go to the next image. 

F3 key Back to the previous image. 

CANCEL key Exit Print Screen View, and back the "Select Folder" window. 
 

 
 When no print screen image exist in the 

folder, the right error message appears. 
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 When a file that cannot be read is selected 
at the above step 2, the right error message 
appears. 

 

Introduction of convenient use (It can be used as a 
procedure manual for settings.) 

If images that can be displayed with Print Screen View (described on page 69) are saved in an SD card in 
advance using PC software, the SD card can be used as a procedure manual for settings as shown below.  
Name the source folder or files to be read such as "Manual", which distinguishes them from other print 
screen images. It enables you to recognize them easily. 

 
Example) When bitmap files which indicates the checker setting procedure and "Print Screen View" 
is executed 
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Chapter 4 
 Setting Inspection Conditions 
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4.1 Procedure for Setting Inspection 
Set the inspection conditions in SETUP menu in the following order. 

 

Select a product type No. （Type Switch） 
 

Page 75 

  

Set camera type and capturing conditions 

*: Adjust White Balance first when using a color camera. 

(ENVIRONMENT > Camera, TYPE > Type Setting) 

page 79 

  

Select Execution Mode condition  
(TYPE > Type Setting) page 113 

  

Capture an image page 122 

  

Preprocess the image to be appropriate for inspection 

Slice Level, Grayscale Preprocess, Color Preprocess 
page 123 

  

Set an inspection 

Checker, Position Adjustment, Area Size Adjustment 
page 139 

  

Calculate the measured data 

- Geometry Calculation 

- Numerical Calculation 

 

page 286 

page 307 

  

Total Judgement 

Judgement 
page 324 

  

Display detection results with figures or characters on the screen 
window 

Character/Figure Drawing 
page 339 

  

Output Settings 

Output judgements, calculated data, and images 
page 434 

  

Save settings (Save, Read) 

Save in the save memory of PV or a SD memory card 
page 381 

 

Set as necessary. 

Display inspection results during inspections and change the setting 
values* (Data R/W) 

(* The settings of checkers, numerical calculations, and judgements) 
page 386 

 

Display a fixed shape on the screen window 

Marker Display 
page 406 

 

Set a special menu for adjustment. 

Select Menu 
page 406 
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4.2 Selecting a Product Type No. 

4.2.1 What Is a Product Type? 

Product Type is a group of settings which are necessary to execute an inspection such as image capturing 
setting of camera, and conditions of inspection area and inspection method. Multiple types can be registered. 
You can continue inspections only by switching to (calling up) the registered type if you need to inspect on the 
object with different conditions. 

Regarding types No.0 - 255 as a set of data, PV200 saves the data in "Storage Space in PV200". The data can 
be saved also in a SD memory card. Up to 100 sets of data can be saved in a SD memory card. 

 

Every time PV200 starts up, it reads saved data from the storage space in PV200 to the execution memory.  

And, it calls up a product type (*1 from it to set inspection conditions and execute inspections.  

Type switching, data calling up to the execution memory, and data saving from the execution memory to the 
storage space in PV200 or a SD memory card can be executed by inputting I/O signal or sending a command 
from an external device. 

 
Storage Space in PV200 

(Max. 8 MB) 
 Execution Memory  SD memory card (Max. 32 GB) 

/Panasonic-EW SUNX 
Vision/PV200/SetData 

 

 
 *1) About how to specify a type to read at startup, see page 76. 

 About how to save/read the setting data, see chapter 4.18 (page 381) 

 
If the data amount of types reaches to the maximum capacity of the setting data area, not all of 256 types may 
be created. You can confirm the free space of the storage space in PV200 in "Free Space for Setting Data" from 
"TOOL" > "Information". (page 473). 
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4.2.2 Selecting a Product Type 

Adding/switching a Product Type 

1. Select "TYPE" > “Select Type” from the menu bar. 

Type selecting window is displayed. 

2. Select a product type No. 

The selected type No. is displayed in the “Current 
Type No.” field. 

 
Selecting a type with blank Type Title field adds a new 
type. In this case, input a title as the following 
procedure. 

 

 

3. Press the FUNC key and select “Enter Title” from the displayed menu. 

A software keyboard is displayed. 

4. Enter a title and select “Enter” on the keyboard at the last. 

The entered title will be displayed in “Type Title” field. 

Setting a Type to Be Read at Startup 

The type to be read at PV200 startup can be specified. This setting can be operated from ENVIRONMENT, and 
also the type switching window. If you change the setting in the window, the setting of ENVIRONMENT is also 
updated. 

1. Press the FUNC key in the Type selecting window.  

The pop-up menu appears. 

2. Select “Type No. at Startup”. 

The last Type No. (default): 
Reads again the type selected right before turning off 
the power. The setting is done if you select this. 
Selected Type No.: 
Reads the type No. specified after. 

 

3. Specify “Selected Type No.”. 

4. After setting is completed, press the CANCEL key. 

5. Save the data. 

About how to save it, see page 381. 
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Copying Product Type 

1. In type selecting window, move the cursor onto the product type which you want to copy. 

2. Press the FUNC key and select “Copy” from the 

displayed menu. 

3. Move the cursor onto the destination product type. 

4. Press the FUNC key and select “Paste" from the 

displayed menu.  
The copied type is pasted. 

 
If the type already exists in the destination, the message of overwrite confirmation appears. 

Reading and Referring Type from SD  
A certain type can be read and referred from the setting data saved in a SD memory card. 

There are following restrictions on the setting data that can be read. 
When data cannot be 
read: 

• The camera type of PV200 and that in the setting data to be read are different. 
• The version of the setting data to be read is higher than that of PV200.  
• "Template Registration" is set to "Common" in PV200. 
• The size of the setting data to be read exceeds the free space of PV200.  

When a part of the 
read data changes: 

• When "Common Setting" is set to "Yes (Common)" in the setting data to be 
read, all the items set in "TYPE" > "Type Setting" > “Camera" are read as the 
common settings of PV200.  

• The setting data in which "Template Registration" has been set to "Common" is 
read as "Per Checker". 

• When "Inspection Process" is set to "Parallel" in PV200 and reading the setting 
data in which "Camera Trigger" is set to "Detect Trigger", "Camera Trigger" is 
read as "Common". 

 

1. In type selecting window, move the cursor onto the product 
type number to which you want to write data. 

2. Press the FUNC key and select "Read Type No. in SD" from 
the displayed menu.  

3. Select the area number to read. 

 
 

When the setting data in the specified area number is password-protected, the password is requested. 
 

4. Select the type number to read. 

5. Select “Yes” following the displayed message. 

The type is read. 
If you select "No", reading is not executed. 
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Deleting a Product Type 

1. In type selecting window, move the cursor onto the product type which you want to delete. 

2. Press the FUNC key and select “Delete” from the displayed menu. 

3. Select “Yes” following the displayed message. 

The type is deleted. If you select “No”, deleting is not executed. 

Deleting All Product Types 
All crated product types can be deleted at a time. When “Template Registration” is set to “Common”, you can 
select execute or not separately for initializing all types and clearing all common templates. 

 Note that once you initialize all types, you can never restore them. 

1. Select "TYPE" > “Initialize” from the menu bar. 

The message confirming initialization appears. 
If you select “No”, initialization is not executed. 

2. Select “Yes”. 

After all types are initialized, “Type No.000” is newly created.  

When “Template Registration” is set to “Common” 

1. Select "TYPE" > “Initialize” from the menu bar.  

The window to choose whether to initialize all types or not is displayed. 

2. To initialize all types, select “Yes”. Not to initialize them, select “No”.  

Selecting “Yes” initializes all types at the time. 
The window to choose whether to clear all common templates or not is displayed. 

 

3. To delete all common templates, select “Yes”. Not to delete them, select “No”. 

The table below shows the data that are initialized (or deleted) by selecting the option of the windows. 
 

Initializing all 
types 

 Deleting all 
common template 

Data initialized or deleted 

No & No None 
No & Yes Common templates 
Yes & No All types 
Yes & Yes Common templates and all types 
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4.3 Setting Capturing Conditions of Camera 
Set conditions of capturing an image of an object. Obtained images vary depending on the following "Camera 
Type" and capturing conditions of each camera. Make the camera settings before making the settings for 
inspection. 

 

Camera Type: 

Two cameras of seven types can be connected. Set a type of camera for each connecting camera ports. 

However, PV200 MC can only be connected with 0.3-Mega compact cameras (Gray, Color). 
 

Camera Trigger: 

PV200 captures images simultaneously by all cameras. You can select Common Trigger or Detect Trigger. 
Selecting Common Trigger starts an inspection at the time all cameras finished capturing. Selecting Detect 
Trigger starts an inspection after PV200 detected that an object is in the inspection area.  

 

Capturing Condition for Each Camera 
 Shutter speed: page 83. 

 Camera gain: page 83. 

 Capture delay: page 89. 

 FLASH delay, FLASH span: page 91. 
 Partial imaging: page 92. 

 Trapezoid adjustment: page 99. 

 Calibration: page 99. 

 White Balance: page 84. 
 

Error if Checker Area outside Image: 

This function cancels the checker when its area is outside a captured image. 

 
On camera trigger, capturing condition of camera, and the error if checker area is outside the image, you can 
set individually for each type other than using common setting. 

4.3.1 Selecting a Camera Type (ENVIRONMENT)  

PV200 provides for seven types of cameras and can connect two cameras. Set a type of camera connecting to 
each camera port. (Note that some cameras cannot be used in combination as shown in the table below. 
PV200 MC can only be connected with 0.3-Mega compact cameras (Gray, Color).) 

 
 When you use just one camera, be sure to connect it to "CAMERA 0".  

 Image transfer time varies depend on camera. (Refer to page 16 for details.) 
 

 CAMERA 1 
Gray Color 

0.3M 2M 4M 0.3M 2M 

CAMERA 0 
Gray 

0.3M OK OK NG OK OK 
2M OK OK NG OK OK 
4M NG NG OK NG NG 

Color 
0.3M OK OK NG OK OK 
2M OK OK NG OK* OK 

 

 
Adjust White Balance first (refer to page 84) when using a color camera. When using two color cameras, 
adjust the white balance for each camera. Readjust the white balance when you replaced the color camera 
or changed the camera port to connect. 
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Selecting a Camera Type 

1. Select “ENVIRONMENT” >  “Camera” from the menu bar. 

2. Select "Camera". 

Camera setting window is displayed. 
PV200 recognizes the connecting cameras at startup and displays their types in “Connected Camera” field. 

3. Confirm that the types for “Connected Camera” and “Camera Type” are the same. 
If they are different, select a correct camera type in “Camera Type”. 

The confirmation message appears. Selecting “Yes” changes the camera type. 
 

 
- If the types for “Connected Camera” and “Camera Type” are different, an image cannot be captured 

correctly. 
- Changing camera type initializes capturing conditions of cameras. It is advisable to set the correct 

camera types before setting capturing conditions.  
- From Ver.2.0, the camera type can also be changed from the menu "TYPE" > "Type Setting" > 

"Camera". 

Setting Polarity of FLASH Signal 
PV200 sends a FLASH signal which notices the timing of light emission to a strobe lighting. Two terminals 
(FLASH 0-1) are provided for two cameras. The polarity of the FLASH signals can be selected for each camera. 

1. Select “FLASH Polarity”. 

2. Select polarity of FLASH Signal. 

“ON at Low” (default): Turns on FLASH signal along with the timing of image capturing. 
“ON at High”: Turns off FLASH signal along with the timing of image capturing. (In other cases, the signal is 
ON.) 

 
The span of Flash signal ON and the delay time to ON can be set for each Type and Camera. 
Refer to Chapter 4.3.4 for how to set them. 

4.3.2 Setting Individual Capturing Condition by Type 

Follow the procedure described below to set an Individual capturing condition for the type which is currently 
being set. 

1. Select "TYPE" > “Type Setting” from the menu bar. 

2. Select "Camera". 

3. Select "No (Individual)" for “Common Setting”. 

Now, the setting you are going to set applies only to the currently setting type. 

To return to Common Setting 

1. Select “Type Setting” > "Camera". 

2. Select "Yes (Common)" for “Common Setting”. 

If the type set to use common setting already exists, the setting condition of the type will be copied to or 
overwritten the current type. 
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4.3.3 Selecting Capture Timing (Camera Trigger) 

"Common Trigger" is the trigger starting image capturing with two cameras simultaneously.  

PV200 cannot give the instruction to capture an image to each camera respectively, however, setting "Capture 
Delay" enables to vary the timing of image capturing for the two cameras. 

 

 Processing image of “Common Trigger” 
(when Capture Delay is not set) 

 

 
 

 Inputting START signal starts capturing an image. 

Although image capturing times are different when connecting different types of cameras, 
checkers and result output are executed after all cameras have completed image capturing. 

1. Set “Camera Trigger” in “Camera” window. 

[Common] (default): All cameras capture images at the same timing. 

[Detect Trigger (common)]: All cameras capture images at the same timing. If Position Adjustment 
No.0 is OK, other checkers are executed and results are output. Until 
Position Adjustment No.0 becomes OK, image capturing and Posit ion 
Adjustment No.0 will be executed repeatedly. 

 

About Detect Trigger (common) 

This function detects an inspect target inside 
the inspection area with Position Adjustment 
No.0. It repeats image capturing and execution 
of Position Adjustment No.0 until the Position 
Adjustment detects the target (Judgement = 
OK), and then other checkers are executed 
and results are output. (“Execute inspection” in 
the figure on the right.) 
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In Continuous Inspection 

After an inspection is complete, the device 
executes image capture and Position Adjustment 
No.0 again. 

The next inspection is not executed if the 
following judgement of Position Adjustment No.0 
is "OK" (No.4 in the right figure).  

After "NG” judgement of Position Adjustment 
No.0 is returned by reasons such as the firstly 
inspected object moving out of the area (No.5 in 
the right figure), "OK” judgement of the checker 
executes the next inspection in the same way as 
the first inspection. 

 

 
How to set Continuous Inspection: See page 432. 

 
 When execution mode is “User Defined”, 

the Position Adjustment of the smallest 
number in the execution block is executed 
repeatedly. 
For example, Position Adjustment No.200 
for block No.2 and Position Adjustment 
No.900 for block No.9. 

 When Inspection Process mode is 
“Parallel”, Detect Trigger cannot be used.  

4.3.4 Setting Capturing Condition for Each Camera 

Selecting Camera to Set 

Various settings such as "Shutter Speed", "Capture 
Delay" or "FLASH Delay" are specified for each 
camera. Switch target camera numbers as follows. 

1. Select "TYPE" > “Type Setting” from the 

menu bar. 

2. Select "Camera". 

Camera setting window is displayed. 

3. Select "Camera No. to Set". 

Camera No. which can be used is displayed. 

4. Select the camera No. to set the capturing 
condition. 

The camera type set to the selected camera 
No. is displayed in “Connected Camera”. 

 
From Ver.2.0, the camera type can also be 
changed from the menu "TYPE" > "Type 
Setting" > "Camera". 
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Setting Shutter Speed 
Specify shutter speed to suit for moving speed of the inspection object or lighting conditions. The shorter 
shutter speed (the smaller value), the darker captured image. Adjust lighting luminance or lens aperture as 
necessary. To set the shutter speed observing the image, set the display image to "Live". 

1. Select the camera No. to set in “Camera” window. 

2. Select "Shutter Speed". 

Now you can specify a value of shutter speed. 
Range of shutter speed: 
Except for Compact Gray Camera 

0.03 - 1000.00 ms (default: 10.00) 
0.3-Mega Compact Camera (Gray, Color) 

0.10 - 500.00 ms (default: 10.00) 
 
 
Setting unit: 0.01 ms 

 

3. Select desired shutter speed. 

To observe the image easily, set “Window Transparency (SETUP menu)” to a larger value. 

Adjusting Camera Gain 

What is Hard Gain? 

Hard Gain is the setting for adjusting light intensity within a camera. As increasing the value, an image 
turns to be lighter. As light intensity is adjusted before loading an image into PV200, a shutter speed can 
be set shorter by increasing the hard gain value.  

What is Soft Gain?】 

"Soft Gain" is the setting for changing the 
brightness captured by a camera element to 
gray values for inspections 0 to 255. 
Although the gray values treated in inspections 
of PV200 are 0 to 255, each element of CCD or 
CMOS in cameras captures brightness with 
higher accuracy and generates images. It is 
possible to specify the range of camera gray 
values used for inspections by setting the 
values of Soft Gain. 

 
For details, refer to page 85 “Setting Gain 

. 
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1. Select the camera No. to set in “Camera” window. 

2. Press the setting button of "Gain Setting". 

"Hard Gain" window is displayed. 

3. Set "Hard Gain" value. 

- Setting range of Hard Gain: 0 to 48 
- Default: 0 
- Setting unit: 1 

 

 
"Hard Gain" setting is available only for Compact camera 
(ANPVC5030 and ANPVC6030). 

 

4. Set "Soft Gain" value. 

- Setting range of Soft Gain: 1.00 to 15.00                                 
- Default: 0 
- Setting unit: 0.01 

 
 

Setting the display image to “Live” updates it to the image 
captured with the specified gain value. To observe the image 
easily, set “Window Transparency (SETUP menu)” to a larger 

value. 

 

5. Select "Offset".  

It can be set for gray cameras. 
- - Offset Range: 0 to 1000 (Initial Value: 0) 

 
For details, refer to page 86 “”. 

6. Select "Corr. Setting". 

Adjust the color information (grayscale values for gray cameras) of the image captured by the camera 
and inspect the image. 

7. When using a color camera, adjust R, G, B of the image converted by the filter in "Select RGB" 
further. 

When using a gray camera, adjust the level of grayscale value. 
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Setting Gain 

Camera gain indicates the sensitivity of camera. Setting it to larger, an image gets brighter. Setting it to 
smaller, the contrast of an image with a small gray range becomes stronger.  On the other hand, it will be 
sensitive to the variation of the brightness surrounding the work if the gain value is increased, and the 
image will be rougher due to increased noises. 

Adjust Hard Gain or Soft Gain when you cannot obtain a desired image even though you have adjusted 
lens aperture and lighting illuminance. 

 

 

The range of gray values used for 
inspections is determined by the 
setting of soft gain values. 
 
As shown in the left figure, the 
ranges where the squires are 
located are different between the 
cases that "the upper and lower 5% 
of camera gray values are not 
used" and "only 90% of darker data 
is used", however, the both 
percentages of the usage of camera 
gray values are 90%. In the both 
cases, the gain to be set is 90%. 
[Offset] is provided among the 
items to determine the positions of 
these squares. For details, refer to 
"Offset". 

 
Image data (10-bit) loaded in a camera has a value in the range of 0 to 1023. This value is a camera gray 
value. As PV200 performs image processing with 8-bit gray images in the range of 0 to 255, inspection 
images are converted to data in the range of 0 to 255. Soft Gain is a value which indicates the conversion 
rate of camera gray value. 
 

How to calculate soft gain value 
- Setting range of soft gain: 1.00 to 15.00  
- Default: 1 
- Setting unit: 0.01 

 

Soft gain = 4 x Max. value of PV200 gray value / (Max. value of camera gray value x Usage ratio) 
(255 fixed)                   (1023 fixed) 

- When using 100% of camera gray value 

Soft gain = 255 / 1023 x 4 
 = Approx. 1.00 

- When using 50% of camera gray value 

Soft gain = 255 / (1023 x 0.50) x 4  
= Approx. 2.00 

 

 

 

 
* Unused camera gray values, 513 to 1023, are 
replaced with 512. 

: 256-tone width = Gray value used for inspections in PV200. The range of brightness of this 
square is 0 to 255. 
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[Details] 
Camera gray values will be more compressed when setting a smaller soft gain, and they will be close 
to camera gray values when setting a larger soft gain. A part of the created gray values in progress is 
used for inspections as inspection gray values. The position where they are used as inspection gray 
values are set by "Setting Offset" (page 86) described in the next chapter. 
 

Setting Offset 
 
What is Offset? 
Set which brightness in camera gray values is used as 0 for inspection gray values when converting 
the camera gray values to the inspection gray values (0 to 255). 

 

The brightness in the camera gray values (in the range of 0 to 
[Offset]) is regarded as 0 for the inspection gray value. 

 

Set a larger value to inspect brighter part by limiting the brightness of 
dark parts. 

 

Offset setting range: 0 to 1000 (Initial value: 0) 
 
 
[Indication of setting] 
Specify the range that is not used for inspection. 
To make the data for 5% of darker parts be 0, set 50. 
(Value 1 is equivalent to 0.1%.) 

Example) Even when the usage range is the same as shown in the above figure, change the offset 
values when the upper and lower positions are different. For the left case in the figure, set the offset 
value to 50 "not to use the upper and lower 5% of data". For the right case, set the offset value to 0 "to 
use only the data for 90% of darker area". 

 
 
A larger gain is set, the whole image will be brighter. 
By setting [Offset], noises in the area that camera gray value is small can be removed. If it is set too large, 
the camera gray value below the offset will be 0, and the image will blur from the darker part. Set the value 
carefully checking the image. 

Offset: Small  Large 
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Difference in images set by Gain and Offset 
 
Variation in image brightness when setting "Soft Gain" and "Offset"  
 

Offset 
 

Soft Gain 
0 20 50 100 200 

1.00 

     

2.00 

     

3.00 

     

4.00 

     

5.00 

     
 
・Variation in image brightness when setting Hard Gain (Soft gain value is fixed)  
 

Hard Gain Soft gain 1.00 (Fixed) 

0 

 

12 

 

24 

 

32 

 

48 
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Adjusting White Balance of Color Camera 
Even a white object may be recognized as a color tinged with orange or red depending on irradiated 
lighting. Adjusting the white balance corrects the variation in colors due to the lighting used, and mak es a 
white object be viewed as white. However, when using a light such as red, blue or green, for example, it 
cannot correct a white paper that appears tinged with red due to a red LED light to white.  It is necessary to 
make the setting for using a color camera.  

1. Select the camera No. to set in “Camera” window.  

2. Select "White Balance". 

White Balance window is displayed. 
Take a white object (such as a white paper) with the camera. 

 

3. Select "Area Setting". 

Set the rectangular area displayed on the screen window in the 
white area. 

 

 

 

4. Select "Auto Adjustment". 

 

5. The message as the right figure appears. Select “Yes”. 

Auto adjustment starts. 
When the adjustment is completed successfully, a message 
"Auto Adjustment is completed." is displayed. 
Values are displayed in Gain R, G, and B. 
When one of the following messages appears, the adjustment is 
not completed successfully. Perform Auto Adjustment again. 
- Too Bright. Adjust Brightness. 
- Too Dark. Adjust Brightness. 
- The brightness cannot be adjusted. Move the area to a white 

space. 
 

- "Auto Adjustment" is performed with the brightness of "Soft 
Gain" which is set to 1.00 from "TYPE" >  "Type Setting" > 
"Camera" > "Gain Setting" as a base. For dealing with the 
above message, it is easy to confirm the brightness by setting 
"Soft Gain" to 1.00 once. 
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6. If further adjustment is required after the completion of auto 
adjustment, directly set the values of gain R, G, and B. 

Settable Range: 1.00 to 15.00 
 

To convert the brightness captured with a camera (1024 levels) to 
the brightness of an inspection image (256 levels), "Gain Setting is 
provided which is set from "TYPE", > "Type Setting" > "Camera". 
When using a color camera, it is possible to set a different 
sensitivity for each RGB component by adjusting the gain of each 
component in "White Balance". 

 
7. Set Offset as necessary.  

Offset can be specified for each RGB component. 
Settable Range: 0 to 1000 

RGB Gain and Offset 
The "White Balance" menu is used for making a white object look whiter by setting the average gray values 
of RGB to nearly 1:1:1 as shown in the result of the above "Auto Adjustment". Besides, inspections can be 
conducted with a different sensitivity for each component (R/G/B) by changing the RGB gain or offset. For 
example, when comparing the difference in red component between two objects in Color Window checker 
and if the difference is too small to distinguish, it is possible to expand the difference by changing the R 
gain value of "White Balance" larger. 
However, as a result of changing the gain of a specific component, the function which "makes a white 
object look whiter" becomes enabled. 
 
For adjusting the sensitivity when using color cameras, use the RGB gain and offset of each component in 
[Soft Gain] and this function [White Balance] described in page 84.  
Although "Soft Gain" is a common gain to each RGB component, it is possible to make the difference in 
luminance clear for a specific component by adjusting "RGB Gain" of each element in "White Balance". 
 
Example) The following figures show the measurement process of each red component with Color 
Window checker. 

Gain（R,G,B）=(1.10,1.00,1.86) 
Offset (R,G,B) =(0,0,0) 

 

Change 
R gain 

 
 

 

（R,G,B）=(2.10,1.00,1.86) 
Offset (R,G,B) =(0,0,0) 

 
Difference in red component = 9  Difference in red component = 17 

The difference is larger than that with the left gain. 
At the same time, the background white part 
becomes reddish. 
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[Concept] 
A color camera recognize each brightness of RGB as 0 to 1023 and 1024 levels. PV200 uses this 
information in inspections converting them to 256 levels (0 to 255). "Soft Gain" and RGB gain are related to 
this conversion. The "Soft Gain" setting is common to RGB, which determines how much data among 1024 
levels is reflected in an inspection image. The usage ratio is also adjusted for each element in RGB Gain. 
 
The following is the calculation of the gain for converting the brightness captured with a camera to an 
inspection gray value. 

 
Gain value of each component (RGB) for converting to an inspection image: GAIN = [Soft gain] x [Gain of 
each component] 
However, when [Soft gain] x [Gain of each component] is larger than 15, PV200 processes as the gain is 
15. 
 
For conducting an inspection with a sensitivity close to the camera sensitivity, set "Soft Gain" and Gain of 
each component" to make the above GAIN larger. For setting a different sensitivity for each RGB 
component, change the gain value of each component. Make the gain of the component to be acquired 
more sensitively large. When there is no need to set a different sensitivity for each component, use "Soft 
Gain" for adjustment. 
 
Example) When Soft Gain = 2, Gain in White Balance (R, G, B) = (2, 1, 1)  

R Gain = 2 x 2 = 4 
G Gain = 2 x 1 = 2 
B Gain = 2 x 1 = 2 

 
According to the concept described in page 85, when the R gain is 4, the usage ratio of camera gray 
value is calculated as follows;  
Usage ratio of camera gray value = Max. camera gray value ÷ (4 x Max. gray value of PV200 x Camera 
gain) = 1024 ÷ (4 x 255 x 4) = Approx. 0.25 
As a result of this, 25% of data among camera gray values are converted to 256 levels used for 
inspections. 
When calculating using the gains of G and B components as 2, each usage ratio of G and B components is 
0.5. As a result, 50% of data among the 1024 levels of camera luminance is used, which is 512 levels. As it 
is converted to 256 levels for inspections, it is compressed to half. Two levels of camera sensitivity is 
equivalent to one level of an inspection image. 
When the gain of R component is 4, 25% of camera luminance is used, so 256 levels of camera luminance 
are used. As it is converted to 256 levels for inspections and one level of camera sensitivity is equivalent to 
one level of an inspection image, an image with the same sensitivity as cameras can be obtained. 
The image of the R component of which the gain is 4 has a sensitivity two times higher than that of the G or 
B component of which the gain is 2. As it is more sensitive to brightness and easily influenced by noises, 
adjust checking the inspection result. 

 
Setting example of Gain and Offset (when Gain is 4 or 2 from the 
above calculation) 

Range of use of camera 
luminance of each component 

 

 
Gain and Offset can be 
adjusted for each component. 

Make the offset large for making the difference in gray level of an 
inspection image large for the area of which the camera gray value is large 
(bright), and make the offset small for making the difference in dark areas 
large. 
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Setting Delay Time from START Signal Input to 
Image Capture 

Specify the time after inputting START 
0-3 signals before cameras start 
capturing. Default value is “0”. After 
signal input, the camera starts image 
capture without delay. Use it as 
necessary. 

This setting can be set individually for 
each camera.  

(Processing image when 2 cameras are connected.) 

1. Select the camera No. to set in “Camera” window. 

2. Select "Capture Delay". 

3. Specify the time from START signal input to capture start. 

Settable range: 0.0 to 999.9 ms 

Setting FLASH Delay and Pulse Output Width 
After inputting START signal, light emission timing signal is output from FLASH 0-1 of I/O connector to external 
strobe flash in pulse. Specify output delay of FLASH signal and outputting pulse width. 

1. Select the camera No. to set in “Camera” window. 

2. Select “FLASH Delay”  and specify delay time. 

Settable range: 0.0 to 999.9 ms 

3. Select “FLASH Span” and specify pulse width of FLASH signal. 

Settable range: 0.2 to 999.9 ms 
 

 
The lighting is needed to be lit while the camera is capturing an image. Set them correctly along with 
Capture delay of the camera and Shutter speed. 

 
 

FLASH signal timing chart: Page 568. 
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Capturing a Part of Image (Partial Imaging) 
This is setting to take a part of image captured by camera in PV200. (The size of image is 640 x 480 pixels 
for ANPVC1040, ANPVC5030 and ANPVC2040, and 640 x 478 pixels for ANPVC6030, and 1600 x 1200 
pixels for ANPVC1210 and ANPVC2260, and 2048 x 2048 pixels for ANPVC1470.)  Decreasing area to be 
taken shortens capturing time. 

The size of image is 640 x 478 pixels for 0.3-Mega Compact Color Camera, and the partial image setting is 
initially set. 

Set the area to be taken by specifying lines with a 
start point and an end point. 

Partial Imaging is the setting by a camera and one 
area can be set per camera. 

 
・ The gray value of the area other than 

imaging target will be zero. 

・ When "Error if Checker Area outside 
image" has been set to "Yes", a checker 
the area of which is outside the capturing 
range is not executed and the result is NG. 

 

In the case of setting  
Start point=160 and End point =320 

 

1. Select the camera No. to set in “Camera” window. 

2. Select "Partial Imaging". 

“Partial Imaging” window is displayed. 

3. Set “Part Area” to “Yes”. 

Now you can set the start/end point. 
 

For 0.3-Mega Compact Color Camera, 
"No" is not available. 

4. Select “Start Point” and specify the 

starting line of the capturing area. 

While you are specifying a range, the 
area where no inspection will be done is 
displayed in red in the image on the 
screen. Use it to make the setting. 
 
 

 

5. Select “End Point” and specify the ending line of the capturing area. 

 
The start point is set to 0 and the end point is set to 477 initially for 0.3-Mega Compact Color Camera. 
 
Minimum value of settable capturing area 
- 0.3-Mega Quad-speed Gray Camera (ANPVC1040): 1 line 
- 0.3-Mega Quad-speed Color Camera (ANPVC2040): 2 lines 
- 0.3-Mega Compact Gray Camera (ANPVC5030) : 1 line 
- 0.3-Mega Compact Color Camera (ANPVC6030): 2 lines 
- 2-Mega Gray Camera (ANPVC1210): 100 lines 
- 2-Mega Color Camera (ANPVC2260): 100 lines 
- 4-Mega Gray Camera (ANPVC1470): 1 line 
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6. After setting is completed, press the CANCEL key. 

 
By partial imaging, the size of image becomes as below. 

When the file size is fixed, the image capture time cannot be reduced.  

Camera No. of lines File size Camera Output 
image File size 

0.3-Mega 
Gray 

1 to 364 642 x No. of lines + 35,970 
bytes 0.3-Mega 

Color 

bmp  982,688 bytes fixed 

365 or more 339,328 bytes fixed byr 368,256 bytes fixed 

2-Mega 
Gray 

100 to 911 1,606 x (No. of lines - 100) + 
211,930 bytes 2-Mega 

Color 

bmp  5,821,088 bytes fixed 

912 or more 1,952,128 bytes fixed byr 1,981,056 bytes fixed 
4-Mega 
Gray 

1 or 1556 2,056 x No. of lines + 73090 
bytes 
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4.3.5 Performing Trapezoid Adjustment 

Using Trapezoid Adjustment corrects a trapezoidally-distorted image due to a camera installed aslant to the 
actual shape as much as possible.  

It is difficult to get a correct width, area size, the distance to the work or angle on the inspection w ith an 
image that is captured as a trapezoidal shape due to the relation between a camera and the work. In such 
case, apply this adjustment on the captured image. 

Even if a camera cannot be installed at right angle to works, optimum images less distorted can be used as 
inspection images by using Trapezoid Adjustment. 

When setting Trapezoid Adjustment, an image on which trapezoid adjustment has been applied is 
displayed on the screen window in SETUP menu. The image before the adjustment is not displayed. In 
RUN menu, it is possible to select whether or not to display an adjusted image in "Image Menu".  

  

 
Trapezoid Adjustment is applied on a gray image. For an image with a color camera, it is applied on the 
converted grayscale image. Be aware of the following restrictions when applying Trapezoid Adjustment on 
images with a color camera. 

[Restrictions on when applying Trapezoid Adjustment on images with a color camera]  
- After setting Trapezoid Adjustment, grayscale processing is performed with that camera . 

Inspections with the following colors cannot be conducted.  
Inspection with colors: Color Window checker/Settings of Color Extraction/Grayscale conversion 
coefficient  

 
PV200 operation when "Adjustment" has been set to "Yes" 
Item Gray camera Color camera 
Screen Display 

SETUP menu 
・Always displays images 
after trapezoid 
adjustment. 

• Always displays 
grayscale images after 
trapezoid adjustment. 

RUN menu 

・According to Layout 
Setting. 
・Switchable between view 
and hide for trapezoid 
adjustment. 

• According to Layout 
Setting. 

• Switchable between 
showing and hiding 
images after Trapezoid 
Adjustment. 
Display: Converted 
gray images 
Not display: Color 
images / Converted 
gray images / Color 
extracted images 

Function Preprocess Grayscale Conversion - Not available (Only 
available in Trapezoid 
Adjustment menu) 

 Color Extraction - Not available 
 Grayscale Preprocess Available Available 
Inspection Slice Level Available Available 

 Checker Color Window - Not available 

 
 

For information on how to switch between view and hide for trapezoid adjustment in RUN menu, refer to 
page 52. 
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When Trapezoid Adjustment is set for a color camera with setting "TYPE" > "Type Setting" > "Camera" 
> "Common Setting" to "Yes", make the following setting. When the type is changed to another type in 
which "Common Setting" has been set to "Yes", set the RGB coefficient of the grayscale conversion 
group selected in "Trapezoid Adjustment" to the same value as that for the type before the change.  
The grayscale conversion coefficient is the individual setting for each type, and cannot be shared with 
other types. Therefore, set as above. Otherwise adjustment or inspection will be performed on 
different gray images depending on types. 

 

Setting Trapezoid Adjustment 

1. Select "TYPE" > "Type Setting" > "Camera". 

2. Select the camera number to set in “Camera” window. 

3. Press "Set" for "Trapezoid Adj.". 

 

4. Set “Trapezoid Adj." to "Available". 

If "Not Available" is selected, the items other than the comment 
field cannot be set. 

5. (Only when using a color camera) Press "Set" for "Grayscale 
Conv.". 

For details of settings for grayscale conversion, refer to page 125 
 

When applying Trapezoid Adjustment on an image with a color 
camera, the gray image selected here will be displayed on the 
screen window and an inspection will be conducted with this gray 
image. Inspections relating to colors cannot be conducted. 

6. Select "Method". 

Select a method for adjusting trapezoidal images from the 
following two methods. 

 
 

"High Speed" (Default): Bilinear method 
"High Accuracy": Bicubic method 

 

 

 

 
Once the operation is performed, the processing time of Trapezoid Adjustment is added to the inspection 
time. The processing time varies according to the interpolation method and the type of connected camera. 
Please refer to the following list. 

Camera type Interpolation method Trapezoid Adjustment 
processing time 

0.3-Mega Quad-speed Gray 
0.3-Mega Compact Gray 
0.3-Mega Color 
0.3-Mega Compact Color 

High Speed Approx. 5 ms 
High Accuracy Approx. 10 ms 

2-Mega Gray 
2-Mega Color 

High Speed Approx. 30 ms 
High Accuracy Approx. 60 ms 

4-Mega Gray High Speed Approx. 75 ms 
High Accuracy Approx. 130 ms 
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Setting Coordinates Before Adjustment 

Set four coordinates (base points) of the area in which Trapezoid Adjustment is performed. 

 
Please tear off the check pattern sheet at the end of this manual. Even when a trapezoidal distortion of images 
is slight, using this sheet enables you to set coordinates of adjustment area easier. Coordinates can be also set 
from the image that an actual inspection object was captured. 

1. Capture the check pattern sheet attached at the 
end of this manual with the camera. 

 

2. Press "Set" for "Before Adjustment". 

 

3. Move the whole rectangle. 

Tilt the ENTER key to move the whole rectangle. 
Tilt the ENTER key pressing the SHIFT key to move 
the area by 10-pixel. (You can use the SHIFT key also 
for setting each base point.) 
 
After moving is completed, press the ENTER key. 

4. Set four base points to surround the trapezoidal 
area. 

Move each base point by tilting the ENTER key and 
press it to determine the positions. 
At this time, confirm the actual aspect ratio of a square 
which is displayed as a trapezoid. When you use the 
checker pattern sheet attached at the end of this 
manual, count the aspect ratio of the surrounding 
square. (In the case of the right figure, 7 cells in height 
and width. One-to-one ratio.) 
 
Setting all four points goes back to the Trapezoid 
Adjustment menu. 
 

 

Setting Coordinates After Adjustment 

Set two coordinates (base points) of the area after Trapezoid Adjustment. 
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1. Press "Set" for "After Adjustment". 

2. Move the whole rectangle. 

Tilt the ENTER key to move the whole 
rectangle. After moving is completed, press 
the ENTER key. 

3. Set two base points to surround the 
area after the adjustment. 

Move each base point by tilting the ENTER 
key and press it to determine the positions. 

 
 

 
Set the coordinates after the adjustment for the positions of base points 0 and 2 specified in "Before 
Adjustment". The aspect ratio of a square created here (the difference between the X and Y coordinates of 
base point 0 and base point 2) should be the same as the ratio confirmed in advance (in step 4 in "Setting 
Coordinates Before Adjustment"). (Height : Width = 1 : 1 for the case of "Setting Coordinates Before 
Adjustment") 

 
 

The rectangle of the coordinates after the adjustment can be set at arbitrary position or size, however, an 
error occurs if it is set to a considerably smaller size than the coordinates before the adjustment, and 
Trapezoid Adjustment cannot be executed. Adjust the rectangle to be an appropriate size and position 
checking the image after the adjustment. 
Example: Execution result when the rectangle of coordinates after the adjustment is considerably 
smaller than the coordinates before the adjustment. 

 

4. Trapezoid Adjustment is executed. 

The screen goes back to the Trapezoid 
Adjustment menu, and the image on which 
Trapezoid Adjustment has been executed is 
displayed. 
 

 
The part where no original image exist due to 
the erosion by adjustment is blacked out. 
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 It is difficult to correctly recognize the top surface of the object from an oblique direction if the object 

has a thick body. In that case, the adjustment may not be performed properly. 

 When coordinates after the adjustment is set in the opposite direction of coordinates before the 
adjustment, the image after the adjustment will be inverted.  

 
When there is a problem with the set base 
points, the right message appears. In that 
case, Trapezoid Adjustment will not be 
executed. Set each base point again. 
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4.3.6 Changing the Coordinate Origin and Unit (Calibration) 

Calibration is the function that converts inspection result from the coordinate in pixels that is a unit for image 
checkers to the actual value (mm or µm) and outputs them. Select a method from the following five types. 

 

Not Available: Not perform coordinate conversion. 

X/Y Size Used to specify coordinate axes and origin point. 

Base 1 point: Performs coordinate conversion from a base point, angle and 
factors. 

Base 2 points: Performs coordinate conversion from two base points.  

Base 3 points: Performs coordinate conversion from three base points.  

 
After calibration has been set, the position data detected by checkers is output in calibrated value.  Enter 
the tolerance in calibrated value in the checkers which detect position (coordinate) or measurement. 

Setting example) 
The coordinate origin is set at upper left position of the image as the default. 

Initial Condition  After Calibration 

 

 

 

 
Setting example) 
Coordinate Axis: Rightward 
and upward 
Origin: (240, 160) 
Calibration:  
 10mm=200 pixels 
 (coefficient: 0.05) 

If the detected coordinate in initial condition is (480, 320), the value turns to be (12, -8) after calibration. 

Setting Calibration 

Before setting calibration, capture an object or a scale with assured measurement to measure actual size in 
pixel unit. 

1. Select the camera No. to set in “Camera” 

window. 

2. Select "Calibration". 

“Calibration” window is displayed. 

3. Set “Calibration” to “Available”. 

Now you can set all items. 

4. Set “Method” to “X/Y Size”. 

“Calibration” window is displayed. 
  

5. Input the setting values for "Real Length X" and "Real Length Y". 

If standard object is 10-mm square, enter “10” either for Real Length X and Real Length Y. Enter Real 
Length in your desired unit. The unit does not have to be "mm". 
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6. Input the setting values for "Length X in Pixels" and "Length Y in Pixels". 

If X and Y are 200 pixels as the result of measuring the standard object, enter “200” either for X and Y. The 
factor converting unit is displayed. 
 

 
Input range 
- Real Length: 1.000 to 10000.000 (settable by 0.001.)  
- Length in Pixels: 1.000 to 10000.000 (settable by 0.001.)  
- Factor: 0.0001 to 10000.0000 

7. After setting is completed, press the CANCEL key. 

Changing Coordinate Origin 

The coordinate origin is set at upper left position of the image as the default. You can change this position. 

1. Select the camera No. to set in “Camera” 

window. 

2. Select "Calibration". 

“Calibration” window is displayed. 

3. Set “Calibration” to “Available”. 

Now you can set all items. 

4. Set “Method” to “X/Y Size”. 

“Calibration” window is displayed. 

 

 

5. Enter value for “Origin X” and “Origin Y”. 

For example, if you want the position of coordinate (100, 100) to be the origin, enter “100” for them. 

6. Select "Coordinate Axis". 

Select from the following four types. 
Decide which direction from the origin you make it positive side, right or left, up or down. 

“Rightward - Downward” (default) 

 

“Rightward - Upward” 

 
“Leftward - Downward” 

 

Leftward - Upward” 
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7. After setting is completed, press the CANCEL key. 

Setting Base 1 Point  
Setting example 
The coordinate origin is set at upper left position of an image as default. 

  

The base position of 
XYtheta can be specified. 

In the example on the 
left, the base position is 
registered as follows; The 
center of gravity 
coordinate XY of white 
object is the origin, and 
the angle of principal axis 
is 0 degree. 

Initial Condition After setting calibration  

Setting Base 1 point 

Before setting Base 1 Point, capture an object or a scale with assured measurement to measure actual 
size in pixel unit. 

1. Select the camera No. to set in “Camera” window. 

2.Select "Calibration". 

The "Calibration" setting window is displayed. 

3. Set “Calibration” to “Available”. 

Now you can set all items. 

4. Set "Method" to "Base 1 point". 

The setting items of "Base 1 point" are displayed. 

5. Select either "Static" or "Dynamic" for "Operation". 

Static: (Default) 
Converts coordinates using the value registered when setting 
calibration. 

Dynamic: 
Detects base position during inspection. 

 

 

 

 

 

 

 
 

 

Example of static operation 

When setting calibration When executing inspection  

  

* When setting calibration, the 
coordinate of gravity center of the 
white object and the principal axis 
angle are detected and they are 
registered as the base position 
(XY=0 mm, theta=0 degree). 
* During inspection, the distance 
and angle from the registered base 
position (difference) can be 
calculated. 

X=0mm、Y=0mm、 
theta=0 degree 

X=-17mm、Y=-20mm、
theta=-24.84 degree 
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Example of dynamic operation 

When setting calibration When executing inspection  

  

The distance (length) of X/Y 
direction can be measured by 
detecting the base position in 
every inspection. 

* In the example on the left, the 
coordinate and rotation angle 
on the upper left corner of the 
white object are detected as the 
base position (X=0 mm, Y=0 
mm, Theta=0 degree).  

Size(X)=85mm, Size(Y)=65mm Size(X)=85mm, Size(Y)=65mm  

 

 

6. Enter the setting value for "Real Length". 

If standard object is 10-mm square, enter "10". 
Enter Real Length in your desired unit. The unit does not have 
to be “mm”.  

7. Enter the setting value for "in Pixels". 

If the size is 200 pixels as the result of measuring the standard 
object, enter "200". The factor converting unit is displayed. 

 
Input range 
・Real Length: 1.000 to 10000.000 (settable by 0.001.) 
・Length in Pixels: 1.000 to 10000.000 (settable by 0.001.) 
・Factor: 0.0001 to 10000.0000 

 

 
 

8. Select either "Value Input" or "Checker" for "Angle". 

Value Input: (Default) 
Enter the value you want to specify as "Angle". It is settable in the range of -179.999 to 180.000 
degrees. 

 
Checker: 
Refers the angle data detected by the checker that is set in "Registering Base point and Global 
coordinate"  described below. 

 
It cannot be selected when the base setting is desired position.  

Example of referring checker 

 

In the left image, the angle of principal axis of a white object is 
detected as -30 degree. 
When "Angle Setting" is set to "Checker", -30 degree is registered 
as the base angle (position at 0 degree). 
 

 
If the angle of principal axis is -40 degree during inspection, -10 
degree is output, which is a difference with the base angle. 

 

9. Select either "CW" or "CCW" for "Coordinate". 

Selecting "CW" or "CCW" specifies the direction of "XYtheta". 
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CW  CCW  

 

CW is +theta 
direction. 

 

CCW is 
+theta 
direction. 

Registering Base 1 point and Global coordinate 

 

In case of the example on the left, set the after-mentioned 
"Item" and "Global Coordinate" of "P0" by the following 
procedure. 

 Register a checker to detect the coordinate 
position of No0 as the item of "P0". 

 Register the coordinate position of No0 (X=0 mm, 
Y=0 mm) in "Global Coordinate" of "P0". 
 

10. Select "P0" and "Set". 

The pop-up menu appears. 
The items that can be used for Base 1 point such as checkers are 
displayed. 

11. Select a checker to use. 

The checker menu is displayed. 

12. After setting is completed, press the CANCEL key. 

The pop-up menu appears. 
A message saying “Do you register the base position?” appears. 

13. When the message appears, select “YES". 

The base position is registered and the factor, origin X and Y are 
displayed. 

14. Input the setting values for "GLOB-Coord. X" and 
"GLOB-Coord. Y". 

Specify the positions of base positions X and Y in global coordinate 
system by the actual measurement values. 
The settable range is -10000.000 to 10000.000. 

15. After setting is completed, press the CANCEL key. 
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Setting Base 2 Points 
 

Setting example 

The coordinate origin is set at upper left position of an image as default. 

  

The base position of XY 
can be specified. 

In the example on the 
left, the coordinate and 
rotation angle on the 
upper left corner of the 
white object are 
detected, and 
registered as XY=0 mm 
and Theta=0 degree.   
Also, the factor is 
calculated by registering 
the coordinate of gravity 
center of the black cross 
mark. Initial Condition After setting calibration 

 

Using this feature enables the measurement with two cameras to be easily achieved.  

  

In the example on the 
left, the coordinates of 
gravity center of the 
black cross marks of 
Camera 0 and Camera 
1 are detected, and 
the distance between 
the marks is measured 
by Geometry 
Calculation. 

Image of Camera 0 Image of Camera 1  

Setting Base 2 points 

Capture an object or a scale with assured measurement to set calibration.  

 

1. Select the camera No. to set in “Camera” window. 

2. Select "Calibration". 

The "Calibration" setting window is displayed. 

3. Set “Calibration” to “Available”. 

Now you can set all items. 

4. Set "Method" to "Base 2 points". 

The setting items of "Base 2 points" are displayed. 

5. Select either "Static" or "Dynamic" for "Operation". 

Static: (Default) 
Converts coordinates using the value registered when setting 
calibration. 
Dynamic： 
Detects base position during inspection. 
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Example of static operation 

When setting calibration When executing inspection  

  

* When setting calibration, 
the coordinate of gravity 
center of the white object 
and the principal axis angle 
are detected and they are 
registered as the base 
position (XY=0 mm, theta=0 
degree). 
* During inspection, the 
distance and angle from the 
registered base position 
(difference) can be 
calculated. X=0mm, Y=0mm、theta=0 

degree 
X=0mm, Y=0mm, theta=3 
degree 

 

Example of dynamic operation 

When setting calibration When executing inspection  

  

The distance (length) of X/Y 
direction can be measured by 
detecting the base position in 
every inspection. 

* In the example on the left, 
the coordinate and rotation 
angle on the upper left corner 
of the white object are 
detected as the base position 
(X=0 mm, Y=0 mm, Theta=0 
degree).  

Size(X)=83.8mm, 
Size(Y)=65.12mm 

Size(X)=83.8mm, 
Size(Y)=65.12mm 

 

Registering Base 2 points and Global coordinate (For Camera 
0) 

 

In case of the example on the left, set the after-mentioned 
"Items" and "Global Coordinates" of "P0" and "P1" by the 
following procedure. 

 Register a checker to detect the coordinate 
position in item of "P0". 

 Register a checker to detect the coordinate 
position in item of "P1". 

 Register the coordinate position (X=0 mm, Y=0 
mm) in "Global Coordinate" of "P0". 

 Register the coordinate position (X=85 mm, Y=65 
mm) in "Global Coordinate" of "P1". 

 

6. Select "P0" and "Set". 

The pop-up menu appears. 
The items that can be used for Base 2 points such as checkers are 
displayed. 
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7. Select a checker to use. 

The checker menu is displayed. 

8. After setting is completed, press the CANCEL key. 

The pop-up menu appears. 
A message saying “Do you register the base position?” appears. 

9. Select "YES". 

10. Select "P1" and "Set". 

The pop-up menu appears. 
The items that can be used for Base 2 points such as checkers are 
displayed. 

11. Select a checker to use. 

The checker menu is displayed. 

12.After setting is completed, press the CANCEL key. 

The pop-up menu appears. 
A message saying “Do you register the base position?” appears. 

13. Select "YES". 

The base position is registered and the factor, origin X and Y are 
displayed. 

14. Input the setting values for "GLOB-Coord. X" and 
"GLOB-Coord. Y". 

Specify the positions of base positions X and Y in global 
coordinate system in millimeter. 
The settable range is -10000.000 to 10000.000. 
 

15. Select either "CW" or "CCW" for "Coordinate". 

Selecting "CW" or "CCW" specifies the direction of "XYtheta".  

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

About specifying the direction of XYtheta axis by Coordinate rotatory direction. 
The following four patterns can be specified by Coordinate rotatory direction and global coordinate settings. 

 

Direction of XYtheta axis Image of coordinate axis Global coordinate setting 

  

Coordinate rotatory 
direction=CW 
 
Global coordinate of Base 0 
 X=0.000, Y=0.000 
 
Global coordinate of Base 1 
 X=85.000, Y=65.000 
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Coordinate rotatory 
direction=CW 
 
Global coordinate of Base 0 
 X=0.000, Y=0.000 
 
Global coordinate of Base 1 
 X=-85.000, Y=-65.000 

  

Coordinate rotatory 
direction=CCW 
 
Global coordinate of Base 0 
 X=0.000, Y=0.000 
 
Global coordinate of Base 1 
 X=-85.000, Y=65.000 

  

Coordinate rotatory 
direction=CCW 
 
Global coordinate of Base 0 
 X=0.000, Y=0.000 
 
Global coordinate of Base 1 
 X=85.000, Y=-65.000 

 

16. After setting is completed, press the CANCEL key. 
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Registering Base 2 points and Global coordinate (Example for 
Camera 2) 

 

 

When capturing the object 
of the size described on 
the left figure with two 
cameras 

Setting for Camera 0 

 

In case of the example on the left, set the 
above-mentioned "Items" and "Global Coordinates" of 
"P0" and "P1" by the following procedure. 

 Register a checker to detect the coordinate 
position in item of "P0". 

 Register a checker to detect the coordinate 
position in item of "P1". 

 Register the coordinate position (X=0 mm, Y=0 
mm) in "Global Coordinate" of "P0". 

 Register the coordinate position (X=90 mm, 
Y=65 mm) in "Global Coordinate" of "P1". 

Setting for Camera 1 

 

In case of the example on the left, set the after-mentioned 
"Items" and "Global Coordinates" of "P0" and "P1" by the 
following procedure. 

 Register a checker to detect the coordinate 
position in item of "P0". 

 Register a checker to detect the coordinate 
position in item of "P1". 

 Register the coordinate position (X=660mm, Y=0 
mm) in "Global Coordinate" of "P0". 

 Register the coordinate position (X=570 mm, 
Y=65 mm) in "Global Coordinate" of "P1". 

 
When setting calibration for Camera 0 and Camera 1, calculation between Camera 0 and Camera 1 can be 
performed using Geometry Calculation. 

The types of Camera 0 and Camera 1 do not have to be the same.  
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Setting Base 3 Points 
 

Setting example  

 

In Base 3 points setting, the origin and the coordinate 
rotatory direction are registered by setting a checker to 
detect three base positions and specifying the global 
coordinates of base positions. 
 
The direction of XYtheta axis is determined by the 
input of base coordinate and global coordinate. The 
setting examples are as below. 
 
The width in X direction is defined as 16.9 mm and the 
height in Y direction as 23.2 mm. 
The P0 is No0, P1 is No1 and P2 is No2 in this 
explanation. 

 

Direction of XYtheta axis Image of coordinate axis Global coordinate setting 

  

Global coordinate of Base 0 
 X=0.000, Y=0.000 
 
Global coordinate of Base 1 
 X=0.000, Y=23.200 
 
Global coordinate of Base 2 
 X=16.900, Y=23.200 

  

Global coordinate of Base 0 
 X=-8.450, Y=-11.600 
 
Global coordinate of Base 1 
 X=-8.450, Y=11.600 
 
Global coordinate of Base 2 
 X=8.450, Y=11.600 

  

Global coordinate of Base 0 
 X=8.450, Y=11.600 
 
Global coordinate of Base 1 
 X=8.450, Y=-11.600 
 
Global coordinate of Base 2 
 X=-8.450, Y=-11.600 
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Global coordinate of Base 0 
 X=8.450, Y=-11.600 
 
Global coordinate of Base 1 
 X=8.450, Y=11.600 
 
Global coordinate of Base 2 
 X=-8.450, Y=11.600 

  

Global coordinate of Base 0 
 X=-8.450, Y=11.600 
 
Global coordinate of Base 1 
 X=-8.450, Y=-11.600 
 
Global coordinate of Base 2 
 X=8.450, Y=-11.600 

 

The setting method of P0-2 and the global coordinate is the same as that of Base 2 points.  Refer to 
"Setting Base 2 Points" 

 

Deleting Set Base 
 

1. Select the base checker (0-2) you want to delete. 

When the background of P0-2 is highlighted in red: Unset 
When the background of P0-2 is highlighted in gray: Already set 

2. Press the FUNC key. 

The pop-up menu appears. 

3. Select "Delete". 

4. Select “Yes” following the displayed message. 

The set base point is deleted. Confirm that the background of 
P0(-2) is highlighted in red. 
Although the set checker has been deleted, the global 
coordinate is not deleted. 
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4.3.7 Error if Checker Area Outside Image 

This function cancels the checker when its area is outside an 
image captured by a camera after Position Adjustment or 
Area Size Adjustment adjusted the area as the figure on the 
right. In this case, the checker returns "Error". 

 
 When "Part Area" is set to "Yes", an actually 

captured image is the capturing range. 

 When "Rotate" is used in the grayscale 
preprocess of the checker even though "Part 
Area" is set, the capturing range is the size of the 
image that partial imaging has not been 
executed. 

 

 

 

1. Select "TYPE" > “Type Setting” from the 

menu bar. 

2. Select "Camera". 

Camera setting window is displayed. 

3. Select “Yes” or “No” in "Error if Checker 
Area outside Image". 

No: 
Executes a checker even if the checker area 
is beyond the camera image. 
 
Yes (Default): 
Cancels checker if the checker area is 
beyond the camera image and outputs NG 
as a result. (The list of checkers and Checker 
List show the checker is ERROR.) 

 

 

 
 

 RUN MENU No ERROR output and 
no ERR display. 

 

SETUP MENU The list of checkers and 
Checker List show the 
checker is ERROR. 

 
Note that a checker is canceled if only a small part of the area is beyond the camera image regardless of a 
checker adjusted by Position Adjustment and Area Size Adjustment because you can create a checker 
area also outside camera capturing range. 



 

112 

S
etting Inspection C

onditions 
C

h. 4 

4.3.8 Selecting Color Extraction Mod 

 

1. Select "TYPE" > "Type Setting" > "Color Extraction" from the menu bar. 

2. Select "Color Extraction Mode". 

The setting window of Color Extraction is displayed. 
When connecting two cameras, the registerable number of color extractions for one camera is 8 colors in 
Fast mode and 64 colors in Extend mode. 

 

Connected 
camera port 

Camera 
type 

Color Extracton Mode 

Fast (Usable 16 
colors) 

Extend (Usable 128 
colors) 

CAMERA 0 : 
CAMERA 1 : 

Color 
Unconnected 

16 colors 
- 

128 colors 
- 

CAMERA 0 : 
CAMERA 1 : 

Color 
Gray 

8 colors 
- 

64 colors 
- 

CAMERA 0 : 
CAMERA 1 : 

Gray 
Color 

- 
8 colors 

- 
64 colors 

CAMERA 0 : 
CAMERA 1 : 

Color 
Color 

8 colors 
8 colors 

64 colors 
64 colors 

 

3. Select "Color for Single Color". 

When specifying "Single Color (Color BG)" for the color of RUN menu or SETUP menu, select the color 
used to fill in the extracted area. The default color is pink. 
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4.4 Inspecting Divided Type (Execution Mode) 
In PV200, checkers can be divided into ten by checker number to execute just one checker, multiple 
checkers or all checkers. Divided part is “Block” and the mode to decide how to execute is “Execution mode”. 

 

Checkers are divided in 100-block-unit from checker No.0. The maximum 
block number is 10. 

If you set the number of blocks to “2”, for example, checker No.0 to 99 are 
sorted in block No.0, checker No.100 to 199 are in block No.1 respectively. In 
this case, numbers larger than 199 cannot be set. 

 
Although checkers No.0 to 999 can be selected if you set the number of 
blocks to “10”, not all checkers can be always created because the memory 
capacity of PV200 is constant regardless of the number of blocks. 

Block 
(Up to 10) 

Checker 
(Up to 1000) 

No.0 No.0 - 99 
No.1 No.100 - 199 
No.2 No.200 - 299 
No.3 No.300 - 399 
No.4 No.400 - 499 
No.5 No.500 - 499 
No.6 No.600 - 699 
No.7 No.700 - 799 
No.8 No.800 - 899 
No.9 No.900 - 999 

4.4.1 Selecting an Execution Mode 

Select an execution mode according to the inspection to perform. Specify an execution mode from “TYPE” > 
“Type Setting”. 

 

Usage  Execution Mode 

• To execute inspection using only one product type. 
• To use many product types when there is enough time to switch the product 

types. 
• To execute inspections of many parts in a captured image at a time. 
• To use many checkers, numerical calculations and judgement expressions to 

perform complicated calculations in an inspection. 

 

“Execute 
All” 

Executes all Checkers, 
Numeric Calculations 
and Judgements in a 
product type. 

To execute different inspection items, checkers or conditions, depending 
on the type and status of target. 
 

Example 1: 
To determine if the object is reversed or not and inspect with the proper 
conditions for each status. 

 

 

“Automatic 
Switch” 

 
Executes multiple 
inspections effectively. 

Example 2: 
To identify the type at an assembly line 
where multiple types of objects are 
running down at a time and inspect with 
the proper condition for each type.  

To execute various types of simple inspections 
Example: Only a few checkers are used for each product type, but more than 

256 product types exist. 
 
To save time to switch product types 

Example: To execute inspections speedily, switching multiple types (up to 10) 
of conditions. 

 Type 0 Type 0  

 
 

 

 

“User 
Defined” 

 
Executes some of the 
inspections in a 
product type. 
(Specify before 
executing inspection.) 
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Referring the results of other blocks 
In Execute All mode, all the set checkers are executed, however, some blocks are not executed in 
Automatic Switch mode or User Defined mode. The checker of the unexecuted block retains the previous 
result when the block was executed. 

When a block is executed with a start signal, the result retained by a checker of a block which was not 
executed with the same start signal can be referred for such block. 

Utilizing this function enables to change the capturing condition of Position Adjustment and inspection. Or it is 
also helpful for measuring the difference between the first captured position and the current position easily. 

Example 1 
(Multiple lighting conditions are 
needed) 

Block 0 
Position Adjustment No.000 

Block 1  
Binary Window No.100 
(Specified Position Adjustment 000) 

Execute block 0 in which 
Position Adjustment No.000 is 
set with back lighting. 

Change the lighting conditions 
and execute block 1 to inspect 
the same object again. 
Although the image suitable 
for the inspection can be 
captured with this capturing 
condition, the adjustment 
amount of Position Adjustment 
No.000 executed previously is 
referred to execute the 
inspection as there is no base 
position under this capturing 
condition. 

 
With back lighting 

 
With reflection (low angle) lighting 
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Example 2. 
(Simple alignment)  
Block 0 
Smart Matching No.000 
Character/Figure Drawing No.000   
0: Cross (SMC000) 

Block 1 
Smart Matching No.100 
C100=SMC100_X.000-SMC000_X.000 
C101=SMC100_Y.000-SMC000_Y.000 
Character/Figure Drawing No.100   
0: Cross (SMC000) 
1: Circle (SMC000) 
2: Circle (SMC000) 
Character/Figure Drawing No.101   
0 - 2: Character (CAC100) 
Character/Figure Drawing No.102   
0 - 2: Character (CAC101) 

 

Overview of operation 

Capture the first object under block 0. 
Detect the object with Smart Matching checker No.000 and 
draw a cross at the detected position with Character/Figure 
Drawing No.000. 
 
Change the object and capture the second object under block 
1. Detect the object with Smart Matching checker No.100 and 
calculate the shift amount between the two objects with 
Numerical Calculation. 
At this time, the detected position of Smart Matching checker 
No.000 executed with block 0 is drawn with Character/Figure 
Drawing No.100. 
The shift amount data of the two objects is drawn with 
Character/Figure Drawing No.101 to 102. 
Executing block 1 several times updates the value of SMC100 
on each execution and enables to calculate the shift amount. 
The value of SMC000 is not updated unless block 0 is 
executed again. 
 
The overview of operation is as above. However, the 
operation differs in "RUN menu" and "SETUP menu". For 
details, refer to the next page. 

Block 0 = Registration of base position 

 
 
Block 1 = Calculation of shift amount 
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Operation in RUN menu 

- Execute block 0. 

1. Smart Matching checker No.000 is executed. 

2. Character/Figure Drawing No.000 is executed and a cross 
is drawn on the screen window. 

- Execute block 1. 

1.  The pattern drawn in the above steps 1 and 2 for block 0 is 
deleted. 

2. Smart Matching checker No.100 is executed. 

3.  Numerical Calculation CAC100 to 101 is executed. 

4. Character/Figure Drawing No.100 to 101 is executed and a 
cross, circles and numerical calculation result are drawn 
on the screen window. 

5. Execute block 1 to repeat the operations 2 through 4. 

- Execute block 0. 

1. The pattern drawn for block 1 is deleted. 

2. Smart Matching checker No.000 is executed. 

3. Character/Figure Drawing No.000 is executed and a 
cross is drawn on the screen window. 

Block 0 operation (RUN menu) 

 
 
Block 1 operation (RUN menu) 
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Operation in SETUP menu 

- Execute block 0. 

1. Smart Matching checker No.000 is executed. 

2. The contents of Character/Figure Drawing set in 
block 0 and block 1 are displayed. 

- Execute block 1. 

1.  Smart Matching checker No.100 is executed. 

2.  Numerical Calculation CAC100 to 101 is executed. 

3.  The contents of Character/Figure Drawing set in 
block 0 and block 1 are displayed. 

 

 
In SETUP menu, all types of drawings are performed 
regardless of block. When there is no result data necessary 
for drawing patterns such as cross or circle, no drawing is 
displayed on the screen window. 

Block 0 operation (SETUP menu) 

 
As block 1 is unexecuted, no numerical 
calculation result is displayed. 
 
Block 1 operation (SETUP menu) 

 
 

Note when turning on the power 

When tuning on the power, the settings of all types of 
Character/Figure Drawing are displayed regardless of block. 
However, no drawing is displayed right after the power-on 
because no result data exists that is necessary for 
drawing a cross or circle. 

 
 

 You can refer to all types of Position Adjustment or Area Size Adjustment in each checker 
regardless of block.  

 Even in Automatic Switch mode and User Defined mode, the results of other blocks can be 
referred. However, when referring a checker of the block that has never been executed after 
power-on or type switch, the result is 0. 

 In Numerical Calculation, the previous values of other blocks can be also referred. Note that the 
value before the previous execution of the target block is referred as the previous value, as shown 
in the example below. 

 
Block 0 
CAC000=SYS_COUNT (Scan Count) 
CAC001=OCA100_VALUE 

Block 1 
CAC100=SYS_COUNT (Scan Count) 
CAC101=OCA000_VALUE 
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4.4.2 Inspecting in “Execute All” Mode 

The “Execute All” is a factory default execution mode. 
This mode executes all set checkers. You do not have to be concerned about “Block” in this mode. 

Specifying Execution Mode and Number of Blocks 

1. Select "TYPE" > “Type Setting” from the menu bar. 

“Type Setting” window is displayed. 

2. Select "Execution Condition". 

3. Select “Execute All” for “Execution 

Mode”. 

4. Enter the number of blocks 1 to 10 for 
“Number of Blocks”.  

4.4.3 Inspecting in “Automatic Switch” Mode 

Automatic Switch mode inspects multiple blocks orderly. Firstly block No.0 is executed. The result decides the 
next operation; proceed another block, execute the next block, or terminate the inspection. These conditions 
can be set in Judgement setting window. (page 120) 

In Automatic Switch mode, only the last block to be executed will be output even when multiple blocks are 
inspected. (Example of the output through Parallel I/O: page 359, page 361) Thus, only when a specific block is 
executed last, the result can be output to an external device according to the settings of Judgement or 
Numerical calculation of the executed block. 

Not only judgement and numerical calculation results but also "Total Judgement" (page 333), "Save Image 
Memory" and "Image Output" (page 335) are executed according to the condition of the block executed 
last. 

 

Example) 

When inspecting the front and back face of three types of objects 
shown on the right, they are identified their type (A/B/C) and top 
or bottom, and then inspected as needed. 

Front face 

 

Back face 
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Flow concept 

 

 The number of the executed block is displayed in the information area. 

 
 
 
 

Specifying Execution Mode and Number of Blocks 

1. Select "TYPE" > “Type Setting” from the menu bar. 

“Type Setting” window is displayed. 

2. Select "Execution Condition". 

3. Select “Automatic Switch” for 

“Execution Mode”. 

4. Enter the number of blocks 2 to 10 for 
“Number of Blocks”.  
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Setting a Branch Condition 

1. Select "INSPECTION” > “Judgement” from 

the menu bar. 

The screen of Judgement setting is displayed. 

2. Select "Set Branch Condition". 

The branch condition setting screen is displayed. 

3. Select "Block No.0". 

Branch 0-8 are displayed.  
(When the number of blocks is 10.) 
Branch condition is the result of the external 
output register (JDC) or the internal register 
(JRC) of the judgement of the specified block. 
Conditions are applied from the top. When the 
result meets the set condition, the right end block 
will be executed. When it does not meet, the next 
branch will be executed. 

 
In the example shown on the right, the setting of 
the Branch 0 indicates that if judgement No.50 is 
OK, Block 1 will be executed, if it is NG, 
proceeds to Branch 1. 

 
 

 

4. Set branch conditions. 

- Condition and Checker No.:  
Specify Judgement type and number to set as a branch condition. 

- Judgement:  
Specify a condition to meet. When specifying "OK", the branch condition is satisfied if the result of the 
set Judgement expression is OK. 

 
As "Destination", you can set the block number that is larger than the currently setting block or "End". 
For instance, Block 0 cannot be set as a branch destination for Block No.1. 
"End" indicates to end the inspection. 
To set the behavior when no branch conditions are fulfilled, select "Destination" field in "False" line. 

 
Set branch conditions as necessary. 

5. Set branch condition of the destination block if needed. 

6. After setting is completed, press the CANCEL key. 
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4.4.4 Inspecting in “User Defined” Mode 

In this mode, inspections are executed by each block. Specify a block No.0 to 9 when inputting start signal from 
the external devices. (I/O input, serial command communication or Ethernet command communication.) The 
checkers, the numerical calculations, and the judgements belong to specified block are executed and output. 
The number of the executed block is displayed in the information area. 

Specifying Execution Mode and Number of Blocks 

1. Select "TYPE" > “Type Setting” from the menu bar. 

“Type Setting” window is displayed. 

2. Select "Execution Condition". 

3. Select “User Defined” for “Execution 

Mode”. 

4. Enter the number of blocks 2 to 10 for 
“Number of Blocks”. 

 

How to Set a Block 
 

Specify a block to input a signal and send a command 
to execute an inspection. 

When inputting a start signal through I/O, specify the 
block number with IN 0-3. 

When sending a serial command, send a designated 
command to specify the block No. 

For PLC communication, refer to 11.3.6 Descriptions 
of PLC Communication Commands (page 649). 

 

Block I/O (STRT) Serial 
command* IN3 IN2 IN1 IN0 

No.0 off off off off %S0 
No.1 off off off ON %S1 
No.2 off off ON off %S2 
No.3 off off ON ON %S3 
No.4 off ON off off %S4 
No.5 off ON off ON %S5 
No.6 off ON ON off %S6 
No.7 off ON ON ON %S7 
No.8 ON off off off %S8 
No.9 ON off off ON %S9 

Starting an Inspection by Keypad 
For the type set as “User Defined”, you can specify a block when starting an inspection with the keypad.  

1. Press the TRIG key (Start) in RUN menu. 

A window to select a block No. to execute is displayed. 

2. Select the block No. to execute. 

The specified block is executed. 
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4.5 Capturing an Image 
This function can save an image processing of inspection object in the memory. 

Specify the inspection area and conditions based on the image. The image is for setting criteria of an inspection. 
Capture a base object maintaining the lighting condition to take an image. 

1. Press the F1 key and select “Delete” from the displayed menu. 

2. Select “Live” for "Memory/Live". 

3. Place an object beneath the camera. 

4. Press the TRIG key. 

A test run is executed and an image is captured. 
 

 
You can call up the images saved in PV200 or a SD memory card to set checkers and execute a test. To use 
the saved images, select "Memory". 

About how to save and read images, refer to pages 380, 376, 378). 
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4.6 Image Preprocessing (Binary / Preprocess) 
PV200 inspects gray scale images and color images. Gray scale images are signals taken from a camera as 
images with 256 intensities (0 to 255). Color images are colored images. Connecting a color camera enables to 
inspect colored images. The function that applies filtering process on an image captured by a camera in order 
to execute desired inspections based on the gray image is “Preprocess”. 

 
  Preprocess   
  Color Preprocess Grayscale 

Preprocess 
Binary  Target Checker 

Color image ┬ 
│ 

──────────────────────────────── List A 

 ├ 
│ 
│ 

Grayscale 
Conversion 

─ Grayscale 
Preprocess 
(No / A-P) 

┬ 
│ 
│ 

────────── List B 

 

 │ 
│ 

   └ Slice Level: A-P 
 

─ List C 

 └ Color Extraction ─ Grayscale 
Preprocess 
(No / A-P) 

┬ 
│ 
│ 

────────── List B 

     └ Slice Level: A-P ─ List C 

 

 
  Preprocess   
   Grayscale 

Preprocess 
Binary  Target Checker 

Grayscale 
image 

┬ 
│

│ 

────────── Grayscale 
Preprocess 
(No / A-P) 

┬ 
│

│ 

────────── List B 

 │ 
│ 

  └ Slice Level: A-P ─ List C 

 └ ────────── Grayscale 
Preprocess 
(No / A-P) 

┬ 
│

│ 

────────── List B 

    └ Slice Level: A-P ─ List C 

 

 
Target Checker List List A Color Window 
 List B Gray Window / Gray Edge / Smart Matching / Contour Matching / 

Flaw Detection / Connector (Gray Window) / Connector (Gray 
Edge) / Smart Edge (Circle) / Smart Edge (Line) 

 List C Line / Binary Window / Binary Edge / Feature Extraction / 
Connector (Binary Window) 

 
 The target checker also includes the same functions of Position Adjustment and Area Size 

Adjustment. 

 Even when the same grayscale preprocess group is used in the grayscale preprocess for a color image, 
the target image varies depending on the setting of Grayscale Conversion/Color Extraction. It is 
recommended to separate grayscale preprocess groups for each grayscale conversion group and color 
extraction used in each checker. 

 Both for color and grayscale images, the target image varies depending on the setting of Grayscale 
Conversion/Color Extraction/Grayscale preprocess even when the same slice level group is used in 
binary operation. It is recommended to separate slice level groups according to the combination of the 
grayscale conversion group, color extraction and grayscale preprocess group used in each checker. 
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4.6.1 Preprocessing on Gray Image (Slice Level / Grayscale Preprocess) 

When using a gray camera, PV200 takes in signals from the camera 
as an image with 256 intensities (0 to 255). The image is “gray image” 
and the 256 intensities are "gray value“. The higher gray value 
indicates the brighter pixel, and the lower gray value the darker pixel. 
When using a color camera, performing the color preprocess enables 
to display the image as a gray image. 

Among the preprocess on a gray image, the process that makes a 
gray image into a monochrome image is binarization and a binarized 
image is a binary image. Some of inspection functions scan with this 
binary image. 

 

4.6.2 Binarizing an Image (Slice Level) 

In PV200, up to 16 sets of slice level (A to P) can be registered per type and camera for the inspection with 
gray values, which is called slice level group. Which slice level group is used to inspect an image is set in the 
window for setting the inspection conditions when creating a checker. 

 
Gray Image  Slice Level Group A 

Maximum value is 255  
Minimum value is 200 

Slice Level Group B 
Maximum value is 255  
Minimum value is 150 

 

 

200 to 255 = white 
0 to 199 = black 

 

150 to 255 = white 
0 to 149 = black 

 
The values are gray level of each 
pixel. 

 The pixel with 170 of gray level will 
be “white”. 

 

Changing the setting values of a slice level group also changes the setting values for the checkers which 
specify the same slice level group. You can adjust quickly. On the other hand, even if you intend to change 
the slice level of a certain checker, it may affect the settings of other checkers.  In this case, change the 
slice level group to another group that is not used by other checkers.  

Especially, when the color or gray preprocess is used in each checker, the target gray images vary. For 
adjusting the values of a slice level, check if the change is appropriate for all the checkers that the slice 
level group is used. 
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Setting a Slice Level 

1. Select "INSPECTION” > “Slice Level” from the menu bar. 

“Slice Level” setting window is displayed. 
 

Slice level can be modified also in setting window of a 
checker which scans with a binary image. 

2. Select a group to set from the table. 

“Slice Level” setting sub-window is displayed. 

3. Select "Auto Adjustment". 

If the image turned to be a desired binary image, setting 
is completed. 

4. Select “Minimum” to specify the minimum value. 

Specify the maximum value as necessary. 
Changing values updates the displayed image. 

 

 
 

Beneath the table, a histogram is displayed. The two red lines indicate the minimum value and the 
maximum value. Refer to the histogram as necessary. 

5. After setting is completed, press the CANCEL key. 

4.6.3 Setting Grayscale Conversion 

Using this function converts a color image to a gray scale image in a range of 0 to 255 using RGB values 
for each pixel. Changing RGB coefficients enables to convert a color image to various gray scale images.  

Up to 16 sets of grayscale conversion (A to P) can be registered per type and color camera. These sets are 
called grayscale conversion groups. When creating each checker, select "Converted Gray Img." in "Select 
Color Image", and select "Set" to specify a grayscale conversion group the image of which is used for the 
inspection. 

"Grayscale Conversion" can be modified also in setting window of each checker. 

 

 
If the setting values of a grayscale conversion group are changed, these changes are also reflected in 
multiple checkers that the same grayscale conversion group is specified. So you can adjust quick ly. On the 
other hand, even if you intend to change the grayscale conversion of a certain checker, it may affect the 
settings of other checkers. In this case, change the grayscale conversion group to another group that is not 
used by other checkers. 
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Setting a Grayscale Conversion Level 
 

1. Select "Inspection” > “Preprocess” from the main 

menu. 

The window to select a preprocess type appears. 

2. Select "Grayscale Conv.". 

The window for selecting a grayscale conversion group 
appears, and the screen window shows converted 
grayscale images. 

3. Select a camera image to set Grayscale Conversion 
from “Camera”. 

The camera image selected in “Camera” is displayed. 
 

4. Select a group to set from the table. 

The grayscale conversion setting window appears. 

 

 

 

 
 

 

 

 

5. Set R coeff., G coeff. and B coeff. 

The images displayed on the screen window vary when 
changing the coefficients. 
The input range of each coefficient is -1000 to 1000. 
 

 
You can call the preset RGB coefficients and finely adjust 
them as necessary. 
The preset values are as below. 
 

  R Coeff. G Coeff. B Coeff. 
 Standard 299 587 114 
 Emphasize R 1000 -500 -500 
 Emphasize G -500 1000 -500 
 Emphasize B -500 -500 1000 
 Emphasize R/G 500 500 -1000 
 Emphasize G/B -1000 500 500 
 Emphasize R/B 500 -1000 500 

 
 

 

 
 

 

 

 
 

6. After setting is completed, press the CANCEL key. 
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4.6.4 Setting Color Extraction 

Color Extraction is a function that extracts specific colors by registering the colors based on a color image.  
It converts RGB values of each pixel to HSV (hue, saturation and value) that is better fitted to human sense 
and extracts colors in a specified area. An image will be a gray scale image with the extracted colors 
converted to 255 and the other colors converted to 0. 

Extracted colors can be registered for each camera. The number of registrable colors varies depending on 
the color extraction mode used and the number of cameras connected.  (For details of the number of 
registrable colors, see page 112.) 

Select "Set" to specify a color extraction No. after selecting "Select Color Image" > "Extracted Color Img." 
when creating a checker. 
Up to eight color extraction numbers can be specified for one checker.  

Color Extraction can be modified also in the setting window of each checker.  

 
If the setting values of a color extraction group are changed, these changes are also reflected in multiple 
checkers that the same color extraction group is specified. So you can adjust quickly.  On the other hand, 
even if you intend to change the color extraction of a certain checker, it may affec t the settings of other 
checkers. In this case, change the color extraction group to another group that is not used by other 
checkers. 

Setting Color Extraction Conditions 

1. Select "Inspection” > “Preprocess” from the main menu. 

The window to select a preprocess type appears. 

2. Select "Color Extraction". 

The window for selecting a color extraction group appears,  
the extraction display mode for the screen window is 
changed to "Single Color (Color BG)". 

3. Select a camera image to set color extraction from 
“Camera”. 

The camera image selected in “Camera” is displayed. 

4. Select a group to set from the table. 

The color extraction setting window appears. The extraction 
display mode for the screen window is changed to "Single 
Color (Color BG)".  
The extracted color of the highlighted extraction No. is 
displayed on the color image in "Color for Single Color". 

5. Set the maximum and minimum values of hue, 
saturation and value. 

Changing the values changes the extracted parts. 
The maximum and minimum values are indicated by red 
lines in the color field. The input range of each setting is 0 to 
255. Only for hue, the maximum value can be set to a 
smaller value than the minimum value. 
In this case, the part of hue that is not included in the range 
of the maximum and minimum values is extracted. When the 
maximum and minimum values are reversed, those values of 
hue are indicated by blue lines. 
In the color field, they are indicated by the blue lines. In 
addition, the columns of the values are highlighted in blue. 
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6. After setting is completed, press the CANCEL key. 

 
The color represented by the median between maximum and minimum values of hue, saturation and value 
is displayed as an extracted color. Note that the actual extracted color may be different from the assumed 
color if the range of the maximum and minimum values is wide. 

Setting Color Extraction Conditions by Sampling 
In "Sampling", a sampling area can be specified with a rectangle window. The maximum and minimum values 
of hue, saturation and value are automatically set to extract all the colors in the sampling area. If colors you 
want to extract are not extracted outside the sampling area, reexecute "Sampling" or finely adjust the maximum 
and minimum values determined by sampling. 

1. Select "Sampling". 

Now you can draw an area. 
 

 
• The default size of the area is as below. 

- 0.3-Mega Color Camera: 24 x 24 pixels 
-  2-Mega Color Camera: 36 x 36 pixels 

• If the size and the position of the area is changed, 
the changes are memorized until you exit from the 
setting window of color extraction. 

2. Move the whole rectangle and change the size. 

The procedures for moving the rectangle and changing 
the size are the same as the one for setting an inspection 
area. Specifying the end point determines the position 
and size of the area and displays the message saying 
"Changing the setting of Extraction No.**. Do you want to 
continue?". Select "Yes" to extract all the colors in the 
area. Select "No" to close the area setting window. 

 

 
 

 

 
 

Copying Color Extraction 

1. Highlight the color extraction number you want to 
copy and press the FUNC key. 

The pop-up menu appears. 

2. Select "Copy". 

3. Move the cursor onto the destination color extraction 
number and press the FUNC key. 

The pop-up menu appears. 
 

 
It cannot be copied to the number indicated in gray. 

4. Select "Paste". 

The color extraction is copied. 
 

 
If a color extraction has been already set in the 
destination, the message of overwrite confirmation 
appears. 
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Deleting Color Extraction Conditions 

1. Highlight the color extraction number you want to 
delete and press the FUNC key. 

The pop-up menu appears. 

2. To delete only the selected color extraction number, 
select “Delete”, and to delete all color extraction 
conditions, select “Delete All”. 

The confirmation screen is displayed. 

3. Select “Yes”. 

The selected color extraction number or all color 
extraction conditions are deleted. Select "No" to cancel. 
 

 

 

 

 

Setting Extracted Colors Used in Checker 

1. Select "Area Setting" > "Select Color Image" > "Set" 
from the setting menu of each checker. 

The selection window appears. The table shows 
"Registered" in the number that the color extraction 
condition has been already set. 
The screen window is changed to "Single Color (Color 
BG)". 

2. Select the color extraction number to use. 

Select necessary color extraction numbers using the 
"colors" displayed in the window as a reference. The color 
extraction numbers that cannot be used due to the 
selected color extraction mode or the number of 
connected cameras are displayed in gray. Up to eight 
color extraction numbers can be selected for one checker. 
The "X" mark is displayed in the "Select" column of the 
selected color extraction number, and the number appears 
in Select No. List. 
 

 
The color represented by the median between maximum 
and minimum values of hue, saturation and value is 
displayed as an extracted color. The actual extracted color 
may be different from the assumed color if the range of the 
maximum and minimum values is wide. 
 
Move the cursor onto "Extract" and press the ENTER key 
to set the conditions of "Color Extraction". 

3. After setting is completed, press the CANCEL key. 

Up to three color extraction numbers can be confirmed in 
"Area Setting " menu. 
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4.6.5 Setting Grayscale Preprocess 

In PV200, up to 16 sets of preprocess (A to P) can be registered per type and camera for grayscale images. 
The sets of preprocess A-P are preprocess groups. Up to 10 steps of filters can be set for a preprocess group. 
PV200 also has a function to temporarily disable a part of the specified 10 steps.  

Which preprocess group (A to P) is applied is set in the checker setting window. Preprocess can be modified 
also in setting window of a checker. 

 
Changing the setting values of a grayscale preprocess group also changes the setting values for the 
checkers which specify the same grayscale preprocess group. You can adjust quickly. On the other hand, 
even if you intend to change the grayscale preprocess of a certain checker, it may affect the settings of 
other checkers. In this case, change the grayscale preprocess group to another group that is not used by 
other checkers. 

Especially, note that the target grayscale images vary depending on the color preprocess when using a 
color camera. For adjusting the values of a grayscale preprocess, check if the change is appropriate for all 
the checkers that the grayscale preprocess group is used. 

 

1. Select "INSPECTION” > “Preprocess” from the menu 

bar. 

The screen to select a preprocess type appears. 

2. Select "Grayscale Preprocess". 

The screen to select a preprocess group is displayed. 

3. Select a camera image to set preprocess from “Camera”. 

The camera image selected in “Camera” is displayed. 

4. Select a preprocess group to set from “Preprocess”. 

The current setting of the preprocess group is displayed. 

5. Select "1ST". 

The screen of preprocess setting is displayed. 

 
 

6. Select “Filter Type” and specify the desired filter from 21 
types grouped into 6 categories. 

The image is updated to be an image applied the specified 
filter. 
The image before applying preprocess can be confirmed in 
the window navigator area (pointed by the arrow in the right 
figure). 
 
Two luminance graphs showing the gray level distribution are 
displayed in the lower part of the Preprocess setting window. 
"Input" shows the gray level distribution before applying 
Preprocess, and "Output" shows the one after applying 
Preprocess. 
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The magnification of the vertical axis of graphs can be changed. 
Increasing magnification displays gray levels that are difficult to see at 1-fold magnification, and 
enables them to be checked. 
Press the FUNC key and select “Luminance Graph Magnification” from the pop-up menu to 
specify magnification. It can be specify in a range of 1 to 1024. 
 

  

7. Set the parameter for the selected filter.  

Set details (Direction, Filter Size, Maximum, and Minimum, etc) as necessary. 
 

 
Direction is to apply the selected preprocess and the options are X, Y, and X/Y. 

8. Set 2ND to 10TH process as necessary.  

When multiple steps are set, PV200 processes from 1ST step in numeric order. 

9. After setting is completed, press the CANCEL key. 

 
As an image displayed in SETUP menu, an image in the mid-course phase of preprocess can be selected. 
Press the F1 key and select “Grayscale Preprocess” from the displayed Image menu. 



 

132 

S
etting Inspection C

onditions 
C

h. 4 

Copying Grayscale Preprocess 

1. Highlight the step you want to copy and press the FUNC key. 

The pop-up menu appears. 

2. Select "Copy". 

3. Move the cursor onto the destination step and press the 
FUNC key. 

The pop-up menu appears. 

4. Select "Paste". 

The preprocess is copied. 

 
 

If a preprocess has been already set in the destination, the message of overwrite confirmation appears. 
Selecting “Yes” executes copying the checker. 
 

Disabling the Set Preprocess 
Using this function disables a specified step and enables to execute an inspection or run a test without deleting 
the setting. 

1. Highlight the step you want to disable and press the FUNC key. 

The pop-up menu appears. 

2. Select "Invalid". 

The display in the column showing [Step] of the selected step 
changes to "----". 
In the example on the right, "2ND" changed to "----" to show the 
step is invalid. In this case, the image rotation of the third step is 
executed after the feature extraction of the first step. 

 
Select "Invalid" from the pop-up menu again to enable the 
preprocess in the invalid step. 

 

 
The invalid/valid setting is saved as type data. 
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Grayscale Preprocess Filter List 

Index 1 

 Main application: Denoising 

 Common 
parameter: 

Size: 3x3, 5x5, 7x7, 9x9 
Direction: X/Y, X(only), Y(only) 

 

Dilation 
Dark (or black) noises are 
removed. Black areas in the image 
of the object contract. White areas 
in the image of the object expand.  

 

 

Erosion 
Light (or white) noises are 
removed. White areas in the image 
of the object contract. Black areas 
in the image of the object expand.  

 

 

Erosion -> Dilation 
After removing light (or White) 
noises, return the contracted area 
to its original size.  

 

 

Dilation -> Erosion 
After removing dark (or black) 
noises, return the expanded area 
to its original size.  

 

 
 

Index 2 
Main application: Change in gray level 

 

Auto Correction 
Automatically corrects the 
brightness or contrast according to 
the luminance graph for the whole 
image. 

 

 

 

Gray Cut 
Reorganizes the specified 
grayscale range into the one 
between 0 and 255. This function is 
effective if there are any light or 
dark noises in the background, or if 
the contrast of the image of the 
object is low. 

 

 
 

Area Averaging 
Averages the brightness in the 
specified area. 
 

 Page 134 
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Correction Setting 
Divides 256 gray levels into 8 
groups. Nine-point gray levels are 
specified. It is possible to change a 
specific level. 

 

 

 

Area Averaging 

In Area Averaging, the pixel with the gray level of "Center Gray Level" 
+/- "Noise Range" is converted to "Center Gray Level". 

 

When "Center Gray Level" is 128 and "Noise Range" is 64, the gray 
level of the pixel the gray level of which is 64 to 192 is "128". 

 
 

When "Center Gray Level" is 50 and "Noise Range" is 70, the gray level 
for the pixel the gray level of which is 0 to 120 is converted to 50. 

In the case of the above setting, the gray level to be converted is -20 to 
120. However, as the gray level is only available in the range of 0 to 
255, it is processed as above.  

Correction Setting 

Gray levels in a range of 0 to 255 are divided into 8 blocks, and the gray levels can be changed at 9 points. 

1. Select "LUT Setting". 

The values are displayed only for the two points (i.e. 0 and 
255) among nine points. Tilting the ENTER key up/down 
increases or decreases the values at the points where the 
values are displayed. 
The luminance graph indicates the point that the value 
has been input in green and the point that is being 
changed in red. 

Tilting the ENTER key left/right/up/down moves 
the cursor. 
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2. Move the cursor onto the point you want to change 
the value and press the F2 "Auto Adjustment". 

The value for the selected gray level (at the point marked 
with a black circle on the graph) is displayed. 

3. Tilt the ENTER key up/down to specify the value. 

Changing the value moves the point on the luminance 
graph up/down. The other points are automatically 
adjusted along with the point moved up/down. 
At this time, the point that the value has been already 
input is not automatically adjusted as the value is fixed. 

 
In the right example, as the point with the gray level of 128 
is determined, the point on the luminance graph does not 
change even if the next gray level has been changed from 
160 to 200. 

4. After setting the necessary points, press the ENTER 
key or "CANCEL" key to fix the setting. 

 
 
 

 
 

Index 3 
Main application: Defocusing 

 

Median 
Removes light or fine noises. 

 

 

 

Smoothing 
Decreases noises by blurring an 
image to help measuring the 
position of the object.  

 

 
 

Index 4 

 Main application: Contour enhancement 

 Common 
parameter: 

Size: 3x3, 5x5, 7x7, 9x9 

 

Sobel 
Same as “Prewitt”. More easily 
extracts the area of lower contrast. 

 

 

 

Prewitt 
Extracts the area of which 
grayscale value changes. The 
image becomes an image with 
extracted outlines and edges of the 
object.  

 

 

Laplacian 
Extracts the area of which 
grayscale value changes. 
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Edge Extract X 
In the X direction, extracts the area 
of which grayscale value changes. 

 

 

 

Edge Extract Y 
In the Y direction, extracts the area 
of which grayscale value has been 
changed.  

 

 

Sharpen 
Enhances the area of which 
grayscale value changes. The 
image becomes sharp. The noises 
may also be enhanced.  

 

 

 

Index 5 
Main application: Flaw detection 

Tophat 
This is a filter to extract a point with a 
small area or a thin line.  

 

 

 

Dynamic 
Divides the image into specified 
areas, and performs Binary process 
by comparing the brightness in the 
area. It is helpful to binarize the image 
the brightness of which is uneven. 
 

 Page 136  

 

 

Frequency Extraction 
It can be executed with the 
combination of the process for 
smoothing the fine change in shading 
and the process for equalizing the 
moderate unevenness of brightness. 
 

 Page 136 
 

 

 

Setting Tophat 

1. Select the color of foreign objects you want to extract in 
"Segment Color". 

Black: Extracts the foreign objects darker than the background. 
White: Extracts the foreign objects lighter than the background. 

 

2. Specify the size (thickness) of the foreign 
objects you want to extract in "Size X/Y". 

The background information larger than the 
size specified here (such as patterns. The 
black horizontal lines in the example on the 
right) is removed. 
Select (check) "Set size X/Y individually." to 
set X and Y directions to different sizes. Now 
you can set Size Y. 
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Setting Dynamic thresholding 

Binarizes pixels using the threshold that is 
calculated by adding the offset value to 
the gray average of the specified size. 
The pixels with the gray level over the 
threshold change to white, and the pixels 
with the gray level below the threshold 
change to black. 

It is helpful to binarize the image the 
brightness of which is uneven or the 
image the brightness of which varies. 

 
  Binary┌────┴────┐Dynamic 

  

1. Set "Size X/Y". 

Set a range to calculate the average. 
Select (check) "Set size X/Y individually." to set X and Y 
directions to different sizes. Now you can set Size Y. 

2. Set "Offset". 

When the average is 100 and the offset is -30, binarizes the 
pixels with the gray level over 70 to white and the pixels with the 
one below 70 to black. 

 

About Frequency Extraction 

Two filters are provided, which are Smoothing Filter and Sharpening Filter. 

Using "Smoothing Filter" removes fine edges. Defocused image can be obtained in whole. (Removes high 
frequencies.) Using "Sharpening Filter" removes the part showing the modest variation in brightness. Image 
with a clear-cut edge can be obtained. (Removes low frequencies.) Using these two filters in combination 
enables a specific frequency to be obtained. 

1. Select and check "Smoothing Filter". 

2. Set "Size X/Y". 

If "Sharpening Filter" is unchecked, only the 
result of the application of Smoothing Filter 
can be confirmed. 
Set the appropriate value to remove 
unnecessary edges by increasing the value 
checking the image. 
 
Select (check) "Set size X/Y individually." to 
set X and Y directions to different sizes. Now 
you can set Size Y. 
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3. Select and check "Sharpening Filter". 

4. Set "Size X/Y" and "Gain". 

Set the value to enhance the part you want to 
extract checking the image. 
Increasing the gain makes the difference in 
the gray level of the image larger. 

 

Index 6 
Main application: Rotation and Reflection 

 

Rotation 
Rotate the whole captured image at a 
specified angle. The gray level can be 
specified for the blank spaces of the image 
created by the rotation (i.e. the gray area 
in the right figure). 
When rotating the image partially 
captured, the area out of the capturing 
range is also displayed with the specified 
background luminance (gray level). 
After the image rotation, the blank space 
created by the rotation (displayed with 
background luminance) is also 
preprocessed and inspected as a part of 
the image. 
Also, when "Part Area" is set and the 
image is rotated, the capturing range is the 
size of the image that partial imaging has 
not been executed. Refer to page 111. 

 

 

 

   

Reflect 
Reflects an image. 
The direction of reflection is selected from 
either "Vertical axis" or "Horizontal axis". If 
the preprocess is executed for an image 
partially captured with setting the direction 
to "Horizontal axis", the whole captured 
image is reflected with a horizontal axis as 
the center of reflection to perform the 
inspection. 

 

Vertical 
axis 

 
 

 
 
 

Horizontal 
axis 

 
 

 

4.6.6 Preprocess Image Switch Function 

(Available from Ver.2.00) 
The display of an image when setting a checker can be switched between the original image (Live/Memory) 
and preprocess image. 

1. Press the F2 key when setting a checker. 

The image on the screen window is switched to the preprocess 
image. Press the F2 key again to return to the original image 
display. 
(Except Color Window) 
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4.7 Setting Inspection Area and Conditions (Checker) 

4.7.1 Types and Overview of Checkers 

Checker is a general term of the areas and the conditions for inspecting a captured image. 

Eighteen types of checkers are available in the PV200. You can set up to 1000 checkers per product type and 
checker type (when the number of used blocks is 10). However, the maximum number of checkers available for 
a type is 1000. 

 
 The way of counting differs depending on checkers. One checker is not always counted as one. 

Before you create a new checker, confirm the number of set checkers displayed on the checker 
number selecting window. 

 The default number of used blocks is one. At this time, checkers can be set to No.000 to 099. If you 
want to use checkers after No.100, change the number of used blocks. For the information of the 
number of used blocks, refer to Chapter 4.4, page 113. 

Types of Checkers 
The following checkers are available in the PV200. 

 

Line 
Main application: Presence/absence inspection, Counting 

 

Description: Line binarizes an image captured by a camera and 
measures white or black pixels on a line. Judges as 
OK or NG on the measured value. 

Refer to: 150 p 

 

Binary Window 
Main application: Measurement of size, Presence/absence inspection 

 

Description: Binary Window binarizes an image captured by a 
camera and measures an area or the number of white 
or black pixels. Judges as OK or NG on the measured 
value. 

Refer to: 154 p 

 

Gray Window 
Main application: Measurement of brightness, Orientation recognition 

 

Description: Calculates the gray average values of all pixels in a 
specified area and judges as OK or NG using the 
measured number. 

Refer to: 157 p 

 

Binary Edge 
Main application: Position detection, Measurement of length (at high 

speed) 

 

Description: Binary Edge binarizes an image captured by a camera 
and detects an edge between white and black pixels. 
Judges as OK/NG according to its existence. 

Refer to: 160 p 
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Gray Edge 
Main application: Position detection, Measurement of length (at high 

inspection accuracy) 

 

Description: Gray Edge detects a brightness changing point on a 
grayscale image and judges as OK or NG in accordance 
with the number of detected points. This function is 
effective if the variation in image brightness is small and 
the contrast of an edge is low. 

Refer to: 164 p 

 

Feature Extraction 
Main application: Position detection, Angle detection, Counting 

 

Description: Binarizes an image captured by a camera and detects 
a specified size of clusters of white or black pixels and 
judges as OK or NG depending on the measured 
number. Outputs the feature quantity such as the 
coordinates of a center of gravity or principal axis 
angle (+/-90 degrees). 

Refer to: 169 p 

 

Smart Matching 
Main application: Position detection, Angle detection, Type recognition 

 

Description: Smart Matching searches and detects a similar part to 
the registered image pattern. 
Outputs the detected position and angle, and similarity 
degree (correlation value). Scans with a gray image. 

Refer to: 176 p 

 

Contour Matching 
Main application: Position detection, Angle detection 

 

Description: Contour Matching searches and detects a similar part 
to the contour of the registered image. Outputs the 
detected position and angle, and similarity degree 
(correlation value). Scans with contour information 
generated based on a gray image. 

Refer to: 193 p 

 

Flaw Detection 
Main application: Flaw detection, Detection of a flaw, missing 

edge, burr on the surface, Detection of a dirt 

 

Description: Calculates gray average value within the 
segmented area (cell) in a line, arc and circle 
or rectangular area. If the PV200 detects an 
area more than a certain level of difference in 
average gray, the device judges it as a flaw. 

Refer to: 188 p 

 

Connector (Binary Window, Gray Window) 
Main application: Appearance inspection of lead pins 

 

Description: Inspects appearance of many pins using the method 
of Binary Window or Gray Window checker. 

Refer to: 214 p 
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Connector (Gray Edge) 
Main application: Measurement of pitch of lead pins, float check, 

Connector gap, Width measurement 

 

Description: Using the edge detecting principle of Gray Edge, 
Connector (Gray Edge) measures pitches of many 
pins, detects floats, and measures gaps of a 
connector. It has also Detect Mode which inspects 
width or height of parts, using many edges. 

Refer to: 220 p 

 

Smart Edge (Circle)  
Main application: Detection of the center point of round object, detection of 

a missing edge, burr on the surface, detection of the 
position or angle of projection, circularity inspection 

 

Description: Detects the radius or diameter of a round object based on 
the coordinate value of the edge of the object detected by 
setting a number of cells. 
A ring-shaped object or circular object can be inspected. 

Refer to: 231 p 

 

Smart Edge (Line)  
Main application: Detection of the position or angle of uneven end face. 

 

Description: Detects the approximate line based on the coordinate 
value of the edge of the end face detected by setting a 
number of cells. 
Detecting the coordinate value or angle of the 
approximate line enables the detection of the position or 
angle of the object by setting only one checker. 

Refer to: 250 p 

 

Color Window 
Main application:  

 
Description: Calculates the maximum, minimum, average and standard 

deviation values of each gray value of R, G and B in the 
inspection area set for a color image. 

Refer to: 265 p 

 

Position/Rotation Adjustment 
Main application: Adjustment of object position and rotation 

angle 

 

Description: Detects the misalignment and rotation 
angle of the object from the base position. 

Refer to: 268 p 

 

Area Size Adjustment 
Main application: Adjustment of area size of checkers 

 
Description: Detects the size of the object.  

Refer to: 282 p  
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Geometry Calculation  
Main application: Geometry calculation using detected data 

 

Description: Conduct seven kinds of geometry calculations using the 
coordinate values and lines detected by each checker. 
Items such as the intersection point of two lines or 
approximate circle can be calculated without setting 
operation expressions. 

Refer to: 286 p 

 

Character/Figure Drawing   
Main application: Display of inspection data or results on the screen 

window 

 

Description: Draw six kinds of figures including characters using 
detected data on the screen window It is possible to 
change the drawing color or draw figures in the detected 
area depending on inspection results. 

Refer to: 339 p 

4.7.2 Creating a Checker 

Creating a New Checker 

1. Select “INSPECTION” > "Checker". 

2. Select a checker type to create in "Checker Type". 

3. Select the checker No. list and specify a checker 
number to create. 

A new checker of the specified type is created and setting 
window is displayed. 
 
To select the number not displayed in the list, move the 
cursor to display the desired number or specify the number 
in “Checker No.” field above the table. 

 
As the default setting, the number of available checkers is 
100 (0-99) for each checker. Increasing the number of 
blocks enables to create checkers after No.100. To set the 
number of blocks, select “TYPE” > "Type Setting > 
"Execution Condition" > "Number of Blocks". 
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Copying Checker 

1. Move the cursor onto the checker number you want to copy and press the FUNC key. 

The Pop-up menu appears. 

2. Select "Copy". 

3. Move the cursor onto the destination checker number and 
press the FUNC key. 

The Pop-up menu appears. 

4. Select "Paste". 

The checker is copied. 
 

If a checker already exists in the destination, the message of 
overwrite confirmation appears. Selecting “Yes” executes pasting 
the checker. 

 

5. Press the ENTER key to select the pasted checker. 

The setting window of the pasted checker is displayed. 
 

 The retention period of copy information varies depending on the version of PV200 as below.  

 The copied information will be retained until the following events even if the checker number list is 
closed. 

 When another checker (checker number, checker type) is copied 

 When the copy source checker is deleted 

 When the type of copy source is deleted 

 When the type is initialized 

 When the mode is switched to RUN menu / when setting data is read 

 When the source data is changed by reading SD type 

 Copy information of checkers is treated in units of submenus of "Inspection". Therefore, "Position 
Adjustment", "Area Size Adjustment", "Checker", "Numerical Calculation", "Judgement" and "Draw 
Character/Figure" has each copy information. 

 If the setting of the copy source checker is edited before "Pasting" the copied checker, the edited 
setting will be pasted. After pasted, the checker of copy source and the pasted checker are 
separated each other. 

Copying Checker and Using it in Another Type  

1. Move the cursor onto the checker number you want to copy and press the FUNC key. 

The pop-up menu appears. 

2. Select "Copy". 

3. Change the type to the type of the 
destination. 

 
 

4. Highlight the checker number you want 
to paste and press the FUNC key. 

 

 

 
 

5. Select "Paste". 

The checker is copied. 
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If a checker already exists in the destination, the message of overwrite confirmation appears. Selecting 
“Yes” executes pasting the checker. 

 

6. Press the ENTER key to select the copied checker. 

The setting window of the copied checker is displayed. 
 

 
 If performing the following operations before pasting a copied checker, the copy information will be 

canceled. 
- Another checker (checker number, checker type) is copied. 
- The copy source checker is deleted. 
- The type of copy source is deleted. 
- All types are initialized. 
- The mode is switched to RUN menu / when setting data is read. 
- The source data is changed by reading SD type. 

 Note that specific values * of "Color Preprocess (Grayscale Conversion / Color Extraction), 
"Grayscale Preprocess" and "Slice Level" will not be copied when a checker is copied between 
difference types. Only the group name selected in each checker will be copied. If you need the 
same values as those for the type of copy source, directly set the same values for the type of 
destination, from "INSPECTION" > "Preprocess" > "Grayscale Conv.", "Color Extraction" or 
"Grayscale Preprocess", and "INSPECTION" > Slice Level".  

*: RGB coefficients for Grayscale Conversion / Extracted color for Color Extraction (hue, saturation, 
luminance) / Type used in Grayscale Preprocess / Upper and lower limits in Slice Level 

Deleting a Checker 

1. Move the cursor onto the checker number you want to delete and press the FUNC key. 

The pop-up menu appears. 

2. Select "Delete". 

The confirmation screen is displayed. 

3. Select “Yes”. 

The checker is deleted. Select "No" to cancel. 
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Displaying a checker list 
The checker list shows created/uncreated checker, comment, camera number and inspection result. 

 

Checker status, Comment 

The column on the right of checker number shows comments. The 
comments input in the checker setting window are displayed. When 
you have not set a comment for the checker, the list shows “Enter 
Comment”. 

If any characters are displayed in the comment field, the checker of 
that number is already created. 

 

Camera No. 

Checker number and comment fields are displayed in different colors 
for each camera number selected in "Camera" in the checker setting 
window.  

- Camera No.0: Green 
- Camera No.1: Yellow 

 

 

Inspection Result 

When the inspection result is abnormal, "ERROR(####)" (#### = 
Alphanumeric characters) is displayed in the comment field, and the 
cause of the error is displayed in the field below the list. 

Only the checkers judged as NG and the checkers with abnormal 
inspection results can be displayed in the following method. 

1. Press the FUNC key. 

The pop-up menu appears. 

2. Select "Display NG checkers only". 

Only the checkers that are judged as NG are displayed. 
 

 
When “None” is displayed, it shows all the checkers of the 
selected types are judged as OK. 

 
Repeat the above 1 and 2 again. Now, all checker numbers are 
displayed. 

 

 



 

146 

S
etting Inspection C

onditions 
C

h. 4 

Selecting Display Pattern on Screen Window 
Set the display methods of various patterns to be displayed on the screen window in SETUP Menu. 

The display methods are selected for the following patterns. 
 Arrows indicating the inspection area and scan direction of checkers (including Position Adjustment and 

Area Size Adjustment) 

 Result of Geometry Calculation 

 Figures set in Character/Figure Drawing 
 Coordinate Axis 

However, in the window to set the above checkers (e.g. when selecting "INSPECTION" > "Geometry 
Calculation"), select whether or not to display only the patterns of the selected checker number or checker 
type instead of selecting "Display/Hide". 

1. Press the F1 key in SETUP Menu. 

Image menu is displayed. 

2. Select "Pattern Display". 

3. Select “Display” or “Hide” for "Pattern Display". 

Specify the conditions to display patterns in the checker 
setting window ("INSPECTION" > "Checker") and the 
checker list window ("INSPECTION" > "Checker List"). 

 
All Checkers (Default): 
When selecting this, all the set checker patterns are 
displayed. 

 
Selected Checker Type:  
The checker patterns of the checker type selected in 
"Checker Type" are displayed. If Smart Matching 
Checker No. 0 is selected, all the checker patterns that 
have been set for Smart Matching checker are 
displayed. 

 
Selected Checker: 
Only the checker pattern for the checker number 
currently being selected is displayed. 
If Smart Matching Checker No. 0 is selected, only that 
checker pattern is displayed. 

4. Select whether to display an arrow to indicate the 
scan directions of checkers or not in "Scan 
Direction". 

Target Checker 
Binary Edge / Gray Edge / Connector (Gray Edge) / 
Smart Edge (Circle) / Smart Edge (Line) 

 

 
 

 
 

 

5. Select “Display” or “Hide” for "Geometry Calculation" and "Character/Figure Drawing". 

In the window after selecting Geometry Calculation or Character/Figure Drawing, select "All Checkers" or 
"Selected Checker" for the condition to display patterns. 

6. Select "No", "Origin" or "Image Center" for "Coordinate Axis". 

[No]: Hides a coordinate axis. (Calibration will be executed.) 
[Origin]: Displays the coordinate axis passing through the origin. 
[Image Center]: Displays the coordinate axis passing through the center of an image. 
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Hiding Pattern on Screen Window 

The checker patterns displayed on the screen window can be hidden in SETUP Menu. 

Pressing the F3 key switches between displaying and hiding. 

Pattern Display Hide Pattern 

 

 
This selection is kept until you cut the power of PV200. Once you reboot PV200, the patterns will be displayed. 

Common settings for checkers 
The procedures for selecting Camera, setting Preprocess, selecting Slice Level group and selecting Position 
Adjustment group set for each checker except Color Window are common to all checkers. As for Slice Level 
group, it is set only for the checkers that scan objects with binary images. 

Selecting a Camera 
Select which camera image is used for inspections. 

1. Select "Area Setting" > "Camera". 

Select a camera number to use. 

Selecting Usage of Color Image in Inspection 
Set this when using a color camera. 

1. Select "Area Setting" > "Select Color Image". 

Select "Converted Gray Img." or "Extracted Color Img.". 
- Converted Gray Img.: Inspects the grayscale image converted from a color image. 
- Extracted Color Img.: Inspects the image created by extracting specific colors of a color image. 

2. Select "Set". 

- When selecting "Converted Gray Img." in step 1, select a grayscale conversion group  (A to P). 
- When selecting "Extracted Color Img." in step 1, select a color in "Color Extraction No.". (More than 

one colors can be selected.) Refer to page 129 for details. 

3. After setting is completed, press the CANCEL key. 

The selected extraction number is displayed above the "Set" button of "Select Color Image". 

Selecting Preprocess / Slice Level Group 
Select a preprocess and slice level group to apply on an image captured by a camera. 

1. Select “Inspection Condition” > "Preprocess". 

“Preprocess” window is displayed. 

2. Select a Grayscale preprocess group (A to P) in “Grayscale Preprocess”. 

 For details of preprocess, refer to page 130. 
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3. After setting is completed, press the CANCEL key. 

Return to “Inspection Condition” setting window. The selected preprocess group is displayed. 

4. Select “Slice Level". 
“Slice Level” setting window is displayed. 

5. Select a Slice Level group (A to P). 

For the details on binarization, refer to page 124. 

6. After setting is completed, press the CANCEL key. 

Return to “Inspection Condition” setting window. The selected slice level group is displayed. 

Selecting Position Adjustment 
Position Adjustment is helpful when position or angle of an inspection object is unstable. Select a Position 
Adjustment checker that has been already set. Refer to page 268 for details of position adjustment. 

1. Select "Position Adj." in Area Setting window. 

The list of position adjustment is displayed. 
 If a position adjustment checker is not created, “Position Adj.” cannot be selected. 

2. Select a Position Adjustment No. from the list. 
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4.7.3 Moving Checkers in Group 

When you want to move the checker areas after creating checkers, you can move the areas of checkers set for 
each camera by checker types or setting value of Position Adjustment. 

This function is helpful to move several checkers or to move them keeping the positions between them. 

1. Select “INSPECTION” > "Group Move". 

2. Specify a camera No. used by the checkers you want to 
move in [Camera]. 

3. Specify conditions of checkers to move in "Position 
Adjustment". 

 
No: 
To move the checkers that select "No" for Position Adjustment 
in the checker setting window. 

 
Select All: 
To move all checkers regardless of the settings of Position 
Adjustment in the checker setting window. 

 
Select Position Adjustment No.: 
Select a Position Adjustment which is already set.  
To move the checkers that select the same Position 
Adjustment No. in the checker setting window. 

4. Take the “X” mark off the checker to exclude from 
group move to [No]. 

Unset checkers are not needed to be set to [No]. 
 

 
As a result of the above setting, if there is no checker to be 
moved, the "Move" button is shown in gray and cannot be 
selected. 

5. Press [Move] button to move the areas. 

After moving them, press the ENTER key to fix the position. 
Pressing the CANCEL key cancels group move. 

 
Now you have completed group move. 
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4.7.4 Line 

What is Line? 

Line checker binarizes an image captured by a camera and 
counts target colored pixels and the number of objects on a 
line. Judges as OK/NG according to those values. 

 

Output Data 

No. of Pixels: Outputs in the number of target colored pixels on the line. 

No. of Objects: The number of parts of pixel string. 

Example) 

 
Target color = black 
No. of Pixels = 7, No. of Objects = 2 

 

Pixel Judgement: If detected pixel count is within the allowable range you have set, the object will be 
judged as "OK", if it exceeds the allowable range, the object is judged as "NG". 

Objects 
Judgement: 

If detected object count is within the allowable range you have set, the object will be 
judged as "OK", if it exceeds the allowable range, the object is judged as "NG". 

(Total) Judgement: Total judgement result of Pixel Judgement and Objects Judgement. 
If two of them are “OK”, the object will be judged as "OK"; otherwise, the object will 
be judged as "NG". 

Specifying Checker No. 

1. Select “Line” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Line” setting window is displayed. The binary image is 
displayed on the screen window regardless of camera 
type. 

 

Selecting a Camera 
Select a camera image to set “Line” checker. 

1. Select “Area Setting” in “Line” setting 

window. 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed. 
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3. Select how to convert a color image in "Select Color Image". (when using a color camera) 

The binary image converted by the selected method is displayed. 
 page 147. 

 
 

Select a displayed image type (Live/Memory and Gray/Color/Binary) or magnification in “Image Menu” 

opened by pressing the F1 key. 

Selecting Grayscale Preprocess / Slice Level Group/ 
Position Adjustment 

 page 147 

Setting an Inspection Area 
Set a line which is the inspection span. 

 
You cannot set a Mask Area in Line checker. 

1. Select “Area Setting” in “Line” setting window. 

2. Select "Area Setting". 

Area setting window is displayed. 

3. Select a shape of inspection area from 
“Change Shape”. 

Line, Broken line, and Ellipse are available. 

4. Select “Change” and draw an area. 

Refer to the section of Drawing an 
Inspection Area, page 63. 

5. After drawing is completed, press the 
CANCEL key. 

 

Using Area Size Adjustment 

Area Size Adjustment is a function for inspecting variable-sized objects. The function adjusts an inspection 
area according to the size of the object detected with Area Size Adjustment checker. 

Refer to Chapter 4.9, page 282 about Area Size Adjustment and the setting procedure. 

Selecting a Target Color 
Set to count pixels of either white or black on a binary image. Target color can be selected for each of pixel 
counting and object counting. 

1. Select “Inspection Condition” > “Count Pixel 
Color”. 

2. Select “White” or “Black” to detect. 

White (default):  
Counts the number of white pixels within the area. 
Black:  
Counts the number of black pixels within the area.  

3. Select “Count Object Color”. 

4. Select “White” or “Black” to detect. 
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White (default): Counts the number of white objects within the area. 
Black: Counts the number of black objects within the area. 

Dilation and Erosion on Binary Image (Filter) 

This is the function that dilates or erodes the pixels of color selected for target color to count. Use this function 
mainly when you delete a slight noise or enhance a detected area. If applying this function is not necessary, 
proceed to the next step. 

1. Select “Inspection Condition” > "Filter". 

The list of settable filters is displayed. 

2. Select "Filter" to process the image to be a desired image. 

Changing filters updates the displayed image. Confirm it and set. 
 
 

Setting Criteria for Counting Objects 
Set object criteria to count. The following two items are the criteria. 

 Min. Object Size: 
Decides the number of pixels to regard as an object. 

 Min. Gap Size: 
Decides the minimum value of gap which is the number of pixels lying between objects and with 
different color from target. 

 

Example 1) 
 Min. Object Size = 2 

 Min. Gap Size = 3   

 
Example 2) 
 Min. Object Size = 3 

 Min. Gap Size = 5  

 
 

1. Select "Inspection Condition". 

2. Enter “Min. Object Size” and “Min. Gap 
Size”. 
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Setting Judgement Limits 
Set tolerance (Maximum and Minimum values) of the counted pixels and objects. If the counted pixels and 
objects are within the tolerance, the object will be judged as "OK", if it is out of it, the object is judged as "NG". 

1. Select "Judgement Limits". 

2. Enter "Max. No. of Pixels." and "Min. 
No. of Pixels". 

Enter the values in pixels. 

3. Enter "Max. No. of Objects." and "Min. 
No. of Objects." 

4. After inputting is completed, press the 
CANCEL key. 

 

 
 

Running a Test 
Confirm if the current settings perform an inspection properly. 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
Position adjustment and area size adjustment are also executed at the same time if they are used. 

2. Confirm the inspection result. 
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4.7.5 Binary Window 

What Is Binary Window? 

Binary Window binarizes an image 
captured by a camera and measures an 
area or the number of white or black 
pixels. Judges as OK/NG according to 
the measured area. 

 

Output Data 

Area: Outputs in the number of pixels. 

Judgement: If the number of detected area is within the allowable range you have set, the object will 
be judged as "OK", if it exceeds the allowable range, the object will be judged as "NG". 

Specifying Checker No. 

1. Select “Binary Window” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Binary Window” setting window is displayed. The binary 
image is displayed on the screen window regardless of 
camera type. 

 

Selecting a Camera 
Select a camera image to set Binary Window checker. 

1. Select “Area Setting” in “Binary Window” 

setting window. 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed. 
 

 

 

3. Select how to convert a color image in "Select Color Image". (when using a color camera) 

The binary image converted by the selected method is displayed. 
 page 147. 

 
 

Select a displayed image type (Live/Memory or Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 
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Selecting Grayscale Preprocess / Slice Level Group 
/ Position Adjustment 

 page 147 

Setting an Inspection Area 
Set a range to measure area. 

1. Select “Area Setting” in “Binary Window” setting window. 

2. Select "Area". 

“Area Setting” window is displayed. 

3. Select a shape of inspection area from “Change Shape”. 

Select from Rectangle, Ellipse, Circle and Polygon. 

4. Select “Change” and draw an area. 

Refer to section of Drawing an Inspection Area (page 63). 

5. After drawing is completed, press the CANCEL key. 

When you want to exclude a part from inspection (Mask area) 

Up to 16 mask areas, where checker does no inspection, can be set in an inspection area. 

Select "Add Mask" in “Area Setting”, specify a shape and draw an area. Refer to section of Setting a Mask Area 
(page 67) for details. 

Using Area Size Adjustment 

Area Size Adjustment is a function for inspecting variable-sized objects. The function adjusts an inspection 
area according to the size of the object detected with Area Size Adjustment checker. 

Refer to Chapter 4.9, page 282 about Area Size Adjustment and the setting procedure. 

Using Auto Area Setting / Auto Mask Area Setting  

Auto Area Setting and Auto Mask Area Setting are functions which enable to set areas used fo r 
inspections automatically. The shape of an object is automatically recognized, and the detected result is 
referred in each checker as an inspection area. Also, inspection areas automatically set can be referred as 
masks. For details of Auto Area Setting, Refer to “Using Auto Area Setting (page 286)”.  

Select a Target Color 
Set to detect pixels of either white or black on a binary image. 

1. Select “Inspection Condition” > "Target". 

2. Select “White” or ”Black” to detect. 

White (default): Measures the area of the pixels in 
white. 
Black: Measures the area of the pixels in black.  
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Dilation and Erosion on Binary Image (Filter) 

This is the function that dilates or erodes the pixels of the color selected in “Target”. Use this function mainly 
when you delete a slight noise or enhance a detected area. If applying this function is not necessary, proceed 
to the next step. 

1. Select “Inspection Condition” > "Filter". 

The list of settable filters is displayed. 

2. Select "Filter" to process the image to be a desired image. 

Changing filters updates the displayed image. Confirm it and set. 

Setting Judgement Limits 
Set a tolerance (Maximum and Minimum values) of the measured area. If the measured area is within the 
tolerance, the object will be judged as "OK", if it is out of it, the object is judged as "NG". 

1. Select "Judgement Limits". 

2. Input the setting values for "OK Judge. Max." and "OK Judge. Min". 

Enter the values in pixels. 

3. After inputting is completed, press the CANCEL key. 

Running a Test 
Confirm if the current settings perform an inspection properly. 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
 

Position adjustment and area size adjustment are also executed at the same time if they are used. 

2. Confirm the inspection result. 
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4.7.6 Gray Window 

What Is Gray Window? 

Gray Window calculates the gray average of the 
inspection area based on the gray values of every 
pixel on a gray image captured by a camera. And 
then the checker judges as OK/NG using the value. 

 

Output Data 

Gray Average: Average of gray value within an area. 

Judgement: If the calculated gray average is within the allowable range you have set, the object will 
be judged as "OK", if it exceeds the allowable range, the object will be judged as "NG". 

Specifying Checker No. 

1. Select “Gray Window” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Gray Window” setting window is displayed. The gray 
image is displayed on the screen window regardless of 
camera type. 

 

Selecting a Camera 
Select a camera image to set “Gray Window” checker. 

1. Select “Area Setting” in “Gray Window” setting window. 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed. 

3. Select how to convert a color image in "Select Color Image". (when using a color camera) 

The gray scale image converted by the selected method is displayed. 
 page 147. 

 
 

Select a displayed image type (Live/Memory or Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 

Selecting Grayscale Preprocess / Position 
Adjustment 

 page 147 
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Setting an Inspection Area 
Set an area to measure gray average. 

1. Select “Area Setting” in “Gray Window” setting window. 

2. Select "Area". 

“Area Setting” window is displayed. 

3. Select a shape of inspection area from “Change Shape”. 

Select from Rectangle, Ellipse, Circle and Polygon. 

4. Select “Change” and draw an area. 

Refer to section of Drawing an Inspection Area (page 63). 

5. After drawing is completed, press the CANCEL key. 

Using Area Size Adjustment 

Area Size Adjustment is a function for inspecting variable-sized objects. The function adjusts an inspection 
area according to the size of the object detected with Area Size Adjustment checker. 

Refer to Chapter 4.9, page 282, about Area Size Adjustment and the setting procedure. 

When you want to exclude a part from inspection (Mask area) 

Up to 16 mask areas, where checker does no inspection, can be set in an inspection area. Select "Add Mask" in 
“Area Setting”, specify a shape and draw an area.  
For details, refer to page 67, “Setting a Mask Area”. 

Using Auto Area Setting / Auto Mask Area Setting  

Auto Area Setting and Auto Mask Area Setting are functions which enable to set areas used for 
inspections automatically. The shape of an object is automatically recognized, and the detected result is 
referred in each checker as an inspection area. Also, inspection areas automatically set can be referred as 
masks. For details of Auto Area Setting, Refer to “Using Auto Area Setting (page 286)”  

Setting Judgement Limits 
Set a tolerance (Maximum and Minimum values) of gray average. If the measured gray average is within the 
tolerance, the object will be judged as "OK", if it is out of it, the object will be judged as "NG". 

1. Select "Judgement Limits". 

2. Input the setting values for "OK Judge. Max." and "OK Judge. Min". 

3. After inputting is completed, press the CANCEL key. 

Running a Test 
Confirm if the current settings perform an inspection properly. 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 
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Position adjustment and area size adjustment are also executed at the same time if they are used. 

2. Confirm the inspection result. 
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4.7.7 Binary Edge 

What Is Binary Edge? 
Binary Edge binarizes an image captured by a camera and detects an edge between white and black pixels. 
The checker judges as OK or NG in accordance with the number of detected points. 

 

Detect Example) 
Condition: Scan direction = Horizontal 

Edge Condition = Black -> White 
Detected Position =All 

Condition: Scan direction = Vertical 
Edge Condition = White -> Black 

 
 

Output Data 

Coordinates X and Y of edges 

Detect color of edges (+ / -): Type of an edge, which is white -> black (-) or black -> white (+). 

No. of Objects: The number of detected edges. The value is 0 to 256. 

Judgement: If the number of detected objects is within the range you have set, the object 
will be judged as "OK", if it exceeds the range, the object is judged as "NG". 

Specifying Checker No. 

1. Select “Binary Edge” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Binary Edge” setting window is displayed. The binary 
image is displayed on the screen window regardless of 
camera type. 

 

Selecting a Camera 
Select a camera image to set Binary Edge checker. 

1. Select “Area Setting” in “Binary Edge” setting window. 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed. 

3. Select how to convert a color image in "Select Color Image". (when using a color camera) 

The binary image converted by the selected method is displayed. 
 page 147. 

 
 

Select a displayed image type (Live/Memory or Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 

Selecting Grayscale Preprocess / Slice Level Group 
/ Position Adjustment 
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 page 147 

Setting an Inspection Area 
Set a range to detect an object. 

 
You cannot set a Mask Area in Binary Edge checker. 

1. Select “Area Setting” in “Binary Edge” setting window. 

2. Select "Area (Set)”. 

“Area Setting” window is displayed. 

3. Select a shape of inspection area from “Change Shape”. 

Select from Line and Plane. 
For detecting a flat edge at high speed, Line scan is suitable. And Plane scan 
suits for detecting a round or pointed edge. 

4. Select “Change” and draw an area. 

Refer to section of Drawing an Inspection Area (page 63). 

 

5. After drawing is completed, press the CANCEL key. 

Using Area Size Adjustment 

Area Size Adjustment is a function for inspecting variable-sized objects. The function adjusts an inspection 
area according to the size of the object detected with Area Size Adjustment checker. Refer to Chapter 4.9, 
page 282 about Area Size Adjustment and the setting procedure. 

Selecting Detect Condition of Edge 
Set detailed conditions such as detecting direction of edge. 

1. Select "Inspection Condition". 

Set Scan Direction, Edge Condition, Detected Position. 

2. Select "Search Method". 

Set "Filter" and "Width". 
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About Conditions 
Scan direction (Horizontal/Vertical) -- Only Plane scan 

Horizontal: Scans horizontally* from the start to the end points. 

 

Vertical: Scans vertically* from the start to the end points. 

 
*If you set a rotated area, it scans at the rotated angle. 

Scan direction = Horizontal 

 
 

Edge Condition (White -> Black(-) / Black -> White(+) / Both) 

White -> Black(-) 

Detects a point changing from 
white to black as an edge. 

Black -> White(+) 

Detects a point changing from 
black to white as an edge. 

Both 

Detects both point from white to 
black and from black to white. 

   
 
 

Detected Position (Front / All) 

Front 

Scans from the start point and detects the first 
edge. 

All 

Detects all edges which meet the condition in the 
area. Use this to count the number of edges. 

 
No. of Objects = 1 

 
No. of Objects = 2 

 

Filter/Width 

These are conditions of object size. The function prevent from detecting undesired part such as noise within the 
area. Adjust them when desired edge cannot be detected after testing. 

 

Filter: Condition of length in scan direction. 

 

Width: Condition of length in the direction at right angle to 
the scan. 

Example: 

When you want to detect “A” in the right figure as an edge, set 
Filter to 20 and Width to 40. 

The first object with length in scan direction 10 and the nose 
with width 30 are not detected. And only “A” meets the 
condition and is detected. 
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Dilation and Erosion on Binary Image (Filter) 

This is the function that dilates or erodes the pixels of color selected in “Edge Condition”. Use this function 
mainly when you delete a slight noise or enhance a detected area. If applying this function is not necessary, 
proceed to the next step. 

1. Select “Inspection Condition” > "Filter". 

The list of settable filters is displayed. 

2. Select "Filter" to process the image to be a desired image. 

Changing filters updates the displayed image. Confirm it and set. 

Setting Judgement Limits 
Set a tolerance (Maximum and Minimum values) of the number of detected edges. If the number of detected 
edges is within the tolerance, the object will be judged as "OK", if it is out of it, the object will be judged as "NG". 

1. Select "Judgement Limits". 

2. Input the setting values for "OK Judge. Max." and "OK Judge. Min". 

3. After inputting is completed, press the CANCEL key. 

 
 

Running a Test and Confirming Result 
Confirm if the current settings perform an inspection properly. To observe the image easily, set “Window 
Transparency (SETUP menu)” to larger value. (See “Changing Window Transmittance”, page 439 ) 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
Position adjustment and area size adjustment are also executed at the same time if they are used. 

2. Confirm a judgement result and the number of detected objects. 

 
The list of detected edges is displayed in the lower part of the setting window. 
When selecting this table and highlighting an edge data, the mark on the screen window indicating the 
detect position turns to pink. 
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4.7.8 Gray Edge 

What Is Gray Edge? 
Gray Edge detects a brightness changing point (edge) on a grayscale image and judges as OK or NG in 
accordance with the number of detected points. This function is effective if the variation in image brightness is 
small and the contrast of an edge is low. 

 

Detect Example) 
Condition: Scan direction = Horizontal 

Edge Condition = Dark -> 
Light 
Detected Position =All 

Scan direction = Vertical 
Edge Condition = Light -> 
Dark 

Scan direction = Clockwise 
Edge Condition = Both 

 

   

Output Data 

Coordinates X and Y of edges 

Edge Differential: Differential value of detected edge (degree of gray value change) 

No. of Objects: The number of detected edges. The value is 0 to 256. 

Judgement: If the number of detected objects is within the allowable range you have set, the object 
will be judged as "OK", if it exceeds the allowable range, the object will be judged as 
"NG" 

Specifying Checker No. 

1. Select “Gray Edge” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Gray Edge” setting window is displayed. The gray 
image is displayed on the screen window regardless of 
camera type.  

Selecting a Camera 
Select a camera image to set Gray Edge checker. 

1. Select “Area Setting” in “Gray Edge” setting window. 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed. 

3. Select how to convert a color image in "Select Color Image". (when using a color camera) 

The gray scale image converted by the selected method is displayed. 
 page 147. 
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Select a displayed image type (Live/Memory and Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 

Selecting Grayscale Preprocess / Slice Level / 
Position Adjustment 

 page 147 

Setting an Inspection Area 

Set a range to detect an object. 

 
You cannot set a Mask Area in Gray Edge checker. 

1. Select “Area Setting” in “Gray Edge” setting window. 

2. Select "Area (Set)". 

“Area Setting” window is displayed. 

3. Select a shape of inspection area from “Change Shape”. 

Select from Line, Plane, and Ellipse. 
For detecting a flat edge at high speed, Line scan is suitable. And Plane scan 
suits for detecting a round or pointed edge.  

4. Select “Change” and draw an area. 

See the description in the next section for setting procedure of an arc. For the setting procedure of other 
shapes, refer to section of “Drawing an Inspection Area” (page 63). 

5. After drawing is completed, press the CANCEL key. 

Setting Procedure of Arc 

To draw an arc in Gray Edge checker, firstly specify its size and position, select scan direction (clockwise/ 
counterclockwise), and then set an arc start point and an arc end point. 

1. Move the area. 

Tilt the ENTER key to move the area. 
Tilt the ENTER key pressing the SHIFT key to move the area by 10-pixel. 
(You can use the SHIFT key also in setting of a start/end point.) 

 
After deciding the position, press the Enter key. 

 

2. Set the start point (a square mark). 

Move the start point by tilting the ENTER key and press it to 
determine the position. 

  

 

3. Set the end point (a filled square mark). 

Move the end point by tilting the ENTER key and press it to determine 
the position. 
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4. Press the FUNC key and select a scan direction “Clockwise” or 

“Counterclockwise”. 

Default is “Clockwise”. 

 
 

 

5. Tilt the ENTER key left/right to specify a start point(SP) and an end 
point(EP). 

Tilting it right moves the start point(SP)/end point(EP) clockwise and 
tilting left moves counterclockwise.  
The coordinates of the start point(SP) and end point(EP) are displayed in 
the lower left on the screen. Use them to make setting. 

6. After setting the end point(EP), press the CANCEL key. 

Using Area Size Adjustment 

Area Size Adjustment is a function for inspecting variable-sized objects. The function adjusts an inspection 
area according to the size of the object detected with Area Size Adjustment checker. 

Refer to Chapter 4.9, page 282 about Area Size Adjustment and the setting procedure. 

Selecting Detect Condition of Edge 
Set detailed conditions such as detecting direction of edge. 

1. Select "Inspection Condition". 

Set Scan Direction, Scan Method, Edge Condition, Edge Threshold and Detected Position. 

2. Select "Search Method". 

Set Scan Pitch, Filter, Width and Average Range. 
 

About Conditions 
Scan direction (Horizontal/Vertical) -- Only for Plane scan 

Horizontal: Scans horizontally* from the start to the end points. 

 

Vertical: Scans vertically* from the start to the end points. 

 *If you set a rotated area, it scans at the rotated angle. 

Scan direction = Horizontal 

 
Scan Method: Projection / Single 

Set this when using projection scan. Projection scan calculates average brightness in the vertical direction 
against the scan direction per column (or row) and detects the edges based on the composite image. 

Original Image Image after projection scanning 

(Scan direction = horizontal) 
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Edge Condition (Light -> Dark/ Dark-> Light/ Both) 
Light ->Dark 
Detects a pixel that changes from 
high gray to lower gray (or from 
light to dark). 

Dark-> Light 
Detects a pixel that changes from 
low gray to high gray (or from 
dark to light). 

Both (default) 
Detects a pixel that changes both 
from light to dark and from dark 
to light. 

   
 

Edge Threshold: 1 - 255 

This is a condition on contrast or bright differential of an edge to detect. Setting it to larger extracts only 
edges with high contrast and lower extracts also low contrast edges. Quantified value of the contrast is 
differential value. 
 
Example) 
When edge threshold=30, the edge A and B are extracted. 
When edge threshold=50, only the edge B is extracted. 

Edge A- 
Differential: -40 

Edge B- 
Differential: -80 

 
 

Detected Position (Front / Peak / All / Front/ Rear) 

Among the edges meeting the condition, decides which edges to output. 

In the example below, "Edge Condition" is set to "Both". 

Front Scans from the (arc) start point and detects the first edge. In 
the right figure, A is detected. 

 

Peak Detects the position having the highest absolute differential 
value as an edge. In the right figure, A is detected. 

All Detects all edges which meet the condition. In the right 
figure, all edges A, B, C, and D are detected. 

Front/ Rear Detects the two points, the nearest position from the (arc) 
start point and from the (arc) end point. In the right figure, A 
and D are detected. 

 

Scan Pitch (only for Plane scan) 

With this item, set amount of scan skipping. As you set 
larger value, the skipping pitch increases. If you have 
enough inspection time to spend, use default value, 1. 

Scan Pitch=1 Scan Pitch=2 

 
 

Filter and Width 

These functions allow checkers to ignore undesired objects in front (in the start point side) of the area to detect. 
If the undesired objects are detected by running a test, increase the “Width” value. 

In addition of above, if the detect object is other than a straight line, including round and pointed object, 
increase both "Width" and "Filter" values. 
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Average Range 

This item decides how many pixels from the detected edge positions are averaged. If the desired position 
cannot be detected as a result of the test using the default value, change the Average Range value. Increasing 
the Average Range value detects the position slightly inside the edge of the object. Decreasing the value 
detects the position on the edges of the object. 

To detect a front edge of a circle, pointed or irregular object, set the Average Range value to be low as much as 
possible. 

 
Average 
Range = 0 

The detection position is the edge position on the tip of the 
detected part. (In the example on the right, the detection 
position is located on the bottom line.) 

Scan Direction ------------- 

 

Average 
Range = 1 

The average value of the coordinate values of the edges on 
the tip of the detected part. (In the example on the right, the 
tip edge is located on the line 105. Thus, the coordinate 
values of the edges on the lines from 105.0 to 105.9 are 
averaged.) 

Average 
Range = 2 

The average value of the coordinate values of the edges 
located between on the tip line and on the next line. (In the 
example on the right, the tip edge is located on the line 105. 
Thus, the coordinate values of the edges on the lines from 
105.0 to 106.9 are averaged.) 

 
If you set the Average Range value to 1 or more, Y coordinate of the horizontal scan and X coordinate of the 
vertical scan will be averaged as well. 

Setting Judgement Limits 
Set a tolerance (Maximum and Minimum values) of the number of detected edges. If the number of detected 
edges is within the tolerance, the object will be judged as "OK", if it is out of it, the object is judged as "NG". 

1. Select "Judgement Limits". 

2. Input the setting values for "OK Judge. Max." and “OK Judge. Min". 

3. After inputting is completed, press the CANCEL key. 

Running a Test and Confirming Result 
Confirm if the current settings perform an inspection properly. To observe the image easily, set “Window 
Transparency (SETUP menu)” to larger value. (“Changing Window Transmittance”, page 439) 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
Position adjustment and area size adjustment are also executed at the same time if they are used. 

2. Confirm a judgement result and the number of detected objects. 

 
The list of detected edges is displayed in the lower part of the setting window. 
When selecting this table and highlighting an edge data, the mark on the screen window indicating the 
detect position turns to pink. 
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4.7.9 Feature Extraction 

What Is Feature Extraction? 

Feature Extraction binarizes an image captured by a 
camera, detects a specified size of clusters of white or 
black pixels (hereinafter called “object”), and then judges 
as OK or NG depending on the measured number. The 
checker outputs the feature quantity such as the 
coordinates of a center of gravity or principal axis angle 
(+/-90 degrees).  

Output Data 

Feature quantity of an object 
 Area: Area of an object (in pixels) 

 Gravity X/ Gravity Y: Gravity center X and Y of a detected object 

 Perimeter: Perimeter length of an object 

 
 Principal axis angle: The angle between the principal 

axis angle and X axis 

 
 Projection 

Width/Height: 
The width and height of the 
rectangle circumscribing around 
an object 

 

No. of Objects: The number of detected objects 

Judgement Results: If the number of detected objects is within the allowable range you have set, the 
object will be judged as "OK", if it exceeds the allowable range, the object will be 
judged as "NG". 

Specifying Checker No. 

1. Select “Feature Extraction” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

To select the number not displayed in the list, move the 
cursor to display the desired number or specify the 
number in “Checker No.” field above the table. 

 

 

3. Press the ENTER key to determine the checker No. 

“Feature Extraction” setting window is displayed. The binary image is displayed on the screen window 
regardless of camera type. 
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Selecting a Camera 
Select a camera image to set Feature Extraction checker. 

1. Select “Area Setting” in “Feature 

Extraction” setting window. 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed. 

3. Select how to convert a color image in 
"Select Color Image". (when using a color 
camera) 

The binary image converted by the selected 
method is displayed. 

 page 147. 
 

 
Select a displayed image type (Live/Memory or 
Gray/Color/Binary) or magnification in “Image 
Menu” opened by pressing the F1 key. 

 

Selecting Grayscale Preprocess / Slice Level Group/ 
Position Adjustment 

 page 147 

Setting an Inspection Area 
Set a range to detect an object. 

1. Select “Area Setting” in “Feature Extraction” setting window. 

2. Select "Area (Set)". 

“Area Setting” window is displayed. 

3. Select a shape of inspection area from “Change Shape”. 

Select from Rectangle, Ellipse, Circle and Polygon. 

4. Select “Change” and draw an area. 

Refer to section of Drawing an Inspection Area (page 63). 

5. After drawing is completed, press the CANCEL key. 

When you want to exclude an area from inspection (Mask 
area) 

Up to 16 mask areas, where checker does no inspection, can be set in an inspection area. 

Select "Add Mask" in “Area Setting”, specify a shape, and draw an area. Refer to section of Setting a Mask 
Area (page 67) for details. 

Using Area Size Adjustment 

Area Size Adjustment is a function for inspecting variable-sized objects. The function adjusts an inspection 
area according to the size of the object detected with Area Size Adjustment checker. 

Refer to Chapter 4.9, page 282 about Area Size Adjustment and the setting procedure. 
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Using Auto Area Setting / Auto Mask Area Setting  

Auto Area Setting and Auto Mask Area Setting are functions which enable to set areas used for 
inspections automatically. The shape of an object is automatically recognized, and the detected result is 
referred in each checker as an inspection area. Also, inspection areas automatically set can be referred as 
masks. For details of Auto Area Setting, Refer to “Using Auto Area Setting (page 286)”.  

Select a Target Color 
Set to detect which object of white or black on a binary image. 

1. Select “Inspection Condition” > "Target". 

2. Select “White” or “Black” to detect. 

White (default): Detects a white object. 
Black: Detects a black object. 

Dilation and Erosion on Binary Image (Filter) 

This is the function that dilates or erodes the pixels of color selected in “Target”. Use this function mainly when 
you delete a slight noise or enhance a detected area. If applying this function is not necessary, proceed to the 
next step. 

1. Select “Inspection Condition” > "Filter". 

The list of settable filters is displayed. 

2. Select "Filter" to process the image to be a desired image. 

Changing filters updates the displayed image. Confirm it and set. 

Set the Number of Objects to Detect 
Set the maximum number of objects to detect. Specifying “10” detects 10 prior objects after sorting or in order 
of appearance. 

1. Select “Inspection Condition” > "Output: Objects 1 - x". 

2. Set the number of objects to detect. 

Default: 100 
Settable Range: 1 to 10000 

Select a condition to number objects (Sorting) 
This is a function used to output and calculate feature data. When multiple objects were detected, the function 
arranges in a certain rule and numbers the first object as No.0 in ascending order. 
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1. Select “Sorting” and specify information to use 

in sorting. 

Select from Area, X, and Y. 

2. Select “Sorting Order” and then select either of 
Ascending or Descending. 

Ascending: Sorts with the object of small value in 
the top. 
Descending: Sorts with the object of large value in 
the top. 

 
 

When setting “Area” and “Descending”, it sorts 
with the object of the largest area in the top in 
descending order. You can confirm the result in the 
detected result list. 

 



 

173 

S
etting Inspection C

onditions 
C

h. 4 

Selecting Feature Data to Measure 
Select feature quantity data to measure on a detected object. Setting unnecessary items to “No” decreases the 
inspection time. 
Selectable feature data types are Perimeter, Projection Width/Height and Principal Axis Angle. 

1. Select "Search Method". 

2. Set whether or not to detect Perimeter, 
Projection Width/Height and Principal Axis 
Angle. 

Yes (default): Measures the selected item. 
No: Does not measure the selected item.  

 
 

When setting labeling to "No", Perimeter and Projection Width/Height cannot be detected. 
When setting Principal Axis Angle to “No”, Projection Width/Height cannot be detected. 

Changing Other Search Methods  
(Labeling/Boundary/Fill Holes/Drawing Pattern of 
Result) 

1. Select "Search Method". 

2. Change the setting of Labeling, Boundary, Fill Holes, or Drawing Pattern of Result as 
necessary. 

Extracting Each Data of Multiple Objects (Labeling) 

This is a function to detect each Feature data when multiple objects exist within the area. 
Yes (default): Measures feature quantity of each object. 

No: Feature quantity of each object is not measured and only total area, coordinate of the 
gravity center, and principal axis angle are output.  

Decides Whether or not to Detect an Object on the Boundary 
of an Area (Boundary) 

Yes (default): Detects an object on the area frame. 

No: Ignores an object on the area frame. 

 
You can set Boundary to “Yes” only when Labeling is set to “Yes”. 

Selecting Whether or not to Fill inside an Object with the 
Target Color (Fill Holes) 

If there is a part with different color from the 
target color inside an object, measurement 
of coordinate of gravity center or principal 
axis angle is interfered. To prevent this, 
processes to fill inside the object with the 
target color. 

Yes: 

Executes Fill Holes. 

No (default): 

Does not execute Fill Holes. 

  

 Fill Holes is available when Labeling is set to “Yes”. 
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Selecting the method of displaying an object detected 
position mark (Drawing Pattern of Result) 

Select the method of displaying the 
mark indicating the detected position 
of an object. 

Normal (Default): Displays the 
gravity center and principal axis 
angle. 

Extend: Displays the gravity center, 
principal axis angle, projection 
width and projection height. 

 
"Drawing pattern of Result" can be 
selected when "Proj. Width, Height" 
is set to "Yes". 

When detecting Principal Axis Angle 

Normal (Default): Extend: 

 

 
When not detecting Principal Axis Angle 

Normal (Default): Extend: 

 
 

 

Set the Condition of Objects to Detect  
(Extraction Condition) 

Set the range of area, projection width, and projection height of objects to detect. 

 

Setting example of an area 

In the right figure, setting “Min. Object Area” to 100 detects 10 objects. 

1. Select “Extraction Condition” in “Feature 

Extraction” setting window. 

2. Set the range of area, projection width, and 
projection height of objects to detect. 

When using no conditions for area, projection width and 
projection height, changing these is not necessary. 

 
 

The default value of Minimum Object Area is “1” which 
indicates that detecting an object with a pixel or more. 
For a noisy binary image, it is advisable to set Minimum 
Object Area to larger value to prevent detecting noise 
as an object. 
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Setting Judgement Limits 
Set a tolerance (Maximum and Minimum values) of the number of detected objects. If the number of detected 
objects is within the tolerance, the object will be judged as "OK", if it is out of it, the object will be judged as 
"NG". 

1. Select "Judgement Limits". 

2. Input the setting values for "OK Judge. Max." and "OK Judge. Min". 

3. After inputting is completed, press the CANCEL key. 

 

Running a Test 
Confirm if the current settings perform an inspection properly. To observe the image easily, set ““Window 
Transparency (SETUP menu)” to larger value. (“Changing Window Transmittance”, page 439 ) 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV 
captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current 
memory image without capturing any images. 

 
 

Position adjustment and area size adjustment are also 
executed at the same time if they are used. 

2. Confirm a judgement result and the number of 
detected objects. 

The list of detected objects is displayed in the lower part of 
the setting window. 
When selecting this table and highlighting an object data, 
the mark on the screen window indicating the detect 
position turns to pink. 

 

 

 
When 40000 or more areas of specified color are detected regardless of whether or not the extraction condition 
is met, the judgement result will be NG and detected count will be 0. 

In this case, to inspect correctly, adjust the lens aperture and the slice level not to display undesired noises on 
the image, or set Preprocess to remove undesired noises. 
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4.7.10 Smart Matching 

What Is Smart Matching? 
This is a function that searches and detects a similar part to the registered image pattern. 

It outputs the detected position and angle, and correlation value (similarity degree). The registered image 
pattern is a template, and the range to search is a search area. 

Smart Matching of PV200 can register up to 64* templates per checker. This checker is suitable to detect a 
target having variable image pattern or to recognize its type. 

Subtraction function, which detects difference between the detected part and the template in gray level, can 
inspect a detailed difference. 

Unlike Contour Matching, the grayscale information of the image registered as a template is used,  
Therefore, the detection ability may be higher than Contour Matching, however conversely, it may be 
sometimes decreased. Decide which checker to use according to the variation among the registered 
template image and inspected images. 

 
* Templates are saved in the dedicated memory. To check the free space for templates, select “TOOL” > 
“Information” from the menu bar. 

 
Base Image 
(Template) 

Detected Image Detected Image 
(Sorted in ascending order of Y) 

 

  

Output Data 

No. of Objects:  0 to 256 

Template No.: (0 to 63) 

Correlation: 0 to 1.000 

Coordinate X, Y: (Output point) 

Detection Angle: -179.999 to 180.000 

Subtraction: Pixels of Max. subtracted Object, No. of Subtracted Objects: 0 to 128 

Specifying Checker No. 

1. Select “Smart Matching” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Smart Matching” setting window appears. The gray 
image is displayed on the screen window regardless of 
camera type. 
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Selecting a Camera 
Select a camera image to set “Smart Matching” checker. 

1. Select “Area Setting” in “Smart Matching” setting window. 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed. 

3. Select how to convert a color image in "Select Color Image". (when using a color camera) 

The gray scale image converted by the selected method is displayed. 
 page 147. 

 
 

Select a displayed image type (Live/Memory and Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 

Selecting Grayscale Preprocess / Position 
Adjustment 

 
Position Adjustment function is helpful when position or angle of an inspection object can be detected in 
advance. In this case, the search area for Smart matching or the range of detect angle can be smaller, so that 
the processing speed can be faster. 

 

 page 147 
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Setting a Template 
Register an image pattern to detect. 
Up to 64 templates can be registered per Smart Matching. When registering multiple templates, the checker 
inspects based on all the templates and outputs the area with the largest correlation value and the number of 
the template used to detect the area. 

To set a template, you need to capture an image in advance.  

 
Common templates can be used. Refer to page 188 for details. 

1. Select “Area Setting” in “Smart 

Matching” setting window. 

2. Select “Set” for "Template". 

Template setting window is displayed. 

3. Tilt the ENTER key up/down/left/right to 
select a template No. Select a template 
No.0 when registering a template for 
the first time. 

4. Select "Register". 

The window to draw a template area is 
displayed. The image captured in advance 
is displayed in the screen window on this 
window.  

 
 

When opening this screen after running a 
test, the image to be displayed may be the 
one which the current memory image has 
been moved and rotated. Refer to "Image 
to be displayed when reregistering a 
template" (page 180) for details. 

 

 
 

 

5. Select a shape of template area from 
“Change Shape”. 

Select from Rectangle, Ellipse, Circle and 
Polygon. 

6. Select “Change” and set a template 
area. 

Refer to section of Drawing an Inspection 
Area (page 63). 

 
 

 

 
 

The settable maximum size (the size of a circumscribing rectangle of the area) is as follow. 
• When using 0.3-Mega Camera (except 0.3-Mega Compact Color Camera): 640 x 480 pixels (full 

screen) 
• When using 0.3-Mega Compact Color Camera: 640 x 478 pixels (full screen) 
• When using 2-Mega Camera/4-Mega Camera: 1600 x 1200 pixels 
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When you want to exclude an area from inspection  
(Mask area) 

Up to 16 mask areas, where is excluded from inspection (correlation calculation), can be set for a template. 
Select "Add Mask" in template setting window, specify a shape and draw an area. Refer to section of Setting a 
Mask Area (page 67) for details. 

7. Select “Output Point” and operate the ENTER key to specify an output point. 

Output point is the point that indicates the location where the image resembling the template was detected. 
This is the point of detection. You can place the output point at the desired location. (It can be set also 
outside template.) 
Select a setting method from the following three types. 

Desired Position: Sets the output point at a desired position by 
moving the cursor. 

 
Area Center: Sets the output point in the center of the set 

template area. 

Sandwich: Sets the output point at the center of a desired 
rectangle in the set template area. 

 
While you are setting it under “Desired Position” or “Sandwich”, the coordinate of the current output point is 
displayed in the information display area. Use it to make the setting. 

 
 

By pressing the FUNC key during the setting under "Desired Position", the pop-up menu of "Middle Point" 
appears. Selecting this sets the output point in the center of a template. (This is the same position when 
selecting "Area Center".) 

8. After setting is completed, press the 
CANCEL key. 

Return to the template setting window. 
To set multiple templates, select a 
template No. and repeat the above 
procedure. 

 
 

If there is no feature (or the degree of 
change in gray level is low) within the 
specified area, a message will be 
displayed and the template cannot be 
registered. 

 
From “Show this many:”, the number of displaying templates can be changed. 
You can choose from the following as necessary; 16 (default), 4, and 1. 

9. After setting the template, press the CANCEL key. 

The screen returns to “Smart Matching” setting window. 
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Image to be displayed when reregistering a 
template(Common to Smart Matching and Contour Matching) 

When a template is reregistered after executing an inspection, the image may be displayed in the moved or 
rotated state. This is because the memory image (fig. 3 below) is displayed after being moved/rotated for the 
difference between the position/angle when the template has been registered (fig. 1 below) and the 
position/angle detected when executing the inspection (fig. 2 below). 

Displaying the image like this enables the template to be reregistrated even when the object is inclined.  (It is 
not necessary to replace and recapture the object at the angle when it has been registered.) 

 
1) When setting a template 2) Detection position when 

executing the inspection (test) 
3) Image displayed when reregistering 
(Dotted line shows the memory image.) 

 

 
Execute either way of the followings to clear the detection position when you do not want to display the image 
corrected when reregistering. 
 Switching Types 

 Turning off the power to PV200 

 Changing the condition not to be detected such as setting the minimum correlation value of the first step 
in Sequence to 1.000 and running a test. 
(After setting the template, reset the condition to the previous setting.) 

Setting a Search Area 
Set the range to search the same image pattern as a template. 

 
You cannot set a Mask Area in the search area of Smart Matching checker. 

1. Select “Area Setting” in “Smart Matching” setting window. 

2. Select "Search Area". 

“Area Setting” window is displayed. 

3. Draw a search area. 

Refer to section of Drawing an Inspection Area (page 63). 
 

 
Settable shape for search area is only rectangle. 

4. After drawing is completed, press the CANCEL key. 
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Detecting Rotated Object 

If a detecting part is rotated or capturing direction is possible to be unstable, it is 
necessary to scan within a search area rotating the image pattern registered as a 
template. To do so, set a rotation angle and angle pitch. 

1. Select "Inspection Condition". 

 

2. Specify the value of “Rotation Range” from 0 (no rotation) to +/-180 (rotation of 360-degree). 

Note that the larger value of rotation angle range you set, the longer time its processing takes. 

3. Specify “Angle - Step”. 

At first, set a pitch to scan. Select from 8, 4, 2, and 1. Selecting “8” scans Rotation Range by 8 degrees and 
finely scans around the detected angle. 

 
 

When setting “Recommendation Setting” from “Sequence”, “Angle - Step” will be automatically replaced to 
the Recommendation Setting. 

4. Specify "Angle - Accuracy". 

This item is to set an angle to scan finely around a detected angle.  
Select either “1 Degree” or “0.001 Degree”. The detected angle is output lastly in the unit set here. 
Setting “0.001 Degree” takes longer process time than “1 Degree.” 

5. After setting is completed, press the CANCEL key. 

Detecting Black/White Reversed Image 

To detect an image which has reversed gray level of registered image 
pattern, use the function of “Detect B/W Reversed Template”. This 
function allows to perform an inspection without lowering correlation value 
because of image reversal. 

1. Select "Inspection Condition". 

2. Select “Yes” for “Detect B/W Reversed Template”. 

Template 

 
 

Detecting Image 
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Condition to Label Detected Images (Sorting) 

When multiple images were detected, the function arranges in a certain rule and numbers them in ascending 
order from the first object as No.0. This is a function used to output and calculate information on detected 
images such as coordinate, angle, and correlation value. 

1. Select “Sorting” and specify information to 
use in sorting. 

Select from Correlation Value, X, and Y. 

2. Select “Sorting Order” and then select either 

of Ascending or Descending. 

Ascending: Sorts with the object of small value 
in the top. 
Descending: Sorts with the object of large value 
in the top.  

 
When setting X and Ascending, it sorts in ascending order with the object of the smallest X coordinate in 
the top. You can confirm the result in the detected result list. 

In the Case of Detection Failure 
If you cannot detect the part you want to detect as the result of tests, adjust three conditions described below 
according to the inspection conditions and image status. Using the functions below takes longer time to 
process compared with the case being not in use. 

Detect Mode - Low Contrast 

If the difference in brightness is small between an 
object image and the background, or some parts 
of object image is chipped or shielded, the 
checker may not detect it correctly. In such 
cases, set “Detect Mode” to “Low Contrast” and 
then specify its intensity (Filter Adjustment). 

 
Feature and Usage of the Object Detect Target  Filter 

Adjustment 
Processing 
speed 

• Higher contrast, no shielded or chipped part 
• Type recognition, quality inspection 

Normal --- Fast 
↑ 

• Higher contrast, possible existence of shielded or chipped part 
• Position detection 

Low Contrast No  

• Lower contrast 
• Position detection 

Low Contrast Yes ↓ 
Slow 

1. Select "Inspection Condition". 

2. Select “Low Contrast” for “Detect Mode”. 

The “Filter Adjustment” button is activated. 
 

Run a test in the current status. If an object cannot be detected stably, make filter adjustment. 
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Filter Adjustment 

The Filter Adjustment function binarizes an object image and background using multiple items. If desired result 
cannot be obtained even though you tried auto adjustment (Recommendation Setting), adjust the values of the 
items. Set the items listed below from the top orderly. 

 

Target (White / Black) 
If a detect target is brighter than the 
background, select “White”. If an object 
image is darker than the background, select 
“Black”. 

Denoising (1 - 80) 
Removes unnecessary noises around an 
object image. As the setting value increases, 
the more noises are removed. 

Distortion (1 - 95) 
Extracts the part having contrast. If some 
parts of the extracted object are chipped 
away, increase the setting value. If the object 
is expanded, decrease the setting value. 

Expansion (1 - 4) 
Expands the extracted object. Makes up the 
chipped or missed parts of the object that 
cannot be adjusted by using the Distortion 
function. 

 

3. Select the button of "Filter Adjustment". 

Template list is displayed. 

4. Select a template to adjust filter and then select “Set Filter”. 

Filter adjustment screen is displayed. The upper image is a template and the lower is the image after filter 
adjustment. 

5. Set “Use Filter” to “Yes”. 

6. Select "Recommendation Setting". 

Set it in order to binarize an image into 
target area and background clearly. 
If Recommendation Setting cannot 
binarize it clearly, adjust Denoising, 
Distortion or Expansion. 

7. After adjustment is completed, press 
the CANCEL key. 

The screen returns to “Inspection 
Condition” setting window. 

Before filter adjustment 

 

 

After filter adjustment 
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Template Rotated by 180d 

Use this function when running a test with a 
specified Rotation Range setting detects 
a180-degree reversed image by mistake, or a 
180-degree reversed image is similar to the image 
pattern registered as a template. 

1. Select "Inspection Condition". 

2. Select “Yes” for “Template Rotated by 
180d”. 

 

 

Ignore Dark Image 
This function is useful to inspect a dark image undesired areas of which are detected. 

The function ignores the part that has lower brightness than the set threshold (0 - 255) for the gray values of 
the area within a template. 

1. Select "Inspection Condition". 

2. Select “Yes” for “Ignore Dark Image”. 

3. Enter a value of brightness limit in “Threshold to Ignore Dark Image”. 

Setting a Sequence 
Set a sequence to search an image pattern of a template within a search area. 

The checker executes a searching on the compressed information of template and search area. The 
compression rate of the information is lowered every time a searching phase (up to six phases) proceeds. 
Processing speed is inversely related to compression ratio; the higher compression ratio, the faster processing 
speed, the lower compression ratio, the slower processing speed. 

Specifying Items in “Sequence” 
Step 

Inspection is performed in up to six steps (1st - 6th) by changing compression ratio and other conditions. 

Accuracy 
This is compression ratio. There are seven types of compression ratio; 32.16, 8, 4, 2, 1, and S. Accuracy 
16, for example, refers to compressing of information of 16 x16 (256) pixels. The smaller value indicates 
the lower compression. Accuracy value must be smaller as a scanning step proceeds. 
Accuracy “1” means that searching is performed without compressing the information. Accuracy “S” means 
that detection is executed per subpixel. If the accuracy is set to "1" or "S", the steps after that will be erased 
and no more steps can be added. (You cannot include both "1" and "S" in one sequence. (e.g. Step 
4TH=Accuracy 1, Step 5TH=Accuracy S)) 

Maximum Count 
Maximum number of the part to be detected in each step. 
Setting an intermediate step to “3” detects 3 parts with higher correlation value than the minimum value in 
descending order, and then inspects the parts with lower compression ratio in the next step. Setting the 
final step to “3” judges as “OK” three or more parts are detected, and judges as “NG” if less than three 
parts or nothing are/is detected. 

Minimum Correlation 
In a certain step, the checker detects the parts having the higher correlation value than this setting value. If 
there is no image with higher correlation value than it, the inspection stops at the step and judges as "NG". 

 

Squaring Correlation Value 
This is a function that squares correlation values to emphasize them. By squaring them, low values 
become much lower. Use this function when you want to widen the difference of correlation values 
between the object to detect and the object not to be detected. 
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The Items can be Confirmed in Sequence 
 

No. of Objects 
Number of the objects that were detected in each step. 

Correlation Value* 
Correlation value of the objects detected at each step. If multiple parts are detected in each step, the 
lowest correlation value is displayed. 

 

 
*Correlation Value for the Low Contrast Function 

In the setting of “Low Contrast” for “Detect Mode”, correlation may be different between the values displayed in 
Sequence table and the values output as inspection results. This is because the PV corrects the decreased 
correlation values that were affected by the distorted, chipped or overlapped parts of the object and output 
them as inspection results. The correlation values in Sequence are the ones that have not been corrected and 
the values in Result or output to the external devices are the ones that have been corrected. Therefore, the 
former is lower than the latter. If there are many distorted or chipped parts over the whole object image, the 
correlation values can be almost the same. 

1. Select "Sequence". 

2. Select "Recommendation Setting". 

Regarding the current conditions, the recommendation values of sequence is set. 
“Angle - Step” of “Inspection Condition” is also replaced to a recommendation value at the same time. 

3. Set “Square Correlation” to “Yes” as necessary. 

4. Select the table of sequence and change 
Accuracy, Max. Count or Min. Correlation as 
necessary. 

The checker judges as “OK” when it detected the 
number of “Max. Count” or more of objects. 

 
How to Change Sequence 

 

• To select the items, tilt the ENTER key left/right. To select the steps, tilt it up/down. 
• To delete a step, select “0” for “Accuracy”. All the steps after that are deleted. 
• Maximum Count can be set per step, however, the value of later steps should be smaller than the value 

of previous steps. 
Example: If setting value of “3RD” is “5”, the value of “4TH” cannot be set to “6” or more. If setting “4TH” 
to “6”, the values of “1ST” to “3RD” are automatically changed to “6”. 

5. After inputting is completed, press the CANCEL key. 



 

186 

S
etting Inspection C

onditions 
C

h. 4 

Using Subtraction Function 
Subtraction function extracts a pixel that exceeds a certain degree of the difference in the gray value comparing 
the detected area and the template. With this feature, the PV can detect up to 128 subtraction parts that are 
difficult to reflect in the correlation value. It judges the object based on the number of detected subtraction 
parts. 

 

 
Items Related to Subtraction 

Subtraction Threshold 
The checker extracts pixels that exceed the set degree of the difference in the grayscale value or more 
between the detected image and the template. The lower the Subtraction Threshold value, the stricter 
extraction standard is. 

Filter 
Dilates or erodes the pixel clusters extracted under the condition of Subtraction Threshold value, or does 
so after dilation or erosion. Use the Filter function to enhance the extracted pixel cluster or remove fine 
noises or dusts. 

Min. Subtracted Size 
The checker detects only the clusters of the filtered extraction pixels having the area value more than the 
Min. Subtracted Size. For example, not to detect 10-pixel or less of extracted subtraction parts, set Min. 
Subtracted Size to “11”. 

Max. OK No. of Subtracted Objects (0-128) 
A tolerance of a detected pixel cluster. If the number of detected pixel clusters is less than the Max. OK No. 
of Subtracted Objects, the object will be judged as "OK". 

1. Select "Subtraction”. 

2. Select “Yes” for “Subtraction”. 

3. Enter the values in “Min. Subtracted Size” and 

“Subtraction Threshold”. 

4. Select "Filter". 

 

No (Default) 
3x3 (5x5) Erosion: Deletes fine noises. 
3x3 (5x5) Erosion -> Dilation: After deleting noises, restore the left parts to the original size. 
3x3 (5x5) Dilation -> Erosion: Filter processing to fill holes within the detect area. 

5. Enter the values in “Max. OK No. of Subtracted Objects”. 

Specify tolerance of the number of extracted parts as the result of subtraction. When performing 
subtraction, this judgement is a judgement of checker. 

 
 

When the result of No. of Objects exceeds 128, it becomes “255” automatically and the object is judged as 
NG. 

6. After the setting is completed, press the CANCEL key. 
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Running a Test and Confirming Result 
Confirm if the current settings perform an inspection properly. To observe the image easily, set “Window 
Transparency (SETUP menu)” to larger value. (“Changing Window Transmittance”, page 439 ) 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
Position adjustment and area size adjustment are also executed if they have been set. 

2. Check data of detected area list. 

 
- The list of detected objects is displayed in the lower part of the setting window. When selecting this 

table and highlighting each No., the mark on the screen window indicating the detected area turns to 
pink. 

- The value of “255” in the “No. of Objects” column indicates the result exceeds 128. 

 
 

Smart Matching Performance 

Selecting "Matching First" speeds up the processing of Smart Matching. However, selecting "Matching First" 
takes more time of type switch than selecting "Type Switch First". 

 

The function has the limit of the number of Smart 
Matching ("Number of checkers" in the right table) to 
allow speeding up the process. This number varies 
depending on the settings of template size, inspection 
sequence, rotation range, and angle step. 

 

After setting to speed up the processing of all Smart 
Matchings, set to speed up that of Contour Matching if 
you have enough space on the internal memory. 

Template 
size 

Rotation 
range 

Angle - 
step 

Number of 
checkers* 

128 x 128 ±90 8 10 
±180 8 6 

384 x 384 ±90 4 5 
±180 4 3 

*In the case of setting one template per Smart 
Matching checker. 

Check the processing time of inspection and type switch on your actual device before you use the function. 

 

1. Select “ENVIRONMENT” >  “System Settings” 

from the menu bar. 

2. Select "Operation". 

3. Select " Matching First" in “Matching 

Performance”. 
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Selecting a Template from Common Image Patterns 
(Common to Smart Matching and Contour Matching) 

Other than templates individually registered in each Matching, PV200 provides with a function that keeps 
common templates to all types, all Smart Matchings and Contour Matchings, including Position Adjustment, 
Area Size Adjustment and Calibration. Necessary common template numbers are specified among them for 
use in each Matching checker. 

Common templates can be saved up to 2000 templates in 256 product types. 

 
One template can be registered per one Contour Matching checker. 

 
When using the common template function (when setting Template Registration to "Common"), the function of 
"Read Type No. in SD" cannot be used. (Refer to page 77 for details.) 

Setting a Template to Use Commonly 

1. Select “ENVIRONMENT” > “System 

Settings” from the menu bar. 

2. Select "Operation". 

3. Select “Common” for "Template 

Registration". 

If templates have already created at this 
moment, the templates will be registered as 
common templates automatically. 

 

Note on resetting to "Per Checker” 
When you operate to reset to "Per Checker” from the menu or initialize environment settings, an error message 
may appear and "Common" setting may be held. This is because of the reason described below. 

 

Changing the setting from "Common" to “Per Checker” copies the common templates that are used by 
checkers to each checker. In “Per Checker” setting, total number of templates is likely to be increased because 
each checker holds a template separately even for the same image, while multiple checkers use a single 
template in “Common” setting.  

For example, the total number of common templates is five in the figure above. After copying the templates to 
each checker, the total number is seven as the figure below which is increased by two.  
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You cannot reset to "Per Checker“ when inadequate memory of PV200 or excessive number of registration 
prevents copying the templates. 

Note that the other settings are initialized even when "Template Registration" remains “Common” due to the 
above reasons after initializing environment settings. 

Creating a New Common Template  

 
For setting Contour Matching, the template number is always zero. Also, "Create Edge" and "Accuracy" 
should be set in step 6. 

1. Select a template No. in template setting window and then select "Register". 

2. Select a blank field for common 
templates. 

When selecting a registered template, you 
can update or delete the image pattern. 

3. Select "Register" for “Common Template 
Setting”. 

Template setting window is displayed. 
Select a shape and set a template area. 
Refer to page 178 for details. 
 

 
To delete the selected template, select 
“Delete”. 

 

4. After area setting is completed, press the CANCEL key. Select “Yes” following the displayed 

message. 

The set image pattern is registered as a common template. 

5. Select “Register” for "To template #". 

(“#” indicates the number you have specified in step 1.) 
 

Through these steps, you can register the commonly saved template in “Template #”. 
 
・For Contour Matching 

6. Adjust the settings of "Create Edge" and "Accuracy" to generate contour information. 

For the details of each item, refer to page 197. The settings set here also become the information 
common to all types. 

7. Press the CANCEL key. 

Returns to the template setting window. 
To set multiple templates in Smart Matching, select a template number and repeat the above procedure. 

8. Press the CANCEL key. 

Returns to the template setting window of each Matching. 
 
If appropriate contour information is not generated in Contour Matching, the error message "Registration of 
template image failed" appears. It can be used as a template of Smart Matching because it is registered in 
the common template as gray image information, however, it is not appropriate for Contour Matching. 
Update the position of the template or adjust the condition to generate contour information. 

Selecting from Saved Common Template List 
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For setting Contour Matching, the template number is always zero. Also, "Create Edge" and "Accuracy" 
should be set in step 4. 

 

1. Select a template No. in template setting window. 

A list of commonly saved templates is displayed. 

2. Select a template to use. 

3. Select “Register” for "To template #". 

(“#” indicates the number you have 
specified in step 1.) 

 
Through these steps, you can register the commonly saved template in “Template #”. 

 
・For Contour Matching 

4. Adjust the settings of "Create Edge" and "Accuracy" to generate contour information. 

For the details of each item, refer to page 197. The settings set here also become the information 
common to all types. 

 

Deleting Common Templates 

This function deletes common templates one by one. 
 

 
How to delete all common templates: See page 78. 

1. Select a template No. in template setting window. 

A list of commonly saved templates is displayed. 

2. Select a template to delete. 

3. Select “Delete” for "Common Template 
Setting". 

Follow the message to delete it. 
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Condition of Reregistering Template by External 
Signals (Common to Smart Matching and Contour 
Matching) 

Created templates of both Matchings can be updated (reregistered) by inputting an I/O signal or a command 
from the external device. How to select conditions to update is described below. 

If you do not reregister it by an external command, setting change is not necessary. 

The procedure of reregistering templates is the same for Smart Matching and Contour Matching, however, 
I/O input terminals and commands are specially assigned to each checker.  

 
For the input terminals and commands used for each checker, refer to the pages below.  

 Reregistering by I/O signal Reregistering by command input 

Smart Matching: p.436, p.551 p.607, p.657 

Contour Matching: p.436, p.551 p.609, p.658,  

For the timing chart of template reregistration by I/O signal, refer to 10.3.4 Re-registering Templates/Contour 
Template Setting (page 568) To see the timing chart of reregistration by command input, replace the timing of 
turning on the input signal with the timing of transmitting the command. 

1. Select “ENVIRONMENT” >  “System Settings” from the menu bar. 

2. Select "Operation". 

3. Set "Template Setting". 

“Use the Last Image”(Default): 
To reregister using the current memory 
image which is the last captured inspection 
image. 
“Capture New Image”: 
To capture a new image to register. 

 

4. Set "Position".  

“Set Position” (Default): 
To register the image pattern within the template of selected Smart Matching or Contour Matching. 
“Adjusted Position”: 
To execute the Position Adjustment relating to the selected Matching and reregister the image pattern 
within the template of selected Smart Matching or Contour Matching. 

5. Select "Area Display". 

“No”(Default):  
To reregister in the position of the specified condition. 
“Yes”:  
To display a template area when the position of the specified condition is determined. Inputting a command 
calling for a registration once more after confirming the display executes registration. 

 
Now you completed the setting for registration condition. 
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Operation when setting "Area Display" to “Yes” 

When setting "Area Display" to “Yes”, the operation when executing re-registration differs depending on the 
settings of "Template Setting" and "Position". Regardless of the type of the display image (Live image/Memory 
image) before executing re-registration, the operations for executing re-registration are as below. 

 
Reentry 
signal 

 Use the Last Image  Capture New Image 

 Set Position  Adjusted Position  Set Position  Adjusted Position 
         

First input        Image capture 

         

  Displays latest 
memory image 

 Displays latest 
memory image 

 Displays live image  Displays the above 
captured image. 

         

    
Executes Position 

Adjustment, 
adjusts area. 

   
Executes Position 

Adjustment, adjusts 
area. 

         

  Displays area 
re-registered. 

 Displays area 
re-registered. 

 Displays area 
re-registered. 

 Displays area 
re-registered. 

         
         

Second input      Image capture   

         

  
Executes 

re-registration.  
Executes 

re-registration.  
Executes 

re-registration.  
Executes 

re-registration. 

 

Reregistering templates of common templates 
Specify a checker number and template number when updating the template from an external device. 

It is not possible to update the template by directly specifying the common template number even when 
Template Registration is set to "Common". 

When specifying a checker number and template number and updating (reregistering) the template, the 
common template that is used for the specified number will be updated.  If this updated common template 
is used for other items (such as type, checker number, template number, and matching type of Smart 
Matching or Contour Matching), all the templates using the same common template will be automatically 
updated. 

The templates used for Position Adjustment, Area Size Adjustment and Calibration cannot be updated 
(reregistered) from an external device, however, they may be updated in conjunction with updating 
(reregistering) the template used in Smart Matching or Contour Matching when "Common" is set.  

Note that when executing the template reregistration. 
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4.7.11 Contour Matching 

What Is Contour Matching? 
Contour Matching searches and detects a similar part of an inspection image to the registered contour 
information on the part of an image the brightness of which varies.  

It outputs the detected position, angle, magnification, and correlation value (similarity degree). The 
registered contour information is a template, and the range to search is a search area. 
Unlike Smart Matching, only the contour information of the image registered as a template is used,  
Therefore, the detection ability may be higher than Smart Matching, however conversely, it may be 
sometimes decreased. Decide which checker to use according to the variation among the registered 
template image and inspected image. 

In Contour Matching, one template can be set per checker, and a maximum of 64 images can be detected in 
the search area. Judges as OK/NG according to its existence. 

 
* Templates are saved in the dedicated memory. To check the free space for templates, select “TOOL” > 
“Information” from the menu bar. 

 
Base Image 
(Template) 

Detected Image  

 

 

 

Output Data 

No. of Objects:  0 to 64 

Template No.: 0 

Correlation: 0 to 1.000 

Coordinate X, Y: (Output point) 

Detection Angle: -179.999 to 180.000 

Magnification: 0.8000 － 1.20 

 

Specifying Checker No. 

1. Select “Contour Matching” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Contour Matching” setting window appears. The gray 
image is displayed on the screen window regardless of 
camera type. 
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Selecting a Camera 
Select a camera image to set “Contour Matching” checker. 

1. Select “Area Setting” in “Contour Matching” setting window. 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed. 

3. Select how to convert a color image in "Select Color Image". (when using a color camera) 

The gray scale image converted by the selected method is displayed. 
 page 147. 

 
 

Select a displayed image type (Live/Memory and Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 

Selecting Grayscale Preprocess / Position 
Adjustment 

 
Position Adjustment function is helpful when position or angle of an inspection object can be detected in 
advance. In this case, the search area for Contour matching or the range of detect angle can be smaller, so that 
the processing speed can be faster. 

 

 page 147 

 

Setting a Template 
Register contour information to detect. 
Only one template can be registered per Contour Matching.  
To set a template, you need to capture an image in advance.  

Register a base gray image (as template) in contour information. The contour information is extracted and 
registered using this image. These two processes are conducted in "Template" menu. 

The following shapes may not be registered as contour information or the output points may be less stable even 
if these shapes can be registered, so it is not recommendable to register them as the templates for Contour 
Matching. 

 Although edges exist, it consists of two straight lines. (e.g. Corner of intersection of triangle or 
rectangle, etc.) 

 Although there are three or more straight lines, lines except two lines are extremely short. (e.g. 
Three sides of long thin rectangle) 

 A part of large arc 

 Edges are dotted about and there is not much part that can be recognized as a straight line. 

 

 
Common templates can be also used. Refer to page 188 for details. 
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1. Select “Area Setting” in “Contour 
Matching” setting window. 

2. Select “Set” for "Template". 

Template setting window is displayed. 

3. Select "Register". 

 

 
The window to draw a template area is displayed. The image captured in advance is displayed in the 
screen window on this window.  
 
The lines displayed in pink here are called edges. If any edge is not created, adjust the "Create Edge" 
condition in step 7 or 9. Even if no edge in pink is displayed, it can be registered as a template image. 
 

 
When opening this screen after running a test, the image to be displayed may be the one which the 
current memory image has been moved and rotated. Refer to "Image to be displayed when reregistering 
a template" (page 180) for details. 

4. Select a shape of template area from 
“Change Shape”. 

Select from Rectangle, Ellipse, Circle and 
Polygon. 

5. Select “Change” and set a template 
area. 

Refer to section of Drawing an Inspection 
Area (page 63). 

 
 

 
 

The settable maximum size (the size of a circumscribing rectangle of the area) is as follow. 
• When using 0.3-Mega Camera (except 0.3-Mega Compact Color Camera): 640 x 480 pixels (full 

screen) 
• When using 0.3-Mega Compact Color Camera: 640 x 478 pixels (full screen) 
• When using 2-Mega Camera/4-Mega Camera: 1600 x 1200 pixels 

When you want to exclude an area from inspection  
(Mask area) 

Up to 16 mask areas, where is excluded from inspection (correlation calculation), can be set for a template. 
Select "Add Mask" in template setting window, specify a shape and draw an area. Refer to section of Setting a 
Mask Area (page 67) for details. 

6. Select “Output Point” and operate the ENTER key to specify an output point. 

Output point is the point that indicates the location where the image resembling the template was detected. 
This is the point of detection. You can place the output point at the desired location. (It can be set also 
outside template.) 
Select a setting method from the following three types. 

Desired Position: Sets the output point at a desired position by 
moving the cursor. 

 
Area Center: Sets the output point in the center of the set 

template area. 

Sandwich: Sets the output point at the center of a desired 
rectangle in the set template area. 
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While you are setting it under "Desired Position" or "Sandwich", the coordinate of the current output point is 
displayed in the information display area. Use it to make the setting. 

 
 

By pressing the FUNC key during the setting under "Desired Position", the pop-up menu of "Middle Point" 
appears. Selecting this sets the output point in the center of a template. (This is the same position when 
selecting "Area Center".) 
 

7. Select "Create Edge" and set the edge condition. 

The "Create Edge" condition set here and 
the condition set in step 9 that is in the 
menu in higher hierarchy are the same 
setting. If either one is changed, this 
change is also reflected in the other.  

About how to set the condition, see step 9.  
 

 

8. After setting is completed, press the CANCEL key. 

Return to the template setting window. 
 

If there is no feature (or the degree of change in gray level is low) within the specified area, a message will 
be displayed and the template cannot be registered. 

9. Adjust the settings of "Create Edge" and "Accuracy" to generate contour information. 

Contour Matching detects an object 
using the contour information generated 
in the condition set in "Create Edge" and 
"Accuracy" based on a template image. 

If there is no feature for generating a 
contour (e.g. the degree of change in 
gray level is low or interrupted) within the 
specified area, a message will be 
displayed in step 10 and the template 
cannot be registered. 

If a part of green edges or no edges are 
displayed or edges exist too much, adjust 
the "Create Edge" condition. 

 

 

If contour information cannot be registered even though edges are displayed, set the level of 
"Accuracy" higher. 

(For details, refer to the following "Generating contour information (Edge Create)" and "Accuracy 

".) 
The conditions of "Create Edge" and "Accuracy" adjusted here are effective only for the template 
(registered gray image). For executing a checker, the condition to create edge information is set by 
"Create Edge" in "Search Area" and by "Accuracy" in "Execution Condition". 
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Generating contour information (Edge Create)  

In Contour Matching, an edge is the part of an object the brightness of 
which varies and the boundary point of the edge of the object.  Contour 
information is made based on it. Edge is created by the following four 
parameters. Check if an edge is displayed in the area you want to 
detect as contour before registering a template. If no edge is displayed, 
set the following items.  

 

Smoothing Decreases noises by blurring an image. The larger the size, the stronger the 
blurring. Increase Smoothing when many unncessary edges appear.  

Differential Specify the size to calculate differential values (degree of gray value change).  
Making the size larger tends to increase the differential value even if an image is 
blurred. Also, making the size larger tends to create sharp edges smoothly even if 
an image is blurred.  

Edge Extract Extracts differential values larger than the specified value in "Edge Extr." as 
edges. The smaller the value is set, the more edges are extracted, however, the 
more unnecessary parts may be extracted. In this case, set "Edge Extend" 
smaller instead of "Edge Extr.". Only necessary edges may be extracted. 

Edge Extend  If setting a value larger than that of "Edge Extr.", edges are created with the 
condition of "Edge Extr" only. If setting a value smaller than that of "Edge Extr.", 
the differential values that cannot be extracted with the condition of "Edge Extr." 
are additionally extracted as edges only when edges exist around.  When there is 
no edges around, the differential values larger than the setting of "Edge Extr." are 
not extracted as edges. Doing so creates edges with less noises than increasing 
the value of "Edge Extr.". 

 

Edge Extr.:20 
Edge Extend:20 

Edge Extr.:20 
Edge Extend:10 

Edge Extr.:10 
Edge Extend:20 

   

Accuracy 

To set the level to make contour information from 
edges. 

The higher the level, the shorter line can be 
recognized as contour information. 

 

Setting the higher level makes complicated 
contour or interrupted edges be recognized as 
contour information more easily. On the other 
hand, for a noisy image, noises are sometimes 
recognized as contour information. 
The higher level you set, the more contour 
information is created. Consequently, the 
inspection time generally gets longer. 

 
"Accuracy" in "Template Setting" window is to set 
the accuracy for the template image. "Accuracy" 
in "Execution Condition is to set it for the 
inspected image. 
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10. After setting the template, press the CANCEL key. 

The screen returns to “Contour Matching” setting window. 
If appropriate contour information is not generated, the error message "Registration of template image 
failed" appears. Update the position of the template or adjust the condition to generate contour information. 
Also check if an inappropriate image is used for contour information. (Refer to page 194) 
 

Selecting a Template from Common Image Patterns 

 page188. 

 

 

Setting a Search Area 
Set the range to search the same image pattern as a template. 

 
You cannot set a Mask Area in the search area of Contour Matching checker. 

1. Select “Area Setting” in “Contour Matching” setting window. 

2. Select "Search Area". 

“Area Setting” window is displayed. 

3. Draw a search area. 

Refer to section of Drawing an Inspection Area (page 63). 
 

 
Settable shape for search area is only rectangle. 

4. After drawing is completed, press the CANCEL key. 

5. Select "Inspection Edge" to set contour information.  

The "Inspection Edge" condition set here is the setting applied for an inspection image. Set the condition to 
create edge for "Template" in the "Template" menu. 
Basically, set the same condition that has been used in Template Setting for "Inspection Edge". 

Detecting multiple objects 

For detecting multiple objects, set the maximum number of detected objects.  

1. Select "Inspection Condition". 

2. Specify the value of "Max No. of results" from 1 to 64. 

Default: 1 
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Detecting Rotated Object 

If a detecting part is rotated or capturing direction is possible to be unstable, it is 
necessary to scan within a search area rotating the image pattern registered as a 
template. To do so, set a rotation angle. 
When "Shape" is "Circle", the rotation angle cannot be set. 

1. Select "Inspection Condition".  

2. Specify the value of “Rotation Range” from 0 (no rotation) to +/-180 (rotation of 360-degree). 

Note that the larger value of rotation angle range you set, the longer time its processing takes. 
Default: 30 

 
The detected angle may be larger than the set range. 
 

When there are some variations in the size of object 
Set when there are some variations in the distance between an object and camera or the size of object. An 
image of a size that is slightly different from template can be detected by using contour information 
registered in template. Set its tolerance. 

1. Select "Inspection Condition". 

2. Specify the value of “Magnification Range (+/-%)” from 0 (no variation in size) to +/-10. 

The larger value you set, the longer time its processing takes. 
 

The value set in "Magnification Range" is used to narrow down the points slated for detection when 
executing a checker. Therefore, the detected magnification may be larger than the set range. 

Changing Other Inspection Conditions 
(Out-Point Limit / Shape / Detect B/W Changed 
Image) 

1. Select "Inspection Condition". 

2. Change the settings of "Out-Point Limit", "Shape" and "Detect B/W Changed Image" as necessary. 

Out-Point Limit  

Decides whether or not to detect an object depending on the position of output point.  

No (Default): Any objects are detected regardless of the positions of output points. 

Yes: Objects are not detected when the output points are not in the following areas. 

 In Search Area 

 In Imaging Area (Actually captured part when Partial Imaging and Rotation 
preprocess are not specified) 

Shape   

Set when the registered template is a true circle. 
A true circle does not have angle information as it has the same shape at any angle. However, when the 
contour is actually detected, the output point is different from the actual position as the detection is 
performed with angle information. (Especially, when the output point is not close to the center of the circle, 
the difference will be larger.) "Shape" is set to prevent the difference. 
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Non-circle (Default): Detects the registered template as not true circle. 

Circle: Detects the registered template as true circle. The detection angle is 0. 

 
"Rotation Range (+/-)" cannot be set when "Shape" is "Circle". 

If setting "Rotation Range (+/-)" to zero without selecting "Circle", a detected angle is not necessarily zero 
degree. When registering a circle as template, always select "Circle". 

 

 

 

Detect B/W Changed Image In the Case of a Black/White 
Reversed Image 

This function is to detect an image which has 
reversed light-dark direction of the edge created in the 
registered template (e.g. the inside is dark or the 
outside is dark). Using this function increases the 
chance to detect images with reversed light-dark 
direction. 

1. Select "Inspection Condition". 

2. Select “Yes (Partially)” or "Yes" for "Detect B/W 

Changed Image". 

Template  Image you want to 
detect 

 
 

 

 

 
 
 
 
 

 

Yes (Partially) 

 
 

Yes  

 
 

No (Default): Detects only when the image has the same light-dark direction as the registered 
template. 

Yes (Partially): Detects even when a part of the edge of the image has reversed light-dark direction. 

Yes: Decides whether to detect or not according to edge positions without checking the 
light-dark direction.  

It has more chances to detect images than other methods, however, variation in 
detected positions tends to large. If a detected image has many unnecessary edges, 
the detection capability may be decreased. 

Setting Minimum Correlation 
Compares an inspection image and template image and detects the parts having a higher correlation value 
(degree of similarity) than this setting value. If there is no image with a higher correlation value than it, the 
inspection is judged as "NG". 

1. Select "Inspection Condition". 
 

2. Specify the value of “Minimum Correlation” from 0 to 1.000. 

The larger value you set, the more strictly inspections are performed (not 
detect dissimilar images). 
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Setting Execution Condition 
Sets the accuracy and speed for the inspection image. 

The condition of edge creation for an inspection image should be set in "Search Area". 

Accuracy 

To set the level to make contour information from edges. The higher the level, the shorter line can be 
recognized as contour information. Refer to "Accuracy" in "Template" (page 197) for details. 

This level does not need to be the same as the accuracy specified in "Template", however, the same level 
can be also set by selecting "Use Template Setting". 

Speed 

To set the speed to search. The higher "Speed" level, the higher detection speed. 

However, some images may not be detected at high speed levels.  

Overlap Ratio Level 
When detecting multiple objects, overlapped objects can be also detected. Setting smaller level numbers in 
"Overlap Ratio Level" enables to detect objects largely overlapped. 

Sorting 
When multiple images were detected, the function arranges in a certain rule and numbers them in ascending 
order from the first object as No.0. 
Specify the information used for sorting. 
Select from No, Correlation, X, Y, and Magnification. 

Sorting Order 
Select either "Ascending" or "Descending" for Sorting Order.  
Ascending: Sorts with the object of small value in the top.  
Descending: Sorts with the object of large value in the top.  
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Running a Test and Confirming Result 
Confirm if the current settings perform an inspection properly. To observe the image easily, set “Window 
Transparency (SETUP menu)” to larger value. (“Changing Window Transmittance”, page 439 ) 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
Position adjustment and area size adjustment are also executed if they have been set. 

2. Check data of detected area list. 

 
- The list of detected objects is 

displayed in the lower part of the 
setting window. When selecting this 
table, the mark on the screen window 
indicating the detected area turns to 
pink. 

 

 

Contour Matching Performance 

Selecting "Contour Matching First" speeds up the processing of Contour Matching. However, selecting 
"Contour Matching First" takes more time of type switch than selecting "Type Switch First".  

Even when selecting "Contour Matching First", the number of Contour Matchings the processings of which 
is speeded up is limited. As Contour Matching executes an inspection using contour information, the 
number of sped-up Contour Matchings varies depending on the amount of contour information not the 
template size. After setting to speed up the processing of all Contour Matchings, set to speed up that of 
Smart Matching if you have enough space on the internal memory.  

Check the processing time of inspection and type switch on your actual device before you use the function. 
 

1. Select “ENVIRONMENT” >  “System Settings” 

from the menu bar. 

2. Select "Operation". 

3. Select " Contour Matching First" in “Matching 

Performance”.  

 

Error messages when running a test 
If Contour Matching is not performed properly when running a test, error numbers and messages are displayed 
in the checker list. 

 
Error No. Message Cause 

0014 Calibration is wrong. When an error occurred in calibration under the 
condition that "Calibration" is "Available" 

0090 The Contour Matching 
process timed out. 

When an inspection does not complete even after the 
timeout period during the test execution of Contour 
Matching 
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Setting Timeout Period of Contour Matching   
If the extended execution time of Contour Matching has an adverse effect on the inspection cycle, the 
inspection can be terminated at the set time by specifying a timeout period. 

The timeout period can be set from "TYPE" > "Type Setting" menu.  

1. Select "TYPE" > “Type Setting” from the menu bar. 

The setting window of operation is displayed. 

2. Select "Execution Condition". 

3. Set a timeout period in "Timeout  
Contour Matching (ms)". 

Settable range: 100 to 99999 ms 
(Default: 10000 ms) 
The time to be set is the time for one 
Contour Matching. 

   

 
                           

          
 

 
The actual timeout period is a little bit longer than the set value. 
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4.7.12 Flaw Detection 

What Is Flaw Detection? 
Flaw Detection detects fine flaws, burs, cracks, and foreign objects (, which are generally called as “flaw” in this 
manual). The checker calculates gray average value within the segmented area (cell) on a line, an arc, or a 
circumference, or in a rectangle. If the PV200 detects an area more than a certain level of difference in average 
gray, the device judges it as a flaw. 

It is useful to detect flaws, burs, missing edges or contamination. 
 

On the edge of a rectangular face  

 

 

On the surface of an image On the edge of a circle 

 

 

Output Data 
 Line Plane Ellipse 

No. of Objects: 0 - 255 0 - 511 0 - 511 

Flaw size: 1 - 256 1 - 256 1 - 3600* 

First Cell of Flaw: 0 - 255 0 - 65535 0 - 3599 

Coordinate X and Y of first cell of flaw 

 
* When setting "Detect Mode" to "Gray Range", it may be 3601 - 3854 depending on the settings of "Num. of 
Cells for Calc. Range" and "Num. of Cells per Shift". 

Specifying Checker No. 

1. Select “Flaw Detection” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Flaw Detection” setting window is displayed. The gray 
image is displayed on the screen window regardless of 
camera type. 
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Selecting a Camera 
Select a camera image to set “Flaw Detection”. 

1. Select “Area Setting” in “Flaw Detection” 

setting window. 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed.  

3. Select how to convert a color image in "Select Color Image". (when using a color camera)  

The gray scale image converted by the selected method is displayed. 
 page 147 

 
 

Select a displayed image type (Live/Memory and Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 

Selecting Grayscale Preprocess / Position 
Adjustment 

 page 147 

Setting an Inspection Area 
Set a range to detect a flaw. 

1. Select “Area Setting” in “Flaw Detection” setting window. 

2. Select "Area (Set)". 

“Area Setting” window is displayed. 

3. Select a shape of inspection area from “Change Shape”. 

Select from Line, Plane, and Ellipse. 

4. Select “Change” and draw an area. 

The setting procedure differs depending on the shape in Flaw Detection. 

5. After drawing is completed, press the CANCEL key. 

Using Area Size Adjustment 

Area Size Adjustment is a function for inspecting variable-sized objects. The function adjusts an inspection 
area according to the size of the object detected with Area Size Adjustment checker. 

Refer to Chapter 4.9, page 282 about Area Size Adjustment and the setting procedure. 
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Drawing an Area: In the case of Area Shape = Line 

1. Set a start point (ST) and an end point (ED). 

You can set an area in the vertical and oblique 
directions as well as in the horizontal direction. 

2. Set the size of a cell (W) which is a rectangle 
calculating the average brightness. 

 
 

The widths in X and Y directions of a cell are 
defined as the figures shown right. 

 
 

 
 

 

3. Set the number of cells (N). 

Settable number of cells: 3 - 256 
Set the number of cells in order to inspect the 
object thoroughly from the start point to the end 
point and not to overlap cells each other as the 
figure shown on the right. 
If the cells overlap each other, the checker 
repeatedly scans the parts where the cells are 
overlapping, resulting in increasing inspection 
time. 

 
 

Changed area size by Area Size Adjustment 
function does not change the number of cells and 
cell size. Specify the number of cells in order to 
inspect thoroughly even if an area size will become 
larger. 

 
The Number of Cells (N) 

 
 

The lower figure is an example of occurrence of area 
that cannot be inspected due to lack of cells. 

 
 

 X 
(Left/right key of 
the keypad). 

Y 
(Up/down key of 
the keypad). 

ST X coordinate of the 
start point 

Y coordinate of the 
start point 

ED X coordinate of the 
end point 

Y coordinate of the 
end point 

W Width-X of cell Width-Y of cell 

N Number of cells  
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In the case of Area Shape = “Plane” 

1. Set a start point and an end point. 

Set a start point (STX, STY) and an end point 
(EDX, EDY). PV scans from the start point to 
the end point. 

 
 

If the scan direction is set to 
“Horizontal/Vertical”, PV scans in both 
directions. 

2. Set the size of a cell which is a rectangle 
calculating the average brightness. 

Scan direction: Horizontal Scan direction: Vertical 

 

3. Set the number of cells. 

Settable number of cells:  
- Number of cells X = 3 - 256 
- Number of cells Y = 3 - 256 

 
Set the number of cells in order to inspect the 
object thoroughly from the start point to the end 
point in both directions of X and Y, and not to 
overlap cells each other as the figure shown on 
the right. If the cells overlap each other, the 
checker repeatedly scans the parts where the 
cells are overlapping, resulting in increasing 
inspection time. 

 
 

Changed area size by Area Size Adjustment 
function does not change the number of cells. 
Specify the number of cells in order to inspect 
thoroughly even if an area size will become 
larger. 

 
 
The lower figure is an example of occurrence of area 
that cannot be inspected due to lack of cells. 
 

 
 

 X 
(Left/right key of the 
keypad). 

Y 
(Up/down key of the 
keypad). 

ST X coordinate of the 
start point 

Y coordinate of the 
start point 

ED X coordinate of the 
end point 

Y coordinate of the 
end point 

W Width-X of cell Width-Y of cell 

N Number of cells in X Number of cells Y 
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In the case of Area Shape = “Ellipse” 

1. Set the coordinates of the center of a circle as 
CPX and CPY, and set the radius in the X and Y 
directions of a circle as RX and RY. 

An inspection area (circle) and the rectangle 
circumscribing around it are displayed. 

2. Tilt the ENTER key left/right to set a start point 
(SPX, SPY) and an end point (EPX, EPY). 

If the coordinates of the start point equal to those of 
the end point, all circumference of the circle is 
scanned. 
Scan direction is always clockwise but 
counterclockwise. 

 
When the area shape is Ellipse, the start and end 
points are always located clockwise. They cannot 
be located in the reverse direction. Also, the start 
and end points of Ellipse in Flaw Detection indicate 
the start and end positions of the inspection area. 
They do not indicate the inspection direction. 
As shown in the following Step 5, it is possible to 
specify whether to inspect the inspection area 
clockwise or counterclockwise. 

 

 

3. Set the size of a cell (W) which is a rectangle 
calculating the average brightness. 

To change Width-X, tilt the Enter key left/right, to 
change Width-Y, tilt it up/down. 

4. Set the number of cells (N). 

Settable number of cells: 3 - 3600 
Set the number of cells in order to inspect the object 
thoroughly from the start point to the end point and 
not to overlap cells each other as the figure shown 
on the right. 
If the cells overlap each other, the checker 
repeatedly scans the parts where the cells are 
overlapping, resulting in slowing down the 
inspection speed. 

 
 

Changed area size by Area Size Adjustment 
function does not change the number of cells and 
cell size. Specify the number of cells in order to 
inspect thoroughly even if an area size will become 
larger. 

5. After setting the area, set the inspection 
direction in "Search Method" > "Direction". 
Select "Clockwise" or "Counterclockwise". 

In accordance with this setting, the start and end 
positions of inspection are determined. 

 
 X (Left/right key of 

the keypad). 
Y (Up/down key of 
the keypad). 

CP X coordinate of 
the center of the 
circle 

Y coordinate of 
the center of the 
circle 

R Diameter of the 
circle X 

Diameter of the 
circle Y 

SP X coordinate of 
the start point 

Y coordinate of 
the start point 

EP X coordinate of 
the end point 

Y coordinate of 
the end point 

W Width-X of cell Width-Y of cell 

N Number of cells  
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How to exclude from inspection (Mask area) 

Mask areas, where checker does no inspection, can be set in an inspection area. 

For Flaw Detection, set a first cell and an end cell of the range to be excluded from inspection. The number of 
mask areas is not limited. 

 

Adding a Mask Area 

1. Select "Add Mask". 

The border of the first cell from the start point is 
displayed in orange. 

 

2. Select the start cell of the mask area. 

 

3. Move the cursor to the end cell of the mask area. 

The borders of the cells from start to end in the mask 
area are displayed in orange. 

 

4. On the end cell, press the ENTER key. 

The mask area you have set is displayed in blue.  

 
 

Deleting a Mask Area 

1. Select "Delete Mask". 

The border of the first cell from the start point is displayed 
in orange. 

 

2. Select the start cell of the mask area to delete. 

 

3. Move the cursor to the end cell of the mask area. 

The borders of the cells from start to end in the mask area 
are displayed in orange. 

 

4. On the end cell, press the ENTER key. 

The mask area is cancelled and the borders of the cells of 
the area are displayed in green. 
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Inspecting in “Differential” Mode 

Principle of “Differential Mode” of Flaw Detection 
 

Process description Image 

The checker calculates the brightness 
(average gray value) of each rectangular 
area, which is called cell, created in a 
certain size within the inspection area. 

 

If the calculated average brightness of the 
cells is more than the “threshold value” you 
will set later, the PV extracts the cell as a 
candidate flaw (see the figure shown on the 
right). 
 
As you increase the threshold value, the PV 
regards the area of larger difference in 
brightness as a candidate flaw, whereas as 
you decrease the threshold value, the PV 
regards even an area having slight 
difference in brightness as a candidate 
flaw. 

The checker judges whether to regard the 
candidate flaw as a flaw based on the 
number of the cells in the candidate flaw. If 
the number of cells in the candidate flaw is 
more than the number of cells that have 
been set as “Flaw Size”, the candidate will 
be judged as a flaw. 

If flaw size = 3 

 

If flaw size = 5 

 

Setting Procedure 

1. Select "Search Method" in “Flaw Detection” 

setting window. 

2. Select “Differential” for “Detect Mode”. 

3. Set “Threshold” and “Min. Flaw Size in Cells”.  

Threshold (1 - 255) 
The minimum value of brightness to extract the cells comprising a candidate flaw. The checker extracts the 
cells with larger gray range than this setting value. 

 
Min. Flaw Size in Cells (1 - 256) 
Flaw size in cell unit. 
Set the minimum number of the cells in a candidate flaw. The checker decides a candidate flaw consisting 
of the more than the minimum number of cells you have set here as a flaw. 

4. After setting is completed, press the CANCEL key. 
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Inspecting in “Gray Range” Mode 

Principle of “Gray Range Mode” of Flaw Detection 
If the PV failed to detect any flaw after testing in Differential mode, try to test again after switching to Gray 
Range mode. 

Gray Range mode is effective to inspect the object with a surface of uneven brightness, but it will take longer 
time to process than Differential mode. 

 
Process description Image 

The checker calculates the brightness 
(average gray value) of each rectangular 
area, which is called cell, created in a certain 
size within the inspection area. 

 

The checker groups the cells and calculates 
the maximum gray range in the brightness of 
the grouped cell. The function calculates 
maximum gray range of each group made by 
shifting the cells by the setting value for “No. 
of Cells per Shift”, and then identifies the 
cells comprising the group gray range of 
which is the value of “Threshold” or more as 
a candidate flaw. 
 
The number of grouped cells 
The cells are grouped according to the 
setting value for “Num. of Cells for Calc. 
Range”. If the setting value for “Num. of Cells 
for Calc. Range” is “4”, four cells are grouped 
(see the figures shown on the right). 
 
The number of cells per shift 
This is the number of shifting cells to group 
them from the start point to the end point in 
the area. If the setting value for “Num. of 
Cells per Shift” is “2”, the PV calculates 
maximum gray range of each group made by 
shifting two cells till the end of the cells. (See 
the figures on the right.) 

Threshold 
As you increase the threshold value, the PV 
identifies the cells having larger gray range 
as a candidate flaw, whereas you decrease 
the threshold value, the PV identifies even 
the cells having lower gray range as a 
candidate flaw. 

The checker judges whether to regard the 
candidate flaw as a flaw based on the 
number of the cells in the candidate flaw. If 
the number of cells in the candidate flaw is 
more than the number of cells that have been 
set as “Flaw Size”, the candidate will be 
judged as a flaw. 

If flaw size = 3 

 

If flaw size = 10 
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Setting Procedure 

1. Select "Search Method" in “Flaw Detection” 

setting window. 

2. Select “Gray Range” for “Detect Mode”. 
 

“Num. of Cells for Calc. Range” and ”Num. of Cells per Shift” become settable. 

3. Set “Num. of Cells for Calc. Range” and ”Num. of Cells per Shift”. 

Num. of Cells for Calc. Range (2 - 256): The number of cells to be grouped. 
Num. of Cells per Shift (1 - 255): The number of shifting cells to group the cells. 

4. Set “Threshold” and “Min. Flaw Size in Cells”. 

 
For details on threshold and minimum flaw size in cells, refer to “Inspecting in Differential Mode”, page 210.  

5. After setting is completed, press the CANCEL key. 

How to Find Appropriate Value for “Threshold” 

With “Threshold Adjustment”, you can check the number of flaws to be detected when changing threshold 
value. This feature is effective if you do not know what threshold can detect the desired flaw. 

After that, you can set the adjusted threshold as inspection condition. 

1. Select “Thresh.Adj.”. 

After a message appears, number of flaws to be detected for each threshold is displayed in descending 
order of threshold by six rows. 
By tilting the ENTER key up/down, you can display data in after the seventh row. 

 
Tilting the ENTER key and pressing the SHIFT key moves the cursor faster. 

2. Move the cursor to each threshold and 
check the number and the positions of 
flaws that are detected according to the 
selected threshold. 

You can confirm the flaw detected according 
to the threshold in the screen window. 
The current setting value for threshold is 
displayed above the table. 

 
 

To observe the image easily, set “Window 
Transparency (SETUP menu)” to larger 

value. (How to change window 
transparency: Refer to page 439) 
Otherwise, press the F1key to display the 
screen window in the front and confirm it. 

 

3. Select a threshold value to set. 

When the dialog message appears, select “Yes” to save the threshold. 
The current threshold displayed above the table is changed. The threshold that has been set in Search 
Method is also updated. 

4. After setting is completed, press the CANCEL key. 
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Setting Judgement Limits 
Set a tolerance (maximum and minimum values) of the number of detected flaws. If the number of detected 
flaw is within the tolerance, the object will be judged as "OK", if it is out of it, the object will be judged as "NG". 

1. Select "Judgement Limits". 

2. Input the setting values for "OK Judge. Max." and "OK Judge. Min". 

3. After inputting is completed, press the CANCEL key. 

Running a Test and Confirming Result 
Confirm if the current settings perform an inspection properly. To observe the image easily, set “Window 
Transparency” to larger value. (“Changing Window Transmittance”, page 439) 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
 

Position adjustment and area size adjustment are also executed at the same time if they are used. 

2. Check data of detected area list. 

No.: Flaw number 
X: The center X coordinate of the first cell from the 
start point in a flaw 
Y: The center Y coordinate of the first cell from the 
start point of a flaw 
Flaw Size: The number of cells making up a flaw 

 
 

The list of detected areas is displayed in the lower 
part of the setting window. 
When selecting this table and highlighting each 
No., the mark indicating the flaw on the screen 
window turns to pink.  

Checking Gray Level and Differential Value of Cells 

You can observe gray level (average) and differential value of each cell. 

1. Press the FUNC key on Flaw Detection setting 
window. 

The pop-up menu appears. 

2. Select “Data Display”. 

The Data display window appears. 
 

3. Select “Gray Value” or “Differential”. (See A 

shown on the right figure.) 

4. Tilt the ENTER key left/right to select the cell 
to check its information. (See B on the right 
figure) 

The gray value or differential value of the 
selected cell is displayed. (See C on the right 
figure)  
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4.7.13 Connector (Binary Window) and Connector (Gray Window) 

What are Connector (Binary Window) and 
Connector (Gray Window)? 

These are the functions that mainly perform appearance inspection such as foreign objects detection on IC 
pins. 

 
 

Connector (Binary Window) measures areas of multiple Binary Window cells set on the inspection line and 
outputs the measured areas. Connector (Gray Window) measures gray average based on gray level of all 
pixels in multiple Gray Window cells set on the inspection line and outputs the gray average. 

These two checkers have different inspection methods as above, however, the setting procedures are the 
same. 

Output Data 
Connector (Binary Window) 

 
Area of each cell  

Judgement of each cell:  If the detected area of each cell is within the allowable range you have set, the 
object will be judged as "OK", if it is outside the allowable range, the object will be 
judged as "NG". 

Judgement: When judgments of all cells are “OK”, judgment of the checker will be “OK”. 
 

Connector (Gray Window) 
 

Gray average of each cell: 0 - 255 

Judgement of each cell: If the detected gray average of each cell is within the allowable range you have 
set, the object will be judged as "OK", if it is outside the allowable range, the 
object will be judged as "NG". 

Judgement: When judgments of all cells are “OK”, judgment of the checker will be “OK”. 
 

Specifying Checker No. 

1. Select “Connector (Binary Window)” or "Connector 

(Gray Window)" in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Connector (Binary Window)” or "Connector (Gray 
Window)" setting window is displayed. 
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Selecting a Camera 
Select a camera image to set a checker. 

1. Select "Area Setting". 

2. Select a camera No. in “Camera”. 

The selected camera image is displayed. 

3. Select how to convert a color image in "Select Color Image". (when using a color camera)  

The gray scale image converted by the selected method is displayed.  
 page 147 

 
 

Select a displayed image type (Live/Memory or Gray/Color/Binary) or magnification in “Image Menu” 

opened by pressing the F1 key. 

Selecting Grayscale Preprocess / Slice Level Group 
/ Position Adjustment 

 page 147 

Setting Inspection Area 

 
You cannot set a Mask Area. 

1. Select "Area Setting". 

2. Select "Set" of "Area Setting". 

“Area Setting” window is displayed. 

3. Move the area to inspecting area by operating 
the ENTER key and press the ENTER key to fix 
the position. 

4. Move the start point and fix it. Then, move the 
end point and fix it. 

5. Set the size (W) of cells which inspect 
appearance for each pin. 

Set a cell for a pin. 
 

 
The widths in X and Y directions of a cell are 
defined in accordance with the position of start point 
and end point as the figures shown on the right. 

6. Tilt the ENTER key left/right to specify the 
number of cells (N), and press the ENTER key to 
fix it. 

Set the number of cells to the same number as of 
pins. 

 
 

 X 
(ENTER key, 
left/right) 

Y 
(ENTER key, 
up/down) 

ST X coordinate of 
the start point 

Y coordinate of 
the start point 

ED X coordinate of 
the end point 

Y coordinate of 
the end point 

W Width-X of cell Width-Y of cell 
N Number of cells 

(Max. 100) 
 

 



 

216 

S
etting Inspection C

onditions 
C

h. 4 

Setting Judgement Limits 
Set a tolerance (Maximum and Minimum values) of gray average and area measured in each cell. 

If the detected data are within the tolerance, the object will be judged as "OK", if they are outside of it, the object 
will be judged as "NG". When judgments of all cells are “OK”, judgement of the checker will be “OK”. 

The maximum/minimum value can be set in two ways, common setting and individual setting. The common 
setting sets the same value for all cells and the individual setting sets separate values. When you want to set 
criteria for OK judgement by cells, use individual setting. 

1. Select "Judgement Limits". 

2. Press the TRIG key to execute a test. 

The area of each cell is displayed for your guide 
to set maximum/minimum values. 

3. To set values individually, select “Yes” for 
“Set individually”. 

Select "No" not to employ Individual Setting. 

4. Select the table of maximum/minimum 
values. 

 

5. To employ the common setting, select the row of “Common” and enter a value. 

To use the individual setting, select a cell number and enter a value. 
 

After the setting is completed, press the CANCEL key. 

Running a Test and Confirming Result 
Confirm if the current settings perform an inspection properly. To observe the image easily, set “Window 
Transparency (SETUP menu)” to a larger value. (See “Changing Window Transmittance”, page 439) 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
 

Position adjustment is also executed at the same time if it is used. 

2. Check data of the result list. 

Connector (Binary Window) 
No.:  Binary Window cell No. 
Area:  Area of each cell 
Judgement:  Judgement of each cell 

 
Connector (Gray Window) 

No.:  Gray Window cell No. 
Gray Average:  Gray average of each cell 
Judgement: Judgement of each cell 

 
 

When you highlight each No., the selected cell 
turns to pink on the screen window. 
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Registering Inspection Results in Numerical 
Calculation 

The detected Area of cells (for Connector (Binary Window)) or Gray Average (for Connector (Gray Window)) 
and Judgement can be registered into Numerical Calculation from the checker setting window. Although you 
can register them also in Numerical Calculation setting window, information of many cells can be registered 
efficiently with less operation from the checker setting window. 

1. Select "Num. Calcu.” in checker setting 
window. 

2. Select “Yes” for “Num. Calcu.” 

3. Select the setting table and select a data type 
to register. 

Result:  Area or Gray average of each cell 
Judgement:  Judgement of each cell 

4. Specify Starting Area, Number of Areas, and 
No. 

Starting Area: Cell No. of the first cell to 
register. 

No. of Areas: The number of cells to register 
No.: No. of the first Numerical 

Calculation that is to be 
registered. 

 
In the setting table, always "0" are displayed.  
Even after registering the data into Numerical 
Calculation, the table shows “0” again. 
The table cannot display the current registration 
status of Numerical Calculation. 

5. Press the CANCEL key to go back to the 
checker selecting window. 

The data is registered at this timing.  
When the destination Numerical Calculation No. 
is already set an expression, a message is 
displayed. Selecting “Yes” overwrites the 
expression. 

 

 
 

 
 

The example shown above is the setting where the 
results of cell No.0 to 4 are being registered into 
Numerical Calculation No.3 to 7. 
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Registering into Data R/W 
The detected Area of cells (for Connector (Binary Window)) or Gray Average (for Connector (Gray Window)), 
Judgement Limits, and Judgement can be registered into Data R/W from the checker setting window. Although 
you can register them also in Data R/W setting window, information of many cells can be registered efficiently 
with less operation from the checker setting window. 

1. Select "Data R/W" in the checker setting window. 

2. Select a sheet of Data R/W to register data in 
"Data R/W". 

3. Select a direction to arrange the data in 
"Rightward/Downward". 

Rightward: Registers the data from the specified 
position to the right cell. 

Downward: Registers the data from the specified 
position to the lower cell. 

4. Select the setting table and select a data type to 
register. 

Result No.: Cell No. of connector checker 
Maximum: Maximum value of cell judgement 

limits 
Minimum: Minimum value of cell judgement limits 
Result: Area or Gray average of each cell 
Judgement: Judgement of each cell 

 
 

In the setting table, always "0" are displayed.  
Even after registering the data into Data R/W, the 
table shows “0” again. 
The table cannot display the current registration 
status of Data R/W. 

5. Specify Starting Area, Number of Areas, and No. 

Starting Area: Cell No. of the first cell to register. 
R/W Row: The position on a Data R/W sheet of 

the first data.  R/W Column: 
No. of Areas: Number of connector checker cells 

data of which are registered in Data 
R/W sheet. 

 

 
 

 
 
 

 
 
The example shown above is the setting where 
Judgements of cell No.0 to 3 are registered into 
row No.3 and column No.1 to 4 in Data R/W 0. The 
data are registered as below. 
 

 
 
When Number of Areas is set to 5 under the 
condition above, the data that cannot be included 
in the specified row are stored in the next row from 
the first cell. 
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6. Press the CANCEL key to go back to the checker 
selecting window. 

The data is registered at this timing. 
When the destination cell of the Data R/W sheet is 
already set an expression, the data is overwritten. 
Note that the confirmation message does not 
appear. 
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4.7.14 Connector (Gray Edge) 

What is Connector (Gray Edge)? 
This checker measures gaps of IC pins, pitch and float of leads, and parts size (outside/inside diameters). It 
uses multiple Gray Edge checkers on a line in the area to detect edges of pins and an object, and helps to 
inspect on a connector IC with many pins. In the same method of Gray Edge checker, it detects a size of an 
object such as edges of pins and chip parts. Three modes are provided. Use them according to your purpose. 

 

Detect Example Output Data 

Execution Mode = Gap  

Detects a gap between pins. 
 

 

• Each gap 
• X coordinate, Y coordinate and differential value of two pins 

making up a gap 
• Maximum value, minimum value, and average of gaps 
• Judgement  

The checker judges based on the set tolerance of detected 
gaps. When all gaps are within the tolerance range, the 
object is judged as OK. 

• Judgement of each gap 

Execution Mode = Pitch  

 

• Each Pitch 
• X coordinate, Y coordinate and differential value of pins 

(edges) 
• Maximum value, minimum value, and average of pitches 
• Judgement of pitches 

The checker judges if the detected pitches are within the set 
tolerance. (Total Judgement, Judgement of each pin) 

Execution Mode = Float  

Detects a tip of each pin and a standard 
position. The difference between them is the 
base distance of a float. If the distance is 
short, it is judged as a float. In this manual, 
this base distance is “Float”. 

 

 

• Float of each pin 
• X coordinate, Y coordinate and differential value of each pin 
• Maximum value, minimum value, average, and distance 

difference* of floats 
• Judgement 

The checker judges if the detected floats are within the set 
tolerance. (Total Judgement, Judgement of each pin) 

• Distance Difference Judgement 
The checker judges if the detected distance difference is 
within the set tolerance. (Total Judgement, Judgement of 
each pin) 

• Total Judgement 
If the float judgement and Distance Difference total 
judgement are both OK, total judgement will be OK. 
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Specifying Checker No. 

1. Select “Connector (Gra. Edg.)” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Connector (Gra. Edg.)” setting window is displayed. The 
gray image is displayed on the screen window regardless 
of camera type. 

 

Selecting a Camera 
Select a camera image to set Connector (Gray Edge) checker. 

1. Select “Area Setting” in “Connector (Gra. Edg.)” setting window. 

2. Select a camera No. in “Camera”. 

3. Select how to convert a color image in "Select Color Image". (when using a color camera)  

The gray scale image converted by the selected method is displayed. 
 page 147 

 
Select a displayed image type (Live/Memory or Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 

Selecting Grayscale Preprocess / Position 
Adjustment 

 page 147 

Selecting an Execution Mode and Checker Direction 
Connector (Gray Edge) checker has three execution modes. Select one of them according to your inspection 
purpose. 

Checker Direction is to set a start point and an end point of an area horizontally or vertically. Changing either of 
Execution Mode or Checker Direction clears an inspection area. Set them before drawing an area. 

1. Select “Inspection Condition” in “Connector (Gra. Edg.)” setting window. 

2. Select one of three modes for 
“Execution Mode”. 

When the dialog message appears, 
select “Yes”. 

3. Select “Horizontal” or “Vertical” in 

"Checker Direction". 

When the dialog message appears, 
select “Yes”. 
Now, selecting Execution Mode and 
Checker Direction is complete. 

Execution Mode = Pitch 
 
 

 

Execution Mode= Float 
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In the case of Execution Mode = Gap 
The procedure described below is for area setting and other inspection conditions when Execution Mode is set 
to “Gap”. 

Setting an Inspection Area 
 

You cannot set a Mask Area in Connector checker. 

1. Select “Area Setting” in “Connector (Gra. Edg.)” setting window. 

2. Select "Area (Set)". 

“Area Setting” window is displayed. In Gap mode, two sets of areas (Area 0, Area 1) must be set. 
The orange area displayed in the window when opening it is Area 0. 

3. Move the Area 0 to inspecting area by operating 
the ENTER key. And then, press the ENTER key to 
fix the position. 

4. Move the start point of Area 0 and fix it. Then, 
move the end point and fix it. 

In the lower left on the screen, the coordinates of the 
start point and the end point of Area 0, and size and 
the number of Gray Edge cells are displayed. Use 
them to make setting. (See the right table) 

5. Set the size (W) of Gray Edge cells which detect 
edges in width measuring area. 

 
The widths in X and Y directions of a cell are defined 
as the figures shown on the right. 

6. Tilt the ENTER key left/right to specify the number 
of cells, and press the ENTER key to fix it. 

7. Tilt the ENTER key up/down to select Area 1. 

Follow the same procedure of Area 0. 

 

 X 
(ENTER key, 
left/right) 

Y 
(ENTER key, 
up/down) 

ST X coordinate of 
the start point 

Y coordinate of 
the start point 

ED X coordinate of 
the end point 

Y coordinate of 
the end point 

W Width-X of cell Width-Y of cell 

N Number of cells 
(Max. 100) 

 

 

 
 

 
Cell size and the number of cells are shared by Area 0 and 1. Changing the values during Area 1 setting 
changes the value of Area 0. (You cannot set different values.) 

Setting Edge Conditions 
Specify the condition of detecting edges and scanning. 

1. Select "Inspection Condition". 

2. Set "Detect Direction". 

Set the direction in order to search edges from the side with fewer noises. 
• Inside -> Outside • Outside -> Inside • Top -> Bottom 

(Checker Direction 
=Horizontal) 

• Bottom -> Top 
(Checker Direction 
=Horizontal) 
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• Right -> Left 
(Checker Direction 
=Vertical) 

• Left -> Right 
(Checker Direction 
=Vertical) 

 

 
For the information of the following conditions, refer to the chapter of Gray Edge checker (page 164). 

 Inspection Condition - "Scan Method”, “Edge Condition", “Detected Position” 

 Search Method 

(As for Edge Condition, set in "Edge Condition 0" and "Edge Condition 1" for Area 0 and 1 respectively. ) 

Deciding Differential Threshold 
Decide a threshold value of differential in detecting area. Only the areas with differential value which is higher 
than this threshold are subjected to detect. 

The threshold can be set in two ways, common setting and Individual setting. The common setting sets the 
same value for all Gray Edge cells and the Individual setting sets separate values. Use the Individual setting if 
pins have different brightness or only some of pins are dark due to lighting condition. 

1. Select “Thresh.Adj.”. 

2. Press the TRIG key to execute a test. 

The detected edge differentials are displayed. Use them to set the threshold. 

3. To set threshold of Gray Edge cells individually, select “Yes” for “Set Individually”. 

Select "No" not to employ Set Individually. 

4. Select the threshold setting table. 

"Thre.0" and "Diff.0" are the settings for Area0, and "Thre.1" and "Diff.1" are the settings for Area 1.  

5. To employ the common setting, select the row of “Common” and enter a value. 

To use the Individual setting, select Gray Edge cell number and enter a threshold. 

6. Press the TRIG key to execute a test. 

Press the F1key to display the image and confirm that all parts are detected stably. 

Setting Judgement Limits 
Set a tolerance (maximum and minimum values) of the values of detected gaps. If the detected widths are 
within the tolerance, the object will be judged as "OK", if it is out of it, the object will be judged as "NG". When all 
widths are detected and judgements of them are “OK”, judgement of the checker will be “OK”. 

1. Select "Judgement Limits". 

2. Input the setting values for "Max. Judge, Pitch" and "Min. Judge. Pitch". 

Even when using "Gap" as the execution mode, these items are displayed as "Max. Judge. Pitch" and "Min. 
Judge. Pitch". 

3. After inputting is completed, press the CANCEL key. 

In the case of Execution Mode = Float 
The procedure described below is for area setting and other inspection conditions when Execution Mode is set 
to “Float”. 
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Setting an Inspection Area 
 

You cannot set a Mask Area in Connector checker. 

1. Select “Area Setting” in “Connector (Gra. Edg.)” setting window. 

2. Select "Area (Set)". 

“Area Setting” window is displayed. In Float mode, two areas (Area 0, Area 1) must be set. Area 0 detects 
a tip of pin and Area 1 detects base position of float such as a foot of pin. An area displayed in orange 
when selecting the window is Area 0. 

3. Move the Area 0 to inspecting area by operating 
the ENTER key and press the ENTER key to fix 
the position. 

4. Move the start point of Area 0 and fix it. Then, 
move the end point and fix it. 

In the lower left on the screen, the coordinates of the 
start point and the end point of Area 0, and size and 
the number of Gray Edge cells are displayed. Use 
them to make setting. (See the right table) 

5. Set the size (W) of Gray Edge cells which detect 
edges in width measuring area. 

 
The widths in X and Y directions of a cell are defined 
as the figures shown on the right. 

6. Tilt the ENTER key left/right to specify the 
number of cells, and press the ENTER key to fix 
it. 

7. Tilt the ENTER key up/down to select Area 1. 

In the same steps for setting Area 0, move and set a 
start point and set an end point. 

 X (ENTER key, 
left/right) 

Y (ENTER key, 
up/down) 

ST X coordinate of 
the start point 

Y coordinate of 
the start point 

ED X coordinate of 
the end point 

Y coordinate of 
the end point 

W Width-X of cell Width-Y of cell 
N Number of cells 

(Max. 100) 
 

 
 

 
 

 
 
 

 
 

 
The relative position of the start point and the end point has no effect on edge detection. Set "Detect 
Direction" in “Inspect Condition”. 
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Setting Edge Conditions 
Specify the condition of detecting edges and scanning. 

1. Select "Inspection Condition". 

2. Set "Detect Direction". 

Set a Detect Direction which is suitable for the captured image. For the image shown below, setting 
“Outside -> Inside” detects edges correctly. 

• Inside -> Outside • Outside -> Inside • Right -> Left 
(Checker Direction  
= Vertical) 

• Left -> right 
(Checker Direction  
= Vertical) 

 
 

 

• Top -> Bottom 
(Checker Direction  
= Horizontal) 

• Bottom -> Top 
(Checker Direction  
= Horizontal) 

 
 

 
For the information of the following conditions, refer to the chapter of Gray Edge checker (page 164). 

 Inspection Condition - "Scan Method”, “Edge Condition", “Detected Position” 

 Search Method 

(As for Edge Condition, set in "Edge Condition 0" and "Edge Condition 1" for Area 0 and 1 respectively. ) 

Deciding Differential Threshold 
Decide a threshold value of differential in detecting area. Only the areas with differential value which is higher 
than this threshold are subjected to detect. 
The threshold can be set in two ways, common setting and individual setting. The common setting sets the 
same value for all Gray Edge cells and the individual setting sets separate values. Use the individual setting if 
pins have different brightness or only some of pins are dark due to lighting condition. 

1. Select “Thresh.Adj.”. 

2. Press the TRIG key to execute a test. 

The detected edge differentials are displayed. Use them to set the threshold. 

3. To set threshold of Gray Edge cells individually, select “Yes” for “Set Individually”. 

Select "No" not to employ individual Setting. 

4. Select the threshold setting table. 

5. To employ the common setting, select the 
row of “Common” and enter a value. 

To use the individual setting, select Gray Edge 
cell number and enter a threshold. 
“Thre.1” and “Diff.1” are respectively threshold 
and differential value of Area 1 which detects the 
base of a float. 

 

 
6. Press the TRIG key to execute a test. 

Press the F1key to display the image and confirm that all parts are detected stably. 
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Setting Judgement Limits 
Set a tolerance (maximum and minimum values) of the values of detected floats and “Distance Difference”. If 
the floats and distance difference are within the tolerance, the object will be judged as "OK", if they are out of it, 
the object will be judged as "NG". When judgement of floats and distance difference are both “OK”, judgement 
of the checker will be “OK”. 

 
“Distance Difference” is a difference between floats of adjacent pins. For example, the distance difference of 
No.0 is the difference between the floats of No.0 and No.1. 

1. Select "Judgement Limits". 

2. Input the setting values for "Max. Judge. Pitch" and "Min. Judge. Pitch". 

Even when using "Float" as the execution mode, these items are displayed as "Max. Judge. Pitch" and 
"Min. Judge. Pitch". 

3. Input the setting values for "Max. Distance Difference" and "Min. Distance Difference". 

Enter maximum/minimum values for distance difference. 

4. After inputting is completed, press the CANCEL key. 
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In the case of Execution Mode = Pitch 
The procedure described below is for area setting and other inspection conditions when Execution Mode is set 
to “Pitch”. 

Setting an Inspection Area 
 

You cannot set a Mask Area in Connector checker. 

1. Select “Area Setting” in “Connector (Gra. Edg.)” setting window. 

2. Select "Area Setting". 

“Area Setting” window is displayed. 

3. Move the area to inspecting area by operating the 
ENTER key and press the ENTER key to fix the 
position. 

4. Move the start point and fix it. Then, move the end 
point and fix it. 

The position of the start point is a start point of scan of 
the first Gray Edge. 

5. Set the size (W) of Gray Edge cells which detect 
edges of pins. 

Set the size to surround a pin with a cell. 
 

The widths in X and Y directions of a cell are defined 
as the figures shown on the right. 

6. Tilt the ENTER key left/right to specify the number 
of cells, and press the ENTER key to fix it. 

Set the number of cells to the same as the number of 
pins to be measured. 

 

 
 X 

(ENTER key, 
left/right) 

Y 
(ENTER key, 
up/down) 

ST X coordinate of 
the start point 

Y coordinate of 
the start point 

ED X coordinate of 
the end point 

Y coordinate of 
the end point 

W Width-X of cell Width-Y of cell 
N Number of cells 

(Max. 100) 
 

 

Setting Edge Conditions 
For the information of the conditions listed below, refer to the chapter of Gray Edge checker (page 164). 
 Inspection Condition - "Scan Method”, “Edge Condition", and Front and Peak of “Detected Position” 

 Search Method 
 

About Detected Position: Center 

“Center” setting detects two points in a cell and outputs 
the middle point of them as detect position and the 
distance between the middle points of each cell as 
Pitch. 

 

The detected point closer to the start point is Edge 
0 and the other is Edge 1. Set edge conditions for 
each edge, Edge Condition 0 and Edge Condition 
1.  
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Setting Edge Threshold 
Decide a threshold value of differential in detecting area. Only the areas with differential value which is higher 
than this threshold are subjected to detect. 

The threshold can be set in two ways, common setting and individual setting. The common setting sets the 
same value for all pins and the individual setting sets separate values. Use the individual setting if pins have 
different brightness or only some of pins are dark due to lighting condition. 

1. Select “Thresh.Adj.” 

2. Press the TRIG key to execute a test. 

The detected edge differentials are displayed. Use them to set the threshold. 

3. To set threshold of pins individually, select “Yes” for “Set Individually”. 

Select "No" not to employ Individual Setting. 

4. Select the threshold setting table. 

5. To employ the common setting, select the 
row of “Common” and enter a value. 

To use the Individual setting, select pin number 
(Gray Edge cell number) and enter a threshold. 

 

6. Press the TRIG key to execute a test. 

Press the F1key to display the image and confirm that all pins are detected stably. 
 

Setting Judgement Limits 
Set a tolerance (maximum and minimum values) of the pitch values of detected pins. If the detected pitches are 
within the tolerance, the object will be judged as "OK", if it is out of it, the object is judged as "NG". When 
judgements of all pitches are “OK”, judgement of the checker will be “OK”. 

1. Select "Judgement Limits". 

2. Input the setting values for "Max. Judge. Pitch" and "Min. Judge. Pitch". 

3. After inputting is completed, press the CANCEL key. 
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Running a Test and Confirming Result 
Confirm if the current settings perform an inspection properly. To observe the image easily, set “Window 
Transparency (SETUP menu)” to a larger value. (“Changing Window Transmittance”, page 439 ) 

1. Press the TRIG key. 

When a live image is displayed on the 
screen, PV captures a new image first and 
runs a test. When a memory image is 
displayed, it runs a test using the current 
memory image without capturing any 
images. 

 
 

Position adjustment is also executed at the 
same time if it is used. 

 

2. Check data of detected area list. 

No.: Gray Edge cell No. 

Pitch: Data of Pitch, Gap or Float. (Regardless of execution modes, the name is fixed to 
“Pitch”.) 

Judgement: Judgement of each pin (or width) 

Distance Difference: Distance Difference of “Float” (Available only in the case of Execution Mode = 
Float) 

Judgement: Judgement of Distance Difference of “Float” (Available only in the case of 
Execution Mode = Float) 

X0, Y0, Diff.0: Coordinates and differential value of edges detected with Area 0.  

X1, Y1, Diff.1: Coordinates and differential value of edges detected with Area 1. 

 
 When Calibration is employed, the data is displayed after calibration. 

 When highlighting each No., Gray Edge cells displayed on the screen window turn to pink. 
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Registering Inspection Results in Numerical 
Calculation 

The detected coordinate and differential value of cells and judgement can be registered into Numerical 
Calculation from the checker setting window. Although you can register them also in Numerical Calculation 
setting window, information of many cells can be registered efficiently with less operation from the checker 
setting window. 

 

Data that can be registered into Numerical Calculation from Connecter (Gray Edge) setting window 

 Pitch 

 Pitch Judgement 

 Distance Difference 

 Distance Difference Judgement 

 X coordinate 0 

 Y coordinate 0 

 Differential value 0 

 X coordinate 1 

 Y coordinate 1 

 Differential value 1 

 

The setting procedure is the same as Connector (Binary Window) and Connector (Gray Window). Refer to 
page 217 for details. 

Registering into Data R/W 
The detected pitch, distance difference, and judgement limits of cells and judgement can be registered into 
Data R/W from the checker setting window. Although you can register them also in Data R/W setting window, 
information of many cells can be registered efficiently with less operation from the checker setting window. 

 

Data that can be registered into Data R/W from Connecter (Gray Edge) setting window 

 Result No.: Cell No. of the first cell to register 

 Maximum: Max. Judge. Pitch 

 Minimum: Min. Judge. Pitch 

 Max. Dist. Differ.: Max. Distance Difference 

 Min. Dist. Differ.: Min. Distance Difference 

 Pitch 

 Pitch Judgement 

 Distance Difference 

 Distance Difference Judgement 

 X coordinate 0 

 Y coordinate 0 

 Differential value 0 

 X coordinate 1 

 Y coordinate 1 

 Differential value 1 

 

The setting procedure is the same as Connector (Binary Window) and Connector (Gray Window). Refer to 
page 218 for details. 



 

231 

S
etting Inspection C

onditions 
C

h. 4 

4.7.15 Smart Edge (Circle) 

What is Smart Edge (Circle)? 
Smart Edge (Circle) is a function to output the center point, radius or diameter of a round object by detecting 
edges of the object with a number of cells. It is suitable for the detection of a missing edge and burr of a round 
object, angle of a convex (or concave) part, the inspection of circularity and the calculation of the angle of the 
diameter position of an ellipse. For a ring-shaped object, detecting the outer and inner circles both enables the 
detection of the difference between the centers of the two circles or the ring width. 

The central coordinate or radius of a circle can be also detected when a whole object cannot be captured or for 
the angle of a chamfered object. 

 

Inspection example 

 
・Detection of radius, 

diameter 
・Detection of angles of 

measured maximum 
and minimum values. 

・Capturing only a part of a 
circle can detect the 
circle. 

・Ring width and center 
points of inner and outer 
circles 

 
Detect Mode  Output Data 

Measure Radius  Detects the radius from the center point 
of a detected virtual circle to the edge. 
This mode is effective to detect a 
missing edge and burr, and the position 
and angle of a projection as the left 
figure. 

Circularity inspection is also possible 
based on a radius value. 

• Virtual circle (Centeral coordinate, 
Radius) 

• Radius, Diameter or Width,  
and the maximum, minimum, 
average and standard deviation 

• Circularity 
• Maximum angle, minimum angle 

(Radius, Diameter or Width) 
• Detected data of each cell 

Radius, Diameter or Width 
Deviation(Detect Mode: Measure 
Radius only), Coordinate, 
Differential 

• Used edge count, Unused edge 
count 

 

 

Measure Diameter  Detects the diameter based on the edge 
coordinates of a circle detected with two 
opposite cells . 

Circularity inspection is also performable 
based on a radius value. 

 

Measure Width  Inspects ring-shaped objects. Measures 
the difference between the edges of 
outer and inner circles, and outputs it as 
"Width". This mode is suitable for 
inspecting the misalignment of center of 
concentric circle as the central 
coordinates of two circles are detected. 

Circularity inspection is also performable 
based on a radius value.  
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Specifying Checker No. 

1. Select “Smart Edge (Circle)” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Smart Edge (Circle)” setting window appears. The gray 
image is displayed on the screen window regardless of 
camera type. 

 

Selecting a Camera 
Select a camera image to set “Smart Edge (Circle)” checker. 

1. Select “Area Setting” in “Smart Edge 
(Circle)” setting window. 

2. Select a camera No. in “Camera”. 

The image of the selected camera is 
displayed. 

 

3. Select how to convert a color image in "Select Color Image". (when using a color camera)  

The gray scale image converted by the selected method is displayed.  
 page 147 

 
 

Select a displayed image type (Live/Memory and Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 

Selecting Position Adjustment 
Position Adjustment is helpful when the position of an inspection object may shift largely or an angle can be 
detected in advance for an ellipse object. 

Select a Position Adjustment checker that has been already set. Refer to page 268 for details of position 
adjustment. 

1. Select "Position Adj." in Area Setting window. 

The list of position adjustment is displayed. 
 

 
If a position adjustment checker is not created, “Position Adj.” cannot be selected. 

2. Select a Position Adjustment No. from the list. 

 

 
When selecting a checker number for Position/Rotation Adjustment or Rotation Adjustment, the criterion values 
for maximum and minimum angles or the label for the horizontal axis of the graph vary depending on the setting 
of "Base Angle". Refer to page 244 for details. 
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Selecting a Grayscale Preprocess Group 
Set a preprocess filter to apply on an image captured by a camera as necessary. 

1. Select “Virtual Circle Detect Condition” > "Grayscale Preprocess". 

“Preprocess” window is displayed. 

2. Select a Grayscale preprocess group (A to P) in “Grayscale Preprocess”. 

 
For details of grayscale preprocess, refer to page 130. 

3. After setting is completed, press the CANCEL key. 

Return to “Virtual Circle Detect Condition” setting window. The selected preprocess group is displayed.  

Execution Sequence of Smart Edge (Circle) 
 

Process sequence   Related parameters 
    

Detection of edges of circle   • Area Setting (p.239) 
• Edge Detect Condition (p.241) 

    

Detection of virtual circle Calculates the central 
coordinate and radius of 
virtual circle. 

 • Detection 
Method 

• Edge ratio used 
• Execution 

Mode 

┐ 
├ (p.242) 
┘ 

    

Detection of radius, diameter or 
width 

Detects according to 
Detect Mode. 

 • Detect Mode (p.234) 

    

Detection of each data (see the right 
column) and circularity of radius, 
diameter or width. 

Max. value, min. value, 
average value, standard 
deviation, angle of 
max./min. value 

 
 

• Denoising (p.246) 
• Base Angle (p.244) 

    

Judgement Each judgement condition  • Judgement Limits: Each Max., Min. 
values (p.248) 
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Setting Detect Mode 

1. Select “Virtual Circle Detect Condition” > "Detect Mode". 

2. Select a desired Detect Mode from the list. 

Depending on the selected Detect Mode, detected data items to be displayed at the bottom of the screen 
vary. 
Detect Mode 
• Measure Radius 
• Measure Diameter 
• Measure Width 

 

 

 
About graphs: page 237 

Displayed data  
Table below (1) 

Displayed data  
Table below (2) 

About Data to be displayed 
 Detect Mode 

 Measure Radius Measure Diameter Measure Width 

(1) Virtual 
circle 

a) Center coordinate (X, Y) Center coordinate (X, Y) of inner circle 
Center coordinate (X, Y) of outer circle 

   Radius Radius of inner circle 
Radius of outer circle 

(2) Measure
-ment 
value 

b) Max. radius Max. diameter Max. width 
  Min. radius Min. diameter Min. width 
  Average radius Average diameter Average width 
  c) (Radius) Standard 

deviation 
(Diameter) Standard 

deviation 
(Width) Standard deviation 

  d) Circularity Circularity of inner circle 
Circularity of outer circle 

  e) Max. radius angle Max. diameter angle Max. width angle 
Min. radius angle Min. diameter angle Min. width angle 
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a) Virtual circle 

Virtual circle is a true circle(*) that is calculated with the 
coordinate values of the edges of an object detected by each cell. 

Two detection methods are available. "General Mode" which 
uses the coordinate values of all detected edges and "Details 
Mode" which does not use the coordinate values of convex or 
concave of an object for calculating the virtual circle. 

 
*) When Calibration is employed, virtual circle (true circle) is 
detected with the values after calibration. When Factor X and 
Factor Y are different, it is displayed as an ellipse according to 
the ratio. (Because the image displayed on the screen is the state 
before calibration.) 

 

b) Maximum, minimum and average of measurement values 

Calculates the radius, diameter or width using the edges detected by each cell. Then, calculates the maximum, 
minimum and average values for the remaining data except the data judged as noises. 

The criterion to judge data as noises is decided by "Denoising" function. 

As the graph displayed on the screen (described below) shows the maximum and minimum values before 
denoising, the values of the graph may be different from the output values. 

 
About Denoising function: Page 246 

c) Standard deviation 

It is the value that the variation in values 
of radius, diameter or width is 
quantified. It is calculated by the formula 
mentioned on the right. 

This formula is for the case of "Detect 
mode: Measure Radius". 

For the case of "Measure Diameter" or 
"Measure Width", replace the "Radius" 
in the right formula with "Diameter" or 
"Width". 

 

 
 

 
The calculation method for "Standard Deviation" used for Denoising 
function is different. 

The larger value indicates the greater variation. 

d) Circularity 

Detects the difference between the maximum radius and minimum 
radius as circularity. 

When Detect Mode is "Measure Diameter" or "Measure Width", 
circularity is also calculated by detecting the radius, maximum radius 
and minimum radius. 

(However, when Detect Mode is "Measure Diameter" or "Measure 
Width", the maximum radius and minimum radius are not displayed on 
the screen.)  

 

Circularity 
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e) Maximum angle and Minimum angle 

Angle between the base angle and the 
position of the maximum/minimum value 
of radius, diameter or width. 

 

 
The base angle (Dotted line position in 
the right figure) used for calculating 
angles is selectable. 
Refer to page 244 for details. 

Example)  
Max. diameter 
angle 

 
Min. width 
angle 
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About Graphs and Cell results to be displayed 
Measurement values of each cell obtained from test results are displayed as graphs in Smart Edge (Circle). 
The graph shows the status of edge detection for each cell or whether they are within edge threshold as marks. 

It is also possible to shows a list of the status of edge detection or detection data for all cells. 

About graph 

 
 

(1) Graph type It shows a graph of radius data when Detect Mode is "Measure Radius". It 
shows a graph of diameter data when selecting "Measure Diameter", and a 
graph of width data when selecting "Measure Width". 

When threshold has been set in Edge Detect Condition, a graph of differential is 
shown. 

However, a graph of radius is shown regardless of the set detect mode when 
setting "Edge Detect Condition" or setting "Judgement Limits" > "Denoising". 

(2) 
(3) 

Maximum value 

Minimum value 

The maximum and minimum values of radius. This is the value of radius 
(diameter/width) that is calculated based on the coordinate of edge detected by 
each cell before applying various parameters such as Judgement Limits. It may 
be different from the maximum measurement or minimum measurement 
displayed at the bottom of the screen. (Because the data displayed at the 
bottom of the screen is the value after applying the denoising function.) 

(4) Angle label 0 to 360 degree for "Measure Radius" and "Measure Width". 0 to 180 degree for 
"Measure Diameter". 

The positions and results of edges detected by each cell are displayed from the 
start angle in order. 

The position at 0 degree and the lower label varies depending on the start angle, 
end angle, setting value of "Base Angle" and adjustment angle for 
Position/Rotation Adjustment. 

(5) Result of each cell It shows detected positions of each cell. It also shows detection results or 
maximum and minimum measurement values as marks. 

Mark Color Description Cell result list (*) 
Display of judgement field 

● Yellow green Min. Measurement OK/NG 

● Yellow green Max. Measurement OK/NG 

× Red Edge: Undetected Undetected 

× Blue Excluded edge by 
denoising 

Excluded 

◆ Light blue Judgment: OK OK 

◆ Red Judgement: NG NG 

   *) Next page 
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Checking result and data of each cell 

Press the FUNC key and select 
“Cell Result”  from the 
pop-up-menu. 

Cell number, judgement, 
measurement values, deviation, 
coordinate and differential are 
listed for all the set cells. The 
selected cell is displayed in pink 
on the screen window. 

Tilt the ENTER key up/down to 
display the data of the desired 
cell. 

 

 
 In the case of Width Measurement, both data of outer and inner circles is displayed. 

 Tilt the SHIFT and ENTER keys to change the page. 
 

Judgement 

Four types of characters are displayed in "Judge." field after the test depending on the edge detection result of 
cells or judgement result. 

 
 "Judge." 

field 
Edge Detection Edge coordinate was 

used for calculating 
measurement value. 

Measurement value (radius, 
diameter or width) is within 
the max. and min. values of 
Judgement Limits. 

Mark in 
graph 

1 OK Yes 
(Detected) 

Yes Yes 
（Judgement: OK） 

◆ 
(Light blue) 

2 NG Yes 
(Detected) 

Yes × 
（Judgement: NG） 

◆  
(Red) 

3 Excluded Yes 
(Detected) 

× 
(Excluded by "Denoising") 

--- ×  
(Blue) 

4 Undetected × 
(Undetected) 

--- --- ×  
(Red) 

 
 

Deviation 

This value is the difference between the radius (Measurement value) and the radius of virtual circle. It is 
displayed only when Detect Mode is set to "Measure Radius". 
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Displaying only the cells of a specific judgement result 

It is possible to display only the cell data of a specific result such as the cells judged as NG or the NG and 
excluded cells. 

Press the FUNC key when displaying the cell result 
list and select the type of the cells to be displayed 
from the pop-up menu. 

The selected result type is checked, and only the 
cells of the checked type are displayed in the list. 

Selecting again deletes the check marks and restores 
the display. 

 

It is possible to select not only one type but also 
several types. 

For example, when NG cells, undetected cells and 
excluded cells are all checked, the cells other than 
the cells judged as OK are displayed. 

 

 
 

 

Setting Inspection Area 
Set the position and size of the area and the size of cells to detect edges of a circle by the cells. 

1. Select “Area Setting” in “Smart Edge (Circle)” setting window. 

2. Select "Area Setting". 

“Area Setting” window is displayed. 
A cell to detect the edge of an object circularly arranged is displayed on the screen window. 

3. Select "Change". 

4. Move the entire area by operating the ENTER key and set 
the center of the circle (CPX, CPY). 

5. Set the size of the area. 

The area size is expressed by radius (RX, RY). 
To change Width-X, tilt the Enter key left/right, to change 
Width-Y, tilt it up/down. 

6. Set the size of the cell (WX, WY). 

To change Width-X, tilt the Enter key left/right, to change 
Width-Y, tilt it up/down. 
The cell scans from the outside to inside of the circle or from the 
inside to outside. This scan direction is Width-Y. 

 
 

 

7. Tilt the ENTER key left/right to set a start angle 
(SAX)and an end angle (EAX). 

When Detect Mode is "Measure Diameter", an end angle 
cannot be specified as it is not possible to measure only a 
part of the circle. 
The sell at the start angle is set to No.0 and cell numbers 
are assigned to the end angle. 

Example) 
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8. Set a pitch of the angle to arrange the cells (cell 

pitch) in 0.1 degree (*1). 
When it is set to 10.0 (Default), 36 cells are arranged 
at every 10 degree for measuring whole 
circumference. 
Set it to a smaller value to arrange more cells. 

 
When a negative value is specified, cell numbers are 
assigned from the start cell counterclockwise. 

 
 

If the number of cells increases and they overlaps 
each other, only two cells are displayed from the start 
angle. 
*1) In Diameter measurement mode, the number of 
cells must be always even. Therefore, it may not be 
specified by 0.1 degree. 

 

 X (Left/right key of 
the keypad) 

Y (Up/down key of 
the keypad) 

CP X coordinate of the 
center of the circle 

Y coordinate of the 
center of the circle 

R Radius of the circle 
X 

Radius of the circle 
Y 

W Width-X of cell Width-Y of cell 
SA Start Angle 
EA End Angle 
AP Cell pitch (+/-90, except 0) 

* Tilting the arrow keys (left/right/up/down) 
pressing the SHIFT key enables to specify SA, 
EA and AP by 0.1 degree. 

* In Diameter measurement mode, there is no 
EA: End angle. 

9. After setting the cell pitch is completed, press the CANCEL key. 

How to exclude from inspection (Mask area) 

Mask areas, where checker does no inspection, can be set in an inspection area. Set a start point and an end 
point of a cell to be excluded from inspection. The number of mask areas is not limited. Follow the same steps 
used for "Flow Detection" checker. 

 Page 209 

Assignment of cell numbers 

Cell numbers are assigned to the arranged cells from the start 
angle. When a mask area has been set, it is also possible not 
to assign a cell number to the mask area (to skip the cell in the 
mask area). 

1. Select "Virtual Circle Detect Condition". 

2. Select either "Mask Area Include" or "Mask Area 
Exclude" in "Result No. Assignment". 

Mask Area Include (Default): 
Assign cell numbers to the cells masked. 
Mask Area Exclude: 
Not assign cell numbers to the cells masked. 

 
The right figure shows an example of the difference in the 
results of cell number assignment when the lower-left 
three cells (dotted line) are masked. 

Mask Area Include 

 
 
Mask Area Exclude 

 



 

241 

S
etting Inspection C

onditions 
C

h. 4 

Edge Detect Condition 
Set conditions of detecting edges of an object. 

1 Select "Edge Detect Condition". 

The list of the conditions for detecting edges and the 
graph is displayed. 
When Detect Mode is "Measure Width", two sets of 
conditions are provided. Setting these conditions enables 
the 2 edges of the outer circle and inner circle to be 
detected with different conditions. 

2. Set "Scan Direction". 

In. -> Out.: 
Scans from the center of the circle to the outside. 
Out. -> In.: 
Scans from the outside of the circle to the center. 

 

 

In. -> Out. Out. -> In. 

  

 
 

In the case of Width Measurement 
Edges of the outer circle and inner circle are detected with one cell. 

 
Inside Outside Scan Method  

In. -> Out. Out. -> In. Scans the inner edges from the center of 
the circle to the outside, and scans the 
outer edges from the outside to the center. 
At this time, if the outer edge is detected at 
the position closer to the center than the 
inner edge, the edges are undetected. 

 

In. -> Out. Scans the edges of the inner circle, and 
starts the scan of the edges of the outer 
circle from that position. 

 
Out. -> In. Scans the edges of the outer circle, and 

starts the scan of the edges of the inner 
circle from that position. 

 
Out. -> In. In. -> Out. Scans the edges of the inner circle from 

the center of the cell, and starts the scan of 
the edges of the outer circle from that 
position. 

 

3. Set "Scan Method", "Edge Condition", "Edge Threshold" and "Detect Position". 

These edge detect conditions are the same as Gray Edge checker. Refer to page 164. 
 

Scan Method: Projection / Single 
Edge Condition: Light -> Dark/ Dark-> Light/ Both 
Edge threshold: 50 (Default) 
Detect Position: Front/Peak/Rear 

 
The following items are available only when selecting "Single". 
Filter, Width, Average Range  

4. Press the TRIG key to run a test and confirm if the edges of the circle are detected. 
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How to read a graph when setting a threshold 
Pointing the cursor to "Edge Threshold" displays the graph of differentials of edges. 

Decide the appropriate threshold referring to the detection result and differential of each cell in "Cell Result" 
and this graph. 

 
 

Vertical axis: It indicates differential. When Edge Condition is "Both", it is -255 to 255. When 
"Light->Dark", 0 to -255. When "Dark->Light", 0 to 255. 

Red line: It indicates threshold. 
When "Edge Condition" is set to "Dark->Light", the edges with the differentials over the red 
line that is drawn above Differential 0 are detected. 
When "Edge Condition" is set to "Light->Dark", the edges with the differentials below the 
red line that is drawn under Differential 0 are detected.  
When "Edge Condition" is set to "Both", the two lines are displayed.  

Light blue line: It indicates the average of differential. 
When Edge Condition is "Both", the both averages of the detected edges for 
"Light->Dark" and edges for "Dark->Light" are displayed. 

 
Refer to "About Graph" (p.237) for the details of marks and items other than those above. 

Setting Virtual Circle Detect Condition 

Set the method for detecting a virtual circle. Set 
"Detection Method", "Edge ratio used" and 
"Execution Mode". 

1. Select “Virtual Circle Detect Condition” ".  
> "Detection Method”. 

"Detection Method" is a parameter to decide 
whether or not to use all the edge coordinates 
detected by each cell for calculating a virtual 
circle. 

 

 
General Mode: 
Detects a virtual circle using all edge coordinates. However, as the figure on the right, if the edge 
coordinates of projections are also used for detecting a virtual circle, the center of the virtual circle may 
shift. 

 
Details Mode (Default): 
When an object has projections or concave surface, using this mode enables those edge coordinates not 
to use for calculating a virtual circle. 
First, detects a virtual circle using all the edge coordinates, and then detects the final virtual circle only 
using the edge coordinates in "Edge ratio used" from those with a smaller error for the first virtual circle. 
Select "Details Mode" to set "Edge ratio used". 
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2. Select "Edge ratio used(%)". 

The menu for setting "Edge ratio 
used" appears in the upper left of 
the screen. The screen window can 
be checked. 
Default: 80 (%) 

 
 

When "Edge ratio used" is 100, all the detected edges are indicated with "Yes"(light blue). It shows that 
they are used for detecting the virtual circle. Decrease the value of Edge ratio used and run the test. The 
mark for the edges unused for the virtual circle changes to "×" (red), and the line showing the virtual circle 
comes closer to the circumference. After determining the value, press the CANCEL key. 

 

 
 

3. Select "Execution Mode". 

[Default: Speed First] 
This parameter is effective when a part of a circle is out of the inspection area due to the position shift of 
the object. 
If a part of the circle is out of the inspection area, the number of detected edge coordinates may reduce or 
a different spot from the edge of the target circle may be detected. As a result, the correct virtual circle may 
not be detected or the center of the detected virtual circle may not be correctly detected. 

 
In such case, set the mode to "Accuracy First". The inspection area will be adjusted to the central 
coordinate of a virtual circle after the detection, and the virtual circle will be detected again. In other words, 
the position adjustment is performed by the checker itself. 
However, the number of detection of virtual circle in "Accuracy First" mode is more than "Speed First" 
mode, and so the inspection time is longer. 
 

Speed First (Default)  Accuracy First 
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Setting Base Angle 
Select a base angle from the following three types for detecting the angles of the maximum and minimum 
values of radius, diameter or width. This setting affects the display of the lower horizontal axis of the graph that 
is displayed on the setting window. 

1. Select “Virtual Circle Detect Condition” > "Base Angle". 

2. Select from “X Direction”, “Rotation Adjustment Angle” or "Start Angle". 

X Direction (Default): 
Outputs an angle using the right side of X axis as 0 degree. An angle is expressed in -180 to +180. 
It is not affected by the "Start Angle" specified in Area Setting or the adjustment angle in "Position 
Adjustment". 
The lower horizontal axis of the graph is indicated from the value that is Start angle + Adjustment angle. 

 
Rotation Adjustment Angle: 
Outputs an angle using  Rotation adjustment angle as a base. An angle is expressed in -180 to +180. 
The lower horizontal axis of the graph is indicated from Start angle. 

 
Start Angle: 
Detects an angle using "Start Angle" specified in the area as 0 degree. An angle is expressed in 0 to 360. 
If the number for Position/Rotation Adjustment or Rotation Adjustment checker is specified for "Position 
Adjustment" in Area Setting, the start angle after rotation adjustment is 0 degree. 

 
 

Example) When Start angle is 45 degree and Adjustment angle is 30 degree, 75 degree is used as a base 
angle as the start angle is located at the position of 75 degree. 
The lower horizontal axis of the graph is always indicated from 0 degree. 
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Output example of angle 
 

Condition 

Start Angle: 45 degree 

End Angle: -45 degree 

Max. value (Max. angle): Projection 

 
Detection angle 
 Position/Rotation Adjustment, Rotation Adjustment 

 No Yes: Adjustment angle = 30 degree 

X Direction 120 degree 
Detects from the right side of X axis to the 
maximum position. 

 

120 degree 
Detects from the right side of X axis (before 
adjustment) to the maximum position. 

 
Rotation 
Adjustment 
Angle 

90 degree 
Detects from the right side of X axis (after 
adjustment) to the maximum position. 

 
Start Angle 75 degree 

Detects from start angle to the maximum 
position. 

 

45 degree 
Detects from start angle (after adjustment) to 
the maximum position 

.  
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Setting Judgement Condition 
Perform judgement for the following four conditions respectively. When all the conditions are met, the 
judgement result of the checker will be OK. 
 Measurement: Radius, Measurement: Diameter, Measurement: Width 

 Standard deviation (Standard deviation calculated from the result of measurement) 

 Circularity 

 Unused Edge Count 

Setting Denoising function 

About Denoising function 

Measurement values are calculated using the edges 
detected by each cell. However, if cells detect 
projections, concaves on the surface of the object or 
noises existing around it as edges, using this function 
enables those edges not to be used for calculating 
measurement values. This is "Denoising Function". 

Only the edges within a distance or standard deviation 
specified based on the radius of a virtual circle are 
used for the calculation of measurement values. 

Figure 1 
 

 

 
Virtual circle 

Range of edge 
positions used for 
calculation 
measurement values 

 

About Unused Edge Count 

In Denoising function, edges excluded from edges to 
be used for calculation and cells which cannot detect 
edges are called "unused edge". Edges used for 
calculating measurement values are called "used 
edge". The number of each edge is displayed in the 
left of the screen together with the judgement result of 
checker. 

Example of edges 
excluded by Denoising 
function.  

 

1. Select “Judgement Limits” > "Denoising". 

2. Use either "Distance" or "Std. Devi." for 
performing "Denoising". 

Distance:  
Uses the edges within the distance specified in 
"Denoising" based on the radius of a virtual circle for 
the calculation of measurement values. 
(Area within the dotted line in Figure 1) 

 
Standard Deviation:  
Calculates the standard deviation from the radius of a 
virtual circle and the edge coordinates detected by 
each cell, and uses the edges within the value 
calculated by the formula mentioned on the right. 
(Area within the dotted line in Figure 1) 

 

"Radius of virtual circle +/- Standard 
deviation * Denoising range" 

 

The "Standard deviation" used here is 
calculated based on the radius of a virtual circle. 

It is different from the "Standard Deviation" 
displayed on the screen (that is a criterion for 
judgement). 
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3. Set "Denoising Range". 

Set the denoising range checking the graph or the result of each cell (Cell Result). 
 

 
Refer to page 238 for details of Cell Result. 

 
The figure below shows an example that Denoising is not used. Multiple edges in the two areas are 
targeted for measurement. 

 
 

Using Denoising function displays a line to divide the range of unused edges from the range of used edges 
as below. 
Enter a value in Denoising Range and press the ENTER key to move this line. 
Check the graph and make the setting to let the target edges in the range of unused edges. 

 
Setting the denoising range to a larger value expands "Used edge range". 

 
 

The "x" mark (red) in the graph indicates the cell that detects no edge. 
Although it is displayed in the used edge range, it is counted as an unused edge. 
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Setting Judgement Limits 

 

 

1. Select the table of maximum/minimum values in "Judgement Limits" setting window. 

2. Specify the maximum and minimum measurement values of radius (diameter/width). 

As the maximum and minimum measurement values are displayed at the bottom of the screen, make the 
setting checking it. 
In addition, red lines indicating the maximum and minimum values are displayed in the graph. Confirm 
them and set. 

3. Specify the maximum and minimum values of standard deviation and circularity. 

As the current value of each condition is displayed at the bottom of the screen, make the setting checking 
it. 

4. Specify the maximum value for "Unused Edge Count". 

The current value of the unused edge count (test result) is displayed on the left of the screen. Confirm it 
and set. 
The default for the maximum number of settable cells is 3597. 
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Running a Test and Confirming Result 
Confirm if the current settings perform an inspection properly. To observe the image or checker pattern easily, 
set “Window Transparency (SETUP menu)” to a larger value.  
(“Change Window Transparency (SETUP Menu)”, page 439 ) 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
 

Position adjustment and area size adjustment are also executed if they have been set. 

2. Check data of detected area list. 

Check the graph, data of virtual circle, measurement data and judgement result to be displayed on the 
screen. 

 

Error messages when running a test 
If Smart Edge (Circle) is not performed properly when running a test, error numbers and messages are 
displayed in the checker list. 

 
Error No. Message Cause 

0014 Calibration is wrong. When an error occurred in calibration under the 
condition that "Calibration" is "Available” 

0040 Virtual circle cannot be 
calculated. 

• When the number of detected edges is 2 or less: 
• When the center of virtual circle is not within the range 

of -9,999.999 to +9,999.999. 
• When all the detected edges are located on the same 

line: 
0041 Edge required for 

measurement cannot be 
detected. 

• When edge count is 0 after denoising: 
• When no combination of edges to be paired cannot be 

detected when Detect Mode is Diameter 
measurement or Width measurement: 
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4.7.16 Smart Edge (Line) 

What is Smart Edge (Line)? 
Smart Edge (Line) is a function to calculate an approximate line using the coordinate values detected with a 
number of cells. 
Detecting the line of the edge face enables the detection of the angle of the object even if the object has a 
rough face.  
The mode for measuring the width of the object is also available. 

 

Inspection example 

Detect Mode: Measure Deviation, Measure Distance 
Detect Mode:  
Measure Width 

 
• Detection of the 

position of a 
projection 

• Angle of an object 

Detection of a corner 
(Combination of Smart 
Edge (Line) and 
Geometry Calculation) 

• Distance difference 
from Base Position 
(Measure Distance) 

• Width measurement 
• Detection of the max. and 

min. values, and output of 
the position 

Output Data 

Approximate Line • Coordinates (Start point, End point) 
• Angle 
• Line element (a, b, c) 
• Linearity 

 

Measurement 

(Deviation, Distance, 
Width) 

• Max. measurement, Position of max. measurement 
• Min. measurement, Position of min. measurement 
• Average Measurement 
• Standard Deviation 

Each cell • Coordinate of edge, Differential, Measurement 

Judgement • (Total) Judgement Result, Measurement 
Judgement, Standard Deviation Judgement,  
Linearity Judgement, Unused Edge Count 
Judgement 

Used Edge Count  

Unused Edge Count  

Specifying Checker No. 

1. Select “Smart Edge (Line)” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

“Smart Edge (Line)” setting window appears. The gray 
image is displayed on the screen window regardless of 
camera type. 
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Selecting a Camera 
Select a camera image to set “Smart Edge (Line)” checker. 

1. Select “Area Setting” in “Smart Edge 

(Line)” setting window. 

2. Select a camera No. in “Camera”. 

The image of the selected camera is 
displayed. 

 

3. Select how to convert a color image in "Select Color Image". (when using a color camera)  

The gray scale image converted by the selected method is displayed. 
 page 147 

 
 

Select a displayed image type (Live/Memory and Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 

Selecting Position Adjustment 
Position Adjustment is helpful when position of an inspection object may move largely. Select a Position 
Adjustment checker that has been already set. Refer to page 268 for details of position adjustment. 

1. Select "Position Adj." in Area Setting window. 

The list of position adjustment is displayed. 
 

 
If a position adjustment checker is not created, “Position Adj.” cannot be selected. 

2. Select a Position Adjustment No. from the list. 

 

 
When selecting a checker number for Position/Rotation Adjustment or Rotation Adjustment, the base angle 
vary depending on the setting of "Base Angle". 

Base Angle: Refer to page 261. 

Selecting a Grayscale Preprocess Group 
Set a preprocess filter to apply on an image captured by a camera as necessary. 

1. Select “Approximate Line Detect Condition” > "Grayscale Preprocess". 

“Preprocess” window is displayed. 

2. Select a Grayscale preprocess group (A to P) in “Grayscale Preprocess”. 

 
For details of preprocess, refer to page 130. 

3. After setting is completed, press the CANCEL key. 

Return to “Approximate Line Detect Condition” setting window. The selected preprocess group is 
displayed. 
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Execution Sequence of Smart Edge (Line) 
   Related parameters 

Detection of edges of target 
area 

  • Area Setting (page 258) 
• Edge Detect Condition (page 241) 

    

Detection of approximate line   • Detection 
Method 

• Edge ratio used 
• Base Angle 

┐ 
├page 260 
┘ 

    

Detection of deviation, 
distance or width 

Detects according to Detect 
Mode. 

 • Detect Mode (page 253) 

    

Detection of each data of 
deviation, distance or width 
(see the right column) 

Maximum, Minimum, Average 
values and Standard deviation 

 
 

• Denoising (page 262) 

    

Detection of linearity of 
approximate line 

Difference between Max. and 
Min. deviations 

  

    

    

Judgement Each judgement condition  • Judgement Limits: Each Max., Min. 
values (page 263) 
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Setting Detect Mode 
Smart Edge (Line) detects the edge of the end face of an object, and detects the coordinate values, angle and 
linearity of the approximate line to be detected from the coordinate value. In addition, the following 
measurements are performed in each inspection mode. 

 

Measure Deviation 

Measures the edge detected in each cell and 
the length of a perpendicular to the approximate 
line through the edge (distance between the 
edge and the approximate line). This is 
"Deviation". 

 
Measure Distance 

Measures the distance between the start point 
of scan in each cell and the detected edge. 

 
Measure Width 

Detects the distance between the two edges 
detected in one cell as width. 
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1. Select “Approximate Line Detect Condition” > "Detect Mode". 

2. Select a desired Detect Mode from the list. 

Depending on the selected Detect Mode, detected data items to be displayed at the bottom of the screen 
vary. 

 
Detect Mode 
• Measure Deviation 
• Measure Distance 
• Measure Width 

 

 

 
Graph: Refer to page 
256. 

 

 

 

About Data to be displayed 

 Measure 
Deviation 

Measure Distance Measure Width 

(a) Angle of approximate line Angles of approximate lines 0 and 1 

(b) Linearity of approximate Line Linearity of approximate lines 0 and 1 

(c) Standard 
deviation of 
deviations 

Standard 
deviation of 
distance 

Standard deviation of width 

(d) Max. deviation Max. distance Max. width 

 Min. deviation Min. distance Min. width 

 Average deviation Average distance Average width 

About Detected Line (Approximate Line) 

It is a line that is calculated with the 
coordinate values of the edges of an 
object detected by each cell. 

Two detection methods are available. 
"General Mode" which uses the 
coordinate values of all detected 
edges and "Details Mode" which does 
not use the coordinate values of 
convex or concave of an object for 
calculating the line.  
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About Positive and Negative of Deviation Data 

The deviation data detected when Detect Mode is 
"Measure Deviation" is positive or negative 
depending on the scan direction (of the cell). When 
the scan direction (upper dashed arrow) is from left 
to right, the right area across the approximate line 
is positive and left area is negative as the right 
figure 

When the scan direction is the other way, the 
positive and negative areas are also inverted. 

 

What are Maximum, Minimum and Average Measurement 
Values? 

Calculates the deviation, distance or width using the edges detected by each cell. Then, calculates the 
maximum, minimum and average values for the remaining data except the data judged as noises. 

The criterion to judge data as noises is decided by "Denoising" function. 

As the graph displayed on the screen (described below) shows the maximum and minimum values before 
denoising, the values of the graph may be different from the output values. 

 About Denoising function: page 262 

What is Standard Deviation? 

It is the value that the variation in values of 
deviation, distance or width is quantified. It is 
calculated by the formula mentioned on the right. 

The larger value indicates the greater variation. 

The right formula is for the case of "Detect mode: 
Measure Distance". For the case of "Measure 
Deviation" or "Measure Width", replace the 
"Distance" in the right formula with "Deviation" or 
"Width". 

 

 
The calculation method for "Standard Deviation" used for 
Denoising function is different. 

What is Linearity? 

Linearity is the difference between the maximum and minimum values of 
the deviation for an approximate line. 
In case of the "Measure Distance" mode and "Measure Width" mode, 
linearity is also calculated in the same method as the "Measure Deviation" 
mode. 

 

Linearity 

Approximate 
line 
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About Graphs and Cell results to be displayed 
Measurement values of each cell obtained from test results are displayed as graphs in Smart Edge (Line). The 
graph shows the status of edge detection for each cell or whether they are within edge threshold as marks. 

It is also possible to show a list of the status of edge detection or detection data for all cells. 

About Graphs 

 
 

(1) Graph type: It shows a graph of deviation data when Detect Mode is "Measure Deviation". It 
shows a graph of distance data when selecting "Measure Distance", and a graph 
of width data when selecting "Measure Width". When threshold has been set in 
Edge Detect Condition, a graph of differential is shown. 

However, a graph of deviation is shown regardless of the set detect mode when 
setting "Edge Detect Condition" or setting "Judgement Limits" > "Denoising".  

(2) 
(3) 

Maximum: 
Minimum: 

The maximum and minimum values of measurements. This is the value of 
measurement (deviation, distance, width) that is calculated based on the 
coordinate of edge detected by each cell before applying various parameters such 
as Judgement Limits. It may be different from the maximum measurement or 
minimum measurement displayed at the bottom of the screen. (Because the data 
displayed at the bottom of the screen is the value after applying the denoising 
function.) 

(4) Horizontal axis: Cell No. (Max. 3000) 

(5) Result of each cell: It shows detected positions of each cell. It also shows detection results or 
maximum and minimum measurement values as marks. 

Mark Color Description Cell result list (*) 
Display of judgement field 

● Yellow 
green 

Min. Measurement OK/NG 

● Yellow 
Green 

Max. Measurement OK/NG 

× Red Edge: Undetected Undetected 

× Blue Excluded edge by 
denoising 

Excluded 

◆ Light 
blue 

Judgment: OK OK 

◆ Red Judgement: NG NG 
   *)Next page 
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Checking result and data of each cell 

Press the FUNC key and select “Cell Result”  from 
the pop-up menu. 

Cell number, judgement, measurement values, 
coordinate and differential are listed for all the set 
cells. The selected cell is displayed in pink on the 
screen window. 

Tilt the ENTER key up/down to display the data of 
the desired cell. 

 

 
 In case of the "Measure Width" mode, two 

sets of data are displayed for one cell as 
two approximate lines are detected. 

 Tilt the SHIFT and ENTER keys to change 
the page.  

 
 

Judgement 

Four types of characters are displayed in "Judge." field after the test depending on the edge detection result of 
cells or judgement result. 
 Judgement 

field 
Edge Detection Edge coordinate was used 

for calculating 
measurement value. 

Measurement value is 
within the max. and min. 
values of Judgement 
Limits 

Mark in 
graph 

1 OK Yes 
(Detected) 

Yes Yes 
（Judgement: OK） 

◆ 
(Light blue) 

2 NG Yes 
(Detected) 

Yes × 
（Judgement: NG） 

◆ (Red) 

3 Excluded Yes 
(Detected) 

× 
(Excluded by "Denoising") 

--- × (Blue) 

4 Undetected × 
(Undetected) 

--- --- × (Red) 

 
 

Displaying only the cells of a specific judgement result 

It is possible to display only the cell data of a specific result such as the cells judged as NG or the NG and 
excluded cells. 

Press the FUNC key when displaying the cell result list 
and select the type of the cells to be displayed from the 
pop-up menu. 

The selected result type is checked, and only the cells 
of the checked type are displayed in the list. Selecting 
again deletes the check marks and restores the 
display. 

 

It is possible to select not only one type but also 
several types. 

For example, when NG cells, undetected cells and 
excluded cells are all checked, the cells other than the 
cells judged as OK are displayed. 
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Setting Inspection Area 
Set the position and size of the area and the size of cells to detect edges of the object by the cells. 

1. Select “Area Setting” in “Smart Edge (Line)” setting window. 

2. Select "Area Setting" > "Change". 

3. Move the whole area by operating the ENTER key and press the ENTER key. 

4 Specify "Start point (ST)" and "End point (ED)". 

The start point is on the left and the end point is on the right in 
the default condition. 
Set the start point and end point along the edges to be 
detected. 
When the edges to be detected are located vertically, set the 
start point at the bottom and the end point at the top. 
The cell at the start point is set to No.0 and cell numbers 
increase to the end point. Note that the scan direction of the 
cells vary depending on the positions of start and end points. 
The scan direction is set in "Edge Detect Condition". 

 
 

 

5. Set the size of the cell (WX, WY). 

To change Width-X, tilt the Enter key left/right, to change 
Width-Y, tilt it up/down. 
The width parallel to the start and end points is Width-X, and 
the right-angled direction is Width-Y. 

6. Tilt the ENTER key left/right to specify the number 
of cells (N), and press the ENTER key to fix it. 

Set the cells with no space between them from the 
start point to the end point. The part with a space 
between cells cannot be inspected. 

 
 X (Left/right key of 

the keypad) 
Y (Up/down key of 
the keypad) 

ST X coordinate of the 
start point 

Y coordinate of the 
start point 

ED X coordinate of the 
end point 

Y coordinate of the 
end point 

W Width-X of cell Width-Y of cell 
N Number of cells (Max. 3000) 

 

 
If the number of cells increases and they overlaps each other, only two cells are displayed from the start 
point. 
If the cells are fully or partly covered with other cells, the scans are repeated in those areas. Although the 
inspection is conducted thoroughly, note that the processing time takes longer as the number of cells 
increases. 

7. After setting the number of cells is completed, press the CANCEL key. 

 

How to exclude from inspection (Mask area) 

Mask areas, where checker does no inspection, can be set in an inspection area. Set the first cell and end cell 
to be excluded from inspection. The number of mask areas is not limited. Follow the same steps used for "Flow 
Detection" checker. 

 page 209 
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Assignment of cell numbers 

Cell numbers are assigned to the arranged cells from the start point. When a 
mask area has been set, it is also possible not to assign a cell number to the 
mask area (to skip the cell in the mask area). 

1. Select "Approximate Line Detect Condition". 

2. Select either "Mask Area Include" or "Mask Area Exclude" in "Result 
No. Assignment". 

Mask Area Include (Default): Assign cell numbers to the cells masked. 
Mask Area Exclude: Not assign cell numbers to the cells masked. 

 
The right figure shows an example of the difference in the results of cell 
number assignment when the three cells (dotted line) are masked. 

Mask Area Include 

 
 
Mask Area Exclude 

 

Edge Detect Condition 
Set conditions of detecting edges of an object. 

1. Select "Edge Detect Condition". 

The list of the conditions for detecting edges and the graph is 
displayed. 
When Detect Mode is "Measure Width", two sets of conditions 
(Condition 0 and Condition 1) are provided. Setting these conditions 
enables the two edges to be detected with different conditions to 
detect the width. 
The edges of Line 0 are detected with Condition 0 and the edges of 
Line 1 is detected with Condition 1. 

 

2. Set "Scan Direction". 

[->]: If the start point is regarded as the position at six o'clock, it scans 
in the direction of three o'clock from nine o'clock. 
[<-]:If the start point is regarded as the position at six o'clock, it scans 
in the direction of nine o'clock from three o'clock. 

 
Selecting the scan direction displays the guide indicating the relation 
between the start and end points in the inspection area and the 
selected direction on the screen. 

When selecting -> 
(Right-pointing arrow) 

 
 
When selecting <- (Left-pointing 
arrow) 
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When Detect Mode is "Measure Width", two edges are detected with one cell. 
The following is the example that the start point of the area is regarded as the position at six o'clock. 
Condition 

0 
Conditi

on1 
Scan Method  

-> -> Condition 0 and 1 scans edges in the same 
direction. 
Edges are scanned in the direction of three 
o'clock from nine o'clock with Condition 0. Then, 
edges are scanned with Condition 1 from the 
edge detection point of Condition 0. 

 

<- <- Condition 0 and 1 scans edges in the same 
direction. Edges are scanned in the direction of 
nine o'clock from three o'clock with Condition 0. 
Then, edges are scanned with Condition 1 from 
the edge detection point of Condition 0.  

-> <- Condition 0 and 1 scans edges in opposite 
directions. Edges are scanned in the direction 
of three o'clock from nine o'clock with Condition 
0, and in the direction of nine o'clock from three 
o'clock with Condition 1.  

<- -> Condition 0 and 1 scans edges in opposite 
directions. Edges are scanned in the direction 
of nine o'clock from the center of a cell. Then, 
edges are scanned with Condition 1 in the 
direction of three o'clock from the edge 
detection point of Condition 0. 

 

3. Set "Scan Method", "Edge Condition", "Edge Threshold" and "Detect Position". 

These edge detect conditions are the same as Gray Edge checker. Refer to page 164. 
 

[Scan Method]: Projection / Single 
[Edge Condition]: Both / Light -> Dark / Dark-> Light 
[Edge Threshold]: Default: 50 
[Detect Position]: Front / Peak / Rear 
[Filter], [Width], [Average Range] (Only when selecting "Single".) 

4. Press the TRIG key to run a test and confirm if the edges to detect the approximate line are 
detected. 

 

How to read graphs when setting thresholds 
It is the same as Smart Edge (Circle). Refer to page 237. However, the horizontal axis of the graph for Smart 
Edge (Line) is cell numbers. 

Setting Approximate Line Detect Condition 
Set the method for detecting an approximate line. Set "Detection Method", "Edge ratio used" and "Execution 
Mode". 

1. Select “Approximate Line Detect Condition”  > "Detection Method". 

This is a parameter to decide whether or not to use all the edge coordinates detected by each cell for 
calculating an approximate line. 

 
General Mode:  
Detects an approximate line using all edge coordinates. 
However, if there is a projection or concave in the detected area, the approximate line may shift as the 
edge coordinates in those parts are also used for the detection. 
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Details Mode (Default): 
When an object has projections or concave 
surface, using this mode enables those edge 
coordinates not to use for calculating an 
approximate line. First, detects an approximate 
line using all the edge coordinates, and then 
detects the final approximate line only using 
the edge coordinates in "Edge ratio used" from 
those with a smaller error for the first 
approximate line. 
Select "Details Mode" to set "Edge ratio used". 

 

2. Select "Edge ratio used(%)". 

The menu for setting "Edge ratio used" 
appears in the upper left of the screen. 
The screen window can be checked. 
The "" mark indicates used edges and 
the "x" mark indicates unused edges. Set 
the value checking the screen. 
Default: 80 (%) 

3. Select "Execution Mode". 

Default: “Speed First”  
 

When selecting "Accuracy First", the inspection area is tilted to be at right angles to the detected 
approximate line after the detection, and the approximate line is detected again. Compared to "Speed 
First", detecting edges more accurately calculates an approximate line with less error. However, the 
inspection time in "Accuracy First" is longer than the one in "Speed First". 

Setting Base Angle  
Select a base angle from the following four types for detecting the angle of the approximate line. 

1. Select “Approximate Line Detect Condition” > "Base Angle". 

2. Select from “X Direction”, "Y Direction", “Rotation Adjustment Angle” or "Area". 

X Direction 
(Default): 
Outputs an angle 
regarding the position 
at three o'clock as 0 
degree. 

 

Y Direction: 
Outputs an angle 
regarding the 
position at six 
o'clock as 0 
degree. 

 

Rotation Adjustment 
Angle: 
Outputs an angle 
using Rotation 
adjustment angle as a 
base. 

 

Area: 
Set the position 
of the end point 
of the inspection 
area to 0 degree 
using the slanted 
angle of the 
inspection area 
as a base.  

 
 

- The bold line (blue) is the approximate line. 
- The above figures show the examples when Calibration function is not used or when Calibration 

Method is set to "X/Y Size"  and "Axis +" is set to "Right Bottom".. 
Changing the setting of Coordinate Axis may change the value of the detected angle. 
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Setting Judgement Condition 
Perform judgement for the following four conditions respectively. When all the conditions are met, the 
judgement result of the checker will be OK. 

 Measurement: Deviation, Measurement: Distance or Measurement: Width 

 Standard deviation (Standard deviation calculated from the result of measurement) 

 Linearity 

 Unused Edge Count 

Setting Denoising function 
 

About Denoising function 

Measurement values are calculated using the edges detected by 
each cell. However, if cells detect projections, concaves on the 
surface of the object or noises existing around it as edges, using 
this function enables those edges not to be used for calculating 
measurement values. This is "Denoising Function". 

Only the edges within a distance or standard deviation specified 
based on an approximate line are used for the calculation of 
measurement values. 

Figure 1 
 

 

Range of edge 
positions used for 
calculation 
measurement 
values 

 

About Unused Edge Count 

In Denoising function, edges excluded from edges to be used for 
calculation and cells which cannot detect edges are called 
"unused edge", and edges used for calculating measurement 
values are called "used edge". The number of each edge is 
displayed in the left of the screen together with the judgement 
result of checker. 

Approximate line 

 

1. Select “Judgement Limits” > "Denoising". 

2. Use either "Distance" or "Std. Devi." for 
performing "Denoising". 

Distance:  
Use the edges within the distance specified in 
"Denoising" based on an approximate line for 
the calculation of measurement values. 
(Area within the dotted line in Figure 1) 

 
Standard Deviation: 
Calculates the standard deviation from an 
approximate line and the edge coordinates 
detected by each cell, and uses the edges within 
the value calculated by the formula mentioned 
on the right. 
(Area within the dotted line in Figure 1) 

 

"Position of approximate line +/- Standard deviation * 
Denoising range" 
 

The "Standard deviation" used here is calculated based 
on each coordinate value of an approximate line. 

It is different from the "Standard Deviation" displayed on 
the screen (that is a criterion for judgement). 
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3. Set "Denoising Range". 

Set the denoising range checking the graph or the result of each cell (Cell Result). 
 

 
Refer to page 256 for details of Cell Result. 

 
The figure below shows an example that Denoising is not used. Multiple edges in the two areas are 
targeted for measurement. 

 
 

Using Denoising function displays lines above and below the approximate line which divides the range of 
unused edges from the range of used edges. 
Changing the value of the denoising range makes the space between the lines wider or narrower. 
Check the graph and make the setting to let the target edges in the range of unused edges. 

 
Setting the denoising range to a larger value expands "Used edge range". 

 
 

- The "x" mark (red) in the graph indicates the cell that detects no edge. Although it is displayed in the 
used edge range, it is counted as an unused edge. 

- The graph of "Deviation" is always displayed here regardless of the inspection mode. 

Setting Judgement Limits 

1. Select the table of 
maximum/minimum values 
in "Judgement Limits" 
setting window. 

2. Specify the maximum and 
minimum measurement 
values of deviation 
(distance/width). 

As the maximum and minimum 
measurement values are 
displayed at the bottom of the 
screen, make the setting 
checking it. 
In addition, red lines indicating 
the maximum and minimum 
values are displayed in the 
graph. Confirm them and set. 
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3. Specify the maximum and minimum values of standard deviation and linearity. 

As the current value of each condition is displayed at the bottom of the screen, make the setting checking 
it. 

4. Specify the maximum value for "Unused Edge Count". 

Default: 2998 
The current value of the unused edge count (test result) is displayed on the left of the screen. Confirm it 
and set. 

Running a Test and Confirming Result 
Confirm if the current settings perform an inspection properly. To observe the image or checker pattern easily, 
set “Window Transparency (SETUP menu)” to a larger value. (“Change Window Transparency (SETUP Menu)”, 
page 439 ) 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
 

Position adjustment and area size adjustment are also executed if they have been set. 

2. Check data of detected area list. 

Check the graph, data of approximate line, measurement data and judgement result to be displayed on the 
screen. 

 

Error messages when running a test 
If Smart Edge (Line) is not performed properly when running a test, error numbers and messages are displayed 
in the checker list. 

 
Error No. Message Cause 

0014 Calibration is wrong. When an error occurred in calibration under the condition 
that "Calibration" is "Available”. 

0040 The approximate line cannot 
be calculated. 

When the detected edge count is less than 2 

0041 Edge required for 
measurement cannot be 
detected. 

• When all edges are excluded with the denoising function 
• When there is no cell that two cells are detected in Width 

measurement mode 
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4.7.17 Color Window 

What is Color Window? 
Color window calculates the maximum, minimum, average and standard deviation values based on the gray 
values of R, G and B of every pixel in the inspection area on a color image captured by a color camera, and 
then judges as OK/NG using the values. 

Output Data 

Each max. value of R,G,B: 

Each min. value of R,G,B: 

Each average value of R,G,B: 

Each standard deviation of 
R,G,B: 

If the pixels of white (R,G,B) = (255,255,255) and black (R,G,B) = 
(0,0,0) exist in the inspection area, each maximum value of RGB is 255 
and minimum value is 0. 

Judgement results of each 
color: 

Outputs the following three types of judgement results for each color 
respectively. 

 Gray Value: If the gray value of each color is within the 
allowable range you have set, the object is judged as "OK", if it 
exceeds the allowable range, the object is judged as "NG". 

 Gray Average: If the gray average of each color is within the 
allowable range you have set, the object is judged as "OK", if 
it exceeds the allowable range, the object is judged as "NG". 

 Gray Standard Deviation: If the gray standard deviation of 
each color is within the allowable range you have set, the 
object is judged as "OK", if it exceeds the allowable range, 
the object is judged as "NG". 

Judgement: When judgements of R, G and B (Gray value, Gray average, Gray 
standard deviation) are all "OK", judgement of the checker will be "OK".  

Specifying Checker No. 

1. Select “Color Window” in "Checker Type". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Press the ENTER key to determine the checker No. 

The "Color Window" setting window is displayed. The 
color image is displayed on the screen window. 

 

Selecting a Camera 
Select a camera image to set “Color Window” checker. 

1. Select “Area Setting” in “Color Window” setting window. 

2. Select a camera No. in “Camera”. 

The image of the selected camera is displayed. Although a gray camera can be selected, the checker 
cannot be executed. Be sure to select a color camera, otherwise checker execution will result in an error. 
 

 
Select a displayed image type (Live/Memory) or magnification in “Image Menu” opened by pressing the F1 
key. 
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Setting Inspection Area 
Set an area to measure R, G and B values. 

1. Select “Area Setting” in “Color Window” setting window. 

2. Select "Area Setting". 

“Area Setting” window is displayed. 

3. Select a shape of inspection area from “Change Shape”. 

Select from Rectangle, Ellipse, Circle and Polygon. 

4. Select “Change” and draw an area. 

For details, refer to page 63 “Specifying an Inspection Area”. 

5. After drawing is completed, press the CANCEL key. 

Using Area Size Adjustment 

Area Size Adjustment is a function for inspecting variable-sized objects. The function adjusts an inspection 
area according to the size of the object detected with Area Size Adjustment checker. 

Refer to Chapter 4.9, page 282 about Area Size Adjustment and the setting procedure. 

When you want to exclude an area from inspection (Mask 
area) 

Up to 16 mask areas, where checker does no inspection, can be set in an inspection area. 
Select "Add Mask" in “Area Setting”, specify a shape, and draw an area. Refer to section of Setting a Mask 
Area (page 67) for details. 

Using Auto Area Setting / Auto Mask Area Setting 

Auto Area Setting and Auto Mask Area Setting are functions which enable to set areas used for 
inspections automatically. The shape of an object is automatically recognized, and the detected result is 
referred in each checker as an inspection area. Also, inspection areas automatically set can be referred as 
masks. For details of Auto Area Setting, Refer to “Using Auto Area Setting: page 286”.  

Setting Judgement Condition 
Perform judgement for the following three conditions on three color elements (R, G, B) respectively.  When 
judgements of all conditions are "OK", judgement of the checker will be "OK".  

 Gray Value: Judges using the maximum and minimum values of the target color element. 

 Gray 
Average: 

Judges using the average value of the target color element. 

 Gray 
Standard 
Deviation: 

Judges using the standard deviation of the target color element.  
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1. Select “Judgement Limits”. 

2. Set the maximum and minimum values of "R Gray", 
"R Gray Ave." and "R Gray Std. Devi.". 

As the maximum, minimum, average values and standard 
deviation of R are displayed at the bottom of the screen, 
make the setting checking them. A luminance graph 
showing the gray level distribution of R is also displayed 
at this time. 
 

 
The magnification of the vertical axis of luminance graph 
can be changed. Refer to page 131 on how to change it. 

 

 

3. Set the maximum and minimum values of "G Gray", "G Gray Ave." and "G Gray Std. Devi.". 

 

4. Set the maximum and minimum values of "B Gray", "B Gray Ave." and "B Gray Std. Devi.". 

 

5. After drawing is completed, press the CANCEL key. 

Running a Test and Confirming Result 
Set an area to measure R, G and B values. 

1. Press the TRIG key. 

When a live image is displayed on the screen, PV captures a new image first and runs a test. When a 
memory image is displayed, it runs a test using the current memory image without capturing any images. 

 
 

Position adjustment and area size adjustment are also executed if they have been set.  

2. Check data of the result list. 

Check the maximum, minimum, average values, standard deviation and judgement result to be 
displayed on the screen. 

 

Error messages when running a test 
If Color Window is not performed properly when running a test, error numbers and messages are displayed 
in the checker list. 

 
Error No. Message Cause 

0014 Calibration is wrong. When an error occurred in calibration under the condition 
that "Calibration" is "Available”. 

0080 The operation cannot be 
executed with the selected 
camera. 

The selected camera is a gray camera. 
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4.8 Adjusting Area Position (Position Adjustment) 

4.8.1 What Is Position Adjustment? 

If positions of checker areas are fixed, inspections cannot be executed properly when an object moved only a 
short distance. 

Position Adjustment allows inspecting properly even if an object is displaced, by detecting the current position 
of the object and reflecting its shift amount from the base position to checkers. 

You can set up to 1000 position adjustment checkers per type (when 10 blocks are used). 
 

  
 

PV200 has multiple types of position adjustments to detect the position and the rotation angle of an object. 
 

Position Adjustment (Horizontal/vertical shift amount) 

After each checker detected the position of the object, Position Adjustment calculates the misalignment 
between the object and the base position. To detect an object, select from the following seven types. 

 
Binary Edge / Gray Edge / Feature Extraction / Matching / Contour Matching / Smart Edge (Circle) / Smart 
Edge (Line) 

 

Position Rotation Adjustment (Horizontal/vertical position and angle shift amount) 

Position/Rotation Adjustment detects position (coordinates) and angle of an object using checkers and 
calculates the misalignment from the base position and rotating angle from the base angle. 

To detect an object, select from the following eight types. 
 

Feature Extraction (Principal axis angle) / Matching (360-dgree) / Contour Matching (360-dgree) / Feature 
Extraction (2 checkers) / Matching (2 checkers) / Contour Matching (2 checkers) / Smart Edge (Line) / 
Smart Edge (Circle) / Flaw Detection (2 checkers) 

 

Rotation Adjustment (rotated amount), Position Adjustment (horizontal/vertical shift amount) 

Rotation Adjustment detects the angle of an object using checkers and calculates the rotating angle from the 
base angle. 

To detect an object, select from the following six types. 
 

Binary Edge (Horizontal) / Binary Edge (Vertical) / Gray Edge (Horizontal) / Gray Edge (Vertical) / Smart 
Edge (Line) (Horizontal) / Smart Edge (Line) (Vertical) / Flaw Detection (Ellipse) 
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4.8.2 Position Adjustment Type 

Position Adjustment 

Binary Edge and Gray Edge 

These checkers detect in the same method of Binary Edge checker and Gray Edge checker. The X/Y 
coordinates of the detected edge is considered as a base position. 

They also have the Center detection function which decides a base position by calculating the middle of the 
detected two points both in horizontal and vertical directions. 

 

 
Only one direction either horizontal or vertical can be set. 

 

 

Center Detection 

 

Feature Extraction 

This checker detects the gravity center of an object in the same 
method of Feature Extraction checker. 

It considers the detected coordinates of the gravity center as a 
base position. 

 

Matching and Contour Matching 

These checkers detect an object in the same method of 
Smart Matching checker and Contour Matching checkers. 

The output point of the detected object will be considered as 
the base position. 

 

Smart Edge (Circle) 

This checker detects a virtual circle in the same method of "Detect 
Mode: Radius" for Smart Edge (Circle). 

The coordinate of the center of the detected virtual circle will be 
considered as the base position. 

If a whole circumference cannot be captured, or for a rounded angle, 
the position detection is possible. 
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Smart Edge (Line) 

This checker detects an object in the same method of Smart Edge 
(Line) 

When the horizontal base checker and vertical base checker are 
both set, the intersection point of two approximate lines will be 
considered as the base position. 

When only the horizontal base checker or vertical base checker is 
set, the intersection point of the approximate line and the line passes 
through the center of the inspection area will be considered as the 
base position. 

 

 

Position/Rotation Adjustment 

Feature Extraction (Principal Axis Angle) 

This checker detects the gravity center and the 
principal axis angle of an object in the same method of 
Feature Extraction checker. It considers the detected 
coordinates of the gravity center and the angle as a 
base position and base angle respectively. The range 
of a detected angle is +/- 90 degrees. 

 

Matching (360-degree) and Contour Matching(360-degree)  

These checkers detect the position of an object 
(output point coordinates) and the rotation angle in 
the same method of Smart Matching and Contour 
Matching checkers. It considers the detected 
coordinates and the angle as a base position and 
base angle respectively. 

 

 
Subtraction function of Matching checker is not 
available. 

 

Feature Extraction (2 checkers), Matching (2 checkers) and 
Contour Matching (2 checkers) 

It considers an angle which are formed by X axis and a line between 
two gravity centers detected by two Feature Extractions or between 
two output points detected by two Matchings (Smart Matchings or 
Contour Matchings) as a base angle. And also it considers the middle 
point of the line as a base position. 
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Smart Edge (Line) 

This checker detects an object in the same method of Smart 
Edge (Line) The intersection point of two approximate lines 
detected with two base checkers is considered as the base 
position, and the angle of the median on two approximate lines is 
considered as the base angle. 

 

Smart Edge (Circle) 

This checker detects a virtual circle in the same method 
of Smart Edge (Circle) 
The coordinate of the center of the detected virtual circle 
is considered as the base position, and the maximum 
angle or minimum angle is considered as the base angle. 

In case of "Detect Mode: Diameter", the angle range is 
+/-90 degrees. 

 

 

Flaw Detection (2 chokers) 

The middle point of each flaw position is regarded as a base position using tow Flaw Detection checkers 
(Ellipse). 

Example 1: The point connecting the middle point 
between D-cut points and the center of the circle is 
regarded as a base position, and this angle is 
regarded as a base angle. 

Example 2: The middle point between two flaw 
positions of each checker is regarded as a base 
position, and this angle is regarded as a base 
angle. 
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Rotation Adjustment 

Binary Edge (Horizontal) / Binary Edge (Vertical), 
Gray Edge (Horizontal) / Gray Edge (Vertical) 

These checkers detect two points in the same method of Binary Edge checker or Gray Edge checker, and 
calculates an object gradient. 

Binary Edge (Horizontal) and Gray Edge (Horizontal) scan horizontally to detect edges. Binary Edge (Vertical) 
and Gray Edge (Vertical) scan vertically to detect edges. 

These checkers can obtain a middle point of two points (center detection) other than edges of an object as a 
base position. 

 

 
Center Detection 
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Smart Edge (Line) (Horizontal), Smart Edge (Line) (Vertical) 

The angle of the approximate line detected in the same method of Smart Edge (Line) is considered as the base 
angle. The base coordinate is the intersection point of the line passing through the center of the inspection area 
and the approximate line. 

   

Flaw Detection (Ellipse) 

With Flaw Detection checker (Ellipse), the center in the setting area is regarded as a base coordinate, and the 
angle from the base coordinate to the detected position of a flaw is regarded as a base angle. 

 

Circle/Feature Rotation (Available from Ver.2.0) 

Rotation angle is obtained by arranging gray edges radially and comparing the number of detected edges 
of each cell to the number of detected edges of the base image. The center of the gray edges radially 
arranged is the base point. This is effective against a circular object (true circle), and the position detection 
is possible even when the whole circumference cannot be captured.  

 

 

Two detection modes are available for 
detecting edges. 

1. Detection mode similar to Gray 
Edge (Gray Edge) 

2. Detection mode which sets a 
luminance range and counting all 
pixels outside of the range (Count) 

For using the Circle/Feature Rotation 
checker, make the settings for following the 
position adjustment to correct the center 
point. 

For details of the setting method, refer to 
"Setting Procedure for Adjusting Positions 
Using Rotation Adjustment "Circle/Feature 
Rotation" on page 278. 
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4.8.3 Setting a Position Adjustment 

Selecting a number and a type of Position 
Adjustment 

1. Select “INSPECTION” > "Position Adj.". 

2. Select the checker No. list and specify a Position 
Adjustment checker number to set. 

3. Move the cursor onto a type of Position 
Adjustment to create. 

The list of detection methods available in the 
selected Position Adjustment is displayed. 

4. Tilt the ENTER key right and then up/down to 
select a detection method. 

The setting window of selected Position Adjustment 
is displayed. 

 
 

 

Selecting a Camera 
Select a camera image to set Position Adjustment. 

1. Select “Checker Settings" in “Pos. Adj.” setting 

window. 

2. Select a camera No. in “Camera”. 

The image of the selected camera is displayed.  

 
Select a displayed image type (Live/Memory and Gray/Color/Binary) or magnification in “Image Menu” 
opened by pressing the F1 key. 
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Creating a Base Checker 

1. Select "Base Setting" in “Checker Settings” 

setting window. 

Now, it is ready for base checker setting. 

2. Select a base checker to set. 

The setting window of selected base checker is 
displayed. 

3. Set necessary items. 

The setting procedure is the same as the other 
checkers. For more details, refer to the chapter of 
description of each checker. 

 
 

Some items displayed in checkers are not 
displayed in Position Adjustment. Nondisplayed 
items cannot be set in Position Adjustment. 

4. Press the TRIG key to execute a test. 

Only the currently setting base checker can be 
tested. Confirm a test result in the same way of 
normal checkers. 

 
 

 

About Priority 

The Priority function is effective if an object moves largely either vertically or horizontally. When the object 
moves largely in the horizontal direction, set to "Horizontal". When it moves largely in the vertical direction, set 
to "Vertical". 

Example) When setting to "Horizontal", this checker calculates a horizontal shift amount first using the 
horizontal base checker. And then, when executing the vertical base checker, it moves the area 
horizontally by the shift amount calculated with the horizontal base checker and calculates a v ertical shift 
amount at this position. (When setting to "Vertical", the procedure is the other way round.)  

 

Horizontal Case 
Setting Priority: No Priority: Horizontal 

 
 

Vertical Case 
Setting Priority: No Priority: Vertical 
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When adjusting position by detecting the center 

1. Select "Base Setting" in “Checker Settings” 

setting window. 

Now, it is ready for base checker setting. 
At this moment, “Detect Center” cannot be 
selected. 

2. Select base checkers to detect the center 
(Horizontal base checker 0 and Vertical base 
checker 2). 

The setting window of the selected base 
checker is displayed. 

3. Set an area and a condition for the base 
checker. 

 

4. Press the CANCEL key to go back to the 
condition setting window. 

Now, “Detect Center” of the set base checker 
can be selected. 

 
Example: When setting horizontal base checker 
No.0, “Detect Center of Base0, 1” will be 
activated. 

5. Select “Yes” for “Detect Center of Base 0, 
1”. 

In the Base Setting field, Checker1 (or 
Checker3) is created. 
The created base checker has the same area 
and conditions of the base checker set in the 
step 3. 

6. Select the created base checker. 

7. Move the area of the base checker and 
change the conditions as necessary. 

8. After setting is completed, press the 
CANCEL key. 

 
The procedure after this is the same as when 
detecting no center. 
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Deleting a Base Checker 

With Position Adjustment - Binary Edge/ Gray Edge/ Smart Edge (Line), adjusting only either of horizontally or 
vertically can be performed. To delete (restore to be unset) the horizontal base checker or vertical base checker 
that has been "Set", operate from the pop-up menu. 

1. Move the cursor onto the set base checker to 
delete. 

2. Press the FUNC key. 

The pop-up menu appears. 

3. Select "Delete". 

When the dialog message appears, select “Yes”. 
 

The selected base checker is deleted and “Status” field 

changes to “Unset”. 

 

Registering Base Position 
Register the current object position as a base position. 

 

 
 When the displayed image is a live image, Position Adjustment scans a newly captured image and the 

detected position and angle are registered as a base. When displaying a memory image, it scans the 
currently displayed image and the detected position and angle are registered as a base. 

 Displaying a message other than “Register a Base Position,” in the message display area indicates that 
the checker could not detect an object in a base checker test. Change the setting of a base checker with 
NG display in the judgement field. 

Position Adjustment - Binary Edge, Gray Edge, Smart Edge 
(Circle), Smart Edge (Line), Position Rotation Adjustment - 
Smart Edge (Line), Smart Edge (Circle) and Rotation 
Adjustment 

1. Select "Base Position". 

2. Select "Register". 

3. When the dialog message appears, 
select “Yes”. 

Correctly registering a base position 
displays values in the list of Adjustment 
Amount, Current Position, Base Position, 
and Base Checker. 

 
 

If a base position cannot be registered, 
return to the Condition setting window and 
reconsider the settings of the base checker 
judged as NG. 
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Position Adjustment - Feature Extraction, Matching and 
Pos/Rot Adjustment  
(Except Position Rotation Adjustment - Smart Edge (Line)) 

1. Select "Base Position". 

2. Select "Register". 

The window to select an object to use in Position 
Adjustment from the detected objects appears. 
Even if only one result is detected, this window is 
displayed. 

 
 

If nothing in the list, no object can be detected. 
Adjust the conditions. 

3. Select the list. 

4. Select a number of detect position to use 
Position Adjustment. 

Adjust the inspection condition and sorting 
order in the base checker menu so that the 
selected detection object always be the same 
number. 
The selected detection object is displayed in pink 
on the screen window. 

5. Press the Cancel key. 

6. Select "Base Position". 

7. When the dialog message appears, select 
“Yes”. 

Correctly registering a base position displays 
values in the list of Adjustment Amount, Current 
Position, Base Position, and Base Checker. 
 

 

 
 
 
 

 

 

Setting Procedure for Adjusting Positions Using Rotation 
Adjustment "Circle/Feature Rotation" (Available from Ver.2.0) 

1. Select "Rotation Adjustment" > "Circle/Feature Rot." in 
Position Adjustment screen. 

2. Select "Base Setting" > "Checker 0" in “Checker 

Settings” setting window. 

3. Set the area of the base checker. 

Set the gray edges radially. 
The resolution of rotation adjustment depends on the value of 
angle pitch (AP). When requiring high-accuracy rotation 
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adjustment, set AP small. 
For the procedure of setting the circular area, refer to the 
checker setting method of "Smart Edge (Circle)". 
The settings of the start and end angles are not available in 
the area setting of Circle/Feature Rotation Position 
Adjustment. 

 

4. Set the inspection conditions of the base checker. 

The following two detection modes are available for "Circle/Feature 
Rotation" position adjustment. 

Gray 
Edge 
(Default) 

Obtains the rotation angle by obtaining the 
number of detected edges of each cell and 
comparing it to the number of detected 
edges of the base image. 

Count Compares the gray average in cells to the 
parameters (Out of max. and min. ranges), 
and counts them as edges. 

 

 

 
 When a flaw or foreign object you want to detect is a line parallel to the cell, use "Count" as Detect 

Mode. 
In "Gray Edge" mode, edges may be hard to be detected as the scan direction is parallel to each cell. 

 

5. (Detect Mode: Gay Edge) 
Set each item of "Inspection Condition" and "Search 
Method". 

Set Scan Direction, Scan Method, Edge Condition, and 
Edge Threshold. For details of the setting items, refer to 
"4.7.8 Gray Edge" on page 164. 
 

 

6. (Detect Mode: "Count") 
Set "Out of max. range" and "Out of min. range". 

Set "Out of max. range" and "Out of min. range" of gray 
value. Set the maximum and minimum values to detect 
the target as edges. In Count mode, there is no Search 
Method setting. 
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7. After the detection of the base coordinate by a test 
execution, register the base position. 

Now you completed the setting. 

 

 

 

 
 As the center of the circle becomes the base point in Position Adjustment of Circle/Feature Rotation, 

make the settings for following another position adjustment which corrects the center point.  

 The numbers of detected edges are displayed in the order of 0 to 360 degrees by the graph on the 
inspection condition screen. (The position of three o'clock of the circle is 0 degree.) 

 



 

281 

S
etting Inspection C

onditions 
C

h. 4 

4.8.4 Applying Position Adjustment to Checkers 

Which Position Adjustment is applied to checkers must be determined because multiple Position Adjustments 
can be registered for a Type. To do so, select a Position Adjustment in Area Setting window of each checker. 

The procedure is an example of the case when using Position Adjustment checker for the source (of which 
adjustment amount is referred) and target (which refers to the adjustment mount) both. The procedure is the 
same when target checkers are other than Position Adjustment (Checkers, Area Size Adjustment). 

1. Select a target checker. 

(In this example, Position Adjustment 
(Gray Edge)) 

2. Select "Checker Settings". 

When target checker is other than position 
adjustment, select “Set” of “Area Setting”. 

3. Select "Position Adjustment". 

The list of Position Adjustments that have 
been set is displayed. 
As selecting a number with the cursor, the 
Position Adjustment area of the number is 
displayed in orange on the screen window. 
Observe it to select. 

4. Select a Position Adjustment No. to refer 
the adjustment amount. 

The selected type No. is displayed in the 
“Position Adjustment” field. 
To cancel applying a position adjustment, 
select “No” in the top of the list. 

 

 
 
 

 
 

 

 
* About selectable position adjustment 

 

When target checker is Position Adjustment 

The number of Position Adjustment checkers must be lower than the number of the currently setting Position 
Adjustment. 

If the currently setting Position Adjustment is No.9 with camera No.0, only the set Position Adjustment checkers 
of No.0 to 8 are displayed. 
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4.9 Adjusting Area Size (Area Size Adjustment) 
This function expands or contracts the inspection area or mask area to fit a variable-sized object. The function 
detects the part which signifies an object size, such as edges of the object or register marks, and expands or 
contracts a checker area based on the coordinates of the part. 

 

 
Area Size Adjustment is not available for some checkers. In the checkers which can use Area Size Adjustment, 
“Area Size Adj.” is displayed in the setting window of each checker. 

Available: Line, Binary Window, Gray Window, Binary Edge, Gray Edge, Feature Extraction, 
Flaw Detection, Connector (Binary Window), Connector (Gray Window), Smart Edge 
(Circle), Smart Edge (Line), Color Window 

Not available: Smart Matching, Contour Matching, Connector (Gray Edge), Position Adjustment, 
Area Size Adjustment 

In the Case of Diagonal Inspection Area 

When applying Area Size Adjustment on a diagonal inspection area, the function expands or contracts the area 
without changing the angle. 

 

Example 1: 
Line 

 
Example 2: 
Rectangle, 
circle, or 
polygon 
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Detecting a Object Size 

Binary Edge, Gray Edge, Feature Extraction, Smart Matching, Contour Matching, Smart Edge (Line) 
checkers and Auto Area Setting can be set to detect an object size in Area Size Adjustment.  

Example 1: 

 

Example 2: 

 

Example 3: 

 

Example 4: 

 

 
If Area Size Adjustment detects multiple parts, the coordinates of result No.0 is used to adjust the area. 

When there is a possible to detect multiple parts, sort them so that the desired part is always No.0. 

Creating a Area Size Adjustment Checker 
Although Area Size Adjustment provides No.0 to 999 per type (if the number of used block is 10), the setting 
limit is 1000 checkers combined with Position Adjustment. 
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1. Select “INSPECTION” > "Area Size Adj.". 

2. Select the checker No. list and specify a 
checker (Area Size Adjustment) number to set. 

3. Select a type of Area Size Adjustment to create. 

The setting window of the selected Area Size 
Adjustment is displayed. 

 
The procedure after here is the same as the checker of 
the type that you select to create an Area Size 
Adjustment. Refer to the following page for details. 
 Binary Edge: page160 

 Gray Edge: page 164 

 Feature Extraction: page 169. 

 Matching: page 176. 

 Contour Matching: page 193 

 Smart Edge (Line): page 250 

 Auto Area Setting: page 286 
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Using Area Size Adjustment for Checkers 
Multiple Area Size Adjustment checkers can be set. For performing auto adjustment of the area size of each 
checker, select an Area Size Adjustment checker to use its coordinates for the adjustment. 

 

 
After using Area Size Adjustment, the area frame (checker pattern) is displayed in the adjusted size. 

However, the positions of the start point (ST) and end point (ED) that are displayed by selecting “Area Setting” 
> “Change” are on the coordinates before the area size adjustment is made. 

1. Select a checker to adjust the size. 

2. Select "Area Setting". 

3. Select the table of "Area Size 
Adjustment". 

4. Select a point which you want to adjust, 
start point, end point, up, down, left or 
right. 

The list of Area Size Adjustments that 
have been set is displayed. 
As selecting a number with the cursor, the 
Area Size Adjustment area of the number 
is displayed in orange on the screen 
window. Observe it to select. 

5. Select an Area Size Adjustment 
checker. 

The screen returns to Area Setting of the 
checker and the selected number of Area 
Size Adjustment is displayed. 
 
Repeat the procedure and select Area 
Size Adjustment checkers as necessary. 
(You can also set just a single part such as 
only start point.) 

6. Specify the offset value as necessary. 

 
 

 
 

 
About Offset Value 
Offset Value is to create an area outside (side of larger area) or inside (side of smaller area) of the 
coordinates of an edge, a gravity center, or an output point detected by Area Size Adjustment checker. 
You can specify different values for each of up, down, left and right. 
 

Offset = 0 Offset = +1 to 128 Offset = -1 to -128 
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4.10 Using Auto Area Setting 
Auto Area Setting is a function that enables to set an area used for an inspection automatically with 
Feature Extraction checker. The shape of an object is automatically recognized, and the detected result is 
referred in each checker as an inspection area. Also, a mask area which meets an actual shape can be 
automatically set with this function. (Auto Mask Area Setting) 

 
Example of an object 

→ 

 

→ 

 
An inspection can be executed 

on the part excluding the 
number, 3, by referring the left 
checker as the inspection area 
and mask area with a checker. 

 
Checker No. 1:  

Auto area setting of perimeter  

→ 
 

→ 

  Checker No. 2:  
Auto area setting of number, 3 

  

 
Some checkers cannot refer to Auto Area Setting and Auto Mask Area Setting. In the usable checkers, “Auto 
Area Setting” and "Auto Mask Area Setting" are displayed in the setting window of each checker. 

 Checkers that can refer to Auto Area Setting 

Binary Window, Gray Window, Feature Extraction, Color Window 

 
For the method of referring the setting in checker, see page 291. 

4.10.1 Automatically Setting Area 

 
The procedures of Auto Area Setting and Auto Mask Area Setting are common. 

Specifying Checker No. 

1. Select “INSPECTION” > "Area Size 

Adj.". 

2. Select the Checker No. list and select 
"Auto Area Setting". 
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Setting Area and Inspection Condition 

 
The settings of Area Setting and Inspection Condition are the same as the settings of Feature Extraction 
checker. For further information, refer to the section of Feature Extraction checker. (Page 169)  

1. Select a camera in "Area 
Setting". 

2. Set Grayscale Preprocess and 
Slice Level in "Inspection 
Condition". 

3. Set the range in "Area Setting". 

4. Select a target color and filter in 
"Inspection Condition". 

5. Set "Sorting". 

 

Area Setting window: 

 
Inspection Condition window: 

 

Setting Search Method 

1. Select “Search Method". 

2. Set the following items as 
necessary. 

- Labeling 
- Boundary 
- Projection Width, Height 
- Fill Holes 
- Drawing Pattern of Result 
- Area Offset Unit 
- Offset 

 

 

 
 The settings of Labeling, Boundary, Proje. Width, Height, Fill Holes, and Drawing Pattern of Result 

are the same as the settings of Feature Extraction checker. For further information, refer to the 
section of Feature Extraction checker. (Page 169) For details of the setting for Offset, see "Setting 
Offset" (page 288).   

 With Auto Area Setting function, "Perimeter" and "Principal Axis Angle" cannot be detected. 
 When "Labeling" is set to "No", "Boundary", "Proj. Width, Height", "Fill Holes", and "Drawing Pattern of 

Result" cannot be detected. 
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Setting Offset 
It is set to create an area outward or inward from the center of gravity coordinate detec ted by Auto Area 
Setting checker. Setting larger offsets expands the area outward, and setting smaller offsets decreases 
the area inward. 

 
Example: When setting Offset area B for the outer frame A of a cylindrical object 

 

1. Select "Area Offset Unit". 

2. Select "Ratio" or "Pixel" as 
offset unit. 

 

 
 

3. Set "Offset". 

 

 

4. Press the TRIG key and 
check the result that offset 
is applied. 
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Offset Unit 

Offset 
Unit Ratio Pixel 

Setting 
range 

1 to 200 
Default: 100 (No offset) 

-1024 to 1024 
Default: 0 (No offset) 

Usage Specify when you want to set an offset area 
at a desired position. 

Specify when you know the number of pixels to be 
offset.  

  
Offset can be used only when the shape of an object is simple such as a circle or rectangle.  If setting 
Offset for a intricately-shaped object, an accurate expanded or decreased area cannot be set because 
the distances from the center of gravity coordinate are not equable.  

Example of OK Example of NG 

Simple Shape 
(such as a circle or rectangle) Intricate shape 

(such as characters or a polygon) 
 Offsets can be registered in Data R/W. (Area Offset Unit cannot be registered.) 

Setting Extraction Condition 

 
The settings of Projection Width and Projection Height are the same as the settings of Feature Extraction 
checker.  For further information, refer to the section of Feature Extraction checker. (Page 169)   

1. Select “Extraction Condition”. 

2. Set the range of area, projection 
width, and projection height of 
objects to be detected. 

When using no conditions, changing 
these is not necessary. 
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Running a Test and Confirming Result 
Confirm if an area is automatically set properly with the current settings.  To observe the image easily, set 
“Window Transparency (SETUP menu)” to a larger value. (“Change Window Transparency (SETUP 
Menu)”, page 439) 

1. Press the TRIG key. 

2. Confirm the automatically-set area 
and detected result. 

 

 
 

 

 
 As the setting for "Output: Objects 1 - x" is not available in Inspection Condition of Auto Area 

Setting, the number of objects is always 1. 
If there are a number of objects in the inspection area and "Labeling" is set to "Yes", only the result 
of Result No. 0 is displayed according to Sorting Order. If a target object is not detected, review the 
setting of Sorting Order or other settings 

 When a number of objects exist in the inspection area, the number of coordinates in the area may 
exceed the limit and the objects may not be detected properly. 

 

 
Example: When a lot of objects exist in the 
inspection area and the bottom part cannot be 
detected. 
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To set a part of an object as an inspection area 

Auto Area Setting is also effective when you want to set an part of an object as an inspection area.  
Pinpointing an inspection area reduces waste of time taken for the inspection of unnecessary area. 

1. Set a range over the part that you 
want to treat as a target area in 
"Area Setting". 

2. Set "Boundary” in "Inspection 

Condition" to “Valid". 

When "Boundary" is set to "Invalid", 
the area cannot detected as an 
inspection area. 

3. Press the TRIG key and confirm 
the detected result. 

When "Boundary" is set to "Invalid", 
the area cannot detected as an 
inspection area. 

 

 

4.10.2 Referring Auto Area Setting by Checkers 

 
Checkers that can refer to Auto Area Setting are as follows.  

- Binary Window, Gray Window, Feature Extraction, Color Window 

1. Select a checker in which Area 
Setting is made, and press 
"Auto Area Setting". 

 

 

2. Select an appropriate number 
from the list of "Auto Area 
Setting". 

 

Register Auto Area Setting in 
advance from "INSPECTION" > 
"Area Size Adj.". Otherwise, Auto 
Area Setting cannot be referred. 
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3. The Pattern display of the 
automatically-set area appears. 

 

 
 

 

 
 Auto Area Setting does not follow the position adjustment referred by checkers. To follow the position 

adjustment, set "Position Adj." in the setting window of Auto Area Setting. 

 If Auto Area Setting is referred by each checker, the area setting cannot be specified manually. (Auto 
Mask Area Setting can be referred.) 

 The field of the normal area size adjustment setting is grayed out and unavailable when using Auto Area 
Setting. 
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4.10.3 Referring Auto Set Area as Mask 

A mask can be automatically set with the Auto Area Setting function. More detailed mask area can be set 
rather than specifying an area with a rectangle or a circle by setting a mask area automatically with this 
function. 

 
Checkers that can refer to Auto Area Setting as a mask are as follows. 

- Binary Window, Gray Window, Feature Extraction, Color Window 

Example: To set a letter in an object as a mask area 

 

Set the number "3" in the right figure as a mask area. The other areas will be 
checked if there are defects.  

Make two Auto Area Settings in advance.  

1. Whole area of the object (Checker No. 000)  

2. Area surrounding the number "3" (Checker No. 001)  

1. Select a checker in which Area 
Setting is made, click "Auto 
Area Setting", and select a 
checker number corresponding 
to the whole area of the object. 

(Checker No. 000) 

 

Register Auto Area Setting in 
advance from "INSPECTION" > 
"Area Size Adj.". Otherwise, the 
area cannot be referred. 

2. Press "Auto Mask Area 
Setting", and select an 
appropriate checker number for 
the mask area. 

Register the area of the number 
"3". (Checker No. 001) 

 

 

3. The pattern display of the area 
excluding the mask area that 
has been automatically set 
appears. 

The inspection is performed on 
the area excluding the number "3". 

 

 

 
 Even if area settings have been made manually in each checker, Auto Mask Area Setting can be 

referred. 

 The mask of Auto Area Setting does not follow the position adjustment refer red by checkers. To 
follow the position adjustment, set "Position Adj." in the setting window of Auto Area Setting.  

 Besides the mask automatically set, a mask can be added to the "Area Setting" menu manually.  The 
mask manually added follows the position adjustment of checkers. 
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4.11 Geometry Calculation of Detected Data 

4.11.1 What is Geometry Calculation? 

Geometry Calculation is a function that calculates the distance between two points, intersection point of 
two lines and median using the data detected with each checker. With this function, only specifying the result 
detected by a checker enables to execute calculation without setting any operation expression. 

Inspection examples 

   
Measurement of C-cut size Measurement of distance between 

D-cut point and center 
Measurement of approximate 
circle with multiple points 

 The figures drawn in the image examples in this chapter includes the images drawn with the 
"Character/Figure Drawing" function. 

Types of Geometry Calculation 
The following seven types of geometry calculations are available. 

 
Type of calculation  Output Data 
Distance 
Point-Point 

 

Detects the distance 
between two points , the line 
connecting two points and its 
median. 

• Distance between two points 
• Coordinate X and Y of median 
• Line angle 
• Line element (a, b, c) 

Intersecting 
Point 

 

Detects the intersecting point 
and the angle of two lines 

• Coordinate X and Y of Intersecting point 
• Intersecting angle of two lines 

Median  

 

Detects the intersecting 
angle of two lines and the 
median (bisector) of the 
angle. 

• Intersecting angle of two lines 
• Median angle 
• Median element (a, b, c) 

Distance 
Point-Line 

 

Detects the intersecting point 
of a perpendicular to a line 
through a point, and the 
length of the perpendicular. 

• Pedal X and Y 
• Length of perpendicular (Distance between 

point and line) 
• Perpendicular angle 
• Perpendicular element (a, b, c) 

Approximate 
Line  

 

Detects the approximate line 
from multiple coordinate 
values. 

• Approximate line angle 
• Approximate line element (a, b, c) 
• Standard deviation 

Approximate 
Circle 

 

Detects the approximate 
circle from multiple 
coordinate values. 

• Center X and Y of approximate circle 
• Radius of approximate circle 
• Standard deviation 

Approximate 
Ellipse 

 

Detects the approximate 
ellipse from multiple 
coordinate values. 

• Center X and Y of approximate ellipse 
• Major and minor axes of approximate 

circle 
• Angle of approximate circle (Major axis 

gradient) 
• Standard deviation 
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Circle - Line 
 
 
 

 

Detects the points where a 
circle (circle / ellipse) 
intersects with a line. 

• Intersection points of circle and line (2 
points) 

• Distance between two intersection points 
• Line angle between the median of two 

inersection points and the center of circle 
• Line element (a, b, c) 

4.11.2 Setting a Geometry Calculation 

Selecting a Checker No. and a Type of Detect Mode 

1. Select “INSPECTION” > "Geometry Calc.". 

2. Select the checker No. list and specify a checker 
number to set. 

3. Move the cursor onto a type of Geometry 
Calculation to create. 

The setting window of the selected type is displayed.  

Selecting a Camera 
Select a camera image to set “Geometry Calculation”. 

1. Select a camera No. in “Camera” in the setting 

window of "Geometry Calculation". 

The image of the selected camera is displayed.  

 
Select a displayed image type (Live/Memory and Gray/Color/Binary) or magnification in “Image Menu” 

opened by pressing the F1 key. 

Setting a Reference 
Specify the created checker to detect "Point", "Line" or "Circle" which are necessary for Geometry 
Calculation. 

1. Select "Reference". 

The items such as points or lines which are required for the selected 
type of Geometry Calculation are listed. 
Items to be specified vary depending on geometry calculations. 
Refer to the next page for how to set an area. 

Detect mode Input item  
Distance Point-Point Point 0, Point 1  
Intersecting Point Line 0, Line 1  
Median of Two Lines   
Distance Point-Line Point 0, Line 1  
Approximate Line Point 0 to Point 9 

or  
All points 

2 points or more 
Approximate Circle 3 points or more 
Approximate Ellipse 6 points or more 
Circle – Line Circle 0, Line 1  
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 Only the checkers set with the same camera can be referred. 

However, when Calibration is set for both two cameras, a checker set for either one camera can be 
referred by the other as the both cameras operate using global coordinates.  

 The procedure for setting "Distance Point-Line" is the same as those for setting "Point" in "Distance 
Point-Point" and "Line" in "Intersecting Point". 

 
 

For Distance Point - Point 
 

In this section, for the object detected in Feature Extraction No.0, 
enter the detected zeroth coordinate in Point 0, and enter the 
detected first coordinate in Point 1. 

In Feature Extraction, it has been set to sort the objects in 
descending order of area and detect the circle of the largest area 
zerothly.  

1. Select No.0: Point from the list. 

The list of checkers which can be input is displayed. 
Unset checkers are shown in gray and cannot be selected. 
For details of selectable checkers, see page 300.  

 

 

2. Select “FEC: Feature Extraction” from the list. 

The list of Feature Extraction checkers is displayed. 

3. Select Checker No. 000. 

The list of result types is displayed. 

4. Select "Center of Gravity Coord." and specify Result No. 
0000. 

The selected data is displayed in a symbol for No.0: Point in the 
list. 

5. Set the second point (No.1: Point) in the same steps. 
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For Intersecting Point  

 

"Intersecting Point" is used to calculate the intersecting point 
using the lines detected by Smart Edge (Line) and Geometry 
Calculation. 

When using the lines detected by Geometry Calculation, only 
smaller numbers than the number of the currently setting 
Geometry Calculation can be specified. 

 

 
The procedure for setting "Reference" of Median of Two Lines 
is the same as the one for Intersecting Point. 

 

The following is an example when setting Smart Edge (Line) to 
No. 0 and Geometry Calculation to No. 1. 

1. Select No.0: Line from the list. 

The list of checkers which can be input is displayed. 
If there is no checker that can be specified, checkers are 
shown in gray and cannot be selected. 
For details of selectable checkers, see page 300. 

 
 

 

2. Select “SEL: Smart Edge (Line)” from the list. 

The list of result types is displayed. 

3. Select "Line0 Element" or "Line1 Element". 

The selected data is displayed in a symbol for No.0: Line 
in the list. 

4. Select No.1: Line. 

5. Select “GGC: Geometry Calculation” from the list. 

The list of the geometry calculations set to the numbers 
smaller than the number of the currently setting checker is 
displayed. 

6. Select the geometry calculation you want to use. 

Geometry calculations to calculate lines are the following 
4 types. 
- Distance Point - Point 
- Median of Two Lines 
- Distance Point-Line 
- Approximate Line 
- Circle - Line 

When selecting a geometry calculation other than the 
above, the intersecting point of two lines cannot be 
calculated. 
When selecting Geometry Calculation No., the type is 
displayed in the message field below the list. Check it. 
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For Approximate Circle 

Selecting "All Points" enables to set multiple points detected by one 
checker in block. 

In this section, enter all the coordinate positions of the object detected by 
Smart Edge (Line) in the point 0. 

 

 
The procedures for setting "Reference" of Approximate Line and 
Approximate Ellipse  are the same as that of Approximate Circle.  

1. Select No.0: Point from the list, and select "All 
Points". 

The list of checkers which can be input is displayed. 
For details of selectable checkers, see page 300. 
Unset checkers are shown in gray and cannot be 
selected. 

 
 

The procedure for setting "Reference" when selecting 
"Point" is the same as that of Distance Point - Point. 

2. Select “SEL: Smart Edge (Line)” from the list. 

The list of Smart Edge (Line) checker is displayed. 

3. Select Checker No. 000. 

The list of result types is displayed. 

4. Select "Cell Individual Result0". 

The selected data is displayed in a symbol for No.0 in 
the list. 

 
Set as necessary after No.1. 
"All Points" and "Point" can be mixed (e.g. set No.0 to 
"All Points" and set No.1 to "Point"). 

 

 

  

 

 

 
When points which cannot be detected by the specified "Target" checker for some reason as below exist, the 
approximate circle, approximate ellipse and approximate line will be calculated with the coordinate values of 
the detected points only. 

- When the specified checker did not detect edges or objects 
- When the cell individual result of the specified Smart Edge (Circle) or Smart Edge (Line) was 

excluded by the denoising function. 

However, the calculation cannot be executed when the number of detected points is less than each minimum 
number of points for Approximate Circle, Approximate Ellipse and Approximate Line. 
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For Circle - Line (How to set a circle) 

"Circle - Line" is used to calculate the intersection point based on a 
circle and line detected by checkers or geometry calculation.  

As reference data, a circle detected by Smart Edge (Circle) or 
Geometry Calculation (Approximate Circle / Approximate Line) and 
a line detected by Smart Edge (Line) or Geometry Calculation is 
specified. 
 

When using the lines detected by Geometry Calculation, only 
smaller numbers than the number of the currently setting Geometry 
Calculation can be specified. 
 

 

The following is an example when setting Smart Edge (Circle) for a 
circle and Geometry Calculation for a line. 

1. Select Circle from the list. 

The list of checkers which can be input is displayed. 
If there is no checker that can be specified, checkers are shown in 
gray and cannot be selected. 
For details of selectable checkers and geometry calculations, see 
page 300. 

 
 

 

 

2. Select “SEC: Smart Edge (Circle)” from the list. 

The list of result types is displayed. 

3. Select "Circle0 Element" or "Circle1 Element". 

The selected data is displayed in a symbol for No.0: Circle in the 
list. 
In the example on the right, SEC000_C0 (Smart Edge (Circle) 
No.000_Circle0 Element) 
 

4. Select No.1: Line. 

5. Select “GGC: Geometry Calculation” from the list. 

The list of the geometry calculations set to the numbers smaller 
than the number of the currently setting checker is displayed. 

6. Select the geometry calculation you want to use. 

Geometry calculations to calculate lines are the following four 
types. 
- Distance Point - Point 
- Median of Two Lines 
- Distance Point - Line 
- Approximate Line 
- Circle - Line 

When selecting a geometry calculation other than the above, the 
intersection point of two lines cannot be calculated. 
When selecting Geometry Calculation No., the type is displayed in 
the message field below the list. Check it. 
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List of Settable Items for Each Object 
  Point  All Points  Line  Circle 

PAC: Position Adjustment  Yes 
Base Position Coord. 
Detect Position Coord. 
Base Coord. (Detect 
Coord. of Base 
Checker) 

 ×  ×  × 

AUC: Area Size Adjustment  Yes  ×  ×  × 
BEC: Binary Edge  Yes  Yes  ×  × 
GEC: Gray Edge  Yes  Yes  ×  × 
FEC: Feature Extraction  Yes 

Center of Gravity 
Coord. 
Circumscribing 
Rectangle Coord. 
(Upper left, Upper right, 
Lower left, Lower right) 

 Yes 
(Center of Gravity 
Coord.) 

 ×  × 

SMC: Smart Matching  Yes  Yes  ×  × 
CMC: Contour Matching  Yes  ×  ×  × 
FWC: Flaw Detection  Yes  Yes  ×  × 
CGE: Connector (Gray 
Edge) 

 Yes 
Area 0 
Area 1 (*a 

 Yes  ×  × 

SEC: Smart Edge (Circle)  Yes 
Center Coord. 0 
Center Coord. 1 (*b 
Cell Individual Result 0 
Cell Individual Result 1 
(*c 

 Yes 
Cell Individual 
Result 0 
Cell Individual 
Result 1 (*c 

 ×  Yes 
Cell Individual 
Result 0 
Cell Individual 
Result 1 (*c 

SEL: Smart Edge (Line)  Yes 
Max. Measurement 
Coord. 
Min. Measurement 
Coord. 
Line0 Start Coord. 
Line0 End Coord. 
Line1 Start Coord. (*b 
Line1 End Coord. (*b 
Cell Individual Result 0 
Cell Individual Result 1 
(*b 

 Yes 
Cell Individual 
Result 0 
Cell Individual 
Result 1 (*b 

 Yes 
Line0 Element 
Line1 Element 
(*b 

 × 

GGC: Geometry Calculation  Yes (*d  ×  Yes (*d (*e  Yes (*d (*f 

ABP: Arbitrary Point(*g  ○  ×  ×  × 
ABL: Arbitrary Line (*g  ×  ×  ○  × 

*a) When selecting "Gap", "Float" or "Width Measurement" in Execution Mode 
*b) When selecting "Measure Width" in Detect Mode 
*c) When selecting "Measure Width" or "Measure Diameter" in Detect Mode 
*d) Available only for the geometry calculations of the smaller numbers than the currently setting geometry 
calculation  
*e) Normally operation can be performed only with the following types which calculate line elements (abc): 
Distance Point - Point / Median of Tow Lines / Distance Point - Line / Approximate Line / Circle – Line 
*f) Normally operation can be performed only with the following types which calculate circle: Approximate 
Circle / Approximate Ellipse / Distance Point - Line / Approximate Line 
*g) Available from PV200 Ver1.9 

 
 The checker with a camera number different from that selected for the setting geometry calculation 

cannot be specified. 

 Arbitrary Point (ABP) and Arbitrary Line (ABL) are registerable up to 10 figures per product type / per 
camera. 

- Camera0：Checker Number of Arbitrary Point(Line) : No.000～009  
- Camera1：Checker Number of Arbitrary Point(Line) : No.010～019 
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Setting Measurement Condition 
 

Measurement conditions vary depending on the type of geometry calculation. 
 

Detect mode Measurement 
condition 

 

Distance Point-Point Line Display: Segment / Half line0 / Half line1 / Wall-to-wall 

 Angle Range: 0<->360 / -180<->180 

 Direction: ST -> ED / ED -> ST / Down / Left / Up / Right 
Intersecting Point Intersecting Angle: Acute Angle / CW / CCW 

Median of Two Lines Angle Range: 0<->360 / -180<-> 180 

 Direction: Vector Sum / Down / Left / Up / Right 

 Intersecting Angle: Acute Angle / CW / CCW 

Distance Point-Line Line Display: Segment / Half line0 / Half line1 / Wall-to-wall 

 Angle Range: 0<->360 / -180<-> 180 

 Direction: OT0 -> IP / IP -> PT0 / Down / Left / Up / Right 

Approximate Line Angle Range: 0<->360 / -180<-> 180 

 Direction: Down / Left / Up / Right 

Approximate Circle None  

Approximate Ellipse Angle Range: 0<->360 / -180<-> 180 

 Direction: Down / Left / Up / Right 

Circle – Line Line Display Segment / Half line0 / Half line1 / Wall-to-wall 

 Angle Range: 0<->360 / -180<-> 180 

 Direction: Center -> Middle / Middle -> Center / Down / 
Left / Up / Right 

 

About Measurement Conditions 
 

Line Display 

Select the display method of the detected line. 
The following figures show the examples of "Distance Point-Point". The large circle is the start point (Reference 
No. 0) and the small circle is the end point (Reference No. 1). 

 
Segment Half line 0 Half line 1 Wall-to-wall 

Draw between No.0 and 
No.1 

Draw between No.0 and 
the edge of the screen 

Draw between No.1 and 
the edge of the screen 

Draw between the both 
edges of the screen 

 
 
 

Angle Range 

Specify 0 to 360 degree or -180 to 180 degree to output the angle data to be detected. 
The position at three o'clock is 0 degree. 

 
0 <-> 360 -180 <-> 180 
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The above figures show the examples when Calibration function is not used or when Calibration Method is set 
to "X/Y Size" and "Axis +" is set to "Right Bottom". 

Changing the setting of Coordinate Axis may change the position of 0 degree or the value of the detected 
angle. 

 

Direction 

Detected angles vary depending on the specified direction and the setting value of "Angle Range". 
 

Example) For Distance Point - Point 
Direction Appearance of Direction Angle Range and Detect Angle 

  Angle Range: 0<->360 Angle Range: -180<->180 

ST -> ED 

 

Range: 0 - 359.999 
Result: 160 

 

Range: -179.999 - 180 
Result: 160 

 

ED -> ST 

 

Range: 0 - 359.999 
Result: 340 

 

Range: -179.999 - 180 
Result: -20 

 

Down 

 

Range: 0 - 179.999 
Result: 160 

 

Range: 0 - 179.999 
Result: 160 

 

Left 

 

Range: 90 - 269.999 
Result: 160 

 

Range: 90 - 180, 
-90.001 - -179.999 

Result: 160 

 

Up 

 

Range: 180 - 359.999 
Result: 340 

 

Range: 0 - -179.999 
Result: -20 

 

Right 

 

Range: 0 - 89.999, 270 - 359.999 
Result: 340 

 

Range: 0 - 89.999 and  
-0.001 - -90 
Result: -20 
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Example) When Median of Two Lines - Direction = Vector Sum 
 Angle Range 
 Angle Range: 0<->360 Angle Range: -180<->180 
Two lines are headed in the 
same direction. 

 

  

Two lines are headed in 
different directions. Example 1 

 

  

Two lines are headed in 
different directions. Example 2 

 

  

 
 In case of Median of Two Lines, the direction of measure median varies depending on the direction of 

two lines. 

 The concepts of Down, Left, Up and Right for Median of Two Lines are the same as those for Distance 
Point - Point. 

 About Direction of Lines 
The direction of the line detected by Smart Edge (Line) is that of the Start point (ST) -> End point (ED) 
of the area setting. 
The direction of the line detected by Approximate Line of Geometry Calculation is as set in "Direction". 
The intersection points 0 and 1 detected by Circle - Line in Geometry Calculation; The point closer to 
the start point of a specified line is intersection point 0, and the other is intersection point 1. 
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Intersecting Angle  

Specify one of the three methods to detect the angle between two intersecting lines. 
 

Line specified in Reference No.0 Line specified in Reference No.1  

  

 

 
Acute Angle CW CCW 

   
 In case of CW or CCW, the start position is the line specified in Reference 

No.0. 
 

When the direction of a line changes, the detected angular positions differ between CW and CCW. 
The following is the case that the direction of line in Reference No.1 is reversed. 
Acute Angle CW CCW 

   

 
The intersecting angle and median is output as below when two lines are not intersected. 
 When two lines are headed in the same 

direction 
When two lines are headed in different 
directions 

Intersecting Angle Error(E0072) Error(E0072) 

Median It is calculated with the same direction and 
angle as the two lines. 

A line passing through the center of the 
image is calculated, which is the angle of 
Line No.0 + 90 degrees. 
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Setting Judgement Condition 
Measurement conditions vary depending on the type of geometry calculation. 

Detect mode Judgement limits Input range 

Distance Point-Point Median X, Median Y -99999999.999 to 99999999.999 

 Distance 0 to 99999999.999 

 Line Angle 0 to 359.999(When Angle Range is 0<->360) 
-179.999 to 180.000 (When Angle Range is -180<->180) 

Intersecting Point IP X, IP Y -99999999.999 to 99999999.999 

 Angle 0 to 359.999 

Median of Two Lines Angle 0 to 359.999 

 Line Angle 0 to 359.999 (When Angle Range is 0<->360) 
-179.999 to 180.000 (When Angle Range is -180<->180) 

Distance Point-Line Pedal X, Pedal Y -99999999.999 to 99999999.999 

 Distance 0 to 99999999.999 

 Pedal Angle 0 to 359.999 (When Angle Range is 0<->360) 
-179.999 to 180.000 (When Angle Range is -180<->180) 

Approximate Line Line Angle 0 to 359.999 (When Angle Range is 0<->360) 
-179.999 to 180.000 (When Angle Range is -180<->180) 

 Standard Deviation 0 to 99999999.999 

Approximate Circle Center X, Center Y -99999999.999 to 99999999.999 

 Radius 0 to 99999999.999 

 Standard Deviation 0 to 99999999.999 

Approximate Ellipse Center X, Center Y -99999999.999 to 99999999.999 

 Major Axis 0 to 99999999.999 

 Minor Axis 0 to 99999999.999 

 Major Axis Gradient 0 to 359.999 (When Angle Range is 0<->360) 
-179.999 to 180.000 (When Angle Range is -180<->180) 

 Standard Deviation 0 to 99999999.999 

Circle - Line Distance 0 to 99999999.999 

 Angle 0 to 359.999 (When Angle Range is 0<->360) 
-179.999 to 180.000 (When Angle Range is -180<->180) 

 

Maximum and Minimum Values of Line Angle 

As for Line Angle, the maximum value can be set to a smaller value than the minimum value (Max. value < Min. 
value). Set the values checking the guide display. 

In the example on the right, it will be judged 
as OK if the detected angle is in the range of 
"290 to 70 degrees". 

  

In the example on the right, it will be judged 
as OK if the detected angle is in the range of 
"110 to -110 degrees". 

  

Intersection Point of Circle and Line 

The intersection point detected by Circle - Line specified in 
Reference which is closer to the start point of a specified line is 
intersection point 0, and the other is intersection point 1. 
When a circle is tangent to a line, the same value is output for the 
coordinates of intersection points 0 and 1. In this case, the distance 
is 0, and the middle point is the same coordinate as intersecting 
point 0. 

When the line across two intersection points passes through the 
center of a circle, "-360" is output as the result of "Angle".  
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Error Messages when performing Geometry 
Calculation 

If Geometry Calculation is not performed properly, error numbers and messages are displayed in the checker 
list. 

 
Error No. Message Cause 

0014 Calibration is wrong. When an error occurred in calibration under the condition that 
"Calibration" is "Available". 

0070 Unset item found. When a checker to be used is not specified. 

0071 No ref. checker result. When the specified checker did not detect edges, objects, lines 
or circles. 

Error No. Message Type Cause 

0072 Could not normally calculate. Distance 
Point-Point 

When two points are in the same position 

Intersecting 
Point 

• When two lines are parallel and not 
intersected 

• When the intersection point is out of the range 
of +/-9999(*) 

Approximate 
Line 

• When the input point is less than 2 
• When all the input points are in the same 

position 
Approximate 
Circle 

• When the input point is less than 3 
• When the input points are located on a line 
• When the center of the approximate circle is 

out of the range of +/-9999(*) 
Approximate 
Ellipse 

• When the input point is less than 6 
• When the input points are located on a line 
• When the center of the approximate ellipse is 

out of the range of +/-9999(*) 
• When the ellipse cannot be calculated (due to 

the positions of the input points) 
Circle – Line • When the circle and line are not intersected 

*) Values in pixels before calibration. 
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4.12 Calculation of Detected Data (Numerical Calculation)  
This function calculates using the data detected by checkers and outputs the data to the external devices. Up to 
1000 expressions (when 10 blocks are used) can be set for each product type. 

 
 PV200 can handle the values from -2147483648.000 to + 2147483647.000, which are -(231) to (231-1), 

during calculation. When a calculating value exceeds the range, it is considered as an error (ER) and an 
error signal (ERROR0) is output. In that case, the calculation result is output as “0”. 

 The setting limit is the maximum of 1000 expressions per product type combined with expressions of 
Numerical Calculation. (After creating 1000 expressions of Numerical Calculation, you cannot create a 
judgement expression any more.) 

 In Connector (Binary Window), Connector (Gray Window), and Connector (Gray Edge), you can register 
some types of data into a Data R/W sheet from the setting windows. Refer to the description of each 
checker for details. 

 When the judgement of the numerical calculation registered in a numerical expression is error (ER), it is 
referred as “0” in the calculated result. 
 
Example) When CA000 is error 

No.  Expression Result 
CA001 = CA000 0 
CA002 = CA000 + 500 500 

4.12.1 Setting a Calculation 

Creating a Calculation 

1. Select "INSPECTION” > “Num. Calcu.” from 

the menu bar. 

“Numerical Calculation” list is displayed. 
Next to the calculation number, the beginning 
part of an expression is displayed. 
Tilting the ENTER key right in the list to display 
the next page shows 63 characters of 
expression and comment. 

2. Select a numerical calculation list and a 
number to set. 

The screen of numerical calculation setting is 
displayed. 
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3. Select the numerical calculation input field and press the ENTER key again. 

The list of items that can be registered in a calculation is displayed. 
 

Checker: Select this to enter the inspection data or the statistics data of checkers 
including position adjustment and area size adjustment. 

Geometry Calculation: Select this to enter the result of geometry calculation or the statistics data of 
them. 

Numerical Calculation: Select this to enter the result of numerical calculation or the statistics data of 
them. 

Judgement: Select this to enter the result of judgement or the statistics data of them. 

Constant: Select this to enter a fixed value. Values that can be input are +/- 
9999999.999. 

System Register: Select this to enter the System Registers No.0 to 7 specified in the 
environment setting. 

Scan Count: Select this to enter the scan count after startup or type switching. 

Operators and Functions: Select this to enter an operator or a function. Refer to the section of 
Operators and Functions, page 321 for details. 

 
 

Scan Count is reset to “0” by turning on the power, switching type, and resetting statistics data. 
Judgement is executed after numerical calculation, so the value that can be referred is the previous value.  

4. Enter an operation expression. 

Up to 16 items and 560* characters can be set. 
 

If you selected a wrong item, delete it with the 
F2 key and reregister the expression. 

 
 

Moving the cursor onto an item displays the 
information of the item in the expression 
explanation field. 

 

5. Enter a comment with the software keyboard as necessary. 

6. Press the CANCEL key again. 

When the dialog message appears, select “Yes”. 
 

“Yes”:  Registers the expression. 

"No": Returns to the status before inputting the expression. 

"Cancel": Cancels registering the expression and come back to status to edit.  

 
 

If the expression is incorrect such as wrong grammar or unspecified data which is necessary for the 
function, selecting “Yes” cannot execute the registration and a message is displayed in the bottom field. 
The cursor is moved to the wrong item. Correct it. 

7. Press the TRIG key to run a test and confirm the result as necessary. 
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Input Example: Entering a Result of a Checker 
For this example, enter the object area detected thirdly by Feature Extraction No.0. Depending on the type of 
checker, selectable data varies. 

1. In the list of items that can be entered in expression, 
select “Checker” > "FEC(Feature Extraction)". 

The list of Feature Extraction checkers is displayed. 

2. Select checker No. 000. 

The list of result types is displayed. 
 

 
For some checkers, the list of result types is displayed on 
multiple pages. Tilt the ENTER key left or light to change 
the page. 

 

3. Select "Area", the data to enter. 

The window to set a result No. is displayed. 
Among multiple detected objects, use the object 
No. numbered with Feature Extraction checker 
to specify.    

4. Select “0003”. 

 
If specifying the number exceeding the number of detected 
objects, the input value will be “0”. 

5. Select "Result". 

The code indicating “the object area detected thirdly by Feature 

Extraction No.0” is displayed in the expression field. 
 

Highlighting a code displays the meaning of it in the Expression 
Description field in the bottom of the screen. 

 

Inputting Functions 

After selecting a type of function, highlighting a code shows the 
description of the function in the field under the expression field. 
Refer to it to enter an expression. 
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Copying an Set Expression 

Numerical expressions in other types can be copied and used.  

1. Select "INSPECTION” > “Num. Calcu.” 

from the menu bar. (For copying a 
numerical expression in another type, 
change the current type to the type of copy 
source, and make this setting.) 

“Numerical Calculation” window is displayed. 

2. Select a numerical calculation list in the 
setting window and move the cursor onto 
the expression No. to copy. 

3. Press the FUNC key and select “Copy” 

from the displayed menu. 

 

4. Move the cursor onto the destination expression No. 

(When the type of copy source is different from that of destination, change the type before making this 
setting.) 

5. Press the FUNC key and select “Paste” from the displayed menu. 

Copying is executed. 
 

 
If an expression already exists in the destination, the message of overwrite confirmation appears. 

 The retention period of copy information varies depending on the version of PV200 as below.  

 The copied information will be retained until the following events even if the numerical calculation 
list is closed. 

 When another number is copied 

 When the number of copy source is deleted 

 When the type of copy source is deleted 

 When the type is initialized 

 When the mode is switched to RUN menu / when setting data is read 

 When the source data is changed by reading SD type  
 Copy information of checkers is treated in units of submenus of "Inspection".  Therefore, "Position 

Adjustment", "Area Size Adjustment", "Checker", "Numerical Calculation", "Judgement" and "Draw 
Character/Figure" has each copy information.  

 If the setting of the copy source number is edited before "Pasting" the copied numerical expression, 
the edited setting will be pasted. After pasted, the numerical expression of  copy source and the 
pasted numerical expression are separated each other.  

 



 

311 

S
etting Inspection C

onditions 
C

h. 4 

Replacing an Item 

This function replaces a part of an expression with 
another item to use. 

1. Move the cursor onto the item to replace. 

The descriptions of the F1, F2 and F3 keys 
are displayed in the key guide. 

2. Press the F1 key: Replace Items. 

In a similar way to creating an expression, an 
item select window is displayed. 

3. Select an item. 

It is replaced with the selected item. 

 

Deleting an Item 

A part of or an entire operation expression can be deleted. 

1. Select an expression in the numerical 
calculation setting window. 

2. To delete just an item, move the cursor onto 
the item and press the F2: Delete key. 

The item is deleted. 

3. To delete an entire expression, press the F3: 
Delete All key. 

As the confirming message appears, selecting 
“Yes” deletes all items registered in the 
expression. 
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Setting Judgement Limits 
Set a tolerance (maximum and minimum values) of the calculated result. If the value is within the tolerance, the 
object will be judged as "OK", if it is out of it, the object will be judged as "NG". If any judgement is not 
necessary, there is no need to set. 

1. In numerical expression setting window, 
select “Maximum” and enter a value. 

2. In numerical expression setting window, 
select “Minimum” and enter a value. 

3. Press the TRIG key to execute a test and 
confirm the judgement. 

 
Maximum/Minimum values can be input in the 
previous window, in the list of numerical 
calculations. 

 

Setting an Output Condition 
Select whether or not to output calculation results to the external devices for each expression. Default setting is 
set to output. 

 

 
In addition to the setting for each expression, setting from “ENVIRONMENT” >  “Input/Output” outputs 
numerical calculation results to the external devices. 

1. Select "Output” in the numerical 
calculation setting window. 

2. To output it, select “Yes”. Select “No” not 
to output. 

 
Output conditions can be input in the previous 
window, in the list of numerical calculations. 
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4.12.2 Data That Can Be Used in Numerical Calculation  

The data described below is that can be used in numerical calculation. The symbols in parentheses are 
displayed in operation expressions. 

Inspection data that can be registered in Numerical 
Calculation 

 
Depending on type of result data, selectable statistics data varies when selecting “Statistics”. 

Statistics: Type 1 
Scan Count (@COUNT) OK count (@OKCOUNT) NG count (@NGCOUNT) 

Statistics: Type 2 
Minimum value (@MIN) Min. OK Judge. (@OKMIN) Min. NG Judge. (@NGMIN) 

Maximum value (@MAX) Max. OK Judge. (@OKMAX) Max. NG Judge. (@NGMAX) 

Average (@AV) OK average (@OKAV) NG average (@NGAV) 

Range (@RG) OK range (@OKRG) NG range (@NGRG) 

Variance (@DV) OK Variance (@OKDV) NG Variance (@NGDV) 

Checker 
Item Result 

No. 
Result Type Statistics 

type 
Output Value, etc 

Position Adjustment 
(PAC) No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 
Inspection Time (TIME) 2  
Base Position X (BPOSX) 2  
Base Position Y (BPOSY) 2  
Base Position Theta (BANG) 2  
X Adjustment Amount (AJX) 2  
Y Adjustment Amount (AJY) 2  
Theta Adjustment Amount (AJANG) 2  
Detect Position X (X) 2  
Detect Position Y (Y) 2  
Theta(ANG) 2  
Judgement of Base 
Checker (BJUDGE) 

No.0-3 1 OK=1, 
NG=0 

Base=Base 
checker 

Base Inspection Time 
(BTIME) 

No.0-3 2  

Base X-Coordinate (BX) No.0-3 2  
Base Y-Coordinate (Y) No.0-3 2  
Base Projection X (BPX) No.0-3 2  
Base Projection Y (BPX) No.0-3 2  

Area Size Adjustment 
(AUC) No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 
Inspection Time (TIME) 2  

 X coordinate (X) 2  
 Y coordinate (Y) 2  
 Projection distance of X (PX) 2  
 Projection distance of Y (PY) 2  
Line (LIC) No.0-999 --- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  
 Pixel judgement (DJUDGE) 1 OK=1, NG=0 
 Objects judgement (LJUDGE) 1 OK=1, NG=0 
 No. of Pixels (DCOUNT) 2 0 - 125938 
 No. of Objects (LCOUNT) 2 0 - 41979 
Binary Window(BWC) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 
 Inspection Time (TIME) 2  
 Area (AREA) 2 0 - 4194304 
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Item Result 

No. 
Result Type Statistics 

type 
Output Value, etc 

Gray Window(GWC) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

Gray Average (AVE) 2 0 - 255 

Binary Edge(BEC) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

No. of Objects (COUNT) 2 0 - 256 

0-255 X coordinate (X) 2  

Y coordinate (Y) 2  

Detected color (COLOR) 2 "White > Black"=0, "Black > 
White"=1 

Projection distance of X (PX) 2  

Projection distance of Y (PY) 2  

Gray Edge(GEC) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

No. of Objects (COUNT) 2 0 - 256 

0-255 X coordinate (X) 2  

Y coordinate (Y) 2  

Differential Value (DIF) 2 0 - 255 

Projection distance of X (PX) 2  

Projection distance of Y (PY) 2  

Feature Extraction 
(FEC) No.0-999 
 
Common Result: 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

No. of Objects (COUNT) 2 0 - 10000 

Total area (ALLAREA) 2 0 - 4194304 

Individual Result1 
1/2 page 

0-9999 Area (AREA) 2 0 - 4194304 

X coordinate of gravity center (X) 2  

Y coordinate of gravity center (Y) 2  

Projection width (PW) 2   

Projection height (PH) 2   

Perimeter (LEN) 2  

Principal axis angle (ANG) 2 -89.9 - +90.0, -180.0 

Projection distance of X (PX) 2  

Projection distance of Y (PY) 2  

Individual Result2: 
2/2 page 

X coordinate of the upper left point of 
circumscribing rectangle (LUX) 

2  

Y coordinate of the upper left point of 
circumscribing rectangle (LUY) 

2  

X coordinate of the upper right point 
of circumscribing rectangle (RUX) 

2  

Y coordinate of the upper right point 
of circumscribing rectangle (RUY) 

2  

X coordinate of the lower left point of 
circumscribing rectangle (LDX) 

2  

Y coordinate of the lower left point of 
circumscribing rectangle (LDY) 

2  

X coordinate of the lower right point 
of circumscribing rectangle (RDX) 

2  

Y coordinate of the lower right point 
of circumscribing rectangle (RDY) 

2  
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Item Result 

No. 
Result Type Statistics 

type 
Output Value, etc 

Smart 
Matching(SMC) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

No. of Objects (COUNT) 2 0 - 255 

0-255 Detect Template No. (TEMP) 2  

Correlation (COR) 2  

X coordinate (X) 2  

Y coordinate (Y) 2  

Angle (CANG) 2 -179.999 -180.000 

Pixels of Max. Subtracted Object  
(AREA) 

2  

No. of Subtracted Objects (LCNT) 2 0 -128 

Projection distance of X (PX) 2  

Projection distance of Y (PY) 2  

0-5 No. of objects (interim) (CNT) 2 0 -256 

Correlation value (interim) (CLL) 2 0.001 -1.000 

Contour 
Matching(CMC) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

No. of Objects (COUNT) 2 0 - 64 

0-255 Correlation (COR) 2  
X coordinate (X) 2  

Y coordinate (Y) 2  

Angle (CANG) 2 -179.999 -180.000 

Magnification (SCAL) 2  
Projection distance of X (PX) 2  

Projection distance of Y (PY) 2  

Flaw 
Detection(FWC) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

No. of objects (COUNT) 2 0 -512 

0-511 Flaw size (SIZE) 2 1 - 3600 

First Cell of Flaw. (CNO) 2  

X coordinate (X) 2  

Y coordinate (Y) 2  

Projection distance of X (PX) 2  

Projection distance of Y (PY) 2  

Connector - Binary 
Window(CBW) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

No. of Cells(CELL) 2 3 - 100 

Total area (ALLAREA) 2 0 - 4194304 

0-99 Area (AREA) 2 0 - 4194304 

Individual judgement (PJUDGE) 1 OK=1, NG=0 

Connector Gray 
Window (CGW) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

No. of Cells(CELL) 2 3 - 100 

0-99 Gray Average (AVE) 2 0 -255 

Individual judgement (PJUDGE) 1 OK=1, NG=0 

Connector Gray 
Edge (CGE) 
No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Pitch total judgement (PTJUDG) 1 OK=1, NG=0 
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Item Result 
No. 

Result Type Statistics 
type 

Output Value, etc 

Common Result: 1/2 
page 

Distance difference total judgement 
(UPJUDG) 

1 OK=1, NG=0 

Inspection time (TIME) 2  

 No. of Cells(CELL) 2 3 - 100 

 Max. Pitch (PMAX) 2  

Min. Pitch (PMIN) 2  

 Average Pitch (PAVE) 2  

Individual Result: 2/2 
page 

0-99 Pitch Individual Judgement 
(PJUDGE) 

1 OK=1, NG=0 

Distance difference individual 
judgement (UJUDGE) 

1 OK=1, NG=0 

Pitch (PT) 2  

Distance difference (UPT) 2  

Edge X coordinate 0 of area 0 (X0) 2  

Edge Y coordinate 0 of area 0 (Y0) 2  

Edge differential 0 of area 0 (D0) 2 0 -255 

Edge X coordinate 1 of area 1 (X1) 2  

Edge Y coordinate 1 of area 1 (Y1) 2  

Edge differential 1 of area 1 (D1) 2 0 -255 

Smart Edge (Circle)  
(SEC) No.0-999 
Detected Result:  
1/3 page 

--- Max. value (LMAX) 2 Measurement value = 
Radius, Diameter or Width Min. value (LMIN) 2 

Average value (LAVE) 2 

 Standard Deviation (STD) 2  

 Max. Angle (AMAX) 2  

  Min. Angle (AMIN) 2  

  Center X 0 (CX0) 2  

  Center Y 0 (CY0) 2  

  Radius 0 (R0) 2  

  Circularity 0 (CIR0) 2  

  Center X 1 (CX1) 2 Each data of outer detected 
circle when selecting Detect 
Mode: Width 

  Center Y 1 (CY1) 2 

  Radius 1 (R1) 2 

  Circularity 1 (CIR1) 2 

Common Result: 
2/3 page 

 Judgement (JUDGE) 1 OK=1, NG=0 

 Measurement Judgement 
(LJUDGE) 

1  

  Standard Devation Judgement 
(SJUDGE) 

1  

  Circularity Judgement (CJUDGE) 1  

  Unused Edge Count Judgement 
(NJUDGE) 

1  

  Inspection Time (TIME) 2  

  Used Edge Count (FCNT) 2  

  Unused Edge Count (NCNT) 2  

  No. of Cells (CELL) 2 0-3599 

Individual Result:  
3/3 page 
 
 
 
 

0-3599 Individual Judgement (IJUDGE) 1 OK=1, NG=0 

 Measurement value (LEN) 2  

 Deviation (DEV) 2  

 X 0 (X0) 2  

 Y 0 (Y0) 2  
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 Differential 0 (D0) 2 0 -255 

  X 1 (X1) *1) 2  

  Y 1 (Y1) *1) 2  

  Differential 1 (D1) *1) 2  

  Judgement Code (STAT) 2 0-4 *2) 

Smart Edge (Line) 
(SEL) No.0-999 

--- Max. value (LMAX) 2  

Min. value (LMIN) 2 

Common Result: 1/3 
page 

Average value (LAVE) 2 

Standard Deviation (STD) 2 

 Max. X (XMAX) 2 

 Max. Y (YMAX) 2 

Min. X (XMIN) 2 

 Min. Y (YMIN) 2 

 Judgement (JUDGE) 1 OK=1, NG=0 

 Measurement Judgement 
(LJUDGE) 

1  

 Standard Devation Judgement 
(SJUDGE) 

1  

 Linearity Judgement (JUDGE) 1  

 Unused Edge Count Judgement 
(NJUDGE) 

1  

 Inspection Time (TIME) 2  

 Used Edge Count (FCNT) 2  

 Unused Edge Count (NCNT) 2  

 No. of Cells (CELL) 2  

*1) 
When Execution Mode = Width: Outer edge data 
When Execution Mode = Diameter: Edge data of the opposite cell to Result No. cell. 
*2) 0: Cell that detected edges and Individual Judgement NG cell 
 1: Cell that detected edges and Individual Judgement OK cell 
 2: Cell that detected edges and denoising 
 3: Cell that detected no edge 
 4: Masked cell 
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Item Result 

No. 
Result Type Statistics 

type 
Output Value, etc 

Detected Result: 2/3 
page 

 Line 0 Start Coordinate X (SX0) 2  

 Line 0 Start Coordinate Y (SY0) 2  

  Line 0 End Coordinate X (EX0) 2  

  Line 0 End Coordinate Y (EY0) 2  

  Line 0 Element a (EA0) 2  

  Line 0 Element b (EB0) 2  

  Line 0 Element c (EC0) 2  

  Line 0 Angle (ANG0) 2  

  Linearity 0 (LI0) 2  

  Line 1 Start Coordinate X (SX1) 2 Approximate line data that 
is detected based on the 
edges detected with the 
condition 1 when selecting 
Width for Detect Mode 

  Line 1 Start Coordinate Y (SY1) 2 

  Line 1 End Coordinate X (EX1) 2 

  Line 1 End Coordinate Y (EY1) 2 

  Line 1 Element a (EA1) 2 

  Line 1 Element b (EB1) 2 

  Line 1 Element c (EC1) 2 

  Line 1 Angle (ANG1) 2 

  Linearity 1 (LI1) 2 

Individual Result:  
3/3 page 

0-2999 Individual Judgement (IJUDGE) 1 OK=1, NG=0 

 Measurement value (LEN) 2  

  X 0 (X0) 2 

  Y 0 (Y0) 2 

  Differential 0 (D0) 2 0 -255 

  X 1 (X1)  2 Data of the edges detected 
with the condition 1 when 
selecting Width for Detect 
Mode 

  Y 1 (Y1)  2 

  Differential 1 (D1) 2 

  Judgement Code (STAT) 2 0-4 *1) 

Color Window 
(CWC) No.0-999 

--- Judgement (JUDGE) 1 OK=1, NG=0 

Inspection Time (TIME) 2  

Result: 1/2 page R Judgement (RJUDG) 1 OK=1, NG=0 

R Average Judgement (RAJUDG) 1 OK=1, NG=0 

 R Standard Deviation Judgement 
(RSJUDG) 

1 OK=1, NG=0 

 G Judgement (GJUDG) 1 OK=1, NG=0 

G Average Judgement (GAJUDG) 1 OK=1, NG=0 

 G Standard Deviation Judgement 
(GSJUDG) 

1 OK=1, NG=0 

 B Judgement (BJUDG) 1 OK=1, NG=0 

 B Average Judgement (BAJUDG) 1 OK=1, NG=0 

 B Standard Deviation Judgement 
(BSJUDG) 

1 OK=1, NG=0 

Result: 2/2 page  R Maximum (RMAX) 2  

 R Minimum (RMIN) 2  

  R Average (RAV) 2  

  R Standard Deviation (RSD) 2  

  G Maximum (GMAX) 2  

  G Minimum (GMIN) 2  

  G Average (GAV) 2  
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  G Standard Deviation (GSD) 2  

  B Maximum (BMAX) 2  

  B Minimum (BMIN) 2  

  B Average (BAV) 2  

  B Standard Deviation (BSD) 2  

*1) 
0: Cell that detected edges and Individual Judgement NG cell  
1: Cell that detected edges and Individual Judgement OK cell  
2: Cell that detected edges and denoising 
3: Cell that detected no edge 
4: Masked cell 

 

Geometry Calculation 
Detected result data varies depending on the type of geometry calculation. Refer to Geometry Calculation: 
page 286 for details. 
Item Result 

No. 
Result Type Statistics 

type 
Output Value, etc 

Geometry 
Calculation (GGC) 
No.0-999 
Result: 1/2 page 

--- X coordinate (X) 2  

Y coordinate (Y) 2 

Intersection Point 0, X coordinate (I0X) 2 

Intersection Point 0, Y coordinate (I0Y) 2 

Intersection Point 1, X coordinate (I1X) 2 

Intersection Point 1, Y coordinate (I1Y) 2 

Standard Deviation (STD) 2 

 Angle (ANG) 2 

 Line Parameter A (LINEA) 2 

 Line Parameter B (LINEB) 2 

 Line Parameter C (LINEC) 2 

 Distance (DIST) 2 

 Intersecting Angle (CANG) 2 0 - 360 

 Radius (R) 2  

 Major Axis (LA) 2 

 Minor Axis (SA) 2 

 Inspection Time (TIME) 2 

Judgement: 2/2 
page 

 Judgement (JUDGE) 1 OK=1, NG=0 

 X Judgement (XJUDGE) 1 

  Y Judgement (YJUDGE) 1 

  Standard Deviation Judgement 
(SJUDGE) 

1 

  Angle Judgement (AJUDGE) 1 

  Distance Judgement (DJUDGE) 1 

  Intersecting Angle Judgement 
(CAJUDGE) 

1 

  Radius Judgement (RJUDGE) 1 

  Major Axis Judgement (LAJUDGE) 1 

  Minor Axis Judgement (SAJUDGE) 1 
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Numerical calculation 
Item  No. Result Type Statistics 

type 
Output Value, etc 

Numerical 
Calculation 

CAC Numerical 
Calculation 

0-999 *1) Judgement (JUDGE) 1 OK=1, NG=01 

Result (VALUE) 2  

OCA Numerical 
Calculation 
(Previous Result) 

0-999 Judgement (JUDGE) 1 OK=1, NG=0 

Result (VALUE) 2  

*1) Only smaller No. than the currently setting numerical calculation No. is settable.  

Judgement 
Item  No. Result Type Statistics 

type 
Output Value, etc 

Judgement JRC Judgement 
(Internal) 

0-999 Judgement (JUDGE) 1 Only statistics 

JDC Judgement 
(External) 

Constant/ System Register/Scan Count 
Item Result Statistics 

type 
Output Value, etc 

System Value (SYS) Number of Scans (COUNT) No 0 - 2147483647 

System Register SYS:REG0 to SYS:REG7  No -9999999.999 - 
9999999.999 

Constant Input value: -9999999.999 to 
9999999.999 

No  
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4.12.3 Operators and Functions 

Operators 
+ Addition  
- Subtraction  
* Multiplication  
/ Division If denominator becomes "0", the calculation will be terminated and an error signal 

(ERROR1) will be output. 
(, ) Parenthesis Up to three parentheses can be used successionally. You cannot use four or 

more of them successionally. 
Correct: (((A+B)-C+D)+E), Wrong: ((((A+B)-C+D)+E)+F) 

Arithmetical Function 
MOD (S0, S1) Remainder when S0 is divided by S1 e.g.) MOD (9,4) = 1 

POW (S0, S1) Value of S0 multiplied by S1.  
In the following cases, an error signal (ERROR) will 
be output and 0 will be output as the result. 

• When S0=0 and S10 
• When S0<0 

e.g.) POW (3, 2) = 9 

LOG10 (S) Common logarithm of S e.g.) LOG10 (100) = 2 

SQRT (S) Square root of S e.g.) SQRT (144) = 12 

ABS (S) Absolute value of S e.g.) ABS (-255) = 255 

PI ( ) Pi (fixed value) PI ( ) = 3.142 

INT (S) Integer portion of S e.g.) INT (-1.8) = -1 

ROUND (S) Round S to a whole number e.g.) ROUND (1.485) = 1 

FLOOR (S) Round S down to a whole number e.g.) FLOOR (1.485) = 1 

CEIL (S) Round S up to a whole number e.g.) CEIL (-1.3) = -1 

 

Difference among INT, ROUND, FLOOR and CEIL 
S INT (S) ROUND (S) FLOOR (S) CEIL (S) 

1.5 1 2 1 2 

1.4 1 1 1 2 

-1.4 -1 -1 -2 -1 

-1.5 -1 -2 -2 -1 

Statistical Function 
MAX(C,S) Maximum value from S-number of results of numerical 

calculation No.C 
Example) 
In the case of  
 CA000=10 
 CA001=5.8 
 CA002=3 
 

MAX(0, 3) = 10 
MIN(0, 3) = 3 
AVE(0, 3) = 6.267 
SUM (0, 3) = 18.8 
 
SORT(0, 3, 1, 0)=3 
The 0-th (smallest) value 
of the ascendingly sorted 
results of numerical 
calculation No.0 to 2. 

MIN(C,S) Minimum value from S-number of results of numerical 
calculation No.C 

AVE(C,S) Average of S-number of results of numerical 
calculation No.C 

SUM(C,S) Sum of S-number of results of numerical calculation 
No.C 

SORT(C,S0,S1,S2) S2th value when sorting S-number of numerical 
calculation No.C in order of S1 condition 
(0=descending, 1=ascending). 
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Trigonometrical Function 
 

 

(  = degree) 

 
c

b
)(SIND   

 
c

a
)(COSD   

 
a

b
TAND )(  

 

SIN(Radian) Sine of angle DR (radian) e.g.) b = SIN (Radian) * c 

COS(Radian) Cosine of angle DR (radian) e.g.) a = COS (Radian) * c 

TAN(Radian) Tangent of angle DR (radian) e.g.) a / b = TAN (Radian) 

ASIN(S) Arcsine of angle DR (radian) e.g.) Radian = ASIN (b / c) 

ACOS(S) Arccosine of angle DR (radian) e.g.) Radian = ACOS (a / c) 

ATAN(S) Arctangent of angle DR (radian) e.g.) Radian = ATAN (b / a) 

SIND(Degree) Sine of angle D e.g.) b = SIND (Degree) * c 

COSD(Degree) Cosine of angle D e.g.) a = COSD(Degree) * c 

TAND(Degree) Tangent of angle D e.g.) a/b = TAND(Degree) 

ASIND(S) Arcsine of angle D e.g.) Degree = ASIND(b / c) 

ACOSD(S) Arccosine of S e.g.) Degree = ACOSD (a / c) 

ATAND(S) Arctangent of S e.g.) Degree = ATAND (b / a) 

RAD(Degree) Radian of angle D e.g.) RAD(45) = 45 / 360 x 2π= 0.785 

DEG(Radian) Angle of radian R e.g.) DEG(0.785) = 45 

Geometric Function 
MIDDLEX(X0,Y0,X1,Y1) 
MIDDLEY(X0,Y0,X1,Y1) 

Coordinate X and Y of the middle point of two points Q0 (X0, Y0) and Q1 (X1, 
Y1) 

CPOINTX 
(a0,b0,c0,a1,b1,c1) 
CPOINTY 
(a0,b0,c0,a1,b1,c1) 

Coordinate X and Y of the intersection of two lines L0 (a0x+b0y+c0=0) and L1 
(a1x+b1y+c1=0) 
If two lines are parallel, the judgement will be “ERR”. 

ELINEPA (x0,y0,x1,y1) 
ELINEPB (x0,y0,x1,y1) 
ELINEPC (x0,y0,x1,y1) 

Element a, b and c of a line L 
(ax+by+c=0) which connects two points 
(x0,y0) and (x1,y1). 

 

CANGLE 
(a0,b0,c0,a1,b1,c1) 

Narrow intersecting angle DR (radian) 
of two lines L0 (a0x+b0y+c0=0) and L1 
(a1x+b1y+c1=0) 
If two lines are parallel, the judgement 
will be “ERR”.  

DIST (X0,Y0,X1,Y1) Distance between two points Q0 (X0,Y0) and Q1(X1,Y1) in pixels  

VDIST (X0,Y0, a0,b0,c0) Length of a perpendicular to line L 
(a0x+b0y+c0=0) through point Q 
(X0,Y0) in pixels 

 
VPOINTX (X0,Y0, a,b,c) 
VPOINTY (X0,Y0, a,b,c) 

Coordinate X and Y of Q1 which is a 
intersection of line L (ax+by+c=0) and 
a perpendicular to line L through point 
Q0 (X0,Y0) 
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CIRCLEX 
(x0,y0,x1,y1,x2,y2) 
CIRCLEY 
(x0,y0,x1,y1,x2,y2) 
CIRCLER 
(x0,y0,x1,y1,x2,y2) 

Coordinate X and Y of the center and 
radius (in pixels) of a circle through 
three points, (x0,y0), (x1,y1) and 
(x2,y2) 

 
 

If it cannot be calculated, the 
judgement will be “Error”. 

LINELSA (C0,C1,S) 
LINELSB (C0,C1,S) 
LINELSC (C0,C1,S) 

Regression line expression in least squares 
Element a, b and c of a regression line (ax+by+c) when regarding numerical 
calculation No.C0 as the top of X, calculation No.C1 as the top of Y, and 
S-number of calculation data as continuous data. Element a, b, and c are 
calculated by LINELSA, LINELSB, and LINELSC respectively. 
If it cannot be calculated, the judgement will be “Error”.  
 
Example) Regression line of five points (X0 , Y0) to (X4, Y4) 

CAC000 = X0 
CAC001 = X1 
CAC002 = X2 
CAC003 = X3 
CAC004 = X4 
CAC005 = Y0 
CAC006 = Y1 
CAC007 = Y2 
CAC008 = Y3 
CAC009 = Y4 

Register the points in a 
calculation so that their 
coordinates X and Y are 
continuous. 

CAC010 = LINELSA(0, 5, 5) To obtain element a. 
CAC011 = LINELSB(0, 5, 5) To obtain element b. 
CAC012 = LINELSC(0, 5, 5) To obtain element c. 

 

Comparison Function 
 

EQ (S0, S1) Returns "1" when S0 = S1, otherwise "0". e.g.) EQ (85, 85) = 1 

NEQ (S0, S1) Returns "1" when S0 ≠ S1, otherwise "0". e.g.) NEQ (85, 85) = 0 

LT (S0, S1) Returns "1" when S0 < S1, otherwise "0". e.g.) LT (85, 85) = 0 

LEQ (S0, S1) Returns "1" when S0 ≤ S1, otherwise "0". e.g.) LEQ (85, 85) = 1 

GT (S0, S1) Returns "1" when S0 > S1, otherwise "0". e.g.) GT (215, 85) = 1 

GEQ (S0, S1) Returns "1" when S0 ≥ S1, otherwise "0". e.g.) GEQ (215, 85) = 1 
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Coordinate Conversion Function 

PTORXC (c, Xp, Yp) 
PTORYC (c, Xp, Yp) 

Converts the coordinate in pixels (Xp, Yp) of c (Camera No.: 0-1) to the real 
coordinate (Xr, Yr) after calibration. 

RTOPXC (c, Xr, Yr) 
RTOPYC (c, Xr, Yr) 

Converts the real coordinate (Xr, Yr) of c (Camera No.: 0-1) after calibration to the 
coordinate in pixels (Xp, Yp). 

PTORD (c, Ap) Converts the pixel count Ap of c (Camera No.: 0-1) to the real area Ar after 
calibration. 

RTOPD (c, Ar) Converts the real area Ar of c (Camera No.: 0-1) after calibration to the pixel count 
Ap. 

PTORA (c, sA) Converts the screen angle sA of c (Camera No.: 0-1) to the real angle rA after 
calibration (unit: degree). 

RTOPA (c, rA) Converts the real angle rA of c (Camera No.: 0-1) after calibration to the screen 
angle sA (unit: degree). 

 



 

325 

S
etting Inspection C

onditions 
C

h. 4 

4.13 Totally Judging Results of Checkers (Judgement)  
PV has a function that totally judges on the judgements of checkers and numerical calculations. Although 1000 
Judgements are provided, No.0 to 999 (when 10 blocks are used), you can set maximum of 1000 expressions 
per type combining with numerical calculations. 

Judgement can be displayed on the screen and output to the external devices. In addition, images can be 
saved according to the judgement and the images can be output to the external devices. 

 
When the execution mode is set to “Automatic Switch”, the judgement is a branch condition. Refer to Chapter 
4.4.3 (page 118) about the setting procedure of branch conditions. 

4.13.1 Setting Judgement Conditions 

Creating a Calculation 

1. Select "INSPECTION” > “Judgement” 

from the menu bar. 

“Judgement” window is displayed. 
 

If [Judgement] is not displayed after 
selecting [INSPECTION], tilt the ENTER key 
to the right to show the hidden menus. 
Yellow arrows shown in the submenu row 
indicates that the menu is hidden. 

2. Select a type of Judgement to set by 
[Type]. 

 
The list of the judgements that you selected is displayed. 
Judgement has two types as below. Select them in accordance with your purpose. 
JDC (External): The judgement result can be output to the external device. 

JRC (Internal): The judgement results cannot be output to the external device. The other conditions 
are the same as that of JDC (External). 
Use JRC when computing a judgement which is not necessary to be output to the 
external device. 
Example: 
As a precalculation of JDC (External) 
As a condition to save images or to output images. 

3. Select a calculation list and a judgement number to set. 

The screen of numerical calculation setting is displayed. 

4. Select the numerical calculation input field and press the ENTER key again. 

The list of items that can be registered in a calculation is displayed. 
Checker: Select this to input judgements of checkers including Position Adjustment and 

Area Size Adjustment. 
Operator: Select this to input operators such as “AND” and “OR” to judge results totally.  
Geometry Calculation: Select this to input a judgement of a geometry calculation. 
Numerical Calculation: Select this to input a judgement of a numerical calculation. 
Judgement JRC: Select this to input a judgement of JRC (Internal). (When you have set a 

judgement of JRC, you can select only JRC with smaller number than currently 
setting JRC.) 

Judgement JDC: Select this to input judgement of JDC (External) with smaller number than 
currently setting judgement number. (When you have set a judgement of JRC, 
you cannot select JDC.) 
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5. Enter an operation expression. 

Up to 16 items and 560 characters* can be 
set. 
If you selected a wrong item, delete it with the 
F2 key and reregister the expression. 

 
 

Moving the cursor onto an item displays the 
information of the item in the expression 
explanation field. 

6. Enter a comment with the software 
keyboard as necessary. 

 

7. After inputting is completed, press the CANCEL key. 

8. Press the Cancel key again. 

When the dialog message appears, select “Yes”. 
“Yes”: Registers the expression. 
"No": Returns to the status before inputting the expression. 
"Cancel": Cancels registering the expression and come back to status to edit. 

 
When an expression is incorrect such as a grammatical error, even if you select [Yes], a message appears 
and registration cannot be executed. Correct the expression in the case. 

9. Press the TRIG key to run a test and confirm the updated judgement as necessary. 

 

Input Example: Entering a Judgement of a Checker 
For this example, we enter the judgement of Position Adjustment No.0. Depending on the type of checker, 
selectable data varies. 

1. In the list of items that can be entered in an 
expression, select “Checker” > "PAC(Position 
Adjustment)". 

The list of position adjustment is displayed. 

2. Select checker No. 000. 

The list of result types is displayed. 

3. Select "Judgement". 

The code indicating the judgement of Position 
Adjustment No.0 is displayed in the expression field. 

 
Highlighting a code displays the meaning of it in the 
bottom field of the screen. 
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Copying Expression 

Judgement expressions in other types can be copied and used. 

1. Select "INSPECTION” > “Judgement” from the menu bar. 

(For copying a judgement expression in another type, change the current type to the type of copy 
source, and make this setting.) 
“Judgement” window is displayed. 

2. Specify a type of judgement in the Judgement window. 

3. Select a calculation list and a judgement number to copy. 

4. Press the FUNC key and select “Copy” 

from the displayed menu. 

5. Move the cursor onto the destination 
judgement No. 

(When the type of copy source is 
different from that of destination, change 
the type before making this setting.) 

6. Press the FUNC key and select “Paste” 

from the displayed menu. 

Copying is executed. 
 

 
If an expression already exists in the 
destination, the message of overwrite 
confirmation appears. 

 

 
 When the specified "Type (JDC (External) / JRC (Internal)" of the copy source differs from that of 

the destination, the data cannot be pasted. 

 The copied information will be retained until the following events even if the Judgement window is 
closed. 

 When another number is copied 

 When the number of copy source is deleted 

 When the type of copy source is deleted 

 When the type is initialized 

 When the mode is switched to RUN menu / when setting data is read 

 When the source data is changed by reading SD type 
 Copy information of checkers is treated in units of submenus of "Inspection".  Therefore, "Position 

Adjustment", "Area Size Adjustment", "Checker", "Numerical Calculation", "Judgement" and "Draw 
Character/Figure" has each copy information. 

 If the setting of the copy source number is edited before "Pasting" the copied Judgement expression, 
the edited setting will be pasted. After pasted, the judgement expression of copy source and the 
pasted judgement expression are separated each other. 
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Replacing a Item 

This function replaces a part of an expression with 
another item to use. 

1. Move the cursor onto the item to replace. 

The descriptions of the F1, F2 and F3 keys 
are displayed in the key guide. 

2. Press the F1 key: Replace Items. 

In a similar way to creating an expression, an 
item select window is displayed. 

3. Select an item. 

It is replaced with the selected item. 

 

Deleting Operation Expressions and Items 

A part of or an entire operation expression can be deleted. 

1. Move the cursor onto the deleting item. 

2. To delete just an item, move the cursor onto the item and press the F2: Delete key. 

The item is deleted. 

3. To delete an entire expression, press the F3: Delete All key. 

As the confirming message appears, selecting “Yes” deletes all items registered in the expression. 
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Data That Can Be Used in Judgement 
The data described below is that can be used in judgement expression. The symbols in parentheses are 
displayed in operation expressions. 

Checker - Position Adjustment (PAC) No.0-999 
Item  Condition for OK 

judgement 
Judgement 
(JUDGE) 

 The specified object 
or edge is detected. 

Base Judgement 
(BJUDGE) 

Position Adjustment: 
• Binary Edge 
• Gray Edge 

Position Adjustment: 
• Feature Extraction 
• Matching 
• Contour Matching 
• Smart Edge (Circle) 
Position Rotation 
Adjustment: 
• Feature Extraction 

(Principal Axis Angle) 
• 360-degree Matching 
• 360-degree Contour 

Matching 
• Smart Edge (Circle) 
Rotation Adjustment 
• Flaw Detection 

(Ellipse) 

Position Rotation 
Adjustment 
• Feature 

Extraction  
(2 checkers) 

• Matching  
(2 checkers) 

• Contour Matching  
(2 checkers) 

• Smart Edge 
(Line) 

• Flaw Detection 
(2 chekers) 

Rotation Adjustment 
all (Except Flaw 
Detection (Ellipse)) 

 

 No.0 (0) Horizontal Base Checker 
0 

Base Checker 0 Base Checker 0 The base checkers 
can detect the 
specified object or 
edge. 

No.1 (1) Horizontal Base Checker 
1(Center Detection) 

 Base Checker 1 
(Center Detection) 

No.2 (2) Vertical Base Checker 2  Base Checker 2 

No.3 (3) Vertical Base Checker 3 
(Center Detection) 

 Base Checker 3 
(Center Detection) 

Others 
Item  Condition for OK judgement 
Checker - Area Size 
Adjustment (AUC) No.0-999 

Judgement (JUDGE) The specified object or edge is detected. 

Checker - Line (LIC) 
No.0-999 

Judgement (JUDGE) Pixel judgement and Object judgement are both 
OK. 

Pixel judgement (DJUDGE) The number of pixels is within the Judgement limits. 

Object judgement (LJUDGE) The number of objects is within the Judgement 
limits. 

Checker - Binary 
Window(BWC) No.0-999 

Judgement (JUDGE) Area value is within the OK Judgement limits. 

Checker- Gray 
Window(GWC) No.0-999 

Judgement (JUDGE) Gray Average is within the OK Judgement limits. 

Checker - Binary 
Edge(BEC) No.0-999 

Judgement (JUDGE) The number of detected edges is within the OK 
Judgement limits. 

Checker - Gray Edge(GEC) 
No.0-999 

Judgement (JUDGE) 

Checker- Feature Extraction 
(FEC) No.0-999 

Judgement (JUDGE) The number of detected objects is within the OK 
Judgement limits. 

Checker - Smart 
Matching(SMC) No.0-999 

Judgement (JUDGE) The number of detected objects at the last phase is 
equal to the maximum limitation of the number of 
detected objects that was set at the last phase of 
the sequence. 

Checker - Contour 
Matching(SMC) No.0-999 

Judgement (JUDGE) The object is detected under the set inspection 
condition. 

Checker - Flaw 
Detection(FWC) No.0-999 

Judgement (JUDGE) The number of detected flaws is within the OK 
Judgement limits. 

Checker - Connector - 
Binary Window(CBW) 
No.0-999 

Judgement (JUDGE)  

Individual 
Judgement(PJUDGE) 
No.0-99 
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Item  Condition for OK judgement 

Checker - Connector Gray 
Window (CGW) No.0-999 

Judgement (JUDGE)  

Individual 
Judgement(PJUDGE) No.0-99 

 

Checker - Connector Gray 
Edge (CGE) No.0-999 

Judgement (JUDGE) Pitch Total Judgement and Distance Difference 
Total Judgement are both OK. 

 Pitch total judgement 
(PTJUDG) 

Pitch Judgements are all OK. 

 Distance Difference Total 
Judgement (UPJUDG) 

Distance Difference Judgements are all OK. 

 Pitch Judgement(PJUDGE) 
No.0-99 
(Judgement of each pitch) 

The detected pitches are within the Judgement 
limits of pitches. 

 Distance Difference 
Judgement(UJUDGE) No.0-99 
(Judgement of each distance 
difference) 

The detected distance difference is within the 
Judgement limits of distance difference. 

Smart Edge (Circle) (SEC) 
No.0-999 

Judgement (JUDGE) The judgements of Measurement Value, Standard 
Deviation, Circularity and Unused Edge Count are 
all OK. 

Measurement Judgement 
(LJUDGE) 

Measurement Value*1) is within the range of the 
maximum/minimum limitations. 

Standard Devation Judgement 
(SJUDGE) 

Standard Deviation is within the range of the 
maximum/minimum limitations. 

Circularity Judgement 
(CJUDGE) 

Circularity is within the range of the 
maximum/minimum limitations. 

Unused Edge Count 
Judgement (FJUDGE) 

Unused Edge Count is within the range of the 
maximum/minimum limitations. 

Individual Judgement 
(IJUDGE) No.0-3599 

The result of the cell with the specified No. is OK. 
(Undetected, excluded and NG cells are NG.) 

Smart Edge (Line) (SEL) 
No.0-999 

Judgement (JUDGE) The judgements of Measurement Value, Standard 
Deviation, Linearity and Unused Edge Count are 
all OK. 

Measurement Judgement 
(LJUDGE) 

Measurement Value*2) is within the range of the 
maximum/minimum limitations. 

Standard Devation Judgement 
(SJUDGE) 

Standard Deviation is within the range of the 
maximum/minimum limitations. 

Linearity Judgement (JUDGE) Linearity is within the range of the 
maximum/minimum limitations. 

Unused Edge Count 
Judgement (FJUDGE) 

Unused Edge Count is within the range of the 
maximum/minimum limitations. 

Individual Judgement 
(IJUDGE) No.0-3599 

The result of the cell with the specified No. is OK. 
(Undetected, excluded and NG cells are NG.) 

Color Window (CWC) 
No.0-999 

Judgement (JUDGE) The judgements of the gray value, average and 
standard deviation of red, green and blue 
elements are all OK. 

R Judgement (RJUDGE) The gray value of red element is within the range 
of the maximum/minimum limitations. 

 R Average Judgement 
(RAJUDG) 

The gray average of red element is within the 
range of the maximum/minimum limitations. 

 R Standard Deviation 
Judgement (RSJUDG) 

The standard deviation of gray value of red 
element is within the range of the 
maximum/minimum limitations. 

 G Judgement (GJUDGE) The gray value of green element is within the 
range of the maximum/minimum limitations. 

 G Average Judgement 
(GAJUDG) 

The gray average of green element is within the 
range of the maximum/minimum limitations. 

 G Standard Deviation 
Judgement (GSJUDG) 

The standard deviation of gray value of green 
element is within the range of the 
maximum/minimum limitations. 
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 B Judgement (BJUDGE) The gray value of blue element is within the 
range of the maximum/minimum limitations. 

 B Average Judgement 
(BAJUDG) 

The gray average of blue element is within the 
range of the maximum/minimum limitations. 

 B Standard Deviation 
Judgement (BSJUDG) 

The standard deviation of gray value of blue 
element is within the range of the 
maximum/minimum limitations. 

Geometry Calculation 
(GGC) No.0-999 

Judgement (JUDGE) All the judgements for the items set in Judgement 
Limits are OK. 

X Judgement (XJUDGE) IP X or Center X is within the range of the 
maximum/minimum limitations. 

Y Judgement (YJUDGE) IP Y or Center Y is within the range of the 
maximum/minimum limitations. 

Standard Deviation 
Judgement (SJUDGE) 

Standard Deviation is within the range of the 
maximum/minimum limitations. 

Angle Judgement (AJUDGE) Line Angle is within the range of the 
maximum/minimum limitations. 

Distance Judgement 
(DJUDGE) 

Distance is within the range of the 
maximum/minimum limitations. 

Intersecting Angle Judgement 
(CAJUDGE) 

Intersecting Angle is within the range of the 
maximum/minimum limitations. 

Radius Judgement (RJUDGE) Radius is within the range of the 
maximum/minimum limitations. 

Major Axis Judgement 
(LAJUDGE) 

Major Axis of Ellipse is within the range of the 
maximum/minimum limitations. 

Minor Axis Judgement 
(SAJUDGE) 

Minor Axis of Ellipse is within the range of the 
maximum/minimum limitations. 

Numerical Calculation 
(CAC/OCA)  

CAC Numerical Calculation 
(JUDGE) No.0-999 

Calculation result is within the Judgement limits. 

OCA Numerical Calculation 
Previous Result (JUDGE) 
No.0-999 

Judgement (JRC/JDC) JRC Judgement (JUDGE) 
No.0-999 

Judgement formula returns true. 

 JDC Judgement (JUDGE) 
No.0-999 

*1) Measurement Value = Radius, Diameter or Width (decided according to the setting value of Detect Mode) 
*2) Measurement Value = Deviation, Distance or Width (decided according to the setting value of Detect Mode) 
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About Operators 

Use operators to judge results of multiple checkers or numerical calculations. 

+: Logical sum 

Returns "OK (1)", if the result of either A or B is OK (1). 

Example: JDC001=A+B 
A B JDC001 
OK (1) OK (1) OK (1) 
OK (1) NG (0) OK (1) 
NG (0) OK (1) OK (1) 
NG (0) NG (0) NG (0) 

 

*: Logical product 

Returns "OK (1)", if the results of both A and B are OK (1). 

Example: JDC001=A*B 
A B JDC001 
OK (1) OK (1) OK (1) 
OK (1) NG (0) NG (0) 
NG (0) OK (1) NG (0) 
NG (0) NG (0) NG (0) 

 

#: Exclusive OR 

Returns "OK (1)", if the results differ between A and B. 

Example: JDC001 = A # B 
A B JDC001 
OK (1) OK (1) NG (0) 
OK (1) NG (0) OK (1) 
NG (0) OK (1) OK (1) 
NG (0) NG (0) NG (0) 

 

/: Negation 

Reverses a judgement. 

Do not put a symbol "/” before the multiple contents in 
parentheses. 

Example: JDC001=/A 
A  /  JDC001 
OK (1) Reversed NG (0) 
NG (0) Reversed OK (1) 

 

JDC001 = / (A + B)  Wrong: Because A and B is in parentheses. 
JDC001 = / A * / B  This means the same as the above formula. (Boolean algebra, De Morgan's laws) 

Or store the formula of A+B in JRC (Internal) once, and then negate the JRC. 
 
JDC002 = / (A * B)  Wrong: Because A and B is in parentheses. 
JDC002 = / A + / B ← This means the same as the above formula. (Boolean algebra, De Morgan's laws)  

Or store the formula of A*B in JRC (Internal) once, and then negate the JRC. 

(: Left parenthesis 

): Right parenthesis 

Judges the contents in parentheses by 
priority. 
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4.13.2 Total Judgement 

Total Judgement is a judgement displayed in the status 
display area in RUN menu or SETUP menu. It can be 
output to the external devices solely. One of 
judgements per type can be registered as a Total 
Judgement *1). In User-Defined mode or Automatic 
Switch mode, a judgement can be registered as a Total 
Judgement for each block. 

 

*1) When Execution Mode is "Execute All". When 
Execution Mode is "Automatic Switch" or 
"User-Defined", only the specified number of blocks 
can be registered. 

 

Selecting Total Judgement Expression 

For “Execute All” execution mode 

1. Select "Condition" in judgement 
output setting window. 

“Condition” setting window is displayed. 

 

2. Select “Condition” column of Total Judge. 

Select a judgement type to register as a Total Judgement. 
[NO]: No Total Judgement 
[JRC]: Use a JRC(Internal) as a Total Judgement 
[JDC]: Use a JDC(External) as a Total Judgement 

3. Select “Checker No.” column and set a judgement number. 

The result of the Total Judgement is displayed in the "Result” column. 

4. After setting is completed, press the CANCEL key. 

Now you completed registering. 

For “Automatic Switch” or “User-Defined” execution mode 

1. Select "Condition" in judgement output setting window. 

“Condition” setting window is displayed. 

2. Select “Total Judge.” in the item selecting field 

on the upper left. 

The list of the Total Judgement by blocks is 
displayed. 

 

3. Select “Condition” column of the block No. to set in the list and select a judgement type. 

For details, refer to the procedure of “Execute All” execution mode. 

4. Select “Checker No.” column and set a judgement number. 

5. After setting is completed, press the CANCEL key. 
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4.13.3 Selecting an Image Output Condition 

Inspected images can be saved in the image memory of PV200 and output to the external devices when the 
judgement of the judging checker is “NG” during an inspection. Select a judging checker to be a condition to 
output images. 

 
This setting is available only when the condition of “Image Output” (or “Save Image Memory”) is set to “NG 
judgement”. These conditions can be set from “Input/Output” of “ENVIRONMENT”. (Refer to page 370 or page 
375.) 

 

How to output inspected images 
NG Judgment To specify a condition expression to output images. This condition expression is 

common to all cameras. When judgement is NG, all images of the cameras which is 
set to "Output" will be output. 

Judge. Per Cam. To specify conditions to output images for each camera. When judgement is NG, 
images of the specified cameras will be output. 

 

Selecting a Condition Expression of Inspection 
Image Output 

When Output Condition is “NG Judgment” and Execution Mode is "Execute All"  

1. Select "Condition" in judgement output setting window. 

“Condition” setting window is displayed. 

2. Select “Condition” column of Image 

Output. 

Select a judgement type to register. 

 
[No]: Images are not output. 
[No Condition]: Always output images regardless of inspection results. 
[JRC]: Use a JRC(Internal) as a condition to image output. 
[JDC]: Use a JDC(External) as a condition to image output. 

 
 

**Select ”No Condition” to temporarily output images regardless of a judgement condition when the 
image output condition is set to “NG Judgement” or "Judge. Per Cam." which is on the window of 
“Input/Output” of “ENVIRONMENT”. 
When the other conditions are selected than “NG Judgement” and "Judge. Per Cam.", the setting of 
Judgment window is invalid. 
(For the setting of "NG Judgement", refer to page 370.) 

3. Select “Checker No.” column and enter a judgement number. 

The status of Image Output is displayed in the "Result” column. 
"No" indicates that image output is not executed because the condition is not fulfilled. 

4. After setting is completed, press the CANCEL key. 

Now you completed registering. 
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When Output Condition is “NG Judgment” and Execution Mode is "Automatic 
Switch" or "User-Defined” 

Set the conditions to output images by block. 

1. Select "Condition" in judgement output setting 
window. 

“Condition” setting window is displayed. 

2. Select “Image Output” in the item selecting field on 
the upper left. 

The list of the Image output by blocks is displayed. 
 

3. Select “Condition” column of the block No. to set in the list and select a judgment type. 

For details, refer to the procedure of “Execute All” execution mode. 

4. Select “Checker No.” column and set a judgment number. 

5. After setting is completed, press the CANCEL key. 

Now you completed registering. 

 
In case of automatic switch, as for the image output, only the sett ing for the block finally executed is 
enabled. 

For example, if executing the operation in the order of block No. 0 -> block No.1 when the conditions for 
the inspection image output have been set for the block No. 0 only, the inspection image is not output as 
the conditions for the inspection image output have not been set for the block No. 1 finally executed.  

When Image output is "Judge. Per Cam." and Execution Mode is “Execute All” 
Set the conditions to output images by camera. 

1. Select "Condition" in judgement output setting window. 

“Condition” setting window is displayed. 

2. Select a camera number. 

3. Select “Condition” column of 

Image Output. 

Select a judgment type to register. 
 

 
[No]: Images are not output. 
[No Condition]: Always output images regardless of inspection results. 
[JRC]: Use a JRC(Internal) as a condition to image output. 
[JDC]: Use a JDC(External) as a condition to image output. 

 
*Select ”No Condition” to temporarily output images regardless of a judgement condition when the image 

output condition is set to “NG Judgement” or "Judge. Per Cam." which is selected in "Output Conditions" 
under "Image Output" on the window of “Input/Output” of “ENVIRONMENT”. 
When the other conditions are selected than “NG Judgement” and "Judge. Per Cam.", the setting of 

Judgment window is invalid. (For the setting of "Judge. Per Cam.", refer to page 370.) 
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4. Select “Checker No.” column and enter a judgment number. 

The status of the image output is displayed in the "Result” column. 
"No" indicates that image output is not executed because the condition is not fulfilled. 

5. After setting is completed, press the CANCEL key. 

Now you completed registering. 

When Image output is "Judge. Per Cam." and Execution Mode is “Automatic Switch” 
or “User-Defined” 

Set the conditions to output images by block and camera. 

1. Select "Condition" in judgement output setting 
window. 

“Condition” setting window is displayed. 

2. Select “Image Output” in the item selecting field 
on the upper left. 

 

3. Select "Camera No." in the item selecting field on 
the upper left. 

The list of the image output of the selected camera 
by blocks is displayed. 

 

 
 

 
 

4. Select “Condition” column of the block No. to set in the list and select a judgment type. 

For details, refer to the procedure of “Execute All” execution mode. 

5. Select “Checker No.” column and set a judgment number. 

6. After setting is completed, press the CANCEL key. 

Now you completed registering. 
Repeat the above steps 3 to 6 for each camera. 

 
In case of automatic switch, as for the image output, only the setting for the block finally executed is 
enabled. 

For example, if executing the operation in the order of block No. 0 -> block No.1 when the conditions for 
the inspection image output have been set for the block No. 0 only, the inspection image is not output as 
the conditions for the inspection image output have not been set for the block No. 1 finally executed.  
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4.13.4 Selecting an Image Memory Save Condition  

Inspected images can be saved in the image memory of PV200 when the judgement of the judging checker 
is NG during the inspection. Select a judging checker to be a condition to output images.  

 
This setting is available only when the condition of “Save Image Memory” is set to “NG judgment”. These 
conditions can be set from “Input/Output” of “ENVIRONMENT”. (Refer to page 375.) 

When Execution Mode is “Execute All” 

1. Select "Condition" in judgement output setting 
window. 

“Condition” setting window is displayed. 

2. Select “Condition” column of Save Img. Memory. 

 
Select a judgment type to register. 
[No]: Images are not saved. 
[No Condition] Save all images without 

selecting a condition 
expression. 

[JRC]: Use a JRC (Internal) as a 
condition to save images. 

[JDC]: Use a JRC (External) as a 
condition to save images. 

 
 

When "Output Conditions" under "ENVIRONMENT" - 
"Input/Output" - "Image Output" is other than "Judge. 

Per Cam.” 

 
 

When "Output Conditions" under "ENVIRONMENT" - 
"Input/Output" - "Image Output" is "Judge. Per Cam." 

 

 
*Select ”No Condition” to temporarily save all images regardless of a judgement condition when the image 
saving condition is set to “NG Judgement” which is selected in "Saving Condition" under "Save Image 
Memory on the window of “Input/Output” of “ENVIRONMENT”. 
When the other conditions are selected than “NG Judgement”, the setting of Judgment window is invalid. 
(For the setting of "NG Judgement", refer to page 375.) 

3. Select “Checker No.” column and enter a judgment number. 

The status of the image memory save is displayed in the "Result” column. 
"No" indicates that image save is not executed because the condition is not fulfilled. 

4. After setting is completed, press the CANCEL key. 

Now you completed registering. 
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For “Automatic Switch” or “User-Defined” execution mode 

1. Select "Condition" in judgement output setting 
window. 

“Condition” setting window is displayed. 

2. Select “Save Image Memory” in the item selecting 
field on the upper left. 

The list of the Save Image Memory by blocks is 
displayed. 

 

 

3. Select “Condition” column of the block No. to set in the list and select a judgment type. 

For details, refer to the procedure of “Execute All” execution mode. 

4. Select “Checker No.” column and set a judgment number. 

5. After setting is completed, press the CANCEL key. 

Now you completed registering. 

 
In case of automatic switch, as for the image memory save, only the sett ing for the block finally executed is 
enabled. 

For example, if executing the operation in the order of block No. 0 -> block No.1 when the conditions for 
the image memory save have been set for the block No. 0 only, the image memory save is not executed as 
the conditions for the image memory save have not been set for the block No. 1 finally executed.  
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4.14 Character/Figure Drawing 

4.14.1 What is Character/Figure Drawing? 

Character/Figure Drawing is the function to draw figures or 
characters, and display them on the screen window. 

The drawable figures are Line, Cross, Rectangle, Slanted rectangle, 
Ellipse and Character. For some shapes, an arrowhead can be added 
or figure can be filled.   

As the function(*1) that refers the values detected by each checker is 
provided, not only drawing a figure of a fixed size at a fixed position 
but also changing the size or position depending on the inspection 
result is possible. The values of the data detected by each checker or 
judgement result (OK/NG) can be also displayed as well as a fixed 
text. 

The color is selectable from eight colors. There is the function to 
switch the display color according to the judgement results of each 
checker. 

Up to ten figures can be registered for one character/figure drawing. 

 

 

 
 *1) Only the checkers set with the same camera can be referred. 

However, when Calibration is set for both two cameras, a checker set for either one camera can be 
referred by the other as the both cameras operate using global coordinates.  

 If the execution mode is "User-defined" or "Automatic Switch" when running a test in RUN Menu, the 
figure in the block that is not executed is not displayed. (Using the Marker function (page 617) displays a 
figure on the screen window of the specified camera regardless of the execution block.) 

 Five kinds of figures and characters are collectively called "Figure" in this manual. 

Examples of Figures 
Cross Line  

(Straight line) 
Ellipse 

 
Set the intersection 
of a cross. The line 
length can be 
specified. 

Set a start point 
and an end point. 
A half line can be 
displayed. 

Set the center, width and height.  
Specifying the start and end angles 
enables to draw an arc or sector. 

 
Rectangle, Slanted rectangle Character 

 
 

Set a start point and an end point. 
The figure can be filled. 
Specify the center, width and height for 
"Slanted rectangle". 

Display judgement results, detected 
data or fixed text characters. 
Specify the display position, character 
size and number of digits. 
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List of Menu Options 
 

Character/Figure Drawing No.000 to 999* 
└ ┬ Comment     
 ├ Camera     
 ├ Color by Judgement     
 ├ Color (OK Color)     
 ├ NG Color     
 └ No.0 - 9 ───── ┬

│ 
Line ┬

│ 
Start XY, End XY 

   │ 
│ 

 ├ 
│ 

Line Display ─ Segment / Half line 0 / Half line 1 / 
Wall-to-wall 

   │  └ Arrowhead ─ None / Start / End / Both 
   │    
   ├ Cross ┬ IP XY 
   │  ├ Cross Display ─ Normal / Wall-to-wall 
   │  └ Length ─ 3 - 999 
   │    
   ├ Rectangle ┬ Start XY, End XY 
   │  └ Solid 
   │    
   ├ 

│ 
Slanted 
rectangle 

┬ 
└ 

Center XY, Width, Height, Angle 
Solid 

   │    
   ├ Ellipse ┬ Center XY, Width, Height, Start Angle, End Angle, Angle 
   │  ├ Solid 
   │  └ Arrowhead ─ None / Start / End / Both 
   │    
   └ Character ┬ Display Character  
     ├ Coordinate XY   
     ├ Character Size ─ 14 - 280 
     ├ 

│ 
│ 
│ 
│ 

Display Base ─ Top Left / Top Center / Top 
Right / Left Center / Center / 
Right Center / Bottom Left / 
Bottom Center / Bottom Right 

     ├ Offset Unit ─ Characters / Pixel 
     ├ Offset X   
     ├ Offset Y   
     ├ 

│ 
Judgement 
Display 

─ 1 0 E / OK NG ER 

     ├ Digit Count ─ 1 - 15 
     ├ Decimal Digit ─ 0 - 3 
     └ Alignment ─ Left / Center / Right 

* When the number of blocks is 10. 
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4.14.2 Creating Character/Figure Drawing 

Creating Character/Figure Drawing 

1. Select "Inspection” > “Draw Char/Fig.” from the menu bar. 

The list of Character/Figure Drawing checker is displayed. 
The number of figures that have been set in the highlighted checker 
number is displayed in the message field beneath the list. 
Example) No. of Set Figures 1/10 

 

 

2. Select the checker number to be set and press the ENTER key. 

The setting window for Character/Figure Drawing is displayed. 
If more than one figure is created, the figure with the larger number is 
displayed in the front. 
For example, rectangles of the same size are created in the same 
position, No.0 is in red and No.1 is in blue. In this case, only the blue 
rectangle of No.1 is displayed on the screen window. 

3. Select a camera No. in “Camera”. 

The image of the selected camera is displayed. 

Setting Color 
Set the color of figures. The display color can be switched or hidden depending on the judgement results 
(OK / NG) of the checkers with the same camera number.  

4. If you want to change the display color depending on the judgement 
results of each checker, select "Color by Judgement". 

(When you do not use the function to change the color depending on the 
judgement results, proceed to Step 6.) 
The list of settable checkers is displayed. Unset checkers are shown in 
gray and cannot be selected. 

5. Select the checker and checker number to be set. 

The selected checker and checker number is displayed in a symbol in the 
"Color by Judgement" field. 

 
 

When the checker which outputs more than one judgement results has 
been selected, specify which judgement result is used. 
Example: When selecting "Smart Edge (Circle)" 
Judgement, Measurement Judgement, Standard Deviation Judgement, 
Circularity Judgement, Unused Edge Count Judgement, Individual 
Judgement (Judgement of each cell) 
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6. When "Color" (Color by Judgement) has been set, select "OK Color" or "NG 
Color". 

"Hide" and eight preset colors are available. 

7. Select a desired color and press the ENTER key. 

The box of the selected color is checked. 
 

 

 

Selecting Figure 
Up to ten figures with the same camera and color settings can be set.  

8. Select the list of figure. 

Now you can select No.0 to 9. 

9. Select the figure number to set. 

The available six figures are displayed.  

10. Select the figure number to create. 

The setting window of the selected figure is displayed. 
The items to specify the size of the figure and the display 
position are in the upper table, and the optional items to 
set appearance such as Arrowhead or Solid are beneath 
the table. 

 
Refer to the next page for how to set each figure. 

 
 

After the selection of a figure, it cannot be changed to 
another figure. 
To change the figure, delete the current figure and 
recreate a new figure. 

 

 
The set figure name is displayed in the list. 

When the figure name is displayed in red, it shows that 
the figure cannot be drawn correctly. Moving the cursor 
onto the figure number displays the reason why it 
cannot be drawn in the message field. Change the 
setting to draw the figure correctly. 
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Copying and Deleting Figure 

Deleting or Copying One Figure 

Figures can be deleted or copied from the pop-up menu to be displayed by  pressing the FUNC key. 

1. Highlight the figure number you want to delete or copy and 
press the FUNC key. 

2. Select "Delete" or "Copy". 

When selecting "Delete", the dialog message appears. Select “Yes”. 

3. When selecting "Copy", move the cursor onto the destination 
figure number, press the FUNC key, and select “Paste”. 

The copied figure is pasted. 
If a figure already exists in the destination, the message of overwrite 
confirmation appears. Select “Yes” to overwrite it. 

 

Copying One Checker Number 

In Character/Figure Drawing, up to ten figures can be set for one checker number. To copy ten figures all at 
once, follow the procedure below. Character/Figure Drawing in other types can be copied and used.  

1. Highlight the checker number of a copy source. 

(For copying a numerical expression in another type, change the 
current type to the type of copy source, and make this setting.) 

2. Press the FUNC key and select “Copy”. 

3. Move the cursor onto the checker number of Character/Figure 
drawing. 

(When the type of copy source is different from that of destination, 
change the type before making this setting. ) 

4. Press the FUNC key and select “Paste”. 

The figure of the copy source is pasted. 
If a figure already exists in the destination, the message of overwrite 
confirmation appears. Select “Yes” to overwrite it. 

 

 

 

 
 The retention period of copy information varies depending on the version of PV200 as below.  

 The copied information will be retained until the following events even if the Character/Figure 
Drawing checker list is closed. 

 When another number is copied 

 When the number of copy source is deleted 

 When the type of copy source is deleted 

 When the type is initialized 

 When the mode is switched to RUN menu / when setting data is read 

 When the source data is changed by reading SD type 

 Copy information of checkers is treated in units of submenus of "Inspection". Therefore, "Position 
Adjustment", "Area Size Adjustment", "Checker", "Numerical Calculation", "Judgement" and 
"Draw Character/Figure" has each copy information. 

 If the setting of the copy source number is edited before "Pasting" the copied Character/Figure 
Drawing, the edited setting will be pasted. After pasted, the Character/Figure Drawing of copy 
source and the pasted Character/Figure drawing are separated each other.  
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4.14.3 Setting the Drawing Position and Size of a Drawing 

Line (Straight Line) 
Specify the X and Y coordinates of the start and end points to display a line. The start and end points can be 
specified with the cursor, values and the coordinates detected by each checker. For details of selectable items, 
see page 353. 

Specifying Start Point and End Point 

1. Select the table to set the start point XY and end point XY on the 
setting window of Line, and move the cursor onto "Start X" and 
press the ENTER key. 

A list of available items is displayed. (The checkers displayed in gray 
indicates that they are not unset.) 

2. Select the item to input in Start X from the list of the selectable 
items. 

When selecting "Cursor", move the cross mark displayed on the 
screen window and press the ENTER key. 

 
 

About the items that X and Y-coordinates are input together 
When selecting items other than Numerical Calculation, System 
Register and Constant, X and Y-coordinates are input together. 
For example, when selecting "GEC: Gray Edge" for setting Start X, 
the XY-coordinate of the detected edge is input for Start X and Start Y. 
If Start Y has been already input, it is overwritten. 

 
If you want to set the item that the X and Y-coordinates are input 
together to X-(or Y-)coordinate and the item that a single coordinate is 
input such as Numerical Calculation, System Register or Constant to 
Y-(or X-)coordinate, specify the item that the coordinates are input 
together first and then specify the item that a single coordinate is 
input. 

3. In the same way, set Start Y, End X and End Y. 
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Optional Settings 

1. Select "Line Display". 

Select the type of the line from the following four types. 
 

Segment Half line 0 Half line 1 Wall-to-wall 
Display a line between 
the start and end 
points. 

Display a line between 
the end point and the 
edge of the screen in the 
start point side. 

Display a line between 
the start point and the 
edge of the screen in the 
end point side. 

Display a line between 
the both edges of the 
screen in the start and 
end point sides (*). 

 

 

 
(*)Draw a line up to the ends of the eight screens surrounding the image 
captured with 4-Mega Camera (X-Coordinate: -2048  to 4095, 
Y-coordinate: -2048 to 4095) regardless of the type of the camera used. 
The right figure shows the example when using 4-Mega Camera. 

 

2. Select "Arrowhead". 

Set this when adding arrowhead to the line. 
 

Start End Both 
Add an arrowhead to 
the start point. 

Add an arrowhead to 
the end point. 

Add arrowheads to the both start and end points. 
The right figure shows the example when "Line Display" is 
"Wall-to-wall". 

 
 

When "Line Display" is set to "Half line 0", "Half line 1" or "Wall-to-wall", the arrowheads are displayed at the 
start and end points. 

Cross 
Specify the X and Y coordinates of the intersection point of a cross to display a cross. The intersection 
point can be specified with the cursor, values and the coordinates detected by each checker.  For details of 
selectable items, see page 353. 

Specifying Intersection Point 

1. Select the table to set the intersection point X and Y on the 
setting window of Cross, and move the cursor onto "IP X" and 
press the ENTER key. 

A list of available items is displayed. (The checkers displayed in gray 
indicates that they are not unset.) 
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2. Select the item to input in IP X from the list of the selectable items. 

When selecting "Cursor", move the cross mark displayed on the screen window and press the ENTER key. 
 

About the items that X and Y-coordinates are input together (page 344) 

3. In the same way, set IP Y. 

Optional Settings 
Set the length of a cross. 

1. Select "Cross Display". 

Normal (Default) Wall-to-wall 

Display the cross of the length 
specified in the next step. 

Display the cross of the length up to the ends of the screen. (*) 

 

 
(*)Draw a line up to the ends of the eight screens surrounding the image 
captured with 4-Mega Camera (X-Coordinate: -2048  to 4095, Y-coordinate: 
-2048 to 4095) regardless of the type of the camera used. 
The right figure shows the example when using 4-Mega Camera. 

 

2. When selecting "Normal" in "Cross Display", set the length of the cross in "Length". 

The length to be set is the total length of the vertical line and horizontal line of the cross. The available 
value is an odd value in the range of 3 to 999 (pixels). 

Rectangle 
Specify the X and Y coordinates of the start and end points to display a rectangle. The start and end points 
can be specified with the cursor, values and the coordinates detected by each checker. For details of 
selectable items, see page 353. 

 

Specifying Start Point and End Point 
Refer to the procedure of "Specifying Start Point and End Point" for 
Figure: Line (page 344). 

Optional Setting 
Rectangle can be filled. 

1. Select "Solid". 

No (Default): Displays only the frame border of rectangle. 
Yes: Fills the inside of rectangle with the same color of the frame 
boarder.  
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Slanted Rectangle 
Specify the center coordinate, width, height and rotation angle to draw a slanted rectangle.  For details of 
selectable items, see page 353. 

Setting Size of Rectangle, Rotation Angle and Display Position 

  

Specifying Center Coordinate 

1. Select the table on the setting window of Slanted rectangle, and 
move the cursor onto "Center X" and press the ENTER key. 

A list of available items is displayed. (The checkers displayed in gray 
indicates that they are not unset.) 

2. Select the item to input in Center X from the list of the selectable 
items. 

When selecting "Cursor", move the cross mark displayed on the 
screen window and press the ENTER key. 

 
 

About the items that X and Y-coordinates are input together (page 
344) 

3. In the same way, set Center Y. 

 

 

Specifying Width and Height 

4. Move the cursor onto "Width" and press the ENTER key. 

A list of available items is displayed. 

5. Select the item to input in Width from the list of the selectable 
items. 

6. In the same way, set Height. 
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Specifying (Rotation) Angle 

Set the rotation angle of the rectangle. 
Specify the angle in a range of -360 to 360 regarding the position at three 
o'clock as 0 degree. 
Clockwise is positive angle (0 to 360) and counterclockwise is negative angle (0 
to -360). 

 

 
When specifying a value of Numerical Calculation or System Register for the 
reference of the angle, the value may  exceed +/-360. In that case, the angle of 
the remainder is automatically calculated by dividing the input value by 360. 

Example) When the value of System Register is 750 
750 divided by 360 is 2, and the remainder is 30. = 30 degrees 

 

7. Move the cursor onto "Angle" and press the ENTER key. 

A list of available items is displayed. 

8. Select the item to input in Angle from the list of the selectable items. 

 

Ellipse 
Specify the center coordinate, width, height and (rotation) angle to draw an ellipse. 
An arc can be also drawn by specifying the angle range. 

For details of selectable items, see page 353. 
 

Setting Size of Ellipse, Position and 
Angle 
 

 
The setting procedures of Center, Width and Angle 
are the same as that of "Slanted rectangle". Refer 
to page 347. 

  

 

Setting Start Angle and End Angle Drawing Elliptic Arc) 
 

To draw an elliptic arc, set the start and end points of the arc by specifying the 
angles. The start point is called Start Angle and the end point is called End 
Angle. In the same way of (Rotation) "Angle", set them in a range of -360 to 
+360. 

 

 
When specifying a value of Numerical Calculation or System Register for the 
reference of each angle, the value may  exceed +/-360. In that case, the 
angle of the remainder is automatically calculated by dividing the input value 
by 360. 

Example) When the value of System Register is 750 

750 divided by 360 is 2, and the remainder is 30. = 30 degrees 
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1. Move the cursor onto "Start Angle" and press the ENTER key. 

A list of available items is displayed. (The checkers displayed in gray 
indicates that they are not unset.) 

2. Select the item to input in Start Angle from the list of the selectable 
items. 

3. In the same way, set End Angle. 
 

 

About 0-degree Position 

The position of "0 degree" for the start and end angles is at three o'clock as mentioned above. However, if 
the ellipse is rotated (when the angle specified in the previous section is other than 0), the specified angle 
is at the position of 0 degree. 

Note that the position of the displayed arc varies when the (rotation) angle of each ellipse differs even if the 
same values are set to the start and end angles as shown in the example below.  

 

Example)  Setting 1 Setting 2 Setting 3 
Angle 0 45 45 
Start angle 0 0 315 
End angle 180 180 135 
Displayed arc 

 

Optional Settings 
"Solid" and "Arrowhead" is provided for the options of "Ellipse".  

1. Set "Solid". 

When filling an arc, the area from the start angle to the end angle is 
filled as shown in the right figure. 

2. Set "Arrowhead". 

Select one from the following three types to add the arrowhead. 

 
Solid 

No Yes 

 
 

Start End Both  
Add an 
arrowhead to the 
start angle side. 

Add an 
arrowhead to the 
end angle side. 

Add arrowheads to the both start and end angle sides. 
The right figure shows the example of the solid figure. 

 



 

350 

S
etting Inspection C

onditions 
C

h. 4 

Character 
Displays a maximum of 16 one-byte characters such as inspection results of checkers and system values.  
Set the characters to display, display position, character size, number of digits and alignment. 

Specifying Characters to Display 

1. Select “Display Character” in “Character” setting window. 

A list of available items is displayed. (The items displayed in gray 
indicates that they are not unset.) 

 
The data that can be set for each item is as follows. 
Checker: Comment of each checker, Inspection 

result (*Same as the items that can be 
input in Numerical Calculation) 

Geometry Calculation: Comment, Inspection result 
Numerical Calculation: Comment, Inspection result (Previous 

value is selectable.) 
Judgement: Comments of JRC(Internal), 

JDC(External), Judgement 
System values: Inspection time, Inspection frequency, 

Total judgement, Scan count, Type No. 
System Register: System Register 0 - 7 
Slice Level: Maximum and Minimum values of each 

slice level group 
Text: Character string up to 16 (one-byte) 

characters 
With "PVWIN200", you can input the 
characters that not on the software 
keyboard. 

 

 
 

2. Select characters to display from the list. 

After the selecting is completed, the detail of 
the displayed characters is shown in the 
upper part of the screen window.  

 
 

Character Size and Display Base 
 

About Character Size 

Specify the vertical size of a character in the 
range of 14 to 280 pixels by 14. This size 
includes the vertical size of the character, top 
and bottom margins. 
As shown in the right figure, the horizontal and 
vertical sizes of two-byte characters are the 
same, however, the horizontal size of one-byte 
characters is a half of the vertical size. 

One-byte 
characters 

Two-byte  
characters 

 

Character 
size 
14 to 280 

7 to 140 
Character size x 1/2 

 14 to 280 
Character size 

 

About Display Position 

Coordinate X, 
Coordinate Y 

Refer the coordinate values detected by each checker, results of numerical calculation or 
values stored in the system registers, or specify specific positions with values or the cursor. 

It is also possible to refer the coordinate of the characters that have been set for the 
currently setting Character/Figure Drawing checker. However, only the character coordinate 
that has been set to the smaller number than the currently setting number can be referred. 
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Display Base When displaying a string in a specified position, the top 
left point of the string is placed on the specified coordinate 
value. This point is called "Display Base". It is selectable 
from nine points including Top Left. 

 

  Differences in the display positions among display bases 
Example) When setting Coordinate X and Y to the center of the screen 

 Display Base =Top Left Display Base = Center 

 

 
Offset It is used to move strings from Coordinate X and Coordinate Y for a certain amount to 

display. The amount of moving strings is called "Offset" and the unit is "Offset Unit". 

Select either "Characters" or "Pixel" for Offset Unit. When the offset unit is "Characters", a 
one-byte character of the size specified in "Character Size" is counted as  one character. 

 
Offset X: 0 Offset X:2 

 

 

 

 

 

 

1. Select the table to set the coordinate X and Y, and move the cursor 
onto "Coordinate X" and press the ENTER key. 

A list of available items is displayed. (The checkers displayed in gray 
indicates that they are not unset.) 
For details of selectable reference items, see page 353. 

 

2. Select the item to input in Coordinate X from the list of the 
selectable items. 

When "Character" has been already created in the number smaller than 
the currently setting figure number, the coordinate of that character can 
be referred. 

 
 

About the items that X and Y-coordinates are input together (page 344)  

3. Set "Coordinate Y". 

4. Set "Character Size". 

Settable Range: 14 to 280 
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5. Set "Display Base". 

Select from nine points (the encircled positions in the right figure), which 
are eight points on the circumscribing rectangle of the characters 
(including margins) and the center point.  
Top Left (Default) / Top Center / Top Right / Left Center / Center / Right 
Center / Bottom Left / Bottom Center / Bottom Right 
 

 
When the displayed characters are numerical values, the size of the 
circumscribing rectangle of characters depends on the "Digit Count" 
optionally set. 

 

 

6. Set "Offset Unit", "Offset X" and "Offset Y". 

The settable offsets X and Y are as shown in the 
right table. 

   
Offset Unit Offset X Offset Y 

Character ±292 ±146 

Pixel ±2048 ±2048 

 
 

Optional Settings for Display Method 
The following options are available depending on created display characters.  Set as necessary. 

 

Judge Display: "1/0/E" (Default) / "OK/NG/ER" 
When Display Character is Judgement, select either values or 
characters to display the judgement. 

 

Digit Count: 1 to 15 
Set when Display Character is numerical values. 
Specify the digit number that is over the displayed values. 
Set the total digit number including the symbol for negative values, 
decimal point for actual values and the number of decimal places. 

 
 

When the digit number of the displayed value exceeds the specified 
digit count, all the digits are displayed as asterisks "*". 

 

Decimal Digit: 0 to 3 
Set when Display Character is actual values. 
When the specified digit number is smaller than the number of decimal 
places for the displayed value, the value is rounded to the specified digit 
number. 
Example) When Display Character is 100.125 and Decimal Digit is 2, 
the displayed value is "100.13". 

 

Alignment: Left (Default) / Center / Right 
Set when Display Character is numerical values. 
Select the alignment of characters when the displayed characters are 
smaller than the specified digit count. 
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A list of the Data Can Be Referred to Figure 
 

  Coordinate X, Y  Width, Height  Angle 

PAC: Position Adjustment  Yes 
Base Position Coord. 
Detect Position Coord. 
Base Coord. (Detect 
Coord. of Base Checker) 

 ×  Yes 
Base Position Angle 
Detect Position Angle 

AUC: Area Size Adjustment  Yes  ×  × 
BEC: Binary Edge  Yes  ×  × 
GEC: Gray Edge  Yes  ×  × 
FEC: Feature Extraction  Yes 

Center of Gravity Coord. 
Circumscribing 
Rectangle Coord. 
(Upper left, Upper right, 
Lower left, Lower right) 

 ×  Yes 
(Principal axis angle) 

SMC: Smart Matching  Yes  ×  Yes 
CMC: Smart Matching  Yes  ×  Yes 
FWC: Flaw Detection  Yes  ×  × 
CGE: Connector (Gray 
Edge) 

 Yes 
Area 0 
Area 1 (*a 

 ×  × 

SEC: Smart Edge (Circle)  Yes 
Center Coord. 0 
Center Coord. 1 (*b 
Cell Individual Result 0 
Cell Individual Result 1 
(*c 

 ×  Yes 
Max. Angle 
Min. Angle 

SEL: Smart Edge (Line)  Yes 
Max. Measurement 
Coord. 
Min. Measurement 
Coord. 
Line0 Start Coord. 
Line0 End Coord. 
Line1 Start Coord. (*b 
Line1 End Coord. (*b 
Cell Individual Result 0 
Cell Individual Result 1 (*b 

 ×  Yes 
Line 0 Angle 
Line 1 Angle (*b 

GGC: Geometry 
Calculation 

 Yes  Yes 
Distance/Radius/Major 
Axis/Minor Axis 

 Yes 

CAC: Numerical Calculation  Yes  Yes  Yes 
OCA: Numerical 
Calculation (Previous 
Result) 

 Yes  Yes  Yes 

Character Coordinate (*d)  Yes 
(Character coord. of 
Character/Figure 
Drawing) 

 ×  × 

System Register  Yes  Yes  Yes 
Constant  Yes  Yes  Yes 
Cursor  Yes  ×  × 

*a) When selecting "Gap" or “Float" in "Execution Mode" 
*b) When selecting "Measure Width" in Detect Mode 
*c) When selecting "Measure Width" or "Measure Diameter" in Detect Mode 
*d) Only when Figure = Character 

 
The checker with a camera number different from that selected for the setting Character/Figure Drawing 
checker cannot be referred. 
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4.15 Checker List 
This function shows setting status and execution result of the checkers, position adjustments, area size 
adjustments, numerical calculations, judgements and character/figure drawing. To change the settings of them, 
you can jump to the setting window from this window. 

In this function, all displayed items in the table are called “checker” including position adjustment, judgement 
and character/figure drawing as well as the general checkers. 

Displaying Checker List 

1. Select "INSPECTION" from the menu bar. 

 

2. Tilt the ENTER key right and select 
displayed “Checker List”. 

The checker list is displayed. 

3. Press the TRIG key. 

A test is executed and its result appears on the 
screen. 

 
When a live image is displayed on the screen, 
PV captures a new image first and runs a test. 
When a memory image is displayed, it runs a 
test using the current memory image without 
capturing any images. 

Checker Pattern displayed on Screen Window 
 

High transparency setting of the SETUP menu allows 
an image or checker patterns on the screen window, 
which is overlapping with the window of Checker List, 
to be seen. 

When its camera setting is the same as that of the 
image currently displayed on the screen window, the 
checker pattern selected in the checker list is displayed 
in orange. 

The condition to display the checker patterns for 
checkers other than the selected checker is determined 
by the setting of "Pattern Display" in the Image Menu. 

Refer to page 146 for the details of setting procedure.  
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Overview of Checker List 
 

 
 

1. Checker information 

It displays the information of the checker selected in Checker List described in 2. Selecting the checker 
outputting the judgement of which is error (“E”) shows detail of the error in the field of A in the figure above. 

 

2. Checker List 
 

a: Checker No. 

Fifty checkers are displayed per page. (e.g. No.000 - 049) To display checkers after No.050, tilt the ENTER key 
left/ right. Tilting the ENTER key and pressing the SHIFT key switches pages. 

 

b: Checker type 

The checkers are displayed in symbols. It displays Position adjustment on the top line and Judgement (output) 
on the bottom line. 

Checker type is displayed in the area of 1. Checker information. 
 

c: Setting status and Execution result 

This field shows the setting status and the execution result of the checker type and checker No. of the selected 
cell in the following symbols and colors(*). You can change the displaying colors. 

 
Blank: Unset 

“1” (Green): Already set, Judgement: OK 

“0” (Pink): Already set, Judgement: NG 

“E” (Red): Already set, Judgement = Error 
Error information is displayed in the “A” field of the checker information 
display area. 

Highlight Color (Yellow): In some cases, selecting the cell of Position Adjustment (PAC) displays some 
other cells in yellow. This indicates that the PAC that you are selecting is 
adjusting the checker displayed in yellow. 
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Changing Checker Settings  
(Jump to Setting Window) 

After running a test by the TRIG key on the Checker list window, you can jump to the setting window from it the 
Checker List to change or refer to the checker setting. 

1. Tilt the ENTER key up/down on the Checker 
list window to select the checker list. 

 
 

 
 

2. Select a cell of the checker type and No. to 
change the setting. 

The setting window of the selected checker 
appears. 

3. After setting is completed, press the CANCEL 
key. 

It returns to the checker list window. 
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4.16 Outputting Inspection Results to the External Device 
PV200 has features of outputting judgements of inspections and results of numerical calculations through 
the I/O terminal block, and the ports, and writing them in an attached SD memory card.  In addition, captured 
images can be saved in a PC through Ethernet port and written in an attached SD memory card. 

 

Multiple data can be output to multiple destinations. For example, a judgment is output to the I/O terminal 
block, a result of numerical calculation is output to a PLC through the COM port, and an inspection image 
is output to a PC through Ethernet port at the same time. 

 

These settings are set in “Input/Output” setting window. 

Displaying the Input/Output Setting Window 

1. Select "ENVIRONMENT" from the menu bar. 

2. Select "Input/Output". 

“Input/Output” setting window is displayed. 

 

4.16.1 Outputting through Parallel I/O 

Scan count, Judgement and result of numerical calculations can be output to the parallel I/O terminal 
block. 

Outputting a Result of Judgement Expression 

 
 Judgement that can be output is JDC (External output register). JRC (Internal register) cannot be output. 

 When outputting a Judgement result while you inspect in "Automatic Switch" mode, PV outputs the 
result of only the block executed lastly. 

Outputting Judgement No.0-7 
When execution mode is "Execute All", Judgement No.0-7 are output to the "OUT0-7" of the I/O terminal 
block. 

When execution mode is “User-Defined” or “Automatic Switch”, 8 points are output to the “OUT0-7” of the 
I/O terminal block in ascending order from the smallest number of judgment of the executed block or the 
last executed block respectively. 

1. Select “Parallel I/O Output” in 

“Input/Output” setting window. 

2. Select “Once, Judgement(8 bit)” for 

“Output Data”. 
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3. Set “Output Signal Guarantee Time”.  

Settable range is 1 - 1000 ms. (Default: 10 ms) 
After outputting OUT signal and TACT signal, PV200 holds to output for the time specified in the item.  
TACT signal turns off after the specified time passes. (Whether OUT signal is held or reset depends on 
the setting in “System Settings” > “Operation” > “Parallel I/O Output Reset Condition”.) 
For more details, refer to Chapter 10.3 Timing Chart, page 562. 

 

Outputting All Judgement (JDC) That Have Been Set 
Results of setting judgement expressions can be output (up to 1000 data). 

Using “OUT0-7” of data of the I/O terminal block, the results are output divided in 8-point unit. As a timing signal 
of data communication, STROBE signal of I/O terminal block, or STROBE signal and ACKNOWLEDGE(ACK) 
signal are used. (To use ACK signal, it is necessary to assign the function to ASSIGN or EXTRA signal in 
“ENVIRONMENT” >  “Input/Output” >  "Parallel I/O".) 

 
About output timing of signals, refer to Chapter 10.3 (page 562). 

1. Select “Parallel I/O Output” in 

“Input/Output” setting window. 

2. Select “All Selectable” for “Output Data”. 

3. Set “Judgement” to “Output”. 
 

4. Set “Handshake”. 

Handshake is to output data while communicating completion signals of sending and receiving with 
external devices. 

 
“Yes”:  As a data output completion signal, STROBE signal is used and as a signal to receive a data 

receive completion signal of external devices, ACK signal is used. 
“No”:  As a data output completion signal, STROBE signal is used. Not using ACK signal, the next 

data will be output after a certain period of time. In this method, PV200 does not confirm 
whether the external device has received data or not.  

 
 

"Data Bit” is a parameter for outputting Numerical Calculation and Scan Count. If you output only 
Judgement, it is not necessary to set. (The setting value of Data Bit does not influence the output result of 
Judgement.) 

5. Set “Output Signal Guarantee Time”. 

Settable range is 1 - 1000 ms. (Default: 10 ms) 
 

When Handshaking is not employed: 
  OUT signal is output in the doubled cycle of the time specified in this item. 
When Handshaking is employed: 
  After handshaking of the first inspection, output of the second inspection is not executed during  
  "Output Signal Guarantee Time".  

6. Set "Timeout (ms)" when you employ handshake.  

Settable range is 4 - 2000 ms. (Default: 5000 ms) 
Specify maximum time from data output to ACK signal (data receipt completion signal) input from the 
external device. If ACK signal is not input within this period, a time error occurs and ERROR signal is 
output. 
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Output Example when outputting only Judgement 

Output Data Assignment in the case of “8 bit” (1000-data output) 

 OUT7 OUT6 OUT5 OUT4 OUT3 OUT2 OUT1 OUT0 

 
1st JDC007 JDC006 JDC005 JDC004 JDC003 JDC002 JDC001 JDC000 

 
2nd JDC015 JDC014 JDC013 JDC012 JDC011 JDC010 JDC009 JDC008 

: 

125th JDC999 JDC998 JDC997 JDC996 JDC995 JDC994 JDC993 JDC992 

 
Until the last number of data which has been set a judgement expression, data will be output. For example, 
when No.0-5 and No.14 are set, No.0-14 are output and after No.16 is not output. No.6-13 and 15 are output as 
OFF. 

In the case of Execution Mode = Automatic Switch 

(When the lastly executed block = Block No.3) 
 

 OUT7 OUT6 OUT5 OUT4 OUT3 OUT2 OUT1 OUT0 

1st: Judgement result of Block No.3 

 JDC 
307 

JDC 
306 

JDC 
305 

JDC 
304 

JDC 
303 

JDC 
302 

JDC 
301 

JDC 
300 

: 
Afterwards, outputs to the last number of judgement expression created 
in Block No.3. 

 
*Only the results of the block executed lastly are output. 
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Outputting Scan Count and Numerical Calculation 
Scan Count and Results of Numerical Calculations can be output to “OUT0-7”of the I/O terminal block dividing 
in multiple times. 

 
 Numerical Calculations can be set to output or not for each expression. Only the expression that is set to 

“Output” is output. 

 Numerical calculation results to be output are integers only. A number with a decimal point is rounded off 
to the nearest whole number. 

 The output order is Scan Count -> Judgement -> Numerical Calculation. 

 When outputting a numerical calculation result while you inspect in "Automatic Switch" mode, PV 
outputs the result of only the block executed lastly. 

 
About output timing of signals, refer to Chapter 10.3 (page 562). 

1. Select “Parallel I/O Output” in 

“Input/Output” setting window. 

2. Select “All Selectable” for “Output 

Data”. 

3. To output Scan Count and Numerical 
Calculation, select “Output” for them.  

4. Set “Data Bit”. 

Select it depending on the maximum value of output data. 
 Value that can be output  

[8bit]: 0 to 255 

[16bit]:(default) 0 to 65535 

[32bit]: -2147483648 to 2147483647 
*Negative values are output in the complement number of 2.  

 
 

When selecting “8-bit” or “16-bit”: 
• Negative values cannot be output. If the values are negative, the result is output as “0”. 
• The data exceeding the output range (8-bit or 16-bit) will be output as value of “0”. 

Example) When “Data Bit” is 32-bit, it outputs by 8-bit in four divided data from lower bit. Refer to the next 
section. 

5. Set "Handshake” and “Output Signal Guarantee Time (ms)”. 
When you employ handshake, specify “Timeout (ms)”. 

See the section of "Outputting All Judgement (JDC) That Have Been Set”, page 358. 
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Example of Bit Assignment when outputting numerical data 

In the case of Data Bit: 32-bit, Bit Width: 8-bit 

 OUT7 OUT6 OUT5 OUT4 OUT3 OUT2 OUT1 OUT0 

1st 

 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

2nd 

 Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 

3rd 

 Bit23 Bit22 Bit21 Bit20 Bit19 Bit18 Bit17 Bit16 

4th 

 Bit31 Bit30 Bit29 Bit28 Bit27 Bit26 Bit25 Bit24 

 

Example of Output Data Assignment in Automatic Switch 
execution mode 

In the case of outputting Numerical Calculation with Data bit: 8-bit 
(When the lastly executed block = Block No.4) 

 OUT7 OUT6 OUT5 OUT4 OUT3 OUT2 OUT1 OUT0 

1st: Numerical Calculation CAC400 

 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

2nd: Numerical Calculation CAC401 

 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

: 
Afterwards, outputs to the last number of numerical calculation expression created in Block 
No.4 and set to output. 
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Example of Output Data Assignment 

Scan Count, Judgement, and Numerical Calculation output with Data bit: 16-bit 

Scan Count = 100, Judgement=JDC000-14(15 points), Numerical Calculation CAC000=7000 
 

 OUT7 OUT6 OUT5 OUT4 OUT3 OUT2 OUT1 OUT0 

1st (Lower 8 bits of Scan Count) 

 0 1 1 0 0 1 0 0 

2nd (Higher 8 bits of Scan Count) 

 0 0 0 0 0 0 0 0 

3rd (Judgement 0-7) 

 JDC 
007 

JDC 
006 

JDC 
005 

JDC 
004 

JDC 
003 

JDC 
002 

JDC 
001 

JDC 
000 

4th (Judgement 8-14) 

 0 JDC 
014 

JDC 
013 

JDC 
012 

JDC 
011 

JDC 
010 

JDC 
009 

JDC 
008 

5th (Lower 8 bits of CAC000) 

 0 1 0 1 1 0 0 0 

6th (Higher 8 bits of CAC000) 

 0 0 0 1 1 0 1 1 
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4.16.2 Outputting to COM Port/ Ethernet Port/ SD Memory Card / FTP Server 

Specify a type of output data, destination and output condition. 

Data That Can Be Output 
 Date and time*: The date and time of the execution of an inspection is output. 

 Scan Count: 0 - 2147483647 

 Total Judgement: 1 (OK) or 0 (NG/Error)  
Regardless of “No. of Digits” setting, 1-digit data is output per judgement. 

 Result of Judgement Expression (up to 1000 points): 1 (OK) or 0 (NG/Error)  
Regardless of “No. of Digits” setting, 1-digit data is output per judgement. 

 Result of Numerical Calculation (up to 1000 data): -214783648.000 to + 2147483647.000. 

 BCC (Block check code) 
 

 
The settings for the above six items (Output; "Yes" / "No") are common to all the destinations (Serial / 
Ethernet / SD Card / FTP). 

Scan Count will be automatically reset and return to "0" when you turn off the power of PV200 or switch types. 
In addition, resetting statistics data by I/O input or command input resets Scan Count as well. 

Output Destination 
 

Serial: 

To output to COM port. With certain PLCs, you can make “PLC communication” which allows to write data in a 
register of PLC directly. To output data through PLC communication, the following setting should be done; 
"ENVIRONMENT" > "PLC Communication" > "Communication Type"; [Serial] 

 Refer to page 618 about PLC communication. 
 

Ethernet:  

Through Ethernet port, data can be received with PC or PLC.  
(TCP/IP connection is established with PC or PLC as “TCP/IP client” and with PV200 as “TCP/IP server”.)  

With certain PLCs, you can make “PLC communication” which allows to write data in a register of PLC directly. 
When you use a PC, prepare Hyper terminal or Telnet software. PC or PLC is needed to be in the status where 
they can always receive data. 

Date and time can be added to the header of data to output. 

To output data through PLC communication, the following setting should be done; "ENVIRONMENT" > "PLC 
Communication" > "Communication Type"; [Ethernet] 

 

 In this case, the port number of PV200 is “8601”. 

 Refer to page 453 for information of TCP/IP settings. 
 

SD Memory Card:  

To write data on a text file in a SD memory card attached to the memory card slot of PV200. 

Time can be added to the header of data to output. 

The name of a text file to write data on and saving path are as follows. 
 File name: nnn_yymmdd.txt (nnn is a type number (000-255). yymmdd is read from information of the 

built-in calendar of PV200.) 

 Path: /Panasonic-EW SUNX Vision/PV200/Result/ 

  
 A new result output file in a SD memory card is created when the first result is output on the day. 

(Even if the reboot is performed several times on the same day, a new file will not be created.) 

 A new file is created when the following conditions are met. However, when a file name to be saved 
already exists, data is additionally written into the file. 



 

364 

S
etting Inspection C

onditions 
C

h. 4 

- When the date and date display setting of PV200 is changed 
- When the type switch is executed 

 

FTP server:  
The FTP client function is available from Ver.2.0 so that the general output and image output can be 
performed to FTP server. 
For using this function, make the FTP client setting in advance. "ENVIRONMENT" > "Input/Output" > "FTP 
Client" 

 FTP client function: page 443 

These settings are set in “General Output” setting window. 

Displaying General Output Setting Window 

1. Select “ENVIRONMENT” >  “Input/Output” 

from the menu bar. 

2. Select “General Output” in “Input/Output” 

setting window. 

 

Selecting Destination and Output Data 

1. Select a data destination in “Output”. 

You can select multiple interfaces as destinations. 
 

For PLC communication, either “Serial” or “Ethernet” can be selected. Refer to page 618 about PLC 
communication. 

2. To output Date and Time, select “Yes”, 

When "Reinspection" is executed, the time at 
the time an inspection was executed (when an 
image was captured and an inspection is 
executed) is output. 

3. To output Scan Count/ Total Judgement/ 
Judgement/ Numerical Calculation, select 
“Yes”. 

 
 

 
When the destination is "Serial" or "Ethernet (PLC) 
Communication", the following setting should be 
done; "ENVIRONMENT" > "System Settings" > 
"Date/Time of General Output" is set to "Yes". 
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4. To output BCC (block check code), select “Yes”. 

BCC cannot be added when the destination is "SD Card" or "Protocol" is "PLC Communication". 
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Specifying Digit Number of Output Data 
In general communication, real numbers (values including after decimal point) can be output. Set the digit 
number of integer and after decimal point. 

1. Specify total digits of integer part and after decimal point in 
“No. of Digits”. 

2. In “Decimal Digit”, specify digits for after decimal point used 
from the digits set in step 1. 

The outputs specified in "No. of Digits" are "Scan Count" and 
"Numerical Calculation" only. If you set “No. of Digits” = 14 
(default) and “Decimal Digit” =3 (default), the value consisting of 
11-digit integer and 3-digit decimal number is output. If you set 
“Decimal Digit” = 2 or 1, the value is rounded. 

 

 

 
When the value exceeding the specified digits is processed, the value is output as “0”. 

3. Set "Unused Digit". 

If the digit number of the data is less than the output digit number you have set, select a handling of 
unused digit. 
Comma Separated: Unused digits are deleted. Multiple data are output in different number of digits . 

Data are separated with a comma (",") before being output. 
Filled with '0' (default):  Unused digits are filled with “0”. Although the data become longer, multiple data 

are output in the same number of digits. 

Example of General Output to SD Card 

 For the details of general output to Serial or Ethernet, refer to "Example of General Output 

" (page 596). 
Output Data: Date: 

Time: 
Scan Count: 
Total Judgement: 
Judgement: 
Numerical Calculation: 

2010/12/15 
09:25:48 
1234 times 
OK 
JDC000 = OK, JDC001 = unset, JDC002 = NG 
CAC000 = 215.8, CAC001 = unset, CAC002 = -368.0 

Output Condition: Date and Time: 
No. of Digits: 
Decimal Digit: 
Unused Digit: 
BCC: 

Output (Only time is output when Destination is SD card) 
6 
1 
Filled with ‘0’ 
Output (Not available when Destination is SD card) 

 

Output destination=”SD card”: 

0 9 : 2 5 : 4 8 0 0 1 2 3 4 1 1 0 0 0 2 1 5 8 - 0 3 6 8 0 CR 

                              Time Scan Count Total 
Judge. 

Judgement Numerical 
Calculation 0 

Numerical 
Calculation 2 

 

 
Judgement JDC001 and Numeric Calculation CAC001 are not output because they are unset. 
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4.17 Saving/ Outputting an Inspection Image 
Captured inspection images can be saved in PV200, output to a PC through Ethernet, or saved in an attached 
SD memory card. Also, you can read the images to change the checker settings and run a test. 

Images that can be output/saved are images captured by gray or color camera. (Preprocessed images cannot 
be output.) 

4.17.1 About Image Memory 

PV200 has multiple image memories including the memory to store camera capturing images for inspection 
and the one to store images for settings. In addition, you can output and save images to a SD memory card or a 
PC connecting with the Ethernet port. 

Storage Space of PV200 and External Devices to Store Images 

PV200  

 1 Inspection image 
memory 

The memory to store images captured by camera. Inspection executes on the 
images. 

 2 Test image memory An image in this memory is copied from the latest image of Inspection image 
memory. The image is used to make checker setting. Setting display image 
to “Memory” in SETUP menu shows the test image. 
You can call up the images from the Save image memory (No.3 below) and a 
SD memory card (No.4, 5 and 6 below) to set checkers and execute a test. 

 3 Save image memory This memory saves all or some of images stored in the Inspection image 
memory during inspections. Up to 150 sets* of images can be saved. Images 
are saved during inspections according to the preset conditions. 

SD memory card  

 4 Image/Output The images stored in the Inspection image memory (No.1 above) are saved 
in this place when outputting them to a SD memory card during inspections. 

 5 Image/Backup/Test The images stored in the Test image memory (No.2 above) are saved in this 
place. You can save them only when an inspection is stopped. 

 6 Image/Backup The images stored in the Save image memory (No.3 above) are backed up in 
this place. 

 7 Any Any folders in a SD memory card including the above 4, 5 and 6. A test can 
be executed by reading any bitmap image or bayer image which is up to 
one-byte 79 characters.  

Ethernet (PC etc.)  

 8 The folder specified 
by Image Receiver 

The images stored in the Inspection image memory (No.1 above) can be 
output in Ethernet port during inspections. In this case, the PC requires the 
designated software "Image Receiver" which specifies a destination folder.  

 9 The folder specified 
in FTP server 
(Available from 
Ver.2.0) 

The images stored in the Inspection image memory (No. 1 above) can be 
output to FTP server via Ethernet during inspections using the FTP client 
function*2) of PV200. 

 
For information on the setting of destination of print screen, refer to section 3.2.5 (page 68). 

*1) The number of sets of images can be saved varies depending on the combination of camera type and the 
number of them. Refer to the table below. 

 
Connected camera and Number of storable images 

 "-" in the above table shows a combination of two cameras is not available.  

CAMERA 1 
 

CAMERA 0 
Unconnected 

Gray Color 

0.3M 2M 4M 0.3M 2M 

Gray 
0.3M 312 150 32 - 150 32 
2M 39 32 13 - 32 13 
4M 14 - - 1 - - 

Color 
0.3M 312 150 32 - 150 32 
2M 39 32 13 - 32 13 
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 When CAMERA1 is unconnected, the number of storable images is shown. 
When CAMERA1 is connected, the number of sets of storable images is shown.  

 
*2）For details of the FTP client function, refer to "6.3.5 FTP Client Function" (page 443). 
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Image Memory Map 

PC etc. PV200 SD memory card 

(//Panasonic-EW SUNX Vision/PV200/Image/) 

 
 
*1) The number of sets of images can be saved varies depending on the combination of camera type and 
the number of them. Refer to the previous page. 

 

   

 
: Chapter4.17.2, page 370 

 
: Chapter 4.17.4, page 376 

 
: It is automatically copied when switching 
"RUN Menu" to "SETUP Menu".  

: Chapter 4.17.4, page 378 

 
: Chapter 4.17.3, page 375  

 
: Chapter 4.17.4, page 376 

 
: Chapter 4.17.4, page 376 

 
: Chapter 4.17.4, page 376  

 
: Chapter 4.17.3, page 375  

 
: Chapter 4.17.4, page 376  
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4.17.2 Outputting Inspection Images to External Device 

Displaying “Image Output” Setting Window 

1. Select “ENVIRONMENT” >  “Input/Output” from the menu bar. 

2. Select “Image Output” in “Input/Output” setting window. 

Selecting Destination 

1. Select "SD Card", "Ethernet" or "FTP" in 
"Destination". 

 

 

 

 
When outputting through Ethernet to a PC, the port number of PV200 is “8602”. 
Ver.1.30 or later of the software for image receiving "Image Receiver for PV" needs to be installed in the 
PC which receives images. Also, to receive compressed images, Ver.1.50 or later of "Image Receiver for PV" 
is required. 
You can download the Image Receiver from our web site.  

http://panasonic.net/id/pidsx/e 

(“Products” > “Machine Vision System” > “PV200” > “Software”) 

Downloading the software requires a user information registration. 

Selecting Output Condition 
Other than outputting by an inspection, images can be output when the specified conditions are fulfilled. 

 
Even when "Output Conditions" is set to "All Images", a saved image may be overwritten with another 
image and all of the image data that should be output may not be saved.  

 

As image data is overwritten under the following conditions, note that when you need to save all image 
data. 
 When "Overwrite" is set to "Yes" for the saving condition of SD memory cards. (When "Overwrite" is set 

to "No", the image output stops.) For details of the condition of overwrite save, refer to page 374. 

 When the scan count is reset and the image file name output before the reset matched the image file 
name output after the reset. (The condition that the scan count is reset to zero: When the power is 
turned on again, type is switched, or statistic data is reset) 

It is possible to prevent the same file names by adding time or type number to the additional information of file 
names. For details of the additional information of file names, refer to page 371. 

1. Select a condition to output images in “Output Condition”. 

[All Images](default): Images are output at every inspection. 
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[NG Judgement]: To output all images of the cameras which are set to output when the 
judgement selected in “Image Output” in “Judgment” is NG.(Refer to page 
334.) 
If any condition is not specified, no image is output. 

[At Interval]: Images are output per the specified number of inspections. 

[Command Reception]: Images are output when receiving the certain signal* from external device.  
* The signal of “Output Latest Image” assigned to one of ASSIGN0-1 and 
EXTRA0-2. 

[Judge. Per Cam.] To output images when the judegment selected in “Image Output” in 
“Judgment” for each camera is NG. (Refer to page 335.)  
Images are output each time when selecting "No Condition" for "Image 
Output". 
If "Destination" is set to "None", no image is output. 
Judgement formula which is used as output condition can be specified per 
camera. As only the images of the camera the result of which is NG can be 
output, the transmission time of images and the image capacity can be 
reduced. 

2. Set an interval in “Interval”. 

(This is the item to set when you select "At Interval" in Step 1.) 
The range of available value is 2 to 10000. 
Specifying “10” outputs an image at the first inspection, and then outputs every ten inspections as 11th time, 
21st time, 31st time… 

Selecting Output Timing 
Set the timing to output images in "Image Output". 

Select from "Synchronous" (default), "Asyn. (image output first)", and "Asyn. (sequence first)".  

There are two settings; to output images every time one inspection is executed, to output images while PV200 
is able to output them until the start of the next inspection. 

Refer to page 431 for details. 

Specifying a Camera Image to Output 
You can set images to output or not by a camera. 

1. Select “Yes” in "Camera No.0 Output" of “Image Output”. 

Doing so makes setting that an inspection image of camera No.0 is output.  

2. In the same way, set a Camera No. to “Yes” to output its image. 

Selecting Additional Information for a File Name 
A file name of image consists of the following information. 
Header: Up to eight characters can be specified. 

Additional information 0-5: Six types of information can be added. 

 Type No.: Type No. (000 - 255) when the image is captured. 

 Date: The date (yymmdd) of built-in calendar of PV200 when the image is captured. 

 Time: The time (hhmmss) of built-in calendar of PV200 when the image is captured. 

 Total Judgement: Total judgement of the image (OK/NG) 
･Total judgement is other than OK/NG, such as NJ = Unset 

 Judge. Per Cam. 
(Result): 

Judgement of the image per camera （CJNJ /CJ NG / CJAL） 
･CJNJ = When "Output Condition" is other than "Judge. Per Cam.” 
･CJNG = When "Output Condition" is "Judge. Per Cam.” 
･CJAL = When "Image Output" set in Judgement is "No Condition” 

 *JRC/JDC(Result): Judgement of the image (0 / 1/ E) 
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･0 = NG ･1 = OK ･E = Error or the specified JRC/JDC No. does not exist. 

Camera No.: C0 – C1 (2 digits) Number of the camera which captured the image. 
(Automatically added) 

Scan Count:  Scan count: 7 digits (Automatically added) 
 

Scan Count is reset to “0” by turning on the power, switching type, and resetting 
statistics data. If the file name of the image to be output after reset is the same 
as the file name that has been output before reset, it will be overwritten.  Adding 
time or type number to the additional information prevents the file names to be 
the same.) 

*Available from Ver.1.9 

1. Select "Set" in "Image file setting", and enter 
"File Header" with the software keyboard. 

Default: “Image_” 

2. Select an item from five types for “Additional 

Information 0” to “Additional Information 5”. 

Select "None" when no additional information is 
needed. 

 Example) 
Setting and Condition: File Header: Image_ 

Additional information 0: Type No. (=50) 
Additional information 1: Date (=20101215) 
Additional information 2: Total Judgement (=NG) 
Additional information 3: Judge. Per Cam. (=NG) 
Additional information 4: JRC/JDC (=NG) 
Additional information 5: None 
Camera No.0 
Scan Count 100 

File Name: Image_050_101215_NG_CJNG_0_C0_0000100.bmp 

 
・Maximum number of digits for a file name is 50. 
・When select “JRC/JDC” for additional information, set ”Type(JRC or JDC) ” and that number. 
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Selecting Compression Rate of Output Image  

1. Select from "None", "1/2", "1/4" and "1/8" in 
"Compression". 

 
 
 

Compression 
rate Captured image size Output image size Output time 

 
 None 

• 640 x 480 pixels (*a 
• 1600 x 1200 pixels 
• 2048 x 2048 pixels 

• 640 x 480 pixels 
• 1600 x 1200 pixels 
• 2048 x 2048 pixels 

Approx. 1/2 of the case 
of "None" 

 
 
 
 

1/2 
• 640 x 480 pixels (*a 
• 1600 x 1200 pixels 
• 2048 x 2048 pixels 

• 320 x 240 pixels 
• 800 x 600 pixels 
• 1024 x 1024 pixels 

Approx. 1/2 of the case 
of "None” 

 
 1/4 

• 640 x 480 pixels (*a 
• 1600 x 1200 pixels 
• 2048 x 2048 pixels 

• 160 x 120 pixels 
• 400 x 300 pixels 
• 512 x 512 pixels 

Approx. 1/4 of the case 
of "None” 

 
 
 

1/8 
• 640 x 480 pixels (*a 
• 1600 x 1200 pixels 
• 2048 x 2048pixels 

• 80 x 60 pixels 
• 200 x 150 pixels 
• 256 x 256 pixels 

Approx. 1/8 of the case 
of "None” 

 

 
Compressed images can be automatically decompressed and retrieved with PV200 and PVWIN200. 
However, note that the resolution deteriorates. 

 

*a) When the used camera is 0.3-Meaga Compact Color Camera (ANPVC6030), the image size is 640 x 478 
pixels, however, the inspection is performed with an image of 640 x 480 pixels. The missing vertical two pixels 
are filled with black pixels (Gray level 0). It is the same state as when partial imaging is set with another camera. 
For the details of Partial Imaging, refer to page 92. 

Selecting a Format to Output Color Images 

1. Select "Bayer Img.  (.byr)" or "RGB Img. (.bmp)" in 
"Color Image Format".  

 

What is Bayer Image? 

Bayer image is an image saved in the same array as an image sensor of a color camera. 
As the file size is small and the time for saving is shortened, you should use Bayer Image to save many images. 

Files saved in this format (.byr) cannot be confirmed with general applications such as a PC.  
Bayer images can be confirmed on PV200, PVWIN200 or PVImageConverter. Its files size is smaller than that 
of RGB image (.bmp). 

 

 
Using PVImageConverter can convert a bayer image (.byr) to a RGB image (.bmp).  

Also, RGB images (.bmp) can be output through Ethernet.  



 

374 

S
etting Inspection C

onditions 
C

h. 4 

Setting Individual Items in accordance with Output 
Destination 

Outputting to a SD memory card 

A folder named as date and time (YYMMDDHHMMSS= year, month, day, hour, minute, second) is created in 
the following path of a SD memory card and image files are saved in it. 

 

/Panasonic-EW SUNX Vision/PV200/Image/Output/ 
 

Initially, decide the number of folders to save images. When using a SD memory card with PV200, it has a limit 
that up to 100 files can be saved in per folder. Thus, the specified number of folders by 100 files can be saved. 
Select either overwriting from older files or terminating image saving when the number of files reaches the 
saving limits. 

1. Select "No. of Folders”. 

The default is “10” and the range of available value is “1 to 1000”. 

2. Set "Overwrite". 

[No] (Default): Terminates image saving. 

[Yes]:  Deletes the oldest folder and all images stored in the folder and creates a new folder to 
continue saving when the number of folders reaches the limit or the space of a SD 
memory card is used up. 

Outputting through Ethernet interface or FTP server 

When outputting images to Ethernet interface or FTP server, the setting of error signal output is made to detect 
disconnection. 
When the PC has an error, such as uninvoked Image Receiver, disconnection of FTP server and disconnection 
of cables, images cannot be output correctly. Set the operation of PV200 in such case. 

When "Output Conditions" is set to "Command Reception", two items described below cannot be selected. In 
this case, if outputting an image failed, ERROR signal will be output.  

1. Set [ERR signal ON at Output Error]. 

To turn on the ERROR signal when an error occurs, select “Yes”. (Default: No) 

2. Set [Forced Outage at Output Error]. 

[No] (Default): Continues the inspection. 

[Yes]:  Terminates the inspection. Confirm the connection following the displayed message. 
When outputting Synchronously, images can be resent. 

*The output to FTP server is available from Ver.2.0. 
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4.17.3 Saving Images in the Image Memory of PV 

The image memory of PV (see page 369, Image Memory Map -  3 ) saves up to 312 images. This image will 
be cleared when you cut the power of PV200. When you need to save the images, back up them in a SD 
memory card or a PC employing PVWIN200. 

 
 The maximum number of saving sets varies depending on camera type and its combination. 
 If the number of saving images reaches the upper limit of the image memory capacity before the number 

becomes the maximum number of sets, no more images can be saved. In the case, it overwrites images 
from older one or terminates image saving. 

 Images are stored from No.0 of Save Image memory in ascending order. The larger image number is the 
more newly saved image. 

 Backing up the images of the Save image memory to a SD memory card and clearing the data of Save 
image memory can be executed also by inputting I/O signal or sending a command from an external 
device. 

- See page 551 about backup by inputting an I/O signal (ASSIGN or EXTRA signal). 
- See page 604 and page 655 about backup/delete by sending a command. 

 

1. Select “ENVIRONMENT” >  “Input/Output” 

from the menu bar. 

2. Select “Save Image Memory” in 

“Input/Output” setting window. 

3. Select a condition to save images in “Saving 

Condition”. 

 
 

 

 

[No] (Default): No image is saved. 

[All]: All inspection images are saved. 

[NG Judgement]: Images are saved when the result of judgement expression specified in “Save 
Image Memory” is NG. (Refer to page 334.) 
If any condition is not specified, no image is saved. 

4. In “Overwrite”, select an operation when the saved images reach the limit of the number or the 
memory. 

[Yes] (default): Continues to save images overwriting the older images. 

[No]: Terminates image saving. (Inspections will be continued.) 
 

5. After setting is completed, press the CANCEL key. 

Backing up Images in Save Image Memory to SD 
Memory Card 

1. Select “SAVE/READ” from the menu bar. 

2. Select “Save Image Memory”. 
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3. Specify a folder number of the SD memory card 
to save. 

000 to 999 are available.  
Specifying it displays a confirming message. 
If you specified the number where image data 
already exists, the message to confirm overwriting 
appears. 

4. Select “Yes”.  

After the saving is complete successfully, a message appears. Press the ENTER key to close. 
The folder specified in the above step 3 is created in the following path, and the image file is saved under 
it. 

¥ Panasonic-EW SUNX Vision ¥PV200¥Image¥Backup 

Clearing Images of Save Image Memory 

1. Select “SAVE/READ” from the menu bar. 

2. Select “Clear Image Memory”. 

A confirming message appears. 

3. Select “Yes”. 

Clearing is executed.  

4.17.4 Operation of Test Image Memory 

The Test image memory (page 369, Image Memory Map - 2) calls up images from the Save image memory or a 
SD memory card in SETUP menu to set checkers and execute a test. 
To operate the Test image memory, use Image Menu displayed by pressing the F1 key in SETUP menu. 

Calling up to Test Image Memory 
The images saved in the following four areas can be called up to the Test image memory. 

 

 Image memory: Read from the Save image memory of PV200. 

 Memory image in SD: Backup images in a SD memory card (folder = /Image/Backup/000-999)  
File name = C0_nnn.bmp, C1_nnn.bmp nnn:000~999 

 Test image in SD: Test images in a SD memory card (folder = /Image/Backup/Test) 
File name = C0_nnn.bmp, C1_nnn.bmp nnn:000~999 

 Output image in SD: 

Images saved in a SD memory card by "Image Output" (folder = 
/Image/Output/YYMMDDHHMMSS (Date and time)) 
File name = Header + Additional information 0-4_C0_nnnnnnn.bmp, 
Header + Additional information 0-4_C1_nnnnnnn.bmp nnnnnnn: Scan 
count 7digits) 

 Select folder Images saved in any folder in a SD memory card 
File name = Arbitrary bitmap image (.bmp) or bayer image (.byr) 
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1. Press the F1 key to display Image menu. 

2. Select "Read Image". 

The window to select the reading source appears. 

 

3. Specify a reading source. 

When selecting "Image Memory in SD", "Output Image in SD" 
or "Select Folder", specify the folder in which an image to be 
read is saved after the specification. 

 
 Folder names saved in the folder ¥Image¥Backup by "Save 

Image Memory" are 000 to 999 (3 digits). 

 PV200 can also read images in folders with 2-digit names 
which made in previous version. 

 However, when 3-digit folder names and 2-digit folder names 
such as "001" and "01" or "015" and "15" exist in the folder 
"¥Image¥Backup", PV200 reads 3-digit folders first. 

 When selecting "Select Folder", refer to "How to Select a 
File When Selecting "Select Folder" described below. 
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4. Select an image number to read. 

As the lastly saved image* appears, change image numbers 
observing the display and specify the desired image number. 

 
(*) The larger image number is the more newly saved image. The 
smaller image number indicates the older image. The image 
number for "Output Image in SD" indicates the scan count. 

 
The date and time that the image was captured or saved and 
inspection information is displayed under the image. 

Captured date 
and time:  

Indicated with letters in black. 

Saved data 
and time: 

Indicated with letters in red when the 
information on the captured data and 
time is not available in the PV200. 

Inspection 
information: 

Indicates the type number, total 
judgement, scan count and execution 
block number when saving an image. 
When there is no information, "---" is 
indicated with letters in red.  

The execution block number is 
indicated as below according to the 
setting of execution mode. 

 Execute All: 0 

 Automatic Switch: Last 
execution block number 

 User-Defined: Executed 
block number 

  
The captured date and time, and inspection information is 
retained even after saving the image memory in a SD memory 
card, and it can be confirmed on the PV200.  
The output image compressed by the setting of "Image Output" 
will be restored automatically to the original size when it is read. 
However, note that the resolution deteriorates. 

5. Select “Read”. 

The specified image is called up. 

 

 
In the following case, a message "Reading image failed." appears, and images cannot be read.  
- When selecting an image number in which there is 

only an image of the camera number that has been 
set to "Unused" for "Camera Type" under "Camera" 
in PV200; 
Example) In the right example, there is only the image 
of camera 1 in Image number 1. If camera 1 has been 
set to "Unused", reading the images cannot be 
performed. 

- When reading a color image for a gray camera or 
reading a grayscale image for a color camera 
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How to Select a File When Selecting "Select Folder" 

1. Select "Select Folder" for "Read from". 

2. Move the cursor to the folder list. 

The list of the folders and files in the SD card is 
displayed. 
 
The location of the folder currently selected is 
displayed in "Path" field. 

 
 The first time selecting "Select Folder", folders and 

file names saved in the PV200 folder 
(¥PV¥Panasonic-EW SUNX Vision ¥PV200) are 
displayed. 

 PV200 memorizes the path at the time an image was 
selected from "Select Folder", therefore, the path 
previously selected is selected when the "Select 
Folder" window is opened. At that time, the cursor is 
located on ".". This indicates "Folder that is currently 
selected". If the read image is saved in this folder, go 
to the next step 4. Pressing the ENTER key on "." 
does not change the path. 

 
 

Folder currently selected 

 

3. Select the folder saving an image to be read. 

Highlight the folder with the cursor, and press the 
CANCEL key. 

 
Do not press the ENTER key for selecting the folder 
to be read. If pressed, PV200 tries to find folders stored 
in that folder. 
 

 
 To go up to the upper hierarchy, select “..”. 

The <dir> in "Size(KB)" column indicates that it is a 
folder. 

 

4. Set "Use Image Header". 

Select whether to use image header information or not. 
No / Yes (Default: No) 
 
This function is used for executing debug by paring 
images of Camera 0 and Camera 1. When the image 
file names are not like "C0_***" or "C1_***", debug is 
executed by finding the camera numbers and images to 
be pair using the inspection information in the image 
files. 
 
For details, refer to “8.2.5 Operation When Using Two 
Cameras (Pair Table)” and “8.2.6 Image Information 
(Image Header)”. 

 

5. Press "Enter" after selecting a folder. 

Press the ENTER key on "Enter". 
 

 



 

380 

S
etting Inspection C

onditions 
C

h. 4 

6. Select an image. 

Thumbnail-size Images in the selected folder are 
displayed. By changing the "Image No." in this 
window, other images in the same folder can be 
confirmed. 
After confirming the images, press the CANCEL key. 
 

 
File numbers can be shifted by 100 using the 
"BEFORE" and "NEXT" buttons. These buttons can 
be used when the number of files is more than 100. 
In the case of 101th image, "1" is indicated beside 
"Image No." and "001" is indicated beside "1". 
Now you completed the specification of the image 
folder to be read. 

7. Select "Read”. 

The specified image is called up. 

 
 

 
 

Saving Images in Test Image Memory to SD Memory 
Card 

The images in the Test image memory can be saved in a SD memory card. 

This operation is useful to pick up necessary images among the images saved in the Save image memory of 
PV200 and to save them. 

1. Press the F1 key to display Image menu. 

2. Select “Save Image”. 

The window to specify a saved image number in 
the SD memory card appears. 

3. Specify the destination number. 

The confirmation message appears. 
This number will be the file name. 

Example: C0_001.bmp 

4. Select “Yes”. 

After the saving is complete successfully, a 
message appears. Press the ENTER key to close. 
The image file is saved in the following folder. 
/Image/Backup/Test 
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4.18 Reading/saving Setting Data (Save/Read) 
The settings set in SETUP menu and RUN menu can be saved. The information existing in the execution 
memory can be saved in the saving memory of PV or a SD memory card except certain data*. This information 
is “Setting data”. 

 
*The data to be specified in [TOOL] > [General] is individual information for each PV200 and saved in the 
different area from the Storage Space of PV200. You cannot save in a SD memory card or copy into another 
PV200. 

Start with Default Settings 

Without loading the setting data of PV200, you can start PV200 with the default settings (execution 
memory initialized). 

1. Press the F1 key and the F3 key on the keypad. 

2. Holding the keys pressed, turn on the power of PV200. 

Until RUN menu appears, hold the keys pressed. 

 

Where to Save the Setting Data 

The conditions in the execution memory are temporarily called up to execute programs and are not saved in the 
memory. 

Regarding types No.0 - 255 as a set of data, PV200 saves the data in “Storage Space in PV200”. The data can 
be saved also in a SD memory card. 

Every time PV200 starts up, it reads saved setting data from the storage space in PV200 or a SD memory card 
to the execution memory. Specify data to be read from "TOOL" > "General" > "Startup Setting". (For details, 
refer to page 453 “7.2.1Specifying Data to be Read to Execution Memory”.) And then, PV calls up a product 
type from the data to set inspection conditions and to execute inspections. 

 
Storage Space in PV200 

(Max. 8 MB) 
 Execution Memory  SD memory card (Max. 32 GB) 

 
 

 
The time taken for saving or reading setting data varies according to the place where the data is saved 
(Storage space in PV200 or SD memory card). 

Reference: Time taken for saving or reading 1M-byte setting data 

 Saving time Reading time 

Storage Space in PV200 Approx. 75 seconds Approx. 1.5 seconds 

SD memory card (8M bytes, CLASS4) Approx. 20 seconds Approx. 2.5 seconds 
* The values in the above table changes depending on the manufacturers or types of SD memory 
cards. 
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The time taken for saving or reading setting data in a SD memory card is shorter. SD memory cards are 
convenient to save or read a large size of data or to save or read them during opera tions. Also, by adding 
comments (Refer to page 383) to the setting data saved in a SD card, you can see the name of the operating 
setting data in RUN menu, and it makes easier to manage data because the entered comments become the 
part of file names when checking files on PC, etc.. 

 

 

 

4.18.1 Saving Setting Data 

This function saves data of 256 product types and environment data set in the execution memory into the main 
memory or a SD card. 

1. Select "SAVE/READ" from the menu bar. 

2. Select "Save Setting Data". 

3. Select “Storage Space in PV200” (or “SD Card”) for 

“Save to”. 

4. Select the list and "No." to save. 

Saving is executed. 

 

 
An overwrite confirmation message appears if data already exists. Select [Yes] to overwrite and [No] to 
save another area.  
 
To stop saving during the process, select "Abort". In this case, the destination area No. will be cleared 
when the destination is the storage space in PV200. When it is a SD memory card, the original data will be 
held. 
 
When saving the data is completed, the saved information is displayed. 
- Size (KB): Size of the setting data 
- Version of the data created: Version of PV200 where the setting data was created 
- Date: Date and time when the data was saved. The information of data and time is referred from the 

calendar of PV200.  
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4.18.2 Entering Comments in Setting Data (Only When Saving Data in SD Card) 

Comments can be entered in the setting data stored in a SD memory card. The entered comments are 
displayed in the information area in RUN menu. 

In SETUP menu 

1. Select "SAVE/READ" from the menu bar. 

2. Select "Save Setting Data". 

 

3. Specify "SD card" for "Save to". 
 

4. Place the cursor on the list of setting data, 
and press the Enter key. 

 
 

 

5. Select the setting data containing the 
comment you want to edit from the list, and 
press the FUNC key. 

6. Select "Edit Comment" in the menu. A 
software keyboard is displayed. 

 

7. Edit the comment and press the Enter key once the input is complete.  

 
For details of character entry method, refer to page 51. 

 
With PVWIN200, you can enter the characters which are not on the software keyboard (such as 
Chinese characters). 
Up to 12 characters (two-byte characters/one-byte characters) can be entered. 

8. The comment is updated. 

 

 
 Although comment editing is not available for the setting data in the main memory, a comment 

column is displayed in the list. 

 The comment information will be displayed in the information area in RUN menu when the setting data 
file is read. 
For details of how to switch between display and hide comment information, refer to page 430. 

 

 
In the case of SD card memory 

 
In the case of Storage space in PV200 

 
In the case of downloading from PVWIN 
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In RUN menu 

1. Stop the operation when PV200 is in the RUN mode. Select "OPERATION" > "Stop RUN Mode" to 
stop the operation. 

 
In the RUN mode, it is not possible to save setting data and edit comments.  

2. Select "TOOL" > "Save Setting Data". 

3. Edit the comment and press the Enter key once the input is complete.  

Edit the comment in the same way as the above case in SETUP menu.  

 
If the comment for the setting data that is being used is edited in RUN menu, the comment information 
will be reflected instantly in the information display area.  

Setting Data Name and Comment 

Example of file name) 

 Set 00  _ XXXXXXXXXXXX .PV2 
      

 Area No.       Comment part 
 
Up to 12 characters (two-byte characters/one-byte characters) can be entered. 
The comment part of a file name can be directly edited with a PC, however, if more than 13 characters are 
entered, the 13th and subsequent characters will be omitted from the setting data list of PV200. 

 

 
 In the list of setting data, one setting data file is displayed per one area.  

When there are setting data files with the same area number in a SD, it depends on the file sys tem 
of PV200 which file is displayed in the list. When there is setting data without comment information 
in the same area, this data is preferentially displayed in the list before setting data with comments. 
(e.g.: Set00.PV2)  

 

 If you want to confirm the setting data that is not displayed in the list, check the information in the 
SD memory card with "SD Property". 

 “7.3.1 Displaying Information of SD Memory Card (page 467)” 

 



 

385 

S
etting Inspection C

onditions 
C

h. 4 

4.18.3 Reading Setting Data 

The setting data registered in the Storage Space in PV200 or a SD memory card can be called up to the 
execution memory. The setting data that has been stored in the execution memory will be overwritten. Before 
reading, save the setting data as necessary. 

 

 
You cannot read the setting data which was created in incompatible version of PV200 with the one you 
use. 

1. Select "SAVE/READ" from the menu bar. 

2. Select "Read Setting Data". 

The setting data reading window is displayed. 

3. Select “Storage Space in PV200” (or “SD card”) for 

“Read From”. 

4. Select the list and the data to read. Reading is 
executed. 

Reading is executed. 
 

To stop reading during the process, select "Abort". In 
this case, the data of Type and ENVIRONMENT will be 
initialized. 

 

 

4.18.4 Deleting Setting Data 

To delete the setting data registered in the Storage Space in PV200 or a SD memory card, follow the procedure 
below. You cannot delete multiple data. Delete one by one.  

1. Select "SAVE/READ" from the menu bar. 

2. Select "Save Setting Data". 

The setting data saving window is displayed. 

3. Select “Storage Space in PV200” or “SD Card” for “Save to” where the data to delete exists. 

4. Select the list and move the cursor onto the 
data to delete. 

5. Press the FUNC key and select “Delete” 

from the displayed menu. 

The pop-up menu appears on the upper left of 
the window (under "Free Space"). 

 

6. Select “Yes” following the displayed message. 

The setting data is deleted. If you select “No”, deleting is not executed. 
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4.19 Displaying Data on the Screen and Updating Settings (Data R/W) 
In RUN menu, inspection results (judgement, data, execution time, etc.), setting values (parameters of 
checkers, etc.), information of PV (calendar, system register value, etc.) can be displayed. This is Data R/W 
(Read/Write) function. 

The displayed value can be modified for some data*. 

The data is displayed on the Data R/W sheet. Up 
to two sheets of data can be set and displayed per 
type and a sheet can show up to 80 items (5 
columns x 16 rows). 

 
* When "Account Setting" is used, Data R/W 
may not be looked or values may not be 
changed according to logged-in users. 

 

 

4.19.1 Setting Data R/W 

Register data in Data R/W sheet. The sheet is made up by cells displaying items. Up to 80 cells can be set. (5 
columns x 16 rows) 

Setting Cell Number of Data R/W Sheet 
Set the number of cells by specifying the number of columns and the number of rows. The settable range is 1 
column x 1 row to 5 columns x 16 rows. 

1. Select "TYPE" from the menu bar. 

The menu appears. 

2. Select "Data R/W". 

“Data R/W” setting window is displayed. 

3. Select a sheet number of Data R/W to set. 

4. Press the FUNC key and select “Number of 

Cells” from the pop-up menu. 

The window to set the number of cells appears. 

5. Enter the number of columns and rows and 
then press the CANCEL key. 

The specified number of cells are displayed. 
 

 
The number of cells is counted from the upper left. 
When setting the number of columns to “3”, the 

4th column and after will be deleted even though 
data has been registered in them and the data 
also will be deleted. Note that setting the number 
of columns to “4” or more again cannot restore the 
deleted data. 
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Registering Data in Data R/W Sheet 

1. Select a sheet number of Data R/W to 
register data in Data R/W setting window. 

2. Select a cell to register data. 

The item selecting window is displayed. 
 

 
- For the information of settable items, 

refer to page 392. 
- When the settable items in the list are 

displayed in gray (when the color setting 
is the default), it shows that those 
parameters are not available or the 
results do not exist. 
For example, the scan pitch in the 
parameters of gray edge is only available 
when the shape of the area is "Plane". 
When the shape is "Line", "Scan Pitch" is 
displayed in gray. 

 

3. Select data to register. 

Depending on data type, details including checker number or parameter are needed to be selected. 
Follow the window display. 
For some checkers, the list of result types is displayed on multiple pages. Tilt the ENTER key left or light 
to change the page. 

 
The description field shows the detail of registered data after registration. 
 
Now you completed registering data. Set the following two items as necessary. 
- Character alignment: Display position of characters in a cell 
- Overwrite permission: Setting to permit overwriting data in RUN menu 

 

 
 Data with value after decimal point is displayed 

3-digit after the point. The display digits after 
decimal point can be changed from the pop-up 
menu displayed by pressing the FUNC key. 

 In Connector (Binary Window), Connector (Gray 
Window), Connector (Gray Edge), you can register 
some types of data into Data R/W sheet from the 
setting windows. Refer to the description of each 
checker for details. 
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Character Alignment and Overwrite Permission 

1. Press the FUNC key and select “Alignment” from the 

pop-up menu. 

Select from Right (default), Center, and Left. 

2. Select "Overwrite" from the same menu. 

Every time you select “Overwrite”, permission status 
switches between on (checked) and off (unchecked). In 
the default setting, overwriting is permitted.  

This item is selectable only when you select the registered data that can be overwritten such as 
parameters of checkers. 

Copying Cell 

To copy the data registered in a cell to the other cell. 

1. Select the cell that you want to copy and press the FUNC key. 

The pop-up menu appears. 

2. Select "Copy". 

3. Move the cursor onto the destination cell and press the FUNC key. 

The pop-up menu appears. 

4. Select "Paste". 

Copying is executed. 

Selecting Judgement Display 
Display of Judgement can be changed. This setting is common for all Data R/W sheets. You cannot select 
separately for each sheet or cell. 

1. Select the cell you have set a judgement in and 
press the FUNC key. Then, select “Judgement 
Display”. 

2. Select "1/0/E" or “OK/NG/ER” 

Judgement 1/0/E OK/NG/ER 
OK 1 OK 
NG 0 NG 
Error E ER 
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Changing Font Color of Data R/W (Available from 
Ver.2.0) 

The font colors in the table of Data R/W can be changed to selected colors as necessary. Use this function 
when you want to change the font colors depending on operation results.  

1. Set "Color Change" to "No" in "TYPE" > "Data R/W" > 
"Font color". 

Default: No 

2. Select colors for OK Color and NG Color respectively. 

Selectable colors: Pink, Blue, Green, Yellow, Red, Light 
blue, White, Black 
Default: OK Color is blue, NG Color is red. 
 

 

 

3. The setting is reflected in the display characters of 
Data R/W once the screen is switched to RUN menu. 

The right figure shows the example when NG Color is set 
to pink. 

 

 
 The reference items whose font colors can be changed are as follows.  The change of font colors is 

not possible for other reference items. 
- Results of Checkers, Geometry Calculation and Numerical Calculation 
- Judgement 
- Total Judgement 

 The background color cannot be changed. 

Deleting a Cell, Clearing a Whole Sheet 

1. Select a sheet number of Data R/W. 

2. Select the cell you want to delete and press the FUNC key. 

The pop-up menu appears. 

3. To delete only the selected cell, select “Delete”, and to delete a whole sheet, select “Delete All”. 

The confirmation message appears. If you select “Yes”, the registered data of a cell or a whole sheet are 
deleted. 
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4.19.2 Data R/W in RUN Menu 

Data R/W 0 -1 are displayed in the designated window, Data R/W 0 window - Data R/W 1 window. In RUN 
menu, the following operations can be done; selecting a window to display, changing the position and size, and 
displaying frame (rule lines). 

Refer to Chapter 5.3.2 Arranging Layout (page 417). 

Displaying Data R/W 

1. Select "VIEW" from the menu bar in RUN menu. 

The menu appears. 

2. Select "Data R/W". 
 

Marked Data R/W windows are displayed and others are not displayed. 

3. Select a window number of Data R/W to display. 

The selected number of Data R/W window is marked and displayed. 
 

Asterisk symbol (*) shown in a cell indicates that not all digits of the value can be displayed within the width 
of the current cell. Adjust the cell width to display the all digits. 
Blue, black or green characters are displayed in cells. The color differs depending on the item referred in 
the cell. Each color shows that the following item is referred; Blue: Result, Black: Parameter, Green: Text  
If you want to use the layout displaying Data R/W windows in future, register it in "Layout". 

 
 

In RUN menu, you can change the outlook of Data R/W including the window size and cell width. Refer to 
page 417 for details. 

To hide the displayed Data R/W window 

Select "Data R/W" from “VIEW” menu and select the number of Data R/W window to hide. 
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Changing Values Using Data R/W 
While displaying Data R/W window, you can change the data registered in Data R/W. (Some data cannot be 
changed such as results. If a logged-in user is not allowed to change Data R/W when "Account Setting" is used, 
it cannot be changed. For details of "Account Setting", refer to page 456.) 

It is helpful to execute inspections changing values frequently (when introducing PV200), or to permit changing 
some limited values (when using password for limitation of switch to the SETUP menu to prevent to change the 
setting data by mistake). 

 
 Only the value of the cell permitted to overwrite can be changed. Setting to permit to overwrite or not is 

made in the window that registers data into a Data R/W sheet (the cell which refers the parameter in 
"TYPE" > "Data R/W" > "Data R/W 0 or 1"). 

 If any parameter other than values is registered in Data R/W, it will be replaced with a value to display. 
The item name will not be displayed. When changing the setting, the item name is displayed in the 
subwindow. 
Example) When the preprocess group selected in a checker has been registered in Data R/W 

Grayscale 
Preprocess 

Display in Data R/W 

 

No 0 
A 1 
B 2 
C 3 
D 4 
: 
: 

: 
: 

P 16 

 

1. Press the F1 key (“Select Window”) in RUN menu. 

2. Select a Data R/W window where the data you 
want to change is registered. 

The Data R/W window is displayed and you can 
select a cell. 

3. Select a cell where the data to change is 
registered. 

Selecting modifiable cell displays the modifying 
window. If you select the cell where the data cannot 
be changed is registered, nothing appears. 

4. Select or enter value and fix. 

Now you completed the modification. 

 
 

 

5. To save the changed value, select [TOOL] -> [Save Setting Data] of the menu bar. 

If you cut the power or read the setting data in SETUP menu before saving the changed data, the data is 
cleared and the values are replaced to the previous ones. 
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4.19.3 Registerable Items 

The data that can be registered in cells of Data R/W are listed below.  

 
 “Yes” in the “Change” column indicates the value of the cell is modifiable from Data R/W sheet. 

 The columns of Position Adjustment and Area Size Adjustment show that the item can be registered in 
Data R/W or not, when they are used for the adjustments.  

Items that can be registered in Data R/W 

Statistics group 
A number is indicated in "Statistics" column for statistics items. See below. 
No. Numeric Statistics All Statistics OK Statistics NG Statistics 
2 Statistics of checker results 

If the checker is OK, calculates “All Statistics” 
and “OK Statistics”. If the judgement is NG, 
calculates “All Statistics” and “NG Statistics”.  

Minimum OK Judge. Min. NG Judge. Min. 
 Maximum OK Judge. Max. NG Judge. Max. 
 Average OK average NG average 
 Range OK Range NG range 
 Variance OK Variance NG Variance 
3 Judgment Statistics 

If the checker is OK, calculates “All Statistics” 
and “OK Statistics”. If the judgement is NG, 
calculates “All Statistics” and “NG Statistics”.  
When referring the statistics of 
judgments(JR/JD) during in RUN mode, the 
latest result is referred. 

Scan Count 
(Judgment 
Count) 

OK count NG count 

Checker 
Position Adjustment (PAC) Change Statistics 
Parameter Base Checker Parameter No.0-3 *1) Yes No 
Result Judgement No 3 
 Inspection time No 2 
 Base Position X No 2 
 Base Position Y No 2 
 Base Position Theta No 2 
 Adjustment Amount X No 2 
 Adjustment Amount Y No 2 
 Adjustment Amount Theta No 2 
 Detect Position X No 2 
 Detect Position Y No 2 
 Detect Position Theta No 2 
 Base Judgement Results No 3 
 Base Inspection Time No 2 
 Base X-Coordinate No 2 
 Base Y-Coordinate No 2 
 Base Proj. X Axis No 2 
 Base Proj. Y Axis No 2 
Area Size Adjustment (AUC) Change Statistics 
Parameter *2)  Yes No 
Result Judgement No 3 
 Inspection time No 2 
 X coordinate No 2 
 Y coordinate No 2 
 Proj. X No 2 
 Proj. Y No 2 

*1) Applies to the items that “Position Adjustment - Base checker” column is “Yes” for each checker 
*2) Applies to the items that “Area Size Adjustment” column is “Yes” for each checker 
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Line (LIC)  Change Statistics 
Parameter Area 

Setting 
Area Setting (Refer to p.403) Yes No 
Area Size Adjustment (Refer to p.403) Yes No 

Inspection 
Conditions 

Grayscale Preprocess Yes No 
Slice Level Yes No 
Count Pixel Color Yes No 
Count Object Color Yes No 
Min. Object Size Yes No 
Min. Gap Size Yes No 
Filter Yes No 

Judgement 
Limits 

Max. No. of Pixels Yes No 
Min. No. of Pixels Yes No 
Max. No. of Objects Yes No 
Min. No. of Objects Yes No 

Result Judgement No 3 
 Inspection time No 2 
 Pixel Judgement No 3 
 Object Judgement No 3 
 No. of Pixels No 2 
 No. of Objects No 2 
Binary Window (BWC) Change Statistics 

Parameter Area 
Setting 

Area Setting (Refer to p.403) Yes No 
Area Size Adjustment (Refer to p.403) Yes No 

Inspection 
Conditions 
 

Grayscale Preprocess Yes No 
Slice Level Yes No 
Target Yes No 
Filter Yes No 

Judgement 
Limits 

OK Judge. Max. Yes No 
OK Judge. Min. Yes No 

Result  Judgement No 3 
 Inspection time No 2 
 Area No 2 

Gray Window (GWC) Change Statistics 

Parameter Area 
Setting 

Area Setting (Refer to p.403) Yes No 
Area Size Adjustment (Refer to p.403) Yes No 

Inspection 
Conditions 

Preprocess Yes No 

Judgement 
Limits 

OK Judge. Max. Yes No 
OK Judge. Min. Yes No 

Result  Judgement No 3 
 Inspection time No 2 
 Gray Average No 2 

 
Binary Edge (BEC) Change Statistics Pos. Adj. - 

Base checker 
Area Size 
Adjustment 

Parameter Area 
Setting 

Area Setting(Refer to p.403) Yes No No Yes 
Area Size Adjustment (Refer 
to p.403) 

Yes No No --- 

Inspection 
Condition 

Grayscale Preprocess Yes No Yes Yes 
Slice Level Yes No Yes Yes 
Edge Condition Yes No Yes Yes 
Detect Position Yes No No No 
Filter Yes No Yes Yes 

Search 
Method 

Filter Yes No Yes Yes 
Width Yes No Yes Yes 

Judgement 
Limits 

OK Judge. Max. Yes No No No 
OK Judge. Min. Yes No No No 
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Binary Edge (BEC) Change Statistics Pos. Adj. - 

Base checker 
Area Size 
Adjustment 

Result  Judgement Yes No Yes Yes 
Inspection time Yes No No No 
No. of Objects Yes No Yes Yes 
X coordinate Yes No Yes Yes 
Y coordinate Yes No Yes Yes 
Detect Color     
Proj. X Yes No No No 
Proj. Y Yes No No No 

Gray Edge (GEC)  Change Statistics Pos. Adj. - 
Base checker 

Area Size 
Adjustment 

Parameter Area 
Setting 

Area Setting (Refer to p.403) Yes No No Yes 
Area Size Adjustment (Refer 
to p.403) 

Yes No No --- 

Inspection 
Conditions 

Grayscale Preprocess Yes No Yes Yes 
Scan method Yes No Yes Yes 
Edge condition Yes No Yes Yes 
Edge Threshold Yes No Yes Yes 
Detect Position Yes No Only “Font 

and Peak” 
 

Search 
Method 

Scan Pitch Yes No Yes Yes 
Filter Yes No Yes Yes 
Width Yes No Yes Yes 
Average Range Yes No Yes Yes 

Judgement 
Limits 

OK Judge. Max. Yes No No No 
OK Judge. Min. Yes No No No 

Result  Judgement No 3 Refer to the 
items of 
Position 
Adjustment 
(PAC) 

Refer to the 
items of Area 
Size 
Adjustment 
(AUC) 

Inspection time No 2 
No. of Objects No 2 
X coordinate No 2 
Y coordinate No 2 
Differential Value No 2 
Proj. X No 2 
Proj. Y No 2 

Feature Extraction (FEC) Change Statistics Pos. Adj. - 
Base checker 

Area Size 
Adjustment 

Parameter Area 
Setting 

Area Setting (Refer to p.403) Yes No No Yes 
 Area Size Adjustment (Refer 

to p.403) 
Yes No No --- 

 Inspection 
Conditions 

Grayscale Preprocess Yes No Yes Yes 
 Slice Level Yes No Yes Yes 
 Target Yes No Yes Yes 
 Filter Yes No Yes Yes 
 Sorting Yes No Yes Yes 
 Sorting Order Yes No Yes Yes 
 Search 

Method 
Labeling Yes No Yes Yes 

 Boundary Yes No Yes Yes 
 Perimeter Yes No No No 
 Projection Width, Height Yes No Yes Yes 
 Principal axis angle Yes No No No 
 Fill Holes Yes No Yes Yes 
 Extraction 

Condition 
Max. Object Area Yes No Yes Yes 

 Min. Object Area Yes No Yes Yes 
 Max. Proj. Width Yes No Yes Yes 
 Min. Proj. Width Yes No Yes Yes 
 Max. Proj. Height Yes No Yes Yes 
 Min. Proj. Height Yes No Yes Yes 
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Feature Extraction (FEC) Change Statistics Pos. Adj. - 

Base checker 
Area Size 
Adjustment 

 Judgement 
Limits 

OK Judge. Max. Yes No No No 
 OK Judge. Min. Yes No No --- 
Result Common 

Result 
Individual 
Result 1: 
1/2 page 

Judgement No 3 Refer to the 
items of 
Position 
Adjustment 
(PAC) 

Refer to the 
items of Area 
Size 
Adjustment 
(AUC) 

 Inspection time No 2 
 No. of Objects No 2 
 Total area No 2 
 Area No 2 
 Gravity X No 2 
  Gravity Y No 2 
  Projection Width No 2 
  Projection Height No 2 
  Perimeter No 2 
  Principal axis angle No 2 
  Proj. X No 2 
  Proj. Y No 2 
 Individual 

Result 2: 
2/2 page 

Circumscribing Rectangle 
Upper Left X 

No 2 

 Circumscribing Rectangle 
Upper Left Y 

No 2 

  Circumscribing Rectangle 
Upper Right X 

No 2 

  Circumscribing Rectangle 
Upper Right Y 

No 2 

  Circumscribing Rectangle 
Lower Left X 

No 2 

  Circumscribing Rectangle 
Lower Left Y 

No 2 

  Circumscribing Rectangle 
Lower Right X 

No 2 

  Circumscribing Rectangle 
Lower Right Y 

No 2 

Smart Matching (SMC) Change Statistics Pos. Adj. - 
Base checker 

Area Size 
Adjustment 

Parameter  Area 
Setting  

Search Area (Refer to p.403) Yes No No Yes 

 Inspection 
Conditions 

Grayscale Preprocess Yes No Yes Yes 
 Detect B/W Reversed 

Template 
Yes No Yes Yes 

 Angle - Accuracy Yes No No=> 
Position 
Adjustment 
Yes=> 
Pos/Rot 
Adjustment 

Yes 

 Sorting Yes No Yes Yes 
 Sorting Order Yes No Yes Yes 
 Template Rotated by 180d Yes No Yes Yes 
 Ignore Dark Image Yes No Yes Yes 
 Threshold to Ignore Dark 

Image 
Yes No Yes Yes 

 Sequence 1st Min. 
Correlation 

Yes No Yes Yes 

  Max. Count Yes No Yes Yes 
  2nd  Min. 

Correlation 
Yes No Yes Yes 

  Max. Count Yes No Yes Yes 
  3 rd Min. 

Correlation 
Yes No Yes Yes 

  Max. Count Yes No Yes Yes 
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Smart Matching (SMC) Change Statistics Pos. Adj. - 

Base checker 
Area Size 
Adjustment 

  4th Min. 
Correlation 

Yes No Yes Yes 

  Max. Count Yes No Yes Yes 
  5th Min. 

Correlation 
Yes No Yes Yes 

  Max. Count Yes No Yes Yes 
  6th Min. 

Correlation 
Yes No Yes Yes 

  Max. Count Yes No Yes Yes 
  Square Correlation Yes No Yes Yes 
 Subtraction Min. Subtracted Size Yes No No No 
  Subtraction Threshold Yes No No No 
  Filter Yes No No No 
  Max. OK No. of Subtracted 

Objects 
Yes No No No 

Result  Judgement No 3 Refer to the 
items of 
Position 
Adjustment 
(PAC) 

Refer to the 
items of Area 
Size 
Adjustment 
(AUC) 

  Inspection time No 2 
  No. of Objects No 2 
  Detect Template No. No 2 
  Correlation Value No 2 
  X No 2 
  Y No 2 
  Angle No 2 
  Pixels of Max. Subtracted 

Object  
No 2 

  No. of Subtracted Objects No 2 
  Projection X No 2 
  Projection Y No 2 
  No. of Objects (Interim) No 2 
  Correlation (Interim) No 2 

 
Contour Matching (CMC) Change Statistics Pos. Adj. - 

Base checker 
Area Size 
Adjustment9 

Parameter  Area 
Setting  

Search Area (Refer to p.403) Yes No No Yes 

 Inspection 
Conditions 

Grayscale Preprocess Yes No Yes Yes 
 Out-Point Limit Yes No Yes Yes 
 Shape Yes No Yes Yes 
 Detect B/W Changed Image Yes No Yes Yes 
 Rotation Range (+/-) Yes No Yes Yes 
 Magnification Range (+/-%) Yes No Yes Yes 
 Min. Correlation Yes No Yes Yes 
 Execution 

Conditions 
Accuracy Yes No Yes Yes 

 Speed Yes No Yes Yes 
  Overlap Ratio Level Yes No Yes Yes 
  Sorting Yes No Yes Yes 
  Sorting Order Yes No Yes Yes 
Result  Judgement No 3 Refer to the 

items of 
Position 
Adjustment 
(PAC) 

Refer to the 
items of Area 
Size 
Adjustment 
(AUC) 

  Inspection time No 2   
  No. of Objects No 2   
  Correlation Value No 2   
  X No 2   
  Y No 2   
  Angle No 2   
  Magnification No 2   
  Projection X No 2   
  Projection Y No 2   
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Flaw Detection (FWC) Change Statistics 

Parameter Area 
Setting 

Area Setting (Refer to p.403) Yes No 
Area Size Adjustment (Refer to p.403) Yes No 

 Inspection 
Conditions 

Grayscale Preprocess Yes No 
Scan Direction Yes No 

 Search 
Method 

Detect Mode Yes No 
Number of Cells for Calculation Range Yes No 
Number of Cells per Shift Yes No 

 Threshold Yes No 
 Direction Yes No 
 Min. Flaw Size in Cells Yes No 
 Judgement 

Limits 
OK Judge. Max. Yes No 
OK Judge. Min. Yes No 

Result  Judgement No 3 
  Inspection time No 2 
  No. of Objects No 2 
  Flaw size No 2 
  First Cell of Flaw No 2 
  X coordinate No 2 
  Y coordinate No 2 
  Proj. X No 2 
  Proj. Y No 2 

 
Connector(Binary Window) (CBW) Change Statistics 

Parameter Area 
Setting 

Area Setting (Refer to p.403) Yes No 
 Area Size Adjustment (Refer to p.403) Yes No 
 Inspection 

Conditions 
Grayscale Preprocess Yes No 

 Slice Level Yes No 
  Target Yes No 
  Filter Yes No 
  Set Individually Yes No 
 Judgement 

Limits 
Common Judgement Max. Yes No 

 Common Judgement Min. Yes No 
  Individual Judgement Max. Yes No 
  Individual Judgement Min. Yes No 
Result  Judgement No 3 
  Inspection time No 2 
  No. of Cells No 2 
  Total area No 2 
  Area No 2 
  Individual Judgement No 3 
   

Connector(Gray Window) (CGW) Change Statistics 

Parameter  Area 
Setting  

Area Setting (Refer to p.403) Yes No 
 Area Size Adjustment (Refer to p.403) Yes No 
 Inspection 

Conditions 
Grayscale Preprocess Yes No 

 Judgement 
Limits 

Set Individually Yes No 
 Common Judgement Max. Yes No 
  Common Judgement Min. Yes No 
  Individual Judgement Max. Yes No 
  Individual Judgement Min. Yes No 
Result  Judgement No 3 
  Inspection time No 2 
  No. of Cells No 2 
  Gray Average No 2 
  Individual Judgement No 3 
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Connector(Gray Edge) (CGE) Change Statistics 

Parameter  Area 
Setting  

Area Setting (Refer to p.403) Yes No 

 Inspection 
Condition 

Grayscale Preprocess Yes No 
 Detect Direction Yes No 
  Scan method Yes No 
  Edge condition 0 Yes No 
  Edge condition 1 Yes No 
  Detect Position Yes No 
 Search 

Method 
Scan Pitch Yes No 

 Filter Yes No 
  Width Yes No 
  Average Range Yes No 
 Threshold 

Adjustment 
Set Individually Yes No 

 Global Threshold 0 Yes No 
  Global Threshold 1 Yes No 
  Individual Threshold 0 Yes No 
  Individual Threshold 1 Yes No 
 Judgement 

Limits 
Max. Judge. Pitch Yes No 

 Min. Judge. Pitch Yes No 
  Max. Distance Difference Judgement Yes No 
  Min. Distance Difference Judgement Yes No 

 
Connector(Gray Edge) (CGE) Change Statistics 

Result Common 
Result 
1/2 page 

Judgement No 3 
Pitch Total Judgement No 3 
Distance Difference Total Judgement No 3 

  Inspection time No 2 
  No. of Cells No 2 
  Max. Pitch No 2 
  Min. Pitch No 2 
  Average Pitch No 2 
 Individual 

Result: 
2/2 page 

Pitch Individual Judgement No 3 
Individual judgement for Distance 
Difference  

No 3 

  Pitch No 2 
  Distance Difference No 2 
  Area 0: X-Coord. Edge No 2 
  Area 0: Y-Coord. Edge No 2 
  Area 0: Edge Differential No 2 
  Area 1: X-Coord. Edge No 2 
  Area 1: Y-Coord. Edge No 2 
  Area 1: Edge Differential No 2 

 

Smart Edge (Circle) (SEC) Change Statistics Pos. Adj. - 
Base checker 

Parameter Area 
Setting  

Area Setting (Refer to P.403) Yes No No 

 
Area Size Adjustment (Refer to 
P.403) 

Yes No No 

 Virtual 
Circle 
Detect 
Condition 

Grayscale Preprocess Yes No Yes 
 Detection Method Yes No Yes 
 Edge ratio used Yes No Yes 
 Execution Mode Yes No Yes 
  Base Angle Yes No No 
  Result No. Assignment Yes No No 
 Edge Detect 

Condition 
Scan Direction 0 Yes No Yes 

 Scan Method 0 Yes No Yes 
  Edge Condition 0 Yes No Yes 
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Smart Edge (Circle) (SEC) Change Statistics Pos. Adj. - 
Base checker 

  Edge Threshold 0 Yes No Yes 
  Detect Position 0 Yes No Yes 
  Filter 0 Yes No Yes 
  Width 0 Yes No Yes 
  Average Range 0 Yes No Yes 
  Scan Direction 1 Yes No No 
  Scan Method 1 Yes No No 
  Edge Condition 1 Yes No No 
  Edge Threshold 1 Yes No No 
  Detect Position 1 Yes No No 
  Filter 1 Yes No No 
  Width 1 Yes No No 
  Averahtge Range 1 Yes No No 
 Judgement 

Limits 
Denoising 0 Yes No No 

 Denoising Range 0 Yes No No 
  Denoising 1 Yes No No 
  Denoising Range 1 Yes No No 
  Meas.: Radius* Maximum Yes No No 
  Meas.: Radius* Minimum Yes No No 

 
Smart Edge (Circle) (SEC) Change Statistics Pos. Adj. - 

Base checker 
  Max. Standard Deviation Yes No No 
  Min. Standard Deviation Yes No No 
  Max. Circularity Yes No No 
  Min. Circularity Yes No No 
  Max. Unused Edge Cnt. Yes No No 
Result Detected 

Result: 
1/3 page 

Max. Measurement No 2 Refer to the 
items of 
Position 
Adjustment 
(PAC) 

 Min. Measurement No 2 
 Average Measurement No 2 
  Standard Deviation No 2 
  Max. Angle No 2 
  Min. Angle No 2  
  Center X 0 No 2  
  Center Y 0 No 2  
  Radius 0 No 2  
  Circularity 0 No 2  
  Center X 1 No 2  
  Center Y 1 No 2  
  Radius 1 No 2  
  Circularity 1 No 2  
 Common 

Result: 
2/3 page 

Judgement No 3 

 
 Measurement Judgement No 3 
 Standard Deviation Judgement No 3 
  Circularity Judgement No 3 
  Unused Edge Count Judgement No 3 
  Inspection Time No 2  
  Used Edge Count No 2  
  Unused Edge Count No 2  
  No. of Cells No 2  
 Individual 

Result: 
3/3 page 
(Result of 
each cell) 

Cell Individual Result: Judgement No 3  
 Cell Individual Result: Measurement No 2  
 Cell Individual Result: Deviation No 2  
 Cell Individual Result: X 0 No 2  
 Cell Individual Result: Y 0 No 2  
  Cell Individual Result Differential 0 No 2  
  Cell Individual Result: X 1 No 2  
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Smart Edge (Circle) (SEC) Change Statistics Pos. Adj. - 
Base checker 

  Cell Individual Result: Y 1 No 2  
  Cell Individual Result: Differential 1 No 2  

  Cell Individual Result: Judgement 
Code 

No 2  

 

Smart Edge (Line) (SEL) Change Statistics Pos. Adj. - 
Base checker 

Area Size 
Adj. 

Parameter 
Area 
Setting  

Area Setting (Refer to P.403) Yes No No Yes 
Area Size Adjustment (Refer to 
P.403) 

Yes No No --- 

 Approximat
e Line 
Detect 
Condition 

Grayscale Preprocess Yes No Yes Yes 
 Detection Method Yes No Yes Yes 
 Edge ratio used Yes No Yes Yes 
 Execution Mode Yes No Yes Yes 
  Base Angle Yes No No No 
  Result No. Assignment Yes No No No 
 Edge Detect 

Condition 
Scan Direction 0 Yes No Yes Yes 

 Scan Method 0 Yes No Yes Yes 
  Edge Condition 0 Yes No Yes Yes 
  Edge Threshold 0 Yes No Yes Yes 
  Detect Position 0 Yes No Yes Yes 
  Filter 0 Yes No Yes Yes 
  Width 0 Yes No Yes Yes 
  Average Range 0 Yes No Yes Yes 
  Scan Direction 1 Yes No No No 
 

 
Scan Direction 1 Yes No No No 

 Scan Method 1 Yes No No No 
  Edge Condition 1 Yes No No No 
  Edge Threshold 1 Yes No No No 
  Detect Position 1 Yes No No No 
  Filter 1 Yes No No No 
  Width 1 Yes No No No 
  Average Range 1 Yes No No No 
 Judgement 

Limits 
Denoising 0 Yes No No No 

 Denoising Range 0 Yes No No No 
  Denoising 1 Yes No No No 
  Denoising Range 1 Yes No No No 
  Meas.: Deviation* Maximum Yes No No No 
  Meas.: Deviation* Minimum Yes No No No 
  Max. Standard Deviation Yes No No No 
  Min. Standard Deviation Yes No No No 
  Max. Linearity Yes No No No 
  Min. Linearity Yes No No No 
  Max. Unused Edge Cnt. Yes No No No 
Result Common 

Result: 
1/3 page 

Max. Measurement No 2 Refer to the 
items of 
Position 
Adj. (PAC) 

Refer to 
the items 
of Area 
Size Adj. 
(AUC) 

 Min. Measurement No 2 
 Average Measurement No 2 
  Standard Deviation No 2 
  Max.: X No 2 
  Max.: Y No 2  
  Min.: X No 2   
  Min.: Y No 2   
  Judgement No 2   
  Measurement Judgement No 2   
  Judgement No 2   
  Measurement Judgement No 2   
  Standard Devation Judgement No 2   
  Linearity Judgement No 2   
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Smart Edge (Line) (SEL) Change Statistics Pos. Adj. - 
Base checker 

Area Size 
Adj. 

  Unused Edge Count 
Judgement 

No 2   

  Inspection Time No 2   
  Used Edge Count No 2   
  Unused Edge Count No 2   
  No. of Cells No 2   
 Detected 

Result: 
2/3 page 

Line 0 Start Coord. X No 2   
 Line 0 Start Coord. Y No 2   
 Line 0 End Coord. X No 2   
 Line 0 End Coord. Y No 2   
  Line 0 Element a No 2   
  Line 0 Element b No 2   
  Line 0 Element c No 2   
  Line Angle 0 No 2   
  Linearity 0 No 2   
  Line 1 Start Coord. X No 2   
 Line 1 Start Coord. Y No 2   
 Line 1 End Coord. X No 2   
 Line 1 End Coord. Y No 2   
  Line 1 Element a No 2   
  Line 1 Element b No 2   
  Line 1 Element c No 2   
  Line Angle 1 No 2   
  Linearity 1 No 2   
 Individual 

Result: 
3/3 page 
(Results of 
each cell) 

Individual Judgement No 3   
 Measurement No 2   
 X0 No 2   
 Y0 No 2   
 Diff.0 No 2   
  X1 No 2   
  Y1 No 2   
  Diff.1 No 2   
  Judgement Code No 2   

 
 

Color Window (CWC) Change Statistics 

Parameter Area 
Setting 

Area Setting (Refer to p.403) Yes No 
Area Size Adjustment (Refer to p.403) Yes No 

 Judgement 
Limits 1: 
1/3 page 

R Gray Max. Yes No 
R Gray Min. Yes No 

 R Gray Ave. Max. Yes No 
 R Gray Ave. Min. Yes No 
  R Gray Std. Devi. Max. Yes No 
  R Gray Std. Devi. Min. Yes No 
 Judgement 

Limits 2: 
2/3 page 

G Gray Max. Yes No 
G Gray Min. Yes No 

 G Gray Ave. Max. Yes No 
 G Gray Ave. Min. Yes No 
  G Gray Std. Devi. Max. Yes No 
  G Gray Std. Devi. Min. Yes No 
 Judgement 

Limits 3: 
3/3 page 

B Gray Max. Yes No 
B Gray Min. Yes No 

 B Gray Ave. Max. Yes No 
 B Gray Ave. Min. Yes No 
  B Gray Std. Devi. Max. Yes No 
  B Gray Std. Devi. Min. Yes No 
Result Result 1: Judgement No No 
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Color Window (CWC) Change Statistics 

 1/2 page Inspection time No No 
 R Judge. No No 
  R Ave. Judge. No No 
  R Std. Devi. Judge. No No 
  G Judge. No No 
  G Ave. Judge. No No 
  G Std. Devi. Judge. No No 
  B Judge. No No 
  B Ave. Judge. No No 
  B Std. Devi. Judge. No No 
Result Result 2: 

2/2 page 
R Max. No 2 

 R Min. No 2 
  R Std. Devi. No 2 
  G Max. No 2 
  G Min. No 2 
  G Std. Devi. No 2 
  B Max. No 2 
  B Min. No 2 
  B Std. Devi. No 2 

 

*1) The name varies depending on Detect Mode. 
- When selecting "Distance": Max.: Distance (Min.)" 
- When selecting "Width": Max.: Width (Min.)" 

 
Geometry Calculation Change Statistics 

Parameter  Attribute 
Setting 
 
 

Line Display Yes No 
 Angle Range Yes No 
 Direction Yes No 
 Intersecting Angle Yes No 
 Judgement 

Limits 
Max. X Judge. Yes No 

 Min. X Judge. Yes No 
  Max. Y Judge. Yes No 
  

 
Min. Y Judge. Yes No 

 Max. Standard Devi. Judge. Yes No 
  Min. Standard Devi. Judge. Yes No 
  Max. Angle Judge. Yes No 
  

 
Min. Angle Judge. Yes No 

 Max. Distance Judge. Yes No 
  Min. Distance Judge. Yes No 
  Max. Intersecting Angle Judge. Yes No 
  

 
Min. Intersecting Angle Judge. Yes No 

 Max. Radius Judge. Yes No 
  Min. Radius Judge. Yes No 
  Max. Major Axis Judge. Yes No 
  Min. Major Axis Judge. Yes No 
  Max. Minor Axis Judge. Yes No 
  Min. Minor Axis Judge. Yes No 
Result 1/2 page X No 2 
  Y No 2 
  IP0 X No 2 
  IP0 Y No 2 
  IP1 X No 2 
  IP1 Y No 2 
  Standard Deviation No 2 
  Angle No 2 
  Line Parameter A No 2 
  Line Parameter B No 2 
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Geometry Calculation Change Statistics 

  Line Parameter C No 2 
  Distance No 2 
  Intersecting Angle No 2 
  Radius No 2 
  Major Axis No 2 
  Minor Axis No 2 
  Inspection Time No 2 
 2/2 page Judgement No 3 
  X Judge. No 3 
  Y Judge. No 3 
  Standard Devi. Judge. No 3 
  Angle Judge. No 3 
  Distance Judge. No 3 
  Intersecting Angle Judge. No 3 
  Radius Judge. No 3 
  Major Axis Judge. No 3 
  Minor Axis Judge. No 3 

For All Checkers - Area Setting 
Line, Binary Edge, Gray Edge, Smart Matching, Contour 
Matching, Flaw Detection (Line, Plane), Connector 
(Binary Window, Gray Window), Smart Edge (Line) 

Change Statistics 

Area Setting Start Point X Yes No 

Start Point Y Yes No 

 End Point X Yes No 

 End Point Y Yes No 

Binary Window, Gray Window, Feature Extraction, Color 
Window 

Change Statistics 

Area Setting Start Point X Yes No 

Start Point Y Yes No 

 End Point X Yes No 

 End Point Y Yes No 
 Vertex X (When the shape is 

polygon) 
Yes No 

 Vertex Y (When the shape is 
polygon) 

Yes No 

Flaw Detection (Ellipse), Smart Edge (Circle)   

 Center X Yes No 

 Center Y Yes No 

 Radius X Yes No 

 Radius Y Yes No 

Connector (Gray Edge)   

 Start Point X0 Yes No 

 Start Point Y0 Yes No 

 End Point X0 Yes No 

 End Point Y0 Yes No 

 Start Point X1 Yes No 

 Start Point Y1 Yes No 

 End Point X1 Yes No 

 End Point Y1 Yes No 
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For All Checkers - Area Setting - Area Size Adjustment 
Line, Binary Window, Gray Window, Binary Edge, Gray Edge, 
Feature Extraction, Smart Edge (Circle), Smart Edge (Line), Color 
Window 

Change Statistics 

Area Size 
Adjustment 

Area Size Adjustment Offset (Top) Yes No 

Area Size Adjustment Offset (Bottom) Yes No 

 Area Size Adjustment Offset (Left) Yes No 

 Area Size Adjustment Offset (Right) Yes No 

Flow Detection, Connector (Binary Window, Gray Window) Change Statistics 

Area Size 
Adjustment 

Area Size Adjustment Offset (Start) Yes No 

Area Size Adjustment Offset (End) Yes No 

Numerical Calculation 
 Change Statistics 

Numerical 
Calculation (CAC) 

Parameter Max. Judge. Yes No 

 Min. Judge. Yes No 

 Result Judgement No 3 

  Result No 2 

Numerical 
Calculation 
Previous Value 
(OCA) 

Result Judgement  No 3 

 Result No 2 

Judgement 
 Change Statistics 

JRC (Internal) Judgement Result No 3 

JDC (External)   No 3 

System Values 
 Change Statistics 

Inspection Time No No 

Inspection Cycle No No 

Total Judgement No No 

Scan Count No No 

Run Type No. No No 

Date (Y-M-D) No No 

Time (H-M-S) No No 

System Register 
 Change Statistics 

SYS:REG0 to SYS REG7 Yes No 

Slice Level 
Camera No. 0 - 1 Change Statistics 

Maximum value 
(Group A to P) 

Yes No 

Minimum value 
(Group A to P) 

Yes No 
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Grayscale Preprocess 
Camera No.0 - 1, Group A - P, 1st step - 
10th step 

Change Statistics 

Type Yes No 

Parameter 0 (Parameter name) to 
Parameter 8 (Parameter name) 

Yes No 

* The parameter name set for the selected step (1-10) is displayed. 
 It shows the parameter number without name is not used for the selected preprocess type. 

Text 
Text Change Statistics 

(Up to 16 characters) No No 
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4.20 Marker 

Marker is the function that displays figures of line, rectangle, circle, 
polygon or cross line on the screen window of RUN menu. This 
function can display an image on the screen like indicating a guide to 
position the object with no effect on the inspection time. This function 
also can move the created marker by inputting commands from the 
external device. 

Up to eight markers can be set for each product type per camera. 

 
Creating and editing markers are operated in SETUP Menu. 
However, they can be displayed only in the RUN Menu. Markers 
cannot be displayed on the screen window in SETUP menu. 

 
Marker display: see page 420 

 

Creating Marker 

1. In SETUP menu, select "TYPE" > "Marker Display" from 
the menu bar. 

The marker menu is displayed.  
The marker list shows marker numbers and their shapes. 

2. Specify a camera No. to set a marker. 

3. Select the marker list and then select a marker number 
from 0 - 7 to create. 

 
The marker shape of larger number is displayed in front on 
the screen window. 
For example, if you create markers in the same size and on 
the same position, setting No.0 in blue and No.7 in yellow, 
only the yellow marker No.7 is displayed on the screen. 

4. Select a color from the six colors. 

5. Select “Set” of "Area Setting" to set area shape and 
area. 

The procedure to select area shape and to specify area is 
the same as of checker area. 
It can be set for the captured image and a total of 9 screens 
surrounding it. However, in the case of the marker of cross 
line, it can be set and displayed only in the area of the 
captured image. 

6. After setting is completed, press the CANCEL key. 

When you close the marker setting window, the marker on 
the screen disappears which was displayed while you are 
setting it. This is because SETUP menu cannot display 
markers. 
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Copying Marker 

1. Highlight the marker number you want to copy and press the 
FUNC key. 

The pop-up menu appears. 

2. Select "Copy". 

3. Move the cursor onto the destination marker number and press 
the FUNC key. 

The pop-up menu appears. 

4. Select "Paste". 

The same marker as the copied one is pasted. 

 

 
 

If a marker already exists in the destination, the message of overwrite confirmation appears. Selecting 
“Yes” executes copying the marker. 

Deleting Marker 

1. Highlight the marker number you want to delete and press 
the FUNC key. 

The pop-up menu appears. 

2. Select "Delete". 

The confirmation screen is displayed. 

3. Select “Yes”. 

The marker is deleted. Select "No" to cancel. 
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Moving Marker (Inputting Command from External 
Device) 

The created marker can be moved by inputting commands 
(*1) from the external device. It is also possible to read the 
current position. 

The position of the marker is based on the coordinate of 
the middle point of the circumscribing rectangle of the 
marker (the intersection point of two lines for Shape: 
Cross line). 

In the example on the right, the solid line shows the 
created marker, the dotted line shows the circumscribing 
rectangle of the marker, and the point in the center shows 
the middle point. The circumscribing rectangle and the 
middle point are not displayed on the screen window. 

Rectangle Ellipse Cross line 

 
  

Polygon Line  

 

 

 

 

Movable range 

As a result of moving through the distance specified with the command parameter from the current position, if 
the circumscribing rectangle of the marker (the intersection point of two lines in the case of cross line) is located 
within the nine screens (which are the captured image and eight surrounding screens), the marker can be 
moved. 

As a result of the move, if only a part of the circumscribing rectangle goes out of the nine screens, the 
marker cannot be moved and an error occurs 

 

 
 Moving the marker is performed by specifying the moving distance from the current position. It is not 

possible to specify the coordinate of the destination to move. 

 The position to be read and the specified moving distance is in units of pixel. It is not possible to read 
and specify the moving distance in the unit after calibration. 

 Reading the marker position and writing the moving distance is performed with a set of X and Y 
coordinates. Reading (writing) is not available by specifying only X coordinate or Y coordinate. 

 
(*1) Read Command and Write Command: From page 603 
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Chapter 5 
 Setting of Operation and RUN Menu 
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5.1 Start /Stop RUN Mode 

Perform inspections along with the settings made in the previous chapter. 

Start RUN mode 

1. Switch to RUN menu by operating the “OPE/SET” switch. 

If you switched to SETUP menu from RUN menu during an inspection stoppage, follow the procedure 
described below to restart the operation. 
In other cases, switching to RUN menu starts the operation automatically. 
You can check whether the operation stops or is running in the lower left of the screen. 

2. Select "OPERATION” > “Start RUN Mode” from the menu bar. 

When the dialog message appears, select “Yes” to start the operation. 
The sign of “RUN” appears in the lower left of the screen. 
  

Stop RUN mode 

To stop RUN mode, follow the procedure below. 

1. Select "OPERATION” > “Stop RUN Mode” from the menu bar. 

When the dialog message appears, select “Yes” to stop the operation. 
The sign of “STOP” appears in the lower left of the screen. 
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Inspection Time and Inspection Cycle 

Executing an inspection shows "Inspection Time" or both of 
"Inspection Time" and “Inspection Cycle” in ms units in the lower 
left of the screen. 

 
 

Inspection Time 

When “Inspection Process” is set to "Serial", Inspection Time 
equals "READY signal OFF time" which is the time from START 
signal input to I/O output. 

 

When you output data to COM.0 port, Ethernet port, or a SD 
memory card, or when you output inspection images in 
"Synchronous" method, Inspections Time is the time from Start 
signal input to completion of the data output. 

 
 

Inspection Cycle 

The time from the I/O output of the previous 
inspection to the I/O output of the current 
inspection. It is displayed only when “Inspection 
Process” is set to "Parallel". 

 

When you output data to COM.0 port, Ethernet 
port, or a SD memory card, or when you output 
inspection images in "Synchronous" method, it 
is the time from the completion of the previous 
inspection data output to the completion of the 
current inspection data output. 

 

 
*1) The time of Image Capture includes the time of capture delay. 

*2) When the data is output in several times, it indicates the I/O output to the last one. 
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5.2 Control in RUN Menu 
The settings and operation listed below are available in RUN menu. 

 

Select Type (OPERATION) Switches types to execute. 

 Page 412 
Reset Statistics (OPERATION) Resets the statistics data of the current type. 

Modification and registration of the 
display (VIEW, LAYOUT) 

Sets the screen layout. 

Arranges the screen window, selects contents 
to display, specifies the size and position of a 
data R/W window, and sets the window 
transparency. this information can be 
registered as layout data. 

 page 415 

Save setting data (TOOL) Saves the settings modified in RUN menu in 
the storage space in PV200 or a SD memory 
card. 

 Page 413 Save/clear image memory (TOOL) Erases images saved during inspections and 
backups them in a SD memory card. 

Information (TOOL) Displays the information of PV. 

Eject SD memory card (TOOL) Prepares to eject the SD memory card. 

Data modification from the Data 
R/W window (Data R/W) 

Modifies the modifiable data registered in the 
Data R/W.  page 391 

 

5.2.1 Control of “OPERATION” Menu 

Switching Types 

 
In RUN menu, you can switch types but modify them such as adding, deleting, copying types and entering a 
title. 

1. Select "OPERATION” > “Select Type” from the 

menu bar. 

The list of product types appears. 

2. Select a Type No. to switch. 

The type is switched. 
When it is operating, the inspection will be 
continued on the switched type. 
 

 
Once the type is switched, the scan count will be 
reset and return to 0. 

 

Resetting Statistics Data 

1. Select "OPERATION” > “Reset Statistics” from the menu bar. 

When the dialog message appears, select “Yes”. 
If you select “No”, resetting is canceled. 
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5.2.2 Control of “TOOL” Menu 

Ejecting SD Memory Card 

1. Select "TOOL” > “Eject SD Card” from the menu bar. 

The message appears. 

2. Select “Yes”. 

The message saying “The SD card can be ejected safely,” appears. Select “OK” to eject the SD memory 
card. 

Saving Setting Data 
Saves the settings modified in RUN menu (or modified by a command of the external device). 

If you cut the power before saving the settings, the modified data will be cleared. 
 

 
It is displayed only when data saving in RUN menu is permitted. 

Refer to the setting of “ENVIRONMENT” >  “Password” > “Save Changes in RUN menu” in SETUP menu. 

1. Select "TOOL" > "Save Setting Data". 

The destination selecting window is displayed. 

2. Select a place to save it. 

Select “Storage Space in PV200” (or “SD card”) 

for “Save to”. 
 

 
Data cannot be saved in a SD card when "Write 
When Cover is Open" has been set to "Disable" 
and the cover of PV200 is open. (Refer to page 
438 for details.) 

3. Select a “No.” of a saving area. 

When the dialog message appears, select “Yes” 
to save. 
If you select “No”, saving is canceled. 
 

 
When "Storage Space in PV200" is selected, 
the saving area number is always 00. 

4. After saving is completed, press the CANCEL 
key. 
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Backing Up Saved Image 
Backups the images saved in the image memory during inspections to a SD memory card. Backupping cannot 
be executed during operations (RUN). 

1. Select "TOOL" > "Save Image Memory". 

The message is displayed if it is operating. To stop the operation and backup the images, stop it from 
“OPERATION” menu. 

2. Select a place in the SD memory card to save them. 

When the confirmation message appears, select “Yes”. 
 

 
Data cannot be saved in a SD card when "Write When Cover is Open" has been set to "Disable" and 
the cover of PV200 is open. (Refer to page 438 for details.) 

3. After the saving is complete, the message appears. Select “OK” and press the CANCEL key. 

Deleting Saved Image 
Deletes the images saved in the image memory during inspections. 

1. Select "TOOL" > "Clear Image Memory". 

When the dialog message appears, select “Yes”. 
When the message disappears, deleting the images is complete. 

Displaying Information of PV 

1. Select "TOOL” > “Information” from the menu bar. 

The list of PV information is displayed. 
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5.3 Setting Display in RUN Menu 
Set the contents to display in RUN menu. 

“Layout” is a combination of display contents described below. Up to 16 layouts can be registered and switched 
by a signal of the keypad or the external device. 

Ten types of layouts are initially registered in PV200. These are "Preset Layout”. 
 

Selecting Display Window / Size and Position of Windows 
RUN menu can display up to two screen windows which show images and up to two Data R/W windows 
which show and modify the data. The size, number and position of screen windows cannot be changed 
from the ten types of preset layouts. The size and position of data R/W windows can be changed freely. 

 

Contents Displayed in Screen Window 
The contents displayed in each screen window are type and magnification of an image, checker pattern, or 
coordinate axis. Set them with “Image Menu” from each screen window. For details of "Image Menu", refer 
to 3.2.2 (page 52). 

 

Window Transparency (RUN menu) 
The transparence of Data R/W windows can be changed. Higher transparency of the window helps to 
observe the image. 
This information is not included in the layout information. 

 
 If you use the above changed settings later, you need to register and save the layout. For details, refer to 

5.3.3 (page 422). 

 The information of layout and window transparency is initialized by executing “Initialize” of 
“ENVIRONMENT” in SETUP menu. 

 After being initialized, layout information will be three preset layouts registered as layout 0 - 9 and 
window transparency will be “0%”. 

 At startup, the layout number specified with the startup setting is called up. Refer to Chapter 6.2.1, page 
429 about the setting procedure 

 



 

416 

S
etting of O

peration and R
U

N
 M

enu 
C

h. 5 

5.3.1 Screen Window Arrangement: Selecting a Preset Layout 

PV200 has preset layouts to select. Based on a selected preset layout, you can arrange the layout and register 
it as a custom layout. 

1. Select "LAYOUT" > “Layout” from the menu bar. 

The layout setting window is displayed. 

2. Select a layout No. 

Layout No.00 - 15 can be selected. 
 

In the layout No.00 - 09, preset layouts 0 - 9 are registered initially. 
Preset layouts  
0 to 6: 

Normal layout (Displays main menu, information display area and key guide on 
the monitor.) 

Preset layouts  
7 to 9: 

Full-screen layout (Not display main menu, information display area and key 
guide on the monitor.) 

 
Specifying No.00 - 09 here can select a preset layout. 

3. Press the F2 (: Select Preset) key or press the FUNC key and select “Select Preset” from the 

displayed menu. 

 

The window for selecting the preset layout 
No.0 - 9 appears. Ten patterns of layouts 
(number of screen windows, the size, and the 
position) are preset. Display image of every 
pattern is set to Live and Gray (color image for 
color cameras). 

4. Operate the ENTER key to select the 
desired preset layout number. 

The window returns to the layout registering 
window. 
The selected layout image is displayed on the 
right. 
 

 

 
If a preset layout is registered in the layout number that has been already set, a message appears. Select 
“Yes” to save it. Select "No" to return to the previous layout. 

5. Press the ENTER key. 

The screen returns to RUN menu and shows 
the windows in the layout you selected. 
 

 
The layout has not been saved in PV200 yet. 
For the details of registering layout, refer to 
page 422. 
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5.3.2 Arranging Layout 

Now we select displayed screen windows (up to two windows ;No.0 - 1) and R/W windows (up to two windows; 
No.0 - 1), and arrange the size, position and other display settings of the R/W windows. 

Note that Data R/W windows are displayed in front of screen windows and cannot be displayed in behind.  

 
Be sure to save the setting data by registering the layout after layout arranging from “Layout”. If you switch to 
the other layouts or turn off the power of PV200 before registering and saving the setting, the arranged layout 
will be cleared. 

Selecting a Data R/W Window 

1. Select "VIEW" from the menu bar. 

The menu is displayed. 

2. Select “Screen” to select a screen window number to 

display. 

The selected number of screen window is checked and the 
Image menu is displayed. 

 

3. Press the Cancel key. 

4. Select "Data R/W" from “VIEW” menu and select the 

number of Data R/W window to hide. 

The window number is unchecked and the data R/W 
window is hidden. 

 

Selecting Image Type Displayed on Screen Window 
See Chapter 3.2.2 , page 52. 

Arranging a Data R/W Window 
The data and the number of cells displayed in a Data R/W window can be specified from “TYPE” > “Data R/W” 
in SETUP menu. 

In RUN menu, the items listed below can be set. 

Position/ size: Changes the position and size of the windows. 

Cell width: Sets the width of cells to display data by the columns. 

Translucent: Sets whether the transparence applies to Data R/W windows or not. 

Frame display: Displays or hides the frame when multiple cells are shown. 

1. Press the F1 key. 

The list of currently displayed window is displayed. 

2. Operate the ENTER key to select a Data R/W window to modify. 

The selected data R/W window is highlighted. 
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3. Press the FUNC key and select “Move” from the pop-up menu. 

4. Move the window by operating the ENTER key and press the 
ENTER key to fix the position. 

The frame of the window is displayed as pink broken line while the 
window is moved. 

5. Select "Size". 
 

6. Move the start point of the window by operating the ENTER key and press the ENTER key to fix the 
position. 

7. Move the end point of the window and press the ENTER key to fix it. 

8. Select the column to change the cell width and press the FUNC key. 

The cell width can be specified by a column basis. 

9. Select "Cell Width" from the pop-up menu. 

The setting window is displayed. Specify it in pixels according to the digit of the displayed data. 
 

Even when Calibration is employed, specify the cell width in pixels. 

10. Specify the value and press the ENTER key. 

The cell width is changed. Change the cell width of other columns if needed. 

11. Press the FUNC key and select “Translucent” from the pop-up menu. 

The Data R/W window is displayed in the “Transparence” specified in VIEW menu. 
As you open the pop-up menu, "Translucent" is checked. 
Selecting “Translucent” again cancels to apply the transparence and the window is displayed in 0% of 
transparence. 

12. Press the FUNC key and select “Hide Frame” from the pop-up menu. 

The frame line is undisplayed. 
As you open the pop-up menu, "Hide Frame" is checked. 
Selecting “Hide Frame” again displays the frame. 

Optimizing Window Size (Optimize Size) 

Adjust the window size so that it displays all cells and no margin. This is optimization. 

While you can adjust the window size by modifying the start/end point by “Size”, using “Optimize Size” allows 
adjusting efficiently in one operation. 

1. Press the FUNC key to display the pop-up menu. 

2. Select "Optimize Size". 

The size of the Data R/W window is changed. 
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Changing Window Transparency of Data R/W 
Window  

The transparence of Data R/W windows can be changed. This is a function that helps to observe images and 
other windows when they are displayed overlapping with the window. You can select whether to apply the 
transparency setting or not to each data R/W window. 

 

 
The information of window transparency is not included in the layout information. 

1. Select "VIEW” from the menu bar. 

2. Select "Window Transparency (RUN menu)". 

The transparence setting window is displayed. Default 
value is 0%. The larger value, the higher transparence. 

3. Select desired transparency. 

4. After setting is completed, press the CANCEL key. 

 

Changing Sequence Order of Data R/W Windows 
When two data R/W windows are displayed and are overlapping each other, using this function brings  a 
selected window to the front of the other window or sends to the back.  

1. Press the F1 key. 

The list of currently displayed windows is displayed. 

2. Operate the ENTER key to select a Data R/W window to change the 
order. 

The selected data R/W window is highlighted. 

3. Press the FUNC key and select “Bring to Front” or "Send to Back" 

from the pop-up menu. 

4. After setting is completed, press the CANCEL key. 

Now, the order of the data R/W windows changes. 

 

 

Before replacement  After replacement 

 

 
Replacing Data R/W 

0 and 1  

Selecting a Display Image 

Select how to display images. 

Example) 
 Camera type 

 Image type (Memory / Live) 

 Color image / Gray image / Extracted color image 
 

For details of the setting method, refer to 3.2.2Selecting a Display Image (Image Menu) (page 52). 
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Selecting Pattern Display 

Select patterns to display on the screen window. 

The patterns that can be selected to display or hide are as 
follows. 
 Inspection area, arrow showing a scan direction and 

detect position of a checker 

 Result of geometry calculation 

 Figures set in character/figure drawing 

 Marker 

 Coordinate axis 

 

 
About types of display images and magnification, refer to Chapter 3.2.2 Selecting a Display Image (Image 
Menu), page 52. 

1. Press the F1 key. 

The list of currently displayed window is displayed. 

2. Operate the ENTER key to select a screen window to set. 

3. Select "Pattern Display". 

Pattern Display setting window is displayed. 
 

4. Select “Display” or “Hide” for "Area". 

Area is an inspection area frame of each checker. 
In the right figure, it is indicated with a dotted line. 

5. Select “Display” or “Hide” for "Scan Direction". 

This item is available only when selecting "Display" for "Area". 
"Scan Direction" is an arrow to indicate the scan direction of a 
checker. 
In the right figure, it is indicated at the right edge of the 
upper side. 
Target Checker 
Binary Edge / Gray Edge / Connector (Gray Edge) / Smart 
Edge (Circle) / Smart Edge (Line) 
(including Position Adjustment and Area Size Adjustment) 

6. Select “Display” or “Hide” for "Detect Position". 

Detect Position is a line or mark indicating a position 
detected by each checker. 
The detect position in the right figure is the line and mark at the 
edge of the circle. 

 
 

 

7. Select “All” or “Display NG checkers only”. for “Display Condition”. 

Display NG Checkers Only: 
Displays the area and detect position of checkers judged as NG. 
(Only when selecting "Display" for each item.) 
All (Default): 
Displays the areas and detect positions of all checkers (only when selecting "Display") regardless of 
an inspection result. 
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The "Display Condition" can be set only for the inspection area, scan direction and detected position of a 
checker. 

8. Select “Display” or “Hide” for "Geometry Calculation", "Character/Figure Drawing" and "Marker" 

respectively. 

9. Select “No”, “Origin” or “Image Center” for “Coordinate Axis”. 

[No] (Default): Not display a coordinate axis. (Calibration will be executed.) 
[Origin]: Displays the coordinate axis passing through the origin. 
[Image Center]: Displays the coordinate axis passing through the center of an image. 
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5.3.3 Registering/copying/deleting a Layout 

Registering a Layout 
An arranged display can be saved as a layout (up to 16 layouts). Saving it can switch layouts by a keypad 
operation or a signal input from the external device. 
Be sure to register the adjusted layout and save the setting data by following procedure after layout arranging. 
If you switch to the other layouts or turn off the power of PV200 before registering the setting, the arranged 
layout will be cleared. 

1. Select "LAYOUT" > “Layout” from the menu bar. 

The layout setting window is displayed. 

2. Move the cursor onto the layout number to register. 

 

 
 

 

3. Press the F1 key to register the current layout. 

If another layout has been registered in the selected 
layout No., a confirmation message appears to 
overwrite. Select “Yes” then. 
Now you completed registering. 
However, the layout information has not been saved in 
PV200 yet. 
Note that if turning off the power of PV200 without 
saving the data in the storage space in PV200 in step 
8, the arranged layout will be deleted. 

 

 
Press the F1, F2 or ENTER key while the 
cursor on the layout number list to make 
the settings for layout. The operation of 
each key is shown in the key guide. The 
operation of each key is as below. 
 F1: Save Layout 
 F2: Select Preset 
 ENTER: Switch Layout 

 

4. Press the FUNC key and select “Enter Title” from the pop-up menu. 

Enter a title with the software keyboard as necessary. 

5. Press the CANCEL key. 

6. Switch to SETUP menu. 

7. Select "SAVE/READ" -> “Save Setting Data”. 

8. Save the data in the Storage Space in PV200 or a SD memory card. 

 
Select "TOOL" > "Save Setting Data" to save data in RUN Menu after stopping the operation. 



 

423 

S
etting of O

peration and R
U

N
 M

enu 
C

h. 5 

Copying/deleting Layout 

1. Select "LAYOUT" > “Layout” from the menu bar. 

The layout setting window is displayed. 

2. Move the cursor onto the layout number to copy (or delete). 

3. Press the FUNC key and select “Copy” from the pop-up menu. 

If you want to delete it, select “Delete”. 

4. Move the cursor onto the destination layout 
number, press the FUNC key, and select 
“Paste” from the pop-up menu. 

The layout is copied. 

5. To display or modify the pasted layout, press 
the ENTER key. 

As you press the CANCEL key, the screen shows 
the layout of the previous number displayed before 
displaying the setting window. Also in this case, 
copying is complete.  
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5.3.4 Switching a Layout 

The current layout can be switched to the registered layout. With keypad, you can switch from the layout list or 
pressing the F2 key. 

 
You can also switch it by inputting a signal from the external device. 

Selecting from Layout List 

When many layouts are registered, switching from 
the layout list is suitable. 

1. Select "LAYOUT" > “Layout” from the menu 

bar. 

The layout setting window is displayed. 

2. Select a layout No. to switch to. 

The screen returns to RUN menu and the 
selected layout is shown. 

 

Switching a Layout with the F2 Key 
When registered layouts are less than 10, switching with the F2 key is suitable. 

1. Press the F2 key (: Change Layout) in RUN menu. 

The screen switches to the layout of the next number. 

2. Pressing the F2 key again switches to the layout of the next number. 

Each time you press the F2 key, the screen switches the layout in the registering order. 
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5.3.5 Example of Layout Registration (Starting PV200 with Memory Image on 
Screen Window) 

To change the state of the screen window at startup of PV200 to Memory, follow the procedures below.  

1. Decide the arrangement of screen window. 

Open "Layout" > "Layout" in RUN menu. 
Select the number of screen windows and how to 
arrange from the preset layout No.00 to 09, and press 
the ENTER key. 

 
In the figure on the right, layout No.00 is selected. 
(Screen windows is one.) 
The title bar of the screen window indicates "Live". 

 
 

For the display of the screen window using the preset 
layout, "Live" is set. 

 
 

 
For details of preset layouts, refer to page 416 “5.3.1 
Selecting a Preset Layout”. 
The display image is "Live". 

 

 
 

 

 

2. Change the display of screen windows to Memory. 

Press the F1 key to display the window selection 
menu, and select a target screen window. 
 
Select Screen0 in the figure on the right. 
 
Select "Switch Disp." from Image menu, and set 
"Memory" in "Memory/Live". 
Press the CANCEL key to close Image menu and the 
window selection menu. 

 
The displayed image will be "Memory". 
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Refer to page 52 "3.2.2 Selecting a Display Image 
(Image Menu) for details. 
Also, In "Image menu", the "Magnification" of images 
can be changed, or inspection areas of checkers can 
be switched to be displayed or hidden. Refer to page 
420 “Selecting Pattern Display”. 

 

3. Register displays in Layout. 

The display contents set in "Image menu" are also 
included in layout. The display switched by Image 
menu is a virtual state. If you want to use it afterwards, 
it must be registered.  

 
Select "Layout" > "Layout" for registration. 
Select a number and press the F1 key. 

 
 

The function of the ENTER key in the layout list is 
"Switch Layout". If the ENTER key is pressed by 
mistake, the display will be changed to the previous 
state which was registered in the past. Please be 
aware that. Press the F1 key to register. 

 
 
 

In the figure on the right, the layout is registered in 
No. 11. 

 
 

Refer to page 422 "5.3.3 Registering/copying/deleting 
a Layout” for details. 

 

 F1 key 

 

4. Set “Layout No.”. 

The state of the screen window displayed when the 
startup of PV200 is in accordance with the registered 
content of the layout number specified below. 

 
Set "Layout No." and "Selected Layout No." in 
"Environment" > "System Settings" > "Startup 
Setting". 

 

 
 

In the figure on the right, No.11 registered in the step 3 is specified.  

 
Refer to page 429 "6.2.1 Setting Startup Status (Startup Setting)” for details of this item. 

5. Save the settings. 

Save the settings in the main memory from the menu 
"Save/Read" > "Save Setting Data". 

 

 

 



 

427 

E
nvironm

ent S
ettings (C

hanging S
ystem

 S
ettings) 

C
h. 6 

Chapter 6 
 Environment Settings (Changing System 

Settings) 
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6.1 Overview of ENVIRONMENT 

In ENVIRONMENT in SETUP menu, the following items can be set including inspection conditions except 
checkers. The settings in ENVIRONMENT are the common settings for all Types. 

System Settings 
This menu sets the status of PV200 at startup and in the execution mode. 
 Startup setting Page 429 
 Operation  

- Inspection process in RUN menu Page 431 
- Inspection start, Parallel output reset Page 431 
- Contour Matching Exe. Mode Page 432 
- Type Switch Guarantee Time (ms) Page 432 
- Template Setting Page 431 
- Template Registration Page 188 
- Matching Performance Page 187 
- Menu Display Priority Page 523 
- Date and Time output of General Results Page 592 

 System Register Page 432 

Input/output 
(Page 434) 

This menu sets items on communication with external devices such as parallel I/O and serial port. 

Camera 
This menu sets camera type to use and the polarity of FLASH signal output from PV200. 
 Camera Page 79 
 FLASH polarity Page 80 

Transparence 
(page 439) 

This menu changes transparence of dialogue window in SETUP menu.  

Password 
This is the function to protect from operational errors. Inputting a password is required when switching from 
RUN menu or DEBUG menu to SETUP menu or switching from Select menu to Normal menu.. The function 
prevents changing the inspection conditions by mistake. 

 

 
For the information of operation to switch to SETUP menu, refer to page 448. 

Initialize 
This menu initializes all settings under ENVIRONMENT menu. 
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6.2 System Settings 

6.2.1 Setting Startup Status (Startup Setting) 

From this menu, you can specify product type to call up at startup of PV200 and display contents (layout). 

When you read up the setting data from the storage space of PV200 or a SD memory card, Type and Layout 
you specified with this menu are called up. 

Select Layout at Startup 
Select a layout as a startup in RUN menu from the registered layout number. 

If the specified layout No. does not exist, the window is displayed in the default layout (same as the preset 
layout No.0). At that time, the current layout number displayed on the screen appears as "--". 

 
For details about adjustment or registration of layouts, refer to Chapter 5.3, page 415. 

1. Select "Startup Setting" in “System Settings” 

setting window. 

2. Set “Layout No.”. 

 
Last Layout No.: Reads the layout again selected right before turning off the power. The 

setting is done if you select this. 
Selected Layout No. (default):  Reads the layout No. specified after. 

3. Select “Select Layout No.” (default: 0). 

The list of layout number is displayed. 

4. Select a desired layout No. 

5. Press the CANCEL key. 

 

 
The last layout No. is held by using the backup battery. When the battery runs out or no battery is installed, 
the layout number 00 is read. If the layout number 00 is not set, the preset layout number 0 is read. 
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Selecting a Type to Be Read at StartupSelect a type 
to read at startup. 

 
Also from the type switching window, the setting of a type to read at startup can be changed. Refer to page 76 
for details. 

1. Select "Setup Setting" in “System Settings” setting window. 

2. Select “Type No.” 

Last Type No. (default): Reads again the type selected right before turning off the power. The 
setting is done if you select this. 

Selected Type No.: Reads the type No. specified after. 

3. Specify a type No. to read in “Select Type No.”. 

4. After setting is completed, press the CANCEL key. 

 

 
The last type No. is held by using the backup battery on the back of PV200. When the battery runs out 
or no battery is installed, the type with the smallest number from the existing types is called up.  Also, if 
the type specified in "Select Type No." does not exist at startup, the type with the smallest number 
from the existing types is called up.  

Displaying or Hiding Comments for Setting Data in 
Information Display Area in RUN Menu and DEBUG 
Menu 

It is possible to choose whether to display or hide the comments for setting data in the information display 
area in RUN menu and DEBUG menu. 

 
For details of how to edit comments for setting data, refer to page 383. 

 

1. Select "Startup Setting" in “System 

Settings” setting window. 

 

 

2. Select "Yes" or "No" for "Setting Data 
Info. View". 

The default is "Yes". 
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6.2.2 Inspection Process and Output Timing 

Selecting Inspection Process 
To reduce inspection time when the tact time is short, change operation mode. 

 

Serial processing 

 

The inspection time displayed on the screen is 
as shown in the right figure. 

In serial processing, the process from "Image 
Capture" to "Result Output" in the right figure 
is regarded as one process. The START signal 
of the next inspection can be accepted after all 
those operations are completed. 
START signal cannot be input until READY 
signal turns on. 

Parallel processing 

Parallel processing is a mode to perform 
inspections concurrently. 
 
As the next image can be captured after image 
capturing is complete, the inspection time can 
be reduced as the right figure. 
However, the third image capturing cannot 
executed until the first inspection result is 
output. 
The third START signal can be input after 
REND signal turns on. 
 
The screen shows time and cycle of 
inspection. 

1. Select “System Settings” > "Operation". 

The setting window of operation is displayed. 

2. Select “Serial” or “Parallel” for “Inspection Process”. 

Default: Serial 

Parallel I/O Reset Condition 
This item is to select reset timing of OUT signal when outputting inspection result through Parallel I/O connector 
and Parallel I/O terminal. 
Hold (default): To hold until outputting the next result.  

When the first and second inspections turn on OUT0 signal, the signal keeps ON until the third 
output of inspection result without turning off. 

Reset: All OUT signals turn off when TACT signal turns off. 

 
Refer to Chapter 10.3 “Timing Chart” (page 562) for details. 
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Inspecting with Internal Trigger 
 (Continuous Inspection) 

This method executes inspections repeatedly before receiving START signal from the external device. This is 
"Continuous Inspection” and helpful to inspect continuously due to a long object. A signal input from the 
external device can stop repeating inspections. To stop inspections with the keypad, press the TRIG key when 
inspections are executed repeatedly. Press the TRIG key again to restart inspections repeatedly. 

1. Select “System Settings” > "Operation". 

The setting window of operation is displayed. 

2. Select whether you inspect repeatedly in “Continuous Inspection”. 

No (Once) (default): Executes an inspection by START signal input. 

Automatic: After Trigger: After PV200 starts up, inputting START signal at the start of the first 
inspection executes inspections repeatedly. 

Automatic: After Power On: After PV200 starts up, inspection is repeatedly executed soon. START 
signal input is not necessary. 

Selecting Contour Matching Execution Mode  
For using contour matching in the detection algorithm compatible with Ver.1.3, you need to change the 
mode. 

1. Select “System Settings” > "Operation". 

The setting window of operation is displayed. 

2. Select "Standard mode" or "Ver.1.3 compatible mode" for "Contour Matching Exe. Mode". 

 
Standard mode (Default): Operates using the detection algorithm available from Ver.1.4, which 

enables multiple detection. 

Ver.1.3 compatible mode Operates using the detection algorithm compatible with Ver.1.3. 

  

Type Switch Guarantee Time (ms)  
If an external device such as PLC cannot detect the READY signal OFF because the type switching time is 
too short, the OFF time of READY signal when switching type can be extended by setting the type switch 
guarantee time. 

The READY signal time when switching type is the longest time of "Type Switch Guarantee Time", "REND 
OFF Min. (Refer to page 436)" and "Actual type switching time". 

When switching type to the current type number, the type switching is not performed. However, when 
setting the type switch guarantee time, the READY signal turns OFF just for the set time.  

1. Select “System Settings” > "Operation". 

The setting window of operation is displayed. 

2. Specify “Type Switch Guarantee Time”. 

Settable Range: 0 (default) to 1000 (ms) 
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6.2.3 Setting Default Variable (System Register) 

PV200 offers eight value registers. These registers can be used in an expression of numerical calculation, or 
can be referred for a drawing position or figure size of character/figure drawing. 

The values of the registers can be changed by inputting a command through COM interface or Ethernet 
interface from the external device. 

Setting Default Value to Store in Registers 
The value can be changed and read from the external device. 

1. Select "System Register" in “System Settings” setting window. 

2. Select register No. to change the value. 

3. Specify the value and press the ENTER key. 

The available values range from -9,999,999.999 to +9,999,999.999. 
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6.3 Input/output 
This function assigns functions of signals input from the external device to PV200, and makes settings on 
outputting result data and images. 

 

PLC Communication: Setting of general output and command control in PLC 
communication 

 Page 589 

Parallel I/O: Setting of the minimum OFF time of READ END signal, and 
assignment of ASSIGN0-1 and EXTRA0-2 signals. 

 Page 436 

Parallel I/O Output: Setting of outputting inspection results through I/O interface 

(Selecting the destination and output data, setting output 
method) 

 Page 357 

Serial: Setting of communication condition of COM.0 port (transmission 
format) 

 Page 435 

General output: Setting of outputting inspection results through COM(serial), 
Ethernet and SD memory card interface. 

 Page 363 

Image output: Setting of outputting inspection images to the external device 

(Selecting the destination and output camera image, setting 
output method) 

 Page 367 

Save Image Memory: Setting to save inspection images in the image memory of PV  Page 375 

Print Screen: Selecting a saving place of screen capture  Page 68 

SD Card Setting: Setting to allow writing when the cover of the SD card 
insertion slot is open. 

 Page 438 

FTP server: Setting to allow using the FTP server function.  Page 439 

FTP Client: Setting relating to the connection with FTP server.  Page 443 

Displaying Input/Output Window 

1. Select "ENVIRONMENT" from the menu 
bar. 

2. Select "Input/Output". 

The screen of communication setting is 
displayed. 

 
 



 

435 

E
nvironm

ent S
ettings (C

hanging S
ystem

 S
ettings) 

C
h. 6 

Selecting Output Timing of General Results and 
Images 

Specify output timing of inspection results (general results) and inspection images to the external devices. 
 

Output Results: 
Synchronous: When outputting all results are completed, an inspection is complete. Because the 

time of outputting general results is included, its inspection time is longer than 
Asynchronous processing. 

Asynchronous: An inspection is complete before outputting results, and PV200 completes data 
output until the next inspection result output. Because the time of outputting 
general results is NOT included, its inspection time is shorter than Synchronous 
processing. 

 

Image Output: 
Synchronous: An inspection is complete after image output is completed. Because the time of 

outputting images is included, its inspection time is longer than the other two 
options. 

Asynchronous 
(image output first):  

An inspection is complete before outputting images, and then PV200 outputs 
images when it can. When the interval of START signal input (the period between 
inspection start and the next inspection start) is short, and Image Output is not 
completed after several inspections, PV200 completes Image Output by delaying 
the next inspection start. 

Asynchronous 
(inspection first):  

An inspection is complete before outputting images, and then PV200 outputs 
images when it can. When the interval of START signal input (the period between 
inspection start and the next inspection start) is short, and image output is not 
completed, PV200 internally stores images up to a certain number as images to be 
output. If the number of images exceeds the storable capacity, new images cannot 
be stored in PV200 until enough space for storing is created by outputting the 
images that have been stored in PV sequentially. Inspections are executed on 
images that cannot be stored, however, image output is not executed.  

 

1. Select “Input/Output” >  “General 

Output”. 

The setting window of General Output is 
displayed. 
Select a destination. 

2. Specify “Operation”. 

Default: Synchronous 

3. Select “Input/Output” >  "Image 
Output". 

The setting window of Image Output is 
displayed. 

4. Specify “Image Output”. 

Default: Synchronous 
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6.3.1 Changing Setting of I/O Terminals (Parallel I/O) 

Set the minimum OFF time of READ END signal and Error signal OFF Timing. And also, assign functions to 
ASSIGN0-1 and EXTRA0-2 when operating by inputting signals toy/O terminals ASSIGN0-1 and 
EXTRA0-2 from the external device. 

 
See chapter 10: Operation and Data Output through I/O Terminals, page 545. 

1. Select "Parallel I/O" in the input/output setting window. 

The parallel setting window is displayed. 

2. Specify “REND OFF Min.”. 

Settable Range: 0 (default) to 1000 
Set these items when external devices such as a PLC cannot detect signal switch between ON and OFF 
because the OFF time of READ END signal is too short. 

 
The REND OFF minimum time cannot be specified when "Continuous Inspection" and "Parallel" 
inspection process is set. 

3. Specify “ERR Signal Off Timing” and “ERR ON Min.(ms)” . 

Auto 
(default) 

Set these items when external devices such as a PLC cannot detect signal switch 
between OFF and ON because the ON time of ERR signal is too short. 
The ERR signal is ON until the normal end of the next operation (such as inspection 
execution or command input) from the occurrence of the error, and then turns OFF. 
However, if the next operation normally ends before the ERR ON Minimum Time, 
the ERR signal stays ON for the specified time and then turns OFF. Measuring the 
ERR minimum time is started when the ERR signal turns ON from OFF, and will not 
be reset until the ERR signal turns OFF. 
When an error reset is input from parallel I/O or communication port, the ERR signal 
turns OFF regardless of the set time of “ERR ON Min.”. 

 ERR ON Min.(ms) Settable Range: 0 (default) to 1000 (ms) 

External Input After the occurrence of an error, the ERR signal stays ON until an error reset is input 
from the parallel I/O or communication port. The ERR signal does not turn OFF even 
if the next operation (such as inspection execution or command input) normally ends.  

 

4. In “Set Signal ASSIGN0” to "Set Signal ASSIGN1" and “Set EXTRA0” to "Set EXTRA2, assign 
functions as needed. 

Default assignment setting 
ASSIGN0: Select Type 
ASSIGN1: Switch Layout 
EXTRA0: ACK 
EXTRA1: Reset Error 
EXTRA2: Reset Statistics 
 

 
Refer to page 551 for details of assignable functions. 

5. After setting is completed, press the CANCEL key. 
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6.3.2 Changing Communication Condition of COM port (Serial) 

This is a setting of the COM port for RS-232C communication. Specify the setting values to the same as that for 
the external device to communicate. 

Item Option Description 

Baud Rate 
(bps) 

1200/ 2400/ 4800/ 9600/ 19200/ 
38400/ 57600/ 115200 (Factory 
default: 9600) 

Transmission speed for communication. The 
higher number the faster communication speed. 

Bit Length 7 / 8 (Factory default: 8) To set the bit number per letter. 

Stop Bit 1 / 2 (Factory default: 1) To set the bit number of the signal that recognizes 
the end of data. 

Parity Check None/ Odd/ Even (Factory default: 
Odd) 

To set the number of overhead bits to check for 
proper data transmission. 

Flow Control None/Soft Flow (Factory default: 
None) 

To set how to control the handshake flow. 

A Series 
Compatible  

Not Use / Use (Factory default: Not 
Use) 

To select whether to keep using serial commands 
that have been used in A series when the mode 
you use is changed from our old model A series to 
PV200. (However, that is not full compatible.) 

Capture End No / Output (Factory default: No) To select whether to output a capture end 
command from PV200 or not when A Series 
Compatible is set to “Yes”. (Command in A 
series: %R) 

Inspection 
End 

No / Output (Factory default: No) To select whether to output a inspection end 
command from PV200 or not when A Series 
Compatible is set to “Yes”. (Command in A 
series: %E) 

 
 When the communication type for "PLC Communication" is set to [Serial], [Default [PLC]] can be 

selected. By using this function, you can easily change the setting to the default for the selected PLC 
model. 

 When "PLC Type" is set to "Mitsubishi: MELSEC-FX (older ver.)" or "Fuji: MICREX-SX" and "PLC 
Communication" is selected for the serial protocol, the communication condition is fixed and 
cannot be changed according to that of the destination PLC. 

 When the communication type for "PLC 
Communication" is set to [Serial], 
[Default [PLC]] can be selected. By 
using this function, you can easily 
change the setting to the default for the 
selected PLC model. 

 When "PLC Type" is set to "Mitsubishi: 
MELSEC-FX (older ver.)" or "Fuji: 
MICREX-SX" and "PLC 
Communication" is selected for the 
serial protocol, the communication 
condition is fixed and cannot be 
changed according to that of the 
destination PLC. 

 For details of  A Series Compatible, 
refer to page 618. 
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6.3.3 Enabling to Write in SD Memory Card 

Set whether or not to allow writing in a SD memory card if the cover is open when outputting results, 
images, and saving them, or printing screens. 

1. Select "SD Card Setting" in the 
input/output setting window. 

The window of SD Card Setting is displayed. 

2. Specify "Write When Cover is Open". 

Disable: Writing is not available when the 
cover is open. 
Enable: Writing is available regardless of 
whether or not the cover is open. 

 

Messages displayed when operating keypad 
 
If a writing error occurs when operating with the keypad in SETUP menu and RUN menu, either of two 
messages shown on the right is displayed on the monitor.  
 

Displayed in the center of monitor Displayed in the key guide 

 

 

Error messages in RUN menu 
In RUN menu, when writing cannot be executed as the setting of "Write When Cover is Open" is "Disable", 
either of the following error numbers is displayed. 

Those messages are displayed when a signal to write(*) is sent from an external device. When a writing error 
occurs due to the keypad operation, the above messages are displayed, and the error codes are not displayed. 

However, as for general output and image output, the codes are displayed even when an inspection start 
signal is input with the keypad. 

* Input by parallel signals (ASSIGN0-1, EXTRA0-2), communication command input through serial, 
Ethernet 

 
Error No. Situation when error occurred Details 

0216 When saving setting data (to SD card) Communication command : %CW 

0255 When outputting general result (to SD 
card) 

When selecting SD Card in “ENVIRONMENT” >  
"Input/Output" > “General Output”, and setting 
"Error Output" to “Yes” 

0255 When outputting image When selecting SD Card in “ENVIRONMENT” >  
"Input/Output" > "Image Output", and setting "Error 
signal ON at Output Error" to “Yes” 

0260 When saving images stored in Image 
Memory of PV into SD card 

Communication command : %SS 

0265 When printing screen Communication command : %PS 
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6.3.4 Setting FTP Server 

Set it to enable the FTP Server function in PV200. Using this function enables data access to an SD card in 
PV200 via a network, and files in the SD card (such as inspection result data, inspection images, screen shot 
data) can be referred or written freely. 

 
 Up to five users can access PV200, and it is possible to individually restrict access for each user. 

 It is possible to access files by an anonymous user.  

One-to-one communication between PV200 
(FTP server) and FTP client (PC) 

One-to-n communication between PV200 (FTP 
server) and FTP client (PC) 
(Up to five clients can be connected.)  

 

 
A FTP client application is required on PCs to use the FTP function.  

Example of FTP client application 
 Web browser with FTP client function (such as Internet Explorer) 

 Command prompt (when using Windows) 

 Dedicated FTP client software 

Setting for using FTP Server 

1. Select "ENVIRONMENT" > “Input/Output” from the 

menu bar. 

2. Select "FTP Server". 

3. Specify “FTP Server”. 

Not Use (Default) : FTP Server function is not 
used. 

Use : FTP Server function is used. 
 

 

 

 
 When setting data in Ver.1.640 or older has been loaded, the FTP Server setting is set to the default 

"Not Use". However, if there is not enough free data space for FTP settings, FTP settings may not be 
made. At this time, a message as below appears when opening the FTP settings menu. Secure data 
free space for using the FTP server function.  
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Registering FTP User Account 
Set user accounts to access the PV200 FTP server. 

1. Specify "Anonymous Access". 

Valid 

(Default) 

: Permits the access by 
anonymous users. 

Invalid : Permits the access only by 
registered user names and 
passwords. 

 
 No password is required for the access 

by anonymous users. 

 User-specified access is not possible 
when accessing by an anonymous user. 

 

 
 

 

 

 

2. (When selecting "Invalid" at step 1) Move the 
cursor on the user account input field and set 
accounts. 

 
When setting "Anonymous Access" to "Valid" at step 
1, user accounts cannot be set. 

 

3. Select a line, and set a user name, password and 
access authority. 

 

4. Press the CANCEL key, and press the OK button 
to fix the settings. 

 

 
 

 

 

User account 

Item Description Remarks 

User Name Up to 15 characters can be 
registered. 

A registration error will occur when no user name is 
input or a user name that has been already 
registered is input.  

 
Password Up to 15 characters can be 

registered. 
Even when no password is input, registration can be 
made. 

Access 
Authority 

Select "Read" or "Read/Write". 
(Default: Read) 

"Read": Only reading files is possible. 
"Read/Write": Reading files and registering/deleting 
files are possible. 

 
 One-byte alphanumeric characters (case-sensitive), spaces, and symbols are usable for registering 

user names and passwords. 

 In the case of the access by an anonymous user, both reading and writing to files are possible.  
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Editing FTP User Account 

1. Select an appropriate user name 
and press the ENTER key. 

2. Correct a desired item. 

 

 
 

3. Press the CANCEL key, and press 
the OK button to fix the correction.  

Deleting FTP User Account 

1. Click the input field of the user 
name you want to delete, and press 
the FUNC key. 

The pop-up menu "Delete" appears. 

2. Press "Delete". 

 

 

3. When the message asking to 
confirm deleting the account 
appears, press the OK button.  

 
 If setting data is updated when a user is logging in, the access authority of users that have been already  

authenticated will continue until the user logs out. 

 If the access authority of a user is changed, the access authority at the time of login will be applied if 
the user has already logged in. A new access authority will be applied at the time of next login. Even 
when the "FTP Server" setting is changed to "Not Use", the access by a user that has been already 
authenticated will be valid until the user logs out.  
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Duplicate data access to an SD card 
When there is duplicate access to an SD card from PV200 and a PC (FTP client), the following operations 
will occur. Be aware that the operations are not overlapped when using this function. 
Function Situation Operation to be occurred 

Image Output When the number of 
saved folders exceeds the 
upper limit 

When outputting inspection images to an SD card or 
the number of folders exceeds while saving command 
communication logs, normally, a new folder will be 
created after executing the deletion of the oldest 
folder. However, if an image in this oldest folder is 
downloaded or uploaded by an FTP client during the 
execution of deletion, competition will occur. At this 
time, only the data that is being accessed by the FTP 
client will remain and other files will be deleted. 

Saving of command 
communication log 

Saving of Image memory When image memory data 
is deleted 

If data is downloaded or uploaded by an FTP client 
while PV200 tries to delete its image memory, 
competition will occur. In this case, a part of the data 
will be deleted. However, competitive data and 
subsequent data will remain. 

Saving of setting data When comments of setting 
data are edited 

If setting data in which comments are being edited is 
downloaded or uploaded by an FTP client, competition 
will occur. At this time, the comments of the setting 
data will not be edited. 

Reading of image When an image is read 
from an SD card 

When an image for which data is being written is 
displayed on an FTP client side, the correct image may 
not be displayed. 

Saving of image When a test image in an 
SD card is deleted 

If data about to be deleted is downloaded or uploaded 
by an FTP client, competition will occur, and the data 
will be deleted. 

Unsupported FTP commands 
The following FTP commands are not supported for the PV200 FTP server function.  

ACCT Account information 

ALLO Assign enough disk space for receiving files. 

REIN Reinitialize connections. 

REST Restart file transmission from a specified point. 

SITE Send a command which is peculiar to a remote server that is not defined in RFC.  

SMNT Mount file structure. 

STOU Upload files without duplicate file name. 
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6.3.5 FTP Client Function 

(Available from Ver.2.0) 
FTP Client Server function is a function to transfer data and image files between PV200 and FTP server using file 
transfer protocol (FTP). FTP server can be specified as the output destination of general results and inspection 
images. 

Processing image of FTP file transfer 
 

 
 

* NAS (network attached storage) equipped with FTP server function can be used. 

Setting for using FTP Client 

1. Select "ENVIRONMENT" > “Input/Output” > “FTP 

Client” from the menu bar. 

2. Set the IP address of a connected server to be 
used as FTP client. 

Default: 192.168.1.10 

3. Set Anonymous Access to "Valid" or "Invalid". 

Default: Valid 
When Anonymous Access is set to Valid, log-in is 
available with anonymous access only. Please 
proceed to the step 6. 
When Anonymous Access is set to "Invalid", a user 
name and password is required. Please proceed to 
the step 4. 

4. Enter a user name. 

Default: Unset 
Set a user name to connect to the server. 
A maximum of 16 characters can be input. A login 
error will occur when no user name is input. 

5. Enter a password. 

Default: Unset 
A maximum of 15 characters can be input. It is 
displayed as "*" after the entry. 

 
 

 

 

 

 

 

 

 

 

 

 

 The IP address, user name and password of FTP server depends on the setting of FTP server. 
Confirm the setting of the FTP server you use in advance. 
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6. Set "Root Folder Name" of the storage destination. 

Default: PV200 
A maximum of 32 characters can be input. (Sub folder 
can also be specified.) 
The folder name should be set with ASCII code. 
However, the following symbols cannot be used for 
folder names. 
* / : < > and space 

7. Set "User Folder Name". 

Settings: User ID (Default) / Use / Not use 
When selecting "Use", enter the folder name. 
The folder name should be set with ASCII code. 
However, the following symbols cannot be used for 
folder names. 
* / : < > and space 
 
When "User ID" is selected while Anonymous Access is 
valid, the IP address of PV200 is set as the user folder 
name. 

8. Set "Method for writing the result data". 

Settings: Write append (Default) / Write 1 file every 

9. Press the Execution button of "Connecting Server" 
to confirm whether PV200 operates correctly with 
the above settings or not. 

 

 
 

 

 

 

 

 

 

 

 
 

Error Messages and Solutions 

 Error message Solution 

1 “PV couldn't connect to FTP Server.” Confirm that the specified IP address is 
correct. 

2 "PV couldn't create the root folder. You create the root folder 
by using the utility of FTP Server, please." 

Create a root folder on FTP server side. 
Depending on the specifications of FTP 
server, the root folder may not be created 
by PV200 or the number of enterable 
characters may be limited. 

3 "PV couldn't create the user folder. You confirm the setting 
of FTP Server, please." 

Check the settings of FTP server. 
Depending on the remaining capacity of 
FTP server, the folder may not be created 
by PV200. 

4 "PV failed test writing the result data. You confirm the setting 
of FTP Server, please." 

Check the settings of FTP server, and 
change the setting of "Method for writing 
the result data" to "Write 1 file every" as 
necessary. Depending on the 
specifications of FTP server, "Write 
append" may not be used. 

5 "PV failed test for append writing. Do you change to Write 1 
file every?" 

6 "User Name doesn't set. Please, register User Name, 
again." 

Set the user name correctly. 

7 "'Save Root Folder Name' is abnormal. Please, register 
'Save Root Folder Name', again." 

Set the root folder correctly. 

8 "User Folder doesn't set. Please, register User Folder, 
again." 

Set the user folder correctly. 
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The login and logout conditions to FTP server are as follows.  

Login Logout 
When the screen is switched 
to RUN menu 

When the screen is switched 
to SETUP menu 

When operation restarts in 
RUN menu 

When operation stops in 
RUN menu 

* When setting data is changed during operation, it will be logged out on completion of reading new setting 
data. 

Specifications and Storage Location of Output Destination 
Folders 

Up to 1000 files are saved in one folder. A new folder is created and files are saved in when any of the 
following conditions is met. 

- When the number of files in the folder exceeds 1000 
- When the date format of the PV setting is changed 
- When PV200 is rebooted 

Image output 
Storage destination 

\Root Folder Name\User Folder Name\Image\ 

General Output 

As for general output , depending on the setting of Method for writing the result data, the folder hierarchy 
saved in FTP server changes. 

Writing method Storage destination Details 

Write append ¥Root Folder Name¥User Folder Name¥Result¥ Records of result data are 
added to one file. 

Write 1 file every ¥Root Folder Name¥User Folder 
Name¥Result¥YYMMDDHHMMDD 

Individual result data is saved 
in date folder. 

* The date of the folder name is the date and time of PV200 at the time of the folder creation.  

 
 Depending on the types of FTP server, "Write append" may not be used. Confirm whether the used 

FTP server supports "APPE command" in advance. APPE command is an FTP command used for 
"Write append". 

Outputting General Results to FTP Server 

1. Select "ENVIRONMENT" > “Input/Output” > 

“General Output” from the menu bar. 

2. Set "Output" of "SD/FTP" to "FTP". 

3. Select items to be output and set to "Yes". 

Once an inspection is executed, output data is output 
to FTP server according to the output conditions. 
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Outputting Inspection Images to FTP Server 

1. Select "ENVIRONMENT" > “Input/Output” > “Image 

Output” from the menu bar. 

2. Set "Destination" to "FTP". 

3. Set the output conditions of images. 

Once an inspection is executed, inspection images are 
output to FTP server according to the output conditions. 
For details of the settings of image output conditions, 
refer to "4.13.3 Selecting an Image Output Condition" 
on page 334. 

 
 

 
When outputting inspection images to FTP server, do not use spaces in the character string of "File 
Header" of "Image file setting". If the image file name contains a space, images cannot be saved in FTP 
server. Error code E0255 is displayed. 

Error Code Output Setting 

When an error occurs in the communication with FTP server, error code E0255 is displayed.  For details of 
error codes, refer to "10.2.3 Cause of Turning On ERROR Signal" on page 556. 
The setting of error code output is available in General Output and Image Output.  
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6.4 Changing Window Transparency of SETUP Menu 
You can change the transparence of the setting window displayed after selecting the submenu. You can 
recognize a screen window behind the setting window. It is useful to observe an image while making settings. 

 
The procedure for setting transparence described below is for SETUP menu. The transparence in RUN menu 
needs to be set with the VIEW setting in RUN menu. 

1. Select “ENVIRONMENT” >  “Transparence” 

from the menu bar. 

2. Select "Window Transparency (SETUP 
Menu)". 

Default value is 0%. The larger value, the higher 
transparence. 

3. Select desired transparence. 

Only highlighting a value updates the 
transparence of the window. Observe it to set. 

4. After setting is completed, press the CANCEL 
key. 

 

 

 
The window transparency (SETUP Menu) can be also changed in the "Image Menu" opened by pressing 
the F1 key. 
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6.5 Protecting Setting Data From Incorrect Operations 

Protecting Data Using a Password 
Inputting a password is required when switching from RUN menu to SETUP menu, switching from the select 
menu to the normal menu in SETUP menu, or opening a checker using [Result] in DEBUG menu. The function 
prevents changing the inspection conditions by mistake. 

1. Select "Password". 

The password setting window is displayed. 

2. Set "Password Setting” to “Valid". 

Valid (Switching to SETUP menu is Restricted): 
Password is required when switching to SETUP menu. 
Valid (Switching to Normal menu is Restricted): 
Password is required when switching from Select menu to 
Normal menu. 
Invalid (default): 
You can switch to SETUP menu or Normal menu without a 
password. 

 
Password is also required when reading the setting data in 
which "Password" is set to "Valid" from a SD card or PVWIN200. 

3. Select “Password” and enter a password with the software 

keyboard. 

Set a password in 15 letters. 

4. Select “Yes” or “No” for "Save Changes in RUN Menu". 

Some data can be modified in RUN menu where a password is 
not required. Select whether you permit saving modified data. 
Yes (default): 
To add [Save Setting Data] menu in [Tool] of RUN menu to save 
the data also in RUN menu . 
No: 
Not to display [Save Setting Data] menu under "TOOL" in 
RUN menu. 

 
 

 
 

 

Prohibiting the operation from the keypad 

The PV200 has "Keypad is invalid" function to disable various operations such as switching the menu to 
SETUP MENU with the keypad and editing in RUN MENU as a function to protect the PV200 from incorrect 
operations. When this function has been specified, "Keypad is invalid" is displayed in the key guide space 
on the window. 

Switching the keypad operation between Invalid and Valid is executed with an exclusive communication 
command. Refer to page 606 or page 652 for details. 

 

 
While PV200 is not energized, the information on keypad operation status is saved with the power of the 
backup battery. To use this function, open the cover on the back and connect the battery with PV200.  
(Before shipment, the battery and PV200 are not connected.) 

 How to attach a backup battery: page 15 
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6.6 Initializing Environment Settings 
This function initializes the Environment data and restores it to the default settings. 

1. Select “ENVIRONMENT” >  “Initialize” from the menu bar. 

The confirmation message appears. 

2. Select “Yes”. 

Environment data are initialized. 
If you select “No”, initializing is canceled. 

 

 

 
As the information of layouts specified in RUN menu is included in "ENVIRONMENT", it is also 
initialized by executing "Initialize" of "ENVIRONMENT". 
 
Initializing Environment might shows the message below when “Common” is selected for “Template 

Registration” in “System Settings” > “Operation”. 
 

Free space for template areas is used up. You cannot change the setting of “Template Registration” to “Per 

Checker”. 
 

In the case, the settings are initialized except “Template Registration” setting which holds “Common”. Refer 
to page 188 about the reason why you cannot change to “Per Checker”. 
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Chapter 7 
 Changing Configuration (TOOL) 
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7.1 Overview of TOOL 

With “TOOL” in SETUP menu, the following can be performed; settings, information display, and updating of 
PV200 you use, adjustment support of optical parts and communication test at the introduction. In addition, you 
can switch the mode to communication with PVWIN200, which is software of setting and simulation for PV 
series. 

PC Communication  
This switches the mode to communication with PVWIN200, which is software of setting and simulation for 
PV200. 

General Settings 
Start Setting  
Specify the setting data to be read when PV200 is powered on.  

 
To specify a type No. and a layout No. to read at startup, select [ENVIRONMENT]. 

 Network 
This is necessary setting to perform Ethernet communication. 

 Calendar 
It adjusts the calendar in PV200. 

 
Be sure to use this function attaching the backup battery (refer to page 15). 

 Language 
This switches between languages of the menus. 

 Initialize 
This restores the settings of PV to the default. 

SD Property 
This is for confirming the property of a SD memory card (such as saved contents or information of a SD 
memory card). 

Files or folders can be deleted.  

Eject SD Card 
Select this before ejecting a SD memory card from PV. 

Information 
It displays the version information on your PV200 and memory usage. 

Setting Help 
This function supports to make setting of optical parts of PV200, to confirm the communication, and its 
adjustment for introduction. 

• Focus Adjustment To adjust focus of the lens. Rotate the focus ring of the lens following the 
displayed message. 

• Aperture Adjustment To adjust aperture of the lens. Rotate the aperture ring (iris ring) of the lens 
following the displayed message. 

• Gray Data Analysis To display the grayscale level of the image in the linear area in a graph form. 

• Capture Delay Control To decide optimum capture conditions by capturing and displaying images 
while changing the condition for each camera. 

• I/O Test To check the connections of I/O connector and I/O terminal block with the 
external devices. 

• Communication Test To test the communication with the external devices connected to COM port 
and Ethernet port. 

Update 
It performs upgrading of PV200 and customizing the splash screen. 
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7.2 General Settings 
The settings made in “General” are saved in PV200. You cannot backup the data into the storage space in 
PV200 or a SD memory card. 

 
As you press the CANCEL key to return to the upper menu hierarchy from “General”, the screen displays a 
message to save the modified settings. Be sure to select “Yes” to save the data in PV when you modified the 
settings. 

7.2.1 Specifying Data to be Read to Execution Memory  

Specify the data to be read at startup saved in "Storage Space in PV200" or a SD card. 

 
 For details of the execution memory and storage space of PV200, refer to page 382 (4.18.1 Saving 

Setting Data). 

 To specify a type No. and a layout No. to read at startup, select “ENVIRONMENT”. For details, refer 
to page 429 (6.2.1 Setting Startup Status (Startup Setting)).System Settings 
 

 

1. Select "TOOL” > “General” from the menu 

bar. 

2. Select "Setup Setting". 

3. Select "Start with Memory". 

Select “Storage Space in PV200” or "SD 
Card". 
 

4. Select an area No. where the setting data 
to be read at startup is stored. 

This item is selectable when "Start with 
Memory" is set to "SD Card". 
0 to 99 (Initial Value: 0) 
 

If the general settings are saved, the setting data 
specified here will be loaded into the execution 
memory when starting PV200 next time. 

 

 
 If there is no data in the specified memory, PV200 starts in the initial condition with no settings. The 

message "Environment and Type data has been initialized because the data could not be loaded." is 
displayed at the startup. Press the ENTER key or CANCEL key. 
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7.2.2 Changing Network Setting 

Set a device name and make TCP/IP setting which is necessary to perform Ethernet communication. 

 
The port number of PV200 depends on type of communication data. 
 General output: 8601 

 Image output: 8602 

 Command* communication: 8604 (*See page 598.) 

Changing IP address 

1. Select "TOOL” > “General” from the menu bar. 

2. Select "Network". 

3. Change "IP Address”. 

Change the subnet mask and default gateway as 
necessary. 

 

Default setting 
IP Address: 192. 168. 1. 5 
Subnet Mask: 255. 255. 255. 0 
Default Gateway: 192. 168. 1. 1 

4. After setting is completed, press “Set” button. 

Pressing the CANCEL key before the “Set” button clears the change. 

Changing Device Name 

1. Select “Device Name” in “Network” setting window. 

2. Enter a device name with the software keyboard. 

3. After inputting is completed, select the ENTER on the keyboard. 

The entered name is displayed. 

4. Press the CANCEL key to close the “General” setting window. 

You do not need to press the “Set” button. 
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7.2.3 Adjusting Calendar Date 

Set the date and time of the built-in clock. The date recorded when outputting data is the date of this calendar. 
 

While PV200 is not energized, the information on calendar is saved with the power of the backup battery. To 
use calendar function, connect the battery inside the battery case lid on the front face with PV200. (Before 
shipment, the battery and PV200 are not connected.) 

 
For the information of how to attach a battery, refer to page 15. 

Adjusting Calendar Date 

1. Select "TOOL” > “General” from the menu bar. 

2. Select "Calendar". 

3. Select “Date Format”. 

For example, the date of August 1st in 2010 is 
displayed as bellow by format. 
[YYYY/MM/DD] (default) : 2010/12/01 
[MM/DD/YYYY]: 12/01/2010 
[DD/MM/YYYY]: 01/12/2010 

4. Adjust year, month, day, hour, and minute. 
 

5. After setting is completed, press “Set” button. 

The changed date is saved and the adjusted date and time are displayed on the top of the setting window. 
Pressing the CANCEL key before the “Set” button clears the change. 

6. After setting is completed, press the CANCEL key. 

 
Calendar date can be read and written with communication port. 

7.2.4 Switching Language 

The displayed language can be switched. 

1. Select "TOOL” > “General” from the menu bar. 

2. Select "Language". 

Settable languages are displayed. 
Japanese 
English 
Simplified Chinese 
Korean 
Traditional Chinese 

3. Select a language to use. 

4. Press the CANCEL key. 

When the confirmation message appears, select “OK" 

to switch the language on the screen. 
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7.2.5 Setting User Account 

The menu operation with the keypad can be limited for each account by setting user accounts. Up to eight 
accounts can be created including default Admin and Start User. Use this function for limiting functions 
available for each account by users. 

 
This function controls the operation level of each user by limiting the PV200 operat ions for each registered 
account. However, the account setting can be changed or initialized freely from PVWIN200.  

 

Logging in and out of an account can be executed from RUN Menu. 
 Switching User (Switch User) page 48Switching User (Switch User)Switching User (Switch 

User) 

 
 

 

Account SettingWindow 

 
 Account Setting is only available when the access authority of logged-in user is "Admin". When a 

user other than "Admin" logs in, the account setting window is not displayed.  

 
 

 Item Description 

1 Account Setting Set whether to use the account function or not. 

2 Login time user name 
display 

Set whether to display user names in the pull-down menu at the time of login 
or not. 
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3 User Name: Admin User having an administrator authority. It is set as the number 0 in the list of 
User Name as the default. 

4 User Name: StartUser 

User at the startup. It is set as the number 1 in the list of User Name as the 
default. 
When the account function is used, PV200 is always powered on with this 
user account. If the Admin user or a general user logs out, the account will 
be switched to this Start User. 

5 User Name Field to display user accounts that are added arbitrarily. Up to six users can 
be added. 

6 Save to SD 
Saves account information to an SD card. 

 
“Saving Account Data” page 464  

7 Read from SD 
Reads account information saved in an SD card. 

 
“Reading Account Data” page 465 

Setting/Changing Account 

 
 Only "Admin" user can set or change accounts. 

 For changing account information, skip the steps 2 and 3.  

1. Select "TOOL” > “General” > "Account Setting" from the menu bar. 

2. Set “Account Setting” to “Use”. 

Set whether to use the account function or not. 
When "Not Use" is selected, the following settings 
are unavailable. 
Default: "Not Use" 
 

 

 

 
 

 If "Account Setting" is changed to "Not Use" during 
login, the message "Logout and change the 
settings. Do you want to continue?" appears. 

Select [OK] It disables the account setting 
immediately. 

Select "Cancel" It does not change the account 
setting. (Enable) 

 

 

3.  Set "Login time user name display". 

Default: "Hide" 
"Display": All user names are displayed in the pull-down menu at the 

time of login. 
"Hide": Enter a user name directly at the time of login. 

 

4. Select the list of user names and press the ENTER key on the user name you want to register or 
change. 
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5. Register or change necessary items in the displayed account setting window. 

 
 

 

Item Description 

1 User Name 

Up to 16 alphanumeric characters and symbols can be input.  

 
 A registration error occurs when the same user name is registered more 

than once, and the following message is displayed. 

 
 A registration error occurs when no user name is entered, and the 

following message is displayed. 

 
2 Password Up to 16 alphanumeric character and symbols. (No entry is possible.) 

3 Access 
Authority 

Select from Admin User or General User. 
Admin : All menu operations are available. 
General User : Register users who operate the system. The necessary menu 

items for the system operation are set by the administrator.  

 
The available start user is only the "StartUser" set as the default. More than one start 
user cannot be registered. 

4 Overwrites the 
Data R/W 

Set whether to allow parameters in Data R/W in RUN Menu to be overwritten or 
not. 

No (Default) : Parameters in Data R/W are not overwritten. 
Yes : Parameters in Data R/W are overwritten. 

 

5 Menu display 
settings To set menu items to be displayed. (Refer to the next section.) 

 

 
 The password for Admin User "Admin" is not registered at shipment.  Set an arbitrary password at 

the time of initial setting. 

 As for the default accounts "Admin" and "StartUser", changing the account information is limited to 
the followings. 

 Admin StartUser 
User Name Possible to change Possible to change 

Password Possible to change 
- 

(No password) 

Access 
Authority 

- 
(Full access) 

- 
(Start User is fixed) 

Overwrites the 
Data R/W 

- 
(Full access) Possible to change 

Menu display 
settings 

- 
(Full access) Possible to change 

* There is no need to set a password for "StartUser". (Possible to log in without password) 



 

459 

C
h. 7 

C
hanging C

onfiguration (T
O

O
L) 

6. Press "Menu display settings" and set the displayed menu items. 

The following screen is displayed. Select each item with the keypad, and switch whether to display or not 
by pressing the ENTER key. 
The items with a "X" mark are displayed. 

 

 

 

 

 
 As the default setting, all the menu items are not displayed.  

 According to the selected status of the upper menu items, lower items become enabled or disabled.  
Example) When setting the submenu "Data R/W" not to display, "Data R/W0" and "Data R/W1" are 
invalid (in gray). 

List of displayed menu items 
RUN Menu 

Menu bar Pull-down menu Sub menu 
OPERATION Select Type - 

Reset Statistics - 

Start RUN Mode - 

Stop RUN Mode - 

To SETUP Menu - 

VIEW Data R/W Data R/W 0 
Data R/W 1 

Window Transparency (RUN 
MENU) 

- 

Command Communication Log - 

LAYOUT Layout - 

DEBUG Debug Start - 

Reset - 

Result - 

Folder select - 

Setting - 

Debug Exit - 

TOOL Eject SD Card - 

Save Setting Data - 

Save Image Memory - 

Clear Image Memory - 

Information - 
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SETUP MENU 
MAIN MENU Submenu Tab menu 

ENVIRONMENT System Settings Startup Setting 
Operation 
System Register 

Input/Output PLC Communication 
Parallel I/O 
Parallel I/O Output 
Serial 
General Output 
Image Output 
Save Image Memory 
Print Screen 
SD Card Setting 
FTP Server 
FTP Client 

Camera Camera 
FLASH Polarity 

Transparence - 
Password - 
Initialize - 

TYPE Select Type - 
Type Setting Execution Condition 

Camera 
Color Extraction 

Marker Display - 
Data R/W Data R/W 0 

Data R/W 1 
Font Color 

Select Menu - 
Initialize - 

INSPECTION - - 

SAVE/READ Save Setting Data - 

Read Setting Data - 

Save Image Memory - 

Clear Image Memory - 

TOOL PC Communi. - 
General Startup Setting 

Network 
Calendar 
Language 
Initialize 

SD Property - 

Eject SD Card - 

Information - 

Setting Help - 

Update - 
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Deleting Account 

 
 Only "Admin" user can delete accounts. 

1. Open the [Account Setting] window. 

2. Select the list of user names and move the 
cursor onto the user name you want to delete, 
and press the FUNC key. 

The pop-up menu "Delete" appears. 
 

3. Select "Delete". 

 

 

4. When the message asking to confirm deleting 
the account appears, press the OK button. 

 
 

 
 The "Admin" and "StartUser" set as the defaults cannot be deleted. (The user names can be 

changed.) 

 When the information on a logged-in user account is updated or deleted, the user's access authority 
will be valid until logout, and will be deleted after logout.  
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If You Forget Your Password 
If you forget your login password when using the account function, reset the account information according 
to the following procedure. The following three methods are available for resetting the account.  

Changing and Saving Account Data from PVWIN200 

You can read account data in PV200 from PVWIN200, change only your password, and overwrite in 
PV200. 

1. Connect PV200 to a PC, and activate PVWIN200. 

2. Click "Read Account" in the "File" menu. 

 
When PV200 is in the following status, it can communicate 
with PVWIN. 
 In RUN menu, when output is Ready or Stopped 

(Operation stops). 

 In SETUP menu, when "PC Communi." under 
"TOOL" is selected. 

 

 

 

 

 

 

3. Select "PV" for "Read From" in "Read Account" and 
click [OK]. 

 
 
 
 
 
 

4. Change the password for the account data in 
"Environment" > "Account Setting", and press [OK]. 
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5. Select "PV" for "Save to" in "File" > "Save Account", 
and press [OK]. 

6. The account data in PV200 is changed. 

For using the changed account data, log out from 
RUN Menu or switch the user.  

Initializing Account from PVWIN200 

Using the "Init Account" function in PVWIN200 initializes the PV settings via PC. 

 
 If the initialization is executed, the setting for the account function returns to the state of "Not Use".  

 If the initialization is executed during login, all the account functions will be invalid.  

 If the initialization of account is executed from PVWIN200, the following data will be initialized. 
Confirm the set information before executing the initialization.  

Initialized data: ・Account data 

1. Connect PV200 to a PC, and activate PVWIN200. 

2. Click "Init Account" in the "File" menu. 

 
When PV200 is in the following status, it can communicate 
with PVWIN. 
 In RUN menu, when output is Ready or Stopped 

(Operation stops). 

 In SETUP menu, when "PC Communi." under 
"TOOL" is selected. 

 

3. The message asking the execution of the 
initialization appears. Select "Yes". 

 

 

Using "Initialize" Function of PV200 

The initialization function provided with PV200 is used. For details, refer to “6.6 Initializing Environment 
Settings” page 449. Only when the logged-in user has an access right to the PV200 menu "TOOL" > 
"General" > "Initialize", the initialization function is available.  

 
 The "Initialize" in "General" is a standard function provided with PV200.  For not allowing a specific 

user to use this function, set not to display this function in "Menu display settings" when registering 
the account in advance. 

 If the initialization is executed, the setting for the account function returns to the state of "Not Use".  

 If the initialization is executed during login, all the account functions will be invalid. 

 If the initialization menu of PV200 is executed, the following data will be initialized. Confirm the set 
information before executing the initialization. 

Initialized data: 
・Account data 
・Network setting 
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Saving and Reading Account Data 
Created account data can be saved in an SD card or read.  
At this time, PV200 creates a single file with eight user's information as one set. Up to 100 sets of 
account data can be saved in an SD card. As saved account data is encrypted, it cannot be seen with 
a PC, etc. 
 
Save to: ¥Panasonic-EW SUNX Vision¥PV200¥AccData 
File name:SetXX.acc (Number between 00 to 99) 

 
Account data can be read with PVWIN200 and saved to a PC. 

 
Situation of Account Data 

 
 

Saving Account Data 
 

1. "Save to SD": Press the ENTER 
key on "Save". 

 

2. Select a number (00 to 99). 

A SetXX.acc file is created in the 
SD card (XX is the specified 
number). 

3. The message "Do you want to 
save the data to the selected 
area?" is displayed. Select 
[Yes]. 

On the completion of saving, the 
message "Saving is done" is 
displayed. 

 
  

 
 

Storage space in PV200 Memory for account execution SD memory card 

 

Data save is performed with 
the message response after 
exiting the "General" menu 
under "TOOL". 

・Account execution 
・Account data edit 

Account file SetXX.acc 
 (XX:00 to 99) 
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Reading Account Data 

Read the account data saved in the SD memory card in advance (with the settings; Use or Not use 
each setting, display or hide the logged-in user name, account users, 8 users) (1). 
However, the user does not change at the time of reading, and it is the logged-in user as is. To switch 
to the read account data, execute "Switch User" or "Logout" in RUN Menu ("RUN Menu" > "Account". 
For details of the procedure, see pages 48, 50. When "Switch User" or "Logout" is executed, the user 
is switched to the account data of (1).  
 

1. "Read from SD": Press the ENTER key on 
"Read". 

The list of account information appears. 
 

2. Select a file number to be read from the list, 
and press the ENTER key. 

The account information is read from the file. 
The login user is not yet changed as stated above. 
 
Source folder 
: ¥Panasonic-EW SUNX Vision¥PV200¥AccData 
File name: SetXX.acc (XX:Number between 00 to 
99) 
 

 
The account file can be named arbitrarily with 
PVWIN200. For reading this file saved in an SD 
card with PV200, change the file name to 
SetXX.acc. 
The account information can be downloaded to 
PV200 with PVWIN200. 

 

 

3. Select "TOOL" > "General" > "Account 
Setting", and press the CANCEL key. 

The message "Do you want to save the 
changes?" appears. Select [Yes] or [No]. 
 

 
 If [Yes] is selected, PV200 starts with the 

account information read in the step 2 next 
time it is powered on. If [No] is selected, 
PV200 starts with the account information 
before reading the data in the step 2.  

 
 Regardless of response to the above 

message, the account data read from the SD 
card or the edited data is held until the power 
supply is turned off. 
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7.2.6 Initializing General Settings 

This menu initializes the configuration. The items and their values to be initialized are listed below. 
 

Item  Value after initialization 

Startup setting Start with Memory: Storage Space in PV200 

Network IP Address 192.168.1.5 

 Subnet Mask 255.255.255.0 

 Default Gateway 192.168.1.1 

 Device Name ImageCheckerPV200 

Account Setting Account Setting Not Use 
Login time user name display No 
Users: Admin (Administrator) 

StartUser (Start user) 
(Settings of each user ("Password", 
"Access Authority", "Overwrites the 
Data R/W", "Menu display settings" are 
also initialized.) 

Language and the calendar (date and time) are not initialized. 

1. Select "TOOL” > “General” from the menu bar. 

2. Select "Initialize” > “Initialize General 
Settings”. 

The confirmation message appears. 

3. Select “Yes” to initialize it. 

Initialization is executed. At the moment, the 
initialized values are saved in PV. 

 
 

Select “No” to cancel. 
 

4. Press the CANCEL key twice.  

The confirmation message appears. 
The initialized values are saved in PV at the time of initialization. You can either “Yes” or “No”. (Even if you 
select “No”, the values are not restored.) 

 
When you changed a value of another item after initialization, select “Yes” to save the changed value in PV. 



 

467 

C
h. 7 

C
hanging C

onfiguration (T
O

O
L) 

7.3 Information Display and Ejection of SD Memory Card 
“SD Property” shows information of a SD memory card when attaching it in the slot. 

Also, files or folders in a SD memory card can be deleted. 

“Eject SD Card” prepares to eject a SD memory card. 

7.3.1 Displaying Information of SD Memory Card 

You can confirm the information of a SD memory card attached to the SD memory card slot of PV200. 

The information includes capacity and free space of the SD memory card, the saving date of the files, and their 
size. 

Also, unnecessary files or folders can be deleted. 

 

1. Select "TOOL” > “SD Property” from the menu 

bar. 

The information is displayed. 

2. Select the file list. 

The files saved in the place are listed. 
 

 
To go up to the upper hierarchy, select “..”. 
A file can be added while the information is 
displayed. Selecting “Update” shows the latest 
status. 

3. Press the FUNC key on the file or folder you 
want to delete.  

The deletion message appears. Press the ENTER 
key and select "Yes" following the message to 
delete. 

 

7.3.2 Preparing to Eject SD Memory Card (Eject SD Card) 

If you forcibly eject a SD memory card while the device is accessing its memory, the SD memory card and 
PV200 might be damaged. Be sure to prepare to eject the card by following the procedure described below 
before withdrawing it from the slot. 

1. Select "TOOL” > “Eject SD Card” from the menu bar. 

The confirmation message appears. 

2. Select “Yes”. 

When it is ready for ejection, the message saying “The SD card can be ejected safely.” appears. Select 
“OK". 

 
Now, the preparation to eject the card is complete. 
Push the SD memory card into the inserting direction and remove the ejected card from the slot. 
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7.4 Setting Help 
This function supports to make setting of optical parts of PV200, to confirm the communication, and its 
adjustment for introduction. 

 

Focus Adjustment: To adjust focus of the lens. Rotate the focus ring of the lens following the 
displayed message. 

Aperture Adjustment: To adjust aperture of the lens. Rotate the aperture ring (iris ring) of the lens 
following the displayed message. 

Gray Data Analysis: To display the grayscale level of the image in the linear area in graph form. 

Capture Delay Control: To decide optimum capture conditions by capturing and displaying images 
while changing the condition for each camera. 

I/O Test: To check the connections of I/O connector and I/O terminal block with the 
external devices. 

Communication Test: To test the communication with the external devices connected to COM port 
and Ethernet port. 

7.4.1 Adjustment of Focus and Aperture 

This feature makes it easy to properly adjust the focus and the aperture of the lens. 

Focus and aperture can be adjusted by the same procedure. 

1. Adjust the position of the camera to display 
the inspection object or the object with 
feature on the monitor screen. 

2. Select “TOOL” > "Setting Help". 

The Setting Help menu appears. 

3. Select “Focus Adjustment” or “Aperture 
Adjustment”. 

The window for focus adjustment (or aperture 
adjustment) appears. 

 

 

4. From “Camera”, select a camera image to 
adjust focus or aperture. 

5. Select “Set” button for Area and set an 
inspection area on a captured object or a 
position where feature of the object exists. 

The place where the feature of the object exists 
is the position where the difference of 
brightness is observed. 
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6. Rotate the focus ring (or aperture ring) of the lens following the 
displayed message. 

7. Rotate the ring until “Result” field shows “OK”. 

A level bar showing consistent percentage is displayed in the 
“Focus Adjustment Level” area. 

 

8. When “OK” is displayed, stop turning the ring and then press 

the ENTER key. 

Now you completed the adjustment. 

 

7.4.2 Gray Data Analysis 

This function graphs gray values in the pixels on a horizontal or vertical line. You can observe the gray data on 
a preprocessed or binarized image. 

1. Adjust the position of the camera to display the inspection object 
or the object with feature on the monitor screen. 

2. Select “TOOL” > “Setting Help”. 

The Setting Help menu appears. 

3. Select “Gray Data Analysis”. 

The Gray Data Analysis window appears. 

4. Select a camera in “Camera”. 

Make the following setting to analyze an image captured with a color 
camera. 
 
- Color (Color/Converted Gray Img.) 
Color: Analyzes grayscale data on either element of R(Red), 
G(Green) and B(Blue) of a color image. Then, select a color. 
Converted Gray Img.: Analyzes an grayscale image converted from 
a color image. Then, select a group for grayscale conversion. 
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5. Set an area on the position where you 
want to observe its gray data from 
“Area“ and “Area Direction”. 

When you completed the area setting, the 
graph of gray data appears in green. 
 
The larger green area indicates the 
brighter pixel (gray value is higher), and 
the smaller area indicates the darker 
pixel (gray value is lower). 

 

 

6. Change the other items as necessary to change the type or size of the image. 

Live/Memory: To switch the image between Live and Memory. 

Magnification: To change the display size of an image. 

Grayscale 
Preprocess: 

To confirm the gray data of a preprocessed image. 

Gray/Binary: To switch between Gray image and Binary image (slice level A-P). 

Scroll: To move the displaying area when the magnification of an image is set to high. 
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7.4.3 Capture Delay Control 

This function helps to decide optimum capture conditions* by capturing and displaying images while changing 
the conditions for each camera. 
*) Shutter speed, Camera gain, Capture delay, FLASH delay, FLASH span 

1. Select “TOOL” > “Setting Help”. 

The Setting Help menu appears. 

2. Select “Capture Delay Control”. 

A live image and the capturing conditions appear. 

3. Specify a camera to display on the screen 
window from “Select Camera. 

4. Change the capturing conditions. 

An image is captured under the changed conditions 
and the displayed image is updated.  
Then, the setting window shows the gray value of 
the entire screen. 
The current gray average and the previous gray 
average are displayed. 

5. When you decide the optimum capturing 
conditions, enter the each values in 
“TYPE”>”Type Setting”>“Camera”. 

 

 
 

 

7.4.4 I/O Test 

This function checks the connections by forcibly outputting signals and monitoring input signal of the I/O 
terminal or I/O connector. 

1. Select “TOOL” -> “Setting Help”. 

The Setting Help menu appears. 

2. Select “I/O Test”. 

The list of output signals and input signals (from the external device) of 
PV200 is displayed. 

3. Select a signal to carry out an output test. 

In the cell of the signal you selected, “X” is displayed. This symbol 
indicates that the specified signal is ON. 

4. Check the signal you turned on is input correctly from the external 
device. 

5. Input a signal from the external device to PV200 

In the cell of the signal you input, “X” is displayed in the same way as the 
output signals. 

 

 
After processing output test, closing the I/O test window while the signals are turned on turns off the signals. 
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7.4.5 Communication Test 

This function tests the communication with the external devices connected to COM port and Ethernet port. 

Selecting a Port 

1. Select “TOOL” > “Setting Help”. 

The Setting Help menu appears. 

2. Select “Communication Test”. 

The Communication Test window appears. 

3. Select a port to carry out communication 
test in “Select Port”. 

After you select a port, PV200 can receive 
commands from the external device. 

 
 

 

Receive and Send Test of Command 

1. Select a port in the Communication test window 
and send a command from the external device. 

The received command is displayed in “Input” field. To 
clear “Input” field, press the “Clear” button. 

2. Tilt the ENTER key up/down to select “Output”. 

A software keyboard is displayed. 

3. Enter characters, such as response to a command 
and output data, to output to the external device. 

4. Tilt the ENTER key up/down to select “Send”. 

The entered characters are sent to the external 
device from the specified port. Check if the device 
receives them correctly. 
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7.5 Information Display and Updating of PV200 

7.5.1 Displaying PV Information  

It displays the version information of your PV200 and memory usage. 

1. Select "TOOL” > “Information” from the 

menu bar. 

The information of PV200 is displayed. 

 

 
 

Model PV200 (fixed) 

Version Version of PV200 you are using  

Free Space for Setting Data Free space in the memory for setting data which sets up to 256 
product types. (except the memory for template) 

Free Space for Templates Camera 0+1 Free space in the memory for template of Matching checker created 
for Camera 0 and Camera 1. 

  

SD Total Capacity This is displayed only when a SD memory card is attached. 

SD Free Space 

Device Name “ImageCheckerPV200” 
This can be changed. Refer to page 453 on how to change it. 
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7.5.2 Version Upgrading of PV200 

By using the file we provide, you can upgrade your PV200. Upgrading requires a SD memory card. 

Preparing a Version Upgrade File 

1. Obtain a version upgrade file. 

Download the file for upgrading from our website. 

2. Decompress the downloaded ZIP file. 

3. Prepare a SD memory card and save the decompressed version-upgrade file (*.PRG) in the path 
below. 

Drive: /Panasonic-EW SUNX Vision/PV200/Update/ 

4. Attach the SD memory card of the step 3 to the PV200 you want to upgrade. 

 
Now you completed the preparation of the version upgrade file. 

Version Upgrading 

1. Select "TOOL” > “Update” from the menu bar. 

Update window is displayed. 

2. Select "Firmware". 

The list of the version upgrade files saved in the SD memory card is displayed. 
 

 
If the file list is not displayed, check the following conditions. 
- The SD memory card is attached correctly? 
- The version upgrade files are saved in the correct place? 

3. Select a desired version upgrade file. 

When the confirmation message appears, select “Yes” to start upgrading. 
Selecting “No” cancels upgrading and the screen returns to the previous one. 

 
 

Do not turn off the power of PV200 during the upgrading. If you turn off the power during the upgrading, the 
system might be damaged and might not be able to start or function correctly. 

4. Reboot the PV200 following the displayed message after the operation is complete. 
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7.5.3 Customizing Splash Screen (Update) 

A splash screen of PV200 is the blue screen showing the product name and the version at startup. The screen 
can be changed to another one. Changing the screen requires a SD memory card. 

Preparing a File 

1. Prepare an image to display as a splash screen. 

Modify and save the image file to meet the following conditions. 
- 24-bit bitmap file 
- Image size: Max. 640 (w) x 480 (h) pixels 

2. Prepare a SD memory card and save the image to display as “Logo.bmp” in the path below. 

Drive: /Panasonic-EW SUNX Vision/PV200/Logo 

3. Attach the SD memory card of the step 2 to the PV200. 

Now you completed the preparation of the image file to use for a splash screen. 

Changing Splash Screen 

1. Select "TOOL” > “Update” from the 

menu bar. 

Update window is displayed. 

2. Select “Splash Screen” > “Change”. 

When the confirming message appears, 
select “Yes” to execute the change. After the 
change is completed, a message is 
displayed.  

 
 

If you cannot change it, the following can be considered as reasons. Check the conditions. 
- A nonqualified file is saved. (A different file format or too large file size.) 
- The file is saved in the wrong place. 
- The file name is not “Logo.bmp”. 
- A SD memory card is not available. 

3. As the message appears telling that the change is completed, select “OK”. 

The changed splash screen will be displayed after the next startup. 

Initializing Splash Screen 

Delete the custom splash screen and replace it with the original image. 

1. Select “Splash Screen” in “Update” window. 

2. Select "Delete". 

When the confirmation message appears, select “Yes” to start initializing604. 

3. As the message appears telling that the process is completed, select “OK”. 

The initial splash screen will be displayed after the next startup. 
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Chapter 8 
 Debug (Further Validation of Inspection) 
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8.1 Debug 

8.1.1 What is DEBUG Menu? 

This menu is used to execute an inspection specified in SETUP menu using an image prepared in advance. 

Normally the PV200 performs an inspection on an image captured with a camera in RUN menu. However, in 
DEBUG menu, the inspection is performed using another image prepared in advance. In this menu, the 
operation status is "STOP", and the PV200 does not communication with external devices at all. The keypad 
is necessary for the operation. 

By using this function, it is possible to simulate the inspection using image data saved in the PV200 or a SD 
card, and confirm the result before performing the actual inspection. By using this function in combination 
with statistics data or data R/W, the result is also used for checking trends of measurement values or used 
for deciding the judgement criteria for each checker (max. values, min. values or thresholds). 

 

In RUN menu, the settings for "Result" and "Setting" under "DEBUG" are available. By using "Result", the 
inspection result most recently executed can be checked in the list. Also, the parameters for the used 
checker can be adjusted here. However, the operation stops during the adjustment of checker. Please note 
that the key emulation by PLC communication cannot be used. 

 

 
 

・Select "Debug Start" or "Debug Exit" under the "DEBUG" menu in RUN menu to switch between RUN 
menu and DEBUG menu. 
・When the connected camera and the camera settings in ENVIRONMENT are different, a message asking 
whether to switch to DEBUG menu or not will be displayed if the OPE/SET switch is snapped in SETUP 
menu. Select "YES" to switch to DEBUG menu. 
・The adjusted checker parameters are not automatically saved in the main memory, so always "Save 
Setting Data" before powering off the PV200. 
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Example of Use 

Example 1 

For simulating an inspection 

An inspection can be simulated with setting data and an inspection image. 

Images are saved in the image memory of PV200 every time an inspection is performed. The same inspection 
can be performed using the saved images. For simulation, the following methods are available; "Run": 
Executes an inspection by automatically sending images, "Step Run": Executes an inspection by manually 
sending images one by one. If total judgement becomes NG during the execution of debug, it is possible to stop 
images. 

(Related items: "Setting" > "NG Stop"  page 494) 

Example 2 

For checking NG images only 

If "NG Image" is specified for Target Image, an inspection can be 
performed again using only the images totally judged as NG. (Images 
captured by PV200 keep the total judgement result information at the 
time the inspection was executed. That information is used.) Using this 
function enables to review inspection items or pursue the causes of NG 
judgement. 
(Related items: "Setting" > "Target Image", "NG Stop"  pages 494, 494)  

Example 3 

Inspection items can be adjusted by checking the judgement results of executed checkers. 

The "Result" window shows the result of the 
inspection executed right before opening this 
window or the list of judgement result of debug. 
Selecting a checker displayed in this windows 
displays the setting window of the checker. The 
parameter can be adjusted confirming the result of 
debug. 

In combination with Statistics or Data R/W, it can be 
used as a guide for determining the maximum and 
minimum values to judge as OK or NG. 

(Related item: "Result"  page 499) 
 

Example 4 

Even if images of different types exist in a folder, PV200 sorts them and executes debug.  

The images captured by PV200 contain information at the time of inspection 
such as inspection result when the image was saved and executed type 
numbers. It is called an image header. When there are multiple types of 
images in the selected folder, PV200 selects the appropriate type from the 
image header information.  It is also possible to execute debug using a 
specific type in disregard of the image header information.(Related item: 
"Setting" > "Changing Type"  page 495) 

  

Example 5 

Images with any file names (extension: bmp, byr) in any folders in a SD card can be verified. An image with a 
name that was rewritten on a PC can be also used.(Related item: "Folder select" > "Select Folder"  page 489) 
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8.1.2 DEBUG Menu 

 
 

1 Display type Displays "DEBUG MENU". 
(Indicates the current window is DEBUG menu. 

2 Menu bar Displays the menu to set in DEBUG menu. 
(There is some restrictions on operable items. *) 

3 Information 
display area 

a Type No. Displays the current type. They change to the type 
number and title being executed during the execution of 
debug. 

  b Image file name Displays the file name of an image on which debug is 
being executed. 

  c No. of NG, No. of 
debugged images 

Displays the current number of occurrence of NG 
judgement and the number of debugged images. 

  d Total Judgement Displays the result of judgement formula registered as 
Total Judgement. 

  e Operation status Displays the status pausing (STOP). 

  f Image count Displays the number of images to be debugged. 
(Displays the total number of images of Camera 0 and 
Camera 1 saved in the storage location of a specified 
image.) 

  g Read from Displays the method of reading images to be 
debugged. The displayed items are as follows. 
Image Memory / Test Image in SD / Image Memory in 
SD / Output Image in SD / Select Folder 

4 Screen window This is a window to display images. 

5 Data R/W Displays inspection results and setting parameters. The displayed items 
change according to the type on which debug is executed. 

6 Key guide Displays the operations of each key on the keypad. 
TRIG: Execute continuous inspections / Stop continuous inspections  F3: Step 
execution (Execute once) 

 

*: Items that are not available in DEBUG menu 
OPERATION: Start RUN Mode / Stop RUN Mode / To SETUP Menu 
VIEW Command communication log 
TOOL: Eject SD Card 
F1 key (Select Window) 
→Screen0、Screen1： 

Switch Disp. > Memory / Live / NG Image 
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8.1.3 Differences Among RUN Menu, DEBUG Menu and SETUP Menu 

The differences among RUN menu, DEBUG menu and SETUP menu are as follows. 
 

 RUN menu DEBUG menu SETUP menu 
Operation status RUN STOP STOP 

Data output Yes × × 
Reception of 
external signals 

Yes × × 

Key emulation 
Yes × 

General purpose communication: 
Yes 
PLC communication.: × 

Image capture Yes × Yes 
Image read × Yes Yes 

Image continuous 
read 

× Yes × 

PVWIN200 Yes* ×* Yes* 

* For details of the connection with PVWIN200, refer to page 709. 

About source image files 
 DEBUG menu SETUP menu 
Image memory Yes Yes 
Test image in SD Yes Yes 
Image memroy in SD Yes Yes 
Output image in SD Yes Yes 
Image in arbitrary folder in SD Yes(bmp/byr) Yes(bmp/byr) 

It is also possible to execute a test by reading images in SETUP menu, however, images that can be read 
at one time is only one set. 

Pressing the TRIG key in DEBUG menu reads images automatically by a set, and executes the operation for 
the number of images. Use the F3 key if you want to read images manually by a set. 

 

Others 
 RUN menu DEBUG menu SETUP menu 
Changing execution 
type 

Change by keypad or 
communication from an 
external device. 

Change by specifying an 
execution type or 
information of image file. 
(Refer to page 495.) 

Change by keypad. 

Specifying 
User-defined 
execution  
Creating new checker × × × 
Adjusting parameter △(Only partially) 

The maximum and 
minimum values can be 
changed using Data 
R/W or commands. The 
settings are limited. 

△(Only partially) 
Parameters can be 
changed for an 
executed checker. 

Yes 
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8.2 Flow of Debug in DEBUG Menu 
To set and execute debug operation in DEBUG menu, follow the procedures below. 

8.2.1 DEBUG Menu - Flow of Execution 

 

Make the settings for an inspection in SETUP menu. Page 74 

  

Prepare an image to be used for debug. 

Save the image in the image memory of PV200 or a SD card. 
Check the type of the image (color or gray) and the size. 

Page 486 

  

Make the camera setting in ENVIRONMENT to match the 
image to be used for reading. 

If the camera setting and the type of read image is different, the 
debug operation cannot be performed.(For debug operation, 
there is no need to match the "Connected Camera" with the 
"Camera" setting (in "ENVRIONMENT" or "TYPE-Type Setting)). 
Debug operation can be executed if an image to be read matches 
the set camera.) 

Page 113 
*Refer to the 

following. 

  

Go to DEBUG Menu. 

"DEBUG" > "Debug Start" 
Page 483 

  

Specify an image to be debugged. 

Images stored in the image memory of PV200 and arbitrary 
image folders in a SD card can be specified. 

Page 486 

  

Set the necessary conditions for execution. 

(DEBUG > Setting) Also, set items such as Layout.  
Page 494 

  

Execute debug. 

Press the TRIG key for continuous execution, and press the F3 
key for step execution. 

Page 497 

  

Confirm the result. 

"DEBUG" > "Result" / Data R/W 
Page 499 

  

Exit DEBUG menu. Page485 

 
 

* : When the connected camera or the set camera is 4-Mega camera, note  there are restrictions on 
switching to DEBUG menu. 

[Connected Camera]  [Set Camera]   

･4-Mega Gray Camera － 4-Mega Gray Camera → Can switch to DEBUG Menu. 

･4-Mega Gray Camera － Other than 4-Mega 
Gray Camera 

→ Cannot switch to DEBUG Menu. To switch to 
DEBUG menu, turn off the PV200, remove the 
connected 4-Mega camera and reboot the PV200. 

･Other than 4-Mega 
Gray Camera 

－ 4-Mega Gray Camera → Can switch to DEBUG Menu. 
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8.2.2 Switching to DEBUG Menu 

Use the keypad for the operations in DEBUG menu. Please note that the key emulation by 
general-purpose communication or PLC communication cannot be used. 

If DEBUG menu is started and ended, the scan count and the statistics data obtained before starting 
debug will be reset. 

Switching RUN Menu to DEBUG Menu 

1. Select “DEBUG” in RUN menu. 

When the connected camera is different 
from the specified "Camera Type" in 
PV200, refer to "Switching SETUP Menu to 
DEBUG Menu" on the next page. 
 
 

 

2. Select “Debug Start”. 

 

 

3. The window changes to DEBUG menu. 

The sign of "DEBUG MENU" appears in 
the upper right of the screen. 
 
The image in Screen window becomes a 
memory display automatically. 
Communication with external devices 
(input/output) is not conducted at all. 
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Switching SETUP Menu to DEBUG Menu 
(when the connected camera is different from the 
set camera) 

When the connected camera is different from the camera setting, the window is switched from SETUP 
menu to DEBUG menu directly. 

 

1. Snap the OPE/SET switch in the main 
menu or sub menu of SETUP menu. 
Or select "OPERATION" > "To RUN 
Menu" in SETUP menu. 

When the connected camera is the same 
as the specified "Camera Type" in PV200, 
refer to "Switching RUN Menu to DEBUG 
Menu" on the next page. 
 

2. Select "Yes" in the window displaying a 
message. 

 
 

  

 

If the message shown on the right appears, 
the image in the image memory of PV200 
will be deleted by selecting "Yes". If the 
image is necessary, save it in a SD card, and 
then go to DEBUG menu. 
(How to save: 4.17.3 Saving Images in the 
Image Memory of PV) 

 

 
 

3. The window changes to DEBUG menu. 
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8.2.3 Exiting DEBUG Menu 

1. Select "DEBUG" in DEBUG menu. 

 

 

2. Select "Debug Exit”. 

 

 

3. It exits DEBUG menu and returns to RUN 
menu. 

When the connected camera is different 
from the specified "Camera Type" in 
PV200, the window changes to SETUP 
menu automatically without changing to 
RUN menu. 
 
 
The operation status (RUN or STOP) and 
the type number return to the previous 
status and number right before starting 
debug. 
 
If the operation status before starting 
debug is RUN, the READ signal will turn 
on after exiting DEBUG menu and 
communication will start again. 
 
 

 
By exiting DEBUG menu, the scan count 
and the statistics data will be reset. 
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8.2.4 Selecting Images 

Existing images are used to conduct an operation test in DEBUG menu. The location saving the images 
used for the operation test is specified before conducting the test.  

1. Select "DEBUG" >  "Folder select" in DEBUG menu. 

This item can be selected in DEBUG menu not in RUN 
menu. 

 

2. Select a location saving images used for the operation 
test from "Read from". 

Select from the following five types. The name of the 
selected item is displayed in the information display area.  
- Image Memory 
- Test Image in SD 
- Image Memory in SD (Setting method: page 487) 
- Output Image in SD (Setting method: page 488) 
- Select Folder (Setting method: page 489) 

 

 
 

 
The setting for "Read from" is common to Camera 0 and Camera 1. 

The following table shows the summary of these contents.  

"D", "F", "H", "I" and “J” in the table indicate the symbols of the memory map described on page 369. For 
details, refer to Chapter 4.17. 

 
Difference in the locations from which images used for debug are read 

[ Read from ] [ Image ] [ File name ]     

Image Memory  

 

Images saved in the image memory of 
PV200 
 

    

P
laces in w

hich im
ages captured by P

V
200 

can be saved 

Test Image  
in SD 

   

Test images in a SD memory card 
¥Panasonic-EW SUNX Vision ¥PV200 ¥ 
Image ¥Backup ¥ Test 

C0_nnn.bmp,  
C1_nnn.bmp, 
C0_nnn.byr 
C1_nnn.byr    (nnn:000~999) 

 

T
here are rules in file nam

es. 

 

Image Memory 
in SD 

 

Backup images in a SD memory card 
¥Panasonic-EW SUNX Vision ¥PV200 ¥ 
Image ¥Backup¥000~999 
 

Multiple folders between 000 to 999 can 
be selected.  

C0_nnn.bmp,  
C1_nnn.bmp, 
C0_nnn.byr 
C1_nnn.byr    (nnn:000~999) 
 

  

Output Image 
in SD 

 

Images saved in a SD memory card by 
"Image Output" 
¥Panasonic-EW SUNX Vision ¥PV200 ¥ 
Image¥Output ¥YYMMDDHHMMSS 
 

Multiple folders in Output folder can be 
selected. (Up to 1000 sets can be saved 
in each folder.) 

Header + Additional 
information_C0_nnnnnnn.bmp 
Header + Additional 
information_C1_nnnnnnn.bmp 
Header + Additional 
information_C0_nnnnnnn.byr 
Header + Additional 
information_C1_nnnnnnn.byr 

  

Select Folder 

 

Images in an arbitrary folder in a SD 
memory card (Up to 1000 sets can be 
saved in each folder.) 

*.bmp ,  *.byr  
(*: File name: Arbitrary name in 79 
characters) 
 
Put "C0_" for Camera 0, and "C1_" for 
Camera 1 at the beginning of a file 
name when you have decided which 
camera is used for reading images. 
If there are not these descriptions, 
images will be read as the images for 
Camera 0. 
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・Target images for debug 

- Reading for Gray camera: 256-color bitmap format (*.bmp) 
- Reading for Color camera: 24-bit color bitmap format (*.bmp), Bayer format (*.byr) 

・When the set camera is a color camera, and when there are a bayer image and a bitmap image with the 
same file name in the location where a specified image is saved, debug will be executed by reading the 
bayer image. 

Image Memory in SD 
Select this item for using images in the image memory in a SD memory card (¥Panasonic-EW SUNX 
Vision¥Image¥Backup¥000~999). 
Select an arbitrary image folder in the range of 000 to 999. Multiple folders can be selected.  

 
If folders with 3-digit names (000 to 999) and 2-digit names (00 to 99) exist in the folder "¥Image¥Backup" in 
Image Memory in SD, PV200 reads 3-digit folder names first.  

1. Select "Image Memory in SD" for "Read from". 
 

 

2. Select "Select Folder". 

Select an image folder to be used for an operation test. 
Move the cursor to the list, and press the ENTER key 
on the "Select" column of the folder number. 
In the cell of the number you selected, “Yes” is 
displayed. 
 
To cancel the selection, press the ENTER key on 
"Yes" of the number you want to cancel.  
 

 
・Method to select all numbers 
To select all the numbers in the image memory in the 
SD memory card, press the ENTER key on the "All 
Image" button. 
To cancel all the numbers, once select "All Image" and 
then press the ENTER key on the "Cancel All Image" 
button. 

 
 
Select "Select Folder". 
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・Method to confirm images in each folder 
Press the FUNC key on the list to confirm images in 
the folder. Press the ENTER key after displaying 
"Display Image" of the pop-up menu to display the 
thumbnail-size image in the highlighted folder. By 
changing the "Image No." in this window, other images 
in the same folder can be displayed. 
After confirming the images, press the CANCEL key. 

 

 

 

3. After selecting the folder, close the list with the CANCEL key. 

Now you completed the specification of the image folder to be read.  

Output Image in SD 
Select an image folder from the output image in SD (¥Panasonic-EW SUNX Vision¥Image¥Output). 

Multiple folders with prescribed names in Output folder (see page 370) can be selected. 

Folder name: YYMMDDHHMMSS (year, month, day, hour, minute, second) 

File name: Header + Additional information_C?_nnnnnn.bmp, Header + Additional 
information_C?_nnnnnnn.byr (?: Camera No.) 

 

1. Select "Output Image in SD" for "Read from". 

  

2. Select "Select Folder". 

Select an image folder to be used for an operation test. 
Move the cursor to the list, and press the ENTER key on 
the "Select" column of the folder name. 
In the cell of the number you selected, “Yes” is displayed. 
 
To cancel the selection, press the ENTER key on the 
"Yes" of the number you want to cancel.  

 
・Method to select all numbers 
To select all the folders in the output image in SD (folders 
with prescribed names), press the ETNER key on the "All 
Image" button. 
To cancel all the numbers, once select "All Image" and 
then press the ENTER key on the "Cancel All Image" 
button. 

 
 
Select "Select Folder". 
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・Method to confirm images in a folder 
Press the FUNC key on the list to confirm images in each 
folder. Press the ENTER key after displaying "Display 
Image" of the pop-up menu to display the thumbnail-size 
image in the highlighted folder. By changing the "Image 
No." in this window, other images in the same folder can 
be displayed. 
After confirming the images, press the CANCEL key. 
 

3. After selecting the folder, close the list with the 
CANCEL key. 

Now you completed the specification of the image folder 
to be read. 
 

 
In case of the compressed image saved by "Image 
Output", it will be blurred when it is restored to the original 
size at the time of debug, because the compressed 
image data is interpolated. Note that the image is not 
completely restored to the original image at the 
inspection. 
(When image data has been edited on a PC, etc., 
inspection is executed using the compressed image 
without restoration. 

 

 

 

 
 

Select Folder 
Select any one of the folders in the SD card. Image files directly saved in the selected folder are used for 
debug. If there are other folders in the selected folder (they are called subfolders), images in those 
subfolders are not used for debug. 

・File name: Arbitrary bmp or byr image (within one-byte 79 characters including extension: bmp or byr) Up to 
1000 sets can be read. 

* When there are bayer and bitmap images with the same name, the bayer image is used for debug. 

 

1. Select "Select Folder" for "Read from". 
  

2. Move the cursor to the folder list. 

The list of the folders and files in the SD card is 
displayed. 
 
The first time the window (for "Select Folder" > 
"Select Folder") is opened, folders and file names 
saved in the PV200 folder (¥PV¥Panasonic-EW 
SUNX Vision ¥PV200) are displayed. 
 
The location of the folder currently selected is displayed 
in "Path" field. 

 

3. Select the folder in which the images to be used for debug is stored. 

Highlight the folder with the cursor, and press the CANCEL key.  
 

Do not press the ENTER key for selecting the folder to be read. If pressing the ENTER key, PV200 tries 
to find folders stored in that folder. 
 

 
To go up to the upper hierarchy, select “..”. 

The <dir> in "Size(KB)" column indicates that it is a folder.  
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Method to confirm images in a folder 
To confirm images in each folder, move the cursor to the 
folder name you want to confirm, and press the FUNC 
key. 
Press the ENTER key after displaying "Display Image" 
of the pop-up menu to display the thumbnail-size image 
in the selected folder. By changing the "Image No." in 
this window, other images in the same folder can be 
confirmed.  
After confirming the images, press the CANCEL key. 
 
 
File numbers can be shifted by 100 using the 
"BEFORE" and "NEXT" buttons. These buttons can 
be used when the number of files is more than 100. 
In the case of 101th image, "1" is indicated beside 
"Image No." and "001" is indicated beside "1". 

 

 

 

4. Set "Use Image Header". 

Select whether to use image header information or not. 
No / Yes (Default: No) 
 
This function is used for executing debug by paring 
images of Camera 0 and Camera 1. When the image 
file names are not like "C0_***" or "C1_***", debug is 
executed by finding the camera numbers and images to 
be pair using the inspection information in the image 
files. 
 
For details, refer to 8.2.5 “Operation When Using Two 
Cameras (Pair Table)” and 8.2.6 “Image Information 
(Image Header)”. 

 

 

5. Press the ENTER key on "Enter". 

Pressing the ENTER key on "Enter" determines the folder selection. 
Note that if closing with the CANCEL key without pressing "Enter", 
debug cannot be executed on the selected folder. 
 
Now you completed the specification of the image folder to be read. 
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8.2.5 Operation When Using Two Cameras (Pair Table) 

When using two cameras, PV200 reads the images of Camera 0 and Camera 1 in pair for executing debug. 
When there is no image of camera 0 or camera 1 in the source folder, the image previously read is used to 
fill a data gap for the debug execution. When there is no leading image for Camera 0 or Camera 1, the first 
image to be found is read for the execution. 

In the figure below, there is no file "C1_000.bmp" that will be pair with the file of Camera 0 "C0_000.bmp".  
Therefore, "C1_001.bmp" is used to fill the data gap of Camera 1.  There is no “C0_002.bmp” and 
“C0_003.bmp” which will be pair for executing “C1_002.bmp” and “C1_003.bmp”. These images are 
replaced with "C0_001.bmp" used in the previous execution. As for the execution of "C0_004.bmp", 
"C1_003.bmp" is used. A combination of one image of Camera 0 and one image of Camera 1 is called a 
pair table. 

 

 
 

Make pair tables by the following procedure for executing debug.  

For Image Memory, Test Image in SD and Image Memory in 
SD 

Make pairs as described above. 

For Output Image in SD 

Make pairs from selected folders when switching folders.  

1.Determine the camera number and the scan count from the file name, and retrieve the type number, 
the saved date and time from the image header information.  

2.Pair the files with the same scan count, type number, saved date and time. 

For "Select Folder" 

Make pair tables by 100 files from selected folders. The message "Searching the image file. Wait for a while." is 
displayed when making 100 pairs. 

 

The methods to make pairs depend on the setting of "Use Image Header". 
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Yes 1. When there is "C0_" or "C1_" in the file name, it is camera number. 

2. If the parts other than "C?_" file names are the same, pair these files. 
(?: Camera number, 0 or 1) 

3. When there is not "C?_" in file names, read the image headers, retrieve the camera 
numbers, scan counts, saved dates and times for finding files to be paired. 

4. Files without image headers are treated as the files of camera 0. 
No 1. When there is "C0_" or "C1_" in file names, it is camera number. 

2. If the parts of file name other than "C?_" are the same, pair these files.  (?: Camera 
number, 0 or 1) 

3. For files other than the above, they are treated as the files of camera 0. 

 

When setting "Use Image Header" to "Yes", it takes time to make pair tables by 100 files for executing 
debug. 
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8.2.6 Image Information (Image Header) 

What is Image Header? 
Some information is automatically added (described in the table below) to images captured by PV200. This 
information is called "Image Header". The information at the time of inspection execution is recorded in image 
headers. Image headers can be added to both bitmap and bayer images. 

The image header is the character string displayed below the image when selecting "Image Memory in SD", 
"Output Image in SD" or "Select Folder" for "Read from" in the "Folder select" menu, and selecting "Display 
Image" in the "Select Folder" list (pressing the FUNC key). 

This information is cleared if the data is edited with software on PC. When selecting "Display Image" for an 
image without image header, "----" is indicated in the columns of "Type No.", "Scan Count", "Total Judgement" 
and "Block No." in red, and the date and time when the image file was saved is indicated in red. 
 
Image header 
information Description 

Debug 
environment Pairing 

File size File size   

Compression 
format 

Compression rate of images saved by image output (Information 
used for restoring compressed images to the original sizes when 
reading with PV200 or PVWIN200) 

  

Original size Original image size when saved as a compressed image by 
image output. 

  

Camera No. Record of the camera which captured the image. 
(Required for making pair tables) 

 Used 

Saved date 
and time 

Date and time of inspection execution.  Used 

Type No. The type number of saved image. Used* Used 

Block No. Execution mode and block number of type. 
(Execute All / User Defined / Automatic Switch, Last block 
No.) 

Used  

Total 
judgement 
(OK/NG/None) 

Total judgement result when inspection is executed 
(When Total Judgement has not been set, "----" is displayed.) Used  

Scan count Scan count when inspection is executed.  Used 

*This header information is not reflected in debugging when selecting "Select Folder" for "Read from" and 
setting "Use Image Header" to "No". 
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8.2.7 Executed Environment Settings: Debug Environment Settings 

Make the settings for executing debug in "Setting". 

 
When "Read from" has been set to "Select Folder" in "Folder select" 
(Chapter 8.2.4) and "Use Image Header" has been set to "No", PV200 
behaves as no image header is available for the debug environment 
settings. 

・When Detect Trigger has been specified; 
Even when "Detect Trigger" has been set from "TYPE" > "Type Setting" 
> "Camera" > Camera Trigger", PV200 behaves in the same way as 
"Common" has been set. 

 

Selecting Images for Executing Debug (Target 
Image) 

Select images to be debugged from among the images in the image memory of PV200 or the folder 
specified in "DEBUG" > "Folder select". However, when selecting "Select Folder" in "Folder select" and 
setting "Use Image Header" to "No", all the images in the folder will be debugged regardless of the 
following "Target Image" setting. 

1. Select "Target Image". 

Select ALL Image, NG Image or OK Image. 

 * For details of "Header Information", refer to Chapter 8.2.6. 

Operation Setting When Total Judgement is NG 
During Continuous Inspections (NG Stop) 

Specify whether to stop the debug execution or not when total judgement is NG during continuous 
inspections. (Image header information is not related to this setting.) 

1. Select "NG Stop”. 

Select "Yes" or "No (default)". 
 
Yes: Stop debugging when total judgement becomes NG during continuous inspections. 

Restart the continuous inspections by pressing the TRIG key. 
No: Continue continuous inspections even when total judgement becomes NG during continuous 

inspections. 

ALL Image 
(Default): 

Executes debug using all the images in the specified storage location. 
(Depending on storage locations, there are restrictions on file names.)  

NG Image: Executes debug using the images recorded as NG in the header information*.  

(Images the total judgements of which are NG when they were saved.) 
OK Image: Executes debug using the images recorded as OK in the header information*.  

(Images the total judgements of which are OK when they were saved.)  
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Selecting Target Type for Debug 

Select the type to execute debug. 

1. Select "Changing type”. 

Select "Auto" (Default) or "Selected Type No.".  
 
Auto: Executes debug with the inspection settings for the type number recorded in 

the image header (described in 8.2.6). If there is no target type or an image 
without image header is selected, executes debug with the setting "Selected 
Type No." (See the "Auto" column of C0_003.bmp in the table below).  
When "Select Folder" has been selected in "Folder select" and "Use Image 
Header" has been set to "No", executes debug with the setting "Selected Type 
No." even when "Auto" has been set. 

Selected Type No.: Executes debug on the type number displayed in the information display area 
right before the debug execution. (It does not depend on the image header.) 

 
Difference between the setting of "changing type" and the executed type 
(In this example, the type number before debugging is 3.) 

Image Type No. in header 
information 

Auto Selected Type No. 

C0_000.bmp 0 0 3 

C0_001.bmp 1 1 3 

C0_002.bmp 2 2 3 

C0_003.bmp None 2 3 

C0_004.bmp 4 4 3 
 

2. Select "User Defined". 

This setting is applied when the execution mode of the type to be 
debugged is "User Defined ("TYPE" > "Type Setting" > Execution 
Condition" > "Execution Mode"). (This setting is not applied when 
the execution mode of the type is "Execute All" or "Automatic 
Switch".) 

Specify how to select the block number to be debugged. 

Select "Auto" (Default) , "Block No." or "Manual".  

 

 
Auto: Executes debug with the block number recorded in the image header.  

Images without image headers are not debugged. 

When "Select Folder" has been selected in "Folder select" and "Use Image Header" 
has been set to "No", executes debug for Block number 0. 

Block No.: Executes debug on the image whose number specified in "Block No." matches the 
block number recorded in the image header. 
Debug is not executed when the block number in the image header is larger than the 
block number specified in Type ("TYPE" > "Type Setting" > "Execution Condition" > 
"Number of Blocks") or when images edited or created on a computer are used 
(because they do not have image headers). 

When "Select Folder" has been selected in "Folder select", debug is executed on all 
files when "Block No." is set to 0. 

Manual Executes debug on the inspection of the block number specified in "Block No.". 

Debug is executed on all files regardless of the image header information.  

When "Select Folder" has been selected in "Folder select" and "Use Image Header" 
has been set to "No", debug is executed on the inspection for the block number 
specified here. 

3. Select "Block No.". 

Set this item when selecting "Block No." or "Manual" in the above 
step 2. Debug is performed on the inspection for the block number 
specified here. 
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Relation between "User Defined" and "Block No." 

The following table shows the relation among "Image Header", debug environment settings (above "User 
Defined" and "Block No.") and block numbers actually executed when "Execution Mode" is set to "User 
Defined" in TYPE. In this example, the "Block No." of the executed type is 4. 

 

Image 
Block No. in 

header 
information 

"User Defined" and "Block No." settings 
Auto Block No.:  

Specified block No.: 
2 

Manual 
Specified block 

No.: 4 

C0_000.bmp 0 0 Not debug 4 

C0_001.bmp 1 1 Not debug 4 

C0_002.bmp 2 2 2 4 

C0_003.bmp None Not debug Not debug 4 

C0_004.bmp 4 4 Not debug 4 

C0_005.bmp 2 2 2 4 

C0_006.bmp 6 Not debug* Not debug 4 

* As for Image C0_006.bmp, debug is not executed when "User Defined" is set to "Auto" because the block 
number of the image header (=6) is larger than the specified "Number of blocks" in TYPE (=4).  

Setting Intervals Between Sending Images in 
Continuous Inspection 

 

Set the interval of executions in continuous inspection. 

Fastest (Default) / 1 sec / 2 sec / 3 sec / 4 sec / 5 sec 

For checking statistics data or the trend of values from a large amount of 
images, selecting "Fastest" completes debug quickly. For checking 
images and the results one by one, specify the interval longer.  

 

 
The actual inspection time may be longer than the specified interval according to the images to be 
debugged. 

Example) When using bitmap images of 2-Mega color cameras or image files of 4-Mega gray cameras, 
the interval is more than 1 second. 
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8.3 Execution 

8.3.1 Executing Debug 

Reading images from the storage place 
selected in advance (Chapter 8.2.4) in 
sequence and executing an inspection is 
called Debug execution. By using this 
function, you can verify the settings or 
adjust the setting confirming the results. 
There are two execution methods "Run" 
and "Step Run". 
The key guide in DEBUG menu shows that 
the TRIG key is "Run" and the F3 key is 
"Step Run". 

 

The information display area shows the 
type number being executed, the file 
name of the used image and the 
execution status. 

(For details, refer to page 480.) 

 

 
The sources from which images are read and the execution timing are as follows.  

Image Memory:  Debug is executed on the images in the image memory of PV200 from the smallest 
image number in ascending order. 

Test Image in SD: Debug is executed on the images in the test folder in SD from the smallest image 
number in ascending order. 

Image Memory in 
SD: 

Debug is executed on the selected folders from the smallest image number in 
ascending order by folder. 

Output Image in 
SD: 

Debug is executed on the selected folders by making pairs for each folder. 
The order of executions depends on the file system. 

Select Folder: Debug is executed on the selected folders by making pair tables by 100 files. 
Debug is executed after making 100 sets of pairs, and then executed again after 
making the next 100 sets of pairs. 

Continuous Inspection (Run) 
PV200 continuously inspects the images saved in the location specified in "DEBUG" > "Folder select" > "Read 
from". Images are automatically changed by PV200. Pressing the TRIG key in DEBUG menu starts the 
continuous inspection. Press the TRIG key to stop the inspection. 

 
 When the continuous inspection is stopped, it is possible to execute a single inspection (Step Run) by 

pressing the "F3" key. The continuous inspection is restarted from the next image by pressing the TRIG 
key. 

 Parts of images or checker patterns displayed in the screen window may be missing during continuous 
inspection when "Interval" has been set to "Fastest", however, there is no problem with the inspection. 
This phenomenon is caused because the timing of displaying images and the timing of displaying 
checker patterns on the completion of inspection differ depending on the contents of inspection. If you 
want to confirm images and result patterns, set "Interval" to "1 sec" or "2 sec". 
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Single Inspection (Step Run) 
PV200 reads the images saved in the location specified in "Folder select" > "Read from" by one set, and 
executes inspection. The next image is loaded every time the F3 key is pressed and the inspection is executed. 
In "Run" operation, PV200 automatically sends images and executes inspection. In "Step Run", images are 
sent by pressing the F3 key one by one. 

1. Press the "F3" key in DEBUG menu. 

A set of the next image is loaded every time the F3 key is pressed and the inspection is executed.  
 

Press the TRIG key to execute continuous inspection from the next image. 

Errors 

When there is no image in the specified storage location, the right 
message is displayed and debug cannot be executed. Change the setting 
of "Read from" in "Folder select", or store images in the specified storage 
location.  

This message is also displayed when there is no images that meet 
"Target Image" in "Setting". 

 

When the images to be read do not meet the camera setting, the 
right message is displayed. At this time, check the camera setting 
and the type of images. 

If there is an image that is not suitable for the set camera in the 
specified storage location, debug will be aborted. 

 

Camera setting: SETUP menu > "ENVIRONMENT" > "Camera" > 
"Camera Type" or SETUP menu > "TYPE" > "Type Setting" > 
"Camera"* 

*From Ver.2.0, the camera type can be specified from the above 
menu. 

Image type: DEBUG menu > "Folder select" 

 

Reset 

Set the execution status of debug to "Debug 
Start". Select "Reset" to start debugging from 
the beginning. 

After reset, the inspection is started from the 
image with the first number, and statistics 
data such as scan count is started from 0. 

 

Once resetting the operation in the state 
shown in the right figure, the display in the 
information display area "RUN 12" will be 0. 
The scan count will be also 0. (It will be 
indicated as "----" in Data R/W.) 
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8.3.2 Result 

Only the latest result of debug execution or inspection execution can be confirmed by "Result".  It shows 
the executed checker type, checker number, each judgement result and errors.  

Selecting a checker from the list and pressing the ENTER key displays the setting window for the selected 
checker. By using this function, you can confirm the detailed result of each checker, execute tests and adjust 
setting items. 

 

[Checkers displayed in the list] 
Position Adjustment / Area Size Adjustment/ Checker / Geometry Calculation / Numerical Calculation / 
Judgement  
 

1. Select "Result". 

Displays the list of results of the most 
recent debug or inspection. 
 

 
The "Result" can be displayed in both 
DEBUG menu and RUN menu. 
 

 

2. Select a checker number in the result 
list and press the ENTER key. 

The setting window of the selected 
checker appears. 
In this window, it is possible to execute a 
test, confirm the result, adjust or change 
setting items. 
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- When a password has been set (refer to page 

448), the password is requested every time the 
ENTER key is pressed after selecting a 
checker. If the correct password is entered, the 
setting window for the checker appears. (It 
appears in the both cases that "Password" has 
been set to "Switching to SETUP Menu is 
Restricted" and "Switching to Normal Menu is 
Restricted". 

- The operation stops by selecting a checker 
from "Result" in RUN menu. Note that the key 
emulation by PLC communication cannot be 
used. 

 

 

3. Press the CANCEL key to return to the result list after confirming or adjusting items in the 
setting window of checker. 

4. Press the CANCEL key to close the "Result" window. 
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Chapter 9 
 Select Menu (Creating Customized Menu) 
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9.1 Select Menu 

9.1.1 What is Select Menu? 

This is customized setting menus for registering buttons to perform various operations such as area 
settings of checkers or changing minimum and maximum values. Using this function enables to limit 
operations carried out by an operator and make settings easier.  

You can create menu contents freely as necessary by registering operation contents. 

Normal Menu This is the setting menu fixed in PV200. 

Enter sub menus from the main menu (OPERATION, ENVIRONMENT, 
TYPE ...) to change settings. 

Select Menu You can register any menu items you want to set. Register multiple menu items 
in one page, and register the operation contents by switching pages. 

Enter into the registered contents from Select menu and change the settings. 
 

Normal menu Select menu 

 

 
- Pressing the F2 key switches between Normal menu and Select menu. However, you cannot switch 

the menu when the F2 key is not displayed in the key guide such as in the hierarchy under the 
submenu in Normal menu.  

- When switching from RUN menu to SETUP menu, you can select either Normal menu or Select 
menu to display. Refer to page 523 for information on how to specify. 

- A password can be set for switching Select menu to Normal menu. For details of password, refer to 
page 448. 
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Determining Settings of Select Menu 
In Normal menu, all the items can be corrected, changed, detected or added. In Select menu, it is possible 
to limit setting operations or set any menus that operators can easily understand by explaining operating 
procedures as mentioned in Examples of use 1 to 4. 

Example of use 1 

Operator can adjust only certain setting menus to prevent unintended operations (changes) from being 
performed at the site of work. Operable levels can be selected according to the contents of 
registered buttons. The names of registered buttons can be changed as you want. 

・Changing only judgement values (such as max./min. values) Judgement max./min. values of Binary 
Window checker 

 

As the button that is judged as NG is displayed in red, the NG 
item can be recognized at a glance. Measurement results can 
be also checked when entering judgement values. Other items 
such as area setting and slice level can be changed as well as 
judgement values. 

 

 
Not only the maximum and minimum values separately, but also the set of maximum and minimum 
values can be registered in Select menu. 
Use Data R/W to change maximum or minimum values in RUN menu. For the details of Data R/W, 
refer to page 386. 

 
・Changing only specified checker (type and No.) Binary Window No.000 

 

Items such as area setting, inspection condition and judgement 
limit can be changed. However, they cannot be deleted or any 
new checker number cannot be registered. 

The button of the checker that is judged as NG is displayed in 
red. 

 
・Operating only specified checker (type) Binary Window 

 

All operations can be performed for specified checkers.  

New checker numbers can be registered or set checker 
numbers can be deleted. The color of the registered buttons 
does not change even if there is a checker number that is 
judged as NG.  

Example of use 2 
When you want to decrease the number of keypad operations to 
change a setting that is in the low hierarchy 

Edge thresholds of multiple Gray 
Edges 

 
 

When there are multiple items you want to change, only setting 
them in Select menu enables you to change them easily. 

For example, when you want to change "Edge Threshold" of 
Gray Edge, register the buttons to set each "Edge Threshold" in 
the same page number so that the number of keypad operations 
can be considerably decreased. 

The number of keypad operations to change four edge 
thresholds is eleven in Normal menu and four in Select menu.  
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Example of use 3 
When you want to change the name of a menu to a particular name 
for an object to be recognized easier by an operator 
 

The name displayed when registering a button is the name in 
Normal menu. The name of registered button can be changed. 

With PVWIN200, you can input the characters that not on the 
software keyboard. 

The names of edge thresholds 
of Gray Edge checker have 
been changed. 

 

Example of use 4 
When you want to make operating procedures easier by specifying 
the order of operating menus or describing the contents of 
operations 

The operating procedure is described in Select menu as the 
figure on the right so that even an operator who uses the 
PV200 for the first time can adjust it easily. 
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9.1.2 Screen Structure of Select Menu 

The maximum number of registrable select menus is as below. 
Page: Max. 50 pages 
Item: Max. 16 items/page 

(Item means text/button/separator/page jump.) 

"Select Menu" Setting Window 
This is the window to setting Select menu. 

 
1 Page No. The page number can be 

changed by entering a 
number. 

 

2 Page name The name is changed 
with the software 
keyboard. 

3 Normal setting Sixteen items from 00 to 
15 can be set. Choose 
the number you want to 
set, and select one from 
Set Button/Set Text/Set 
Page Jump/Set 
Separator.  

4, 5 Preview 
display 

The menus being set in 
step 3 can be displayed 
as the figure 5 on the 
right so that you can get 
an image when they are 
in Select menu. 
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Select Menu (Screen After Setting) 
This is the window for actually operating the items registered in the Select Menu setting window. 

Tilting the ENTER key up/down in this menu, you can select buttons. By tilting it left/right, you can jump to 
another page. However, texts or separators cannot be selected. 

 
1 Page No. 

and page 
name 

The page number and name is 
displayed. 

 

2 Page 
switchable 
mark 

By tilting the ENTER key 
left/right, you can switch the 
page. These marks are 
displayed when other pages 
exist. They are not displayed 
when only one page exists. 
 

 
By registering a page jump 
button, you can jump to a 
separate page. 
For the details of registering 
page jump buttons, refer to 
page 517. 

3 Text 
setting 

Up to 32 one-byte characters 
can be displayed. 

4 Button 
setting 

• By pressing the button, hierarchies under the registered menu can be set. 
• Although the button name is automatically registered, the name can be changed. 
• If a button is registered by specifying a checker number of a function related to checker and  the 

test result is NG, the background color of the button will be displayed in red. However, when the 
cursor is on the button that is judged as NG, the selected color for the cursor has priority and it is not 
displayed in red. 

* When using the account function, buttons for which "Account Limit" has been set to "Invalid" may 
not be displayed depending on logged-in users. For details, refer to page 510. 

5 Page jump 
setting 

• Button to jump to another page in Select menu. 
• It cannot be selected when there is no page to jump to. 

6 Separator 
display 

Displays a separator line in Select menu. 
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9.1.3 Setting Select Menu 

1. Select "TYPE" > "Select Menu". 

2. Select "Set" in "Assign Menu". 

The setting window of Select Menu is displayed. 

3. Select a page number. 

By tilting the ENTER key left/right, the page can be 
changed. 
Entering a page number, you can jump to the specified 
page. 

4. Select a item number. 

5. Select a function. 

Select one from Set Button, Set Text, Set Page Jump and 
Set Separator. For the details of each setting method, 
refer to the sections mentioned below. 

 

 

 

Setting Button 
Set the menus of Normal menu you want to register in Select Menu. 

Selecting "Set Button" displays the following setting window. 

 
1 Page No. and 

Setting No. 
The selected page number and setting 
number are displayed. 

 

2 Set Button Before setting, "Unset" is displayed. After 
setting, the name of the main menu of the 
selected item is displayed. The selected 
item is displayed in the Select menu screen. 

3 Button Name Although the name of the selected item is 
displayed as its name, the name can be 
changed. 
Up to 32 one-byte characters can be 
displayed.  
It cannot be selected when no button is set. 
With PVWIN200, you can input the 
characters that not on the software 
keyboard. 

4 Alignment Select from Left, Center or Right. 
It cannot be selected when no button is set. 

5 Account Limit Select Valid or Invalid. 
Select the limit on accessing this button 
when Select Menu is displayed, whether to 
follow "Account Setting" (Valid) or allow the 
access regardless of "Account Setting" 
(Invalid). For details, refer to page 510. 

6 Checker 
Resetting 

The number of selected item or the settings 
can be changed. 

7 Details of 
Button setting 

The details of the settings selected by "Set 
Button" are displayed. 
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Newly registering a menu as button 

1. Select "Page" and "Item No.". 

 

 

 

2. Select "Set Button". 

The button setting menu is displayed. 

3. Press the ENTER key on “Unset”. 

Select data to register. 

Specify the checker number and parameters you want to register 
following the window. Red triangle marks are displayed when selectable 
items are extended on multiple pages. Tilt the ENTER key left or light to 
change the page. 
The description field shows the detail of registered data after 
registration. 
For details of registrable items, see page 524. 

 
 

 
Press the F2 key when displaying "F2: Fix Setting" in the key guide 
to register items in hierarchies other than the lowest one.  
For example, to register the set of judgement max. and min. values of 
Gray Edge, select Gray Edge checker up to the hierarchy of 
"Judgement Limits" and press the F2 key. 
When registrable item is displayed in gray, it shows that the parameter 
of this item is not set (does not exist). Even if the parameter is not set, it 
can be registered in Select menu. However, the lower hierarchies of the 
item displayed in gray cannot be registered. 

 

Changing the registered data of button 
The specified checker can be reset in the button setting window. 

By copying the button that has been already registered and changing its checker number, you can easily 
register multiple buttons of the same item with different checker numbers.  

Also, an item can be changed to that in the same hierarchy as the set button. For example, if you want to 
register the buttons for "Edge Threshold" or "Edge Condition" in the same hierarchy as "Scan Pitch" of Gray 
Edge checker after registering the button for "Scan Pitch", copying the button of "Scan Pitch" of Gray Edge 
checker after registering the button for "Scan pitch" copying the button of "Scan Pitch" and using "Checker 
Resetting" enables to change it to the button for "Edge Threshold" or "Edge Condition". 
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When changing a target checker number 

Only the checker numbers of the checkers that have been already set can be changed.   
Changing Gray Edge No.000 Judgement Limits to Gray Edge No.005 Judgement Limits 

 

1. Select the button of the checker you want to change in the Select Menu setting window. 

2. Select “Set” in "Checker Resetting". 

The items that can be changed are displayed. 
In the above example, Judgement Limits of Binary Window No.000 is changed to Judgement Limits of 
Binary Window No.005. 

3. Select a checker number. 

When the cursor on Judgement Limits, move it to the checker number with the CANCEL key and by 
tilting the ENTER key. 
Only the checker numbers that have already set can be selected. 
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When changing items in a checker 

1. Select the item (already registered) you want to change in the Select Menu setting window. 

2. Select “Set” in "Checker Resetting". 

3. Select an item to change. 

When there are multiple items that can be changed, use the left or right keys to confirm other conditions 
of changes. 

Checker Resetting window 

 

 Checker Resetting items 

 
 

The contents described in "8.1.7 Registrable Items" can be newly registered. In Checker Resetting, 
however, only the items in the same hierarchy as the currently registered items can be changed. The 
items cannot be changed to any items in higher or lower hierarchies. 
The "Scan Pitch" and "Edge Threshold" in the above right figure can be changed as they are in the same 
hierarchy. In "Checker Resetting", "Scan Pitch" cannot be changed to "Inspection Condition" as they are 
not in the same hierarchy. 

 

Changing the button name 
The button name is automatically set when a menu is newly registered.  This name can be changed. By 
changing the button name, an operator can easily understand the content of the button.  

 
 

When performing Checker Resetting, 
the button name is changed to that of 
the item after resetting.  However, if 
the button name has been already 
changed, it is not changed to the button 
name after resetting. 
With PVWIN200, you can input the 
characters that not on the software 
keyboard. 
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Select whether to Follow "Account Setting" for Displaying Created Buttons or Not 
(Account Limit) 

"Account Limit" in Select Menu is used to select whether to follow 
the "display setting" of each logged-in user for enabling or 
disabling the operations of target buttons or enabling them 
regardless of users. 

 

Valid: Accessing target buttons is limited by "Account Setting". 
When a logged-in user is allowed to access target buttons, 
they are displayed. As unpermitted items are not displayed, 
the user cannot operate them. 

Invalid: Any user can operate target buttons regardless of "Account 
Setting". 

 

"Account Limit" in Select Menu can be specified when the "Access 
Authority" of logged-in user is "Admin" or Account setting is not 
used. 

 

 
For details of "Account Setting", refer to page 456. 

 

 
All buttons registered in Select Menu are displayed regardless of the setting (Valid or Invalid) of "Account 
Limit" when "Account Setting " is not used or the "Access Authority" of logged-in user is "Admin". 

When "Account Setting" is used and the "Access Authority" of logged-in user is "General User" or "Start 
User", the buttons which belongs to the items permitted in "Menu display setting" of each user are 
displayed, but the buttons which belong to the unpermitted items are not displayed and only the "Invalid" 
button is displayed. 
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Button display of Account Setting and Select Menu 

 

 

Difference in displays in Select Menu 

In the following image, six buttons are set in Select Menu. 

Account 
Setting 

 Display of Select Menu 

Not Use ‐ Displays all registered buttons. 

 

Use 

・Admin  

・Start User or General User 

 

 

 

 

 
 

 

Displays the buttons for the items which the 
logged-in user is allowed to access and the 
buttons with the setting "Account Limit: Invalid) 
at the time of the registration. 

 
Buttons with the setting "Account Limit: Valid" 
and without access authority are not displayed. 

 

The next page describes the difference in the button display in Select Menu in accordance with the "Menu 
display setting" and "Account Limit" settings. 

Account Setting Buttons which are displayed and operated in Select Menu 

In the case of "Not Use" All registered buttons 

In the case 
of "Use" 

Admin  All registered buttons 

Start User or 
General User 

Buttons for the items which the logged-in user is allowed 
to access 

+ 

Buttons with the setting "Account Limit: Invalid" at the time 
of the registration 
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Difference in Menu Display in accordance with "Account 
Setting" and "Account Limit" for Select Menu Buttons 

 

This section describes the difference in the display of the buttons in Select Menu in accordance with 
"Account Limit" when the "Access Authority" of logged-in user is General User or Start User. 

Example) When registering "System Settings" under "ENVIRONMENT" and its lower menu "Startup 
Setting" as the buttons in Select Menu  

 

 
 

 

■ Account Limit: Valid buttons are not displayed unless the "VIEW" field of "Menu display setting" shows X 
mark. 

The following example shows the case when setting buttons for "ENVIRONMENT" > "System Settings and 
"ENVIRONMENT" > "System Settings" > "Startup Setting", and following "Menu display setting" for each 
operation.  

Select Menu display for Admin "Menu display setting" for Start User and General User 

  
  

 Select Menu display for Start User and General User 

 

 

As "Account Limit" is set to 
"Valid", only the items specified 
in "Menu display setting" are 
displayed. Both "System 
Settings" and "Startup Setting 
are not displayed as they are 
not allowed to be displayed (no 
X mark). 
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■ As for the buttons with the setting "Account Limit: Valid", operations of the items under the registered 
items are subject to "Menu display setting". 

 

The following example shows the case when setting buttons for "ENVIRONMENT" > "System Settings and 
"ENVIRONMENT" > "System Settings" > "Startup Setting", and following "Menu display setting" for each 
operation.  

Select Menu display for Admin "Menu display setting" for Start User and General User 

  
  

 Select Menu display for Start User and General User 

 

 
 (1) As "Account Limit" is set to "Valid" for the buttons of both "System 

Settings" and "Startup Setting", the setting of "Menu display setting" 
determines whether or not they are displayed. 

(2) As the "VIEW" field of "ENVIRONMENT" shows X, this item is 
displayed as a button, however, the setting of VIEW determines 
whether or not "Startup Setting", "Operation" and "System Register" 
under this item are displayed. In this example, the "VIEW" field of 
"Operation" does not show X so that it is not displayed. 

(3) As the "VIEW" field of "System Settings" shows X, the button is 
displayed. 
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■As for the buttons with the setting "Account Limit: Invalid", items under the registered items can be 
operated freely.  

Select Menu display for 
Admin "Menu display setting" for Start User and General User 

 
 

  
 Select Menu display for Start User and General User 

 

 
 (1) Although both "VIEW" fields of "ENVIRONMENT" and "Startup Setting" 

are not with X in "Menu display setting", these buttons are displayed 
regardless of "Menu display setting" because "Account Limit" is set to 
"Invalid" for "ENVIRONMENT". 

(2) "Account Limit" is set to "Invalid" for "ENVIRONMENT". When setting 
"Invalid", this setting is applied to items under it. Therefore, when opening 
the button of "ENVIRONMENT", "Startup Setting", "Operation" and 
"System Register" are displayed and can be set although they are not 
allowed to be displayed in "Menu display setting". 
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Registering Button from Normal Menu to Select 
Menu 

Buttons can be registered from the normal operation menu to Select menu.  

How to register is as below. 

1. Move the cursor onto the item you want to register from the normal 
menu (OPERATION, ENVIRONMENT or TYPE, ...). 

INSPECTION>Checker>
Binary Window 000 

 

2. Press the FUNC key on the item to register. 

The pop-up menu appears. 

 

3. Select "Assign Menu". 

The setting window of Select Menu is displayed. 
Select the page you want to register and press the ENTER key on 
the item number to register. 

 
 
"Account Limit" for the button registered in this method is set to 
"Valid". 

Setting Text 
Up to 32 one-byte characters can be displayed. Texts are displayed in green in the Select Menu setting 
window. 

1. Select "Page" and "Item No.". 

2. Select "Set Text". 

A software keyboard is displayed. 

3. Enter characters one by one. 

With PVWIN200, you can enter the 
characters that not on the software 
keyboard. 

4. After entering is completed, press the 
ENTER key. 

The content entered in "Enter Text" is 
displayed. 

5. Select "Alignment". 

Select from left, Center and Right. 
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Setting Page Jump 
By setting Page Jump, you can jump to a specified page of Select menu. 

By doing so, the number of keypad operations can be decreased. 

1. Select "Page" and "Item No.". 

2. Select "Set Page Jump". 

3. Enter a page number in "Jump to Page". 

4. Change the name in "Button Name". 

If unchanged, it shows "Jump to Page XX". 

5. Select "Alignment". 

Select from Left (default), Center and Right. 

 

Setting Separator 
A separator line is displayed in Select menu by setting separator.  

Set separator to split items in Select menu. 

1. Select "Page" and "Item No.". 

  

2. Select "Set Separator". 

3. "- - - Separator - - -" is displayed in the selected item number. 

 

 
As the figure on the right, a separator line is displayed to split 
columns in the Select Menu window. 
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9.1.4 Edit Function of Setting Items 

Editing Set Items 
Items can be copied, deleted or sorted. 

Pressing the FUNC key on an item number appears the following pop-up menu. 

 
Cut: Cuts the item. 

Can move the cut item by pasting to another item. 
The item to be cut is displayed in red. 

 

Copy: Copies the item. The item to be copied is displayed in red. 
Paste: Pastes the copied or cut item. 
Clear: Returns the item to be unset. 
Insert: Inserts an unset item above the highlighted item. If an unset item 

exists below the items to be moved down, this unset item will be 
deleted when those items are moved down. 
If the item No.15 must be moved by inserting an unset item, the 
confirmation message of deletion appears. Select "Yes" to delete 
it. 

Delete: Deletes the selected setting number. All the setting numbers 
after the selected setting number will be the number one number 
before. When the item to be deleted has been already set, the 
confirmation message of deletion appears. Select "Yes" to delete 
it. 

Copy Page: Copies the selected page. The page to be copied is displayed in 
red. 

Paste Page: Pastes the copied page. 
Delete Page: Returns all the items in the page to be unset. 
Sort: Sorts the set items. 

Three edit modes are available. After sorting the items, the 
confirmation message appears. Select "Yes" to complete the 
sort. 
Selectable from "Rearrange in Order by Number", "Rearrange 
Selected Menus" and "Rearrange by Drag and Drop". See 
"Sorting Items" (page 520). 

 

Copying or cutting and moving an item 

By using this feature, you can copy or move an registered item to another item.  

1. Select the item that you want to copy and press the FUNC key. 

The pop-up menu appears. 

2. Click "Copy" or "Cut". 

The item copied or cut is displayed in red. 

3. Highlight the destination cell you want to paste and press the 
FUNC key. 

The pop-up menu appears. 

4. Select "Paste". 

Pasting is executed. 
 

 
When the copied item is displayed in red, it can be pasted as many 
times as needed. 
It can be also pasted in different pages. 
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Inserting an item 

By using this feature, you can insert an unset item. 

1. Select the item to insert an unset item and press the FUNC 
key. 

The pop-up menu appears. 

2. Select "Insert". 

3. Inserts an unset item above the highlighted item. 

 
 If data is set in the item No. 15, the message "The data of 

No.15 will be deleted. Are you sure?" appears. 

 If an unset item exists below the items to be moved down, 
this unset item will be deleted. The items below the deleted 
number will not be moved. 

 

Clearing or deleting an item 

By using these features, you can clear or delete an registered item.  
Clear: Makes the selected number to be unset. Any other setting items 

unchanged. 
Delete: Deletes the selected number. Each number after it becomes the number 

one number before. 

1. Select the item you want to clear or delete and press the FUNC key. 

The pop-up menu appears. 

2. Select "Clear" or "Delete". 

Copying a whole page 

By using this feature, you can copy all the items in a page. 

1. Press the FUNC key in Select menu. 

The pop-up menu appears. 

2. Select "Copy Page". 

All the items in the page to be copied are displayed in red. 

3. Highlight the destination page you want to paste and press the FUNC key. 

The pop-up menu appears. 

4. Select "Paste". 

Pasting is executed. 
 

When the items in the copied page is displayed in red, it can be pasted as many times as needed. 
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Deleting a whole page 

By using this feature, you can delete all the items in a page.  

1. Press the FUNC key in Select menu. 

The pop-up menu appears. 

2. Select "Delete Page". 

3. All the items in the page are deleted. 

Sorting Items 

By using this feature, you can sort the item numbers in a page.  

1. Press the FUNC key on an item. 

The pop-up menu appears. 

2. Select "Sort". 

The "Sorting of Setting Data" window appear. 

3. Select a edit mode. 

Selectable from "Rearrange in Order by Number", "Rearrange 
Selected Menus" and "Rearrange by Drag and Drop". 

 
Rearrange in 
Order by Number: 
(Default) 

Assign a number by pressing the ENTER key 
in order. Once all the orders are decided 
from 00 to 15, sorting is executed. 

Rearrange 
Selected Menus: 

Select the source item and the destination 
item to replace. 

Rearrange by 
Drag and Drop: 

Move the selected data to a desired position 
by tilting the ENTER key up/down. 

4. Sorting is executed according to the selected edit mode. 

After sorting, press the CANCEL key twice. The confirmation 
message appears. 

5. Select "Yes". 

The sorted result is registered. 
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Displaying Preview / Hiding Preview 
This is the function to confirm the select menu screen of the registered contents in advance. 

Selecting "Display Preview" displays the preview on the right side of the setting window.  

Selecting "Hide Preview" hides the preview. 
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9.1.5 Referring to Other Type Menus 

The select menu that has been set for another type can be copied to the type currently selected.  

Using this function copies all pages of the select menu. It is not possible to copy some of the pages.  

If a checker that is unset in the current type exists in the copied select menu, the text color of the button of 
the unset checker is displayed in gray and it cannot be selected when using the select menu.  (It can be 
selected, corrected or deleted in the setting window.) 

Referring to Other Type Menus 

1. Select "TYPE" > "Select Menu". 

 

 

2. Select "Copy" in "Refer to Other Type Menus". 

The "No." and "Type Title" of the set type is displayed. 

3. Select the type number you want to copy. 

 
If a select menu has been already set for the current type, the 
message of overwrite confirmation appears. 

9.1.6 Referring to the Select Menu Created by Another PV200 

The select menu created by another PV200 used in a different facility can be copied using a SD memory card. 
However, copying may not be possible when the current environmental setting and that of the PV200 to be 
copied are different. (For the details, refer to page 77.) 

After copying the type in a SD memory card to the PV200, copy the menu from "TYPE" > "Select Menu" > 
Refer to Other Type Menus" > "Copy". 

1. Select the type to read. 

Press the FUNC key on the destination type 
number under "Select Type". 
The pop-up menu appears. 

Reading Type from SD card to PV200 

PV200  
(Execution memory) 

SD memory card 

Current type No. 000 

 

2. Select "Read Type No. in SD". 

The storage area number in the SD card is 
displayed. 

3. Select the area number in which the type to 
copy is saved. 

The type data in the selected area number is 
displayed. 
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4. Select the type number you want to copy. 

The confirmation message appears. 
Select "Yes" to copy the selected type to the PV200. 
 
For information on using the select menu of the copied type, refer to “9.1.5 Referring to Other Type 
Menus”. 

Specifying Menu Display in SETUP Menu 
As the factory default (or when initializing environment), the normal menu is displayed in SETUP menu.  

In the setting below, you can select which menu is displayed when switching from RUN menu to SETUP 
menu. 

1. Select “ENVIRONMENT” > "System Settings".  

 
 
 
 

 

2. Select "Operation". 

 

3. Select "Select Menu" in "Menu Display Priority". 

Select from Last-used Menu, Normal Menu, and Select 
Menu. 

 
Last-used Menu: 
(Default) 

Retains the menu screen when 
switching from SETUP menu to RUN 
menu. 
Displays Normal menu when 
switching to RUN menu for the first 
time after the startup of PV200. 

Normal Menu: Displays Normal menu whenever 
switching from RUN menu to 
SETUP menu. 

Select menu: Displays Select menu whenever 
switching from RUN menu to 
SETUP menu. 
If a select menu is not set, the 
message "No select menu setting." 
appears. 

 

 
Press the F2 key to display Select menu from Normal menu in SETUP menu.  

However, you cannot switch the menu when the F2 key is not displayed in the key guide or from the 
hierarchy under the submenu in Normal Menu. 

When "Password" is set to "Valid (Switching to Normal Menu is Restricted)", password is required for 
switching to Normal menu with the F2 key in SETUP menu. Refer to page 448 for details. 

Page of Select Menu Displayed When Switching 
Type 

The page number displayed when switching to Select menu is also displayed even if the type is switched. 

However, if the same page does not exist in the selected type, it cannot be displayed. When the same page 
does not exist, the screen shows as below. 

When the same page number exists in 
the selected type: 

The same page number is displayed. 

When the same page number does not 
exist in the selected type: 

The smallest page number among the pages 
registered in the selected type is displayed. 

When Select menu does not exist in the 
selected type: 

"No select menu setting" is displayed. 
Press the F2 key to switch to Normal menu. 
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9.1.7 Registrable Items 

The items that can be registered by "Set Button" in Select Menu are as below.  The items below are those 
that can be registered at a maximum. 

The boxed items can be registered. The unboxed items cannot be registered. 

The contents that can be changed differ depending on the registered item. Refer to the table below. 

 
1 As it is unboxed, it cannot be set as button. 

 

2 Once "Checker" is set as button, all types of 
checkers can be newly registered, added, deleted 
or changed. 

3 Once "Gray Edge" is set as button, the settings for 
Gray Edge checker of a specified number can be 
changed. 

4 Once "Specify No." is set as button, the settings 
for Gray Edge checker of a specified number can 
be changed. 

5 Once "Area Setting" is set as button, subitems can 
be changed from the Area Setting tab. 

6 Once "Comment" is set as button, only comments 
can be changed. 

7 Although "Select Color Image" and "Color Image 
Setting" are displayed, these two items can be set 
as button even when using a gray camera. 

For registering items 2 to 5 as button, press the F2 key on each item as selectable items exist in the lower 
hierarchies. For registering items 6 and 7 as button, press the ENTER key on each item as no selectable item 
exists in the lower hierarchy. 

 

 
Some unset items may be registered in Select menu, however, they cannot be changed. 

Example 1 
When referring "Gray Edge" > "Area Setting" > "Select Color 
Image" with a gray camera: 
"Select Color Image" can be selected from Select menu. However, 
it cannot be changed after selection as a gray camera is used. 
 

 
 

Example 2 
When referring "Gray Edge" > "Area Setting", "Color Image 
Setting" with a gray camera: 
The text of "Color Image Setting" is displayed in gray and cannot 
be selected in Select menu. 
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OPERATION      
 └ To RUN Menu     

 
ENVIRONMENT      
 ├ System Settings     
 │ ├ Startup Setting     
 │ ├ Operation     
 │ └ System Register     
 │  ├ SYS:REG0 Default    
 │  ├  :        
 │  └ SYS:REG7 Default    
 ｜           
 ├ Input/Output       
 │ ├ PLC Communication    
 │ ├ Parallel I/O      
 │ ├ Parallel I/O Output     
 │ ├ Serial      
 │ ├ General Output     
 │ ├ Image Output     
 │ ├ Save Image Memory    
 │ ├ Print Screen     
 │ ├ SD Card Setting    
 │ ├ FTP Server    
 └ FTP Client    
 ｜           
 ├ CAMERA       
 │ ├ CAMERA      
 │ └ FLASH Polarity     
 ｜           
 ├ Transparence      
 ｜           
 └ Password       

 
TYPE      
 ├ Select Type       
 ｜           
 ├ Type Setting      
 │ ├ Execution Condition    
 │ ├ Camera      
 │ │ └ Specify Camera No.    
 │ │  ├ Shutter Speed(ms)    
 │ │  ├ Capture Delay (ms)    
 │ │  ├ FLASH Delay (ms)    
 │ │  ├ FLASH Span (ms)    
 │ │  ├ Partial Imaging    
 │ │  ├ Trapezoid Adjustment   
 │ │  ├ Calibration    
 │ │  ├ White Balance    
 │ │  └ Camera Gain    
 │ └ Color Extraction     
 ｜           
 ├ Marker Display      
 ｜           
 └ Data R/W       
 ├ Data R/W 0      
 ├ Data R/W 1      
 └ Font Color      

 

 

 
INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │  ├ (Position Adj.: For Binary Edge) 
 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ ├ Priority    
 │  │ │ ├ Detect Center of Base 0, 1  
 │  │ │ ├ Detect Center of Base 2, 3  
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting   
 │  │ │ │ └ Area    
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ │ ├ Slice Level   
 │  │ │ │ ├ Edge Condition   
 │  │ │ │ └ Filter    
 │  │ │ └ Search Method    
 │  │ │  ├ Filter    
 │  │ │  └ Width    
 │  │ ├ Base Checker Parameter No.1  
│ 
│ 

 │ 
│ 

│ 
│ 
└ (Registrable items are the same as 

No.0.) 
 │  │ │   :      
 │  │ └ Base Checker Parameter No.3  
│ 
│ 

 │ 
│ 

 └ (Registrable items are the same as 
No.0.) 

 │  │         
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INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │  ├ (Position Adj.: For Gray Edge) 
 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ ├ Priority    
 │  │ │ ├ Detect Center of Base 0, 1  
 │  │ │ ├ Detect Center of Base 2, 3  
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting   
 │  │ │ │ └ Area    
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ │ ├ Scan Method   
 │  │ │ │ ├ Edge Condition   
 │  │ │ │ ├ Edge Threshold   
 │  │ │ │ └ Detect Position   
 │  │ │ └ Search Method    
 │  │ │  ├ Scan Pitch    
 │  │ │  ├ Filter    
 │  │ │  ├ Width    
 │  │ │  └ Average Range   
 │  │ ├ Base Checker Parameter No.1  
│ 
│ 

 │ 
│ 

│ 
│ 
└ (Registrable items are the same as 

No.0.) 
 │  │ │   :      
 │  │ └ Base Checker Parameter No.3  
│ 
│ 

 │ 
│ 

 └ (Registrable items are the same as 
No.0.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │  ├ (Position Adj.: For Feature Extraction) 
 │ 
 │  

 ├ 
│ 

(Po/Rot Adjustment: For Feature 
Extraction (Principal Axis Angle)) 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ └ Base Checker Parameter No.0  
 │  │  ├ Area Setting    
 │  │  │ ├ Select Color Image   
 │  │  │ ├ Color Image Setting   
 │  │  │ └ Area    
 │  │  ├ Inspection Condition   
 │  │  │ ├ Grayscale Preprocess  
 │  │  │ ├ Slice Level   
 │  │  │ ├ Target    
 │  │  │ ├ Filter    
 │  │  │ ├ Output : Objects 1 - x  
 │  │  │ ├ Sorting    
 │  │  │ └ Sorting Order   
 │  │  ├ Search Method    
 │  │  │ ├ Labeling   
 │  │  │ ├ Boundary   
 │  │  │ ├ Perimeter    
 │  │  │ ├ Proj. Width, Height   
 │  │  │ ├ Principal Axis Angle   
 │  │  │ ├ Fill Holes   
│  │  │ └ Drawing Pattern of Result  

 │  │  └ Extraction Condition   
 │  │   ├ Max. Object Area   
 │  │   ├ Min. Object Area   
 │  │   ├ Max. Proj. Width   
 │  │   ├ Min. Proj. Width   
 │  │   ├ Max. Proj. Height   
 │  │   └ Min. Proj. Height   
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INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │  ├ （Position Adj.: For Matching） 
 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ └ Base Checker Parameter No.0  
 │  │  ├ Area Setting    
 │  │  │ ├ Select Color Image   
 │  │  │ ├ Color Image Setting   
 │  │  │ ├ Template    
 │  │  │ └ Search Area   
 │  │  ├ Inspection Condition   
 │  │  │ ├ Grayscale Preprocess  
 │  │  │ ├ Detect Mode    
 │  │  │ ├ Filter Adjustment   
 │  │  │ ├ Detect B/W Reversed Template 
 │  │  │ ├ Sorting    
 │  │  │ ├ Sorting Order   
 │  │  │ ├ Template Rotated by 180d  
 │  │  │ ├ Ignore Dark Image   
 │  │  │ └ Threshold to Ignore Dark Image 
 │  │  └ Sequence    
 │  │   ├ Sequence Setting Table  
 │  │   └ Square Correlation   
 │  │         
 │  ├ （Position Adj. :For Contour Matching） 
 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ └ Base Checker Parameter No.0  
 │  │  ├ Area Setting    
 │  │  │ ├ Select Color Image   
 │  │  │ ├ Color Image Setting   
 │  │  │ ├ Template    
 │  │  │ └ Search Area   
 │  │  ├ Inspection Condition   
 │  │  │ ├ Grayscale Preprocess  
 │  │  │ ├ Out-Point Limit   
 │  │  │ ├ Shape    
 │  │  │ ├ Detect B/W Changed Image 
│  │  │ ├ Max. No. of results 

 │  │  │ ├ Magnification Range (+/-%) 
 │  │  │ └ Min. Corr.   
 │  │  └ Execution Condition  
 │  │   ├ Accuracy  
 │  │   └ Speed  
│  │   ├ Overlap Ratio Level  
│  │   ├ Sorting  
│  │   └ Sorting Order  

 
INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │  ├ （Position Adj. :For Smart Edge (Circle) 
 │ 
 │ 

 ├ 
│ 

(Position Rotation Adj.: For Smart Edge 
(Circle) 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ └ Base Checker Parameter No.0  
 │  │  ├ Area Setting    
 │  │  │ ├ Select Color Image   
 │  │  │ ├ Color Image Setting   
 │  │  │ └ Area    
 │  │  │ └ Area Setting    
 │  │  ├ Virtual Circle Detect Condi. 
 │  │  │ ├ Grayscale Preprocess  
 │  │  │ ├ Detect Mode  
 │ 
 │ 

 │ 
│ 

 │ 
│ 

│ 
│ 

(For Position Rotation Adjustment 
only) 

 │  │  │ ├ Detection Method   
 │  │  │ ├ Rotation Adjustment Angle 
 │ 
 │ 

 │ 
│ 

 │ 
│ 

│ 
│ 

(For Position Rotation Adjustment 
only) 

 │  │  │ ├ Edge ratio used(%)   
 │  │  │ └ Execution Mode   
 │  │  └ Edge Detect Condition   
 │  │   ├ Scan Direction 0   
 │  │   ├ Scan Method 0   
 │  │   ├ Edge Condition 0   
 │  │   ├ Edge Threshold 0   
 │  │   ├ Detect Position 0   
 │  │   ├ Filter0    
 │  │   ├ Width 0    
 │  │   └ Average Range 0   

 



 

528 

C
h. 9 

S
elect M

enu (C
reating C

ustom
ized M

enu) 

 
INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │   ├ （Position Adj. :For Smart Edge (Line)） 
 │  
 │ 

 ├ 
│ 

（Pos/Rot Adjustment : For Smart Edge 
(Line)） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting   
 │  │ │ │ └ Area    
 │  │ │ ├ Approx. Line Detect Cond.  
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ │ ├ Detection Method   
 │  │ │ │ ├ Edge ratio used(%)   
 │  │ │ │ └ Execution Mode   
 │  │ │ └ Edge Detect Condition   
 │  │ │  ├ Scan Direction 0   
 │  │ │  ├ Scan Method 0   
 │  │ │  ├ Edge Condition 0   
 │  │ │  ├ Edge Threshold 0   
 │  │ │  ├ Detect Position 0   
 │  │ │  ├ Filter0    
 │  │ │  ├ Width 0    
 │  │ │  └ Average Range 0   
 │  │ └ Base Checker Parameter No.2  
 │  │  └ (Registrable items are the 

same as No.0.) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │ 
 │ 

 ├ 
│ 

（Pos/Rot Adjustment : For Matching 
(360-degree)） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ └ Base Checker Parameter No.0  
 │  │  ├ Area Setting    
 │  │  │ ├ Select Color Image   
 │  │  │ ├ Color Image Setting   
 │  │  │ ├ Template    
 │  │  │ └ Search Area   
 │  │  ├ Inspection Condition   
 │  │  │ ├ Grayscale Preprocess  
 │  │  │ ├ Detect Mode    
 │  │  │ ├ Filter Adjustment   
 │  │  │ ├ Detect B/W Reversed Template 
 │  │  │ ├ Rotation Range (+/-)  
 │  │  │ ├ Angle - Step   
 │  │  │ ├ Angle - Accuracy   
 │  │  │ ├ Sorting    
 │  │  │ ├ Sorting Order   
 │  │  │ ├ Template Rotated by 180d  
 │  │  │ ├ Ignore Dark Image   
 │  │  │ └ Threshold to Ignore Dark Image 
 │  │  └ Sequence    
 │  │   ├ Sequence Setting Table  
 │  │   └ Square Correlation   
 │  │         
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INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │ 
 │ 

 ├ 
│ 

（Pos/Rot Adjustment : For Contour 
Matching (360-degree)） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ └ Base Checker Parameter No.0  
 │  │  ├ Area Setting    
 │  │  │ ├ Select Color Image   
 │  │  │ ├ Color Image Setting   
 │  │  │ ├ Template    
 │  │  │ └ Search Area   
 │  │  ├ Inspection Condition   
 │  │  │ ├ Grayscale Preprocess  
 │  │  │ ├ Out-Point Limit   
 │  │  │ ├ Shape    
 │  │  │ ├ Detect B/W Changed Image 
│  │  │ ├ Max. No. of results 

 │  │  │ ├ Rotation Range (+/-)  
 │  │  │ ├ Magnification Range (+/-%) 
 │  │  │ └ Min. Corr.   
 │  │  └ Execution Condition  
 │  │   ├ Accuracy  
 │  │   ├ Speed  
│  │   ├ Overlap Ratio Level  
│  │   ├ Sorting  
│  │   └ Sorting Order  

 │  │         

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │ 
 │ 

 ├ 
│ 

（Pos/Rot Adjustment : For Feature 
Extraction（2 checkers）） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting   
 │  │ │ │ └ Area    
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ │ ├ Slice Level   
 │  │ │ │ ├ Target    
 │  │ │ │ ├ Filter    
 │  │ │ │ ├ Output : Objects 1 - x  
 │  │ │ │ ├ Sorting    
 │  │ │ │ └ Sorting Order   
 │  │ │ ├ Search Method    
 │  │ │ │ ├ Labeling   
 │  │ │ │ ├ Boundary   
 │  │ │ │ ├ Perimeter    
 │  │ │ │ ├ Proj. Width, Height   
 │  │ │ │ ├ Principal Axis Angle   
 │  │ │ │ └ Fill Holes   
│  │ │ │ └ Drawing Pattern of Result  

 │  │ │ └ Extraction Condition   
 │  │ │  ├ Max. Object Area   
 │  │ │  ├ Min. Object Area   
 │  │ │  ├ Max. Proj. Width   
 │  │ │  ├ Min. Proj. Width   
 │  │ │  ├ Max. Proj. Height   
 │  │ │  └ Min. Proj. Height   
 │  │ └ Base Checker Parameter No.2  
│ 
│ 

 │ 
│ 

 └ (Registrable items are the 
same as No.0.) 

 

 │  │         
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INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │ 
 │ 

 ├ 
│ 

（Pos/Rot Adjustment : For Matching (2 
checkers)） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting   
 │  │ │ │ ├ Template    
 │  │ │ │ └ Search Area   
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ │ ├ Detect Mode    
 │  │ │ │ ├ Filter Adjustment   
 │  │ │ │ ├ Detect B/W Reversed Template 
 │  │ │ │ ├ Rotation Range (+/-)  
 │  │ │ │ ├ Angle - Step   
 │  │ │ │ ├ Angle - Accuracy   
 │  │ │ │ ├ Sorting    
 │  │ │ │ ├ Sorting Order   
 │  │ │ │ ├ Template Rotated by 180d 
 │  │ │ │ ├ Ignore Dark Image   
 │  │ │ │ └ Threshold to Ignore Dark Image 
 │  │ │ └ Sequence    
 │  │ │  ├ Sequence Setting Table  
 │  │ │  └ Square Correlation   
 │  │ └ Base Checker Parameter No.2  
 │  │  └ (Registrable items are the 

same as No.0.) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │ 
 │ 

 ├ 
│ 

（Pos/Rot Adjustment : For Contour 
Matching (2 checkers)） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting   
 │  │ │ │ ├ Template    
 │  │ │ │ └ Search Area   
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ │ ├ Out-Point Limit   
 │  │ │ │ ├ Shape    
 │  │ │ │ ├ Detect B/W Changed Image 
 │  │ │ │ ├ Max. No. of results 
 │  │ │ │ ├ Rotation Range (+/-)  
 │  │ │ │ ├ Magnification Range (+/-%) 
 │  │ │ │ └ Min. Corr.   
 │  │ │ └ Execution Condition   
 │  │ │  ├ Accuracy    
 │  │ │  └ Speed    
│  │ │  ├ Overlap Ratio Level  
│  │ │  ├ Sorting  
│  │ │  └ Sorting Order  

 │  │ └ Base Checker Parameter No.2  
 │  │  └ (Registrable items are the 

same as No.0.) 
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INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │ 
 │ 

 ├ 
│ 

（Pos/Rot Adjustment : For Flaw Detection
（2 checkers）） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting  
 │  │ │ │ └ Area    
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ ├ Search Method   
 │  │ │ │ ├ Detect Mode   
 │  │ │ │ ├ Num. of Cells for Calc. Range 
 │  │ │ │ ├ Num. of Cells per Shift  
 │  │ │ │ ├ Threshold   
 │  │ │ │ ├ Min. Flaw Size in Cells  
 │  │ │ │ └ Direction   
 │  │ │ └ Threshold Adj.    
 │  │ └ Base Checker Parameter No.2  
 │  │  └ (Registrable items are the 

same as No.0.) 
 

           

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │ 
 │ 

 ├ 
│ 

（Rotation Adjustment: For Binary Edge 
Hor.） 

 │ 
 │ 

 │ 
│ 

（Rotation Adjustment : For Binary Edge 
Ver.） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ ├ Detect Center of Base 0, 1  
 │  │ │ ├ Detect Center of Base 2, 3  
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting   
 │  │ │ │ └ Area    
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ │ ├ Slice Level   
 │  │ │ │ ├ Edge Condition   
 │  │ │ │ └ Filter    
 │  │ │ └ Search Method    
 │  │ │  ├ Filter    
 │  │ │  └ Width    
 │  │ ├ Base Checker Parameter No.1  
│ 

 │ 
 │ 

│ 
│ 
│ 

└ (Registrable items are the same as 
No.0.) 

 │  │ │   :      
 │  │ └ Base Checker Parameter No.3  
 │  │  └ (Registrable items are the same as 

No.0.) 
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INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
│ 
│ 

 ├ 
│ 

（Rotation Adjustment: : For Gray Edge 
Hor.） 

 │ 
 │ 

 │ 
│ 

（Rotation Adjustment: : For Gray Edge 
Ver.） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ ├ Detect Center of Base 0, 1  
 │  │ │ ├ Detect Center of Base 2, 3  
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting   
 │  │ │ │ └ Area    
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ │ ├ Scan Method   
 │  │ │ │ ├ Edge Condition   
 │  │ │ │ ├ Edge Threshold   
 │  │ │ │ └ Detect Position   
 │  │ │ └ Search Method    
 │  │ │  ├ Scan Pitch    
 │  │ │  ├ Filter    
 │  │ │  ├ Width    
 │  │ │  └ Average Range   
 │  │ ├ Base Checker Parameter No.1  
 │ 
 │ 

 │ 
│ 

│ 
│ 
└ (Registrable items are the same as 

No.0.) 
 │  │ │   :      
 │  │ └ Base Checker Parameter No.3  
 │  │  └ (Registrable items are the same as 

No.0.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
│ 
│ 

 ├ 
│ 

（Rotation Adjustment: For Smart Edge 
(Line) Hor.） 

 │ 
 │ 

 │ 
│ 

（Rotation Adjustment: For Smart Edge 
(Line) Ver.） 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ └ Base Checker Parameter No.0  
 │  │  ├ Area Setting    
 │  │  │ ├ Select Color Image   
 │  │  │ ├ Color Image Setting  
 │  │  │ └ Area    
 │  │  ├ Approx. Line Detect Cond. 
 │  │  │ ├ Grayscale Preprocess  
 │  │  │ ├ Detection Method   
 │  │  │ ├ Edge ratio used(%)   
 │  │  │ └ Execution Mode   
 │  │  └ Edge Detect Condition  
 │  │   ├ Scan Direction 0   
 │  │   ├ Scan Method 0   
 │  │   ├ Edge Condition 0   
 │  │   ├ Edge Threshold 0   
 │  │   ├ Detect Position 0   
 │  │   ├ Filter 0    
 │  │   ├ Width 0    
 │  │   └ Average Range 0   
 │  │         
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INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │ 
 │ 

 ├ 
│ 

（Rotation Adjustment : For Flaw 
Detection (Ellipse) 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting  
 │  │ │ │ └ Area    
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ ├ Search Method   
 │  │ │ │ ├ Detect Mode   
 │  │ │ │ ├ Num. of Cells for Calc. Range 
 │  │ │ │ ├ Num. of Cells per Shift  
 │  │ │ │ ├ Threshold   
 │  │ │ │ ├ Min. Flaw Size in Cells  
 │  │ │ │ └ Direction   
 │  │ │ └ Threshold Adj.    
 │  │    
│ 
│ 

 │ 
│ 

 └ (Registrable items are the 
same as No.0.) 

 

 │  │         

 
INSPECTION      
 ├ Position Adj.      
 │ └ Specify No.      
 │ 
 │ 

 ├ 
│ 

(Rotation Adjustment: For Circle/Feature 
Rotation) 

 │  │ ├ Checker Settings    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Position Adjustment   
 │  │ │ └ Base Setting    
 │  │ ├ Base Position    
 │  │ ├ Base Checker Parameter No.0  
 │  │ │ ├ Area Setting    
 │  │ │ │ ├ Select Color Image   
 │  │ │ │ ├ Color Image Setting  
 │  │ │ │ └ Area    
 │  │ │ ├ Inspection Condition   
 │  │ │ │ ├ Grayscale Preprocess  
 │  │ │ │ ├ Detect Mode   
 │  │ │ │ ├ Scan Direction 
 │  │ │ │ ├ Scan Method  
 │  │ │ │ ├ Edge Condition  
 │  │ │ │ ├ Edge Threshold  
 │  │ │ │ ├ Out of max. range  
 │  │ │ │ └ Out of min. range  
 │  │ │ └ Search Method    
 │  │ │  ├ Scan Pitch    

 │  │ │  ├ Filter    
 │  │ │  ├ Width    
 │  │ │  └ Average Range   

 

 
INSPECTION      
 ├ Area Size Adj.      
 │ └ Specify No.      
 │  ├ （For Binary Edge） 
 │  │ ├ Area Setting     
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Select Color Image   
 │  │ │ ├ Color Image Setting   
 │  │ │ ├ Position Adj.    
 │  │ │ └ Area    
 │  │ ├ Inspection Condition   
 │  │ │ ├ Grayscale Preprocess   
 │  │ │ ├ Slice Level    
 │  │ │ ├ Scan Direction    
 │  │ │ ├ Edge Condition    
 │  │ │ └ Filter    
 │  │ └ Search Method    
 │  │  ├ Filter     
 │  │  └ Width     
 │  │         
 │  ├ （For Gray Edge） 
 │  │ ├ Area Setting     
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Select Color Image   
 │  │ │ ├ Color Image Setting   
 │  │ │ ├ Position Adj.    
 │  │ │ └ Area    
 │  │ ├ Inspection Condition   
 │  │ │ ├ Grayscale Preprocess   
 │  │ │ ├ Scan Direction    
 │  │ │ ├ Scan Method    
 │  │ │ ├ Edge Condition    
 │  │ │ ├ Edge Threshold    
 │  │ │ └ Detect Position    
 │  │ └ Search Method    
 │  │  ├ Scan Pitch    
 │  │  ├ Filter     
 │  │  ├ Width     
 │  │  └ Average Range    
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INSPECTION      
 ├ Area Size Adj.      
 │ └ Specify No.      
 │  ├ （For Feature Extraction） 
 │  │ ├ Area Setting     
 │  │ │ ├ Comment    
 │  │ │ ├ Camera    
 │  │ │ ├ Select Color Image   
 │  │ │ ├ Color Image Setting   
 │  │ │ ├ Position Adj.    
 │  │ │ └ Area    
 │  │ ├ Inspection Condition   
 │  │ │ ├ Grayscale Preprocess   
 │  │ │ ├ Slice Level    
 │  │ │ ├ Target    
 │  │ │ ├ Filter    
 │  │ │ ├ Output : Objects 1 - x   
 │  │ │ ├ Sorting    
 │  │ │ └ Sorting Order    
 │  │ ├ Search Method    
 │  │ │ ├ Labeling    
 │  │ │ ├ Boundary    
 │  │ │ ├ Proj. Width, Height   
 │  │ │ ├ Fill Holes    
│  │ │ └ Drawing Pattern of Result  

 │  │ └ Extraction Condition   
 │  │  ├ Max. Object Area   
 │  │  ├ Min. Object Area   
 │  │  ├ Max. Proj. Width   
 │  │  ├ Min. Proj. Width    
 │  │  ├ Max. Proj. Height   
 │  │  └ Min. Proj. Height   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
INSPECTION      
 ├ Area Size Adj.      
 │ └ Specify No.      
 │  ├ （For Matching） 
 │  │ ├ Area Setting     
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Select Color Image   
 │  │ │ ├ Color Image Setting   
 │  │ │ ├ Position Adj.    
 │  │ │ ├ Template    
 │  │ │ └ Search Area    
 │  │ ├ Inspection Condition   
 │  │ │ ├ Grayscale Preprocess   
 │  │ │ ├ Target    
 │  │ │ ├ Filter Adjustment   
 │  │ │ ├ Detect B/W Reversed Template 
 │  │ │ ├ Rotation Range (+/-)   
 │  │ │ ├ Angle - Step    
 │  │ │ ├ Angle - Accuracy   
 │  │ │ ├ Sorting    
 │  │ │ ├ Sorting Order    
 │  │ │ ├ Template Rotated by 180d  
 │  │ │ ├ Ignore Dark Image   
 │  │ │ └ Threshold to Ignore Dark Image 
 │  │ └ Sequence     
 │  │  ├ Sequence Setting Table  
 │  │  └ Square Correlation   
 │  │         
 │  ├ （For Contour Matching） 
 │  │ ├ Area Setting     
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Select Color Image   
 │  │ │ ├ Color Image Setting   
 │  │ │ ├ Position Adj.    
 │  │ │ ├ Template    
 │  │ │ └ Search Area    
 │  │ ├ Inspection Condition   
 │  │ │ ├ Grayscale Preprocess   
 │  │ │ ├ Out-Point Limit    
 │  │ │ ├ Shape     
 │  │ │ ├ Detect B/W Changed Image  
 │  │ │ ├ Max. No. of results  
 │  │ │ ├ Rotation Range (+/-)   
 │  │ │ ├ Magnification Range (+/-%)  
 │  │ │ └ Min. Corr.    
 │  │ └ Sequence     
 │  │  ├ Accuracy     
 │  │  ├ Speed     
│  │  ├ Overlap Ratio Level   
│  │  ├ Sorting   
│  │  └ Sorting Order   
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INSPECTION      
 ├ Area Size Adj.      
 │ └ Specify No.      
 │  └ （For Smart Edge (Line)） 
 │   ├ Area Setting     
 │   │ ├ Comment    
 │   │ ├ Camera     
 │   │ ├ Select Color Image   
 │   │ ├ Color Image Setting   
 │   │ ├ Position Adj.    
 │   │ └ Area    
 │   ├ Approx. Line Detect Cond. 
 │   │ ├ Grayscale Preprocess   
 │   │ ├ Detection Method   
 │   │ ├ Edge ratio used(%)   
 │   │ └ Execution Mode    
 │   └ Edge Detect Condition   
 │    ├ Scan Direction 0   
 │    ├ Scan Method 0    
 │    ├ Edge Condition 0   
 │    ├ Edge Threshold 0   
 │    ├ Detect Position 0   
 │    ├ Filter0     
 │    ├ Width 0     
 │    └ Average Range 0   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
INSPECTION      
 ├ Area Size Adj.      
 │ └ Specify No.      
 │  ├ (For Auto Area Setting) 
 │  │ ├ Area Setting    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera    
 │  │ │ ├ Select Color Image   
 │  │ │ ├ Color Image Setting   
 │  │ │ ├ Position Adj.    
 │  │ │ └ Area    
 │  │ ├ Inspection Condition   
 │  │ │ ├ Grayscale Preprocess   
 │  │ │ ├ Slice Level    
 │  │ │ ├ Target    
 │  │ │ ├ Filter    
 │  │ │ ├ Output : Objects 1 - x   
 │  │ │ ├ Sorting    
 │  │ │ └ Sorting Order    
 │  │ ├ Search Method    
 │  │ │ ├ Labeling   
 │  │ │ ├ Boundary   
 │  │ │ ├ Proj. Width, Height   
 │  │ │ ├ Fill Holes   
 │  │ │ ├ Drawing Pattern of Result  
 │  │ │ ├ Area Offset Unit   
 │  │ │ └ Offset   
 │  │ └ Extraction Condition   
 │  │  ├ Max. Object Area   
 │  │  ├ Min. Object Area   
 │  │  ├ Max. Proj. Width   
 │  │  ├ Min. Proj. Width   
 │  │  ├ Max. Proj. Height   
 │  │  └ Min. Proj. Height   
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INSPECTION      
 ├ Checker       
 │ ├ Line      
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Area Setting    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Slice Level    
 │ │  │ ├ Count Pixel Color   
 │ │  │ ├ Count Object Color   
 │ │  │ ├ Min. Object Size   
 │ │  │ ├ Min. Gap Size   
 │ │  │ └ Filter    
 │ │  └ Judgement Limits    
 │ │   ├ Max. No. of Pixels   
 │ │   ├ Min. No. of Pixels   
 │ │   ├ Max. No. of Objects   
 │ │   └ Min. No. of Objects   
 │ │          
 │ ├ Binary Window     
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Auto Area Setting   
 │ │  │ ├ Auto Mask Area Setting  
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Slice Level    
 │ │  │ ├ Target    
 │ │  │ └ Filter    
 │ │  └ Judgement Limits    
 │ │   ├ OK Judge. Max.   
 │ │   └ OK Judge. Min.   

 

 

 

 

 

 

 

 

 

 
INSPECTION      
 ├ Checker       
 │ ├ Gray Window     
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Auto Area Setting   
 │ │  │ ├ Auto Mask Area Setting  
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Inspection Condition   
 │ │  └ Judgement Limits    
 │ │   ├ OK Judge. Max.   
 │ │   └ OK Judge. Min.   
 │ │          
 │ ├ Binary Edge     
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Slice Level    
 │ │  │ ├ Scan Direction    
 │ │  │ ├ Edge Condition    
 │ │  │ ├ Detect Position    
 │ │  │ └ Filter    
 │ │  ├ Search Method    
 │ │  │ ├ Filter     
 │ │  │ └ Width     
 │ │  │        
 │ │  └ Judgement Limits    
 │ │   ├ OK Judge. Max.   
 │ │   └ OK Judge. Min.   
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INSPECTION      
 ├ Checker       
 │ ├ Gray Edge     
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Scan Direction    
 │ │  │ ├ Scan Method    
 │ │  │ ├ Edge Condition    
 │ │  │ ├ Edge Threshold    
 │ │  │ └ Detect Position    
 │ │  ├ Search Method    
 │ │  │ ├ Scan Pitch    
 │ │  │ ├ Filter     
 │ │  │ ├ Width     
 │ │  │ └ Average Range    
 │ │  └ Judgement Limits    
 │ │   ├ OK Judge. Max.   
 │ │   └ OK Judge. Min.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

INSPECTION      
 ├ Checker       
 │ ├ Feature Extraction     
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Auto Area Setting   
 │ │  │ ├ Auto Mask Area Setting  
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Slice Level    
 │ │  │ ├ Target    
 │ │  │ ├ Filter    
 │ │  │ ├ Output : Objects 1 - x   
 │ │  │ ├ Sorting    
 │ │  │ └ Sorting Order    
 │ │  ├ Search Method    
 │ │  │ ├ Labeling    
 │ │  │ ├ Boundary    
 │ │  │ ├ Perimeter     
 │ │  │ ├ Proj. Width, Height   
 │ │  │ ├ Principal Axis Angle   
 │ │  │ ├ Fill Holes    
│ │  │ └ Drawing Pattern of Result  

 │ │  ├ Extraction Condition   
 │ │  │ ├ Max. Object Area   
 │ │  │ ├ Min. Object Area   
 │ │  │ ├ Max. Proj. Width    
 │ │  │ ├ Min. Proj. Width    
 │ │  │ ├ Max. Proj. Height   
 │ │  │ └ Min. Proj. Height    
 │ │  └ Judgement Limits    
 │ │   ├ OK Judge. Max.   
 │ │   └ OK Judge. Min.   
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INSPECTION      
 ├ Checker       
 │ ├ Smart Matching     
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Template    
 │ │  │ └ Search Area    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Detect Mode    
 │ │  │ ├ Filter Adjustment   
 │ │  │ ├ Detect B/W Reversed Template 
 │ │  │ ├ Rotation Range (+/-)   
 │ │  │ ├ Angle - Step    
 │ │  │ ├ Angle - Accuracy   
 │ │  │ ├ Sorting    
 │ │  │ ├ Sorting Order    
 │ │  │ ├ Template Rotated by 180d  
 │ │  │ ├ Ignore Dark Image   
 │ │  │ └ Threshold to Ignore Dark Image 
 │ │  ├ Sequence     
 │ │  │ ├ Sequence Setting Table  
 │ │  │ └ Square Correlation   
 │ │  └ Subtraction     
 │ │   ├ Subtraction    
 │ │   ├ Min. Subtracted Size   
 │ │   ├ Subtraction Threshold   
 │ │   ├ Filter    
 │ │   └ Max. OK No. of Subtracted Objects 

 



 
 

539 

C
h. 9 

S
elect M

enu (C
reating C

ustom
ized M

enu) 

 
INSPECTION      
 ├ Checker       
 │ ├ Contour Matching     
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Template    
 │ │  │ └ Search Area    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Out-Point Limit    
 │ │  │ ├ Shape     
 │ │  │ ├ Max. No. of results   
 │ │  │ ├ Detect B/W Changed Image  
 │ │  │ ├ Rotation Range (+/-)   
 │ │  │ ├ Magnification Range (+/-%)  
 │ │  │ └ Min. Corr.    
 │ │  └ Execution Condition   
 │ │   ├ Accuracy     
 │ │   ├ Speed     
│ │   ├ Overlap Ratio Level   
│ │   ├ Sorting   
│ │   └ Sorting Order   

 │ │          
 │ ├ Flaw Detection     
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ └ Scan Direction    
 │ │  ├ Search Method    
 │ │  │ ├ Detect Mode    
 │ │  │ ├ Num. of Cells for Calc. Range   
 │ │  │ ├ Num. of Cells per Shift   
 │ │  │ ├ Threshold    
 │ │  │ └ Min. Flaw Size in Cells   
 │ │  │ └ Direction    
 │ │  ├ Threshold Adj.   
 │ │  └ Judgement Limits    
 │ │   ├ OK Judge. Max.   
 │ │   └ OK Judge. Min.   

 

 

 

 

 
INSPECTION      
 ├ Checker       
 │ ├ Connector-Binary Window   
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Slice Level    
 │ │  │ ├ Detect Mode    
 │ │  │ └ Filter    
 │ │  ├ Judgement Limits    
 │ │  │ ├ Set Individually    
 │ │  │ ├ Max./Min. Values Setting Table 
 │ │  │ ├ Common Judgement Max.  
 │ │  │ ├ Common Judgement Min.  
 │ │  │ ├ Individual Judgement Max.  
│ 
│ 

│ 
│ 

 │ 
│ 

│ 
│ 

└ Specify Individual Judgement 
Max. No. 

 │ │  │ └ Individual Judgement Min.  
│ 
│ 

│ 
│ 

 │ 
│ 

 └ Specify Individual Judgement 
Min. No. 

 │ │  ├ Num. Calcu.     
 │ │  └ Data R/W     
 │ │          
 │ ├ Connector-Gray Window   
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Inspection Condition   
 │ │  ├ Judgement Limits    
 │ │  │ ├ Set Individually    
 │ │  │ ├ Max./Min. Values Setting Table 
 │ │  │ ├ Common Judgement Max.  
 │ │  │ ├ Common Judgement Min.  
 │ │  │ ├ Individual Judgement Max.  
│ 
│ 

│ 
│ 

 │ 
│ 

│ 
│ 

└ Specify Individual Judgement 
Max. No. 

 │ │  │ └ Individual Judgement Min.  
│ 
│ 

│ 
│ 

 │ 
│ 

 └ Specify Individual Judgement 
Min. No. 

 │ │  ├ Num. Calcu.     
 │ │  └ Data R/W     
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INSPECTION      
 ├ Checker       
 │ ├ Connector-Gray Edge   
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ └ Area    
 │ │  ├ Inspection Condition   
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Execution Mode    
 │ │  │ ├ Detect Direction    
 │ │  │ ├ Checker Direction   
 │ │  │ ├ Scan Method    
 │ │  │ ├ Edge Condition 0   
 │ │  │ ├ Edge Condition 1   
 │ │  │ └ Detect Position    
 │ │  ├ Search Method    
 │ │  │ ├ Scan Pitch    
 │ │  │ ├ Filter     
 │ │  │ ├ Width     
 │ │  │ └ Average Range    
 │ │  ├ Threshold Adj.    
 │ │  │ ├ Set Individually    
 │ │  │ ├ Threshold Setting Table  
 │ │  │ ├ Global Threshold 0   
 │ │  │ ├ Global Threshold 1   
 │ │  │ ├ Independent Threshold 0  
│ 
│ 

│ 
│ 

 │ 
│ 

│ 
│ 

└ Specify Independent Threshold 
0 No. 

│ │  │ └ Independent Threshold 1  
│ 
│ 

│ 
│ 

 │ 
│ 

 └ Specify Independent Threshold 1 
No. 

 │ │  ├ Judgement Limits    
 │ │  │ ├ Max. Judge. Pitch   
 │ │  │ ├ Min. Judge. Pitch   
 │ │  │ ├ Max. Distance Diff.   
 │ │  │ └ Min. Distance Diff.   
 │ │  ├ Num. Calcu.     
 │ │  └ Data R/W     

 

 

 

 

 

 

 

 

 

 

 

 

 
INSPECTION      
 ├ Checker       
 │ ├ Smart Edge (Circle)    
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Virtual Circle Detect Condi.  
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Detect Mode    
 │ │  │ ├ Detection Method   
 │ │  │ ├ Edge ratio used(%)   
 │ │  │ ├ Execution Mode    
 │ │  │ ├ Base Angle    
 │ │  │ └ Result No. Assignment   
 │ │  ├ Edge Detect Condition   
 │ │  │ ├ Scan Direction 0   
 │ │  │ ├ Scan Method 0    
 │ │  │ ├ Edge Condition 0   
 │ │  │ ├ Edge Threshold 0   
 │ │  │ ├ Detect Position 0   
 │ │  │ ├ Filter0     
 │ │  │ ├ Width 0     
 │ │  │ ├ Average Range 0   
 │ │  │ ├ Scan Direction 1   
 │ │  │ ├ Scan Method 1    
 │ │  │ ├ Edge Condition 1   
 │ │  │ ├ Edge Threshold 1   
 │ │  │ ├ Detect Position 1   
 │ │  │ ├ Filter1     
 │ │  │ ├ Width 1     
 │ │  │ └ Average Range 1   
 │ │  └ Judgement Limits    
 │ │   ├ Denoising Setting Table  
 │ │   ├ Denoising 0    
 │ │   ├ Denoising Range 0   
 │ │   ├ Denoising 1    
 │ │   ├ Denoising Range 1   
 │ │   ├ Judgement Limits Setting Table 
 │ │   ├ Measurement: Max. Value  
 │ │   ├ Measurement: Min. Value  
 │ │   ├ Max. Standard Deviation  
 │ │   ├ Min. Standard Deviation  
 │ │   ├ Max. Circularity    
 │ │   ├ Min. Circularity    
 │ │   └ Max. Unused Edge Cnt.  
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INSPECTION      
 ├ Checker       
 │ ├ Smart Edge (Line)     
 │ │ └ Specify No.      
 │ │  ├ Area Setting     
 │ │  │ ├ Comment    
 │ │  │ ├ Camera     
 │ │  │ ├ Select Color Image   
 │ │  │ ├ Color Image Setting   
 │ │  │ ├ Position Adj.    
 │ │  │ ├ Area    
 │ │  │ └ Area Size Adj.    
 │ │  ├ Approx. Line Detect Cond.  
 │ │  │ ├ Grayscale Preprocess   
 │ │  │ ├ Detect Mode    
 │ │  │ ├ Detection Method   
 │ │  │ ├ Edge ratio used(%)   
 │ │  │ ├ Execution Mode    
 │ │  │ ├ Base Angle    
 │ │  │ └ Result No. Assignment   
 │ │  ├ Edge Detect Condition   
 │ │  │ ├ Scan Direction 0   
 │ │  │ ├ Scan Method 0    
 │ │  │ ├ Edge Condition 0   
 │ │  │ ├ Edge Threshold 0   
 │ │  │ ├ Detect Position 0   
 │ │  │ ├ Filter0     
 │ │  │ ├ Width 0     
 │ │  │ ├ Average Range 0   
 │ │  │ ├ Scan Direction 1   
 │ │  │ ├ Scan Method 1    
 │ │  │ ├ Edge Condition 1   
 │ │  │ ├ Edge Threshold 1   
 │ │  │ ├ Detect Position 1   
 │ │  │ ├ Filter1     
 │ │  │ ├ Width 1     
 │ │  │ └ Average Range 1   
 │ │  └ Judgement Limits    
 │ │   ├ Denoising Setting Table  
 │ │   ├ Denoising 0    
 │ │   ├ Denoising Range 0   
 │ │   ├ Denoising 1    
 │ │   ├ Denoising Range 1   
 │ │   ├ Judgement Limits Setting Table 
 │ │   ├ Measurement: Max. Value  
 │ │   ├ Measurement: Min. Value  
 │ │   ├ Max. Standard Deviation  
 │ │   ├ Min. Standard Deviation  
 │ │   ├ Max. Linearity    
 │ │   ├ Min. Linearity    
 │ │   └ Max. Unused Edge Cnt.  
           
           

 

 

 

 

 
INSPECTION      
 ├ Checker       
 │ └ Color Window     
 │  └ Specify No.      
 │   ├ Area Setting     
 │   │ ├ Comment    
 │   │ ├ Camera     
 │   │ ├ Position Adj.    
 │   │ ├ Auto Area Setting   
 │   │ ├ Auto Mask Area Setting  
 │   │ ├ Area Setting    
 │   │ └ Area Size Adj.    
 │   └ Judgement Limits    
 │    ├ R Gray Max.    
 │    ├ R Gray Min.    
 │    ├ R Gray Ave. Max.   
 │    ├ R Gray Ave. Min.   
 │    ├ R Gray Std. Devi. Max.  
 │    │ R Gray Std. Devi. Min.  
 │    ├ G Gray Max.    
 │    ├ G Gray Min.    
 │    ├ G Gray Ave. Max.   
 │    ├ G Gray Ave. Min.   
 │    ├ G Gray Std. Devi. Max.  
 │    ├ G Gray Std. Devi. Min.  
 │    ├ B Gray Max.    
 │    ├ B Gray Min.    
 │    ├ B Gray Ave. Max.   
 │    ├ B Gray Ave. Min.   
 │    ├ B Gray Std. Devi. Max.  
 │    └ B Gray Std. Devi. Min.  
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INSPECTION      
 ├ Geometry Calc.      
 │ └ Specify No.      
 │  ├ （For Distance Point – Point）  
 │  │ ├ Attribute Setting    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Line Display    
 │  │ │ ├ Angle Range    
 │  │ │ └ Direction     
 │  │ ├ References     
 │  │ └ Judgement Limits    
 │  │  ├ Max. X Judge.    
 │  │  ├ Min. X Judge.    
 │  │  ├ Max. Y Judge.    
 │  │  ├ Min. Y Judge.    
 │  │  ├ Max. Angle Judge.   
 │  │  ├ Min. Angle Judge.   
 │  │  ├ Max. Distance Judge.   
 │  │  └ Min. Distance Judge.   
 │  │         
 │  ├ （For Intersecting Point）  
 │  │ ├ Attribute Setting    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ └ Intersect. Angle    
 │  │ ├ References     
 │  │ └ Judgement Limits    
 │  │  ├ Max. X Judge.    
 │  │  ├ Min. X Judge.    
 │  │  ├ Max. Y Judge.    
 │  │  ├ Min. Y Judge.    
 │  │  ├ Max. Intersecting Angle Judge. 
 │  │  └ Min. Intersecting Angle Judge. 
 │  │         
 │  ├ （For Median of Two Lines）  
 │  │ ├ Attribute Setting    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Angle Range    
 │  │ │ ├ Direction     
 │  │ │ └ Intersect. Angle    
 │  │ ├ References     
 │  │ └ Judgement Limits    
 │  │  ├ Max. Angle Judge.   
 │  │  ├ Min. Angle Judge.   
 │  │  ├ Max. Intersecting Angle Judge. 
 │  │  └ Min. Intersecting Angle Judge. 

 

 

 

 

 

 

 

 

 
INSPECTION      
 ├ Geometry Calc.      
 │  ├ （For Distance Point – Line）  
 │  │ ├ Attribute Setting    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Line Display    
 │  │ │ ├ Angle Range    
 │  │ │ └ Direction     
 │  │ ├ References     
 │  │ └ Judgement Limits    
 │  │  ├ Max. X Judge.    
 │  │  ├ Min. X Judge.    
 │  │  ├ Max. Y Judge.    
 │  │  ├ Min. Y Judge.    
 │  │  ├ Max. Angle Judge.   
 │  │  ├ Min. Angle Judge.   
 │  │  ├ Max. Distance Judge.   
 │  │  └ Min. Distance Judge.   
 │  │         
 │  ├ （For Approximate Line）  
 │  │ ├ Attribute Setting    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Angle Range    
 │  │ │ └ Direction     
 │  │ ├ References     
 │  │ └ Judgement Limits    
 │  │  ├ Max. Standard Devi. Judge.  
 │  │  ├ Min. Standard Devi. Judge.  
 │  │  ├ Max. Angle Judge.   
 │  │  └ Min. Angle Judge.   
 │  │         
 │  ├ （For Approximate Circle）  
 │  │ ├ Attribute Setting    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ ├ References     
 │  │ └ Judgement Limits    
 │  │  ├ Max. X Judge.    
 │  │  ├ Min. X Judge.    
 │  │  ├ Max. Y Judge.    
 │  │  ├ Min. Y Judge.    
 │  │  ├ Max. Standard Devi. Judge.  
 │  │  ├ Min. Standard Devi. Judge.  
 │  │  ├ Max. Radius Judge.   
 │  │  └ Min. Radius Judge.   
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INSPECTION      
 ├ Geometry Calc.      
 │  ├ （For Approximate Ellipse）  
 │  │ ├ Attribute Setting    
 │  │ │ ├ Comment    
 │  │ │ ├ Camera     
 │  │ │ ├ Angle Range    
 │  │ │ └ Direction     
 │  │ ├ References     
 │  │ └ Judgement Limits    
 │  │  ├ Max. X Judge.    
 │  │  ├ Min. X Judge.    
 │  │  ├ Max. Y Judge.    
 │  │  ├ Min. Y Judge.    
 │  │  ├ Max. Standard Devi. Judge.  
 │  │  ├ Min. Standard Devi. Judge.  
 │  │  ├ Max. Angle Judge.   
 │  │  ├ Min. Angle Judge.   
 │  │  ├ Max. Major Axis Judge.   
 │  │  ├ Min. Major Axis Judge.   
 │  │  ├ Max. Minor Axis Judge.   
 │  │  └ Min. Minor Axis Judge.   
 │  │         
 │  └ (For Circle - Line)   
 │   ├ Attribute Setting     
 │   │ ├ Comment     
 │   │ ├ Camera      
 │   │ ├ Line Mode      
 │   │ ├ Angle Range     
 │   │ └ Direction      
 │   ├ References      
 │   └ Judgement Limits     
 │    ├ Max. Angle Judge.    
 │    ├ Min. Angle Judge.    
 │    └ Max. Distance Judge    
 │           
 ├ Preprocess       
 │ ├ Grayscale Conv.     
 │ │ └ Specify Camera No.     
 │ │  ├ Group A     
 │ │  ├  :       
 │ │  ├  :       
 │ │  └ Group P     
 │ │          
 │ ├ Color Extraction     
 │ │ └ Specify Camera No.     
 │ │  └ Set Individually    
 ｜  │   └ Specify Individual Setting No.   
 ｜ │          
 ｜ └ Grayscale Preprocess    
 │  └ Specify Camera No.     
 │   ├ Group A     
 ｜   │ └ Specify Step No.    
 │   │  :       
 │   └ Group P     
 ｜    └ Specify Step No.    
           

 
INSPECTION       
 ├ Slice Level       
 ｜ └ Specify Camera No.     
 ｜  ├ Group A      
 ｜  ├  :        
 ｜  └ Group P      
 ｜           
 ├ Num. Calcu.       
 ｜ └ Specify No.     
 ｜  ├ Comment     
 ｜  ├ Maximum     
 ｜  ├ Minimum     
 ｜  └ Output     
 ｜           
 ├ Judgement       
 ｜ ├ JRC :Judgement(Internal)   
 ｜ ｜ └ Specify No.     
 ｜ ├ JDC :Judgement(External)   
 ｜ ｜ └ Specify No.     
 ｜ ├ Judgement : Condition   
 ｜ └ Judgement : Branch condition   
 ｜           
 ├ Draw Char/Fig.      
 ｜ └ Specify No.     
 ｜           
 ├ Checker List      
 ｜           
 └ Group Move      

 

 
SAVE/READ      
 ├ Save Setting Data     
 │ ├ Storage Space in PV200    
 │ └ SD Card      
 ｜           
 ├ Read Setting Data     
 │ ├ Storage Space in PV200    
 │ └ SD Card      
 ｜           
 ├ Save Image Memory     
 ｜           
 └ Clear Image Memory     
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TOOL      
 ├ PC Communi.       
 ｜           
 ├ General       
 ｜ ├ Startup Setting     
 ｜ ├ Network     
 ｜ ├ Calendar     
 │ ├ Language      
  Account Setting      
 │ └ Initialize      
 ｜           
 ├ SD Property      
 ｜           
 ├ Eject SD Card      
 ｜           
 ├ Information       
 ｜           
 ├ Setting Help      
 │ ├ Focus Adjustment     
 │ ├ Aperture Adjustment     
 ｜ ├ Gray Data Analysis     
 ｜ ├ Capture Delay Control     
 ｜ ├ I/O Test     
 │ └ Communication Test     
 ｜           
 └ Update      
  ├ Firmware     
  └ Splash Screen     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Image Menu      
 ├ Select Camera      
 │ ├ Camera No.0     
 │ └ Camera No.1     
 ｜           
 ├ Switch Disp.      
 ｜           
 ├ Pattern Display      
 ｜           
 ├ Scroll       
 ｜           
 ├ Magnification       
 ｜           
 ├ Full Screen       
 ｜           
 ├ Save Image       
 ｜           
 ├ Read Image       
 │ ├ Image Memory     
 │ ├ Test Image in SD    
 │ ├ Image Memory in SD    
 │ ├ Output image in SD    
 │ └ Select Folder    
 ｜           
｜ Print Screen View    
 └ Window Transparency    
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10.1 Main Items that can be Communicated through I/O Interface 

PV200 is provided with I/O interface as below. 
 Input: 14 pins 

 Output: 15 pins 

 

Input 
The operations shown in the table below can be executed by input from the external devices. 
  Terminal Block  Command*3 
Execute inspection  STRT  %S 

Execute reinspection  (ASN, EXT)*1  %R 

Execute type switch  (ASN, EXT)+IN0-7*1  %X 

Set a template for Smart Matching   (ASN, EXT)+IN0-7*1  %A 

Set a template for Contour Matching  (ASN, EXT)+IN0-7*1  %B 

Switch layout  (ASN, EXT)+IN0-3*1  %I 

Switch between RUN/STOP  (ASN, EXT)*1  %RM 

Reset statistics data  (ASN, EXT)*1  %Q 

Reset error signal  (ASN, EXT)*1  %E 

Save setting data Storage Space in PV200  (ASN, EXT)*1  %MW 

SD memory card  (ASN, EXT)+IN0-6*1  %CW 

Read setting data Storage Space in PV200  (ASN, EXT)*1  %MR 

SD memory card  (ASN, EXT)+IN0-6*1  %CR 

Abort Save/read Setting Data  (ASN, EXT)*1  %CD 

Operate image 
memory of PV 

Save in a SD memory card 
(backup) 

 (ASN, EXT)*1  
%SS 

Delete  (ASN, EXT)*1  %SR 

Print screen  (ASN, EXT)*1  %PS 

Save the latest inspection image in a SD memory card 
or PC etc. through Ethernet 

 (ASN, EXT)*1  
--- 

Abort inspection/process  (ASN, EXT)*1  %CC 

*1: Up to five functions are available because five points of ASN0 to 1 and EXT0 to 2 are assigned functions.  
*2: Command to control with interface of RS-232C and Ethernet. Refer to page 598 for details. 

Output 
 Terminal Block 
Scan Count OUT0-7 
Judgement (JDC) OUT0-7 
Numerical calculation result OUT0-7 

 To set whether to output or not, select “ENVIRONMENT” >  “Input/Output” > “Parallel I/O Output”. 
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10.2 Specification of I/O Interface 

10.2.1 I/O Connector 

Pin Arrangement 

Input 

 
 

No. Signal Name Description 
1 COM EXTRA COMMON Common for Extra 
2 EXT0 EXTRA0 Function assignment 0-2 

(select from 20 functions) 3 EXT1 EXTRA1 
4 EXT2 EXTRA2 
5 COM START COMMON Common for START 
6 STRT START Execute inspection 
7 COM IN COMMON Common for Input 
8 ASN0 ASSIGN0 Function assignment 0-1 

(select from 20 functions) 9 ASN1 ASSIGN1 
10 IN0 IN0 Input data 0-7 
11 IN1 IN1 
12 IN2 IN2 
13 IN3 IN3 
14 IN4 IN4 
15 IN5 IN5 
16 IN6 IN6 
17 IN7 IN7 
18 24V+  24V power input 
19 0V  
20 F.G.  
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Output 

 
 
No. Signal Name Description 
1 GND (SG) SG RS232C 
2 RD RD (Rxd) 
3 SD SD (Txd) 
4 COM OUT COMMON Common for output 
5 STRB STROB Data output complete 
6 REND REND Image capture with Camera 

complete 
7 REDY READY Ready completion signal 
8 ERR ERROR Error signal 
9 TACT TACT Timing of reading inspection 

data 
10 OUT0 OUT0 Output data 0-7 
11 OUT1 OUT1 
12 OUT2 OUT2 
13 OUT3 OUT3 
14 OUT4 OUT4 
15 OUT5 OUT5 
16 OUT6 OUT6 
17 OUT7 OUT7 
18 COM FLASH COMMON Common for Flash 
19 FLA0 FLASH0 Camera 0 Flash 
20 FLA1 FLASH1 Camera 1 Flash 
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Input Circuit 
Circuit Diagram 

 
 

Connection Example 

 
 

Rated input voltage: 24 V DC 
Voltage range: 21.6 to 26.4 V DC 
Appropriate wire size: AWG#24 to 16, 0.2 to 1.5 mm2 
Uncovered wire length: 10 mm 
 

 

Output Circuit 
Circuit Diagram 

 
 

Connection Example 

 
 

Output load voltage: 5 to 24 V DC 
Output circuit: PhotoMos output 
Maximum load current: 24 mA/ terminal 
Appropriate wire size: AWG#24 to 16, 0.2 to 1.5 mm2 
Uncovered wire length: 10 mm 
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Wiring with Terminal Block 

 
Be sure to cut the power of PV200 before wiring. Wiring while the power is supplied might cause damage of 
PV200 and the connecting external device. 

About Terminal Block Socket 
Terminal block socket (included): Manufactured by PHOENIX CONTACT 

Model number: FMC1.5 / 20-ST-3.5 
or 
Manufactured by Degson Electronics Co., Ltd. 
Model number: 15EDGKN-3.5-20P-14-1100A(H) 

Applicable size of wire: AWG#24 - 16, 0.2 - 1.5 mm2 

How to Wire 

1. Remove the wire shield. 

 

 
 

 

2. Push the orange part into the 
socket with a slotted screwdriver. 

3. Insert the lead wire all the way 
into it pressing the orange part. 

4. Release the screw driver. 

The lead wire is connected. 
Connect the lead wire with the pins 
as necessary. 

5. After wiring is complete, attach it to the I/O 
terminal block. 
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10.2.2 Main Function of Signals 

Input Signal 
START (STRT): Inspection Start Signal 

This is start signal of an inspection. Inputting this signal starts capturing an image. 
 

ASSIGN0 - 1 (ASN0-1), EXTRA0 - 2 (EXT0-2) : Function Assignment 
The functions shown in the table below can be performed by a signal from the external device.  
To assign a function to ASSIGN and EXTRA signals, select “ENVIRONMENT” >  “Input/Output” > “Parallel 
I/O” in SETUP menu. 

 
Select Type: Use this signal to switch product types by a signal from the external 

device. 
Inputting the type number (0 - 255) to switch to “IN0 - 7”and inputting a 
Select Type signal executes switching types. 

Switch Layout: Use this signal to switch layouts displayed on the monitor by a signal 
from the external device in RUN menu. Setting a layout number (0 - 15) to 
IN0 - 3 and turning on the layout switching signal changes the layout. 

ACK: Use this signal with output STROB signal (which is a data output 
completion signal during handshake) when outputting result data output 
from OUT0 - 7 to the external device while performing handshake. 
During handshake, PV200 turn on STROB signal after outputting data. 
The external device receives data at rising edge of STROB ON signal. 
Turn on Reception completion signal after reception is complete. PV200 
receives the reception completion signal with ACK terminal.  

Reset Error:  Turns off ERROR. 

Reset Statistics:  Input this to clear the statistics data and scan count. 

Template Setting: Use this signal to update the template of Smart Matching checkers by 
inputting signals from the external device. 
Specifying a checker number (0 - 31) to set for "IN0 - 4" and a template 
number (0 - 7) for "IN5 - 7", and inputting the template setting signal 
executes template setting. 
 

 
When executing template setting through I/O interface, the allowable 
range of checker numbers is 0 to 31, the range of template numbers is 0 
to 7. 
When setting "Template Registration" to "Common" and using Common 
template, the procedure of template setting is the same as the above.  
However, executing template setting requires attention because the 
template image is overwritten automatically when a Smart Matching 
checker in another product type uses the same template due to common 
template for all types. The template is also used in common to Contour 
Matching. Therefore, when the same template is used in Smart Matching 
and Contour Matching checkers, the template in the Contour Matching 
checker is also changed automatically by executing the template setting 
in the Smart Matching checker. 

Contour Template Setting: 
 

Use this signal to update the template of Contour Matching checkers by 
inputting signals from the external device. 
Inputting the Contour template setting signal after setting a checker 
number (0 - 31) to reregister to "IN0 - 4" and turning off "IN5 - 7" that 
indicate a template number (template number is zero) executes Contour 
template setting. 
 

 
When executing Contour template setting through I/O interface, the 
allowable range of checker numbers is 0 to 31. 
When setting "Template Registration" to "Common" and using Common 
template, the procedure of template setting is the same as the above. 
However, executing template setting requires attention because the 
template image is overwritten automatically when a Contour Matching 
checker in another product type uses the same template due to common 
template for all types. The template is also used in common to Smart 
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Matching. Therefore, when the same template is used in Smart Matching 
and Contour Matching checkers, the template in the Smart Matching 
checker is also changed automatically by executing the template setting 
in the Contour Matching checker.  

Switch Run/Stop: Use this signal to switch between Run and Stop of PV200 by a signal 
from the external device. 
The status change of signal from OFF to ON (or rising edge of the signal) 
switches between RUN and STOP. 

Save Data in PV: All product type data currently registered in “execution memory” will be 
saved in “memory for store” of PV.  

Save Data in SD: All product type data currently registered in “execution memory” will be 
saved in a SD memory card. Input a data save signal to the SD memory 
card after specifying an area number (0 - 99) with "IN0 - IN6". 

Read Data from PV: The setting data registered in the storage space in PV200 will be called 
up to “execution memory”. 

Read Data from SD: The setting data registered in a SD memory card will be called up to 
“execution memory” of PV. Input a data read signal from the SD memory 
card after specifying an area number (0 - 99) with "IN0 - IN6". 

Reinspect: Input this to reinspect without capturing an image. Enter a block number 
(0 - 9) to execute with “IN0 - IN3”. 

Save Image Memory in SD: Backs up all images saved in the image memory to a SD memory card.  
Creates a folder named one of "00" to "99" which does not exist in  
"Panasonic-EW SUNX Vision/PV200/Image/Backup" in a SD memory 
card and saves images in the folder.  

Output Latest Image: Outputs the latest inspection image.  
The destination (SD memory card or PC connected with Ethernet cable) 
and the image file name can be set from “ENVIRONMENT” >  
"Input/Output" > "Image Output" menu. 
 

 
• In “ENVIRONMENT” >  "Input/Output" > "Image Output", set "Output 

Conditions" to "Command Reception". 
• Image Receiver needs to be activated on the destination PC when 

"Destination" is set to "Ethernet". 
• ERR signal is output if an output errror occurs when "ERR signal ON at 

Output Error" is set to “Yes” for outputting images through Ethernet 
interface. 

Clear Image Memory: All image data registered in the Storage Space in PV200 will be cleared. 
Print Screen: The currently displayed screen (entire contents the monitor displaying) 

will be captured and saved in a SD memory card or a PC through 
Ethernet. 
You can specify destination from “ENVIRONMENT” >  “Input/Output” >  
“Print Screen”. 

Abort Inspection/Process Cancels the following active operations, and restores into the previous 
status before the operation. 
• Cancellation of the operation of a serial command which has been 

received 
• Abort of output in the status waiting for result output after an inspection is 

complete 
• Abort of image saving from Image Memory to a SD memory card 
• Cancellation of template re-registration 

Abort Save/read Setting Data Cancels saving or reading the setting data. 

Read PLC Communication 
Command 
 

Reads commands through PLC communication. 
When "Command Read Type" is not set to "Parallel Input" in 
"ENVIRONMENT" > "Input/Output" > "PLC Communication", the ERR 
signal is output by the input of "Read PLC communication command" 
signal. 
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List of acceptable input signals 
The items that can be input from an external device vary depending on the used operation mode. 
Also, some items can be accepted even when READY signal is off. 

 
Yes:Acceptable 
No:Not acceptable 

OPERATION MODE RUN STOP 

READY ON OFF OFF 

Execute Inspection Yes No No 

Select Type Yes No No 

Switch Layout Yes Yes No 

Reset Error Yes Yes Yes 

Reset Statistics Yes Yes No 

Template Setting Yes No No 

Contour Template Setting Yes No No 

Switch Run/Stop Yes Yes Yes* 

Save Data in PV Yes No No 

Save Data in SD Yes No No 

Read Data from PV Yes No No 

Read Data from SD Yes No No 

Reinspect Yes No No 

Save Image Memory in SD Yes No No 

Output Latest Image Yes Yes No 

Clear Image Memory Yes Yes No 

Print Screen Yes Yes No 

Abort Inspection/Process Yes Yes Yes** 

Abort Save/read Setting Data Yes Yes No 
* Not acceptable in SETUP Menu or DEBUG Menu. 
** Not acceptable in DEBUG Menu. 

 

IN0 - 7: Input data 
These are signals to input the values for switching type, reading/saving setting data when you execute the 
functions. Specify values in binary data as follows. 

 
Example 1) Specifying No.6 IN7 IN6 IN5 IN4 IN3 IN2 IN1 IN0 

 0 0 0 0 0 1 1 0 
   

Example 2) Specifying No.237 IN7 IN6 IN5 IN4 IN3 IN2 IN1 IN0 
 1 1 1 0 1 1 0 1 
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Output Signal 
READY (REDY): Inspection start ready completion signal 

Use this as condition signal to input START signal when inspecting in “Serial” mode as inspection process 
mode. READY signal turns on when PV can receive START signal and turns off when it starts capturing an 
image. 

 
Use “REND” signal as ready completion signal to inspect in “Parallel” mode. 

 

REND: Image capture completion signal 
Use this as condition signal to input START signal when inspecting in “Parallel” mode as inspection 

process. Receiving a START signal for inspection, REND signal turns off when capturing an image and 
turns on after capturing is complete. 

 

FLASH 0 - 1: Flash synchronization signal 
The signals of FLASH0 – FLASH1 correspond to CAMERA0 – CAMERA1 respectively. 
When the specified time of FLASH delay passes after START signal turns on, FLASH signal is output in the 
specified length. Whether turning on FLASH signal or turns off at the time of output, you can select for 
every FLASH signal from ENVIRONMENT > “Camera” > “FLASH Polarity”. This setting is common to all 
product types. 

 
 

Delay time and output width of FLASH signal can be set for each product type and each FLASH signal 
from “TYPE” > “Type Setting” > “Camera” in SETUP menu. 

 

TACT (TACT): Result read timing 
The signal turns on when outputting the data using OUT 0 - 7 at the timing of output. 
It turns on when PV starts outputting a result, and turns off after set “Output signal guarantee time” passes. 
Obtain a result with the external device after more than 1 ms wait time passed after rising edge of TACT 
signal. 
When data is output in multiple times, perform handshake with STROB signal described below. 
 

 
The time from when TACT signal turns on till when the result output (OUT signal) is determined varies 
according to the condition of the connected load or ambient temperature.  

 
 To set Inspection Process, Serial or Parallel, select as follow. 

 SETUP menu > “ENVIRONMENT” > “System Settings” > "Operation" > “Inspection Process”  

 To set image capturing trigger, Common or Individual, select as follow. 
 “SETUP menu” > “TYPE” > “Type Setting” > “Camera” > “Camera Trigger” 

 To set “Output signal guarantee time”, select “ENVIRONMENT” >  “Input/Output” >  “Parallel I/O 
Output”. 

 

STROB: Read timing 
Use this signal to output result data with OUT 0 - 7 to the external device in multiple times or re-register 
templates. 
Each time result data is output, STROB signal turns on. 

 
Result read timing when Handshaking is employed: 
Use the signal with ACK signal for input (assigned to ASSIGN or EXTRA terminals) in pairs. 
PV200 turn on STROB signal after outputting data. The external device receives data at rising edge of 
STROB ON signal. Turn on Reception completion signal after reception is complete. PV200 receives the 
reception completion signal with ACK terminal (assigned to ASSIGN or EXTRA terminals). 

 
Inspection data read timing when Handshaking is not employed (When "Data Output" is "All 
Selectable"): 
Inspection data are output at intervals of set “Output signal guarantee time”. STROB signal turns on each 
time outputting the data. 
Receive data with the external device after rising edge of STROB ON signal and in the output signal 
guarantee time. 
When "Output Data" is set to "Once, Judgement(8 bit)", STROB signal does not turn on. 
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To set “Output signal guarantee time”, select “ENVIRONMENT” >  “Input/Output” > “Parallel I/O Output”. 
To set “Output Data", select “ENVIRONMENT” >  “Input/Output” > “Parallel I/O Output” > "Output Data". 

 
Re-registration area display timing when template is re-registered: 
STROB signal turns on after displaying the re-registered area in Template Setting. Input a template setting 
signal and register a template with the external device after rising edge of STROB ON signal. 

 

ERROR (ERR): Error in executing an inspection, outputting a result or command error 
 

About ERR signal 
Some functions do not output ERR signals. 
 
 Terminal 

Block 
Command Existence of ERR signal 

 
A:  ERR is available 
N/A: ERR is not available 

Execute Inspection STRT %S A 

Select Type ASN･EXT %X A 

Switch Layout ASN･EXT %I A 

Reset Error ASN･EXT %E N/A 

Reset Statistics ASN･EXT %Q N/A 

Template Setting ASN･EXT %A A 

Contour Template Setting ASN･EXT %B A 

Switch Run/Stop ASN･EXT %RM A 

Save Data in PV ASN･EXT %MW A 

Save Data in SD ASN･EXT %CW A 

Read Data from PV ASN･EXT %MR A 

Read Data from SD ASN･EXT %CR A 

Reinspect ASN･EXT %R A 

Save Image Memory in SD ASN･EXT %SS A 

Output Latest Image ASN･EXT - A 

Clear Image Memory ASN･EXT %SR N/A 

Print Screen ASN･EXT %PS A 

Abort Inspection/Process ASN･EXT %CC N/A 

Abort Save/read Setting Data ASN･EXT %CD A 

Key emulating - %K N/A 

Keypad operation (Command prohibiting 
/permitting keypad operation) 

- %BS A 

Keypad operation (Command checking the 
status of keypad operation) 

- %BC N/A 

Parameter (Read) - %PR A 

Parameter (Read pairs) - %PRP A 

Parameter (Change) - %PW A 

Parameter (Change pairs) - %PWP A 
 
When a error occurs and ERR signal turns on while waiting for a detect trigger, the waiting state is 
cancelled. 
While the error signal is ON, inputting the signals again operates correctly and turns off the error signal. 
Also, ERR signal can be reset forcibly by inputting an error reset signal assigned to one of ASSIGN0 to 1 
and EXT0 to 2, or by inputting the designated command. 
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10.2.3 Cause of Turning On ERROR Signal 

Turning on the signal of ERROR indicates that processes such as executed inspection or type switching have 
not completed correctly. 

Check if PV200 makes the causes of turning on the error signals. And then, to prevent those causes, adjust the 
settings of PV200 or recheck the signal and the command that the external device sends to PV200. 

Cause of Turning on ERROR Signal 
ERROR 0 signal turns on when an error occurs while the device executes an inspection or template setting. 

 

Cause Error 
Code Solution, etc 

Inspection area of Auto Area Setting was undetected, and the 
referring inspection checker cannot be executed. 

E0020 Set Auto Area Setting correctly. 

The following errors when sending a command to PV200. 
• BCC (Block check code) error 
• An undefined command was sent. 

(including the case of sending a part of command such as only 
delimiter(CR)) 

E0100  

Command receive buffer overflow of PV200 E0110 Decrease commands to send to 
PV200. 

Communication error (communication timeout or sum check error) 
occurred during PLC communication. 

E0111 Connect and set correctly. 

Parallel Handshake Timeout occurred. 
(No ACK signal indicating that the external device has received 
data was input to PV200 within the Timeout.) 

E0112 Input ACK signal within 
Handshake Timeout. 

Command Start Bit Off Timeout. E0113 Write command start bit to OFF 
from PLC 

When "Parallel Input" has not been selected for "Command Read 
Type", the "Read PLC Communication Command" signal was 
input. 

E0114 Select "Parallel Input". 

Values exceeded the following ranges during calculation. 
Effective range of values during calculation  
= -2147483648 to +2147483647 (- 231 to (231 – 1)) 

E0151 Check the expression of 
Numerical Calculation or 
Judgement which shows “E” sign 
in the Checker List. Denominator became “0” in the division that is specified as a 

numeric calculation. 
E0152 

Any item that does not exist is referred to the Numeric calculation, 
Judgement. (If the referred item is deleted although it existed 
when it was set.) 

E0153 

Any parameter that is not allowed is set as function (such as 
arithmetical function or statistical function) in numerical 
calculation. 

E0154  

Position adjustment for a detect trigger is unset or a base position 
is unset when you use “Detect Trigger (common)”.  

E0160 Register a Position Adjustment 
for the detect trigger. 

Any base point is not registered when "Method" in Calibration is 
set to Base Point. 

E0170 Set a base point. 

Base point is not registered correctly when "Operation" in 
Calibration is set to "Static". 

E0171 Set the base point correctly. 

When "Operation" in Calibration is set to "Dynamic"; 

• A checker for detecting base points is undetected or unregistered. E0171 Register a checker for detecting 
base points properly. 

• All the coordinates of base points 0 to 2 are on the same line 
when Method is set to "Base 3 points". 

• The coordinates of base points 0 and 1 are the same when 
Method is set to "Base 2 points". 

E0172 

While PV200 stops the operation, a command to execute one of the following is sent.  
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Cause 
Error 
Code Solution, etc 

• Start executing an inspection 
• Execute template setting of Smart Matching 
• Execute template setting of Contour Matching 
• Select type 
• Save the setting data (in the storage space in PV or a SD memory 

card) 
• Read the setting data (from the storage space in PV or a SD 

memory card) 
• Save images saved in the save image memory to a SD memory 

card 
• Clear the save image memory 
• Print screen 
• Reset statistics 
• Layout change 
• Read or write parameters 

E0200 Operate (run) PV200 and execute 
again. 

The command specifying a block number was sent when setting 
execution mode to “Execute All” or “Automatic Switch”. 

E0201 Send an inspection start 
command which specifies no 
block number. 

The inspection start command specifying no block number was 
sent when setting execution mode to "User Defined". 

E0202 Specify block numbers correctly. 

Image capturing error occurred. 
• No camera is connected. 
• Disconnection of the camera cable, loose connection of the 

camera connector. 
• No image exists in Inspection image memory when executing 

reinspection (without capturing any image after PV starting up) 
• Both two cameras of PV200 are set to "Unused". 

E0203 Connect and set correctly. 
If the error reoccurs, try the 
following procedures. 
• Cut the power and reconnect 

the camera cable. 
• Replace the cable. 

During continuous inspection, the signal to execute "Reinspection" 
is input or the command is sent. 

E0204 You cannot reinspect during 
continuous inspection. 

Although a command (except PIO) to be activated by checking 
that the READY signal is on was requested, it was not accepted 
more than one second because the READY signal was off (e.g. 
Detect trigger or Continuous inspection start was processing, or 
setting data was being saved to the PV). 

E0205  

The inspection command was sent while reading setting data in 
continuous inspections. 

E0206  

• The specified product number does not exist. 
• Other number than 000-255 was specified for a product number. 

E0210 Specify a type number correctly. 

Type switch was executed by an external command while 
executing detect trigger. 

E0211 Stop the detect trigger and then 
execute type switch. 

Other number than 00-99 was specified as an area number when 
saving or reading setting data to or from PV or a SD memory card. 

E0212  

When reading setting data from a SD memory card; 

• No SD memory card is attached or cannot be accessed. 
• No data file in the designated area of a SD memory card. 

E0213 Check attachment of the SD 
memory card or presence of data 
file. 

• The data file is not data of PV200. 
• The data file is incompatible. (Data of the later version, etc.) 
• The number and types of cameras connected to PV200 is different 

from the Camera setting of the data file. (Example: Camera was 
disconnected unexpectedly.) 

E0214 Prepare a correct data file. 
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Cause 
Error 
Code Solution, etc 

When saving setting data in a SD memory card; 
• No SD memory card is attached, the card cannot be accessed, or 

used up its capacity. 
• The SD memory card is write-protected. 
• The file with the specified storage number already exists, and the 

property of the file is "Read-only". 
• "Write When Cover is Open" is set to "Disable", and the cover is 

open. 

E0216 Correctly attach a SD memory 
card which is writable and has 
enough free space. 

When aborting save/read setting data,  
• The command to abort is sent other than when saving/reading 

setting data. 
• Aborting failed. 

E0217  

When you make Template setting (Smart Matching or Contour Matching) with the following conditions; 

• It was executed when Detect trigger was processing or 
Continuous Inspection was used. 

E0230 Stop Detect trigger and 
Continuous Inspection, and then 
execute Template setting. 

• It was executed during parallel I/O output when setting "Area 
Display" to “Yes”. 

Execute Template setting after 
the completion of parallel I/O 
output. 

• While “Area Display” is set to “Yes”, the command for Send 2 (%A 
or %B) was sent when Send 1 was supposed to. 

• While “Area Display” is set to “Yes”, the command for Send 1 
(%Accc,?? Or %Bccc,??) was sent when Send 2 was supposed 
to. 

• While "Area Display" is set to "No", the command "%A" or “%B” 
was sent. 

Enter a command correctly. 

• The specified number of checker or template is not create. 
• Any other number than 0-999 for checker number, or 0-63 for 

template was specified. (for serial command) 

E0231 Specify a correct checker number 
or template number. 

• Template cannot be set because no image has been captured 
after PV200 started up when you select “Use the Last Image” for 
“Template Setting. 

E0232 Execute an inspection, or change 
the setting to “Capture New 
Image” to execute Template 
setting. 

• No feature on the image of template registration area. 
• Contour information is insufficient in the template of Contour 

Matching. 
• An error occurs in Position adjustment when you use it. 

E0233 Che.ck the captured image. 

• Template registration area is outside of the captured image (image 
partially captured when executing partial imaging). 

Adjust the whole registration area 
to be in the range of the captured 
image. 

When switching between Run and Stop; 

• Specification of the parameter is wrong. (A number other than 0 
and 1 was specified.) 

E0240 Specify correct parameters. 

• PV200 sent a command in the following inoperable state. 
• When selecting "TOOL" > "General", "Settign Help" or "Update 

Make PV200 be operable. 

• A command was sent when saving in image memory.  

When switching layout; 

• Other number than 00-15 is specified for layout number. 
• No layout has been registered in the specified layout number. 

E0246 Specify a correct layout number. 

When sending parameter write command (%PW, %PWP); 

• Specification of the parameter is wrong. 
(e.g. Undefined parameter is specified.) 

E0251 Specify correct parameters. 

• The specified parameter does not exist. (e.g. The number of 
uncreated checker is specified as a parameter.) 

• The specified parameter value is out of the settable range. (e.g. 

E0252  
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Cause 
Error 
Code Solution, etc 

Maximum value of slice level is being set to over 256.) 
• The specified values led to the status of “Maximum value < 

Minimum value” when entering them. 
• When specifying the moving distance of the marker, a part of 

the circumscribing rectangle of the marker (the intersection 
point when Shape is Cross line) after move was out of the nine 
screens where checker area is settable. 

• When the number of write commande received by PV200 
exceeds the receivable number when executing one 
inspection. 

E0253 Decrease commands to send to 
PV200. 

When outputting general result 

When the general result could not output when "Error Output" is 
set to “Yes”; 
• Ethernet communication (including FTP client) cannot be 

established (with connection problems such as cable 
unconnected or disconnection). 

• No SD memory card is attached, the card cannot be accessed, or 
used up its capacity. 

• The SD memory card is write-protected. 
• "Write When Cover is Open" is set to "Disable", and the cover is 

open. 

E0255*1 Correctly connect Ethernet. 
Correctly attach a SD memory 
card which is writable and has 
enough free space. 
Close the cover. 

When outputting inspection image 

When the latest inspection image could not output when "ERR 
signal ON at Output Error" is set to “Yes”; 
• Ethernet communication (including FTP client) cannot be 

established (with connection problems such as cable 
unconnected or disconnection). 

• Image Receiver is not activated or stops. 
• No SD memory card is attached, the card cannot be accessed, or 

used up its capacity. 
• The SD memory card is write-protected. 
• "Write When Cover is Open" is set to "Disable", and the cover is 

open. 

E0255*1 Correctly connect Ethernet. 
Activate Image Receiver, and set 
it to "CONN: Standby". 
Close the cover. 

The latest image output command was sent when waiting for the 
execution of detect trigger. 

E0257*1  

When outputting the latest inspection image to a SD memory card or Ethernet interface(Output Latest Image); 

When the latest inspection image could not output to Ethernet 
interface when "ERR signal ON at Output Error" is set to “Yes”;  
• No SD memory card is attached, the card cannot be accessed, or 

used up its capacity. 
• The SD memory card is write-protected. 
• "Write When Cover is Open" is set to "Disable", and the cover is 

open. 

E0255*1 Correctly attach a SD memory 
card which is writable and has 
enough free space. 
Close the cover. 

• Output Condition* of Image Output is not set to [Command 
Reception]. 

E0256 Set Output Condition to 
[Command Reception]. 

•  • There is no image captured. E0257*1 Capture an image. 

When saving Image memory of PV200 in a SD memory card; *3 

• No SD memory card is attached, the card cannot be accessed, or 
used up its capacity. 

• The SD memory card is write-protected. 
• "Write When Cover is Open" is set to "Disable", and the cover is 

open. 

E0260 Correctly attach a SD memory 
card which is writable and has 
enough free space. 
Close the cover. 

• When saving Image memory of PV200 in a SD memory card, 
there is no blank folder. (All of 00-99 are used.) 

Delete all or some folders of 00 - 
99 in the “Backup” folder of the 
SD memory card. 
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Cause 
Error 
Code Solution, etc 

• No image is saved in the image memory.   

When saving Print screen in a SD memory card or a PC through Ethernet; 

• No SD memory card is attached, the card cannot be accessed, or 
used up its capacity. 

• The SD memory card is write-protected. 
• "Write When Cover is Open" is set to "Disable", and the cover is 

open. 

E0265 Correctly attach a SD memory 
card which is writable and has 
enough free space. 
Close the cover. 

• Ethernet communication cannot be established (with 
connection problems such as cable unconnected or 
disconnection)Image Receiver is not activated. 

 Correctly connect Ethernet. 
Activate Image Receiver, and set 
it to "CONN: Standby". 

When Setting Invalid/Valid of Keypad operation command to PV200. 

• When sending command in SETUP menu. E0270 Change RUN menu. 

• Specification of the parameter is wrong. 
(e.g. Other number than 0-1 is specified.) 

E0271 Specify correct parameters. 

 

*1: The error processings in PV200 are classified into "Error in executing an inspection, outputting a result" 
and "Command error". 
The same error code may be returned for "Error in executing an inspection, outputting a result" and 
"Command error". Judge which error is indicated by the error code according to the content of the instruction.  
*2: “ENVIRONMENT” >  “Input/Output” >  "Image Output" > "Output Conditions” 
*3: When setting “ENVIRONMENT” >  "Input/Output" > "Save Image Memory" > "Overwrite" > “Yes”, if the 
capacity of a SD memory card is full even though the number of saved folders is less than the specified 
number of folders, the oldest folder is deleted. 
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10.2.4 Error Log Display Function 

(Available from Ver.2.0) 
The log of errors occurred when PV200 is operating can be confirmed in RUN menu. The error log display shows 
the date and time, and error codes of all errors occurred from the power-on of PV200. 

Displaying Error Log 

1. Select "View" > "Err Log" in RUN menu.  

2. The Err Log window is displayed. 

Date, time and error code are displayed in this 
order. 

 

3. If you want to delete the error log, press the 
"Clear" button. 

The confirmation message appears. Select "Yes" to 
clear the log. 

 

 
 When PV200 is turned off, the error log will be cleared.  

 Up to 1000 errors are displayed in the error log. When the number of errors exceeds 1000, the error 
log of subsequent errors will not be displayed. 

 The error log cannot be externally output or saved. 
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10.3 Timing Chart 

10.3.1 Typical Operations in Inspections 

Common Trigger 
In serial processing mode 

 
Tf: 400µs (fixed), Tp (1-1000ms): Data output guarantee time (default: 10 ms) 

 

1. Make sure that REDY signal is ON and then turn on STRT signal for more than 1 ms. 

2. PV200 turns off REDY signal and REND signal, and starts capturing an image. 

The OFF time of REDY signal is called "inspection time" up to No.4.  

 
The delay time mentioned on the right may occur from the input of 
STRT signal until the start of image capture (REND signal is OFF) 
when displaying a live image. 

4-Mega Camera:  
Max. 63 msec + Shutter speed 
2-Mega Camera: 
Max. 40 msec + Shutter speed 
0.3-Mega Quad-speed Camera: 
Max. 9 msec + Shutter speed 
0.3-Mega Compact Camera: 
Max. 12 msec + Shutter speed 

3. After image capturing is completed, PV turns on REND signal and executes checkers. 

4. As the inspection ends, a result is output through I/O interface and TACT signal and REDY signal 
are turned on after the period of “Tf”. 

When executing synchronous output (data output to COM port and Ethernet port or image output) as well 
as I/O output, REDY signal stays OFF until these outputs complete. 
After REDY signal turns ON, the device can receive the next STRT signal. 
Obtain a result after more than 1 ms of wait time when TACT signal turns on. 

 
 

The time from when TACT signal turns on till when the result output (OUT signal) is determined varies 
according to the condition of the connected load or ambient temperature. 

5. TACT signal is turned on for the time of “Tp”, and then turned off for the time of “Tp + Tf”. 

While the signal is off, result of the next inspection is not output.  

6. Out signal keeps on status until the next output (Hold), or turns off when TACT signal turns off 
(Reset). 

To select “Hold” or “Reset”, select “ENVIRONMENT” >  “System Settings” > “Operation” > “Parallel I/O 
Output Reset Condition”. 
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In parallel processing mode 

 
Tf: 400µs (fixed), Tp (1-1000ms): Data output guarantee time (default: 10 ms) 

1. Make sure that REND signal is ON and then turn on STRT signal for more than 1 ms. 

2. PV200 turns off REND signal and starts capturing an image. 

 
The delay time occurs from the input of STRT signal until the start of image capture (REND signal is 
OFF) when displaying a live image. Refer to page 56. 

3. After image capturing is completed, PV turns on REND signal and executes checkers. 

After REND signal turns on, PV200 can receive STRT signal (or capture and image). 
At the timing when it starts capturing the next image, input STRT signal. 

4. As the inspection ends, a result is output through I/O interface and TACT signal is turned on after 
the period of "TV". 

Obtain a result after more than 1 ms of wait time when TACT signal turns on. 
 

The time from when TACT signal turns on till when the result output (OUT signal) is determined varies 
according to the condition of the connected load or ambient temperature. 

5. TACT signal turns on for the time of “Tp”, and then turns off for the time of "Tp + Tf". 

You cannot output the next result while the signal is off and the device is in the status of waiting for output. 

6. OUT signal keeps on status till the next output (Hold), or turns off when TACT signal turns off 
(Reset). 

To select “Hold” or “Reset”, select “ENVIRONMENT” >  “System Settings” > “Operation” > “Parallel I/O 
Output Reset Condition”. 

7. After the second image capturing is completed, PV executes checkers. If the first data has been 
output at the time, REND signal is turned on. If it has not, PV waits until the data is output and turns 
on REND signal. 

After REND signal turns on, PV200 can receive STRT signal (or capture and image). 
At the timing when it starts capturing the next image, input STRT signal. 

 
Setting “Image Output” to “Async.(inspection first)” turns on REND signal and allows capturing the third 
image after the second image capturing or the first synchronous result output (general output through I/O 
and synchronously) whichever completed later, before outputting the general result and the image of the 
first inspection is completed. 
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10.3.2 Outputting All Results (Output = All) 

When the Handshake Function Is Set to “No” 
Inspection data are output at intervals of set “Output signal guarantee time (Tp)”. STRB signal turns on each 
time outputting the data. 

Receive data with the external device after rising edge of STRB ON signal and before the next STRB signal 
turns on. 

The following is an example of outputting data dividing into three times in Serial mode. 
 

 
Tf: 400µs (fixed), Tp (1-1000ms): Data output guarantee time (default: 10 ms) 

1. As the inspection ends, the first data (OUT signal) is output through I/O interface and turned on 
STRB signal and TACT signal. 

Obtain the first result after more than 1 ms of wait time when STRB signal turns on. 
 

The time from when STRB signal turns on till when the result output (OUT signal) is determined varies 
according to the condition of the connected load or ambient temperature.  

2. STRB signal turns off after the time of Tp passes. 

3. As the time of Tp passed from STRB signal turns off, the second data is output and STRB signal 
and REDY signal turn on(*). 

Obtain the second result after more than 2 ms of wait time when STRB signal turns on. 
 

When synchronous output is operated in addition to I/O output, including data output to COM port and 
Ethernet port, and inspection image output, READY signal stays OFF until the operation is completed. 

4. STRB signal and TACT signal turn off after the time of Tp passes. Setting "Parallel I/O Output Reset 
Condition" to "Reset" resets OUT signal at this timing. 

5. I/O result output is complete after the time of "Tp+Tf" passes from TACT signal turns off. 

 
You cannot output the next result while the time of "Tp+Tf" is passing in Parallel mode, and the device is in 
the status of waiting for output. 
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When the Handshake Function Is Set to “Yes” 
Use STRB signal (PV200 -> the external device) and ACK signal (The external device -> PV200) in pairs. 

 
Tf: 400µs (fixed)、Tp: Data output guarantee time, 1-1000ms (default: 10 ms) 

To: Timeout period, 4 - 20000 ms (default: 5000 ms)  
   Exceeding this time causes a timeout error, terminates output processing, and outputs ERR signal. 

1. As the inspection ends, the first data is output through I/O interface and turned on STRB signal and 
TACT signal. 

2. As for an external device, obtain the first result after more than 1 ms of wait time(*) when STRB 
signal turns on, and turn on ACK signal. 

Be sure to turn on ACK signal in the time of "To" after turning on STRB signal. 
 

(*) The time from when STRB signal turns on till when the result output (OUT signal) is determined 
varies according to the condition of the connected load or ambient temperature.  

3. PV200 checks that ACK signal is ON and turns off STRB signal. 

4. Check STRB signal if OFF with the external device and turn off ACK signal in the time of “To”. 

5. PV200 outputs the second (last) data in 100μsec (Td) after turning off ACK signal. 

6. As the time of “Tf” passed from data output, turn on STRB signal and REDY signal. 

 
When synchronous output is operated in addition to I/O output, including data output to COM port and 
Ethernet port, and inspection image output, REDY signal stays OFF until the operation is completed. 

7. As for an external device, obtain the second result after more than 2 ms of wait time(*) when 
STRB signal turns on, and turn on ACK signal. 

Be sure to turn on ACK signal in the time of To after turning on STRB signal. 

8. PV200 checks that ACK signal is ON and turns off STRB signal and TACT signal. Setting "Parallel 
I/O Output Reset Condition" to "Reset" resets OUT signal at this timing. 

Check STRB signal is OFF with the external device and turn off ACK signal. If the time from turning on of 
TACT signal is less than “Tp”, wait until the time passes and turn off TACT signal. 

9. I/O result output is complete after the time of "Tp+Tf" passes from TACT signal turns off. 

 
You cannot output the next result while the time of "Tp+Tf" is passing in Parallel mode, and the device is in 
the status of waiting for output. 
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10.3.3 Type Switch (TYPE) 

 

T1>1ms 
 

1. Specifying the number of the product type that you want to call using IN0- 7. 

Input IN0-7 more than 1 ms before TYPE signal input. 
 
How to specify product number to IN0-7 

Type IN7 IN6 IN5 IN4 IN3 IN2 IN1 IN0 
000 off off off off off off off off 
001 off off off off off off off ON 
002 off off off off off off ON off 
003 off off off off off off ON ON 
004 off off off off off ON off off 

    :     
252 ON ON ON ON ON ON off off 
253 ON ON ON ON ON ON off ON 
254 ON ON ON ON ON ON ON off 
255 ON ON ON ON ON ON ON ON 

2. Check the REDY signal ON and then input the TYPE signal (Type switch execution signal). 

3. PV200 checks that TYPE signal is ON and turns off REDY signal and REND signal. 

 
- When the current type number is specified, the type switching is not performed. However, when 

setting the type switch guarantee time (Refer to page 432.), the READY signal and REND signal turns 
OFF just for the set time. 

- If an external device such as PLC cannot detect the READY signal OFF because the OFF time of the 
READY signal is too short, adjust the type switch guarantee time or REND OFF minimum time (Refer 
to page 436.) 

4. PV200 executes type switch. 
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5. After type switching completed, REDY and REND signals turns on. 

6. Turns off TYPE signal and IN0-7 signals before inputting a signal, such as STRT, to PV200. 



 
 

568 

O
peration and D

ata O
utput through I/O

 Term
inals 

C
h. 10 

10.3.4 Re-registering Templates/Contour Template Setting 

“Use the Last Image” > "Set Position" 
When Area Display is "No" 

 T1>/=1msec 

Although the re-registration signal used for Contour Template Setting differs from that for "(Smart 
Matching) Template Setting", the timing chart is the same. 

1. Specifying the number of the checker that you want to re-register using IN0-4. 

Input IN0-4 more than 1 msec before Template re-registration signal input. 
 

How to specify checker number to IN0-4 
Checker No. IN4 IN3 IN2 IN1 IN0 

0 off off off off off 
1 off off off off ON 
2 off off off ON off 
 :     

29 ON ON ON off ON 
30 ON ON ON ON off 
31 ON ON ON ON ON 

2. Specifying the number of the template that you want to re-register using IN5-7. 

Input IN5-7 more than 1 msec before Template re-registration signal input. 
Always set the template number to zero for Contour Matching. 

 
How to specify template number to IN5-7 

Template No. IN7 IN6 IN5 
0 off off off 
1 off off ON 
2 off ON off 
 :   

5 ON off ON 
6 ON ON off 
7 ON ON ON 

3. Check the REDY signal ON and then input the template re-registration signal. 

4. PV200 checks that the template re-registration signal is ON and turns off REDY signal. 

5. PV200 executes template re-registration. 

6. After template re-registration completed, REDY signal turns on. 
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7. Turns off the template re-registration signal and IN0-7 signals before inputting a signal, such as 
STRT, to PV200 the next time. 
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“Use the Last Image” > "Set Position" 
When Area Display is “Yes” 

 T1>/=1msec 

Although the re-registration signal used for Contour Template Setting differs from that for “(Smart Matching) 
Template Setting”, the timing chart is the same. 

 

1. Specifying the number of the checker that you want to re-register using IN0-4. 

Input IN0-4 more than 1 msec before Template re-registration signal input. 
 

How to specify checker number to IN0-4 
Checker No. IN4 IN3 IN2 IN1 IN0 

0 off off off off off 
1 off off off off ON 
2 off off off ON off 
 :     

29 ON ON ON off ON 
30 ON ON ON ON off 
31 ON ON ON ON ON 

2. Specifying the number of the template that you want to re-register using IN5-7. 

Input IN5-7 more than 1 msec before Template re-registration signal input. 
Always set the template number to zero for Contour Matching. 

 
How to specify template number to IN5-7 

Template No. IN7 IN6 IN5 
0 off off off 
1 off off ON 
2 off ON off 
 :   

5 ON off ON 
6 ON ON off 
7 ON ON ON 

3. Check the REDY signal ON and then input the template re-registration signal. 

4. PV200 checks that the template re-registration signal is ON and turns off REDY signal. 

5. PV200 executes area display and then turns on STRB signal. 

6. Check the STRB signal ON and then input the template re-registration signal with the external 
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device. 

7. PV200 executes template re-registration. 

8. After template re-registration completed, STRB signal turns off and REDY signal turns on. 

9. Turns off the template re-registration signal and IN0-7 signals before inputting a signal, such as 
STRT, to PV200 the next time. 
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“Use the Last Image” > "Adjusted Position" 
When Area Display is "No" 

 T1>/=1msec 

Although the re-registration signal used for Contour Template Setting differs from that for “(Smart Matching) 
Template Setting”, the timing chart is the same. 

 

1. Specifying the number of the checker that you want to re-register using IN0-4. 

Input IN0-4 more than 1 msec before Template re-registration signal input. 
 

How to specify checker number to IN0-4 
Checker No. IN4 IN3 IN2 IN1 IN0 

0 off off off off off 
1 off off off off ON 
2 off off off ON off 
 :     

29 ON ON ON off ON 
30 ON ON ON ON off 
31 ON ON ON ON ON 

2. Specifying the number of the template that you want to re-register using IN5-7. 

Input IN5-7 more than 1 msec before Template re-registration signal input. 
Always set the template number to zero for Contour Matching. 

 
How to specify template number to IN5-7 

Template No. IN7 IN6 IN5 
0 off off off 
1 off off ON 
2 off ON off 
 :   

5 ON off ON 
6 ON ON off 
7 ON ON ON 

3. Check the REDY signal ON and then input the template re-registration signal. 

4. PV200 checks that the template re-registration signal is ON and turns off REDY signal. 

5. PV200 executes position adjustment and then executes template re-registration. 

6. After template re-registration completed, REDY signal turns on. 

7. Turns off the template re-registration signal and IN0-7 signals before inputting a signal, such as 
STRT, to PV200 the next time. 



 

573 

O
peration and D

ata O
utput through I/O

 Term
inals 

C
h. 10 

 “Use the Last Image” > "Adjusted Position" 
When Area Display is “Yes” 

 

 T1>/=1msec 

Although the re-registration signal used for Contour Template Setting differs from that for “(Smart Matching) 
Template Setting”, the timing chart is the same. 

 

1. Specifying the number of the checker that you want to re-register using IN0-4. 

Input IN0-4 more than 1 msec before Template re-registration signal input. 
 

How to specify checker number to IN0-4 
Checker No. IN4 IN3 IN2 IN1 IN0 

0 off off off off off 
1 off off off off ON 
2 off off off ON off 
 :     

29 ON ON ON off ON 
30 ON ON ON ON off 
31 ON ON ON ON ON 

2. Specifying the number of the template that you want to re-register using IN5-7. 

Input IN5-7 more than 1 msec before Template re-registration signal input. 
Always set the template number to zero for Contour Matching. 

 
How to specify template number to IN5-7 

Template No. IN7 IN6 IN5 
0 off off off 
1 off off ON 
2 off ON off 
 :   

5 ON off ON 
6 ON ON off 
7 ON ON ON 

3. Check the REDY signal ON and then input the template re-registration signal. 

4. PV200 checks that the template re-registration signal is ON and turns off REDY signal. 

5. PV200 executes position adjustment and area display and then turns on STRB signal.  

6. Check the STRB signal ON and then input the template re-registration signal with the external 
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device. 

7. PV200 executes template re-registration. 

8. After template re-registration completed, STRB signal turns off and REDY signal turns on. 

9. Turns off the template re-registration signal and IN0-7 signals before inputting a signal, such 
as STRT, to PV200 the next time. 
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“Capture New Image” > "Set Position" 
When Area Display is "No" 

 T1>/=1msec 

Although the re-registration signal used for Contour Template Setting differs from that for “(Smart Matching) 
Template Setting”, the timing chart is the same. 

 

1. Specifying the number of the checker that you want to re-register using IN0-4. 

Input IN0-4 more than 1 msec before Template re-registration signal input. 
 

How to specify checker number to IN0-4 
Checker No. IN4 IN3 IN2 IN1 IN0 

0 off off off off off 
1 off off off off ON 
 :     

30 ON ON ON ON off 
31 ON ON ON ON ON 

2. Specifying the number of the template that you want to re-register using IN5-7. 

Input IN5-7 more than 1 msec before Template re-registration signal input. 
Always set the template number to zero for Contour Matching. 

 
How to specify template number to IN5-7 

Template No. IN7 IN6 IN5 
0 off off off 
1 off off ON 
 :   

6 ON ON off 
7 ON ON ON 

3. Check the REDY signal ON and then input the template re-registration signal. 

4. PV200 checks that the template re-registration signal is on, displays live image, and turns off REDY 
and REND signals. Then it starts capturing an image. REND signal turns on automatically after 
capturing an image is completed. 

 
The delay time occurs from the input of template re-registration signal until the start of image 
capture (REND signal is OFF) when displaying a live image. (Refer to page 56.) 

5. PV200 executes template re-registration. 

6. After template re-registration completed, REDY signal turns on. 
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7. Turns off the template re-registration signal and IN0-7 signals before inputting a signal, such 
as STRT, to PV200 the next time. 
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“Capture New Image” > "Set Position" 
When Area Display is “Yes” 

 T1>/=1msec 

Although the re-registration signal used for Contour Template Setting differs from that for “(Smart Matching) 
Template Setting”, the timing chart is the same. 

 

1. Specifying the number of the checker that you want to re-register using IN0-4. 

Input IN0-4 more than 1 msec before Template re-registration signal input. 
 

How to specify checker number to IN0-4 
Checker No. IN4 IN3 IN2 IN1 IN0 

0 off off off off off 
1 off off off off ON 
2 off off off ON off 
 :     

29 ON ON ON off ON 
30 ON ON ON ON off 
31 ON ON ON ON ON 

2. Specifying the number of the template that you want to re-register using IN5-7. 

Input IN5-7 more than 1 msec before Template re-registration signal input. 
Always set the template number to zero for Contour Matching. 

 
How to specify template number to IN5-7 

Template No. IN7 IN6 IN5 
0 off off off 
1 off off ON 
2 off ON off 
 :   

5 ON off ON 
6 ON ON off 
7 ON ON ON 

3. Check the REDY signal ON and then input the template re-registration signal. 

4. PV200 checks that the template re-registration signal is ON and turns off REDY signal. 
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5. PV200 executes area display and then turns on STRB signal.  

6. Check the STRB signal ON and then input the template re-registration signal with the external 
device. 

7. PV200 turns off REND signal and starts capturing an image. REND signal turns on 
automatically after capturing an image is completed. 

 
The delay time occurs from the input of template re-registration signal until the start of image 
capture (REND signal is OFF) when displaying a live image. (Refer to page 56.) 

8. PV200 executes template re-registration. 

9. After template re-registration completed, STRB signal turns off and REDY signal turns on. 

10. Turns off the template re-registration signal and IN0-7 signals before inputting a signal, such as 
STRT, to PV200 the next time. 
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“Capture New Image” > "Adjusted Position" 
When Area Display is "No" 

 

 T1>/=1msec 

Although the re-registration signal used for Contour Template Setting differs from that for “(Smart Matching) 
Template Setting”, the timing chart is the same. 

 

1. Specifying the number of the checker that you want to re-register using IN0-4. 

Input IN0-4 more than 1 msec before Template re-registration signal input. 
 

How to specify checker number to IN0-4 
Checker No. IN4 IN3 IN2 IN1 IN0 

0 off off off off off 
1 off off off off ON 
 :     

30 ON ON ON ON off 
31 ON ON ON ON ON 

2. Specifying the number of the template that you want to re-register using IN5-7. 

Input IN5-7 more than 1 msec before Template re-registration signal input. 
Always set the template number to zero for Contour Matching. 

 
How to specify template number to IN5-7 

Template No. IN7 IN6 IN5 
0 off off off 
1 off off ON 
 :   

6 ON ON off 
7 ON ON ON 

3. Check the REDY signal ON and then input the template re-registration signal. 

4. PV200 checks that the template re-registration signal is on, and turns off REDY and REND signals. 
Then it starts capturing an image. REND signal turns on automatically after capturing an image is 
completed. 

 
The delay time occurs from the input of template re-registration signal until the start of image 
capture (REND signal is OFF) when displaying a live image. (Refer to page 56.) 

5. PV200 executes template re-registration after executing position adjustment. 
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6. After template re-registration completed, REDY signal turns on. 

7. Turns off the template re-registration signal and IN0-7 signals before inputting a signal, such 
as STRT, to PV200 the next time. 
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“Capture New Image” > "Adjusted Position" 
When Area Display is “Yes” 

 T1>/=1msec 

Although the re-registration signal used for Contour Template Setting differs from that for “(Smart Matching) 
Template Setting”, the timing chart is the same. 

 

1. Specifying the number of the checker that you want to re-register using IN0-4. 

Input IN0-4 more than 1 msec before Template re-registration signal input. 
 

How to specify checker number to IN0-4 
Checker No. IN4 IN3 IN2 IN1 IN0 

0 off off off off off 
1 off off off off ON 
2 off off off ON off 
 :     

29 ON ON ON off ON 
30 ON ON ON ON off 
31 ON ON ON ON ON 

2. Specifying the number of the template that you want to re-register using IN5-7. 

Input IN5-7 more than 1 msec before Template re-registration signal input. 
Always set the template number to zero for Contour Matching. 

 
How to specify template number to IN5-7 

Template No. IN7 IN6 IN5 
0 off off off 
1 off off ON 
2 off ON off 
 :   

5 ON off ON 
6 ON ON off 
7 ON ON ON 

3. Check the REDY signal ON and then input the template re-registration signal. 



 
 

582 

O
peration and D

ata O
utput through I/O

 Term
inals 

C
h. 10 

4. PV200 turns off REDY and REND signals and starts capturing an image. REND signal turns on 
automatically after capturing an image is completed. 

 
The delay time occurs from the input of template re-registration signal until the start of image 
capture (REND signal is OFF) when displaying a live image. (Refer to page 56.) 

5. PV200 executes position adjustment and area display and then turns on STRB signal.  

6. Check the STRB signal ON and then input the template re-registration signal with the external 
device. 

7. PV200 executes template re-registration. 

8. After template re-registration completed, STRB signal turns off and REDY signal turns on. 

9. Turns off the template re-registration signal and IN0-7 signals before inputting a signal, such 
as STRT, to PV200 the next time. 
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Operation of Accepting External Commands When 
"Area Display" is “Yes” 

To perform template re-registration with the setting that "Area Display" is “Yes”, you need to input the 
template re-registration signal twice. 
The table below shows the operations of external commands in the waiting state for the second template 
input. 

 
Connection 

method 
Operation of command Waiting state Processing 

Parallel Template Setting 
(When Template Setting is 
executed firstly) 

ASN･EXT Complete Accept 

 Contour Template Setting 
(When Contour Template Setting 
is executed firstly) 

ASN･EXT Complete Accept 

 Abort Inspection/Process ASN･EXT Cancel Abort 

 Input signals other than the 
above 

ASN･EXT Continue Ignore 

General 
Communica
tion 
Control 
command 

Template Setting 
(When Template Setting is 
executed firstly) 

%A Complete Accept 

Contour Template Setting 
(When Contour Template Setting 
is executed firstly) 

%B Complete Accept 

 Abort Inspection/Process %CC Cancel Abort 

 Key emulating %K Continue Ignore 

 Commands other than the above 
or wrong commands 

(Any 
characters) 

Continue Error 

PLC 
Communica
tion 
Control 
command 

Template Setting 
(When Template Setting is 
executed firstly) 

 Complete Accept 

Contour Template Setting 
(When Contour Template Setting 
is executed firstly) 

 Complete Accept 

 Abort Inspection/Process  Cancel Abort 

 Key emulating  Continue Ignore 

 Commands other than the above 
or wrong commands 

(Any 
commands) 

Continue Error 

Waiting state 
 Complete: Template re-registration processing is executed. 
 Cancel: Waiting for the second template re-registration signal is canceled 
 Continue: Waiting state continues. 
Processing 
 Accept: Template re-registration processing is executed. 
 Abort: The second template setting is cancelled. 
 Ignore: No processing is performed. 
 Error: Error is output. 
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10.3.5 FLASH Output Timing 

 
When you turn on the light by inputting FLASH signal sent from PV200, the light continuously flashes while 
display image of PV200 is set to "Live". This is because the Flash signal is output continuously along with the 
display timing of the live image. It is advisable to display "Memory" image when you use the light using Flash 
signal.  

 
 

a Image capture 
response 

Response time for STRT signal to the start of image capturing. 
STRT signal response time (1 ms or less) + Capture delay *1) 
(0 to 999.9 ms) = 1000.9 ms (Max) 

b FLASH signal 
response time 

Response time for STRT signal to the start of FLASH signal output *2) *3). 
STRT signal response time (1 ms or less) + FLASH signal delay *1) (0 to 999.9 
ms) = 1000.9 ms (Max) 

c FLASH span *1) Set the value with PV200 in accordance with a connecting lighting.  
(0.2 - 999.9 ms *4)) 

d Lighting response time Response time for FLASH signal of a lighting *3). 
Set the value with a lighting. (It varies depending on the delay time setting of a 
lighting.) 

e Lighting range Lighting tolerance time between light emission start and the end. 
If it lights out of the range (above E’), brightness of captured images vary every 
inspection. 

f Shutter speed *1) Set the value with PV200. 0.03 to 1000.00 ms (30 µs to 1000 ms) 

g Lighting time Set the value with a lighting. 
The time from the emission start to the end of lighting must be less than “Lighting 
range” (e). 

• *1)  
Set it for each “Camera No. to Set” of Types. 

• *2)  
Depending on the internal circuit of a connecting device, the response time could be longer than the maximum time 
(1000.9 ms). Check on the system you actually use. 

• *3) For your imformation  
When using our digital power sourse for LED lighting (ANB86001/ANB86003), 
- Setting of “Capture delay” in PV200 to “0 ms” makes “b” = 1 ms or less 
- Setting of “Light delay Time” of the digital power sourse to “10 μs” makes “d” = 100 μs or less 

• *4)  
In PNP-output-type product (PhotoMos output type, the end of the product number is "P"), actual signal span against 
the set Falsh span is as listed below due to the feature of PhotoMos relay. The signal span changes depending on 
the setting of "Flash Polarity". 
When FLASH polarity is set to "ON at Low": [Output signal span] = [set signal span] - [approx. 120µs(0.12ms)] 
When FLASH polarity is set to "ON at High": [Output signal span] = [set signal span] + [approx. 40µs] 

 
Example)  
Set Signal Span Output Signal Span 

[FLASH Polarity] = ON [FLASH Polarity] = OFF 
Example 1 0.2 ms (200μs) 0.08 ms (80μs) 0.24 ms (240μs) 
Example 2 10 ms 9.88 ms 10.04 ms 
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Chapter 11 
 Control with Communication Port 
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11.1 Communication Port and Protocol 

PV200 is provided with the following communication ports. 
 COM port: RS-232C interface 

 Ethernet port: Ethernet interface 
 

There are two types of protocols for each communication port, 
"General Communication " and "PLC Communication". The 
communication details differ depending on the protocols. Use 
one of them according to your purpose. 

 

 

11.1.1 RS-232C Interface 

Using COM port, PV200 communicates with the external device through RS-232C. Outputting inspection 
result data and sending/receiving control commands can be performed. 

Make the settings for RS232C interface from the following items. 
Setting of communication 
condition 

“ENVIRONMENT” > “Input/Output” > “Serial” page 437 

Setting of serial output “ENVIRONMENT” > “Input/Output” > “General Output” > 
"Serial" column 

page 363 

Setting of PLC 
communication 

“ENVIRONMENT” > “Input/Output” > “PLC Communication” page 632 

Setting when selecting 
"PLC Communication" - 
"Command Read Type" - 
"Parallel Input" 

“ENVIRONMENT” > “Input/Output” > “Parallel I/O” > 
"ASSIGN0-1/EXTRA0-2" > Read PLC Communication 
Command 

page 436 

page 552 

 
For PLC communication, either RS-232C interface or Ethernet interface must be selected. 

Communication Specification of RS-232C 
Item Specifications 

Connector D-sub9 pin 
Communication method Full duplex 
Synchronous method Asynchronous 
Baud rate *1) 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200 

bps (Factory default: 9600) 
Transmission code ASCII 
Transmission 
format 

Bit length 7-bit, 8-bit (Factory default: 8-bit) 
Stop bit 1-bit, 2-bit (Factory default: 1-bit) 
Parity check None/Odd/Even (Factory default: Odd) 
Flow control None/Soft Flow (Factory default: None) 
Delimiter CR 

*1) When Baud Rate is "115200 bps", the communication may not be carried out stably in accordance with the 
device to communicate with. In the case, set Baud Rate to "57600 bps" or lower. 

 

For information how to set communication speed and transmission format, refer to Chapter 6.3.2 Changing 
Communication Condition of COM port (Serial), page 436. 
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Connecting with a PC or a PLC 

Connecting with a PC 

The arrangement of the cables is shown on the right. 

 

PV200                              PC       

 

Connections with Panasonic PLC 
 
FP2 CCU FP0 /FP0R/ FP7 

PV200                         PLC    

 

PV200                        PLC     

 

 

Connections with other companies' PLC (Reference) 
 
     PV200  PLC  Signal Pin List 

PLC Type 
Pin 
No. 

 
Signal 

 
Signal 

 Pin No. 
   A B C D E F 

Mitsubishi  

A /Q series 
9Pin A  SG 

 

SG(GND)  5 5 9 3 7 7 
 

25Pin E  RD 
 

SD(TXD)  3 3 2 2 2 2  

FX series , FX-2N series B  SD 
 

RD(RXD)  2 2 3 1 3 3 
 

Q series 6Pin D   
  

RS(RTS)  7 - 4 - 4 4   

OMRON :  9Pin C   
  

CS(CTS)  8 - 5 - 5 5   

C series, CV series, CS1 series 25Pin F   
  

CD(DCD)  1 1 - - 8 -   

Allen-Bradley : SLC series A   
  

ER(DTR)  4 4 - 6 20 20   

Fuji : SX series A   
  

DR(SDR)  6 6 - 5 6 -   

 About the broken line in the connecting example, please refer to an instruction manual of PLC 
to connect it as necessary. 

 The above pin numbers are those of typical devices such as communication units of each 
company. Refer to the instruction manual of PLC you use for the actual pin numbers. 
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11.1.2 Ethernet Interface 

Ethernet communication is performed with an external device. Outputting inspection result data and 
sending/receiving Control commands can be performed. PV200 can communicate with the designated setting 
software PVWIN200. By using "Image Receiver for PV", image data can be also output. 

Make the settings for Ethernet interface from the following items. 
Setting of network "TOOL" > "General" > "Network" page 453 
Setting of Ethernet output “ENVIRONMENT” > “Input/Output” > “General Output” > 

"Ethernet" column 
page 363 

Setting of PLC 
communication 

“ENVIRONMENT” > “Input/Output” > “PLC Communication” page 632 

Setting when selecting 
"PLC Communication" - 
"Command Read Type" - 
"Parallel Input” 

“ENVIRONMENT” > “Input/Output” > “Parallel I/O” > 
"ASSIGN0-1/EXTRA0-2" > Read PLC Communication 
Command 

page 436 

page 552 

Setting software 
"PVWIN200" 

All the settings except the network setting are set with 
PVWIN200. 

page 708 

Image output “ENVIRONMENT” > “Input/Output” > “Image Output” page 370 
Print screen “ENVIRONMENT” > “Input/Output” > “Print Screen” page 68 

 
 Note that incorrect setting of the connection to the existing LAN might cause malfunction in the 

devices on the network. Consult your network administrator before connecting. 

 One PV200 cannot be operated by multiple PCs on the network. 

 Depending on the network condition, delay might be caused in the communication. It is advisable to 
use I/O interface or RS-232C interface for the operation that requires speedy response such as 
inspection trigger input. 

 For PLC communication, either RS-232C interface or Ethernet interface must be selected. 

Communication Specification of Ethernet 
Item Specifications 

Connector RJ-45 

Media 10BASE-T / 100BASE-TX / 1000BASE-T 

Protocol General Communication: TCP / IP 
PLC Communication: UDP / IP 

 
According to the network adapter of your PC, 1000BASE-T communication may not be available.  
When you use Ethernet communication with 1000BASE-T, please check the maximum frame size (which is the 
data size that can be sent or received in one communication) available in the network environment. In some 
cases, the network adapter complying with 1000BASE-T also requires a setting change. For details including 
how to set, please contact a manufacturer of network adapters. 

 

About Baud Rate 

PV200 automatically adjusts the baud rate according to the speed of the device to communicate. (Auto 
negotiation)You can know the current baud rate by the position and color of LED of Ethernet port that lights 
when communicating. 

 
Ethernet Port LED Color Baud Rate 

 

Upper Green 100 megabits 

 Orange 1000 megabits 
(1 gigabit) 

Lower Yellow 10 megabits 
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About Port Number 

Port number differs depending on protocol and communication data. 

 General Purpose 
Communication 

PLC Communication 

Protocol TCP / IP UDP / IP 

Communication behavior Server Client 

Port No. Data output 8601 1 – 65534  
(Except 8600 – 8699, 9090) Command 

send/receive 
8604 

Image output 8602 8602 

Destination 
setting 

IP address 

Port No. 

No Yes 

 If the setting to cutoff connection in case of no communication is available on a destination device, 
set it not to cutoff. 

Connecting PV200 with PC 

Communicating between a PV200 and a PC 
Connect them with a commercially available crossing cable. (STP crossing cable of category 5e or more is 
recommended.) 

 

Communicating between a PV200 and Multiple PCs 
Connect them with a commercially available straight cable (STP straight cable of category 5e or more is 
recommended.) through a hub or a router, which supports 1000BASE-T, 100BASE-TX, and 10BASE-T. 

 

 
Do not use the same IP addresses for the PV200 and the PC on the network. 
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11.1.3 Protocol 

The following two protocols are available for PV200.  
 

General 
Communication: 

This method communicates with external devices according to the protocol 
specified in PV200. 

As data is sent and received using ASCII strings, there is no restriction on external 
devices, however, a communication program for PV200 should be created in the 
external devices. 

Using this method enables to output inspection results, control PV200, read and 
change the setting values of PV200. 

PLC 
COMMUNICATION
: 
 

This method communicates with a PLC according to the protocol of the destination 
PLC. Although usable PLC units are limited, communication can be easily 
performed by reading or writing specified registers. Inspection results are written in 
a specified register of PLC. Also, PV200 can be controlled or the setting values can 
be read and changed by writing commands into another specified register. Unlike 
General communication, only integers can be read and written. 

Two methods are available for the timing of reading commands, "Polling" and 
"Parallel Input". "Polling" checks whether commands are written in the register of 
PLC or not in a specified “Polling Time”. The response speed is slower than that of 
"Parallel Input". The time such as the time of inspection or image output gets longer 
because the polling process is performed even during the inspection. 

 
For PLC communication, either RS-232C interface or Ethernet interface must be selected. 

The pattern 1 in the table below shows the condition when PLC communication is selected for RS-232C 
interface. In this case, PLC communication cannot be used for Ethernet interface. Although the result output of 
RS-232C interface is limited to PLC communication, the control command can be also accepted through 
General communication. 

The pattern 2 in the table below shows the condition when PLC communication is selected for Ethernet 
interface. In this case, PLC communication cannot be used for RS-232C interface. Even when PLC 
communication is selected for Ethernet interface, General communication can be used for both result output 
and control command. Note that, however, the output port is different from that of PLC communication. 

 

 RS-232C Interface Ethernet Interface 

 General 
Communication 

PLC  
Communication 

General 
Communication 

PLC  
Communication 

 Result 
output 

Control 
command 

Result 
output 

Control 
command 

Result 
output 

Control 
command 

Result 
output 

Control 
command 

Pattern 
1 

N/A A A A A A N/A N/A 

Pattern 
2 

A A N/A N/A A A A A 

 
A: Available. It is also OK not to use. 

N/A: Not available 
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11.2 General Communication 

11.2.1 Overview and Communication Specifications 

This method communicates with external devices according to the protocol specified in PV200. 
Use General Communication for communicating with a PLC other than the PLCs applicable for PLC 
Communication or PC. RS232C interface and Ethernet interface can be used simultaneously. (In some cases, 
they cannot be used simultaneously. Refer to 11.1.3 Protocol for details.) 

The following communications are available with General Communication.  
 

・General output  

When accepting an inspection start signal (parallel input including reinspection signal, control command by 
communication or TRIG input by keypad) in RUN menu, after the inspection, the inspection results that are 
set to be output (Date and Time, Scan count, Total judgement, Judgement, Numerical calculation) and 
BCC are output using ASCII strings, and CR is output at the end of data strings.  The following two output 
methods are available; Outputs data separated with comma and outputs data in fixed digits (unused digits 
filled with zeros) according to a specified output digits (For Scan count and Numerical calculation results 
only. For Total judgement, it is one digit. For Judgement, it depends on a set judgement formula.).  

Numerical calculation results are output as integer omitting the decimal point by specifying digits after decimal 
point you want to output in advance. 

(e.g. When setting "Decimal digit" to "2" for "12.345", it is rounded and output as "1235".) 

The date and time at the time of the execution of inspections can be output to Ethernet interface, SD card, and 
RS232C interface. The data can be added to the header of general output. 

These settings are common to all destination devices. 

 

ASCII strings to be output vary depending on the specified settings.  Create a program to read data on the 
external device according to the output strings. 

For information on the settings to use this function, refer to "Selecting Destination and Output Data" (page 
592). 

A function to resend general output is not available. 

 

・Control command  

Using this function enables to control PV200, read and change the setting values (including decimal point).  
(In PLC communication, only integers can be read and changed.) 

For the details of the control and commands to be used, refer to "11.3.5 List of Commands for PLC 
Communication" (page 647). 

Even when performing general output and control command using PLC communication, PV200 can accept 
all the general communication commands described in Chapter 11.2.5. 
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11.2.2 Setting General Communication 

Set only "General Output" for the setting of general communication. The condition to set for "Control 
command" using general communication is the setting of communication port only.  

Displaying General Output Setting Window 

1. Select “ENVIRONMENT” >  “Input/Output” 

from the menu bar. 

2. Select “General Output” in “Input/Output” 

setting window. 

 

Selecting Destination and Output Data 

1. Select a data destination in “Output”. 

You can select multiple interfaces as destinations. 
 

Both "Serial" and "Ethernet" can be selected for the general output using general communication as the 
figure below. However, for PLC communication, either “Serial” or “Ethernet” can be selected. Refer to page 
618 about PLC communication. 

2. To output Date and Time, select “Yes”, 

3. To output Scan Count/ Total Judgement/ 
Judgement/ Numerical Calculation, select 
“Yes”. 

 
 

 
When the destination is "Serial" or "Ethernet (PLC) 
Communication", the following setting should be done; 
"ENVIRONMENT" > "System Settings" > "Date/Time of 
General Output" is set to "Yes". 

 

4. To output BCC (block check code), select “Yes”. 
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Specifying Digit Number of Output Data 
In general communication, real numbers (values including after decimal point) can be output. Set the digit 
number of integer and after decimal point. 

1. Specify total digits of integer part and after decimal point in 
“No. of Digits”. 

2. In “Decimal Digit”, specify digits for after decimal point used 
from the digits set in step 1. 

The outputs specified in "No. of Digits" are "Scan Count" and 
"Numerical Calculation" only. If you set “No. of Digits” = 14 
(default) and “Decimal Digit” =3 (default), the value consisting of 

11-digit integer and 3-digit decimal number is output. If you set 
“Decimal Digit” = 2 or 1, the value is rounded. 

 

 

 
When the value exceeding the specified digits is processed, the value is output as “0”. 

3. Set "Unused Digit". 

If the digit number of the data is less than the output digit number you have set, select a handling of 
unused digit. 
Comma Separated: Unused digits are deleted. Multiple data are output in different number of digits. 

Data are separated with a comma (",") before being output. 
Filled with '0' (default):  Unused digits are filled with “0”. Although the data become longer, multiple data 

are output in the same number of digits. 
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11.2.3 Outputting Data through General Communication 

Data Output Flaw 
 

PV200    PLC 

     
Receives START signal.  

 
 Outputs START signal for inspection 

execution. 

Outputs response in case of accepting 
inspection by control command. 

 
 

 Receives response such as %S$52(CR). 

Executes inspection; capturing image 
and performing checkers. 

    

 
    

Outputs inspection results specified in 
advance using ASCII strings at a time 
and outputs CR at the end. 

 
 

 PLC uses transmitted ASCII strings by 
converting them to values. 

 
   

 

Waits for the next signal.  
 

 Goes back to the beginning and outputs 
START signal for the next inspection 
execution. 

     

 

About Data that can be Output 
When PV200 executes inspection, the data set to output are output in the following order.  

1. Date and Time  

2. Scan Count 

3. Total Judgement 

4. Judgement result: 
Up to 1000 points combining judgements and numerical calculations. 

5. Numerical Calculation: 

6. BCC  

The settings for the above output items 1 to 6 (Output; "Yes" / "No") are common to all the destinations 
(Serial / Ethernet / SD Card). 

In the following cases, the data of Judgement and Numeric Calculation are not output to PLC.  
 PV sets data to output, but no data exist. 

 The setting data exist, but data are set to not to be output. 

 

Output format of Date and Time: 
Output Data • Date: YY/MM/DD (2-digit of year/ 2-digit of Month/ 2-digit of Day) Total eight 

characters 
• Time: HH:MM:SS(2-digit of Hour/2-dgit of Minute/2-digit of Second) Total eight 

characters 
• Sixteen characters or seventeen characters (when setting "Unused Digit" to 

"Comma Separated" are output regardless of output digits. 
Number of Data 1 

However, when "Unused Digit" is "Comma Separated", a comma is put between 
date and time. 
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Output format of Scan count: 
Output Data 1 to 2147483647 

Number of Data 1 

Values to be Output Normal 1 to 2147483647 

Overflow  2147483647 

When exceeding the specified "No. of Digits". 0 

 

Output format of Total Judgement: 
Output Data 1 / 0 / E (1 character) 

Number of Data 1 

Values to be Output OK 1 

NG 0 

Error E 

Unset E 

 

Output format of Judgement data: 
Output Data Outputs one judgement data with one character (1 / 0 / E) 

Once all data are output, output will be terminated regardless of output digits. 
Number of Data Up to 1000 

Values to be Output OK 1 

NG 0 

Error E 

Unset Data are not output.  

 

Output format of Numerical Calculation:  

Values to be output are integers. When setting "Decimal Digit", the integer part and the digit after decimal 
point that is rounded to the specified decimal place is output without the decimal point.  

Example: In case of numerical calculation result is 123.456; 
When setting "Decimal Digit" to "2", 12346 is output by rounding it to two decimal place.  
Output Data Outputs one numerical calculation output as one data. 

-2147483648 to 2147483647 
Number of Data Numerical Calculation: Up to 1000 
Values to be Output Normal Calculation results: 

 -2147483648 to +2147483647 
Overflow or when exceeding 
the specified "No. of Digits". 

0 
("0" is output only for the appropriate 
numerical calculation results.)) 

Error 0 
Unset Data are not output. 

 

Output format of BCC:  

BCC is output subsequent to previous data. When "Unused Digits" is set to "Comma Separated", commas 
are put between each data for separation. However, the last data and BCC are output without separation.  
If you want to read the last data separated with comma, output one extra data next to it.  
Output Data 00 ~ FF (2 characters) 

Number of Data 1 
Values to be Output Obtains an Exclusive OR from the ASCII code of all characters from the first 

character of output string to the string right before BCC. The obtained 
Exclusive OR is expressed in hexadecimal and two characters are output 
regarding four bits as one character. 

 
Refer to "About Block Check Code 
" (page 599) for details. 
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Example of General Output 

 For details of output to SD card, refer to "Example of General Output to SD Card 

" (page 366). 
Output Data: Date: 

Time: 
Scan Count: 
Total Judgement: 
Judgement: 
Numerical Calculation: 

2010/12/15 
09:25:48 
1234 times 
OK 
JDC000 = OK, JDC001 = unset, JDC002 = NG 
CAC000 = 215.8, CAC001 = unset, CAC002 = -368.0 

   
Output Condition 
1: 

Date and Time: 
No. of Digits: 
Decimal Digit: 
Unused Digit: 
BCC: 

Output * 
6 
1 
Filled with ‘0’ 
Output 

* Output when setting "Date/Time of General Output" to "Yes". 

 

Output destination=”Serial”: ( When setting "Date/Time of General Output" to "No") 

0 0 1 2 3 4 1 1 0 0 0 2 1 5 8 - 0 3 6 8 0 BCC CR 

       Scan Count Total 
Judge. 

Judge- 
ment 

Numerical 
Calculation 0 

Numerical 
Calculation 2 

2-digit 
Block Check Code 

 

 

Output destination = "Serial": (When setting "Date/Time of General Output" to "Yes") 

1 0 / 1 2 / 1 5 0 9 : 2 5 : 4 8 0 0 1 2 3 4 1 1 0 

                         Date Time Scan Count Total 
Judge. 

Judge- 
ment 

 

0 0 2 1 5 8 - 0 3 6 8 0 BCC CR 

              Numerical 
Calculation 0 

Numerical 
Calculation 2 

2-digit block 
Check Code 

 

 

Output destination=”Ethernet (General Communication)”: 

1 0 / 1 2 / 1 5 0 9 : 2 5 : 4 8 0 0 1 2 3 4 1 1 0 

                         Date Time Scan Count Total 
Judge. 

Judgement 

 

0 0 2 1 5 8 - 0 3 6 8 0 BCC CR 

              Numerical  
Calculation 0 

Numerical  
Calculation 2 

2-digit 

Block Check Code 

 

 
Judgement JDC001 and Numeric Calculation CAC001 are not output because they are unset. 
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Output Condition 
2: 

Date and Time: 
No. of Digits: 
Decimal Digit: 
Unused Digit: 
BCC: 

Output * 
6 
1 
Deleted 
Output 

* Output when setting "Date/Time of General Output" to "Yes". 

 

Output destination=”Serial”: ( When setting "Date/Time of General Output" to "No") 

1 2 3 4 , 1 , 1 , 0 , 2 1 5 8 , - 3 6 8 0 BCC CR 

       Scan Count  Total 
Judge. 

 Judge.  Judge.  Numerical 
Calculation

0 

 Numerical 
Calculation 2 

2-digit 
Block Check 

Code 

 

 

Output destination = "Serial": (When setting "Date/Time of General Output" to "Yes") 

1 0 / 1 2 / 1 5 , 0 9 : 2 5 : 4 8 , 1 2 3 4 , 1 , 1 , 0 , 
                             

Date  Time 
 

 Scan Count  Total 
Judge. 

 Total 
Judge. 

 Judge.  

 

2 1 5 8 , - 3 6 8 0 BCC CR 
            

Numerical 
Calculation 

0 

 Numerical 
Calculation 2 

 

2-digit 
Block Check 

Code 

 

 

 

Output destination=”Ethernet (General Communication)”: 

1 0 / 1 2 / 1 5 , 0 9 : 2 5 : 4 8 , 1 2 3 4 , 1 , 1 , 0 , 

                           Date  Time  Scan Count  Total 
Judge. 

 Judge.  Judge.  

 

2 1 5 8 , - 3 6 8 0 BCC CR 

              Numerical  
Calculation 0 

 Numerical  
Calculation 2 

2-digit 

Block Check Code 
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11.2.4 List of Commands for General Communication 

The commands described in this chapter are the common commands for the ports to control PV200 with 
RS-232C interface and Ethernet interface through general communication. (Other commands are provided for 
the control through PLC communication. Refer to page 647.) 

 
Port number of Ethernet interface to send/ receive commands for PV200 is “8604”. 

List of Commands (When setting A Series 
Compatible to "No") 

The commands and the modes permitting the commands are listed below. For the details of commands using 
RS-232C interface when setting A Series Compatible to "Yes", refer to page 618. 

   Command Permission 
   RUN Menu SETUP 

Menu 
DEBUG 
Menu 

Parallel 
Proces-
sing 

Conti- 
nuous 
Inspec- 
tion 

  Command RUN STOP STOP STOP 

Inspection start Common Trigger %S Yes    Yes Yes 

Stop repeating inspection %S Yes    Yes Yes 

Stop Detect trigger execution %S Yes     Yes 

Start reinspection (to inspect on the 
current memory image without 
capturing a new image) 

%R Yes    Yes  

Switch product type %X Yes    Yes Yes 

Save the 
setting data 

Storage space in 
PV200 

%MW Yes    Yes   

SD memory card %CW Yes    Yes   

Read the 
setting data 

Storage space in 
PV200 

%MR Yes    Yes   

SD memory card %CR Yes    Yes   

Abort save/read setting data 
(Cancel) 

%CD Yes    Yes   

Image 
memory 

Save (in a SD card) %SS Yes    Yes   

Clear %SR Yes    Yes Yes 

Print screen %PS Yes Yes Yes  Yes Yes 

Reset statistics %Q Yes    Yes Yes 

Switch between RUN/STOP %RM Yes Yes   Yes Yes 

Reset error signal %E Yes Yes Yes  Yes Yes 

Cancel Inspection/ Process (Cancel 
various operations) 

%CC Yes Yes Yes  Yes Yes 

Key emulating %K Yes Yes Yes  Yes Yes 

Keypad 
Operation 

Invalid/Valid %BS Yes Yes   Yes Yes 

Confirm Status %BC Yes Yes Yes  Yes Yes 

Switch layout %I Yes    Yes Yes 

Set a template for Smart Matching  %A Yes      

Set a template for Contour Matching %B Yes      

Parameter Read %PR Yes *1 *1  Yes Yes 

 Read pairs 
(Maximum/minimum 
values) 

%PRP Yes    Yes Yes 

 Change %PW Yes    Yes Yes 

 Change pairs 
(Maximum/minimum 
values) 

%PWP Yes    Yes Yes 

*1 Only operation status (parameter: SYS_RUN) and screen status (parameter: SYS_EDIT) can be read. 
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11.2.5 Details of Commands 

“SEND” described in this chapter indicates the commands given from external devices to PV200. On the other 
hand, “Receive” indicates the responses for the sent commands from PV200 to external devices. 

About Block Check Code 

All command messages except the following * are added with a block check code, which checks an error 
using horizontal parity to improve reliability of transmission data.  This manual describes a block check code 
as “BBC”. (* When setting "A Series Compatible" with RS-232C interface) 

As a block check code of PV200, a code that is given by removing a terminal code from Exclusive OR (8-bit) of 
a command message and converting it into ASCII code (two letters) is used. 

If you do not employ block check, add it to “**” (2AH2AH) instead of a block check code. 
 

Example) When reading execution time 

Command message 

% P R  S Y S _ T I M E 1 

             25H 50H 52H 20H 53H 59H 53H 5FH 54H 49H 4DH 45H 31H 

             Obtain Exclusive OR  

 25H  
 

Command message including BCC 

% P R  S Y S _ T I M E 1 2 5 CR 

 BCC  

About Response at Error 

When sending a command message from the external device, an error response message containing 3-digit 
error code may be returned. This message is returned when the sent command is wrong or PV200 cannot 
receive the command. When setting "A Series Compatible" with RS-232C interface, a response message 
without BCC is sent back. 

The response differs depending on commands except the following common responses. Refer to the 
descriptions of each command. 

 

Error Response Message Common to Commands 
 

% ! 1 0 0 BCC(35) CR 
 

 This message is sent when Block Check Code (BCC) error occurred or an undefined command 
(unrecognizable command) is received. 

 ERROR signal turns on. 

 

% ! 1 1 0 BCC(34) CR 
 

 Receive buffer overflow of PV200. This might occur when inputting multiple commands in a row from 
the external device to PV200. If you receive this error response, decrease commands to send to 
PV200. 

 ERROR signal turns on. 
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Inspection start 

When using common trigger in “Execute All” or “Automatic 
Switch” execution mode 

Send % S BCC CR 
 

BCC = 76 or ** 

Receive % S $ BCC(52) CR 
 

 

Error (ERROR signal = ON) 

% S ! Error code (3-digit) BCC CR 
 

Error code 
160 Position adjustment for a detect trigger is unset or a base position is unset 

when "Camera Trigger" is set to “Detect Trigger (common)”.  
200 Operation is stopped. 
202 Execution mode is “User-Defined”. 
203 • No camera is connected. And setting data is not saved in the memory of 

PV200. 
• Both two cameras of PV200 are set to "Unused". 

 

When using common trigger in “User-Defined” execution 
mode 

Send % S ? BCC CR 
 

? = 0 - 9 (Block No. to execute) 

Receive % S $ BCC(52) CR 
 

 

Error (ERROR signal = ON) 

% S ! Error code (3-digit) BCC CR 
 

Error code 
160 Position adjustment for a detect trigger is unset or a base position is unset 

when "Camera Trigger" is set to “Detect Trigger (common)”.  

201 Execution mode is NOT “User-Defined” in PV200. 
202 The specified block is invalid (the number which does not/ cannot exist was 

specified) 

203 • No camera is connected. And setting data is not saved in the memory of 
PV200. 

• Both two cameras of PV200 are set to "Unused". 
 

Example: Starts the inspection of block No.2. 

Send % S 2 * * CR 
 

Receive % S $ 5 2 CR 
 

 
The above error code 203 will not be returned even if a camera cable is removed or disconnected when PV200 
is running. For detecting the error with an external device, check the parallel ERR signal. 
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Reinspection  
(Executes inspection without capturing an image) 

For “Execute All” or “Automatic Switch” execution mode 

Send % R BCC CR 
 

BCC = 77 or ** 

Receive % R $ BCC(53) CR 
 

 

Error (ERROR signal = ON) 

% R ! Error code (3-digit) BCC CR 

Error code 
200 Operation is stopped 

202 Execution mode is “User-Defined”. 

203 There is no image captured. 

204 Reinspection cannot be executed because PV200 is inspecting repeatedly 
 

For “User-Defined” execution mode 

Send % R ? BCC CR 
 

? = 0 - 9 (Block No. to execute) 

Receive % R $ BCC(53) CR 
 

 

Error (ERROR signal = ON) 

% R ! Error code (3-digit) BCC CR 

Error code 
200 Operation is stopped 

201 Execution mode is NOT “User-Defined”. 

202 The specified block is invalid. (The number which does not/ cannot exist was 
specified.) 

203 There is no image captured. 

204 Reinspection cannot be executed because PV200 is inspecting repeatedly 
 

Example: Starts the inspection of block No.0. 

Send % R 0 * * CR 
 

Receive % R $ 5 3 CR 
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Type Switch 

Send % X ? ? ? BCC CR 
 

??? = 000 - 255 (Product type No.) 

Receive % X $ BCC(59) CR 
 

 

Error (ERROR signal = ON) 

% X ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 

210 • The specified product number does not exist. 
• Other number than 000-255 was specified for a product number. 

 

Saving Setting Data 

Saving in the Storage Space in PV200 

Send % M W ? ? BCC CR 
 

 

Receive % M W $ BCC(1B) CR 
 

 

Error (ERROR signal = ON) 

% M W ! Error code (3-digit) BCC CR 

 

Error code 
200 Operation is stopped. 

 

Saving in a SD memory card 

Send % C W ? ? BCC CR 
 

?? = 00 - 99 (Storage area No. of a SD memory card) 

Receive % C W $ BCC(15) CR 
 

 

Error (ERROR signal = ON) 

% C W ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 

212 Other number than 00-99 was specified for a saving area number. 

216 • No SD memory card is attached or cannot be accessed. 
• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• "Write When Cover is Open" is set to "Disable", and the cover is open. 
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Reading Setting Data 

Reading from the Storage Space in PV200 

Send % M R ? ? BCC CR 
 

 

Receive % M R $ BCC(1E) CR 
 

 

Error (ERROR signal = ON) 

% M R ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 

214 • The data file is incompatible. (Data of the later version, etc.) 
• The number and types of cameras connected to PV200 is different from the 

Camera setting of the data file. 
(including the case that the camera is unconnected because the camera cable 
came off unexpectedly.) 

 

Reading from a SD memory card 

Send % C R ? ? BCC CR 
 

?? = 00 - 99 (No. of storage area of SD memory card saving 
the data to read) 

Receive % C R $ BCC(10) CR 
 

 

Error (ERROR signal = ON) 

% C R ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 

212 Other number than 00-99 was specified for a saving area number. 

213 • No SD memory card is attached or cannot be accessed. 
• No data file in the designated area of a SD memory card. 

214 • The data file is not data of PV200. 
• The Data file is incompatible. (Data of the later version, etc.) 
• The number and types of cameras connected to PV200 is different from the 

Camera setting of the data file. 
(including the case that the camera is unconnected because the camera cable 
came off unexpectedly.) 
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Abort Save/Read Setting Data 

Send % C D BCC CR 
 

 

Receive % C D $ BCC(06) CR 
 

 

Error (ERROR signal = ON) 

% C D ! Error code (3-digit) BCC CR 
 

Error code 
217 • Saving or reading setting data is not executed. 

• Aborting failed. 
 

Saving Images Stored in the Save Image Memory of 
PV into a SD Memory Card 

Data is saved into free area of the SD memory card. (A destination number cannot be specified.) 
 

Send % S S BCC CR 
 

BCC = 25 or ** 

Receive % S S $ BCC(01) CR 
 

 

Error (ERROR signal = ON) 

% S S ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 

260 • No SD memory card is attached or cannot be accessed. 
• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• No blank folder exists in the destination. (All of 000-999 folders are used.)  
• No image is saved in the save image memory. 
• "Write When Cover is Open" is set to "Disable", and the cover is open. 

 

Clearing the Image Memory Stored in PV 
Execute “SAVE/READ” -> “Clear Image Memory” in SETUP menu. 

Send % S R BCC CR 
 

BCC = 24 or ＊＊ 

Receive % S R $ BCC(00) CR 
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Print Screen 
It is output into the place specified from “ENVIRONMENT” >  “Input/Output” >  “Print Screen” -> “Destination”. 
This command cannot specify the destination. 

Send % P S BCC CR 
 

BCC = 26 or ** 

Receive % P S $ BCC(02) CR 
 

 

Error (ERROR signal = ON) 

% P S ! Error code (3-digit) BCC CR 
 

Error code 
265 • No SD memory card is attached or cannot be accessed. 

• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• "Write When Cover is Open" is set to "Disable", and the cover is open. 
• Ethernet communication cannot be established (with connection problems 

such as cable unconnected or disconnection) 
• Image Receiver is not activated. 

 

Resetting Statistics Data 
Resets statistics data and scan count. 

Send % Q BCC CR 
 

BCC = 74 or **  

Receive % Q $ BCC(50) CR 
 

 

 Error (ERROR signal = ON) 

% Q ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 

 

Switch between Run/Stop 
 

Send % R M ? BCC CR 
 

? = 0 - 1 (0 = switch to RUN, 1 = switch to STOP) 

Receive % R M $ ? BCC CR 
 

? = 0 – 1 (0 = RUN, 1 = STOP) 

Error (ERROR 1 signal = ON) 

% R M ! Error code (3-digit) BCC CR 
 

Error code 
240 • Specification of the parameter is wrong. (A number other than 0 and 1 was 

specified.) 
 

Example: Switches to Run. 

Send % R M 0 * * CR 
 

Receive % R M $ 0 2 E CR 
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Resetting Error Signal 
To turns off ERROR signal. 

 

Send % E BCC CR 
 

BCC = 60 or **  

Receive % E $ BCC(44) CR 
 

 

Keypad Operation (Key Emulation)  
This is a command that performs the same operations of the keypad. 

Send % K s ? ? BCC CR 

s = 0 - 1 
(On/off switch of the shift key; 0 = off, 1 = on) 

?? = 01 – 16 (See the right figure) 

   

Receive No response 

Setting Invalid/Valid of Keypad operation  
This is a command for prohibiting/permitting keypad operation in RUN MENU. 

When keypad operation has been set to "Invalid", the keypad cannot be used. A message "Keypad is invalid" is 
shown in the key guide space on the window. Even when setting to "Invalid", key emulate commands can be 
received. 

Send % B S ? BCC CR 
 

? = 0-1 (0 = Valid. 1 = Invalid) 

Receive % B S $ BCC(10) CR 
 

 

 Error (ERROR signal = ON) 

% B S ! Error code (3-digit) BCC CR 
 

Error Code 
270 Not available because SETUP MENU is displayed. 

271 Other number than 0.1 and 1 is specified. 
 

Reading Keypad Operation Status 

Send % B C BCC CR 
 

BCC = 24 or ** 

Receive % B C $ ? BCC CR 
 

? = 0-1 (0 = Valid. 1 = Invalid) 
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Canceling Inspection/ Processing (Cancel specific 
operation) 

Cancels the following active operations, and restores into the previous status before the operation. 

 Cancellation of the operation of a serial command which has been received 

 Abort of output in the status waiting for result output after an inspection is complete 

 Abort of image saving from Image Memory to a SD memory card 

 Cancellation of template re-registration 

Send % C C BCC CR 
 

BCC = 25 or ** 

Receive % C C $ BCC(01) CR 
 

 

Layout Switch 

Send % I ? ? BCC CR 
 

?? = 00 – 15 (Layout No.) 

Receive % I $ BCC(48) CR 
 

 

Error (ERROR signal = ON) 

% I ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 
246 • Other number than 00-15 is specified for layout number. 

• No layout has been registered in the specified layout number. 
 

Smart Matching Template Setting 
Set a template of Smart Matching. 

 
A template that can be set with the command is one of Smart Matching in “Checker” menu. In Smart Matching 
used in Position Adjustment and Area Size Adjustment, a template cannot be re-registered. 

 
For information on the conditions when re-registering templates: page 191 

When “Area Display” is set to “No” for Template Setting 

Send % A n n n , ? ? BCC CR 
 

nnn = 000 - 999 (Checker No.)  

?? = 00 – 63 (Template No.) 

Receive % A $ BCC(40) CR 
 

 

Error (ERROR signal = ON) 

% A ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 

230 • Because PV200 is processing Detect trigger or Continuous Inspection, 
Template setting cannot be executed. 

• The command (%A) when "Area Display" is set to “Yes” was sent. 

231 • The specified checker number or template number has not be created. 
• Other number than 000-999 for checker number, or 00-63 for template was 

specified. 
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232 Template cannot be set because no image has been captured after PV200 
started up when you select “Use the Last Image” for “Template Setting”.  

233 • No feature on the image of template registration area. 
• An error occurs in Position adjustment when you use it. 
• Template setting area is outside of the captured image (image partially 

captured when executing partial imaging). (The whole template setting area 
should be in the range of the captured image.) 

 

Example: Re-registers a template No.1 of checker No.5. 

Send % A 0 0 5 , 0 1 * * CR 
 

Receive % A $ 4 0 CR 
 

 

When “Area Display” is set to “Yes” for Template Setting 

Send1 % A n n n , ? ? BCC CR 
 

nnn = 000 - 999 (Checker No.) 

?? = 00 – 63 (Template No.) 

Receive1 % A $ BCC(40) CR 
 

 

Send2 % A BCC CR 
 

BCC = 64 or ** 

Receive2 % A $ BCC(40) CR 
 

 

 Error (ERROR signal = ON) 

% A ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 

230 • Because PV200 is processing Detect trigger or Repeat start, Template setting 
cannot be executed. 

• Because parallel I/O result is being output, Template setting cannot be 
executed. 

• The command for Send 2 (%A) was sent when Send 1 was supposed to.  
• The command for Send 1 (%Annn,??) was sent when Send 2 was 

supposed to. 

231 • The specified checker number or template number has not be created. 
• Other number than 000-999 for checker number, or 00-63 for template was 

specified. 

232 Template cannot be set because no image has been captured after PV200 
started up when you select “Use the Last Image” for “Template Setting”. 

233 • No feature on the image of template registration area. 
• An error occurs in Position adjustment when you use it. 
• Template setting area is outside of the captured image (image partially 

captured when executing partial imaging). (The whole template setting area 
should be in the range of the captured image.) 

 

Example: Re-registers a template No.1 of checker No.5. 

 Send1 % A 0 0 5 , 0 1 * * CR 
 

 Receive1 % A $ 4 0 CR 
 

 Send2 % A 6 4 CR 
 

 Receive2 % A $ 4 0 CR 
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Contour Matching Template Setting 
Set a template of Contour Matching. 

 
A template that can be set with the command is one of Contour Matching in “Checker” menu. In Contour 
Matching used in Position Adjustment and Area Size Adjustment, a template cannot be re-registered. 

 
For information on the conditions when re-registering templates: page 191 

When “Area Display” is set to “No” for Template Setting 

Send % B n n n , ? ? BCC CR 
 

nnn = 000 - 999 (Checker No.)  

?? = 00 (Template No.):Fixed 

Receive % B $ BCC(43) CR 
 

 

Error (ERROR signal = ON) 

% B ! Error code (3-digit) BCC CR 
 

Error code 
200 Operation is stopped 

230 • Because PV200 is processing Detect trigger or Continuous Inspection, 
Template setting cannot be executed. 

• The command (%B) when "Area Display" is set to “Yes” was sent.  

231 • The specified checker number or template number has not be created. 
• Other number than 000-999 for checker number, or 00 for template was 

specified. 

232 Template cannot be set because no image has been captured after PV200 
started up when you select “Use the Last Image” for “Template Setting”.  

233 • No feature on the image of template registration area. 
• An error occurs in Position adjustment when you use it. 
• Template setting area is outside of the captured image (image partially 

captured when executing partial imaging). (The whole template setting area 
should be in the range of the captured image.) 

 

Example: Re-registers a template No.0 of checker No.5. 

Send % B 0 0 5 , 0 0 * * CR 
 

Receive % B $ 4 3 CR 
 

 

When “Area Display” is set to “Yes” for Template Setting 

Send1 % B n n n , ? ? BCC CR 
 

nnn = 000 - 999 (Checker No.) 

?? = 00 (Template No.):Fixed 

Receive1 % B $ BCC(43) CR 
 

 

Send2 % B BCC CR 
 

BCC = 67 or ** 

Receive2 % B $ BCC(43) CR 
 

 

 Error (ERROR signal = ON) 

% B ! Error code (3-digit) BCC CR 
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Error code 
200 Operation is stopped 

230 • Because PV200 is processing Detect trigger or Repeat start, Template setting 
cannot be executed. 

• Because parallel I/O result is being output, Template setting cannot be 
executed. 

• The command for Send 2 (%B) was sent when Send 1 was supposed to. 
• The command for Send 1 (%Bnnn,??) was sent when Send 2 was 

supposed to. 

231 • The specified checker number or template number has not be created. 
• Other number than 000-999 for checker number, or 00 for template was 

specified. 

232 Template cannot be set because no image has been captured after PV200 
started up when you select “Use the Last Image” for “Template Setting”. 

233 • No feature on the image of template registration area. 
• An error occurs in Position adjustment when you use it. 
• Template setting area is outside of the captured image (image partially 

captured when executing partial imaging). (The whole template setting area 
should be in the range of the captured image.) 

 

Example: Re-registers a template No.0 of checker No.5. 

 Send1 % B 0 0 5 , 0 0 * * CR 
 

 Receive1 % B $ 4 3 CR 
 

 Send2 % B 6 7 CR 
 

 Receive2 % B $ 4 3 CR 
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Read Out Command 
This is a command that reads out the settings of PV200 and system value. For the information of readable data, 
refer to the pages after page 613. 

When reading one of data (such as Execution time,  
Total judgement, Maximum value, or Minimum value) 

Send % P R  Parameter BCC CR 
 

Receive % P R $ Parameter = Data BCC CR 
 

 Error (ERROR signal = ON) 

% P R ! Error code (3-digit) BCC CR 
 

Example: Reads out Execution time 1. 

Send 

% P R  S Y S _ T I M E 1 BCC CR 
 

Receive 

% P R $ S Y S _ T I M E 1 = 5 3 . 2 5 BCC CR 
 

 

When reading two of data (such as Maximum value and 
Minimum value) 

Send % P R P  Parameter BCC CR 
 

Receive % P R P $ Parameter = Data 1 , Data 2 BCC CR 
 

 Error (ERROR signal = ON) 

% P R P ! Error code (3-digit) BCC CR 
 

Example: Reads out the maximum and minimum values of slice level group "A" for camera 0. 

Parameter to read out the maximum and minimum values of slice level group. 
"BLV:PAIR?" 

Send 

% P R P  B L V : P A I R A BCC CR 
 

Receive 

% P R P $ B L V : P A I R A = 8 0 , 2 5 5 BCC CR 

               Minimum  Maximum   
 

  

Error codes for Read Out command 
200 Operation is stopped. 

251 Specification of the parameter is wrong. (Undefined parameter is specified.) 

252 The specified parameter does not exist. (e.g. You tried to read out the setting value of an 
uncreated checker.) 
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Write Command 
This is a command that changes the setting value of PV200. Writing is available only when being in RUN mode. 
For the information of writable data, refer to the next page. 

When writing one of data (such as System Register, maximum 
value, or minimum value) 

Send % P W  Parameter = Data BCC CR 
 

Receive % P W $ Parameter BCC CR 
 

 Error (ERROR signal = ON) 

% P W ! Error code (3-digit) BCC CR 
 

Example: Writes the value “3.14” in System Register 0. 

Send % P W  S Y S : R E G 0 = 3 . 1 4 BCC CR 
 

Receive % P W $ S Y S : R E G 0 BCC CR 
 

When writing two of data (such as maximum value and 
minimum value) 

Send % P W P  Parameter = Data 1 , Data 2 BCC CR 
Data 1, Data 2: Data to be written 

 

Receive % P W P $ Parameter BCC CR 
 

 Error (ERROR signal = ON) 

% P W P ! Error code (3-digit) BCC CR 
 

Example: Writes a maximum value of “100” and a minimum value of “50” in Numerical Calculation 
No.10. CACnnn:LPAIR 

Parameter for changing the maximum and minimum values in Numerical Calculation 
"CACnnn:LPAIR" 

Send 
 

% P W P C A C 0 1 0 : L P A I R    
                   

          = 5 0 , 1 0 0 BCC CR 

           Minimum  Maximum   

Receive 

% P W P $ C A C 0 1 0 : L P A I R BCC CR 
 

Error codes for Write command 
200 Operation is stopped. 
251 Specification of the parameter is wrong. (Undefined parameter is specified.) 

252 • The specified parameter does not exist. (e.g. The number of uncreated checker is specified as a 
parameter.) 

• The specified parameter value is out of the settable range. (e.g. Maximum value of slice level is 
being set to over 256.) 

• The specified values led to the status of “Maximum value < Minimum value” when entering them. 
• (When specifying the moving distance of marker) 

A part of the circumscribing rectangle of the marker (the intersection point when Shape is Cross 
line) after move was out of the nine screens where checker area is settable.  

254 The number of write commands received by PV200 exceeds the receivable number when 
executing one inspection. 
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Details of Read out/write Command Parameter 

 
When writing maximum and minimum values in sets using %PWP command, specify maximum values in 
Data 1 and minimum values in Data 2. When reading two data in sets using %PRP command, the data is 
output in the same order. 

System values 
 Parameter Read Write Lower limit Upper limit Details 
Inspection time SYS_TIME1 Yes  0.00 9999.00 When exceeding the 

upper limit, 10000.00 is 
output. 

Inspection Cycle SYS_TIME2 Yes  0.00 9999.00 

Total Judgement SYS_RESULT Yes  0 1 0:NG  1: OK 
Scan Count SYS_COUNT Yes  0 2147483647  
Window Status SYS_EDIT Yes  0 1 0: RUN menu,  

1: SETUP menu 
Operation Status SYS_RUN Yes  0 1 0: RUN, 1: STOP 
Current Type No. SYS_TYPE Yes  0 255  
Date SYS_DATE Yes Yes   YYYY/MM/DD 

(4-digit of year/ 2-digit 
of Month/ 2-digit of 
Day) 

Time SYS_TIME Yes Yes   HH:MM:SS 
(2-digit of Hour:  
2-dgit of Minute:  
2-digit of Second) 

System Register 0 
to System Register 
7 

SYS:REG0 – 
SYS:REG7 

Yes Yes -9999999.999 9999999.999 Up to 3-digit is 
available after decimal 
point. 

Checker 
The symbol of “nnn” shown in parameters is a checker number (000 - 999). 

Line Parameter Read Write Lower limit Upper limit 
Max. No. of Pixels. LICnnn:DMAX Yes Yes 0 125938 
Min. No. of Pixels. LICnnn:DMIN Yes Yes 0 125938 
Max. and Min. No. of Pixels. LICnnn:DPAIR Yes Yes 0 125938 
Max. No. of Objects LICnnn:LMAX Yes Yes 0 41979 
Min. No. of Objects LICnnn:LMIN Yes Yes 0 41979 
Max. and Min. No. of Objects LICnnn:LPAIR Yes Yes 0  41979 
Binary Window Parameter Read Write Lower limit Upper limit 
OK Judge. Max. BWCnnn:MAX Yes Yes 0 4194304 
OK Judge. Min. BWCnnn:MIN Yes Yes 0 4194304 
OK Judge. Max.and Min. BWCnnn:LPAIR Yes Yes 0 4194304 
Gray Window Parameter Read Write Lower limit Upper limit 
OK Judge. Max. GWCnnn:MAX Yes Yes 0 255 
OK Judge. Min. GWCnnn:MIN Yes Yes 0 255 
OK Judge. Max and Min. GWCnnn:LPAIR Yes Yes 0 255 
Binary Edge Parameter Read Write Lower limit Upper limit 
OK Judge. Max. BECnnn:MAX Yes Yes 0 256 
OK Judge. Min. BECnnn:MIN Yes Yes 0 256 
OK Judge. Max and Min. BECnnn:LPAIR Yes Yes 0 256 
Gray Edge Parameter Read Write Lower limit Upper limit 
Edge Threshold GECnnn:LVL Yes Yes 1  255 
OK Judge. Max. GECnnn:MAX Yes Yes 0 256 
OK Judge. Min. GECnnn:MIN Yes Yes 0 256 
OK Judge. Max and Min. GECnnn:LPAIR Yes Yes 0 256 
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Feature Extraction Parameter Read Write Lower limit Upper limit 
OK Judge. Max. FECnnn:MAX Yes Yes 0 10000 
OK Judge. Min. FECnnn:MIN Yes Yes 0 10000 
OK Judge. Max and Min. FECnnn:LPAIR Yes Yes 0 10000 
Smart Matching Parameter Read Write Lower limit Upper limit 
Search Count 1st step SMCnnn:CNT.1 Yes Yes 1  256  
Search Count 2nd step SMCnnn:CNT.2 Yes Yes 1  256  
Search Count 3rd step SMCnnn:CNT.3 Yes Yes 1  256  
Search Count 4th step SMCnnn:CNT.4 Yes Yes 1  256  
Search Count 5th step SMCnnn:CNT.5 Yes Yes 1  256  
Search Count 6th step SMCnnn:CNT.6 Yes Yes 1  256  
Max. OK No. of Subtracted 
Objects 

SMCnnn:DCNTMAX Yes Yes 0 128  

Flaw Detection Parameter Read Write Lower limit Upper limit 
OK Judge. Max. FWCnnn:MAX Yes Yes 0 512 
OK Judge. Min. FWCnnn:MIN Yes Yes 0 512 
OK Judge. Max and Min. FWCnnn:LPAIR Yes Yes 0 512 
Connector  
(Binary Window) 

Parameter Read Write Lower limit Upper limit 

Common Judge. Max. CBWnnn:CMAX Yes Yes 0 62500  
Common Judge. Min. CBWnnn:CMIN Yes Yes 0 62500  
Common Judge. Max. and 
Min. 

CBWnnn:CPAIR Yes Yes 0 62500  

Individual Judge. Max. *1) CBWnnn:MAX.ss Yes Yes 0 62500  
Individual Judge. Min. *1) CBWnnn:MIN.ss Yes Yes 0 62500  
Individual Judge. Max. and 
Min. *1) 

CBWnnn:LPAIR.ss Yes Yes 0 62500  

Connector  
(Gray Window) 

Parameter Read Write Lower limit Upper limit 

Common Judge. Max. CGWnnn:CMAX Yes Yes 0 255 
Common Judge. Min. CGWnnn:CMIN Yes Yes 0 255 
Common Judge. Max. and 
Min. 

CGWnnn:CPAIR Yes Yes 0 255 

Individual Judge. Max. *1) CGWnnn:MAX.ss Yes Yes 0 255 
Individual Judge. Min. *1) CGWnnn:MIN.ss Yes Yes 0 255 
Individual Judge. Max. and 
Min. *1) 

CGWnnn:LPAIR.ss Yes Yes 0 255 

Connector  
(Gray Edge) 

Parameter Read Write Lower limit Upper limit 

Max. Judge. Pitch CGEnnn:PMAX Yes Yes 0 99999999.999 
Min. Judge. Pitch CGEnnn:PMIN Yes Yes 0 99999999.999 
Max. and Min. Judgement 
Pitch 

CGEnnn:PPAIR Yes Yes 0 99999999.999 

Max. Distance Difference 
Judgement 

CGEnnn:UMAX Yes Yes 0 99999999.999 

Min. Distance Difference 
Judgement 

CGEnnn:UMIN Yes Yes 0 99999999.999 

Max. and Min. Distance 
Difference Judgement 

CGEnnn:UPAIR Yes Yes 0 99999999.999 

*1) "ss" in the parameters of Individual Judgement is cell numbers. 
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Smart Edge (Circle) Parameter Read Write Lower limit Upper limit 
Max. Measurement *1) SECnnn:LMAX Yes Yes 0 99999999.999 
Min. Measurement *1) SECnnn:LMIN Yes Yes 0 99999999.999 
Max. and Min. Measurement 
*1) 

SECnnn:LPAIR Yes Yes 0 99999999.999 

Max. Standard Deviation SECnnn:SMAX Yes Yes 0 99999999.999 
Min. Standard Deviation SECnnn:SMIN Yes Yes 0 99999999.999 
Max. and Min. Standard 
Deviation 

SECnnn:SPAIR Yes Yes 0 99999999.999 

Max. Circularity SECnnn:CMAX Yes Yes 0 99999999.999 
Min. Circularity SECnnn:CMIN Yes Yes 0 99999999.999 
Max. and Min. Circularity SECnnn:CPAIR Yes Yes 0 99999999.999 
Max. Unused Edge Count SECnnn:NMAX Yes Yes 0 3597 
Smart Edge (Line) Parameter Read Write Lower limit Upper limit 
Max. Measurement *2) SELnnn:LMAX Yes Yes -99999999.999 99999999.999 
Min. Measurement *2) SELnnn:LMIN Yes Yes -99999999.999 99999999.999 
Max. and Min. Measurement 
*2) 

SELnnn:LPAIR Yes Yes -99999999.999 99999999.999 

Max. Standard Deviation SELnnn:SMAX Yes Yes 0 99999999.999 
Min. Standard Deviation SELnnn:SMIN Yes Yes 0 99999999.999 
Max. and Min. Standard 
Deviation 

SELnnn:SPAIR Yes Yes 0 99999999.999 

Max. Linearity SELnnn:LIMAX Yes Yes 0 99999999.999 
Min. Linearity SELnnn:LIMIN Yes Yes 0 99999999.999 
Max. and Min. Linearity SELnnn:LIPAIR Yes Yes 0 99999999.999 
Max. Unused Edge Count SELnnn:NMAX Yes Yes 0 2998 
Color Window Parameter Read Write Lower limit Upper limit 
R Gray Max. CWCnnn:RMAX Yes Yes 0 255 
R Gray Min.  CWCnnn:RMIN Yes Yes 0 255 
R Gray Max. and Min. CWCnnn:RPAIR Yes Yes 0 255 
R Gray Ave. Max. CWCnnn:RAMAX Yes Yes 0 255 
R Gray Ave. Min.  CWCnnn:RAMIN Yes Yes 0 255 
R Gray Ave. Max. and Min. CWCnnn:RAPAIR Yes Yes 0 255 
R Gray Std. Devi. Max. CWCnnn:RSMAX Yes Yes 0.000 127.500 
R Gray Std. Devi. Min.  CWCnnn:RSMIN Yes Yes 0.000 127.500 
R Gray Std. Devi. Max. and 
Min. 

CWCnnn:RSPAIR Yes Yes 0.000 127.500 

G Gray Max. CWCnnn:GMAX Yes Yes 0 255 
G Gray Min.  CWCnnn:GMIN Yes Yes 0 255 
G Gray Max. and Min. CWCnnn:GPAIR Yes Yes 0 255 
G Gray Ave. Max. CWCnnn:GAMAX Yes Yes 0 255 
G Gray Ave. Min.  CWCnnn:GAMIN Yes Yes 0 255 
G Gray Ave. Max. and Min. CWCnnn:GAPAIR Yes Yes 0 255 
G Gray Std. Devi. Max. CWCnnn:GSMAX Yes Yes 0.000 127.500 
G Gray Std. Devi. Min.  CWCnnn:GSMIN Yes Yes 0.000 127.500 
G Gray Std. Devi. Max. and 
Min. 

CWCnnn:GSPAIR Yes Yes 0.000 127.500 

B Gray Max. CWCnnn:BMAX Yes Yes 0 255 
B Gray Min.  CWCnnn:BMIN Yes Yes 0 255 
B Gray Max. and Min. CWCnnn:BPAIR Yes Yes 0 255 
B Gray Ave. Max. CWCnnn:BAMAX Yes Yes 0 255 
B Gray Ave. Min.  CWCnnn:BAMIN Yes Yes 0 255 
B Gray Ave. Max. and Min. CWCnnn:BAPAIR Yes Yes 0 255 
B Gray Std. Devi. Max. CWCnnn:BSMAX Yes Yes 0.000 127.500 
B Gray Std. Devi. Min.  CWCnnn:BSMIN Yes Yes 0.000 127.500 
B Gray Std. Devi. Max. and 
Min. 

CWCnnn:BSPAIR Yes Yes 0.000 127.500 

*1) "Measurement": Radius, Width or Diameter (Determined by the selection of "Detect Mode".) 
*2) "Measurement": Deviation, Distance or Width (Determined by the selection of "Detect Mode".) 
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Geometry Calculation 
Geometry Calculation Parameter Read Write Lower limit Upper limit 
Max. X Coord. 
(IP X, Center X) 

GGCnnn:XMAX Yes Yes -99999999.999 99999999.999 

Min. X Coord. 
(IP X, Center X) 

GGCnnn:XMIN Yes Yes -99999999.999 99999999.999 

Max. and Min. X Coord.(IP X, 
Center X) 

GGCnnn:XPAIR Yes Yes -99999999.999 99999999.999 

Max. Y Coord. 
(IP Y, Center Y) 

GGCnnn:YMAX Yes Yes -99999999.999 99999999.999 

Min. Y Coord. 
(IP Y, Center Y) 

GGCnnn:YMIN Yes Yes -99999999.999 99999999.999 

Max. and Min. Y Coord.(IP Y, 
Center Y) 

GGCnnn:YPAIR Yes Yes -99999999.999 99999999.999 

Max. Standard Deviation GGCnnn:SMAX Yes Yes 0 99999999.999 
Min. Standard Deviation GGCnnn:SMIN Yes Yes 0 99999999.999 
Max. and Min. Standard 
Deviation 

GGCnnn:SPAIR Yes Yes 0 99999999.999 

Max. Angle (Line Angle, Pedal 
Angle, Major Axis Angle) 

GGCnnn:AMAX Yes Yes -99999999.999 99999999.999 

Min. Angle (Line Angle, Pedal 
Angle, Major Axis Angle) 

GGCnnn:AMIN Yes Yes -99999999.999 99999999.999 

Max. and Min. Angle (Line 
Angle, Pedal Angle, Major Axis 
Angle) 

GGCnnn:APAIR Yes Yes -99999999.999 99999999.999 

Max. Distance GGCnnn:DMAX Yes Yes 0 99999999.999 
Min. Distance GGCnnn:DMIN Yes Yes 0 99999999.999 
Max. and Min. Distance GGCnnn:DPAIR Yes Yes 0 99999999.999 
Max. Intersecting Angle GGCnnn:CAMAX Yes Yes 0 360.000 
Min. Intersecting Angle GGCnnn:CAMIN Yes Yes 0 360.000 
Max. and Min. Intersecting 
Angle 

GGCnnn:CAPAIR Yes Yes 0 360.000 

Max. Radius GGCnnn:RMAX Yes Yes 0 99999999.999 
Min. Radius GGCnnn:RMIN Yes Yes 0 99999999.999 
Max. and Min. Radius GGCnnn:RPAIR Yes Yes 0 99999999.999 
Max. Major Axis GGCnnn:LAMAX Yes Yes 0 99999999.999 
Min. Major Axis GGCnnn:LAMIN Yes Yes 0 99999999.999 
Max. and Min. Major Axis GGCnnn:LAPAIR Yes Yes 0 99999999.999 
Max. Minor Axis GGCnnn:SAMAX Yes Yes 0 99999999.999 
Min. Minor Axis GGCnnn:SAMIN Yes Yes 0 99999999.999 
Max. and Min. Minor Axis GGCnnn:SAPAIR Yes Yes 0 99999999.999 

Slice Level 
The symbol of “?” shown in parameters is a slice level group (Camera 0: A - Z, Camera 1: Not supported) 

 Parameter Read Write Lower limit Upper limit 
Max. Slice Level BLV:H? Yes Yes 0 255 

Min. Slice Level BLV:L? Yes Yes 0 255 

Max. and Min. Slice Level BLV:PAIR? Yes Yes 0 255 

Numerical calculation 
The symbol of “nnn” shown in parameters is a numerical calculation number (000 - 999). 

 Parameter Read Write Lower limit Upper limit 
Max. Judgement CACnnn:MAX Yes Yes -2147483648 2147483647 

Min. Judgement CACnnn:MIN Yes Yes -2147483648 2147483647 

Judge. Max. and Min. CACnnn:LPAIR Yes Yes -2147483648 2147483647 
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Marker 
As the marker position should be read/write with a set of X and Y coordinates, use "%PRP" command or 
"%PWP" command. 

Coordinate values to be read is in units of 0.5 pixels, and the moving distance to be written is in pixel. It is not 
possible to read or write with the values after calibration. 

"c" of "MRKcg" in the parameters is camera numbers (0-1), and "g" is marker numbers (0-7). 
 Parameter Read Write Lower 

limit 
Upper 
limit 

Details 

Central Coordinate 
(Read)) 

MRKcg_CXY Yes --- -2048 4095 Data 1 = X coordi. *1) 

-2048 4095 Data 2 = Y coordi. *1) 
Central Coordinate 
Moving Distance (Write) 

MRKcg:MOV
E 

--- Yes -6143 6143 Data 1 = Distance X *2) 
-6143 6143 Data 2 = Distance Y *2) 

*1) The number of digits of the coordinate values of response to the read command is as below. 
 Example 
• Positive value: Max. 6 digits 

(Integar portion: Max. 4 digits, Decimal point: 1 digit, Decimal 
portion: 1 digit) 

4 2 8 . 0 
 

• Negative value: Max. 7 digits 
(Sign: 1 digit, Integar portion: Max. 4 digits, Decimal point: 1 digit, 
Decimal portion: 1 digit) 

― 4 2 8 . 0 
 

*2) Specify values with the following number of digits to write the moving distance. 
 Example 
• Positive value: Max. 4 digits (Integar portion: Max. 4 digits) 1 0 

 

• Negative value: Max. 5 digits (Sign: 1 digit, Integar portion: Max. 
4 digits) 

― 1 2 0 0 
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11.2.6 Communication Command when A Series Compatible is set to "Yes" 
(Serial) 

"A Series Compatible" is the setting which enables the control commands used in our Micro Imagechecker 
A series to be used in the communication between PV200 and external devices. However, not all 
commands are supported. Please confirm before use. ("A Series Compatible" setting: "ENVIRONMENT" > 
"Input/Output" > "Serial) This chapter describes the commands used when "A Series Compatible" is set to 
"Yes". 

When "A Series Compatible" is set to "Yes", responses from PV200 to serial general -purpose commands 
input from external devices are displayed in the command communication log.  

 

Normally, the block check code must be added for the control with general communication commands of 
PV200 as described on page 599, however, the block check code is not added when setting "A Series 
Compatible". The table below shows the differences between A series and "A Series Compatible" setting.  

 

Differences in general communication commands between A series and "A Series Compatible" setting 
 

Description A series 
PV200 

A Series Compatible 

No Yes 

Block check code 

External device to 
Imagechecker 

Not 
required 

Required 
Not required 
Error with BCC 

Imagechecker to External 
device 

Not 
available 

Always added Not available 

Response of 
Imagechecker to 
control commands  

Commands in A series Not 
available 

Always available Not available 
except a part of 
them* 

Commands not in A series - 
Always available 
except key 
emulation 

Always available 
except key 
emulation 

Error response 

Unregistered data error %ZC
R Differs according 

to each command. 
% ZC

R 

Data code error %UC
R Differs according 

to each command. 
%UC

R 

Capture end 
command 

Imagechecker to External 
device 

%RC
R Not supported %RC

R 

Inspection end 
command 

Imagechecker to External 
device 

%EC
R Not supported %EC

R 

Checker number, Starting number of Type number 1 0 

*: There are responses to the following four commands. 
- Type switch end command (Response in normal condition %Y??CR) 
- Type data save end command (Response in normal condition:) 
- Statistics data reset command (%Q C

R) 
- Camera switch end command (%I?? C

R) 
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Differences in Commands Between A Series and 
"A Series Compatible" Setting 

The table below show the difference in commands when replacing the control commands used in A series for 
the communication between PV200 and external devices. 

ICH in the table stands for Imagechecker. For the details of each command, refer to page 628. 
 A: The same command as A series can be used. (BCC is not required, no response.) 

 

Command in A210 Data send 
direction Item Command 

in PV200 Remarks 

%S C
R  

External 
device to 
ICH 

Execute All / Automatic Switch 
Inspection start command A  

%P C
R

 
 

External 
device to 
ICH 

Execute All / Automatic Switch 
Inspection start command (Executes 
numerical calculation for specific 
assignment) 

A 
PV200 is not equipped 
with specific 
assignment function. 

%R C
R

 
 

External 
device to 
ICH 

Execute All / Automatic Switch 
Reinspection command A  

%S? C
R  (?=1-3) 

External 
device to 
ICH 

User Defined (Specified block) 
Inspection start command A(?=0-9)  

%P? C
R (?=1-3) 

External 
device to 
ICH 

User Defined (Specified block) 
Inspection start command (Executes 
numerical calculation for specific 
assignment) 

A(?=0-9) 
PV200 is not equipped 
with specific 
assignment function. 

%R? C
R (?=1-3) 

External 
device to 
ICH 

User Defined, Reinspection command A(?=0-9)  

%R C
R 

ICH to 
External 
device 

Capture end command %R C
R  

%E C
R 

ICH to 
External 
device 

Inspection end command %E C
R  

%X?? C
R (??=1-64) 

External 
device to 
ICH 

Type switch command A With response (%Y?? 
CR below) 

%Y?? C
R 

ICH to 
External 
device 

Type switch end command 
(Response to %X?? CR) A  

%M C
R 

External 
device to 
ICH 

Setting data (Type & Environment data) 
save command A 

With response 
(%MC

R below) 

%M C
R 

ICH to 
External 
device 

Save end command A  

%L? C
R  

External 
device to 
ICH 

Slice level max./min. reference 
command N/A 

Read command of 
PV200 is used. 

%L?,[Max.][Min.] C
R 

ICH to 
External 
device 

Slice level max./min. notify command N/A  

%T?,[Max.] [Min.] C
R  

External 
device to 
ICH 

Slice level max./min. change command N/A 
Write command of 
PV200 is used. 

%T?,[Max.] [Min.] C
R   

ICH to 
External 
device 

Change end command N/A  

%K??,n C
R 

External 
device to 
ICH 

Gray Edge threshold reference 
command 

N/A Read command of 
PV200 is used. 
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Command in A210 Data send 
direction Item Command 

in PV200 Remarks 

%K??,n,[Threshold]C
R 

External 
device to 
ICH 

Gray Edge threshold notify command N/A  

%G??,[Threshold],n C
R 

External 
device to 
ICH 

Gray Edge threshold change command N/A Write command of 
PV200 is used. 

%G??,[Threshold],n C
R 

ICH to 
External 
device 

Change end command N/A  

%N??,[Max.] [Min.] C
R 

External 
device to 
ICH 

Numerical calculation max./min. change 
command A  

%N??,[Max.] [Min.] C
R 

ICH to 
External 
device 

Numerical calculation max./min. change 
end command 

A  

%F?? C
R 

External 
device to 
ICH 

Numerical calculation max./min. 
reference command A  

%F??,[Max.] [Min.]C
R 

ICH to 
External 
device 

Numerical calculation max./min. notify 
command 

A  

%I? C
R (?=0-3) 

External 
device to 
ICH 

Camera switch command A (?=0-15) Layout is switched. 

%IC
R 

ICH to 
External 
device 

Camera switch end command A  

%QC
R

 
 

External 
device to 
ICH 

Spread sheet data reset command A 
Statistics reset 
With response below 
（%Q C

R） 

%QC
R 

ICH to 
External 
device 

Spread sheet data reset response 
command 

A  

％ZC
R 

ICH to 
External 
device 

Unregistered data error command A  

％UC
R 

ICH to 
External 
device 

Data code error command A  

 

 
The following general-purpose commands for PV200 cannot be used with A Series Compatible setting. Use the 
commands for A series. 

- %MW (Saves setting data. Use the command %M for A series.) 
- %PRP CACnnn: LPAIR (Reads Numerical Calculation Max. and MIn.. Use the command %F?? for A 

series.) 
- %PWP CACnnn: LPAIR=[Min.],[Max.] (Writes Numerical Calculation Max. and Min.. Use the 

command %N?? for A series.) 
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List of commands unique to PV200 
The followings are the commands unique to PV200, which are not available for A series.  

For the details of each command, refer to 11.2.5 “Details of Commands”. It is not necessary to add the 
block check code for using these commands. Also, the block check code is not added to the responses 
from PV200 to external devices. 

 
Description  Command 

Save setting data SD memory card %CW 

Read setting 
data 

SD memory card %CR 

Abort save/read setting data (Cancel) %CD 

Save image 
memory 

Save (SD memory card) %SS 

Clear %SR 

Print screen %PS 

Switch between Run/Stop %RM 

Reset error signal %E 

Cancel inspection/ process (Cancel various 
operations) 

%CC 

Key emulation %K 

Keypad 
Operation 

Invalid/Valid %BS 

Confirm status %BC 

Set template %A 

Set template for Contour Matching %B 

Parameter Read %PR 

 Read pairs (such as max. 
and min. values) 

%PRP 

 Change %PW 

 Change pairs 
(such as max. and min. 
values) 

%PWP 
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11.2.7 Details of Commands Available for A Series Compatible 

This section describes the commands used in A series and the commands used for "A Series Compatible" in 
PV200. 
“SEND” described in this chapter indicates the commands given from external devices to PV200. On the other 
hand, “Receive” indicates the responses for the sent commands from PV200 to external devices. 

Inspection start 
(A Series Compatible) 

When using common trigger in “Execute All” or “Automatic 
Switch” execution mode 

Send A series % S CR 
 

 PV200 % S CR 
 

Receive None  

    

Send A series 
 

% P CR Execute Numerical Calculation for specific assignment 

 PV200 % P CR 
 

PV200 is not equipped with "specific assignment" function. 
When this command is sent, the same operation is 
performed as the case of the above %S. 

Receive None 

 
 When setting "ENVIRONMENT" > "Input/Output" > "Serial" > "Capture End" to "Output", %R CR will 

be output after the completion of image capture. 

 When setting "ENVIRONMENT" > "Input/Output" > "Serial" > "Inspection End" to "Output", %E CR 
will be output after the execution of an inspection. 

When using common trigger in “Use-Defined” execution 
mode 

Send A series % S ? CR 
 

? = 1 – 3 (Block No. to execute) 

 PV200 % S ? CR 
 

? = 0 – 9 (Block No. to execute) 

Receive Normal: None 

Abnormal: Receives error code. 

  % U CR 
 

Other number than 0-9 was specified for block number. 

    

Send A series 
 

% P ? CR ? = 1 – 3 (Block No. to execute) 
Execute Numerical Calculation for specific assignment 

 PV200 % P ? CR 
 

? = 0 – 9 (Block No. to execute) 
PV200 is not equipped with "specific assignment" function. 
When this command is sent, the same operation is 
performed as the case of the above %S. 

Receive Normal: None 
Abnormal: Receives error code. 

  % U CR 
 

Other number than 0-9 was specified for block number. 
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 When setting "ENVIRONMENT" > "Input/Output" > "Serial" > "Capture End" to "Output", %R CR will 
be output after the completion of image capture. 

 When setting "ENVIRONMENT" > "Input/Output" > "Serial" > "Inspection End" to "Output", %E CR 
will be output after the execution of an inspection. 

Inspection (Executes inspection without capturing 
an image) 
(A Series Compatible) 

For “Execute All” or “Automatic Switch” execution mode 

Send A series % R CR 
 

 

 PV200 % R CR 
 

 

Receive None  

 
 When setting "ENVIRONMENT" > "Input/Output" > "Serial" > "Inspection End" to "Output", %E CR 

will be output after the execution of an reinspection. 

For “User-Defined” execution mode 

Send A series % R ? CR 
 

? = 1 – 3 (Block No. to execute) 

 PV200 % R ? CR 
 

? = 0 – 9 (Block No. to execute) 

Receive Normal: None 

 Abnormal: Receives error code. 

  % U CR 
 

Other number than 0-9 was specified for block number. 

 
 When setting "ENVIRONMENT" > "Input/Output" > "Serial" > "Inspection End" to "Output", %E CR 

will be output after the execution of an reinspection.  

Switch Type 
(A Series Compatible) 
 

Send A series  % X ? ? CR 
 

?? = 1 – 64 (Type No.) 

 PV200 
(Can be sent in 
two ways.) 

(1) % X ? ? CR 
 

?? = 00 – 99 (Type No.) 

 (2) % X ? ? ? CR 
 

?? = 000 – 255 (Type No.) 

Receive It varies depending on the way of transmission. 

 
Switched with 
the above (1): % Y ? ? CR 

 

 
Switched with 
the above (2): % Y ? ? ? CR 

 

 Abnormal: Receives error code. (The specified type number is an unregistered type.) 

  % Z CR 
 

The specified type number does not exist. 

  % U CR 
 

Other number than 000-255 was specified for type number. 
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Save Setting Data 
(A Series Compatible) 
 

Send A series % M CR 
 

 

 PV200 % M CR 
 

 

Receive  % M CR 
 

 

Read Slice Level 
(A Series Compatible) 
The same command (%L) as A series is not provided. Use the read command for parameters. 

Send A series % L ? CR 
 

 

 PV200 % P R P  B L V c : P A I R ?  CR 
 

c: Camera No. 
?: A-P 

Receive 
In normal 
state % P R P $ B L V c : P A I R ?  = Min. , Max. CR 

 

 

Write Slice Level 
(A Series Compatible) 
The same command (%T) as A series is not provided. Use the write command for parameters. 

Send A series % T ? ? ? ? ? CR 
 

 

 PV200 % P W P $ B L V c : P A I R ?  = Min. , Max. CR 
 

  c: Camera No., ?: A-P 

Receive 
In normal 
state % P W P $ B L V c : P A I R ?  CR 

 

 

 
 

Read Gray Edge Threshold 
(A Series Compatible) 
The same command (%K) as A series is not provided. Use the read command for parameters. 
The edge threshold to be read in PV200 is that has been set in "Checker" > "Gray Edge".  "Edge Thresholds" 
for the base checkers set in Position Adjustment or Area Size Adjustment are not read.  

Send A series % K ? ? , n CR 
 

??: Gray Edge Checker No., n: Type 

 PV200 % P R  G E C n n n : L V L CR 
 

  nnn: Checker No. 

Receive 
In normal 
state % P R $ G E C n n n : L V L = Threshold CR 
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Write Gray Edge Threshold 
(A Series Compatible) 
The same command (%G) as A series is not provided. Use the write command for parameters. 
The edge threshold to be written in PV200 is that has been set in "Checker" > "Gray Edge".  "Edge 
Thresholds" for the base checkers set in Position Adjustment or Area Size Adjustment are not read.  
 

Send A series % G ? ? , Threshold , n CR 
 

??: Gray Edge Checker No., n: 
Type 

 PV200 % P W  G E C n n n : L V L = Threshold CR 
 

  nnn: Checker No. 

Receive 
In normal 
state % P W $ G E C n n n : L V L CR 

 

 

Read Maximum and Minimum Values in Numerical 
Calculation 
(A Series Compatible) 
The maximum and minimum values to be read with A Series Compatible setting in Numerical Calculation are 
integers. The number of decimals is not read. 

Send A series  % F ? ? CR 
 

?? = 00–96 (Numerical Calculation No.) 

 PV200 
(Can be 
sent in two 
ways.) 

(1) % F ? ? CR 
 

?? = 00–99 (Numerical Calculation No.) 

 (2) % F ? ? ? CR 
 

??? = 000–999 (Numerical Calculation No.) 

Receive 
In normal 
state It varies depending on the way of transmission. 

  (1) % F ? ? , Min. , Max. CR 
 

?? = 00–99 (Numerical 
Calculation No.) 

  (2) % F ? ? ? , Min. , Max. CR 
 

??? = 000–999 (Numerical 
Calculation No.) 

 Abnormal: Receives error code. 

   % Z CR 
 

No operation expression has been registered in the 
specified Numerical Calculation number. 

   % U CR 
 

Other number than 000-999 was specified for numerical 
calculation number. 
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Write Maximum and Minimum Values in Numerical 
Calculation 
(A Series Compatible) 
Only integers can be written as the maximum and minimum values in Numerical Calculation with A Series 
Compatible setting. The number of decimals cannot be written. 

Send A series  % N ? ? , Min. , Max. CR 
 

   ??:Numerical Calculation No. 

 
PV200 
(Can be sent 
in two ways.) 

(1) % N ? ? , Min. , Max. CR 
 

?? = 00–99 (Numerical 
Calculation No) 

 (2) % N ? ? ? , Min. , Max. CR 
 

???=000–999 (Numerical 
Calculation No.) 

Receive In normal state It varies depending on the way of transmission. 

 
Written with the 
above (1): % N ? ? , Min. , Max. CR 

 

 
Written with the 
above (2): % N ? ? ? , Min. , Max. CR 

 

 Abnormal: Receives error code. 

  % Z CR 
 

No operation expression has been registered in the specified 
Numerical Calculation number. 

  % U CR 
 

Other number than 000-999 was specified for numerical 
calculation number. 

 

Switch Image Displayed on Monitor (Switch Layout) 
(A Series Compatible) 
 

Send A series  % I ? CR 
 

? = 0-3 Specify Image 

 PV200 
(Can be sent in 
two ways.) 

(1) % I ? CR 
 

?? = 0 – 9  (Layout No.) 

 (2) % I ? ? CR 
 

?? = 00 – 15 (Layout No.) 

Receive In normal state % I CR 
 

 Abnormal: Receives error code. 

  % Z CR 
 

・Unregistered number was specified. 
・Other number than 00-15 is specified for layout number. 

 
Four types of patterns (%I0CR; Camera A (Live), %I1CR; Camera B (Live), %I2CR; Camera A (Memory), 
and %I1CR; Camera B (Memory)) are set for %I (Camera switch command) in A series, however, the display 
patterns switched with the %I command of PV200 are not fixed like A series. These display patterns are 
called layouts in PV200. The default layouts number 0 to 3 in PV200 are not the same as those in A series.  
To switch displayed images like A series with this command, it is necessary to set layouts and register 
images to be displayed as follows; the live image of Camera 0 in Layout No. 0, the live image of Camera 1 in 
Layout No. 1, the memory image of Camera 0 in Layout No. 2, and the memory image of Camera 1 in Layout 
No. 3. (For details, refer to each page: Layout setting and registration; 5.3.3, Layout registration, copy and 
delete; 5.3.5, Example of layout registration (Starting PV200 with memory image on screen window); 1,2 on 
page 425) A series displays only images of one of two connected cameras on the monitor, however, PV200 
can display the images of Camera 0 and Camera 1 side-by-side, or images of one camera in two patterns. 
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Reset Statistics Data 
(A Series Compatible) 
 

Send A series % Q CR 
 

 

 PV200 % Q CR 
 

 

Receive None % Q CR 
 

 

 



 

628 

C
ontrol w

ith C
om

m
unication P

ort 
C

h. 11 

11.3 PLC Communication 

11.3.1 Overview and Communication Specifications 

This method communicates with a PLC according to the protocol of the destination PLC. Either RS-232C 
interface or Ethernet interface can be used. (Refer to 11.1.3 Protocol for details.) 
The following communications are available with PV200. 

・General output  

When accepting an inspection start signal (parallel input including reinspection signal, control command by 
communication or TRIG input by keypad) in RUN menu, after the inspection, the inspection results that are set 
to be output (Date and Time, Scan count, Total judgement, Judgement, Numerical calculation) are written to a 
specified register of PLC as the beginning. Only integers can be written. The PLC does not need a 
communication program to receive data. For the information of the settings to use this function, refer to "PLC 
Communication Common Setting" (page 632) and "PLC Communication (General) Output Setting" (page 633). 
For the procedure of result output, refer to "11.3.3 Outputting Data through PLC Communication " (page 638).  

A function to resend general output is not available. 

 

・Control command  

Using this function enables to control PV200, read and change the setting values. Only integers can be read 
and changed. For the information of the settings to use this function, refer to "PLC Communication Common 
Setting" (page 632) and "PLC Communication Control Command Setting" (page 634). For the timing of sending 
and receiving commands between PV200 and PLC, refer to "11.3.4 Controlling PV200 through PLC 
Communication” (page 643) 

For the details of the control and commands to be used, refer to "11.3.5 List of Commands for PLC 
Communication". 

PV200 can accept all the general communication commands described in Chapter 11.2.5 even when PLC 
communication is selected. 

Usable PLCs for PLC Communication 
The following list shows the PLC models available for PLC communication via a RS232C or Ethernet 
interface. 

 

*1) TOOL port, COM port, FP2-MCU (RS232C communication block), FP2-CCU 
*2) Applicable unit: FP-X COM5 communication cassette, FP Web Server 2 unit 
*3) Applicable unit: CPU with a built-in Ethernet, Ethernet unit (QJ71E71-100) only 
*4)For using FX or FX-2N series, it is recommended to use the settings of A/FX series. 

 
 When Baud Rate is "115200 bps", the communication via RS232C interface may not be carried out 

stably in accordance with PLC to communicate with. In the case, set Baud Rate to "57600 bps" or lower. 

 PLC communication via Ethernet interface is performed with UDP/IP. 

Manufacturer Model (series) name RS232C Ethernet 
Panasonic Industrial Devices 
SUNX Co., Ltd. 

FP series Available *1) Available *2) 

FP2 ET-LAN unit  Available 

Mitsubishi Electric Corporation 
(MELSEC) 

A /FX series Available  

Q series Available Available *3) 

FX series(older ver.)  
(FX1N)*4) 

Available  

FX-2N series(older ver.)  
(FX2N, FX3U, FX3UC)*4) 

Available  

OMRON Corporation C series, CV series, CS1 series Available  

Allen-Bradley SLC500 Available  

Fuji Electric FA Components & 
Systems Co., Ltd. 

MICREX-SX SPH series Available  
 

Yokogawa Electric Corporation FA-M3/e-RT3  Available 

(Standard) MODBUS RTU  Available  
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Specifications of PLCs 

 
In accordance with specification of PLCs, some of the registers in "Usable range" of "Usable device" listed 
below could not be used. Please confirm the specifications of PLC before use. 

Panasonic: FP / Panasonic: FP(ET-LAN unit) 

 Protocol: MEWTOCOL 

 Usable 
device 

Data output/ Type switch DT 

Data output completion notice Register* WR 

 Bit 0-15 (0-F) 

 Control command Control Register WR 

  Command Input/Output Register DT 

 Sum check: Yes (type: BCC) 

Mitsubishi: MELSEC-Q 

 Protocol: 
- RS232C interface: “Format 4”, 4C frame compatible for QnA 
- Ethernet interface: 3E frame compatible for QnA 

CPU with a built-in Ethernet port, Ethernet unit (Applicable unit: QJ71E71-100 only) 

 Usable 
device 

Data output/ Type switch D 

Data output completion notice Register* M 

 Bit Invalid 

 Control command Control Register M ("Specified value" is command start 
bit, "Specified value +16" is processing 
bit and "Specified value +17" is error bit.) 

  Command 
Input/Output Register 

D 

 Make the following setting with PLC. 
When using RS-232C Interface 
- Sum check: Yes (type: BCC) 
- Write at RUN time: "Enable" 

When using Ethernet interface 
- Communication data code: Binary code communication  
- Initial timing setting: Always wait for OPEN 
- Send frame setting: Ethernet(V2.0) 
- Write at RUN time: "Enable" 

Mitsubishi: MELSEC-A/FX 

 Protocol: “Format 4”, 1C frame compatible for A 

 Usable 
device 

Data output/ Type switch D 

Data output completion notice Register* M 

 Bit Invalid 

 Control command Control Register M ("Specified value" is command start 
bit, "Specified value +16" is processing 
bit and "Specified value +17" is error bit.) 

  Command 
Input/Output Register 

D 

 Make the following setting with PLC. 
- Sum check: Yes (type: BCC) 
- Modification in RUN mode: Available 
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Mitsubishi: MELSEC-FX (older ver.)  

 For using FX-series, it is recommended to set PLC type to "Mitsubishi: MELSEC-A/FX". 

 CPU: FX1N, Communication adapter: FX1N-232-BD 

 Protocol: Special protocol for FX1N 
Register for specifying communication format: Store "0" in D8120. (Reboot the PLC after the setting.) 

 Usable 
device 

Data output/ Type switch D 

Data output completion notice Register* M 

 Bit Invalid 

 Control command Control Register M ("Specified value x16" is 
command start bit, "Specified 
value x16 +16" is processing bit 
and "Specified value x16 +17" is 
error bit.) 

  Command 
Input/Output 
Register 

D 

 Sum check: Yes 
With PLC, you cannot select to perform sum check. Automatically “Yes” is selected. 

Mitsubishi: MELSEC-FX-2N (older ver.) 

 For using FX-2N series, it is recommended to set PLC type to "Mitsubishi: MELSEC-A/FX". 

 CPU: FX2N, FX3U, FX3UC 
Communication adapter: FX2N-232-BD, FX3U-232-BD, FX3U-232-ADP 

 Protocol: Special protocol for FX2N 
Register for specifying communication format: Store "0" in D8120. (Reboot the PLC after the setting.) 

 Usable 
device 

Data output/ Type switch D 

Data output completion notice Register* M 

 Bit Invalid 

 Control command Control Register M ("Specified value x16" is 
command start bit, "Specified 
value x16 +16" is processing bit 
and "Specified value x16 +17" is 
error bit.) 

  Command 
Input/Output 
Register 

D 

 Sum check: Yes 
With PLC, you cannot select to perform sum check. Automatically “Yes” is selected. 

C, CV, and CS1 series by OMRON Corporation 

 Protocol: Host link 

 Usable 
device 

Data output/ Type switch D / DM 

Data output completion notice Register* CIO / IR 

 Bit 0-15 (0-F) 

 Control command Control Register CIO / IR 

  Command Input/Output Register D / DM 

 

 Make the following setting with PLC. 
- Sum check: Yes 
- Station No.: "0" 

 Communication is not available when PLC is in "Run" mode. Change to "Monitor" mode to 
communicate. 
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SLC series by Allen-Bradley 

 Usable 
device 

Data output/ Type switch N7 (Only integer registers) 

Data output completion notice Register* N7 (Only integer registers) 

 Bit 0-15 (0-F) 

 Control command Control Register N7 (Only integer registers) 

  Command Input/Output Register N7 (Only integer registers) 

 Make the following setting with PLC. 
- Duplicate Detect: OFF 
- ACK Timeout (*20 ms): 20 
- Control Line: NO HANDSHAKING 
- Error Detect: CRC 
- NAK Retries: 3 
- ENQ Retries: 0 
- Embedded Responses: AUTO DETECT 

MICREX-SX (SPH series) by Fuji Electric FA Components & 
Systems Co., Ltd. 

 Usable device 

 Usable 
device 

Data output/ Type switch %MW3 

Data output completion notice Register* %MW3 

 Bit 0-15 (0-F) 

 Control command Control Register %MW3 

  Command Input/Output Register %MW3 

 Sum check: Yes (type: BCC, the calculation method developed by Fuji is used.) 

FA-M3/e-RT3 by Yokogawa Electric Corporation  
Protocol: UDP/IP Host link 

 Usable device 

 Usable 
device 

Data output/ Type switch D 

Data output completion notice Register* I (Specify 1 or more.) 

 Bit 0 (Fixed) 

 Control command Control Register I (Specify 1 or more.) 

  Command Input/Output Register D 

 The port number of PLC should be the same as the setting of PV200. (Select 12289 or 12291.) 

 Binary is supported for transmission code. 

 Specify the CPU number of a connected PLC in PV200. 
 

MODBUS RTU 

 Usable 
device 

Data output/ Type switch Holding register 

 Data output completion notice Bit Coil 

 Control command Control Register Coil 

  Command Input/Output Register Holding register 
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11.3.2 Setting PLC Communication 

In PLC communication, commands and results are sent and received using the registers of a PLC to 
communicate. More than one register area is used for each function. Set register areas as the figure below. 

Relation between setting items and PLC registers  

 

PLC Communication Common Setting 
This is the common setting for sending and receiving result output and control commands.  

1. Select ”ENVIRONMENT” > “Input/Output” > “PLC Communication” from the menu bar. 

2. Select a communication port in "Communication 
Type". 
Select "PLC Type". 

Serial Communicates with RS-232C 
interface. 
Refer to page 635 for the detailed 
setting. 

  

Ethernet Communicates with Ethernet 
interface. 
Refer to page 636 for the detailed 
setting. 

  

 
Selectable PLC types differ depending on the 
communication type. 
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3. Set time for “Timeout (ms)”.  

20 – 20000 msec  (default: 5000) 
 

 
When PV200 writes data in the specified address of 
PLC, it sends and receives commands and response 
messages in the dedicated protocol between PV200 
and PLC. The value set here is Timeout in the message 
communication in this case. 
If PLC sends no response in the time of Timeout, a 
timeout error occurs. 

4. Set "No. of Error Retries". 
0 – 255  (Default: 0)  

5. According to the function to be used, set "Result 
Output" or "Communication Command". 

 

 

PLC Communication (General) Output Setting 

1. Make PLC communication common settings. Refer to page 632. 

2. Select “ENVIRONMENT” > “Input/Output” > “PLC Communication” > “Result Output” from the menu 
bar.  

 

3. In “Data Output Register”, specify the first 
register number of the PLC that PV200 outputs 
data into. 

0 to 99999 are available. 
 

 
Not all addresses 0 to 99999 can be used in 
destination PLC. As the address allowed to be 
written by the external device (PV200) varies 
depending on PLC, please make sure the address 
with the instruction manual of PLC. 
The number of data registers differ depending on 
the number of data to be output and "Bit Width". Be 
sure to set address number not to destroy the 
contents of registers used for other applications. 

 

 

4. Select 16-bit or 32-bit to output Scan count and Numerical calculation data in “Bit Width” 
according to the maximum value of the data to be output. 

When output data exceeds the value which can be output in the selected Bit Width, "0" is output.  

5. To notice to PLC that data output is complete, set “Data Output Completion Notice” to “Yes”.  

Specify an address to make the specified bit to “1” and the bit. 
 

Register: 0 - 99999: It varies according to the PLC used. 

Bit: 0 - 15: Specifying “15” makes the highest order bit "1".  
 

 
For Mitsubishi PLC, enter interface No. to output register. (Output bit is invalid.) 

6. Select “ENVIRONMENT” > “Input/Output” > “General Output” from the menu bar. 
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7. Set "Output" to "Yes" for the selected 
communication port, and select "PLC 
communication" in Protocol. 

When the communication port is Ethernet, 
select the column of PLC communication in 
advance. For PLC communication, either 
“Serial” or “Ethernet” can be selected.. 

 
 

8. Set "Date/Time"*, "Scan Count", "Total 
Judgement", "Judgement", and 
"Numerical Calculation" to "Yes" as 
necessary. 

*When Output "Date/Time" ,set "Date/Time 
of General Output" to "Yes" under 
"ENVIRONMENT" > "System Settings" > 
"Operation". 

 

 

 

 

PLC Communication Control Command Setting 

1. Make PLC communication common settings. Refer to page 632. 

2. Select either "Polling" or "Parallel Input" in "Command 
Read Type" from "ENVIRONMENT" > "Input/Output" > "PLC 
Communication". 

Select the trigger for PV200 to start reading data from PLC.  

No Not perform command control. 

Polling:  Periodically checks whether commands are written in PLC or not, and starts reading the 
commands once the completion is confirmed. The response speed is slower than that of 
"Parallel Input". 
The time such as the time of inspection or image output gets longer because the polling 
process is performed even during the inspection. 
Set "Polling Time" and "Start Bit Off Timeout" in step 7. 
Set "Watch Dog Timer" as necessary. 

Parallel 
Input 

Starts reading commands from PLC when the signal is input to PV200 from a parallel input 
terminal (*). 
 *: Terminal among one of ASSIGN0, 1 and EXTRA 0 to 2 assigned to "PLC 
Communication Command". (Set in "ENVIRONMENT" > "Input/Output" > "Parallel I/O") 

 

3. Open the "Communication Command" menu. 

 

The display of "WR" and "DT" in the menu is different 
between PLC types. 

 
 

 

4. ”Control Register": Specify the start address of the control register to be used for sending and 
receiving the control command. 
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According to the bit information of the 
specified control register, it is used as 
the command start bit, error bit, 
processing bit or transmitting bit. 
It is used as the watch dog bit when 
using watch dog timer. 
For the information of using the control 
register, refer to "Controlling PV200 
through PLC Communication" (page 
641). 

 
Example: Control Register = 10 

5. ”Command Input Register": Specify the start register number in which PLC writes commands for 
PV200.  

There is a command which uses a maximum of twelve words. It is recommended not to use twelve 
words for other applications. 
Refer to page 649 for the details of commands. 

6. ”Command Output Register": Specify the start register number in which PV200 writes responses 
to PLC.  

There is a response which uses a maximum of nine words. It is recommended not to use nine words for 
other applications. 
Refer to page 649 for the details of responses. 

7. When "Polling" was selected in step 2, set "Polling Time (ms)" and "Start Bit Off Timeout (ms)". 

”Polling Time”  The cycle that PV200 monitors the registers of PLC. The shorter the cycle, the 
faster the response after a command is written by PLC. However, it affects the 
execution time as PV200 monitors the PLC registers during inspections. 
The actual polling frequency may be longer than the frequency set here. The 
actual polling frequency is displayed in the information area of RUN menu. 
Please check it. 

”Start Bit Off 
Timeout”  

The time until PLC turns off the command start bit after PV200 turns on the 
command processing bit. The error (E0113) occurs when the command start bit 
does not turn off within the time set here. 

8. When "Polling" was selected in step 2, set " Watch Dog Timer" and “WD Time (ms)”as necessary.  

The watch dog timer is to notify that PV200 is in the normal communication status such as no 
disconnection of the communication cable to PLC. When setting "Watch Dog Timer" to "Yes", the watch 
dog bit is overwritten during inspection. It affects the execution time or the response time to the 
command transmitted from PLC. 

No  Not activate watch dog timer. 

Yes  Activates watch dog timer. "Watch Dog Time" can be set freely, however, the 
watch dog timer is activated with a period of polling time. Actually, it is activated 
with a period of the integral multiple of polling time and a longer period of the set 
watch dog time. For information on the registers used for watch dog, refer to page 
644. 

 

 

When performing PLC communication using RS-232C Interface 
 For the information of applicable PLC types, refer to page 618. 
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1. Make PLC communication common settings. 
(Refer to page 632.) 

2. Only when selecting "Panasonic: FP" for PLC Type, set 
"Specify Station No.". 

Station Home (Default):  
A command which specifies no station number is issued. 
Example) %EE#WDD0001      

 
Specify Station No. (Station No.:1 – 99):  
A command for a PLC with the specified station number is 
issued. Specify the same number of the station number that 
is set for the PLC to communicate in "Station No.". 
Example) When Station No. is 99 %99#WDD0001     

 

 

 

When performing PLC communication using Ethernet interface 
  

Refer to page 453 for details of network settings. 

 
Applicable PLCs are three types. Refer to page 618 for details. 

1. Make PLC communication common settings. 
(Refer to page 632.) 

2. Specify the network setting of the selected "PLC 
Type".  

The network setting consists as listed below. 
- PV Station No. 
- PLC IP Address  
- PLC Port No. 
- Specify PLC Station No. 
- PLC Station No. 
- PLC CPU No. 

 
Items to be specified vary depending on the 
selected PLC type. For the detail, refer to steps 3 
to 6.. 

 

3. Specify the PV200 station No. in "PV Station No.". 

Selectable station No.: 1 – 64 
 

Set only when PLC Type is Panasonic: FP (ET-LAN unit)  

4. Assign the IP address to the PLC.  

 
When changing the connection to a PLC with the same IP address as the PLC currently connected, 
the connection may be disconnected for a maximum of five minutes.  
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5. Specify the port number of the PLC.  

Input the same number as the port number set on the PLC to communicate. 
When PLC Type is " Panasonic: FP " or " Panasonic: FP(ET-LAN unit) "  
Available port No. on PV200: 1 to 32767 (except 8600 to 8699 and 9090) 
Default: 9094 
 
When PLC Type is Mitsubishi: MELSEC-Q 
Available port No. on PV200: 1 to 65534 (except 8600 to 8699 and 9090) 
Default: 5000 
 
When PLC Type is Yokogawa: FA-M3/e-RT3 
Available port No. on PV200: 12289, 12291 
Default: 12289 

6.Only when selecting "Panasonic: FP" or "Panasonic: FP(ET-LAN unit)" for PLC Type, set "Specify 
Station No.". 

Station Home (Default):  
A command which specifies no station number is issued. 
Example) %EE#WDD0001      

 
Specify Station No. (Station No.:1 – 99):  
A command for a PLC with the specified station number is issued. Specify the same number of the station 
number that is set for the PLC to communicate in "Station No.". 
Example) When Station No. is 99 %99#WDD0001      

 
When PLC Type is " Panasonic: FP "  
Selectable station No.: 1 – 99 
 
When PLC Type is "Panasonic: FP(ET-LAN unit )" 
Selectable station No.: 1 – 64 
The number specified in the step 3 "PV Station No." cannot be used. 

7. Specify the CPU No. of the PLC in "CPU No.".  

Selectable station No.: 1 to 4 
 

Specify this setting only when PLC Type is Yokogawa: FA-M3/e-RT3. 

 
 
 



 

638 

C
ontrol w

ith C
om

m
unication P

ort 
C

h. 11 

11.3.3 Outputting Data through PLC Communication 

Data Output Flaw 
 

PV200    PLC 

     
Receives START signal  

 
 Outputs START signal for inspection 

execution. 

Turns on command processing bit in 
case of accepting inspection by control 
command. 

    

   Command read type: Always turns off 
command start bit in case of polling. 

Writes response in command output 
register, turns on response completion 
and turns off command processing bit. 

   

    

Executes an inspection; image capturing 
and performing checkers. 

    

 
    

Changes data output completion notice 
to “0” and writes data in PLC from the 
specified address. (Writes data 
communicating commands and 
response messages with the dedicated 
protocol.) 

 

 

 Writes data in the address specified by 
data output register. 

 
   

  

Changes data output completion notice 
to “1”. 

 
 

 As detecting data output completion 
notice is “1”, confirms the address where 
the data have been stored. 

 
   

 

Waits for the next signal.  
 

 Goes back to the beginning and outputs 
START signal for the next inspection 
execution. 

     

 
 
 
 
 
 

About Data that can be Output 
When PV200 executes inspection, the data set to output are output in the following order.  

1. Date/Time  

2. Scan Count 

2. Total Judgement 

3. Judgement result:  
Up to 1000 points combining judgements and numerical calculations. 

4. Numerical Calculation:  
 

In the following cases, the data of Judgement and Numeric Calculation are not output to PLC.  
 PV sets data to output, but no data exist. 

 The setting data exist, but data are set to not to be output. 
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Output format of Date/Time: 
Output Data Regardless of output bit width, 3 words (48 bits) are used. Order of output: 1st 

word; "Year and Month (YYMM)", 2nd word; "Date and Hour (DDH)", 3rd word; 
"Minute and second (MMSS)". It does not depend on the format of the calendar in 
PV200. 
(Output example) 
  15:26:03 on August 31, 2014 
    1408   3115   2603 
   YYMM  DDHH  MMSS 

 

Output format of Scan count: 
Output Data Differs depending on the setting of Output bit width. 

• Range (16 bits) between 1 and 32767 
• Range (32 bits) between 1 and 2147483647 

Number of Data 1 

Values to be Output Normal 1 to 2147483647 

Overflow (when exceeding the 
specified "Bit Width") 

0 

 

Output format of Total Judgement: 
Output Data Regardless of output bit width, it is output in the last bit using one word.  

Number of Data 1 

Values to be Output OK 1 in hexadecimal form (0001 in binary form) 

NG 0 in hexadecimal form (0000 in binary form) 

Error E in hexadecimal form (1110 in binary form) 

Unset E in hexadecimal form (1110 in binary form) 

 

Output format of Judgement data: 
Output Data A Judgement is output in 4-bit (digit) unit 

Four data of Judgement per word from PLC are saved starting with LSB.  
When the outputting data is other than multiples of four, hexadecimal E is 
output. 

Number of Data Up to 1000 

Values to be Output OK 1 in hexadecimal form (0001 in binary form) 

NG 0 in hexadecimal form (0000 in binary form) 

Error E in hexadecimal form (1110 in binary form) 

Unset Data are not output. (But if the Judgement data No.s before and 
after the unset data No. are set to output, E is output in 16-digit 
form (1110 in binary form).) 

 

Output format of Numerical Calculation:  

The values that can be output are only integers. Actual values with value after decimal point are rounded to 
whole number and output. 
Output Data Differs depending on the setting of Output bit width. 

• Range of 16-bit: -32768 to 32767 
• Range of 32-bit: -2147483648 to 2147483647 

Number of Data Numerical Calculation: Up to 1000 
Values to be Output Normal Range of specified bit width 

Overflow (when exceeding the 
specified "Bit Width") 

- Range of 16-bit: 
If the numerical calculation results to be 
output exceeds the ranges of 16-bit and 
32-bit regardless of setting to output or 
not, all the numerical calculation results 
are output as "0".  
- Range of 32-bit: 
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Only the numerical calculation results 
which exceed the range of 32-bit are 
output as "0". 

Error - Range of 16-bit: 
If an error occurs in any of the set 
numerical calculation regardless of 
setting to output or not, all the numerical 
calculation results are output as "0". 
- Range of 32-bit: 
(Only the erroneous numerical 
calculation result is output as"0".) 

Unset or not output Data are not output. 
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Example of General Output 
Concept: 
 Four pieces of judgement data are stored per word (16 bits). (Four bits are used for a piece of data.) 

Data is output up to Judgement specified with the largest number.  For unset judgement data within 
the range, "E" is output such as JDC000. 
Also, when the number of output data is "3" which is not multiples of 4 like this example, "E" is 
stored in each part which cannot make a word. 

 Only the data of Numeric Calculation that are set to output are output. 
(In the case where the data of CAC000 or CAC002 is out of the range between -32768 and +32767, “0” 
is stored in corresponding registers. 

 Numerical calculation results are rounded to whole numbers and output. 

 Negative numbers are output in the complement number of 2. 

In the case of Bit Width : 16 bit, Data Output Register : 500 

 

Output Condition - Output Data: 
 Date and Time: 15:26:03 on August 31, 2014 

 Scan count: 1234 times 
 Total Judgement: OK 

 Judgement: JDC000=OK, JDC001=unset, JDC002=NG, JDC003 or later=Unset 

 Numerical Calculation: CAC000=215.3, CAC001=unset, CAC002=-2184.6, CAC003 or later=Unset 

Data 
Register 
No. 

Value 
(Hex.) Description Details 

Date/Time 

500 1408 Year-Month (Value calculated by subtracting 2000 from 
Year is displayed.) 

 

501 3115 Date-Hour  

502 2603 Minute-Second  

Scan Count 503 04D2 “1234” is stored. Scan 
Count 

  Bit 15  ---------------------------------------------------  Bit 0  

Total 
Judgement 

504 0001 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 OK 

Judgement 505 E01E 1 1 1 0 0 0 0 0 0 0 0 1 1 1 1 0 JDC001, 
JDC002 

Numerical 
calculation 

506 00D7 “215” is stored. CAC000 
507 F777 “-2185” is stored. CAC002 
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In the case of Bit Width: 32-bit, Data Output Register: 500 

Output Condition - Output Data: 

 Date and Time: 15:26:03 on August 31, 2014 

 Scan Count = 2848000 

 Total Judgement: OK 
 Judgement: JDC000=Unset, JDC001=OK, JDC002=NG, JDC003 or later=Unset 

 Numerical Calculation: CAC000=215.3, CAC001=Unset, CAC002=-2184.6, CAC003 or later=Unset 
 

Data Register 
No. 

Value 
(Hex.) Description Details 

Date/Time 

500 1408 
Year-Month (Value calculated by subtracting 2000 from Year 
is displayed.)  

501 3115 Date-Hour  

502 2603 Minute-Second  

Scan 
Count 503-504 002B7500 "2848000" is stored.  

  Bit 15  -----------------------------------------------------  Bit 0  

Total 
Judgement 505 0001 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 OK 

Judgement 506 E01E 1 1 1 0 0 0 0 0 0 0 0 1 1 1 1 0 
JDC001 , 
JDC002 

Numerical 
Calculation 

507-508 000000D7 "215" is stored. CAC000 

509-510 FFFFF777 "-2185" is stored. CAC002 

 

 Four Judgment data are stored per word as the same as when you select "16-bit". 

 Each data of Scan Count and Numerical Calculation uses two words (32-bit). 
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11.3.4 Controlling PV200 through PLC Communication 

For controlling PV200 through PLC Communication, PLC sends commands to PV200 and receives the 
responses. 

For the details of the control and commands to be used, refer to "11.3.5 List of Commands for PLC 
Communication". 

PV200 uses the following signals for the timings that PV200 reads commands sent by PLC and PLC receives 
responses. Refer to the timing charts for the details of the timing of each signal. 

Those signals can be read when PV200 is in RUN menu. PV200 cannot be controlled when it is in SETUP 
menu. (Refer to page 647.) 

 

Timing signal for PV200 to read the command sent by PLC 

The timing varies according to the selected "Command Read Type". 

Polling Uses the command start bit of the control register. PLC turns on the command start bit 
after writing a command. 

Parallel 
Input 

PLC turns on the signal of "Read PLC Communication Command" assigned to ASSIGN 
or EXTRA after writing a command. 

 

Timing signal for PLC to read the received response 

PV200 sets the response completion (COR = the first word of command output register) to 1 after writing 
responses. 

Also, PV200 sets the processing bit of the control register to zero after setting the response completion (COR) 
to one. 

Control register 
Example: Control Register = 10 

 
 

Command start bit: 

The zeroth register number specified in "Control Register". 
It is used when setting "Command Read Type" to "Polling". It indicates that a command was sent to PV200 
from PLC. PLC turns on (sets to 1) after setting the command. PV200 performs polling, and starts reading the 
command after confirming this bit is on. Also, PLC turns off this bit (sets to zero) when the processing bit is on. 

 

Processing bit:  

The zeroth bit of the next register number specified in "Control Register". 
PV200 turns on this bit (sets to 1) during the command processing. After the processing, PV200 writes 
response to the command in the command output register and turns off this bit (sets to zero). Monitoring this bit 
shows the timing that the next trigger can be used. 

 

Error bit:  

The first bit of the next register number specified in "Control Register". 
It indicates that an error occurred. When an error occurred, PV200 turns on this bit (sets to 1). 
(1) When the response error to the control command occurred 
(2) When the "Start Bit Off Timeout" error occurred when using polling 
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Transmitting bit : 

The eighth bit of the next register number specified in "Control Register". 
It indicates PV200 can communicate. In such state, PV200 turns on this bit (sets to 1). 
It turns on when RUN menu is displayed after the startup of PV200.  As PV200 cannot perform PLC 
communication once switching to SETUP menu, PV200 turns off this bit (sets to zero).   

If PV200 is turned off or the communication cable is disconnected while this bit is on, it will retain on state.  

 

Watch Dog bit : 

The ninth bit of the next register number specified in "Control Register" 
When "Watch Dog Timer" is set to "Yes", PV200 switches this bit on (sets to 1) and off (sets to 0) periodically.  
The watch dog bit is overwritten with a period of the integral multiple of polling time and a longer period of the 
set watch dog time. However, when the transmitting bit is off, PV200 does not switch the watch dog bit on and 
off. Also, during some processings such as saving the image memory in a SD card (the processing bit turns 
on), the processing time of switching the watch dog bit on and off gets slow.  

Therefore, for checking communication errors, set the check timer long enough in combination with the 
processing bit, transmitting bit and watch dog bit. 

 

 Example of sequence for checking communication 
errors 

R110:  

R118:  

R119:  

 

T0: 

 

T1:  

 

R0:  

Processing bit 

Transmitting bit 

Watch Dog bit 

 

Watch dog bit ON 
check timer 

Watch dog bit OFF 
check timer 

Communication 
error 
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PLC Communication: Control Command Timing 
Chart 
(Command Read Type: Polling) 

 

 
Tc: Command processing time. It varies depending on the content. For example, the processing time of saving 

data in a SD card may be over several seconds. 
To: Timeout period. An error occurs when the command start bit does not turn off within the time of Tc + To. 
CR: PLC address specified in "Control Register". 
CIR: PLC address specified in "Command Input Register". 
COR: PLC address specified in "Command Output Register". 

1. PLC confirms that the command processing bit is off, and resets the response completion (COR) to 
zero to clear the previous result output. (Off-state) Then, PLC writes a command in the command 
input registers (CIR, CIR+1, ...) to give PV200. 

2. PLC turns on the command start bit. 
PV200 monitors the command start bit in the specified polling cycle, and starts reading the 
commands from the command input register (CIR) as the first register once it confirms that the 
start bit is on. 

3. PV200 turns on the command processing bit.  Also, PV200 turns off the error bit regardless of the 
previous state. 

4. PLC turns off the command start bit within the time of Tc + To after confirming the command 
processing bit is on. 
During this process, PV200 confirms that the command start bit is off by polling. 

PV200 responds the error code (113) when the command start bit does not turn off within the time of Tc + 
To. 

5. PV200 write responses in the command output register, and then sets the response completion 
(COR) to 1. (On-state) 

6. PV200 turns off or on the error bit according to the error occurrence, and then turns off the 
command processing bit. 
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PLC Communication: Control Command Timing 
Chart 
(Command Read Type: Parallel Input) 

 

 
 

CR: PLC address specified in "Control Register". 
CIR: PLC address specified in "Command Input Register". 
COR: PLC address specified in "Command Output Register". 

1. PLC confirms that the command processing bit is off, and resets the response completion (COR) to 
zero to clear the previous result output. (Off-state) Then, PLC writes a command in the command 
input registers (CIR, CIR+1, ...) to give PV200. 

2. PLC turns on the "Read PLC Communication Command" assigned to the parallel I/O terminal of 
PV200. 
PV200 starts reading the commands from the command input register (CIR) as the first register 
once it confirms this parallel signal is on. 

Assign "Read PLC Communication Command" to one of ASSIGN0-1 and EXTRA0-2 from 
"ENVIRONMENT" > "Input/Output" > "Parallel" in SETUP menu. 

3. PV200 turns on the command processing bit.  Also, PV200 turns off the error bit regardless of the 
previous state. 
PLC can turn off the "Read PLC Communication Command" signal after turning on the command 
processing bit. 

4. PV200 write responses in the command output register, and then sets the response completion 
(COR) to 1. (On-state) 

5. PV200 turns off or on the error bit according to the error occurrence, and then turns off the 
command processing bit. 
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11.3.5 List of Commands for PLC Communication 

The commands and the modes permitting the commands are listed below.  

   Command Permission 

  For 
details, 
refer to 

RUN Menu SETUP 
Menu 

Parallel 
Processing 

Continuous 
Inspection 

  RUN STOP STOP 

Inspection 
start 

Common Trigger Page 649 Yes   Yes Yes 

Start reinspection (to inspect on the 
current memory image without 
capturing a new image) 

Page 650 Yes   Yes  

Switch product type Page 653 Yes   Yes Yes 

Save the 
setting data 

Storage space in 
PV200 

Page 653 Yes   Yes  

SD memory card Page 654 Yes   Yes  

Read the 
setting data 

Storage space in 
PV200 

Page 654 Yes   Yes  

SD memory card Page 654 Yes   Yes  

Abort save/read setting data (Cancel) Page 655 Yes   Yes  

Image memory Save (in a SD card) Page 655 Yes   Yes  

Clear Page 656 Yes   Yes Yes 

Print screen Page 656 Yes   Yes Yes 

Reset statistics Page 651 Yes   Yes Yes 

Start RUN Mode Page 651 Yes Yes  Yes Yes 

Stop RUN Mode Page 651 Yes Yes  Yes Yes 

Reset error signal Page 651 Yes Yes  Yes Yes 

Cancel Inspection/ Process Page 659 Yes Yes  Yes Yes 

Keypad 
Operation 

Key emulating Page 652 Yes Yes  Yes Yes 

Valid Page 652 Yes Yes  Yes Yes 

Invalid Page 652 Yes Yes  Yes Yes 

Confirm Status Page 653 Yes Yes  Yes Yes 

Switch layout Page 656 Yes   Yes Yes 

Set a template Page 657 Yes   Yes  

Set a template for Contour 
Matching 

Page 658 Yes   Yes  
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List of Read/Write Command Parameter 
 
        Command Permission   

Continuous 
Inspection   For details, refer to RUN Menu SETUP 

Menu 
Parallel 
Processing 

    Read Write RUN STOP STOP 

Inspection time Page 660 - Yes   Yes Yes 

Inspection Cycle Page 660 - Yes   Yes Yes 

Total Judgement Page 660 - Yes   Yes Yes 

Scan Count Page 660 - Yes   Yes Yes 

Operation Status Page 660 - Yes Yes  Yes Yes 

Current Type No. Page 660 - Yes   Yes Yes 

System Register 0 to 
System Register 7 

Page 660 Page 675 Yes   Yes Yes 

Date Page 660 Page 675 Yes   Yes Yes 

Time Page 660 Page 675 Yes   Yes Yes 

Line Page 661 Page 675 Yes   Yes Yes 

Binary Window Page 661 Page 676 Yes   Yes Yes 

Gray Window Page 662 Page 677 Yes   Yes Yes 

Binary Edge Page 663 Page 678 Yes   Yes Yes 

Gray Edge Page 663 Page 678 Yes   Yes Yes 

Feature Extraction Page 664 Page 679 Yes   Yes Yes 

Smart Matching Page 665 Page 680 Yes   Yes Yes 

Flaw Detection Page 665 Page 680 Yes   Yes Yes 

Connector  
(Binary Window) Page 666 Page 681 Yes   Yes Yes 

Connector  
(Gray Window) Page 667 Page 682 Yes   Yes Yes 

Connector  
(Gray Edge) Page 668 Page 683 Yes   Yes Yes 

Smart Edge (Circle) Page 669 Page 684 Yes   Yes Yes 

Smart Edge (Line) Page 670 Page 685 Yes   Yes Yes 

Color Window Page 671 Page 686 Yes   Yes Yes 

Geometry Calculation Page 672 Page 687 Yes   Yes Yes 

Numerical calculation Page 673 Page 688 Yes   Yes Yes 

Marker Page 674 Page 689 Yes   Yes Yes 

Slice Level Page 674 Page 690 Yes   Yes Yes 

 

 



 

649 

C
ontrol w

ith C
om

m
unication P

ort 
C

h. 11 

11.3.6 Descriptions of PLC Communication Commands 

The "Command" in the tables means commands to be issued (sent) to PV200 from PLC. CIR is written at the 
beginning. The "Response" means the responses to PLC from PV200 to the sent commands. COR is written at 
the beginning. 

The CIR and COR in the tables mean the following contents. 
CIR:  
 

Address specified in "Command Input Register". A request to PV200 is 
written with this address at the beginning. 

（Refer to page 632） 
 

COR: 
 

Address specified in "Command Output Register”. A response is 
written by PV200 with this address at the beginning. 

（Refer to page 632） 
 

The common error codes in PLC communication are as follows. For the details of the error codes peculiar to 
each command, refer to the description of each command.  

Common error code 
100 An undefined command was sent. 

111 • PLC response timeout 
• Register number error 
• Format error of a response from PLC 

113 Command Start Bit Off Timeout 

114 When "Parallel Input" has not been selected for "Command Read Type", the "Read 
PLC Communication Command" signal was input. 

 

For Read and Write commands 
200 Operation is stopped. (However, except Read of "Operation Status") 

252 • The specified parameter does not exist. (e.g. The number of uncreated checker is 
specified as a parameter.) 

• The specified parameter value is out of the settable range. (e.g. Maximum value 
of slice level is being set to over 256.) 

• The specified values led to the status of “Maximum value < Minimum value” when 
entering them. 

• When specifying the moving distance of the marker, a part of the circumscribing 
rectangle of the marker (the intersection point when Shape is Cross line) after move 
was out of the nine screens where checker area is settable. 

 

Inspection start 

When using common trigger in “Execute All” or “Automatic 
Switch” execution mode 

Error code 
160 Position adjustment for a detect trigger is unset or a base position is unset when 

"Camera Trigger" is set to “Detect Trigger (common)”. 

200 Operation is stopped. 

202 Execution mode is “User-Defined”. 

203 • No camera is connected. 
• Both two cameras of PV200 are set to "Unused". 

211 Type switch was executed by an external command while executing detect trigger. 
 

 Command    Response 

 CIR 0200 h   COR Response completion=1  

 CIR +1 0110 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  
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When using common trigger in “User-Defined” execution 
mode 

Error code 
160 Position adjustment for a detect trigger is unset or a base position is unset when 

"Camera Trigger" is set to “Detect Trigger (common)”. 

201 Execution mode is NOT “User-Defined” in PV200. 

202 The specified block is invalid (the number which does not/ cannot exist was specified) 

203 • No camera is connected. 
• Both two cameras of PV200 are set to "Unused". 

 

 

Reinspection  
(Executes inspection without capturing an image) 

For “Execute All” or “Automatic Switch” execution mode 

Error code 
200 Operation is stopped 

202 Execution mode is “User-Defined”. 

203 There is no image captured. 

204 Reinspection cannot be executed because PV200 is inspecting repeatedly 
 

 

 

For “User-Defined” execution mode 

 Command    Response 

 CIR 0200 h   COR Response completion=1  

 CIR +1 0120 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 4    

 CIR +3 , CIR +4 Block No. to execute  COR +2 0  

       

 Block No. to execute = 0 - 9     

 Command    Response 

 CIR 0200 h   COR Response completion=1  

 CIR +1 0210 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0200 h   COR Response completion=1  

 CIR +1 0220 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 4    

 CIR +3 , CIR +4 Block No. to execute  COR +2 0  

       

 Block No. to execute = 0 - 9     
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Error code 
200 Operation is stopped 

201 Execution mode is NOT “User-Defined”. 

202 The specified block is invalid. (The number which does not/ cannot exist was specified.) 

203 There is no image captured. 

204 Reinspection cannot be executed because PV200 is inspecting repeatedly 
 

 

Resetting Statistics Data 
Resets statistics data and scan count. 

Error code 
200 Operation is stopped 

 

Start RUN Mode 

 

 

STOP Run Mode 
 

Resetting Error Signal 
To turns off ERROR signal. 

 

 Command    Response 

 CIR 0200 h   COR Response completion=1  

 CIR +1 0600 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0300 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0300 h   COR Response completion=1  

 CIR +1 0100 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0400 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  
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Keypad Operation (Key Emulation)  
This is a command that performs the same operations of the keypad. (Note that this command cannot be used 
in SETUP menu.) 

 

Setting Valid of Keypad operation 
This is a command for permitting keypad operation in RUN MENU. 

Cancel "Keypad is invalid" that is the setting to disable the keypad operation. 

Setting Invalid of Keypad operation 
This is a command for prohibiting keypad operation in RUN MENU. 

When keypad operation has been set to "Invalid", the keypad cannot be used. A message "Keypad is invalid" is 
shown in the key guide space on the window. Even when setting to "Invalid", key emulate commands can be 
received. 

 

 

 

 

 Command    Response 

 CIR 0500 h   COR Response completion=1  

 CIR +1 0100 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 8    

 CIR +3 , CIR +4 shift key  COR +2 0  

 CIR +5 , CIR +6 Key No.     

   

 

 On/off switch of the shift key; 0 = off, 1 = 
on 

 

 Key No.=1-16 (See the right figure)  

 

 

 

 

 

 
Using the key No.16 switches to 
SETUP menu. The keypad becomes 
inoperable in PLC communication. Do 
not use the key No. 16 for using the 
key emulation function in PLC 
communication. 

The keypad also becomes inoperable 
in PLC communication when starting 
debug in RUN menu. 

 

 Command    Response 

 CIR 0500 h   COR Response completion=1  

 CIR +1 0200 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0500 h   COR Response completion=1  

 CIR +1 0300 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  
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Reading Keypad Operation Status 

Type Switch 

Error code 
200 Operation is stopped 

210 • The specified product number does not exist. 
• Other number than 000-255 was specified for a product number. 

 

 

 

Saving Setting Data 

Saving in the Storage Space in PV200 

Error code 
200 Operation is stopped. 

205 READY signal is off for more than one seconds during operations such as detect 
trigger or continuous inspection. 

 

 Command    Response 

 CIR 0500 h   COR Response completion=1  

 CIR +1 0400 h   COR +1 Normal end=0  

 CIR +2 0   COR +2 4  

    COR +3 , COR +4 Status 

    Status:  0=Valid, 1=Invalid 

   COR Response completion=1  

   COR +1 Error code  

   COR +2 0  

 Command    Response 

 CIR 0100 h   COR Response completion=1  

 CIR +1 0100 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 4    

 CIR +3 , CIR +4 Type No.  COR +2 0  

       

 Type No. = 0-255     

 Command    Response 

 CIR 0600 h   COR Response completion=1  

 CIR +1 0111 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  
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Saving in a SD memory card 

Error code 
200 Operation is stopped 

205 READY signal is off for more than one seconds during operations such as detect 
trigger or continuous inspection. 

212 Other number than 00-99 was specified for a saving area number. 

216 • No SD memory card is attached or cannot be accessed. 
• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
・The file with the specified storage number already exists, and the property of the file is 

"Read-only". 
・”Write When Cover is Open” is set to “Disable”, and the cover is open. 

 

Reading Setting Data 

Reading from the Storage Space in PV200 

Error code 
200 Operation is stopped 

205 READY signal is off for more than one seconds during operations such as detect 
trigger or continuous inspection. 

214 • The data file is incompatible. (Data of the later version, etc.) 
• The number and types of cameras connected to PV200 is different from the Camera 

setting of the data file. 
(including the case that the camera is unconnected because the camera cable came 
off unexpectedly.) 

 

Reading from a SD memory card 

 Command    Response 

 CIR 0600 h   COR Response completion=1  

 CIR +1 0112 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 4    

 CIR +3 , CIR +4 Storage area No.  COR +2 0  

       

 Storage area No. = 0 – 99     

 Command    Response 

 CIR 0600 h   COR Response completion=1  

 CIR +1 0211 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0600 h   COR Response completion=1  

 CIR +1 0212 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 4    

 CIR +3 , CIR +4 Reading area No.  COR +2 0  

       

 Reading Area No. = 0-99     
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Error code 
200 Operation is stopped 

205 READY signal is off for more than one seconds during operations such as detect 
trigger or continuous inspection. 

212 Other number than 00-99 was specified for a reading area number. 

213 • No SD memory card is attached or cannot be accessed. 
• No data file in the designated area of a SD memory card. 

214 • The data file is not data of PV200. 
• The Data file is incompatible. (Data of the later version, etc.) 
• The number and types of cameras connected to PV200 is different from the Camera 

setting of the data file. 
(including the case that the camera is unconnected because the camera cable came 
off unexpectedly.) 

 

Abort Save/Read Setting Data 

Error code 
217 • Saving or reading setting data is not executed. 

• Aborting failed. 
 

Saving Images Stored in the Save Image Memory of 
PV into a SD Memory Card 

Data is saved into free area of the SD memory card. (A destination number cannot be specified.) 

Error code 
200 Operation is stopped. 

260 • No SD memory card is attached or cannot be accessed. 
• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• No blank folder exists in the destination. (All of 000-999 folders are used.)  
• No image is saved in the save image memory. 
• “Write When Cover is Open” is set to “Disable”, and the cover is open. 

 

 

 Command    Response 

 CIR 0600 h   COR Response completion=1  

 CIR +1 0410 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0600 h   COR Response completion=1  

 CIR +1 0122 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  
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Clearing the Image Memory Stored in PV 
Execute “SAVE/READ” -> “Clear Image Memory” in SETUP menu. 

 

Print Screen 
It is output into the place specified from “ENVIRONMENT” >  “Input/Output” -> “Print Screen” -> “Destination”. 
This command cannot specify the destination. 

Error code 
265 • No SD memory card is attached or cannot be accessed. 

• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• ”Write When Cover is Open” is set to “Disable”, and the cover is open. 
• Ethernet communication cannot be established (with connection problems such as 

cable unconnected or disconnection) 
• Image Receiver is not activated. 

 

Layout Switch 

Error code 
200 Operation is stopped. 

246 • Other number than 00-15 is specified for layout number. 
• No layout has been registered in the specified layout number 

 

 

 Command    Response 

 CIR 0600 h   COR Response completion=1  

 CIR +1 0320 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0600 h   COR Response completion=1  

 CIR +1 0130 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0700 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 4    

 CIR +3 , CIR +4 Layout No.  COR +2 0  

       

 Layout No. = 0-15     
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Smart Matching Template Setting 
Set a template of Smart Matching. When "Area Display" is "Yes", follow two instructions in order. 

 
A template that can be set with the command is one of Smart Matching in “Checker” menu. In Smart Matching 
used in Position Adjustment and Area Size Adjustment, a template cannot be re-registered. 

 
For information on the conditions when re-registering templates: page 191 

When “Area Display” is set to “No” for Template Setting 
The first command to be sent when "Area Display" is "Yes" 

Error code 
200 Operation is stopped. 

230 • Because PV200 is processing Detect trigger or Continuous Inspection, Template 
setting cannot be executed. 

• Command was sent in the second operation when "Area Display" is "Yes".  

231 • The specified checker number or template number has not be created. 
• Other number than 000-999 for checker number, or 00-63 for template was specified. 

232 Template cannot be set because no image has been captured after PV200 started up 
when you select “Use the Last Image” for “Template Setting”. 

233 • No feature on the image of template registration area. 
• An error occurs in Position adjustment when you use it. 
• Template setting area is outside of the captured image (image partially captured when 

executing partial imaging). (The whole template setting area should be in the range of 
the captured image.) 

 

 

 

 

The second command to be sent when "Area Display" is 
"Yes" 

 Command    Response 

 CIR 0800 h   COR Response completion=1  

 CIR +1 0100 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 8    

 CIR +3 , CIR +4 Checker No.  COR +2 0  

 CIR +5 , CIR +6 Template No.     

      

 Checker No. = 0 – 999     

 Template No.=0-63     

 Command    Response 

 CIR 0800 h   COR Response completion=1  

 CIR +1 0200 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  
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Error code 
200 Operation is stopped. 

230 • Because PV200 is processing Detect trigger or Repeat start, Template setting cannot 
be executed. 

• Because parallel I/O result is being output, Template setting cannot be executed 
• Command was sent without the first command transmission when "Display Area" is 

"Yes". 

232 Template cannot be set because no image has been captured after PV200 started up 
when you select “Use the Last Image” for “Template Setting”. 

233 • No feature on the image of template registration area. 
• An error occurs in Position adjustment when you use it. 
• Template setting area is outside of the captured image (image partially captured when 

executing partial imaging). (The whole template setting area should be in the range of 
the captured image.) 

 

 

Contour Matching Template Setting 
Set a template of Contour Matching. When "Area Display" is "Yes", follow two instructions in order. 

 
A template that can be set with the command is one of Contour Matching in “Checker” menu. In Contour 
Matching used in Position Adjustment and Area Size Adjustment, a template cannot be re-registered. 

 
For information on the conditions when re-registering templates: page 191 

When “Area Display” is set to “No” for Template Setting 
The first command to be sent when "Area Display" is "Yes" 

Error code 
200 Operation is stopped. 

230 • Because PV200 is processing Detect trigger or Continuous Inspection, Template 
setting cannot be executed. 

• Command was sent in the second operation when "Area Display" is "Yes". 

231 • The specified checker number or template number has not be created. 
• Other number than 000-999 for checker number, or 0 for template was specified. 

232 Template cannot be set because no image has been captured after PV200 started up 
when you select “Use the Last Image” for “Template Setting”. 

233 • No feature on the image of template registration area. 
• An error occurs in Position adjustment when you use it. 
• Template setting area is outside of the captured image (image partially captured when 

executing partial imaging). (The whole template setting area should be in the range of 
the captured image.) 

 

 Command    Response 

 CIR 0800 h   COR Response completion=1  

 CIR +1 0101 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 8    

 CIR +3 , CIR +4 Checker No.  COR +2 0  

 CIR +5 , CIR +6 Template No.     

      

 Checker No. = 0 – 999     

 Template No.=0 (Fixed)     
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The second command to be sent when "Area Display" is 
"Yes" 

Error code 
200 Operation is stopped. 

230 • Because PV200 is processing Detect trigger or Repeat start, Template setting cannot 
be executed. 

• Because parallel I/O result is being output, Template setting cannot be executed 
• Command was sent without the first command transmission when "Display Area" is 

"Yes". 

232 Template cannot be set because no image has been captured after PV200 started up 
when you select “Use the Last Image” for “Template Setting”. 

233 • No feature on the image of template registration area. 
• An error occurs in Position adjustment when you use it. 
• Template setting area is outside of the captured image (image partially captured when 

executing partial imaging). (The whole template setting area should be in the range of 
the captured image.) 

 

 

 

Canceling Inspection/ Processing (Cancel specific 
operation)  

Cancels the following active operations, and restores into the previous status before the operation. 

 Cancellation of the operation of a serial command which has been received 

 Abort of output in the status waiting for result output after an inspection is complete 

 Abort of image saving from Image Memory to a SD memory card 

 Cancellation of template re-registration 

 

 Command    Response 

 CIR 0800 h   COR Response completion=1  

 CIR +1 0201 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0900 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 0    

     COR +2 0  
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Read Command Parameters 

System values（Read）1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

System values（Read）2 

 

 
  Code Result 1 Result 2 Result 3 

Date 6407 h Year Month Day 

Time 6408 h Hour Minute Second 

 

 

 Command    Response 

 CIR 0A01 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 2    

 CIR +3 Code   COR +2 4  

     COR +3 , COR +4 Result 

  Code Lower limit Upper limit Details 

Inspection time 6400 h 0 10000 Value is rounded to the 
whole number, and the 
integer portion is read. Inspection Cycle 6401 h 0 10000 

Total Judgement 6402 h 0 1 0:NG 1: OK 

Scan Count 6403 h 0 2147483647   

Operation Status 6405 h 0 1 0: RUN  1: STOP 

Current Type No. 6406 h 0 255   

System Register 0 6480 h -10000000 10000000 Value is rounded to the 
whole number, and the 
integer portion is read. System Register1 6481 h -10000000 10000000 

System Register2 6482 h -10000000 10000000 

System Register3 6483 h -10000000 10000000 

System Register4 6484 h -10000000 10000000 

System Register5 6485 h -10000000 10000000 

System Register6 6486 h -10000000 10000000 

System Register7 6487 h -10000000 10000000 

 Command    Response 

 CIR 0A01 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 2    

 CIR +3 Code   COR +2 12  

     COR +3 , COR +4 Result 1 

    COR +5 , COR +6 Result 2 

    COR +7 , COR +8 Result 3 
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Line（Read）1 

 
    Code Lower limit Upper limit 

No. of Pixels Maximum 0100 h 0 182386 

  Minimum 0101 h     

No. of Objects Maximum 0103 h 0 60795 

  Minimum 0104 h     

Line（Read）2 

 
    Code Lower limit Upper limit 

No. of Pixels Max. and Min. 0102 h 0 182386 

No. of Objects Max. and Min. 0105 h 0 60795 

 

Binary Window（Read）1 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0200 h 0 4194304 

  Minimum 0201 h     

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0100 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0100 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0200 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 
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Binary Window（Read）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0202 h 0 4194304 

 

Gray Window（Read）1 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0300 h 0 255 

  Minimum 0301 h     

Gray Window（Read）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0302 h 0 255 

 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0200 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0300 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0300 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 
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Binary Edge（Read）1 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0400 h 0 256 

  Minimum 0401 h     

Binary Edge（Read）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0402 h 0 256 

Gray Edge（Read）1 

 
    Code Lower limit Upper limit 

Edge Threshold   0500 h 1 255 

OK JUDGE. Maximum 0501 h 0 256 

  Minimum 0502 h     

 

 

 

 

 

 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0400 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0400 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0500 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 
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Gray Edge（Read）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0503 h 0 256 

 

Feature Extraction（Read）1 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0600 h 0 10000 

  Minimum 0601 h     

Feature Extraction（Read）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0602 h 0 10000 

 

 

 

 

 

 

 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0500 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0600 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0600 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 
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Smart Matching（Read） 

 
    Code Lower limit Upper limit 

Search Count 1st step 0700 h 1 256 

 2nd step 0701 h 1 256 

 3rd step 0702 h 1 256 

 4th step 0703 h 1 256 

 5th step 0704 h 1 256 

  6th step 0705 h 1 256 

No. of Subtracted Objects  0706 h 0 128 

 

Flaw Detection（Read）1 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0800 h 0 512 

  Minimum 0801 h     

Flaw Detection（Read）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0802 h 0 10000 

 

 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0700 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0800 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0800 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 
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Connector Binary Window（Read）1 

 
    Code Lower limit Upper limit 

Common Judge. Maximum 0900 h 0 62500 

  Minimum 0901 h     

Connector Binary Window（Read）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0902 h 0 62500 

Connector Binary Window（Read）3 

 
    Code Lower limit Upper limit 

Individual Judge. Maximum 0903 h 0 62500 

  Minimum 0904 h     

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0900 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0900 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0900 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 CIR +6 , CIR +7 Cell No.    
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Connector Binary Window（Read）4 

 
    Code Lower limit Upper limit 

Individual Judge. Max. and Min. 0905 h 0 62500 

 

Connector Gray Window（Read）1 

 
    Code Lower limit Upper limit 

Common Judge. Maximum 0A00 h 0 255 

  Minimum 0A01 h     

Connector Gray Window（Read）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0A02 h 0 255 

 

 

 

 

 

 

 

 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0900 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

 CIR +6 , CIR +7 Cell No.  COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0A00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0A00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 
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Connector Gray Window（Read）3 

 
    Code Lower limit Upper limit 

Individual Judge. Maximum 0A03 h 0 255 

  Minimum 0A04 h     

Connector Gray Window（Read）4 

 
    Code Lower limit Upper limit 

Individual Judge. Max. and Min. 0A05 h 0 255 

 

Connector Gray Edge（Read）1 

 
    Code Lower limit Upper limit 

Judge. Pitch Maximum 0B00 h 0 100000000 

  Minimum 0B01 h     

Distance 
Difference Judge. 

Maximum 0B03 h 0 100000000 

Minimum 0B04 h     

* Value is rounded to the whole number, and the integer portion is read.  

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0A00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 

 CIR +6 , CIR +7 Cell No.    

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0A00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

 CIR +6 , CIR +7 Cell No.  COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0B00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 
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Connector Gray Edge（Read）2 

 
    Code Lower limit Upper limit 

Judge. Pitch Max. and Min. 0B02 h 0 100000000 

Distance 
Difference Judge. Max. and Min. 0B05 h 0 100000000 

* Value is rounded to the whole number, and the integer portion is read.  

 

Smart Edge Circle（Read）1 

 
    Code Lower limit Upper limit 

Measurement  Maximum 0C00 h 0 100000000 

  Minimum 0C01 h     

Standard Deviation Maximum 0C03 h 0 100000000 

  Minimum 0C04 h     

Circularity Maximum 0C06 h 0 100000000 

  Minimum 0C07 h     

Unused Edge Count Maximum 0C09 h 0 3597 

* Value is rounded to the whole number, and the integer portion is read. 

Smart Edge Circle（Read）2 

 
    Code Lower limit Upper limit 

Measurement  Max. and Min. 0C02 h 0 100000000 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0B00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.   COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0C00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.  COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0C00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.  COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 
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Standard Deviation Max. and Min. 0C05 h 0 100000000 

Circularity Max. and Min. 0C08 h 0 100000000 

* Value is rounded to the whole number, and the integer portion is read. 

 

Smart Edge Line（Read）1 

 
    Code Lower limit Upper limit 

Measurement  Maximum 0D00 h 0 100000000 

  Minimum 0D01 h     

Standard Deviation Maximum 0D03 h 0 100000000 

  Minimum 0D04 h     

Linearity Maximum 0D06 h 0 100000000 

  Minimum 0D07 h     

Unused Edge Count Maximum 0D09 h 0 2998 

* Value is rounded to the whole number, and the integer portion is read.  

 

Smart Edge Line（Read）2 

 
    Code Lower limit Upper limit 

Measurement  Max. and Min. 0D02 h 0 100000000 

Standard Deviation Max. and Min. 0D05 h 0 100000000 

Linearity Max. and Min. 0D08 h 0 100000000 

* Value is rounded to the whole number, and the integer portion is read.  

 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0D00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.  COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0D00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.  COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 
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Color Window（Read）1 

 
    Code Lower limit Upper limit 

RGray Maximum 0E00 h 0 255 

  Minimum 0E01 h     

RGray Ave. Maximum 0E03 h 0 255 

  Minimum 0E04 h     

RGray Std. Devi. Maximum 0E06 h 0 128 

  Minimum 0E07 h     

GGray Maximum 0E09 h 0 255 

  Minimum 0E0A h     

GGray Ave. Maximum 0E0C h 0 255 

  Minimum 0E0D h     

GGray Std. Devi. Maximum 0E0F h 0 128 

  Minimum 0E10 h     

BGray Maximum 0E12 h 0 255 

  Minimum 0E13 h     

BGray Ave. Maximum 0E15 h 0 255 

  Minimum 0E16 h     

BGray Std. Devi. Maximum 0E18 h 0 128 

  Minimum 0E19 h     

* Value is rounded to the whole number, and the integer portion is read.  

Color Window（Read）2 

 
    Code Lower limit Upper limit 

RGray Max. and Min. 0E02 h 0 255 

R Gray Ave. Max. and Min. 0E05 h 0 255 

R Gray Std. Devi. Max. and Min. 0E08 h 0 127 

GGray Max. and Min. 0E0B h 0 255 

GGray Ave. Max. and Min. 0E0E h 0 255 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0E00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Checker No.  COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A02 h   COR Response completion=1  

 CIR +1 0E00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Checker No.  COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 



 

672 

C
ontrol w

ith C
om

m
unication P

ort 
C

h. 11 

GGray Std. Devi. Max. and Min. 0E11 h 0 127 

BGray Max. and Min. 0E14 h 0 255 

BGray Ave. Max. and Min. 0E17 h 0 255 

BGray Std. Devi. Max. and Min. 0E1A h 0 127 

* Value is rounded to the whole number, and the integer portion is read.  

 

Geometry Calculation（Read）１ 

 
    Code Lower limit Upper limit 

X COORD. Maximum 6500 h -100000000 100000000 

(IP X, Center X) Minimum 6501 h     

Y COORD. Maximum 6503 h -100000000 100000000 

(IP Y, Center Y) Minimum 6504 h     

Standard Deviation Maximum 6506 h 0 100000000 

  Minimum 6507 h     

Angle Maximum 6509 h -100000000 100000000 

  Minimum 650A h     

Distance Maximum 650C h 0 100000000 

  Minimum 650D h     

Intersecting Angle Maximum 650F h 0 360 

  Minimum 6510 h     

Radius Maximum 6512 h 0 100000000 

  Minimum 6513 h     

Major Axis Maximum 6515 h 0 100000000 

  Minimum 6516 h     

Minor Axis Maximum 6518 h 0 100000000 

  Minimum 6519 h     

* Value is rounded to the whole number, and the integer portion is read.  

 

 
 

 

 

 

 

 

 Command    Response 

 CIR 0A03 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Geometry Calculation 
No. 

 COR +3 , COR +4 Result 
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Geometry Calculation（Read）2 

 
    Code Lower limit Upper limit 

X COORD. Max. and Min. 6502 h -100000000 100000000 

Y COORD. Max. and Min. 6505 h -100000000 100000000 

Standard Deviation Max. and Min. 6508 h 0 100000000 

Angle Max. and Min. 650B h -100000000 100000000 

Distance Max. and Min. 650E h 0 100000000 

Intersecting Angle Max. and Min. 6511 h 0 360 

Radius Max. and Min. 6514 h 0 100000000 

Major Axis Max. and Min. 6517 h 0 100000000 

Minor Axis Max. and Min. 651A h 0 100000000 

* Value is rounded to the whole number, and the integer portion is read.  

Numerical Calculation（Read）１ 

 
    Code Lower limit Upper limit 

Judgement Max. and Min. 6600 h -100000000 100000000 

  Max. and Min. 6601 h     

* Value is rounded to the whole number, and the integer portion is read.  

Numerical Calculation（Read）2 

 Command    Response 

 CIR 0A03 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Geometry Calculation 
No. 

 COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A04 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Numerical calculation 
No. 

 COR +3 , COR +4 Result 

 Command    Response 

 CIR 0A04 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Numerical calculation 
No. 

 COR +3 , COR +4 Result 1 (Min.) 

    COR +5 , COR +6 Result 2 (Max.) 
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    Code Lower limit Upper limit 

Judgement Max. and Min. 6602 h -100000000 100000000 

* Value is rounded to the whole number, and the integer portion is read.  

 

Marker（Read） 

 
    Code Lower limit Upper limit 

Central Coordinate XY set 6700 h -2048 4095 

* Value is rounded to the whole number, and the integer portion is read.  

* Witten values are in pixel units before calibration. 

Slice Level（Read）１ 

 
    Code Lower limit Upper limit 

Slice Level Maximum 6800 h 0 255 

  Minimum 6801 h     

 

Slice Level（Read）2 

 
    Code Lower limit Upper limit 

Slice Level Max. and Min. 6802 h 0 255 

 Command    Response 

 CIR 0A05   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Camera No.  COR +3 , COR +4 Result 1 (Min.) 

 CIR +6 , CIR +7 Marker No.  COR +5 , COR +6 Result 2 (Max.) 

 Command    Response 

 CIR 0A06 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 4  

 CIR +4 , CIR +5 Camera No.  COR +3 , COR +4 Result 

 CIR +6 , CIR +7 Slice Level Group No.    

 Command    Response 

 CIR 0A06 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 8  

 CIR +4 , CIR +5 Camera No.  COR +3 , COR +4 Result 1 (Min.) 

 CIR +6 , CIR +7 Slice Level Group No.  COR +5 , COR +6 Result 2 (Max.) 
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Write Command Parameters 

System values（Write）1 

 
  Code Data 1 Data 2 Data 3 

Date 6407 h Year Month Day 

Time 6408 h Hour Minute Second 

System values（Write）2 

 
  Code Lower limit Upper limit Details 

System Register 0 6480 h -9999999 9999999 Only integers can be written. 

System Register1 6481 h -9999999 9999999  

System Register2 6482 h -9999999 9999999  

System Register3 6483 h -9999999 9999999  

System Register4 6484 h -9999999 9999999  

System Register5 6485 h -9999999 9999999  

System Register6 6486 h -9999999 9999999  

System Register7 6487 h -9999999 9999999   

 

Line（Write）1 

 

 Command    Response 

 CIR 0A11 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Data 1    

 CIR +6 , CIR +7 Data 2    

 CIR +8 , CIR +9 Data 3    

 Command    Response 

 CIR 0A11 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 6    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Data    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0100 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    
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    Code Lower limit Upper limit 

No. of Pixels Maximum 0100 h 0 182386 

  Minimum 0101 h     

No. of Objects Maximum 0103 h 0 60795 

  Minimum 0104 h     

 

Line（Write）2 

 
    Code Lower limit Upper limit 

No. of Pixels Max. and Min. 0102 h 0 182386 

No. of Objects Max. and Min. 0105 h 0 60795 

 

 

Binary Window（Write）１ 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0200 h 0 4194304 

  Minimum 0201 h     

 

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0100 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0200 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    
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Binary Window（Write）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0202 h 0 4194304 

 

Gray Window（Write）1 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0300 h 0 255 

  Minimum 0301 h     

 

Gray Window（Write）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0302 h 0 255 

 

 

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0200 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0300 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0300 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    
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Binary Edge（Write）1 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0400 h 0 256 

  Minimum 0401 h     

 

Binary Edge（Write）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0402 h 0 256 

 

 

Gray Edge（Write）1 

 
    Code Lower limit Upper limit 

Edge Threshold   0500 h 1 255 

OK JUDGE. Maximum 0501 h 0 256 

  Minimum 0502 h     

 

 

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0400 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0400 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0500 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    
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Gray Edge（Write）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0503 h 0 256 

 

Feature Extraction（Write）1 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0600 h 0 10000 

  Minimum 0601 h     

 

Feature Extraction（Write）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0602 h 0 10000 

 

 

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0500 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0600 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0600 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    
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Smart Matching（Write） 

 
    Code Lower limit Upper limit 

Search Count 1st step 0700 h 1 256 

 2nd step 0701 h 1 256 

 3rd step 0702 h 1 256 

 4th step 0703 h 1 256 

 5th step 0704 h 1 256 

  6th step 0705 h 1 256 

No. of Subtracted Objects  0706 h 0 128 

 

Flaw Detection（Write）1 

 
    Code Lower limit Upper limit 

OK JUDGE. Maximum 0800 h 0 512 

  Minimum 0801 h     

Flaw Detection（Write）2 

 
    Code Lower limit Upper limit 

OK JUDGE. Max. and Min. 0802 h 0 512 

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0700 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0800 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0800 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    
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Connector Binary Window（Write）1 

 
    Code Lower limit Upper limit 

Common Judge. Maximum 0900 h 0 62500 

  Minimum 0901 h     

 

Connector Binary Window（Write）2 

 
    Code Lower limit Upper limit 

Common Judge. Max. and Min. 0902 h 0 62500 

 

Connector Binary Window（Write）3 

 
    Code Lower limit Upper limit 

Individual Judge. Maximum 0903 h 0 62500 

  Minimum 0904 h     

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0900 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0900 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0900 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Cell No.    

 CIR +8 , CIR +9 Data    
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Connector Binary Window（Write）4 

 
    Code Lower limit Upper limit 

Common Judge. Max. and Min. 0905 h 0 62500 

 

Connector Gray Window（Write）1 

 
    Code Lower limit Upper limit 

Common Judge. Maximum 0A00 h 0 255 

  Minimum 0A01 h     

 

Connector Gray Window（Write）2 

 
    Code Lower limit Upper limit 

Common Judge. Max. and Min. 0A02 h 0 255 

 

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0900 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 18    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Cell No.    

 CIR +8 , CIR +9 Data 1 (Min.)    

 CIR +10 , CIR 

+11 

Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0A00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0A00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    
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Connector Gray Window（Write）3 

 
    Code Lower limit Upper limit 

Individual Judge. Maximum 0A03 h 0 255 

  Minimum 0A04 h     

 

Connector Gray Window（Write）4 

 
    Code Lower limit Upper limit 

Common Judge. Max. and Min. 0A05 h 0 255 

Connector Gray Edge（Write）1 

 
    Code Lower limit Upper limit 

Judge. Pitch Maximum 0B00 h 0 99999999 

  Minimum 0B01 h     

Distance 
Difference Judge.  

Maximum 0B03 h 0 99999999 

Minimum 0B04 h     

* Only integers can be written. 

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0A00   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Cell No.    

 CIR +8 , CIR +9 Data    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0A00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 18    

 CIR +3 Code   COR +2   0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Cell No.    

 CIR +8 , CIR +9 Data 1 (Min.)    

 CIR +10, CIR +11 Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0B00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    
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Connector Gray Edge（Write）2 

 
    Code Lower limit Upper limit 

Judge. Pitch Max. and Min. 0B02 h 0 99999999 

Distance 
Difference Judge. Max. and Min. 0B05 h 0 99999999 

* Only integers can be written. 

 

Smart Edge Circle（Write）1 

 
    Code Lower limit Upper limit 

Measurement  Maximum 0C00 h 0 99999999 

  Minimum 0C01 h     

Standard Deviation Maximum 0C03 h 0 99999999 

  Minimum 0C04 h     

Circularity Maximum 0C06 h 0 99999999 

  Minimum 0C07 h     

Unused Edge Count Maximum 0C09 h 0 3597 

* Only integers can be written. 

 

 

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0B00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0C00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    
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Smart Edge Circle（Write）2 

 
    Code Lower limit Upper limit 

Measurement  Max. and Min. 0C02 h 0 99999999 

Standard 
Deviation Max. and Min. 0C05 h 0 99999999 

Circularity Max. and Min. 0C08 h 0 99999999 

* Only integers can be written. 

Smart Edge Line（Write）1 

 
    Code Lower limit Upper limit 

Measurement  Maximum 0D00 h 0 99999999 

  Minimum 0D01 h     

Standard Deviation Maximum 0D03 h 0 99999999 

  Minimum 0D04 h     

Linearity Maximum 0D06 h 0 99999999 

  Minimum 0D07 h     

Unused Edge Count Maximum 0D09 h 0 2998 

* Only integers can be written. 

 

 

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0C00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0D00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    
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Smart Edge Line（Write）2 

 
    Code Lower limit Upper limit 

Measurement  Max. and Min. 0D02 h 0 99999999 

Standard 
Deviation Max. and Min. 0D05 h 0 99999999 

Linearity Max. and Min. 0D08 h 0 99999999 

* Only integers can be written. 

Color Window（Write）1 

 
    Code Lower limit Upper limit 

RGray Maximum 0E00 h 0 255 

  Minimum 0E01 h     

RGray Ave. Maximum 0E03 h 0 255 

  Minimum 0E04 h     

RGray Std. Devi. Maximum 0E06 h 0 127 

  Minimum 0E07 h     

GGray Maximum 0E09 h 0 255 

  Minimum 0E0A h     

GGray Ave. Maximum 0E0C h 0 255 

  Minimum 0E0D h     

GGray Std. Devi. Maximum 0E0F h 0 127 

  Minimum 0E10 h     

BGray Maximum 0E12 h 0 255 

  Minimum 0E13 h     

BGray Ave. Maximum 0E15 h 0 255 

  Minimum 0E16 h     

BGray Std. Devi. Maximum 0E18 h 0 127 

  Minimum 0E19 h     

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0D00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0E00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data    
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* Only integers can be written. 

 

Color Window（Write）2 

 
    Code Lower limit Upper limit 

RGray Max. and Min. 0E02 h 0 255 

RGray Ave. Max. and Min. 0E05 h 0 255 

RGray Std. Devi. Max. and Min. 0E08 h 0 127 

GGray Max. and Min. 0E0B h 0 255 

GGray Ave. Max. and Min. 0E0E h 0 255 

GGray Std. Devi. Max. and Min. 0E11 h 0 127 

BGray Max. and Min. 0E14 h 0 255 

BGray Ave. Max. and Min. 0E17 h 0 255 

BGray Std. Devi. Max. and Min. 0E1A h 0 127 

* Only integers can be written. 

 

Geometry Calculation（Write）1 

 
    Code Lower limit Upper limit 

X COORD. Maximum 6500 h -99999999 99999999 

(IP X, Center X) Minimum 6501 h     

Y COORD. Maximum 6503 h -99999999 99999999 

(IP Y, Center Y) Minimum 6504 h     

Standard Deviation Maximum 6506 h 0 99999999 

  Minimum 6507 h     

Angle Maximum 6509 h -99999999 99999999 

  Minimum 650A h     

 Command    Response 

 CIR 0A12 h   COR Response completion=1  

 CIR +1 0E00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Checker No.    

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A13 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Geometry Calculation 
No. 

   

 CIR +6 , CIR +7 Data    
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Distance Maximum 650C h 0 99999999 

  Minimum 650D h     

Intersecting Angle Maximum 650F h 0 360 

  Minimum 6510 h     

Radius Maximum 6512 h 0 99999999 

  Minimum 6513 h     

Major Axis Maximum 6515 h 0 99999999 

  Minimum 6516 h     

Minor Axis Maximum 6518 h 0 99999999 

  Minimum 6519 h     

* Only integers can be written. 

 

Geometry Calculation（Write）2 

 
    Code Lower limit Upper limit 

X COORD. Max. and Min. 6502 h -99999999 99999999 

Y COORD. Max. and Min. 6505 h -99999999 99999999 

Standard Deviation Max. and Min. 6508 h 0 99999999 

Angle Max. and Min. 650B h -99999999 99999999 

Distance Max. and Min. 650E h 0 99999999 

Intersecting Angle Max. and Min. 6511 h 0 360 

Radius Max. and Min. 6514 h 0 99999999 

Major Axis Max. and Min. 6517 h 0 99999999 

Minor Axis Max. and Min. 651A h 0 99999999 

* Only integers can be written. 

Numerical Calculation（Write）1 

 Command    Response 

 CIR 0A13 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Geometry Calculation 
No. 

   

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A14 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 10    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Numerical calculation 
No. 

   

 CIR +6 , CIR +7 Data    
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    Code Lower limit Upper limit 

Judgement Maximum 6600 h -99999999 99999999 

  Minimum 6601 h     

* Only integers can be written. 

Numerical Calculation（Write）2 

 
    Code Lower limit Upper limit 

Judgement Max. and Min. 6602 h -99999999 99999999 

* Only integers can be written. 

Marker（Write） 

 
    Code Lower limit Upper limit 

Central Coordinate 
Moving Distance 

XY set 6701 h -6143 6143 

* Only integers can be written. 

* Witten values are in pixel units before calibration. 

 

 Command    Response 

 CIR 0A14 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Numerical calculation 
No. 

   

 CIR +6 , CIR +7 Data 1 (Min.)    

 CIR +8 , CIR +9 Data 2 (Max.)    

 Command    Response 

 CIR 0A15 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 18    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Camera No.    

 CIR +6 , CIR +7 Marker No.    

 CIR +8 , CIR +9 Data 1 (Movement 
amount X) 

   

 CIR +10 , CIR +11 Data 2 (Movement 
amount Y) 
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Slice Level（Write）1 

 
    Code Lower limit Upper limit 

Slice Level Maximum 6800 h 0 255 

  Minimum 6801 h     

Slice Level（Write）2 

 
    Code Lower limit Upper limit 

Slice Level Max. and Min. 6802 h 0 255 

 

 Command    Response 

 CIR 0A16 h   COR Response completion=1  

 CIR +1 0000 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2 0  

 CIR +4 , CIR +5 Camera No.    

 CIR +6 , CIR +7 Slice Level Group No.    

 CIR +8 , CIR +9 Data    

 Command    Response 

 CIR 0A16 h   COR Response completion=1  

 CIR +1 0A00 h   COR +1 

 

Normal end=0 

or Error code 

 

 CIR +2 14    

 CIR +3 Code   COR +2   0  

 CIR +4 , CIR +5 Camera No.    

 CIR +6 , CIR +7 Slice Level Group No.    

 CIR +8 , CIR +9 Data 1 (Min.)    

 CIR +10, CIR +11 Data 2 (Max.)    
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11.4 Command Communication Log 

11.4.1 What is Command Communication Log? 

This is a function to display the communication logs (history) of the general -purpose communication and 
PLC communication, or to save the logs in SD cards. 

The following communication data can be displayed and saved.  

 
・Control commands: Commands from external devices + Responses from PV200 

Requests from PV200 to external devices + Responses from external devices  
・Result output: Outputs from PV200 + Responses from external devices 

(Data set to "Output" from "ENVIRONMENT" > "Input/Output" > "General Output") 

 

As these communication logs belong to Environment settings, they will be initialized if executing "Initialize". 

The TRIG and OPE/SET switches of the keypad cannot be used while the setting window for the command 
communication log is displayed. Therefore, inspection cannot be started with the keypad, however, as the 
inspection start signal from an external device can be accepted, the communication log can be confirmed 
during the ongoing inspection.  

 

Interface: Available for RS232C interface and Ethernet interface. 

The patterns that can be output are as follows. 

Pattern 1 shows the case that PLC communication is selected for RS232C interface, 
and Patter 2 shows the case that PLC communication is selected for Ethernet interface. 

  Control command  Result Output 

RS232C Ethernet RS232C Ethernet 

General 
Com. 

PLC 
Com. 

General 
Com. 

PLC 
Com. 

General 
Com. 

PLC 
Com. 

General 
Com. 

PLC 
Com. 

Pattern 1 A A A N/A N/A A A N/A 

Pattern 2 A N/A A A A N/A A A 

A: Available. It is also OK not to use.  N/A: Not available 

Log form: Communication logs are displayed and output by any one of the following forms; 
"Command" that is telegraphic data in PV200 or "Data" that is telegraphic data based on 
transmission formats of various PLC devices. 

Save to: Communication logs can be saved in SD cards. 

Logs saved in SD cards can be always output in RUN menu. Also, when the command 
communication log list (see the next page) is displayed, the displayed log data can be saved 
manually. The folder and file names saved by "Keep logs" are different from those saved 
manually. The following figure shows the difference. 
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11.4.2 Screen Structure of Command Communication Log 

 

 
While command communication logs are displayed, inspection cannot be executed with the TRIG key. 
However, as the start signal from external devices can be accepted, the communication logs can be 
confirmed during the ongoing inspection. 

 
1 Log list Displays communication logs. 

The list is updated every time communication is performed when the monitor 
status of the following item 3 is "Monitoring". The latest histories (128 lines) are 
displayed. 

2 Highlighted log The selected communication log in the list is displayed. 

3 Monitor status Displays the monitor status. "Monitoring" or "Monitoring Stop" is displayed. It is 
Saving communication logs to a SD card does not depend on the monitor status, 
therefore, the saving continues while the status is "Monitoring Stop" when "Keep 
logs" has been set to "Yes". 

4 Format Displays the display format of communication logs. (It is switched between 
"Command" and "Data" in the setting window.) 

5 Polling view It is switched between displaying/saving polling data in PLC communication and 
not doing it. 

6 Communication 
log in RUN menu 
SD status 

Displays the writing status of communication logs to a SD card in the status 
display area. 
It is displayed when "Keep logs" has been set to "Yes". It is not displayed at the 
time of manual save. 
[Description] 

• Blank: No setting  
• Saving logs: Logs are always saved. 
• SD unfound: Logs cannot be saved as no SD card is inserted. 
• SD is full: Logs cannot be saved as the SD card is full. 
• SD is read-only: Logs cannot be saved as the SD card is read only. 
• SD cover is opened: Writing is not possible as the SD card cover is open. 

(when "Write When Cover is Open" has been set to "Invalid" from 
"ENVIRONMENT" > "Input/Output" > "SD Card Setting".) 

• Overwriting is limited: Log output was cancelled as the number of log folders 
and the number of files reached the upper limit. (Log output can be performed 
by setting "Overwrite" to "Yes" or increasing the maximum number of folders.) 
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 Keypad operation  

  FUNC SD Save/Set Displays the SD Save/Set window. The "SD Save" button saves 
monitor display logs to a SD card and the "Set" button displays the 
setting window for displaying or saving logs. 

  F1 Monitoring 
Start/Stop 

It is selected whether to start and keep updating the log display or stop 
it. 

  F2 Clear logs Clears all the logs displayed in the log list. This item is invalid when no 
log is displayed. 

  F3 Create New Log Use this to change the saving location to a new file when 
communication logs are always saved to SD cards. This item is invalid 
when "Keep logs" is not set. 

Confirming Communication Logs on Monitor 
 

1. Select "View" > "Command Communication Log" 
from the menu bar in RUN menu. 

2. The "Command Communication Log" window is 
displayed. 

3. Press the F1 key when "Monitoring Stop" is 
displayed as the monitor status. "Monitoring" is 
displayed. 

(When the monitor status has been already 
"Monitoring", there is no need to press this button. 
Logs are already displayed in the communication 
log list.) 
 

 
The F1 key switches whether to keep monitoring 
the monitor display or pause when the command 
communication log window is displayed. 

4. When PV200 communicates with external 
devices (general-purpose communication , PLC 
communication), the communication data is 
displayed on the monitor. 
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Stopping the Display of Communication Logs on  
Monitor 

The command communication log list is updated every time communication is performed when the monitor 
status is "Monitoring". To confirm the data in the pause state without updating, take the following 
procedure. 

 

1. Confirm the monitor status when the "Command 
Communication Log" window is displayed. 
Press the F1 key when "Monitoring" is displayed. 

(If "Monitoring Stop" is displayed, the display of the 
communication log list has been already stopped.) 
 

 
As the operation of "Keep logs" into SD card is not 
related to the monitor status, PV200 keeps saving logs 
when "Keep logs" has been set even if the monitor 
status is changed to stop. 

2. The log display on the monitor stops, and the list is 
not updated even when communication is 
performed. 

 
 

 

 

Clearing All Logs in the List (Clear Logs) 
 

1. Press the F2 key when the "Command 
Communication Log" window is displayed. 

 

2. When the message appears, select “Yes”. 

 
 

3. All the logs in the list are cleared. 
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11.4.3 Setting for Displaying and Saving Communication Logs 

Set the methods to display and save communication logs. 

Communication logs can be saved in SD memory cards. There are two methods to save logs, one is to always 
save logs and the other is to manually save the data displayed in the log list. 

When saving communication logs in a SD memory card, the inspection time will be longer for 8 to 12 ms. Also, 
when always saving logs and overwriting them, the inspection time will be longer for approximately 500 ms at 
the time of deletion of a folder in the SD memory card. Note that the time varies depending on the manufacturer 
or type of SD memory card. 

Setting the Contents of Communication Logs 
(Common to Display and Save) 
 

1. Press the FUNC key when the "Command Communication 
Log" window is displayed. 

2. Select "Set" in the communication log setting window 

The communication log setting window is displayed. 

3. Select "Format". 

Determine the target of communication logs. 
Select Command or Data. 
 
Command: 
(Default) 

For the general-purpose communication, 
original texts are displayed. For the PLC 
communication, communication data is 
processed and displayed. For details of 
the process, refer to 11.4.5 “Difference 
Between Display Formats "Command" 
and "Data" 

 
Data: Original texts of communication data is 

displayed. 
 

 
 

 

 

4. Select "Polling view". 

Select whether to display and save polling data as 
communication logs or not. 
This item is available when "Data" has been set for 
"Format". 
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Setting for Always Saving Communication Logs 

1. Select "Keep logs" in the communication log setting window. 

Select "No (default)" or "Yes". 
 
Once [Yes] is selected, it starts saving communication logs in a 
SD card. 
 

 
If a SD card is not inserted, or it does not have enough free 
space, a message will appear, and the setting will be changed 
to [Keep logs: No]. 

 

 

2. Select "Overwrite”. 

Select "No (default)" or "Yes". 
 
Set whether to overwrite logs or not when the number of log 
folders reaches the specified number, or it exceeds the 
capacity of the SD card. 
 
Yes: When the number of folders created by [Keep logs] 

reaches the specified [No. of Folders], the oldest 
log folder will be deleted, and a new folder will be 
generated. And log files will be output. 
 
Also, in the case of "SD is full", the oldest folder 
will be deleted, a new log file will be output after 
the generation of a new folder. 

No: 
(Default) 

The log output will stop when the number of log 
folders reaches the specified "No. of folders". 

 

 

 
 

3. Select "No. of Folders”. 

1 to 1000 (Initial Value: 10) 
 
Set the maximum number of folders to store communication log 
files generated by [Keep logs]. 

 

 
The name of a log file saved by [Keep log] is as follows. 
 
<File name> 
Cmd_Ayyyymmdd_hhmmss.log 

yyyy : Year (4 digits)   mm : Month  
dd: Day              hh: Hour 
mm: Minute           ss: Second 

 
50,000 lines are output as one file for logs. 
For logs more than 50,000 lines, a new file is generated for saving the next log. 
However, even if not exceed 50,000 lines, a new log file is generated in the following cases. 

1．when pressing the F3 key to save the next file. 
2．when pausing the ongoing output to a SD card and starting it again. 
3．When switching type. 
4．When rebooting PV. 

<Folder name where log files are stored> 
Cmdyymmddhhmmss 

(yymmddhhmmss is the generation time.) 
Up to 100 files are stored in one folder.  
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Changing Output Destination to a New File When 
Setting Keep Logs 

Method to change the output destination of log data to another file when always saving logs.  

1. Press the F3 key when "Keep logs" has been set 
(refer to the above description). 

 
The logs of sent and received commands are written 
into a new file after pressing the F3 key. 

 

 

Saving Communication Logs Currently Displayed in 
List to SD (Manual Save) 

1. "Stop" the monitor status when the "Command 
Communication Log" window is displayed. 

Press the F1 key when the monitor status is 
"Monitoring". 

2. Press the FUNC key when the "Command 
Communication Log" window is displayed. 

3. Select "Save to SD" in the communication log 
setting window. 

The displayed log data is saved in the SD card. 
A file is created in ¥Panasonic-EW SUNX 
Vision¥PV200¥Log. 
 
File Name: Cmd_Myyyymmdd_hhmmss.log 
 

yyyymmdd: Date of file creation of  
the built-in calendar of PV200 

yyyy: Year (4 digits)   
mm: Month (2 digits 
dd: Day (2 digits) 
hhmmss: The time of file creation of  

the built-in calendar of PV200 
hh: Hour (2 digits) 
mm: Minute (2 digits) 
ss: Second (2 digits) 

 
Example) In the case of 14:23:5 on February 14, 2014 

→ Cmd_M20140214_142305.log 

 
 

     
 

 
 

4. Press the "Abort" button to stop saving. 
A file is created in ¥Panasonic-EW SUNX Vision¥PV200¥Log. 
The message "Are you sure to stop saving?" is displayed. Select 
"Yes" to stop the saving to the SD card. 
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11.4.4 Management of Log Data Saving to SD Card 

When saving communication logs between PV200 and external devices to a SD card, a management file will 
be automatically created in the SD card. It decreases the number of times PV200 tries to access the SD card at 
the time of saving logs so that the time taken for saving can be shorten and logs are output effectively. 

 
Management file name: CmdComLogMng.bin 

 

The following contents are stored in this file. 

・Current folder name (Name of the most recently accessed folder among the folders when "Keep logs" has 
been set.) 

・The number of files in the current folder (The current number of accessed files when "Keep logs" has 
been set.) 

・Number of folders (Number of folders when setting "Keep logs") 

・Oldest folder name (Name of the oldest folder in the folders when setting "Keep logs")  

When logs are saved, if there is no management file, it will be automatically created at the time of saving.  

 

Timing of Saving Logs to SD Card When Setting "Keep 
Logs" 

When setting "Keep logs", logs are output to the SD card every time communication is performed.  

Example) 

 

 
 

The data displayed in the above figure is written to a file one by one as below.  

14:05:51(9217) <%EE#WCP1R01181**[0D] Write→ 

 

14:05:51(9226) >%EE$WC15[0D] Write→ 

14:05:59(7486) <%EE#WCP4R01100R01110 R01180 R01190**[0D] Write→ 

14:05:51(7498) >%EE$WC15[0D] Write→ 
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11.4.5 Difference Between Display Formats "Command" and "Data" 

There are two methods to display communication logs, which are "Command" and "Data". Using 
"Command" displays and outputs telegraphic logs in PV200, and using "Data" displays and outputs logs in 
the transmission format of a PLC to be communicated. The following figures show the displays on the 
monitor when an inspection start command (page 649) is given using PLC communication and the 
inspection is executed. 

 

[Command] [Data] 

 

 
The processing flow is as below. It is the same as that described in 11.3.3. When selecting "Command", 
only the logs in the ■ parts are displayed and output. When selecting "Data", written and read data such 
as "Turn the command processing bit to 1" is also treated as logs.  

 

PV200    PLC 

     
Receives START signal.  

 
 Outputs START signal for inspection 

execution. 

Turns on command processing bit in case 
of accepting inspection by control 
command. 

 
 

 

  

  Command read type: Always turns off 
command start bit in case of polling. 

Writes response in command output 
register, turns on response completion and 
turns off command processing bit. 

   

    

Executes inspection; capturing image and 
performing checkers. 

 
 

  

     

Changes "Data output completion notice" 
to “0” and writes data in PLC from the 
specified address. (Writes data 
communicating commands and response 
messages with the dedicated protocol.) 

 

 

 Writes data in the address specified by 
data output register. 

     

Changes "Data output completion notice" 
to "1". 

 
 

 As detecting the data output completion 
signal is “1”, confirms the address where 
the data have been stored. 

     

Waits for the next signal.  
 

 Goes back to the beginning and outputs 
START signal for the next inspection 
execution. 
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11.4.6 Log Transmission Format 

Communication log data is displayed and output in the following formats.  

The formats differ depending on the communication methods (general-purpose communication or PLC 
communication) and display methods (Command or Data).  

・General-purpose device (Communication command, Result output) 
・PLC communication (Communication command, Result output, Error) 
・Serial communication error 

 

 
The time at which logs are output is indicated in every data. 
The time (hh:mm:dd) is the time of the calendar in PV200, and ms(xxxx) is the counter value which counts "ms" 
in PV200. The calendar time and the counter of ms are asynchronous. Use the value of ms for checking the 
interval of communications.  

General-purpose Communication: Transmission 
Format (Format: Command or Data) 

Control with General-purpose communication commands 

Sent and received data is displayed and output as 
follows. 

 

The right figure and the table below show the state 
when PV200 received the type switch command 
(%X2). In the second line, PV200 sent back the error 
E0210 because there is no appropriate type.  

 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 ・・・ 

Format (1)Log output time (2) 
sp 

(3) 
Error No. 

(4) 
sp 

(5) (6) Command data 

Input 0 9 : 4 8 : 2 3 (  5  9  8  0  )    > % X 2 4 F 

Output 0 9 : 4 8 : 2 3 (  5  9  8  3  )  E  0  2  1  0  < % X ! 2 1 0 6 F 

(sp: Space) 

(1) Log output time 14 bytes 
hh:mm:ss(xxxx)  
  hh: hour, mm: minute, ss: second, xxxx: millisecond 

(2) Space 1 byte  

(3) Error No. 5 bytes Normal state: 5 spaces ("     "), 
Error state: "Exxxx (xxxx: 4-digit error number) 

(4) Space 1 byte  

(5) 
Communication 
direction 1 byte ">": Receive, "<": Send 

(6) Command data Variable General-purpose command 
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Data Output 

(Output when "Protocol" has been set to "General Com." from "ENVIRONMENT" > "Input/Output" > 
"General Output".) 

Result data is displayed and output as follows. 

 

The third line and the subsequent lines in the right 
figure show the state that general result output was 
performed via Ethernet. (The inspection start 
command was sent to PV200 from an external device 
in the first line, and the result was output in the third 
line.) 

 
 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18  ・・・ 

Format (1)Log output time (2) 
sp 

(3) Result output data 

Output 1 3 : 4 4 : 0 5 (  2  5  0  2  )  1 4 / 0 2 / 0 1 , 1 3 : 4 4 : 0 5 ,  8 1 , 0 , - 4 4 8 7 2 , 4 5 2 6 5  

    |_ __ Date and time_____|  ｜ ｜ |___Numerical calculation__| 
Scan count   Judgement 

(sp:Space） 

(1) Log output time 14 bytes hh:mm:ss(xxxx)  
  hh: hour, mm: minute, ss: second, xxxx: millisecond 

(2) Space 1 byte  

(3) 
Result output 
data 

Variable  
(Max. 241 bytes) 

The results (*) of the items that have been set to be output 
from "ENVIRONMENT" > "Input/Output" > "General 
Output" are displayed and output as character strings.(*: 
Date and time, Scan count, Total judgement, Judgement 
output, Numerical calculation, BCC) 

PLC Communication: Transmission Format 
(Format: Command) 

Control Command 

Sent and received data is displayed and output as 
follows. 

 

The right figure and the table below show the 
state when PV200 received the type switch 
command. PV200 sent back the error E0210 
because there is no appropriate type. 

 

 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 

Format (1) Log output time (2) 
sp 

(3)Error No. (4) 
sp 

(5) (6) PLC data 

Input 1 1 : 5 7 : 4 0 (  3 6 3 5 )    > 0 1 0 0 , 0 1 0 0 , 0 0 0 4 , 0 0 0 2 , 0 0 0 0 

Output 1 1 : 5 7 : 4 0 (  3 6 3 9 )  E 0 2 1 0  < 0 0 0 1 , 0 0 D 2 , 0 0 0 0     

(sp: Space) 

(1) Log output time 14 bytes 
hh:mm:ss(xxxx)  
  hh: hour, mm: minute, ss: second, xxxx: millisecond 

(2) Space 1 byte  

(3) Error No. 5 bytes 
Normal state: 5 spaces ("     "),Error state: "Exxxx (xxxx: 4-digit 
error number) 
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(4) Space 1 byte  

(5) 
Communication 
direction 1 byte ">": Receive (Obtain data from PLC), "<": Send (Request to PLC)  

(6) PLC data Variable 
Displays communication contents 
They are displayed by two bytes in hexadecimal. Separated 
section is divided with a comma (","). 

 

 

Result Output 

(Output when "Protocol" has been set to "PLC Com." from "ENVIRONMENT" > "Input/Output" > 
"General Output".) 

Result data is displayed and output as follows. 

 

The right figure shows the state when the 
inspection result 2 data was output to PLC. 
 

 
 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18  ・・・ 

Format (1) Log output time (2) 
sp 

(3) Result output data 

Output 1 8 : 2 9 : 1 2 (  1  5  0  6  )  0 0 1 9 , F F D 3 

(sp: space) 

 

(1) Log output time 14 bytes 
hh:mm:ss(xxxx)  
  hh: hour, mm: minute, ss: second, xxxx: millisecond 

(2) Space 1 byte  

(3) 
Result output 
data 

Variable 
(Max. 241 bytes) 

Results (*) of the items set to be output among the communications 
for which "Protocol" has been set to "PLC Com." in 
"ENVIRONMENT" > "Input/Output" > "General Output" are 
displayed and output separated with commas by two bytes in 
hexadecimal. (*: Scan count, Total judgement, Judgement output, 
Numerical calculation, BCC) 

 

PLC Communication: Transmission Format 
(Format: Data) 

Control Command 

Sent and received data is displayed and output as 
follows. 

 

The right figure shows the state when PV200 read 
and handled the command written to a register in 
Panasonic PLC FPsigma.  
ASCII code and control code are displayed. 
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 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 ・・・ 

Format 
(1) Log output time (2) 

sp 
(3) (4) PLC data 

Read 1 0 : 4 1 : 3 0 (  7  9  8  7  )  < % E E # R D D 0 1 0 0 0 0 0 1 0 0 2 * * [ 0 D ] 

Write 1 0 : 4 1 : 3 0 (  7  9  9  7  )  > % E E # R D 0 0 0 2 1 0 0 1 0 0 0 0 1 5 [ 0 D ] 

Read 1 0 : 4 1 : 3 0 (  8  0  0  7  )  < % E E # W C P 2 R 0 1 1 0 1 R 0 1 1 1 0 * * [ 0 D ] 

Response 1 0 : 4 1 : 3 0 (  8  0  1  6  )  > % E E # W C 1 5 [ 0 D ] 

 ・・・ 

(sp: Space) 

(1) Log output time 14 bytes hh:mm:ss(xxxx)  
  hh: hour, mm: minute, ss: second, xxxx: millisecond 

(2) Space 1 byte  

(3) Communication 
direction 

1 byte ">": Receive (Obtains data from PLC), "<": Send (Requests to PLC)  

(4) PLC data Variable Displays communication contents 
Transmission formats differ depending on PLC types. Confirm the 
specifications of PLC. 
ASCII codes, control codes and binary codes are mixed in the displayed 
data. 
・ASCII code: Displayed and read as is. 
・Control code: Displayed with [ ] by one byte in hexadecimal. 
・Binary code: Displayed with [ ] by one byte in hexadecimal. 
 
Control code is the control characters of ASCII. (CR code which indicates 
the end position of communication (that is expressed as [0d] ) is it.) 

 
Output example) 
ASCII + Control code 

13:45:34(3145) <%EE#RDD0001600018**[0d] 
13:45:34(3216) >%EE$RD024000010800**[0d] 

 
Binary code 

16:07:00(8285) <[50][00][00][ff][ff][03][00][0c][00][14][00][01][04][00][00][00][00][00][90][02][00] 
16:07:00(8367) >[d0][00][00][ff][ff][03][00][06][00][00][00][01][00][03][01] 

 
Binary code + ASCII + Control code 

16:05:55(3867) <[10][00][13][00][00][00][00][00][00][00][01]@%01#RCCR00000001**[0d] 
16:05:55(3925) >[10][00][11][00][00][00][00][00][00][00]@[01]%01$RC01000301**[0d] 

Result Output 

Result data is displayed and output as follows. 

 

The right figure shows the state when PV200 
read and handled the command of PLC by 
writing two results to a register in Panasonic 
PLC FPsigma. 
  

The communication format is the same as that of the above "Control command".  
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PLC Communication: Transmission Format (When 
Communication Error Occurs) 
 

When an error occurs in PLC communication, the 
error number will be displayed and output as 
shown in the right figure. 

 

 

 
When an error occurs in PLC communication, the error number will be displayed and output in the next 
format.  

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 ・・・ 

Format (1) Log output time (2) 
sp 

(3) Error code 

Input 1 5 : 3 8 : 3 6 (  0  9  8  3  )  E 0 1 1 3 

(sp: Space) 

(1) Log output 
time 

14 bytes hh:mm:ss(xxxx)  
  hh: hour, mm: minute, ss: second, xxxx: millisecond 

(2) Space 1 byte  

(3) Error Code Character 
string 

Displays error codes as character strings. 
 
E0111: Timeout occurs because of polling. 
It occurs when no response is returned from PLC until the time 
specified from "ENVIRONMENT" > "Input/Output" > "PLC 
Communication" > "Timeout" has elapsed. 
E0113: "Start bit off timeout" occurs. 
Cause: It occurs when the time until PLC turns off the command start 
bit after PV200 turns on the command processing bit exceeds the 
specified time. 
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Serial Communication: Output Format When Error 
Occurs 

 

When an error occurs in serial communication, the 
descriptions and codes of the error will be 
displayed and output as shown in the right figure. 

 

 

 

 
When an error occurs in serial communication, they will be displayed and output in the next format.  

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 ・・・   

Format (1) Log output time (2) 
sp 

(3) Error type (4) 
sp 

(5) Error code 

Input 1 4 : 5 0 : 5 0 (  9  9  4  3  )  F r a m i n g E r r o r  [ 0 1 ] 

(sp: Space) 

 

(1) Log output 
time 
 

14 bytes hh:mm:ss(xxxx)  
  hh: hour, mm: minute, ss: second, xxxx: millisecond 

(2) Space 1 byte  

(3) Error type Character 
string 
(Variable) 

[Displayed character strings] [Descriptions] 

Framing Error Occurs when serial communication 
settings are unmatched. 

Parity Error Occurs in parity check in serial 
communication settings. 

Over Run Interrupt occurs. 

Rx Ring-Buffer OverFlow Overflow of receive buffer occurs. 

(4) Space 1 byte  

(5) Error code  The number of the error occurred is displayed and output as 5-bit number 
between 1 and 31. 
Framing Error: The 0th bit turns on. / Parity Error : The 1st bit turns on. 
Break Error: The 2nd bit turns on. / Over Run : The 3rd bit turns on.  
Rx Ring-Buffer OverFlow: The 4th bit turns on. 
 
Example) Framing error and Parity error occurred simultaneously. 
          Error code = 1 + 2 = 3 
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12.1 About PVWIN200 

PVWIN200 is software of setting and simulation for PV200. Almost items set in PV200 can be also set with 
PVWIN200. 

In PVWIN200, the program can be simulated off-line with PV200. For this, you can adjust the set programs by 
simulating them to confirm they obtain the expected results on the images captured with a camera and saved in 
a PC. 

Downloading PVWIN200 
To use PVWIN200, download the file from our web site. Downloading the software requires registration of your 
information (for free), MAC address of PV200, and MAC address of your PC. 

 

http://panasonic.net/id/pidsx/e 

(“Products” > "Machine Vision System" > "PV200" > "Software")  

 

 
When PVWIN200 is installed, PVImageConverter is also installed at the same time.  

Hardware Requirements of PVWIN200 
 

PC Compatible computer for IBM PC/AT 

OS *1 Windows XP / Vista / 7*2 / 8*2 

Hard Disc Capacity 
Requirement 

70 MB or more 
*(excluding storage for the setting data or images) 

CPU Pentium III 700 MHz or more 

Memory Amount 512 MB or more 

Display resolution 1024 x 768 or more 

Display color Full Color (32-bit) or more 

Communication format USB 2.0, Ethernet (1000BASE-T/100BASE-TX/10BASE-T) 

*1: As for operation systems other than Windows 7 and Windows 8, only 32-bit edition is applicable. 
*2: Note that there are some restrictions on installation. For details, refer to the PVWIN200 download page on our 

web site. 

Connecting PV200 with PC 
Connect PV200 and the PVWIN200-installed PC with a USB cable or an Ethernet cable.  
About connection with an Ethernet cable, refer to page 587. 

Connecting with USB Cable 

Use a USB cable (for 2.0, AB type) of which length is 5m or less. 
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12.1.1 Communicating with PV200 

Uploading or downloading setting data or image data may not be performed according to the status of 
PV200. 
To communicate with PV200, set the status to be in the conditions listed below. 

 
When the image receiving software "Image Receiver for PV" is running and the connection is established 
on the PC that PVWIN200 is running, PVWIN200 cannot communicate with PV200.  

A: Available   N/A: Not available 
Operation Status RUN menu SETUP menu 

Function RUN STOP "TOOL" - "PC 
Communication" 

Other 
statuses 

Upload/download of setting data 
(Settings including ENVIRONMENT, TYPE 
and INSPECTION) 

A* A A N/A 

Reading of image data (Images in the 
inspection image memory of PV200) N/A A A A 

Upload of saved images 
(Images saved in the storage space in 
PV200) 

N/A A A N/A 

Download of test images 
(Downloading images saved in a PC into 
the test image memory of PV200) 

N/A N/A A N/A 

* : READY signal turns off and inspections cannot be executed during the communication.  
 

12.1.2 Upload and Download of Setting Data 

In PVWIN200, setting data is called Project File. Project files can be downloaded to PV200 (PVWIN200 to 
PV200) or uploaded from PV200 (PV200 to PVWIN200). 

 
After downloading a project file from PVWIN200 to PV200, be sure to save the data in PV200. Turning off the 
power of PV200 without saving data removes the downloaded project file from the PV200. 

When PV200 is in RUN menu 
Operate uploading or downloading from PVWIN200. (No need to operate from PV200.) 

 

When executing upload, the currently inspecting data are uploaded. 

When executing download, the data are overwritten on the currently inspecting data. After downloading is 
complete, inspections will be executed with the setting data of the downloaded project file. 

READY signal turns off and inspections cannot be executed during the upload or download. 
 

When communication error occurs 

When a communication error occurs, the notice is displayed on the screen of PVWIN200 or PVWIN200 and 
PV200. Execute again after solving the problem described on the message. 

When PV200 is in SETUP menu 
To upload or download the data in SETUP menu, PV200 requires being in the status where it can communicate 
with PC. Other than the status, you cannot upload and download the data. 

When executing upload, the data currently loaded on SETUP menu are uploaded. When executing download, 
the data are overwritten on the data currently loaded on SETUP menu. 
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1. Select "TOOL” > “PC Communi.” from the 
menu bar. 

The PV200 becomes to be able to 
communicate with PC and the current 
communication status is displayed under the 
menu. 
 

 
"10.1.1 Communicating with PV200 (page 
709)" 

 

2. Execute communication from PVWIN200. 

The display changes to "Transmitting..." and a project file (setting data) is downloaded or uploaded.  
Pressing the CANCEL key during the communication stops the transmitting and the display changes to 
"Terminating..." and eventually to "Standby". 

 
When communication error occurs 
When the devices cannot communicate, the display shows "Communication Error". (When the next 
transmission is executed, the display changes to "Transmitting...") 
When a communication error occurs, the notice is displayed on the screen of PVWIN200 or PVWIN200 
and PV200. Execute again after solving the problem described on the message. The error occurring during 
download initializes (deletes all) the setting data loaded on PV200. And the error during upload initializes 
the contents of the project file being set on PVWIN200. 

3. After transmission is complete, press the CANCEL key to cancel the communication mode. 

12.1.3 Reading the Latest Image of PV200 

The latest image of PV200 can be read out on the camera window of PVWIN200 by a command from 
PVWIN200. Make PV200 be the state that can communicate. Refer to "10.1.1 Communicating with PV200 
(page 709)". 

1. Execute an inspection in RUN menu of PV200. 

The inspected image can be read with PVWIN200. When no inspection is executed, PVWIN200 cannot 
read because there is no image to read. 

2. Execute image reading from PV200 with PVWIN200. 

The latest image of PV200 is read out. 

 
When "Detect Trigger" is used as Camera Trigger, the device reads the image of when detect trigger is 
executed. When no detect trigger is executed, image cannot be read because there is no image to read. 
(Although a memory image is displayed even when no detect trigger is executed, the memory image cannot be 
read.) 

 

When communication error occurs 

When a communication error occurs, the message is displayed on the screen of PVWIN200 or PVWIN200 and 
PV200. Execute again after solving the problem described on the message. 
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12.1.4 Uploading Images in Storage Space in PV200 

This is the function that efficiently saves the images stored in the storage space in PV200 into a PC by a 
command from PVWIN200. Make PV200 be the state that can communicate. Refer to "10.1.1 
Communicating with PV200 (page 709)". 

1. Go to SETUP menu and select “TOOL” > “PC 
Communi.” from the menu bar. 

The PV200 becomes to be able to communicate 
with PC and the current communication status is 
displayed under the menu. 

 
"10.1.1 Communicating with PV200 (page 709)" 

 

2. Execute communication from PVWIN200. 

Specifying the destination of images with PVWIN200 starts communication. The display of PV200 changes 
to “Transmitting…” Pressing the CANCEL key during the communication stops the transmitting and the 
display changes to “Terminating...” and eventually to “Standby”. 

 
When communication error occurs 
When the devices cannot communicate, the display shows “Communication Error”. (When the next 

transmission is executed, the display changes to “Transmitting...”) 
When a communication error occurs, the notice is displayed on the screen of PVWIN200 or PVWIN200 
and PV200. Execute again after solving the problem described on the message. 

3. After transmission is completed, press the CANCEL key to cancel the communication mode. 

 

About File Name 

Images are saved in the specified folder as the following name. 

For Gray Camera: Cn_NNN.bmp 

For Color Camera: Cn_NNN.byr 
- Cn_: Camera No. C0_ to C1_ 
- NNN: Image No. 000 – 

 

 
Image files for color cameras are created as bayer images (.byr).  

Images saved in this format (.byr) cannot be confirmed with general applications such as a PC.  

Bayer images can be confirmed on PV200, PVWIN200 or PVImageConverter.  
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12.1.5 Downloading images into Test Image Memory of PV200 

This is the function that downloads the images stored in a PC into the Test Image Memory of PV200 by a 
command from PVWIN200. 

Other than the images uploaded from PV200, images that meet the following conditions can be downloaded. 
 Download for Gray Camera 

- 256-color bitmap format (Size of 4 MB or less) 
 Download for Color Camera 

- 24-bit color bitmap format (Size of approx. 6 MB or less) 
- Bayer format (Size of approx. 2 MB or less) 
 

 
Images compatible with color cameras cannot be downloaded for gray cameras. 

Images compatible with gray cameras cannot be downloaded for color cameras.  

 

1. Go to SETUP menu and select “TOOL” > “PC 

Communi.” from the menu bar. 

The PV200 becomes to be able to communicate with 
PC and the current communication status is 
displayed under the menu. 

 

2. Execute communication from PVWIN200. 

Specifying the destination of images with PVWIN200 starts communication. The display of PV200 changes 
to “Transmitting…” Pressing the CANCEL key during the communication stops the transmitting and the 

display changes to “Terminating...” and eventually to “Standby”. 
 

When communication error occurs 
When the devices cannot communicate, the display shows “Communication Error”. (When the next 
transmission is executed, the display changes to “Transmitting...”) 
When a communication error occurs, the notice is displayed on the screen of PVWIN200 or PVWIN200 
and PV200. Execute again after solving the problem described on the message. 

3. After transmission is completed, press the CANCEL key to cancel the communication mode. 
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12.2 About PVImageConverter 

PVImageConverter is software to check bayer images (refer to page 373) saved with PV200 or Image 
Receiver for PV on a PC, or to convert bayer images to RGB images (.bmp). 

Downloading PVImageConverter 
PVImageConverter is installed together when PVWIN200 is installed.  

 

 Downloading PVWIN200 (page 708) 

Hardware Requirements of PVImageConverter 
 

PC Compatible computer for IBM PC/AT 

OS *1 Windows XP / Vista / 7*2 / 8*2 

CPU Pentium III 700 MHz or more 

Memory Amount 512 MB or more 

Display resolution 1024 x 768 or more 

Display color Full Color (32-bit) or more 

*1: As for operation systems other than Windows 7 and Windows 8, only 32-bit edition is applicable. 
*2: Note that there are some restrictions on installation. For details, refer to the PVWIN200 download page 

on our web site.  
 

Checking Bayer Images 

1. Start PVImageConverter. 

2. Specify the folder saving bayer images 

You can check bayer images in the folder one by one on the screen in the window. 

Converting Bayer Images to RGB Images 

1. Check bayer images with PVImageConverter. 

2. Convert the bayer image (.byr) you want to convert to RGB image (.bmp). There are two types of 
conversion, "All Convert" and "Convert". 

- All Convert: Changes the extension of file names, and creates RGB images in the same folder. 
- Convert : Creates a RGB image by specifying a folder and file name. 
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13.1 General Specification 

PV200 

CPU 32-bit RISC CPU & DSP 

Number of camera connections Up to 2 *1 

Processing resolution 0.3-Mega Camera (Quad-speed Gray/Quad-speed Color/Compact Gray): 
Hor. 640 x Ver. 380 pixels 
0.3-Mega Camera (Compact Color): Hor. 640 x Ver. 478 pixels 
2-Mega Camera (Gray/Color): Hor. 1600 x Ver. 1200 pixels  
4-Mega Camera (Gray): Hor. 2048 x Ver. 2048 pixels 
Partial imaging is available (One area) 

Processing function Gray camera/Color camera: Gray scale processing/Binary)  
Color camera: Color/Color extraction/Grayscale conversion 

Interface Serial RS-232C x 1 

Parallel input I/O terminal: Input 14 points,  
24V DC, Bi-directional photo coupler 

Parallel 
output 

I/O terminal: Output 15 points,  
5 to 24V DC, Photo Mos output  

USB For USB2.0, AB type (for PVWIN200 only) 

Ethernet Ethernet Port x 1 
Media: 10-BASE-T / 100BASE-TX / 1000BASE-T  
Protocol: TCP/IP (General communication), UDP/IP (PLC communication) 

Memory card SD memory card slot x1 

Monitor 
output 

1ch: VGA (640 X 480) output 

Setting 1 ch: For the dedicated keypad 

Rating Voltage 24 V DC  Operating voltage range: 21.6 to 26.4 V DC (with ripples)  

Power 
Consumption 

1.2 A or less 

Environmental 
resistance 

Operating 
temperature 
range 

0 to +45 °C (without icing and dew condensation) 

Operating 
humidity 
range 

35 to 85% RH (without icing and dew condensation at 25°C) 

Noise 
resistance 

1000 V pulse width 50 ns/1 µs (a noise simulator was used.)  

Vibration 
resistance 

10 to 55 Hz, one sweep per minute, amplitude 0.75 mm, 30 minutes each in 
X/Y/Z direction 

Shock 
resistance 

196m/ s2, 5 times each in X, Y and Z directions 

Insulation 
resistance 
(initial) 

100 MΩ or more (500 V DC by insulation resistance tester)*2 
Input terminals and output terminals - Power terminal and functional earth 
Input terminals and output terminals - Non-electrifiable metal part 
Power terminal - Non-electrifiable metal part 

Voltage 
resistance 
(initial) 

500 V AC / minute (600 V AC / second), cutoff current 10 mA *2 
Input terminals and output terminals - Power terminal and functional earth 
Input terminals and output terminals - Non-electrifiable metal part 
Power terminal - Non-electrifiable metal part 

Battery life Approx. 10 years (at 25°C) 

Weight Approx. 0.5 kg (including Terminal block) 

*1: When connecting a 2-Mega camera, only a gray camera can be used in combination. Also, a 4-Mega 
camera cannot be used with other cameras. (Refer to page79.) 
*2: Tested with the varistor and the condenser at the primary side of the power supply for the internal circuit 
removed. 
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Keypad 
Operation keys ENTER key, TRIG(TRIGGER) key, FUNC(FUNCTION) key, CANCEL 

key, F1 key, F2 key, F3 key, OPE/SET switch, LOCK key, and SHIFT 
key 

Environmental 
resistance 

Operating 
humidity range 

35 to 85% RH (without icing and dew condensation at 25°C) 

Operating 
temperature range 

0 to + 45°C (without icing and dew condensation) 

Weight ANPVP03: 170g, ANPVP10: 425g 

0.3-Mega Gray Camera: ANPVC1040 / 0.3-Mega Color Camera: ANPVC2040 
2-Mega Gray Camera: ANPVC1210 / 2-Mega Color Camera: ANPVC2260 

 0.3-Mega Gray/Color Camera 2-Mega Gray/Color Camera 

Image sensor Interline transfer method. 
1/3-inch CCD 
Pixel size: 7.4 ｍ x 7.4 ｍ 
(tetragonal pixel)  

Interline transfer method. 
1/1.8-inch CCD 
Pixel size: 4.4 ｍ x 4.4 ｍ 
(tetragonal pixel)  

Number of effective pixels Horizontal 659 x vertical 494 
pixels 

Horizontal 1628 x vertical 1236 
pixels 

Scanning method Non-interlace 

Shutter Speed 0.03 to 1000.00 ms (30 s to 1 s) 

Lens mount C mount 

Synchronous Method Internal synchronous 

Picture output Digital output 

Rating Power supply 
voltage 

12 V DC +/- 10% 

Power 
Consumption 

235 mA or less 360 mA or less 

Environmental 
resistance 

Operating ambient 
temperature 

0 to +45°C (without icing and 
dew condensation) 

0 to +40°C (without icing and 
dew condensation) 

Operating ambient 
humidity 

35 to 85% RH (without icing and dew condensation at 25°C) 

Vibration 
resistance 

10 to 55 Hz, 1 sweep per minute, amplitude 1 mm, 30 minutes in each 
X, Y and Z directions 

Shock resistance 700 m/s2, 3 times each in X, Y and Z direction 

Weight Approx. 65g (without lens) 

0.3-Mega Compact Gray Camera (ANPVC5030)/0.3-Mega Compact Color Camera 
(ANPVC6030) 

Image sensor Interline transfer method. 1/3-inch CMOS 
Pixel size: 6.0 ｍ x 6.0 ｍ (tetragonal pixel)  

Number of effective pixels Horizontal 752 x vertical 480 pixels 

Scanning method Non-interlace 

Shutter Speed 0.10 to 500.00 ms (100 s to 0.5 s) 

Lens mount C mount (Without C-mount Adapter: NF mount) 

Synchronous Method Internal synchronous 

Picture output Digital output 

Rating Power supply 
voltage 

11.0 ～13.0 V DC 

Power 
Consumption 

90 mA or less 

Environmental 
resistance 

Operating ambient 
temperature 

0 to +45°C (without icing and dew condensation) 

Operating ambient 
humidity 

35 to 85% RH (without icing and dew condensation at 25°C) 

Vibration 10 to 55 Hz, 1 sweep per minute, amplitude 1 mm, 30 minutes in each 
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resistance X, Y and Z directions 

Shock resistance 700 m/s2, 3 times each in X, Y and Z direction 

Weight Approx. 30g (without lens) 

 

4-Mega Gray Camera (ANPVC1470) 
Image sensor Interline transfer method. 2/3-inch CCD 

Pixel size: 3.45 ｍ x 3.45 ｍ (tetragonal pixel)  

Number of effective pixels Horizontal 2456 x vertical 2058 pixels 

Scanning method Non-interlace 

Shutter Speed 0.03 to 1000.00 ms (30 s to 1 s) 

Lens mount C mount 

Synchronous Method Internal synchronous 

Picture output Digital output 

Rating Power supply voltage 11.0 to 13.0 V DC  

Power Consumption 310 mA or less 

Environmental 
resistance 

Operating ambient 
temperature 

0 to +40°C (without icing and dew condensation) 

Operating ambient humidity 35 to 85% RH (without icing and dew condensation at 25°C) 

Vibration resistance 10 to 55 Hz, 1 sweep per minute, amplitude 1 mm, 30 minutes 
in each X, Y and Z directions 

Shock resistance 490.3 m/s2, once each in X, Y and Z direction 

Weight Approx. 125 g (without lens) 

XGA Monitor: ANPVM11021 
General Specification 
Rated power Power supply voltage 24 V DC  Operating voltage range: 21.6 to 26.4 V DC 

Power Consumption 0.5 A (Max. 1 A) 

Environmental 
resistance 

Operating ambient temperature 0 to +45 °C 

Operating ambient humidity 35 to 85 %RH (without dew condensation at 25°C) 

Power noise 1,000 V (P-P) or more, pulse width 50 ns, 1 µs between 
power terminals (a noise simulator was used.) 

Static electricity noise 4000 V or more 

Vibration resistance 10 to 55 Hz (1 sweep per minute), amplitude 0.75 mm, 
30 minutes each in X, Y and Z directions 

Shock resistance 196 m/s2, 3 times each in X, Y and Z direction 

Weight Approx. 1.4kg 
 

Specification for Display Area 
Display element 10.4-inch TFT liquid crystal 

Number of pixels 1024(H) x 768(V) pixels 

Display color 16,777,216 colors 

Effective display size 210.4(H) x 157.8(V) 

Service life of backlight Average: 50,000 hours 

Input Signal Picture signal Analog RGB 

Synchronizing signal Horizontal/vertical synchronizing signal 

Horizontal operation frequency 48.36 kHz* (Number of all pixels: 1024) 

Vertical operation frequency 60 Hz* (Number of all lines: 768) 

Dot clock 65 MHz 

Interface Analog RGB input, Mini-D-SUB connector 15 pins (female) 

Screen adjustment Brightness, display width, vertical and horizontal positions, 
flicker, gain(R,G,B) 

*The specified signals should be used for the monitor. Failure to do so may result in no screen display and noise 
occurrence on the screen. 
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13.2 Product Numbers 

PV200 
PV200 

2-Camera type I/O COM.: Bi-polar, Language switch over *1 ANPV0202ADP Compliant with CE*2 

2-Camera type I/O COM.: Bi-polar, Language switch over *1 

For 0.3-Mega Compact Camera (Gray: 
ANPVC5030, Color: ANPVC6030) 

ANPV0202MC Compliant with CE*2 

Included item:  
- I/O connector for discrete cables (2 pcs) 

*1:Supported languages: Japanese, English, Simplified Chinese, Korean and Traditional Chinese 
*2:Attach the designated ferrite cores on the both sides of a monitor cable. Do not connect with the USB port. 

Keypad 
Keypad Cable length: 3m ANPVP03 Compliant 

with CE 
 Cable length: 10 m ANPVP10 

Camera 
0.3-Mega Gray Camera*1 Adapted for progressive camera, C-mount, 

120 fps 
ANPVC1040 Compliant 

with CE 

0.3-Mega Color Camera*1 Adapted for progressive camera, C-mount, 
120 fps 

ANPVC2040 

0.3-Mega Compact Gray 
Camera*2 

Adapted for progressive camera, C-mount, 
90 fps 

ANPVC5030 

0.3-Mega Compact Color 
Camera*2 

Adapted for progressive camera, C-mount, 
90 fps 

ANPVC6030 

2-Mega Gray Camera*1 Adapted for progressive camera, C-mount, 
30 fps 

ANPVC1210 

2-Mega Color Camera*1 Adapted for progressive camera, C-mount, 
30 fps 

ANPVC2260 

4-Mega Gray Camera*1 Adapted for progressive camera, C-mount, 
16 fps 

ANPVC1470 

Camera Cable Cable length: 3m ANPVC8103 

 Cable length: 5 m*3 ANPVC8105 

 Cable length: 10 m*3 ANPVC8110 

 Durable type, cable length: 3m ANPVC8103R 

 Durable type, cable length: 5 m*3 ANPVC8105R 

 Durable type, cable length: 10 m*3 ANPVC8110R 

Camera Cable for 0.3-Mega 
Compact Camera 

Cable length: 3m ANPVC8203  

Cable length: 5 m ANPVC8205 

Cable length: 10 m ANPVC8210 

Bracket for 4-Mega Gray 
Camera 

For 4-Mega gray camera ANPVH005  

*1:Included item: Adapter ring 2.5 mm (1mm x 2, 0.5 mm x 1) 
*2: Included item: Adapter ring 2.5 mm (1mm x 2, 0.5 mm x 1), C-mount converter 
*3: Cannot use with 4-Mega Gray Camera 
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Lens 
For 0.3-Mega Camera f = 6 mm With a lock ANB842NL 
 f = 8.5 mm With a lock ANB843L *1 
 f = 16 mm With a lock, compact type ANM88161 *1 
  With a lock ANB845NL 
 f = 25mm With a lock, compact type ANM88251 *1 
  With a lock ANB846NL 
 f = 50 mm With a lock, compact type ANM88501 
  With a lock ANB847L 
For 2-Mega/4-Mega Camera f = 16 mm With a lock ANPVL162 
 f = 25 mm With a lock ANPVL252 
 f = 50 mm With a lock ANPVL502 
Adapter ring 5 mm adapter ring ANB84805 

Adapter ring set (0.5/ 1/ 5/ 10/ 20/ 40 
mm) ANB848 

Lenses are noncompliant products with CE. 
*1: Cannot be used for 0.3-Mega Compact Cameras. 

Monitor 
XGA Monitor 10.4-inch (with attachment bracket: 4 pcs) ANPVM11021 Compliant 

with CE*1 
Monitor cable Cable length: 3m ANMX83313 Compliant 

with CE*1  Cable length: 5 m ANMX83315 

*1: Ferrite cores (equivalent products to RFC-5 produced by Kitagawa Industries. Co., Ltd.) must be attached to 
both ends of a monitor cable. 

Repair Parts 
Backup buttery for PV200 Coin-type lithium buttery AFPX-BATT Compliant 

with CE 
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Lighting 
LED Ring light 

[Direct lighting] 
outside diameter: Ø 50, red AULDR2-50RD*3 

 outside diameter: Ø 50, white AULDR2-70SW*2 

 outside diameter: Ø 70, red AULDR2-70RD*3 

 outside diameter: Ø 70, white AULDR2-70SW*2 

 Options for ring 
light 
[Direct lighting] 

For AULDR2-50RD/ 
AULDR2-50SW 

Polarization plate AUPL-LDR-50B*3 

 Diffusing plate AUDF-LDR-50B*3 

 Diffusing plate, 
polarization plate 
Mounting adapter 

AUAD-LDR-50B*3 

 For AULDR2-70RD/ 
AULDR2-70SW 

Polarization plate AUPL-LDR-70A*3 

 Diffusing plate AUDF-LDR-70A*3 

 Surface emitting 
ring light 
[Indirect lighting] 

outside diameter: Ø 74 AULKR-70A*3 

 outside diameter: Ø 102 AULFR-100*3 

 Surface emitting 
flat light 
[Indirect lighting] 

light source size: 27 x 27 AULDL-TP2727*2 

 light source size: 43 x 35 AULDL-TP4335*2 

 light source size: 80 x 100 AULFL-100*3 

 Surface emitting 
coaxial light 
[Indirect lighting] 

translucent glass size: 26 x 28 AULFV-34*3 

 translucent glass size: 32 x 36 AULFV-50A*3 

 Power supply Digital light source  
(Output: switchover 12V/24V / 10W) 

ANB86001 

 Digital light source  
(Output: switchover 12V/24V / 30W) 

ANB86003 

 Cable Extension cable for 12V: 3 m AUCB-3*3 

 Extension cable for 24V: 3 m AUFCB-3*3 

 Light control cable (for 
ANB86001/ANB86003) 
: 3 m 

AUEXCB-B3*3 

Inverter ring 
light 

Ø60 ring light ANMF0064*4 

Ø92 ring light ANMF0104*4 

Replacement lamp: Ø60 ring light (for ANMF0064) ANMF0060*4 

Replacement lamp: Ø92 ring light (for ANMF0104) ANMF0100*4 

*1: This product was discontinued as of August 2011. 

*2: This product was discontinued as of February 2012. 

*3: This product was discontinued as of December 2012. 

*4: This product will be discontinued as of September 2013. 
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PV200 

 

Keypad 

 

 

L = cable length 
ANPVP03: 3 m 
ANPVP10: 10 m 
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Camera 
0.3-Mega Gray Camera: ANPVC1040 / 2-Mega Gray Camera: ANPVC1210 

0.3-Mega Color Camera: ANPVC2040 / 2-Mega Color Camera: ANPVC2260 
 

 
 With the mounting plate Without the mounting plate 

 
The mounting plate can be attached to four sides of camera except lens attaching side and cable connecting 
side. 

0.3-Mega Gray Camera: ANPVC5030 / 0.3-Mega Color Camera: ANPVC6030  

 

 With the mounting plate With the mounting plate and 
C-mount adapter  

Without the mounting plate and 
C-mount adapter 

 
- A lens whose projection from the C-mount face is larger than 4.5 mm cannot be attached 

structurally. 
- The mounting plate can be attached to four sides of camera except lens attaching side and cable 

connecting side. However, the positions of screw holes differ depending on each side. Check the 
positions before installing it to a fixture, etc. 
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4-Mega Gray Camera: ANPVC1470 
 

 
 With the mounting plate Without the mounting plate 

 
- Usable camera cables are 3m cables (ANPVC8103 or ANPVC8103R) only. 
- The mounting plate can be attached to the bottom and the top sides of camera. (The sides 

mentioned above are the side where the plate is initially attached and the opposite side.) The 
mounting positions of screws are different between the bottom and top sides. 

 

Camera Cable: ANPVC8103, ANPVC8105, ANPVC8110 

 
 

1: Product number label 
2: Ferrite core 
L: Cable length 
ANPVC8103: 3 m, ANPVC8105: 5 m, ANPVC8110: 10 m 
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Camera Cable: ANPVC8203, ANPVC8205, ANPVC8210 

 
 

1: Product number label 
L: Cable length 
Ø: Cable diameter 

Product Numbers L Ø 

ANPVC8203 3m 5.7mm 

ANPVC8205 5m 5.7mm 

ANPVC8210 10m 7.0mm 

 

Bracket for 4-Mega Gray Camera: ANPVH005 
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Lens 

ANM88501 ANB842NL 

 

 
ANB847L ANB843L 
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ANB846NL ANB845NL 

  

ANM88251 

 

ANM88161 

 

ANPV162 
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ANPV252 

 

ANPV502 
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Monitor (10.4-inch) 
Product No.: ANPVM11021 

 
Cutting Dimensions of the Mounting Plate 
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How to read commands 
This section describes the command names of the string functions used for Numerical Calculation or 
Judgement and the meanings in alphabetical order. 

"nnn" in the string functions expresses a checker number. "mmm" expresses a result number and the number 
of "m" expresses the number of digits. 

 

Depending on type of result data of Numerical Calculation, selectable type varies when selecting "Statistics". 
 

Statistics: Type 1 

Scan Count (@COUNT) OK count (@OKCOUNT) NG count (@NGCOUNT) 
 

Statistics: Type 2 

Minimum (@MIN) OK Judge. Min. (@OKMIN) NG Judge. Min. (@NGMIN) 

Maximum (@MAX) OK Judge. Max. (@OKMAX) NG Judge. Max. (@NGMAX) 

Average (@AV) OK average (@OKAV) NG average (@NGAV) 

Range (@RG) OK Range (@OKRG) NG range (@NGRG) 

Variance (@DV) OK Variance (@OKDV) NG Variance (@NGDV) 

 

Example 1) 

CGWnnn_ AVE.mm        Items used 

Connector (Gray Window) / Checker No. / Gray Average / Result No.  Numerical Calculation 

Example 2) 

COS( 

Cosine when the value in parentheses is radian    Numerical Calculation 

Example 3) 

FWCnnn_SIZE.mmm@OKRG 

Flaw Detection / Checker No. / Flaw Size / Result No. / Statistics / OK Range Numerical Calculation 

Example 4) 

SELnnn_LIJUDGE 

Smart Edge (Line) / Checker No. / Linearity Judgement Numerical Calculation or Judgement 

 
For details of Numerical Calculation, refer to "4.11.2 Data That Can Be Used in Numerical Calculation" 
(p.313). 

For details of Judgement, refer to "Data That Can Be Used in Judgement" (p.329). 

List of commands (in alphabetical order) 
 

String function 
Numerical Calculation 

Judge. Meaning of function 
Statistics Result 

ABS(  Yes  Absolute value of value in parentheses 
ACOS(  Yes  Arccosine of value in parentheses 

(unit:radian) 
ACOSD(  Yes  Arccosine of value in parentheses 

(unit:degree) 
ASIN(  Yes  Arcsine of value in parentheses 

(unit:radian) 
ASIND(  Yes  Arcsine of value in parentheses 

(unit:degree) 
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Judge. Meaning of function 
Statistics Result 

ATAN(  Yes  Arctangent of value in parentheses 
(unit:radian) 

ATAND(  Yes  Arctangent of value in parentheses 
(unit:degree) 

AUCnnn_JUDGE @ (Type1) Yes Yes Area Size Adj. Judgement 
AUCnnn_PX @ (Type2) Yes  Area Size Adj. Proj. X Axis 
AUCnnn_PY @ (Type2) Yes  Area Size Adj. Proj. Y Axis 
AUCnnn_TIME @ (Type2) Yes  Area Size Adj. Inspection Time 
AUCnnn_X @ (Type2) Yes  Area Size Adj. X 
AUCnnn_Y @ (Type2) Yes  Area Size Adj. Y 
AVE(  Yes  Average of the calculation results for the 

number specified by the second term in 
parentheses from the Numerical 
Calculation No. specified by the first term. 

BECnnn_COLOR.mmm @ (Type2) Yes  Binary Edge Detected Color 
BECnnn_COUNT @ (Type2) Yes  Binary Edge No. of Objects 
BECnnn_JUDGE @ (Type1) Yes Yes Binary Edge Judgement 
BECnnn_PX.mmm @ (Type2) Yes  Binary Edge Proj. X Axis 
BECnnn_PY.mmm @ (Type2) Yes  Binary Edge Proj. Y Axis 
BECnnn_TIME @ (Type2) Yes  Binary Edge Inspection Time 
BECnnn_X.mmm @ (Type2) Yes  Binary Edge X 
BECnnn_Y.mmm @ (Type2) Yes  Binary Edge Y 
BWCnnn_AREA @ (Type2) Yes  Binary Window Area 
BWCnnn_JUDGE @ (Type1) Yes Yes Binary Window Judgement 
BWCnnn_TIME @ (Type2) Yes  Binary Window Inspection Time 
CACnnn_JUDGE @ (Type1) Yes Yes Numerical Calcu. Judgement 
CACnnn_VALUE @ (Type2) Yes  Numerical Calcu. Calculated result 
CANGLE(  Yes  Display of a narrow intersecting angle of 

two lines in radian specified by six values in 
parentheses. 

CBWnnn_AREA.mm @ (Type2) Yes  Connector (Binary 
Window) 

Area 

CBWnnn_CELL @ (Type2) Yes  Connector (Binary 
Window) 

No. of Cells 

CBWnnn_JUDGE @ (Type1) Yes Yes Connector (Binary 
Window) 

Judgement 

CBWnnn_PJUDGE.mm @ (Type1) Yes Yes Connector (Binary 
Window) 

Individual 
Judgement 

CBWnnn_TIME @ (Type2) Yes  Connector (Binary 
Window) 

Inspection Time 

CEIL(  Yes  Integer to which a value in parentheses was 
rounded up 

CGEnnn_CELL @ (Type2) Yes  Connector (Gray 
Edge) 

No. of Cells 

CGEnnn_D0.mm @ (Type2) Yes  Connector (Gray 
Edge) 

Area 0: Edge 
Differential 

CGEnnn_D1.mm @ (Type2) Yes  Connector (Gray 
Edge) 

Area 1: Edge 
Differential 

CGEnnn_JUDGE @ (Type1) Yes Yes Connector (Gray 
Edge) 

Judgement 

CGEnnn_PAVE @ (Type2) Yes  Connector (Gray 
Edge) 

Average Pitch 

CGEnnn_PJUDGE.mm @ (Type1) Yes Yes Connector (Gray 
Edge) 

Pitch Individual 
Judgement 

CGEnnn_PMAX @ (Type2) Yes  Connector (Gray 
Edge) 

Max. Pitch 

CGEnnn_PMIN @ (Type2) Yes  Connector (Gray 
Edge) 

Min. Pitch 
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Judge. Meaning of function 
Statistics Result 

CGEnnn_PT.mm @ (Type2) Yes  Connector (Gray 
Edge) 

Pitch 

CGEnnn_PTJUDG @ (Type1) Yes Yes Connector (Gray 
Edge) 

Pitch Total 
Judgment 

CGEnnn_TIME @ (Type2) Yes  Connector (Gray 
Edge) 

Inspection Time 

CGEnnn_UJUDGE.mm @ (Type1) Yes Yes Connector (Gray 
Edge) 

Distance Difference 
Judgement 

CGEnnn_UPJUDG @ (Type1) Yes Yes Connector (Gray 
Edge) 

Distance Difference 
Total Judgement 

CGEnnn_UPT.mm @ (Type2) Yes  Connector (Gray 
Edge) 

Distance Difference 

CGEnnn_X0.mm @ (Type2) Yes  Connector (Gray 
Edge) 

Area 0: X-Coord. 
Edge 

CGEnnn_X1.mm @ (Type2) Yes  Connector (Gray 
Edge) 

Area 1: X-Coord. 
Edge 

CGEnnn_Y0.mm @ (Type2) Yes  Connector (Gray 
Edge) 

Area 0: Y-Coord. 
Edge 

CGEnnn_Y1.mm @ (Type2) Yes  Connector (Gray 
Edge) 

Area 1: Y-Coord. 
Edge 

CGWnnn_AVE.mm @ (Type2) Yes  Connector (Gray 
Window) 

Gray Average 

CGWnnn_CELL @ (Type2) Yes  Connector (Gray 
Window) 

No. of Cells 

CGWnnn_JUDGE @ (Type1) Yes Yes Connector (Gray 
Window) 

Judgement 

CGWnnn_PJUDGE.mm @ (Type1) Yes Yes Connector (Gray 
Window) 

Individual 
Judgement 

CGWnnn_TIME @ (Type2) Yes  Connector (Gray 
Window) 

Inspection Time 

CIRCLER(  Yes  Radius of the circle on three points 
specified by six values in parentheses 

CIRCLEX(  Yes  Center X of the circle on three points 
specified by six values in parentheses 

CIRCLEY(  Yes  Center Y of the circle on three points 
specified by six values in parentheses 

CMCnnn_CANG.mmm  @ (Type2) Yes  Contour Matching Angle 
CMCnnn_COR.mmm @ (Type2) Yes  Contour Matching Correlation Value 
CMCnnn_COUNT @ (Type2) Yes  Contour Matching No. of Objects 
CMCnnn_JUDGE @ (Type1) Yes Yes Contour Matching Judgement 
CMCnnn_PX.mmm @ (Type2) Yes  Contour Matching Projection X 
CMCnnn_PY.mmm @ (Type2) Yes  Contour Matching Projection Y 
CMCnnn_SCAL.mmm @ (Type2) Yes  Contour Matching Magnification 
CMCnnn_TIME @ (Type2) Yes  Contour Matching Inspection Time 
CMCnnn_X.mmm @ (Type2) Yes  Contour Matching X 
CMCnnn_Y.mmm @ (Type2) Yes  Contour Matching Y 
COS(  Yes  Cosine when the value in parentheses is 

radian 
COSD(  Yes  Cosine when the value in parentheses is 

degree 
CPOINTX(  Yes  X of the intersection of two lines specified 

by six values in parentheses 
CPOINTY(  Yes  Y of the intersection of two lines specified 

by six values in parentheses 
CWCnnn_BAJUDG @ (Type1) Yes Yes Color Window B Ave. Judge. 
CWCnnn_BAV @ (Type2) Yes  Color Window B Ave. 
CWCnnn_BJUDG @ (Type1) Yes Yes Color Window B Judge. 
CWCnnn_BMAX @ (Type2) Yes  Color Window B Max. 
CWCnnn_BMIN @ (Type2) Yes  Color Window B Min. 
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Judge. Meaning of function 
Statistics Result 

CWCnnn_BSD @ (Type2) Yes  Color Window B Standard Devi. 
CWCnnn_BSJUDG @ (Type1) Yes Yes Color Window B Standard Devi. 

Judge. 
CWCnnn_GAJUDG @ (Type1) Yes Yes Color Window G Ave. Judge. 
CWCnnn_GAV @ (Type2) Yes  Color Window G Ave. 
CWCnnn_GJUDG @ (Type1) Yes Yes Color Window G Judge. 
CWCnnn_GMAX @ (Type2) Yes  Color Window G Max. 
CWCnnn_GMIN @ (Type2) Yes  Color Window G Min. 
CWCnnn_GSD @ (Type2) Yes  Color Window G Standard Devi. 
CWCnnn_GSJUDG @ (Type1) Yes Yes Color Window G Standard Devi. 

Judge. 
CWCnnn_JUDGE @ (Type1) Yes Yes Color Window Judgement 
CWCnnn_RAJUDG @ (Type1) Yes Yes Color Window R Ave. Judge. 
CWCnnn_RAV @ (Type2) Yes  Color Window R Ave. 
CWCnnn_RJUDG @ (Type1) Yes Yes Color Window R Judge. 
CWCnnn_RMAX @ (Type2) Yes  Color Window R Max. 
CWCnnn_RMIN @ (Type2) Yes  Color Window R Min. 
CWCnnn_RSD @ (Type2) Yes  Color Window R Standard Devi. 
CWCnnn_RSJUDG @ (Type1) Yes Yes Color Window R Standard Devi. 

Judge. 
CWCnnn_TIME @ (Type2) Yes  Color Window Inspection Time 

DEG(  Yes  Convert a value in parentheses (radian) to 
degree. 

DIST(  Yes  Distance between two points Q0 (X0,Y0) 
and Q1(X1,Y1) in pixels 

ELINEPA(  Yes  Element a of a line (ax+by+c=0) which 
connects two points (x0,y0) and (x1,y1). 

ELINEPB(  Yes  Element b of a line (ax+by+c=0) which 
connects two points (x0,y0) and (x1,y1). 

ELINEPC(  Yes  Element c of a line (ax+by+c=0) which 
connects two points (x0,y0) and (x1,y1). 

EQ(  Yes  Returns "1" when (the first term in 
parentheses) = (the second term), 
otherwise "0". 

FECnnn_ANG.mmmm @ (Type2) Yes  Feature Extraction Principal axis angle 
FECnnn_AREA.mmmm @ (Type2) Yes  Feature Extraction Area 
FECnnn_COUNT @ (Type2) Yes  Feature Extraction No. of Objects 
FECnnn_JUDGE @ (Type1) Yes Yes Feature Extraction Judgement 
FECnnn_LDX.mmmm @ (Type2) Yes  Feature Extraction Circumscribing 

Rectangle Lower 
Left X 

FECnnn_LDY.mmmm @ (Type2) Yes  Feature Extraction Circumscribing 
Rectangle Lower 
Left Y 

FECnnn_LEN.mmmm @ (Type2) Yes  Feature Extraction Perimeter 
FECnnn_LUX.mmmm @ (Type2) Yes  Feature Extraction Circumscribing 

Rectangle Upper 
Left X 

FECnnn_LUY.mmmm @ (Type2) Yes  Feature Extraction Circumscribing 
Rectangle Upper 
Left Y 

FECnnn_PH.mmmm @ (Type2) Yes  Feature Extraction Projection Height 
FECnnn_PW.mmmm @ (Type2) Yes  Feature Extraction Projection Width 
FECnnn_PX.mmmm @ (Type2) Yes  Feature Extraction Proj. X Axis 
FECnnn_PY.mmmm @ (Type2) Yes  Feature Extraction Proj. Y Axis 
FECnnn_RDX.mmmm @ (Type2) Yes  Feature Extraction Circumscribing 

Rectangle Lower 
Right X 
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FECnnn_RDY.mmmm @ (Type2) Yes  Feature Extraction Circumscribing 
Rectangle Lower 
Right Y 

FECnnn_RUX.mmmm @ (Type2) Yes  Feature Extraction Circumscribing 
Rectangle Upper 
Right X 

FECnnn_RUY.mmmm @ (Type2) Yes  Feature Extraction Circumscribing 
Rectangle Upper 
Right Y 

FECnnn_TIME @ (Type2) Yes  Feature Extraction Inspection Time 
FECnnn_X.mmmm @ (Type2) Yes  Feature Extraction Gravity X 
FECnnn_Y.mmmm @ (Type2) Yes  Feature Extraction Gravity Y 
FLOOR(  Yes  Integer to which a value in parentheses was 

rounded down 
FWCnnn_CNO.mmm @ (Type2) Yes  Flaw Detection First Cell of Flaw 
FWCnnn_COUNT @ (Type2) Yes  Flaw Detection No. of Objects 
FWCnnn_JUDGE @ (Type1) Yes Yes Flaw Detection Judgement 
FWCnnn_PX.mmm @ (Type2) Yes  Flaw Detection Proj. X Axis 
FWCnnn_PY.mmm @ (Type2) Yes  Flaw Detection Proj. Y Axis 
FWCnnn_SIZE.mmm @ (Type2) Yes  Flaw Detection Flaw size 
FWCnnn_TIME @ (Type2) Yes  Flaw Detection Inspection Time 
FWCnnn_X.mmm @ (Type2) Yes  Flaw Detection X 
FWCnnn_Y.mmm @ (Type2) Yes  Flaw Detection Y 
GE(  Yes  Returns "1" when (the first term in 

parentheses) is greater than or equal to 
(the second term), otherwise "0". 

GECnnn_COUNT @ (Type2) Yes  Gray Edge No. of Objects 
GECnnn_DIF.mmm @ (Type2) Yes  Gray Edge Differential 
GECnnn_JUDGE @ (Type1) Yes Yes Gray Edge Judgement 
GECnnn_PX.mmm @ (Type2) Yes  Gray Edge Proj. X Axis 
GECnnn_PY.mmm @ (Type2) Yes  Gray Edge Proj. Y Axis 
GECnnn_TIME @ (Type2) Yes  Gray Edge Inspection Time 
GECnnn_X.mmm @ (Type2) Yes  Gray Edge X 
GECnnn_Y.mmm @ (Type2) Yes  Gray Edge Y 
GGCnnn_AJUDGE @ (Type1) Yes Yes Geometry Calcu. Angle Judgement 
GGCnnn_ANG @ (Type2) Yes  Geometry Calcu. Angle 
GGCnnn_CAJUDGE @ (Type1) Yes Yes Geometry Calcu. Intersecting Angle 

Judgement 
GGCnnn_CANG @ (Type2) Yes  Geometry Calcu. Intersecting Angle 
GGCnnn_DIST @ (Type2) Yes  Geometry Calcu. Distance 
GGCnnn_DJUDGE @ (Type1) Yes Yes Geometry Calcu. Distance Judgement 
GGCnnn_JUDGE @ (Type1) Yes Yes Geometry Calcu. Judgement 
GGCnnn_I0X @ (Type2) Yes  Geometry Calcu. IP0 X 
GGCnnn_I0Y @ (Type2) Yes  Geometry Calcu. IP0 Y 
GGCnnn_I1X @ (Type2) Yes  Geometry Calcu. IP1 X 
GGCnnn_I1Y @ (Type2) Yes  Geometry Calcu. IP1 Y 
GGCnnn_LA @ (Type2) Yes  Geometry Calcu. Major Axis 
GGCnnn_LAJUDGE @ (Type1) Yes Yes Geometry Calcu. Major Axis 

Judgement 
GGCnnn_LINEA @ (Type2) Yes  Geometry Calcu. Line Parameter A 
GGCnnn_LINEB @ (Type2) Yes  Geometry Calcu. Line Parameter B 
GGCnnn_LINEC @ (Type2) Yes  Geometry Calcu. Line Parameter C 
GGCnnn_R @ (Type2) Yes  Geometry Calcu. Radius 
GGCnnn_RJUDGE @ (Type1) Yes Yes Geometry Calcu. Radius judgement 
GGCnnn_SA @ (Type2) Yes  Geometry Calcu. Minor Axis 
GGCnnn_SAJUDGE @ (Type1) Yes Yes Geometry Calcu. Minor Axis 

Judgement 



 

735 

 
IN

D
E

X
 

A
ppendix 

String function 
Numerical Calculation 

Judge. Meaning of function 
Statistics Result 

GGCnnn_SJUDGE @ (Type1) Yes Yes Geometry Calcu. Standard Devation 
Judgement 

GGCnnn_STD @ (Type2) Yes  Geometry Calcu. Standard Deviation 
GGCnnn_TIME @ (Type2) Yes  Geometry Calcu. Inspection Time 
GGCnnn_X @ (Type2) Yes  Geometry Calcu. X 
GGCnnn_XJUDGE @ (Type1) Yes Yes Geometry Calcu. X Judgement 
GGCnnn_Y @ (Type2) Yes  Geometry Calcu. Y 
GGCnnn_YJUDGE @ (Type1) Yes Yes Geometry Calcu. Y Judgement 
GT(  Yes  Returns "1" when (the first term in 

parentheses) is greater than (the second 
term), otherwise "0". 

GWCnnn_AVE @ (Type2) Yes  Gray Window Gray Average 
GWCnnn_JUDGE @ (Type1) Yes Yes Gray Window Judgement 
GWCnnn_TIME @ (Type2) Yes  Gray Window Inspection Time 
INT(  Yes  Integer portion of a value in parentheses 
JDCnnn_JUDGE @ (Type1) Yes Yes Judgement 

(External output) 
Judgement 

JRCnnn_JUDGE @ (Type1) Yes Yes Judgement 
(Internal) 

Judgement 

LE(  Yes  Returns "1" when (the first term in 
parentheses) is less than or equal to (the 
second term), otherwise "0". 

LICnnn_DCOUNT @ (Type2) Yes  Line No. of pixels 
LICnnn_DJUDGE @ (Type1) Yes Yes Line Pixel Judgement 
LICnnn_JUDGE @ (Type1) Yes Yes Line Judgement 
LICnnn_LCOUNT @ (Type2) Yes  Line No. of objects 
LICnnn_LJUDGE @ (Type1) Yes Yes Line Object Judgement 
LICnnn_TIME @ (Type2) Yes  Line Inspection Time 
LINESA(  Yes  Element a of a regression line expression in 

least squares calculated by multiple 
coordinate values specified with three 
values in parentheses 

LINESB(  Yes  Element b of a regression line expression in 
least squares calculated by multiple 
coordinate values specified with three 
values in parentheses 

LINESC(  Yes  Element c of a regression line expression in 
least squares calculated by multiple 
coordinate values specified with three 
values in parentheses 

LOG10(  Yes  Common logarithm of a value in 
parentheses 

LT(  Yes  Returns "1" when (the first term in 
parentheses) is less than (the second 
term), otherwise "0". 

MAX(  Yes  Maximum value of the calculation results 
for the number specified by the second 
term in parentheses from the Numerical 
Calculation No. specified by the first term. 

MIDDLEX(  Yes  Coordinate X of the median of two pairs of 
coordinates specified with four values in 
parentheses. 

MIDDLEY(  Yes  Coordinate Y of the median of two pairs of 
coordinates specified with four values in 
parentheses. 

MIN(  Yes  Minimum value of the calculation results for 
the number specified by the second term in 
parentheses from the Numerical 
Calculation No. specified by the first term. 
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MOD(  Yes  Remainder when (the first term in 
parentheses) is divided by (the second 
term) 

NE(  Yes  Returns "1" when (the first term in 
parentheses) is not equal to (the second 
term), otherwise "0". 

OCAnnn_JUDGE @ (Type1) Yes Yes Numerical Calcu. Judgement 
(Previous Value) 

OCAnnn_VALUE @ (Type2) Yes  Numerical Calcu. Calculation Result 
(Previous Value) 

PACnnn_AJANG @ (Type2) Yes  Position Adjustment Adjustment Amount 
Theta 

PACnnn_AJX @ (Type2) Yes  Position Adjustment X Adjustment 
Amount 

PACnnn_AJY @ (Type2) Yes  Position Adjustment Y Adjustment 
Amount 

PACnnn_ANG @ (Type2) Yes  Position Adjustment Detect Position 
Theta 

PACnnn_BANG @ (Type2) Yes  Position Adjustment Base Position Theta 
PACnnn_BJUDGE.m @ (Type1) Yes Yes Position Adjustment Judgement of Base 

Checker 
PACnnn_BPOSX @ (Type2) Yes  Position Adjustment Base Position X 
PACnnn_BPOSY @ (Type2) Yes  Position Adjustment Base Position Y 
PACnnn_BPX.m @ (Type2) Yes  Position Adjustment Base projection X 
PACnnn_BPY.m @ (Type2) Yes  Position Adjustment Base projection Y 
PACnnn_BTIME.m @ (Type2) Yes  Position Adjustment Base Inspection 

Time 
PACnnn_BX.m @ (Type2) Yes  Position Adjustment Base X 
PACnnn_BY.m @ (Type2) Yes  Position Adjustment Base Y 
PACnnn_JUDGE @ (Type1) Yes Yes Position Adjustment Judgement 
PACnnn_TIME @ (Type2) Yes  Position Adjustment Inspection Time 
PACnnn_X @ (Type2) Yes  Position Adjustment Detect Position X 
PACnnn_Y @ (Type2) Yes  Position Adjustment Detect Position Y 
PI()  Yes  Pi (fixed value: 3.142) 
POW(  Yes  Value when (the first term in parentheses) 

is multiplied by (the second term) 
PTORA(  Yes  Converts the screen angle specified by the 

second term of the camera specified by the 
first term in parentheses to the real angle. 

PTORD(  Yes  Converts the pixel count specified by the 
second term of the camera specified by the 
first term in parentheses to the real area. 

PTORXC(  Yes  X coordinate of the real value converted 
from the coordinate in pixels specified by 
the second and third terms of the camera 
specified by the first term in parentheses. 

PTORYC(  Yes  Y coordinate of the real value converted 
from the coordinate in pixels specified by 
the second and third terms of the camera 
specified by the first term in parentheses. 

RAD(  Yes  Convert a value in parentheses (degree) to 
radian. 

ROUND(  Yes  Integer to which a value in parentheses was 
rounded off 

RTOPA(c, rA)  Yes  Converts the real angle specified by the 
second term of the camera specified by the 
first term in parentheses to the screen 
angle. 

RTOPD(c, Ar)  Yes  Converts the real area specified by the 
second term of the camera specified by the 
first term in parentheses to the pixel count. 
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RTOPXC(c, Xr, Yr)  Yes  X coordinate of the coordinate in pixels 
converted from the real value specified by 
the second and third terms of the camera 
specified by the first term in parentheses. 

RTOPYC(c, Xr, Yr)  Yes  Y coordinate of the coordinate in pixels 
converted from the real value specified by 
the second and third terms of the camera 
specified by the first term in parentheses. 

SECnnn_AMAX @ (Type2) Yes  Smart Edge (Circle) Max. Angle 
SECnnn_AMIN @ (Type2) Yes  Smart Edge (Circle) Min. Angle 
SECnnn_CELL @ (Type2) Yes  Smart Edge (Circle) No. of Cells 
SECnnn_CIR0 @ (Type2) Yes  Smart Edge (Circle) Circularity 0 
SECnnn_CIR1 @ (Type2) Yes  Smart Edge (Circle) Circularity 1 
SECnnn_CJUDGE @ (Type1) Yes Yes Smart Edge (Circle) Circularity 

Judgement 
SECnnn_CX0 @ (Type2) Yes  Smart Edge (Circle) Center X 0 
SECnnn_CX1 @ (Type2) Yes  Smart Edge (Circle) Center X 1 
SECnnn_CY0 @ (Type2) Yes  Smart Edge (Circle) Center Y 0 
SECnnn_CY1 @ (Type2) Yes  Smart Edge (Circle) Center Y 1 
SECnnn_D0.mmmm @ (Type2) Yes  Smart Edge (Circle) Differential 0 
SECnnn_D1.mmmm @ (Type2) Yes  Smart Edge (Circle) Differential 1 
SECnnn_DEV.mmmm @ (Type2) Yes  Smart Edge (Circle) Deviation 
SECnnn_FCNT @ (Type2) Yes  Smart Edge (Circle) Used Edge Count 
SECnnn_IJUDGE.mmmm @ (Type1) Yes Yes Smart Edge (Circle) Individual 

Judgement 
SECnnn_JUDGE @ (Type1) Yes Yes Smart Edge (Circle) Judgement 
SECnnn_LAVE @ (Type2) Yes  Smart Edge (Circle) Average 
SECnnn_LEN.mmmm @ (Type2) Yes  Smart Edge (Circle) Measurement 
SECnnn_LJUDGE @ (Type1) Yes Yes Smart Edge (Circle) Measurement 

Judgement 
SECnnn_LMAX @ (Type2) Yes  Smart Edge (Circle) Maximum 
SECnnn_LMIN @ (Type2) Yes  Smart Edge (Circle) Minimum 
SECnnn_NCNT @ (Type2) Yes  Smart Edge (Circle) Unused Edge Count 
SECnnn_NJUDGE @ (Type1) Yes Yes Smart Edge (Circle) Unused Edge Count 

Judgement 
SECnnn_R0 @ (Type2) Yes  Smart Edge (Circle) Radius 0 
SECnnn_R1 @ (Type2) Yes  Smart Edge (Circle) Radius 1 
SECnnn_SJUDGE @ (Type1) Yes Yes Smart Edge (Circle) Standard Devation 

Judgement 
SECnnn_STAT.mmmm @ (Type2) Yes  Smart Edge (Circle) Judgement Code 
SECnnn_STD @ (Type2) Yes  Smart Edge (Circle) Standard Deviation 
SECnnn_TIME @ (Type2) Yes  Smart Edge (Circle) Inspection Time 
SECnnn_X0.mmmm @ (Type2) Yes  Smart Edge (Circle) X 0 
SECnnn_X1.mmmm @ (Type2) Yes  Smart Edge (Circle) X 1 
SECnnn_Y0.mmmm @ (Type2) Yes  Smart Edge (Circle) Y 0 
SECnnn_Y1.mmmm @ (Type2) Yes  Smart Edge (Circle) Y 1 
SELnnn_ANG0 @ (Type2) Yes  Smart Edge (Line) Line 0 Angle 
SELnnn_ANG1 @ (Type2) Yes  Smart Edge (Line) Line1 Angle 
SELnnn_CELL @ (Type2) Yes  Smart Edge (Line) No. of Cells 
SELnnn_D0.mmmm @ (Type2) Yes  Smart Edge (Line) Differential 0 
SELnnn_D1.mmmm @ (Type2) Yes  Smart Edge (Line) Differential 1 
SELnnn_EA0 @ (Type2) Yes  Smart Edge (Line) Line0 Element a 
SELnnn_EA1 @ (Type2) Yes  Smart Edge (Line) Line1 Element a 
SELnnn_EB0 @ (Type2) Yes  Smart Edge (Line) Line0 Element b 
SELnnn_EB1 @ (Type2) Yes  Smart Edge (Line) Line1 Element b 
SELnnn_EC0 @ (Type2) Yes  Smart Edge (Line) Line0 Element c 
SELnnn_EC1 @ (Type2) Yes  Smart Edge (Line) Line1 Element c 
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SELnnn_EX0 @ (Type2) Yes  Smart Edge (Line) Line 0 End 
Coordinate X 

SELnnn_EX1 @ (Type2) Yes  Smart Edge (Line) Line 1 End 
Coordinate X 

SELnnn_EY0 @ (Type2) Yes  Smart Edge (Line) Line 0 End 
Coordinate Y 

SELnnn_EY1 @ (Type2) Yes  Smart Edge (Line) Line 1 End 
Coordinate Y 

SELnnn_FCNT @ (Type2) Yes  Smart Edge (Line) Used Edge Count 
SELnnn_IJUDGE.mmmm @ (Type1) Yes Yes Smart Edge (Line) Individual 

Judgement 
SELnnn_JUDGE @ (Type1) Yes Yes Smart Edge (Line) Judgement 
SELnnn_LAVE @ (Type2) Yes  Smart Edge (Line) Average 
SELnnn_LEN.mmmm @ (Type2) Yes  Smart Edge (Line) Measurement 
SELnnn_LI0 @ (Type2) Yes  Smart Edge (Line) Linearity 0 
SELnnn_LI1 @ (Type2) Yes  Smart Edge (Line) Linearity 1 
SELnnn_LIJUDGE @ (Type1) Yes Yes Smart Edge (Line) Linearity Judgement 
SELnnn_LJUDGE @ (Type1) Yes Yes Smart Edge (Line) Measurement 

Judgement 
SELnnn_LMAX @ (Type2) Yes  Smart Edge (Line) Maximum 
SELnnn_LMIN @ (Type2) Yes  Smart Edge (Line) Minimum 
SELnnn_NCNT @ (Type2) Yes  Smart Edge (Line) Unused Edge Count 
SELnnn_NJUDGE @ (Type1) Yes Yes Smart Edge (Line) Unused Edge Count 

Judgement 
SELnnn_SJUDGE @ (Type1) Yes Yes Smart Edge (Line) Standard Devation 

Judgement 
SELnnn_STAT.mmmm @ (Type2) Yes  Smart Edge (Line) Judgement Code 
SELnnn_STD @ (Type2) Yes  Smart Edge (Line) Standard Deviation 
SELnnn_SX0 @ (Type2) Yes  Smart Edge (Line) Line 0 Start 

Coordinate X 
SELnnn_SX1 @ (Type2) Yes  Smart Edge (Line) Line 1 Start 

Coordinate X 
SELnnn_SY0 @ (Type2) Yes  Smart Edge (Line) Line 0 Start 

Coordinate Y 
SELnnn_SY1 @ (Type2) Yes  Smart Edge (Line) Line 1 Start 

Coordinate Y 
SELnnn_TIME @ (Type2) Yes  Smart Edge (Line) Inspection Time 
SELnnn_X0.mmmm @ (Type2) Yes  Smart Edge (Line) X 0 
SELnnn_X1.mmmm @ (Type2) Yes  Smart Edge (Line) X 1 
SELnnn_XMAX @ (Type2) Yes  Smart Edge (Line) X of Max. value 
SELnnn_XMIN @ (Type2) Yes  Smart Edge (Line) X of Min. value 
SELnnn_Y0.mmmm @ (Type2) Yes  Smart Edge (Line) Y 0 
SELnnn_Y1.mmmm @ (Type2) Yes  Smart Edge (Line) Y 1 
SELnnn_YMAX @ (Type2) Yes  Smart Edge (Line) X of Max. value 
SELnnn_YMIN @ (Type2) Yes  Smart Edge (Line) X of Min. value 
SIN(  Yes  Sine when the value in parentheses is 

radian 
SIND(  Yes  Sine when the value in parentheses is 

degree 
SMCnnn_AREA.mmm @ (Type2) Yes  Smart Matching Pixels of Max. 

Subtracted Object 
SMCnnn_CANG.mmm @ (Type2) Yes  Smart Matching Detect Angle 
SMCnnn_CLL.m @ (Type2) Yes  Smart Matching Correlation (Interim) 
SMCnnn_CNT.m @ (Type2) Yes  Smart Matching Detected Count 

(Interim) 
SMCnnn_COR.mmm @ (Type2) Yes  Smart Matching Correlation Value 
SMCnnn_COUNT @ (Type2) Yes  Smart Matching No. of Objects 
SMCnnn_JUDGE @ (Type1) Yes Yes Smart Matching Judgement 
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SMCnnn_LCNT.mmm @ (Type2) Yes  Smart Matching No. of Subtracted 
Objects 

SMCnnn_PX.mmm @ (Type2) Yes  Smart Matching Proj. X Axis 
SMCnnn_PY.mmm @ (Type2) Yes  Smart Matching Proj. Y Axis 
SMCnnn_TEMP.mmm @ (Type2) Yes  Smart Matching Detect Template No. 
SMCnnn_TIME @ (Type2) Yes  Smart Matching Inspection Time 
SMCnnn_X.mmm @ (Type2) Yes  Smart Matching X 
SMCnnn_Y.mmm @ (Type2) Yes  Smart Matching Y 
SORT(  Yes  The value of the number specified by the 

fourth term in parentheses when sorting the 
number of Calculation Nos. specified by the 
second term from the Numerical 
Calculation No. specified by the first term in 
the order specified by the third term 
(0=descending, 1=ascending). 

SQRT(  Yes  Square root of a value in parentheses 
SUM(  Yes  Sum of the calculation results for the 

number specified by the second term in 
parentheses from the Numerical 
Calculation No. specified by the first term. 

SYS:REG0  Yes  System Register 0  
SYS:REG1  Yes  System Register 1  
SYS:REG2  Yes  System Register 2  
SYS:REG3  Yes  System Register 3  
SYS:REG4  Yes  System Register 4  
SYS:REG5  Yes  System Register 5  
SYS:REG6  Yes  System Register 6  
SYS:REG7  Yes  System Register 7  
SYS_COUNT  Yes  Scan Count  
TAN(  Yes  Tangent when the value in parentheses is 

radian 
TAND(  Yes  Tangent when the value in parentheses is 

degree 
VDIST(  Yes  Length of a perpendicular to a line through 

a point expressed by five values in 
parentheses 

VPOINTX(  Yes  X of the foot of a perpendicular to a line 
through a point expressed by five values in 
parentheses 

VPOINTY(  Yes  Y of the foot of a perpendicular to a line 
through a point expressed by five values in 
parentheses 

 
 



 

740 

A
ppendix 

List of general communication commands 
This section describes communication commands in alphabetical order.  "nnn" in commands expresses a 
checker number. 

 

Command Meaning Send Receive Refer 
to 

%!10035 BCC error, reception of an undefined 
command / error 

 Yes 599 

%!11034 Receive buffer overflow / error  Yes 599 
%A!20077 Smart Matching template setting / error  Yes 607 

608 
%A!23074 Smart Matching template setting / error  Yes 607 

608 
%A!23175 Smart Matching template setting / error  Yes 607 

608 
%A!23276 Smart Matching template setting / error  Yes 607 

608 
%A!23377 Smart Matching template setting / error  Yes 607 

608 
%A$40 Smart Matching template setting  Yes 607 

608 
%A64 Smart Matching template setting ("Area 

Display: Yes") 
Yes  608 

%Annn,??(BCC) 
??:Template No.(00-63) 

Smart Matching template setting Yes  607 
608 

%B!20074 Smart Matching template setting / error  Yes 609 
609 

%B!23077 Smart Matching template setting / error  Yes 609 
609 

%B!23176 Smart Matching template setting / error  Yes 609 
609 

%B!23275 Smart Matching template setting / error  Yes 609 
609 

%B!23374 Smart Matching template setting / error  Yes 609 
609 

%B$43 Smart Matching template setting  Yes 609 
609 

%B67 Smart Matching template setting ("Area 
Display: Yes") 

Yes  609 

%Bnnn,??(BCC) 
??:Template No. 00 (Fixed) 

Smart Matching template setting Yes  609 

%BC$?(BCC) 
?:Valid/Invalid(0-1) 

Reading Keypad Operation Status  Yes 606 

%BC24 Reading Keypad Operation Status Yes  606 
%BS!27020 Setting Invalid/Valid of Keypad operation / 

error 
 Yes 606 

%BS!27121 Setting Invalid/Valid of Keypad operation / 
error 

 Yes 606 

%BS$10 Setting Invalid/Valid of Keypad operation  Yes 606 
%BS$?(BCC) 
?:Valid/Invalid(0-1) 

Setting Invalid/Valid of Keypad operation Yes  606 

%CC$01 Canceling Inspection/ Processing (Cancel 
specific operation) 

 Yes 606 

%CC25 Canceling Inspection/ Processing (Cancel 
specific operation) 

Yes  606 

%CD!21737 Aborting save/read setting data / error  Yes 604 
%CD$06 Aborting save/read setting data / error  Yes 604 
%CD22 Aborting save/read setting data / error Yes  604 
%CR!20027 Reading setting data (SD memory card) / 

error 
 Yes 603 

%CR!21224 Reading setting data (SD memory card) / 
error 

 Yes 603 
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%CR!21325 Reading setting data (SD memory card) / 
error 

 Yes 603 

%CR!21422 Reading setting data (SD memory card) / 
error 

 Yes 603 

%CR$10 Reading setting data (SD memory card)  Yes 603 
%CR??(BCC) 
??:Storage area No.(00-99) 

Reading setting data (SD memory card) Yes  603 

%CW!20022 Saving setting data (SD memory card) / 
error 

 Yes 602 

%CW!21221 Saving setting data (SD memory card) / 
error 

 Yes 602 

%CW!21625 Saving setting data (SD memory card) / 
error 

 Yes 602 

%CW$15 Saving setting data (SD memory card)  Yes 602 
%CW??(BCC) 
??:Storage area No.(00-99) 

Saving setting data (SD memory card) Yes  602 

%E$44 Resetting error signal  Yes 606 
%E60 Resetting error signal Yes  606 
%I!2007F Switching layout / error  Yes 607 
%I!2467D Switching layout / error  Yes 607 
%I$48 Switching layout  Yes 607 
%I??(BCC) 
??:Layout No.(00-15) 

Switching layout Yes  607 

%Ks??(BCC) 
s:SHIFT OFF/ON(0-1) 
??:Button information(01-16) 

Keypad Operation (Key Emulation) Yes  606 

%MR!20029 Reading setting data (Storage space in 
PV200) / error 

 Yes 603 

%MR!2142C Reading setting data (Storage space in 
PV200) / error 

 Yes 603 

%MR$1E Reading setting data (Storage space in 
PV200) 

 Yes 603 

%MR3A Reading setting data (Storage space in 
PV200) 

Yes  603 

%MW!2002C Saving setting data (Storage space in 
PV200) / error 

 Yes 602 

%MW$1B Saving setting data (Storage space in 
PV200) 

 Yes 602 

%MW3F Saving setting data (Storage space in 
PV200) 

Yes  602 

%PR BECnnn:MAX(BCC) Read / Checker / Binary Edge / OK Judge. 
Max. 

Yes  611 
613 

%PR BECnnn:MIN(BCC) Read / Checker / Binary Edge / OK Judge. 
Min. 

Yes  611 
613 

%PR BLVc:H?(BCC) 
c: Camera No.(0-1)  
?:Slice Level Group(A-P) 

Read / Slice Level / Maximum Value Yes  611 
616 

%PR BLVc:L?(BCC) 
c: Camera No.(0-1) 
?:Slice Level Group(A-P) 

Read / Slice Level / Minimum Value Yes  611 
616 

%PR BLV:H?(BCC) 
?:Slice Level Group(A-P) 

Read / Slice Level / Maximum Value Yes  611 
616 

%PR BLV:L?(BCC) 
?:Slice Level Group(A-P) 

Read / Slice Level / Minimum Value Yes  611 
616 

%PR BWCnnn:MAX(BCC) Read / Checker / Binary Window / OK 
Judge. Max. 

Yes  611 
613 

%PR BWCnnn:MIN(BCC) Read / Checker / Binary Window / OK 
Judge. Min. 

Yes  611 
613 

%PR CACnnn:MAX(BCC) Read / Numerical Calculation / Judge. Max. Yes  611 
616 
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%PR CACnnn:MIN(BCC) Read / Numerical Calculation / Judge. Min. Yes  611 
616 

%PR CBWnnn:CMAX(BCC) Read / Checker / Connector(Binary 
Window) / Common Judge. Max. 

Yes  611 
614 

%PR CBWnnn:CMIN(BCC) Read / Checker / Connector(Binary 
Window) / Common Judge. Min. 

Yes  611 
614 

%PR CBWnnn:MAX.ss(BCC) 
ss: Cell No.(00-99) 

Read / Checker / Connector(Binary 
Window) / Individual Judge. Max. 

Yes  611 
614 

%PR CBWnnn:MIN.ss(BCC) 
ss: Cell No.(00-99) 

Read / Checker / Connector(Binary 
Window) / Individual Judge. Min. 

Yes  611 
614 

%PR CGEnnn:PMAX(BCC) Read / Checker / Connector(Gray Edge) / 
Max. Pitch Judge. 

Yes  611 
614 

%PR CGEnnn:PMIN(BCC) Read / Checker / Connector(Gray Edge) / 
Min. Pitch Judge. 

Yes  611 
614 

%PR CGEnnn:UMAX(BCC) Read / Checker / Connector(Gray Edge) / 
Max. Distance Difference Judge. 

Yes  611 
614 

%PR CGEnnn:UMIN(BCC) Read / Checker / Connector(Gray Edge) / 
Min. Distance Difference Judge. 

Yes  611 
614 

%PR CGWnnn:CMAX(BCC) Read / Checker / Connector(Gray Window) / 
Common Judge. Max. 

Yes  611 
614 

%PR CGWnnn:CMIN(BCC) Read / Checker / Connector(Gray Window) / 
Common Judge. Min. 

Yes  611 
614 

%PR CGWnnn:MAX.ss(BCC) 
ss: Cell No.(00-99) 

Read / Checker / Connector(Gray Window) / 
Individual Judge. Max. 

Yes  611 
614 

%PR CGWnnn:MIN.ss(BCC) 
ss: Cell No.(00-99) 

Read / Checker / Connector(Gray Window) / 
Individual Judge. Min. 

Yes  611 
614 

%PR CWCnnn:BAMAX(BCC) Read / Checker / Color Window / B Gray 
Ave. Max. 

Yes  611 
615 

%PR CWCnnn:BAMIN(BCC) Read / Checker / Color Window / B Gray 
Ave. Min. 

Yes  611 
615 

%PR CWCnnn:BMAX(BCC) Read / Checker / Color Window / B Gray 
Max. 

Yes  611 
615 

%PR CWCnnn:BMIN(BCC) Read / Checker / Color Window / B Gray 
Min. 

Yes  611 
615 

%PR CWCnnn:BSMAX(BCC) Read / Checker / Color Window / B Gray 
Standard Deviation Max. 

Yes  611 
615 

%PR CWCnnn:BSMIN(BCC) Read / Checker / Color Window / B Gray 
Standard Deviation Min. 

Yes  611 
615 

%PR CWCnnn:GAMAX(BCC) Read / Checker / Color Window / G Gray 
Ave. Max. 

Yes  611 
615 

%PR CWCnnn:GAMIN(BCC) Read / Checker / Color Window / G Gray 
Ave. Min. 

Yes  611 
615 

%PR CWCnnn:GMAX(BCC) Read / Checker / Color Window / G Gray 
Max. 

Yes  611 
615 

%PR CWCnnn:GMIN(BCC) Read / Checker / Color Window / G Gray 
Min. 

Yes  611 
615 

%PR CWCnnn:GSMAX(BCC) Read / Checker / Color Window / G Gray 
Standard Deviation Max. 

Yes  611 
615 

%PR CWCnnn:GSMIN(BCC) Read / Checker / Color Window / G Gray 
Standard Deviation Min. 

Yes  611 
615 

%PR CWCnnn:RAMAX(BCC) Read / Checker / Color Window / R Gray 
Ave. Max. 

Yes  611 
615 

%PR CWCnnn:RAMIN(BCC) Read / Checker / Color Window / R Gray 
Ave. Min. 

Yes  611 
615 

%PR CWCnnn:RMAX(BCC) Read / Checker / Color Window / R Gray 
Max. 

Yes  611 
615 

%PR CWCnnn:RMIN(BCC) Read / Checker / Color Window / R Gray 
Min. 

Yes  611 
615 

%PR CWCnnn:RSMAX(BCC) Read / Checker / Color Window / R Gray 
Standard Deviation Max. 

Yes  611 
615 
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%PR CWCnnn:RSMIN(BCC) Read / Checker / Color Window / R Gray 
Standard Deviation Min. 

Yes  611 
615 

%PR FECnnn:MAX(BCC) Read / Checker / Feature Extraction / OK 
Judge. Max. 

Yes  611 
614 

%PR FECnnn:MIN(BCC) Read / Checker / Feature Extraction / OK 
Judge. Min. 

Yes  611 
614 

%PR FWCnnn:MAX(BCC) Read / Checker / Flaw Detection/ OK Judge. 
Max. 

Yes  611 
614 

%PR FWCnnn:MIN(BCC) Read / Checker / Flaw Detection/ OK Judge. 
Min. 

Yes  611 
614 

%PR GECnnn:LVL(BCC) Read / Checker / Gray Edge / Edge 
Threshold 

Yes  611 
613 

%PR GECnnn:MAX(BCC) Read / Checker / Gray Edge / OK Judge. 
Max. 

Yes  611 
613 

%PR GECnnn:MIN(BCC) Read / Checker / Gray Edge / OK Judge. 
Min. 

Yes  611 
613 

%PR GGCnnn:AMAX(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. Angle 

Yes  611 
616 

%PR GGCnnn:AMIN(BCC) Read / Geometry Calculation / Geometry 
Calculation / Min. Angle 

Yes  611 
616 

%PR GGCnnn:CAMAX(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. Intersect. Angle 

Yes  611 
616 

%PR GGCnnn:CAMIN(BCC) Read / Geometry Calculation / Geometry 
Calculation / Min. Intersect. Angle 

Yes  611 
616 

%PR GGCnnn:DMAX(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. Distance 

Yes  611 
616 

%PR GGCnnn:DMIN(BCC) Read / Geometry Calculation / Geometry 
Calculation / Min. Distance 

Yes  611 
616 

%PR GGCnnn:LAMAX(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. Major Axis 

Yes  611 
616 

%PR GGCnnn:LAMIN(BCC) Read / Geometry Calculation / Geometry 
Calculation / Min. Major Axis 

Yes  611 
616 

%PR GGCnnn:RMAX(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. Radius 

Yes  611 
616 

%PR GGCnnn:RMIN(BCC) Read / Geometry Calculation / Geometry 
Calculation / Min. Radius 

Yes  611 
616 

%PR GGCnnn:SAMAX(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. Minor Axis 

Yes  611 
616 

%PR GGCnnn:SAMIN(BCC) Read / Geometry Calculation / Geometry 
Calculation / Min. Minor Axis 

Yes  611 
616 

%PR GGCnnn:SMAX(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. Standard Deviation 

Yes  611 
616 

%PR GGCnnn:SMIN(BCC) Read / Geometry Calculation / Geometry 
Calculation / Min. Standard Deviation 

Yes  611 
616 

%PR GGCnnn:XMAX(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. X 

Yes  611 
616 

%PR GGCnnn:XMIN(BCC) Read / Geometry Calculation / Geometry 
Calculation / Min. X 

Yes  611 
616 

%PR GGCnnn:YMAX(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. Y 

Yes  611 
616 

%PR GGCnnn:YMIN(BCC) Read / Geometry Calculation / Geometry 
Calculation / Min. Y 

Yes  611 
616 

%PR GWCnnn:MAX(BCC) Read / Checker / Gray Window / OK Judge. 
Max. 

Yes  611 
613 

%PR GWCnnn:MIN(BCC) Read / Checker / Gray Window / OK Judge. 
Min. 

Yes  611 
613 

%PR LICnnn:DMAX(BCC) Read / Checker / Line / Max. No. of Pixels Yes  611 
613 

%PR LICnnn:DMIN(BCC) Read / Checker / Line / Min. No. of Pixels Yes  611 
613 
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%PR LICnnn:LMAX(BCC) Read / Checker / Line / Max. No. of Objects Yes  611 
613 

%PR LICnnn:LMIN(BCC) Read / Checker / Line / Min. No. of Objects Yes  611 
613 

%PR SECnnn:CMAX(BCC) Read / Checker / Smart Edge(Circle) / Max. 
Circularity 

Yes  611 
615 

%PR SECnnn:CMIN(BCC) Read / Checker / Smart Edge(Circle) / Min. 
Circularity 

Yes  611 
615 

%PR SECnnn:LMAX(BCC) Read / Checker / Smart Edge(Circle) / Max. 
Measurement 

Yes  611 
615 

%PR SECnnn:LMIN(BCC) Read / Checker / Smart Edge(Circle) / Min. 
Measurement 

Yes  611 
615 

%PR SECnnn:NMAX(BCC) Read / Checker / Smart Edge(Circle) / Max. 
Unused Edge Count 

Yes  611 
615 

%PR SECnnn:SMAX(BCC) Read / Checker / Smart Edge(Circle) / Max. 
Standard Deviation 

Yes  611 
615 

%PR SECnnn:SMIN(BCC) Read / Checker / Smart Edge(Circle) / Min. 
Standard Deviation 

Yes  611 
615 

%PR SELnnn:LIMAX(BCC) Read / Checker / Smart Edge(Line) / Max. 
Linearity 

Yes  611 
615 

%PR SELnnn:LIMIN(BCC) Read / Checker / Smart Edge(Line) / Min. 
Linearity 

Yes  611 
615 

%PR SELnnn:LMAX(BCC) Read / Checker / Smart Edge(Line) / Max. 
Measurement 

Yes  611 
615 

%PR SELnnn:LMIN(BCC) Read / Checker / Smart Edge(Line) / Min. 
Measurement 

Yes  611 
615 

%PR SELnnn:NMAX(BCC) Read / Checker / Smart Edge(Line) / Max. 
Unused Edge Count 

Yes  611 
615 

%PR SELnnn:SMAX(BCC) Read / Checker / Smart Edge(Line) / Max. 
Standard Deviation 

Yes  611 
615 

%PR SELnnn:SMIN(BCC) Read / Checker / Smart Edge(Line) / Min. 
Standard Deviation 

Yes  611 
615 

%PR SMCnnn:CNT.?(BCC) 
?: Sequence Step (1-6) 

Read / Checker / Smart Matching / Search 
Count 

Yes  611 
614 

%PR SMCnnn:DCNTMAX 
(BCC) 

Read / Checker / Smart Matching / Max. OK 
No. of Subtracted Objects 

Yes  611 
614 

%PR SYS:REG?(BCC) 
?: General Register No.(0-7) 

Read / System value / General registers 0-7 Yes  611 
613 

%PR SYS_COUNT(BCC) Read / System value / Scan Count Yes  611 
613 

%PR SYS_DATE(BCC) Read / System value / Current Date Yes  611 
613 

%PR SYS_EDIT(BCC) Read / System value / Window Status Yes  611 
613 

%PR SYS_RESULT(BCC) Read / System value / Total Judgement Yes  611 
613 

%PR SYS_RUN(BCC) Read / System value / Operation Status Yes  611 
613 

%PR SYS_TIME(BCC) Read / System value / Current Time Yes  611 
613 

%PR SYS_TIME1(BCC) Read / System value / Inspection Time Yes  611 
613 

%PR SYS_TIME2(BCC) Read / System value / Inspection Frequency Yes  611 
613 

%PR SYS_TYPE(BCC) Read / System value / Current Type No. Yes  611 
613 

%PR!20034 Read / error  Yes 611 
%PR!25130 Read / error  Yes 611 
%PR!25233 Read / error  Yes 611 
%PR$BECnnn:MAX=[Data] 
(BCC) 

Read / Checker / Binary Edge / OK Judge. 
Max. 

 Yes 611 
613 
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%PR$BECnnn:MIN=[Data] 
(BCC) 

Read / Checker / Binary Edge / OK Judge. 
Min. 

 Yes 611 
613 

%PR$BLVc:H?=[Data](BCC) 
c: Camera No.(0-1) 
?: Slice Level Group(A-P) 

Read / Slice Level / Maximum Value  Yes 611 
616 

%PR$BLVc:L?=[Data](BCC) 
c: Camera No.(0-1) 
?: Slice Level Group(A-P) 

Read / Slice Level / Minimum Value  Yes 611 
616 

%PR$BLV:H?=[Data](BCC) 
?: Slice Level Group(A-P) 

Read / Slice Level / Maximum Value  Yes 611 
616 

%PR$BLV:L?=[Data](BCC) 
?: Slice Level Group(A-P) 

Read / Slice Level / Minimum Value  Yes 611 
616 

%PR$BWCnnn:MAX=[Data] 
(BCC) 

Read / Checker / Binary Window / OK 
Judge. Max. 

 Yes 611 
613 

%PR$BWCnnn:MIN=[Data] 
(BCC) 

Read / Checker / Binary Window / OK 
Judge. Min. 

 Yes 611 
613 

%PR$CACnnn:MAX=[Data] 
(BCC) 

Read / Numerical Calculation / Judge. Max.  Yes 611 
616 

%PR$CACnnn:MIN=[Data] 
(BCC) 

Read / Numerical Calculation / Judge. Min.  Yes 611 
616 

%PR$CBWnnn:CMAX=[Data] 
(BCC) 

Read / Checker / Connector(Binary 
Window) / Common Judge. Max. 

 Yes 611 
614 

%PR$CBWnnn:CMIN=[Data] 
(BCC) 

Read / Checker / Connector(Binary 
Window) / Common Judge. Min. 

 Yes 611 
614 

%PR$CBWnnn:MAX.ss=[Data
](BCC) 
 ss: Cell No.(00-99) 

Read / Checker / Connector(Binary 
Window) / Individual Judge. Max. 

 Yes 611 
614 

%PR$CBWnnn:MIN.ss=[Data]
(BCC) 
 ss: Cell No.(00-99) 

Read / Checker / Connector(Binary 
Window) / Individual Judge. Min. 

 Yes 611 
614 

%PR$CGEnnn:PMAX=[Data](
BCC) 

Read / Checker / Connector(Gray Edge) / 
Max. Pitch Judge. 

 Yes 611 
614 

%PR$CGEnnn:PMIN=[Data] 
(BCC) 

Read / Checker / Connector(Gray Edge) / 
Min. Pitch Judge. 

 Yes 611 
614 

%PR$CGEnnn:UMAX=[Data](
BCC) 

Read / Checker / Connector(Gray Edge) / 
Max. Distance Difference Judge. 

 Yes 611 
614 

%PR$CGEnnn:UMIN=[Data](
BCC) 

Read / Checker / Connector(Gray Edge) / 
Min. Distance Difference Judge. 

 Yes 611 
614 

%PR$CGWnnn:CMAX=[Data](
BCC) 

Read / Checker / Connector(Gray Window) / 
Max. Common Judge. 

 Yes 611 
614 

%PR$CGWnnn:CMIN=[Data](
BCC) 

Read / Checker / Connector(Gray Window) / 
Common Judge. Min. 

 Yes 611 
614 

%PR$CGWnnn:MAX.ss=[Data
](BCC) 
 ss: Cell No.(00-99) 

Read / Checker / Connector(Gray Window) / 
Individual Judge. Max. 

 Yes 611 
614 

%PR$CGWnnn:MIN.ss=[Data]
(BCC) 
 ss: Cell No.(00-99) 

Read / Checker / Connector(Gray Window) / 
Individual Judge. Min. 

 Yes 611 
614 

%PR$CWCnnn:BAMAX=[Data
](BCC) 

Read / Checker / Color Window / B Gray 
Ave. Max. 

 Yes 611 
615 

%PR$CWCnnn:BAMIN=[Data]
(BCC) 

Read / Checker / Color Window / B Gray 
Ave. Min. 

 Yes 611 
615 

%PR$CWCnnn:BMAX=[Data](
BCC) 

Read / Checker / Color Window / B Gray 
Max. 

 Yes 611 
615 

%PR$CWCnnn:BMIN=[Data](
BCC) 

Read / Checker / Color Window / B Gray 
Min. 

 Yes 611 
615 

%PR$CWCnnn:BSMAX=[Data
](BCC) 

Read / Checker / Color Window / B Gray 
Standard Deviation Max. 

 Yes 611 
615 

%PR$CWCnnn:BSMIN=[Data]
(BCC) 

Read / Checker / Color Window / B Gray 
Standard Deviation Min. 

 Yes 611 
615 
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%PR$CWCnnn:GAMAX=[Data
](BCC) 

Read / Checker / Color Window / G Gray 
Ave. Max. 

 Yes 611 
615 

%PR$CWCnnn:GAMIN=[Data]
(BCC) 

Read / Checker / Color Window / G Gray 
Ave. Min. 

 Yes 611 
615 

%PR$CWCnnn:GMAX=[Data](
BCC) 

Read / Checker / Color Window / G Gray 
Max. 

 Yes 611 
615 

%PR$CWCnnn:GMIN=[Data](
BCC) 

Read / Checker / Color Window / G Gray 
Min. 

 Yes 611 
615 

%PR$CWCnnn:GSMAX=[Data
](BCC) 

Read / Checker / Color Window / G Gray 
Standard Deviation Max. 

 Yes 611 
615 

%PR$CWCnnn:GSMIN=[Data]
(BCC) 

Read / Checker / Color Window / G Gray 
Standard Deviation Min. 

 Yes 611 
615 

%PR$CWCnnn:RAMAX=[Data
](BCC) 

Read / Checker / Color Window / R Gray 
Ave. Max. 

 Yes 611 
615 

%PR$CWCnnn:RAMIN=[Data]
(BCC) 

Read / Checker / Color Window / R Gray 
Ave. Min. 

 Yes 611 
615 

%PR$CWCnnn:RMAX=[Data](
BCC) 

Read / Checker / Color Window / R Gray 
Max. 

 Yes 611 
615 

%PR$CWCnnn:RMIN=[Data](
BCC) 

Read / Checker / Color Window / R Gray 
Min. 

 Yes 611 
615 

%PR$CWCnnn:RSMAX=[Data
](BCC) 

Read / Checker / Color Window / R Gray 
Standard Deviation Max. 

 Yes 611 
615 

%PR$CWCnnn:RSMIN=[Data]
(BCC) 

Read / Checker / Color Window / R Gray 
Standard Deviation Min. 

 Yes 611 
615 

%PR$FECnnn:MAX=[Data] 
(BCC) 

Read / Checker / Feature Extraction / OK 
Judge. Max. 

 Yes 611 
614 

%PR$FECnnn:MIN=[Data] 
(BCC) 

Read / Checker / Feature Extraction / OK 
Judge. Min. 

 Yes 611 
614 

%PR$FWCnnn:MAX=[Data] 
(BCC) 

Read / Checker / Flaw Detection/ OK Judge. 
Max. 

 Yes 611 
614 

%PR$FWCnnn:MIN=[Data] 
(BCC) 

Read / Checker / Flaw Detection/ OK Judge. 
Min. 

 Yes 611 
614 

%PR$GECnnn:LVN=[Data] 
(BCC) 

Read / Checker / Gray Edge / Edge 
Threshold 

 Yes 611 
613 

%PR$GECnnn:MAX=[Data] 
(BCC) 

Read / Checker / Gray Edge / OK Judge. 
Max. 

 Yes 611 
613 

%PR$GECnnn:MIN=[Data] 
(BCC) 

Read / Checker / Gray Edge / OK Judge. 
Min. 

 Yes 611 
613 

%PR$GGCnnn:AMAX=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. Angle 

 Yes 611 
616 

%PR$GGCnnn:AMIN=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Min. Angle 

 Yes 611 
616 

%PR$GGCnnn:CAMAX=[Data
](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. Intersect. Angle 

 Yes 611 
616 

%PR$GGCnnn:CAMIN=[Data]
(BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Min. Intersect. Angle 

 Yes 611 
616 

%PR$GGCnnn:DMAX=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. Distance 

 Yes 611 
616 

%PR$GGCnnn:DMIN=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Min. Distance 

 Yes 611 
616 

%PR$GGCnnn:LAMAX=[Data]
(BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. Major Axis 

 Yes 611 
616 

%PR$GGCnnn:LAMIN=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Min. Major Axis 

 Yes 611 
616 

%PR$GGCnnn:RMAX=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. Radius 

 Yes 611 
616 

%PR$GGCnnn:RMIN=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Min. Radius 

 Yes 611 
616 

%PR$GGCnnn:SAMAX=[Data
](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. Minor Axis 

 Yes 611 
616 
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%PR$GGCnnn:SAMIN=[Data]
(BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Min. Minor Axis 

 Yes 611 
616 

%PR$GGCnnn:SMAX=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. Standard Deviation 

 Yes 611 
616 

%PR$GGCnnn:SMIN=[Data] 
(BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Min. Standard Deviation 

 Yes 611 
616 

%PR$GGCnnn:XMAX=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. X 

 Yes 611 
616 

%PR$GGCnnn:XMIN=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Min. X 

 Yes 611 
616 

%PR$GGCnnn:YMAX=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. Y 

 Yes 611 
616 

%PR$GGCnnn:YMIN=[Data](
BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Min. Y 

 Yes 611 
616 

%PR$GWCnnn:MAX=[Data] 
(BCC) 

Read / Checker / Gray Window / OK Judge. 
Max. 

 Yes 611 
613 

%PR$GWCnnn:MIN=[Data] 
(BCC) 

Read / Checker / Gray Window / OK Judge. 
Min. 

 Yes 611 
613 

%PR$LICnnn:DMAX=[Data] 
(BCC) 

Read / Checker / Line / Max. No. of Pixels  Yes 611 
613 

%PR$LICnnn:DMIN=[Data] 
(BCC) 

Read / Checker / Line / Min. No. of Pixels  Yes 611 
613 

%PR$LICnnn:LMAX=[Data] 
(BCC) 

Read / Checker / Line / Max. No. of Objects  Yes 611 
613 

%PR$LICnnn:LMIN=[Data] 
(BCC) 

Read / Checker / Line / Min. No. of Objects  Yes 611 
613 

%PR$SECnnn:CMAX=[Data](
BCC) 

Read / Checker / Smart Edge(Circle) / Max. 
Circularity 

 Yes 611 
615 

%PR$SECnnn:CMIN=[Data] 
(BCC) 

Read / Checker / Smart Edge(Circle) / Min. 
Circularity 

 Yes 611 
615 

%PR$SECnnn:LMAX=[Data](
BCC) 

Read / Checker / Smart Edge(Circle) / Max. 
Measurement 

 Yes 611 
615 

%PR$SECnnn:LMIN=[Data] 
(BCC) 

Read / Checker / Smart Edge(Circle) / Min. 
Measurement 

 Yes 611 
615 

%PR$SECnnn:NMAX=[Data](
BCC) 

Read / Checker / Smart Edge(Circle) / Max. 
Unused Edge Count 

 Yes 611 
615 

%PR$SECnnn:SMAX=[Data] 
(BCC) 

Read / Checker / Smart Edge(Circle) / Max. 
Standard Deviation 

 Yes 611 
615 

%PR$SECnnn:SMIN=[Data] 
(BCC) 

Read / Checker / Smart Edge(Circle) / Min. 
Standard Deviation 

 Yes 611 
615 

%PR$SELnnn:LIMAX=[Data](
BCC) 

Read / Checker / Smart Edge(Line) / Max. 
Linearity 

 Yes 611 
615 

%PR$SELnnn:LIMIN=[Data](B
CC) 

Read / Checker / Smart Edge(Line) / Min. 
Linearity 

 Yes 611 
615 

%PR$SELnnn:LMAX=[Data] 
(BCC) 

Read / Checker / Smart Edge(Line) / Max. 
Measurement 

 Yes 611 
615 

%PR$SELnnn:LMIN=[Data] 
(BCC) 

Read / Checker / Smart Edge(Line) / Min. 
Measurement 

 Yes 611 
615 

%PR$SELnnn:NMAX=[Data](
BCC) 

Read / Checker / Smart Edge(Line) / Max. 
Unused Edge Count 

 Yes 611 
615 

%PR$SELnnn:SMAX=[Data] 
(BCC) 

Read / Checker / Smart Edge(Line) / Max. 
Standard Deviation 

 Yes 611 
615 

%PR$SELnnn:SMIN=[Data] 
(BCC) 

Read / Checker / Smart Edge(Line) / Min. 
Standard Deviation 

 Yes 611 
615 

%PR$SMCnnn:CNT.?=[Data](
BCC) 
 ?: Sequence Step(1-6) 

Read / Checker / Smart Matching / Search 
Count 

 Yes 611 
614 

%PR$SMCnnn:DCNTMAX= 
[Data](BCC) 

Read / Checker / Smart Matching / Max. OK 
No. of Subtracted Objects 

 Yes 611 
614 



 

748 

A
ppendix 

Command Meaning Send Receive Refer 
to 

%PR$SYS:REG?=[Data] 
(BCC) 
 ?: General Register No.(0-7) 

Read / System value / General registers 0-7  Yes 611 
613 

%PR$SYS_COUNT=[Data] 
(BCC) 

Read / System value / Scan Count  Yes 611 
613 

%PR$SYS_DATE=[Data] 
(BCC) 

Read / System value / Current Date  Yes 611 
613 

%PR$SYS_EDIT=[Data] 
(BCC) 

Read / System value / Window Status  Yes 611 
613 

%PR$SYS_RESULT=[Data] 
(BCC) 

Read / System value / Total Judgement  Yes 611 
613 

%PR$SYS_RUN=[Data] 
(BCC) 

Read / System value / Operation Status  Yes 611 
613 

%PR$SYS_TIME=[Data] 
(BCC) 

Read / System value / Current Time  Yes 611 
613 

%PR$SYS_TIME1=[Data] 
(BCC) 

Read / System value / Inspection Time  Yes 611 
613 

%PR$SYS_TIME2=[Data] 
(BCC) 

Read / System value / Inspection Frequency  Yes 611 
613 

%PR$SYS_TYPE=[Data] 
(BCC) 

Read / System value / Current Type No.  Yes 611 
613 

%PRP BECnnn:LPAIR(BCC) Read / Checker / Binary Edge / OK Judge. 
Max. and Min. 

Yes  611 
613 

%PRP BLVc:PAIR?(BCC) 
c: Camera No.(0-1) 
?: Slice Level Group (A-P) 

Read / Slice Level / Max. and Min. Yes  611 
616 

%PRP BLV:PAIR?(BCC) 
?: Slice Level Group (A-P) 

Read / Slice Level / Max. and Min. Yes  611 
616 

%PRP BWCnnn:LPAIR(BCC) Read / Checker / Binary Window / OK 
Judge. Max. and Min. 

Yes  611 
613 

%PRP CACnnn:LPAIR(BCC) Read / Numerical Calculation / Max. and 
Min. 

Yes  611 
616 

%PRP CBWnnn:CPAIR(BCC) Read / Checker / Connector(Binary 
Window) / Common Judge. Max. and Min. 

Yes  611 
614 

%PRP CBWnnn:LPAIR.ss 
(BCC) 
 ss: Cell No.(00-99) 

Read / Checker / Connector(Binary 
Window) / Individual Judge. Max. and Min. 

Yes  611 
614 

%PRP CGEnnn:PPAIR(BCC) Read / Checker / Connector(Gray Edge) / 
Max. and Min. Pitch Judge. 

Yes  611 
614 

%PRP CGEnnn:UPAIR(BCC) Read / Checker / Connector(Gray Edge) / 
Max. and Min. Distance Difference Judge. 

Yes  611 
614 

%PRP CGWnnn:CPAIR(BCC) Read / Checker / Connector(Gray Window) / 
Common Judge. Max. and Min. 

Yes  611 
614 

%PRP CGWnnn:LPAIR.ss 
(BCC) 
 ss: Cell No.(00-99) 

Read / Checker / Connector(Gray Window) / 
Individual Judge. Max. and Min. 

Yes  611 
614 

%PRP CWCnnn:BAPAIR 
(BCC) 

Read / Checker / Color Window / B Gray 
Ave. Max. and Min. 

Yes  611 
615 

%PRP CWCnnn:BPAIR(BCC) Read / Checker / Color Window / B Gray 
Max. and Min. 

Yes  611 
615 

%PRP CWCnnn:BSPAIR 
(BCC) 

Read / Checker / Color Window / B Gray 
Standard Deviation Max. and Min. 

Yes  611 
615 

%PRP CWCnnn:GAPAIR 
(BCC) 

Read / Checker / Color Window / G Gray 
Ave. Max. and Min. 

Yes  611 
615 

%PRP CWCnnn:GPAIR(BCC) Read / Checker / Color Window / G Gray 
Max. and Min. 

Yes  611 
615 

%PRP CWCnnn:GSPAIR 
(BCC) 

Read / Checker / Color Window / G Gray 
Standard Deviation Max. and Min. 

Yes  611 
615 

%PRP CWCnnn:RAPAIR 
(BCC) 

Read / Checker / Color Window / R Gray 
Ave. Max. and Min. 

Yes  611 
615 
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%PRP CWCnnn:RPAIR(BCC) Read / Checker / Color Window / R Gray 
Max. and Min. 

Yes  611 
615 

%PRP CWCnnn:RSPAIR 
(BCC) 

Read / Checker / Color Window / R Gray 
Standard Deviation Max. and Min. 

Yes  611 
615 

%PRP FECnnn:LPAIR(BCC) Read / Checker / Feature Extraction / OK 
Judge. Max. and Min. 

Yes  611 
614 

%PRP FWCnnn:LPAIR(BCC) Read / Checker / Flaw Detection / OK 
Judge. Max. and Min. 

Yes  611 
615 

%PRP GECnnn:LPAIR(BCC) Read / Checker / Gray Edge / OK Judge. 
Max. and Min. 

Yes  611 
613 

%PRP GGCnnn:APAIR(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Angle 

Yes  611 
616 

%PRP GGCnnn:CAPAIR 
(BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Intersect. Angle 

Yes  611 
616 

%PRP GGCnnn:DPAIR(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Distance 

Yes  611 
616 

%PRP GGCnnn:LAPAIR(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Major Axis 

Yes  611 
616 

%PRP GGCnnn:RPAIR(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Radius 

Yes  611 
616 

%PRP GGCnnn:SAPAIR 
(BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Minor Axis 

Yes  611 
616 

%PRP GGCnnn:SPAIR(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Standard 
Deviation 

Yes  611 
616 

%PRP GGCnnn:XPAIR(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. X 

Yes  611 
616 

%PRP GGCnnn:YPAIR(BCC) Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Y 

Yes  611 
616 

%PRP GWCnnn:LPAIR(BCC) Read / Checker / Gray Window / OK Judge. 
Max. and Min. 

Yes  611 
613 

%PRP LICnnn:DPAIR(BCC) Read / Checker / Line / Max. and Min. No. of 
Pixels 

Yes  611 
613 

%PRP LICnnn:LPAIR(BCC) Read / Checker / Line / Max. and Min. No. of 
Objects 

Yes  611 
613 

%PR$MRKcg_CXY(BCC) 
 c: Camera No.(0-1) 
 g: Marker No.(0-7) 

Read / Marker / Central Coordinate set Yes  611 
617 

%PRP SECnnn:CPAIR(BCC) Read / Checker / Smart Edge(Circle) / Max. 
and Min. Circularity 

Yes  611 
615 

%PRP SECnnn:LPAIR(BCC) Read / Checker / Smart Edge(Circle) / Max. 
and Min. Measurement 

Yes  611 
615 

%PRP SECnnn:SPAIR(BCC) Read / Checker / Smart Edge(Circle) / Max. 
and Min. Standard Deviation 

Yes  611 
615 

%PRP SELnnn:LIPAIR(BCC) Read / Checker / Smart Edge(Line) / Max. 
and Min. Linearity 

Yes  611 
615 

%PRP SELnnn:LPAIR(BCC) Read / Checker / Smart Edge(Line) / Max. 
and Min. Measurement 

Yes  611 
615 

%PRP SELnnn:SPAIR(BCC) Read / Checker / Smart Edge(Line) / Max. 
and Min. Standard Deviation 

Yes  611 
615 

%PRP!20064 Read / Error  Yes 611 
%PRP!25160 Read / Error  Yes 611 
%PRP!25263 Read / Error  Yes 611 
%PRP$BECnnn:LPAIR=[Data 
1],[Data 2](BCC) 

Read / Checker / Binary Edge / OK Judge. 
Max. and Min. 

 Yes 611 
613 

%PRP$BLVc:PAIR?=[Data 1], 
[Data 2](BCC) 
 c: Camera No.(0-1) 
 ?: Slice Level Group(A-P) 

Read / Slice Level / Max. and Min.  Yes 611 
616 
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%PRP$BLV:PAIR?=[Data 1], 
[Data 2](BCC) 
 ?: Slice Level Group(A-P) 

Read / Slice Level / Max. and Min.  Yes 611 
616 

%PRP$BWCnnn:LPAIR=[Data 
1],[Data 2](BCC) 

Read / Checker / Binary Window / OK 
Judge. Max. and Min. 

 Yes 611 
613 

%PRP$CACnnn:LPAIR=[Data 
1],[Data 2](BCC) 

Read / Numerical Calculation / Max. and 
Min. 

 Yes 611 
616 

%PRP$CBWnnn:CPAIR=[Data
1],[Data 2](BCC) 

Read / Checker / Connector(Binary 
Window) / Common Judge. Max. and Min. 

 Yes 611 
614 

%PRP$CBWnnn:LPAIR.ss=[D
ata 1],[Data 2](BCC) 
 ss: Cell No.(00-99) 

Read / Checker / Connector(Binary 
Window) / Individual Judge. Max. and Min. 

 Yes 611 
614 

%PRP$CGEnnn:PPAIR=[Data 
1],[Data 2](BCC) 

Read / Checker / Connector(Gray Edge) / 
Min. and Min. Pitch Judge. 

 Yes 611 
614 

%PRP$CGEnnn:UPAIR=[Data 
1],[Data 2](BCC) 

Read / Checker / Connector(Gray Edge) / 
Max. and Min. Distance Difference Judge. 

 Yes 611 
614 

%PRP$CGWnnn:CPAIR=[Dat
a1],[Data 2](BCC) 

Read / Checker / Connector(Gray Window) / 
Common Judge. Max. and Min. 

 Yes 611 
614 

%PRP$CGWnnn:LPAIR.ss= 
[Data 1],[Data 2](BCC) 
 ss: Cell No.(00-99) 

Read / Checker / Connector(Gray Window) / 
Individual Judge. Max. and Min. 

 Yes 611 
614 

%PRP$CWCnnn:BAPAIR=[Da
ta 1],[Data 2](BCC) 

Read / Checker / Color Window / B Gray 
Ave. Max. and Min. 

 Yes 611 
615 

%PRP$CWCnnn:BPAIR=[Data
1],[Data 2](BCC) 

Read / Checker / Color Window / B Gray 
Max. and Min. 

 Yes 611 
615 

%PRP$CWCnnn:BSPAIR=[Da
ta 1],[Data 2](BCC) 

Read / Checker / Color Window / B Gray 
Standard Deviation Max. and Min. 

 Yes 611 
615 

%PRP$CWCnnn:GAPAIR=[Da
ta 1],[Data 2](BCC) 

Read / Checker / Color Window / G Gray 
Ave. Max. and Min. 

 Yes 611 
615 

%PRP$CWCnnn:GPAIR=[Dat
a1],[Data 2](BCC) 

Read / Checker / Color Window / G Gray 
Max. and Min. 

 Yes 611 
615 

%PRP$CWCnnn:GSPAIR=[Da
ta 1],[Data 2](BCC) 

Read / Checker / Color Window / G Gray 
Standard Deviation Max. and Min. 

 Yes 611 
615 

%PRP$CWCnnn:RAPAIR=[Da
ta 1],[Data 2](BCC) 

Read / Checker / Color Window / R Gray 
Ave. Max. and Min. 

 Yes 611 
615 

%PRP$CWCnnn:RPAIR=[Dat
a1],[Data 2](BCC) 

Read / Checker / Color Window / R Gray 
Max. and Min. 

 Yes 611 
615 

%PRP$CWCnnn:RSPAIR=[Da
ta 1],[Data 2](BCC) 

Read / Checker / Color Window / R Gray 
Standard Deviation Max. and Min. 

 Yes 611 
615 

%PRP$FECnnn:LPAIR=[Data 
1],[Data 2](BCC) 

Read / Checker / Feature Extraction / OK 
Judge. Max. and Min. 

 Yes 611 
614 

%PRP$FWCnnn:LPAIR=[Data 
1],[Data 2](BCC) 

Read / Checker / Flaw Detection / OK 
Judge. Max. and Min. 

 Yes 611 
614 

%PRP$GECnnn:LPAIR=[Data 
1],[Data 2](BCC) 

Read / Checker / Gray Edge / OK Judge. 
Max. and Min. 

 Yes 611 
613 

%PRP$GGCnnn:APAIR=[Data 
1],[Data 2](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Angle 

 Yes 611 
616 

%PRP$GGCnnn:CAPAIR=[Da
ta 1],[Data 2](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Intersect. Angle 

 Yes 611 
616 

%PRP$GGCnnn:DPAIR=[Data 
1],[Data 2](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Distance 

 Yes 611 
616 

%PRP$GGCnnn:LAPAIR=[Dat
a 1],[Data 2](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Major Axis 

 Yes 611 
616 

%PRP$GGCnnn:RPAIR=[Data
1],[Data 2](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Radius 

 Yes 611 
616 

%PRP$GGCnnn:SAPAIR=[Dat
a 1],[Data 2](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Minor Axis 

 Yes 611 
616 

%PRP$GGCnnn:SPAIR=[Data
1],[Data 2](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Standard 
Deviation 

 Yes 611 
616 
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%PRP$GGCnnn:XPAIR=[Data
1],[Data 2](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. X 

 Yes 611 
616 

%PRP$GGCnnn:YPAIR=[Data
1],[Data 2](BCC) 

Read / Geometry Calculation / Geometry 
Calculation / Max. and Min. Y 

 Yes 611 
616 

%PRP$GWCnnn:LPAIR=[Data
1],Data 2](BCC) 

Read / Checker / Gray Window / OK Judge. 
Max. and Min. 

 Yes 611 
613 

%PRP$LICnnn:DPAIR=[Data 
1],[Data 2](BCC) 

Read / Checker / Line / Max. and Min. No. of 
Pixels 

 Yes 611 
613 

%PRP$LICnnn:LPAIR=[Data 
1],[ Data 2](BCC) 

Read / Checker / Line / Max. and Min. No. of 
Objects 

 Yes 611 
613 

%PRP$MRKcg_CXY=[Data1], 
[Data2](BCC) 
 c: Camera No.(0-1) 
 g: Marker No.(0-7) 

Read / Marker / Central Coordinate set  Yes 611 
617 

%PRP$SECnnn:CPAIR=[Data 
1],[ Data 2](BCC) 

Read / Checker / Smart Edge(Circle) / Max. 
and Min. Circularity 

 Yes 611 
615 

%PRP$SECnnn:LPAIR=[Data 
1],[ Data 2](BCC) 

Read / Checker / Smart Edge(Circle) / Max. 
and Min. Measurement 

 Yes 611 
615 

%PRP$SECnnn:SPAIR=[ Data 
1],[ Data 2](BCC) 

Read / Checker / Smart Edge(Circle) / Max. 
and Min. Standard Deviation 

 Yes 611 
615 

%PRP$SELnnn:LIPAIR=[ Data 
1],[ Data 2](BCC) 

Read / Checker / Smart Edge(Line) / Max. 
and Min. Linearity 

 Yes 611 
615 

%PRP$SELnnn:LPAIR=[ Data 
1],[ Data 2](BCC) 

Read / Checker / Smart Edge(Line) / Max. 
and Min. Measurement 

 Yes 611 
615 

%PRP$SELnnn:SPAIR=[ Data 
1],[ Data 2](BCC) 

Read / Checker / Smart Edge(Line) / Max. 
and Min. Standard Deviation 

 Yes 611 
615 

%PS!20035 Print Screen / Error  Yes 605 
%PS!26536 Print Screen / Error  Yes 605 
%PS$02 Print Screen  Yes 605 
%PS26 Print Screen Yes  605 
%PW BECnnn:MAX=[ Data] 
(BCC) 

Write / Checker / Binary Edge / OK Judge. 
Max. 

Yes  612 
613 

%PW BECnnn:MIN=[ Data] 
(BCC) 

Write / Checker / Binary Edge / OK Judge. 
Min. 

Yes  612 
613 

%PW BLVc:H?=[Data ](BCC) 
c: Camera No.(0-1) 
?: Slice Level Group(A-P) 

Write / Slice Level / Max. Value Yes  612 
616 

%PW BLVc:L?=[Data](BCC) 
c: Camera No.(0-1) 
?: Slice Level Group(A-P) 

Write / Slice Level / Min. Value Yes  612 
616 

%PW BLV:H?=[Data ](BCC) 
?: Slice Level Group(A-P) 

Write / Slice Level / Max. Value Yes  612 
616 

%PW BLV:L?=[Data](BCC) 
?: Slice Level Group(A-P) 

Write / Slice Level / Min. Value Yes  612 
616 

%PW BWCnnn:MAX=[Data] 
(BCC) 

Write / Checker / Binary Window / OK 
Judge. Max. 

Yes  612 
613 

%PW BWCnnn:MIN=[Data] 
(BCC) 

Write / Checker / Binary Window / OK 
Judge. Min. 

Yes  612 
613 

%PW CACnnn:MAX=[Data] 
(BCC) 

Write / Numerical Calculation / Judge. Max. Yes  612 
616 

%PW CACnnn:MIN=[Data] 
(BCC) 

Write / Numerical Calculation / Judge. Min. Yes  612 
616 

%PW CBWnnn:CMAX=[Data] 
(BCC) 

Write / Checker / Connector(Binary Window) 
/ Common Judge. Max. 

Yes  612 
614 

%PW 
CBWnnn:CMIN=[Data](BCC) 

Write / Checker / Connector(Binary Window) 
/ Common Judge. Min. 

Yes  612 
614 

%PW CBWnnn:MAX.ss=[Data] 
(BCC) 
 ss: Cell No.(00-99) 

Write / Checker / Connector(Binary Window) 
/ Individual Judge. Max. 

Yes  612 
614 
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%PW CBWnnn:MIN.ss=[Data] 
(BCC) 
 ss: Cell No.(00-99) 

Write / Checker / Connector(Binary Window) 
/ Individual Judge. Min. 

Yes  612 
614 

%PW CGEnnn:PMAX=[Data] 
(BCC) 

Write / Checker / Connector(Gray Edge) / 
Max. Pitch Judge. 

Yes  612 
614 

%PW CGEnnn:PMIN=[Data] 
(BCC) 

Write / Checker / Connector(Gray Edge) / 
Min. Pitch Judge. 

Yes  612 
614 

%PW CGEnnn:UMAX=[Data] 
(BCC) 

Write / Checker / Connector(Gray Edge) / 
Max. Distance Difference Judge. 

Yes  612 
614 

%PW CGEnnn:UMIN=[Data] 
(BCC) 

Write / Checker / Connector(Gray Edge) / 
Min. Distance Difference Judge. 

Yes  612 
614 

%PW CGWnnn:CMAX=[Data] 
(BCC) 

Write/ Checker / Connector(Gray Window) / 
Common Judge. Max. 

Yes  612 
614 

%PW CGWnnn:CMIN=[Data] 
(BCC) 

Write/ Checker / Connector(Gray Window) / 
Common Judge. Min. 

Yes  612 
614 

%PW CGWnnn:MAX.ss= 
[Data](BCC) 
 ss: Cell No.(00-99) 

Write/ Checker / Connector(Gray Window) / 
Common Judge. Max. 

Yes  612 
614 

%PW CGWnnn:MIN.ss=[Data] 
(BCC) 
 ss: Cell No.(00-99) 

Write/ Checker / Connector(Gray Window) / 
Individual Judge. Max. 

Yes  612 
614 

%PW CWCnnn:BAMAX= 
[Data](BCC) 

Write / Checker / Color Window / B Gray 
Ave. Max. 

Yes  612 
615 

%PW CWCnnn:BAMIN=[Data] 
(BCC) 

Write / Checker / Color Window / B Gray 
Ave. Min. 

Yes  612 
615 

%PW CWCnnn:BMAX=[Data] 
(BCC) 

Write / Checker / Color Window / B Gray 
Max. 

Yes  612 
615 

%PW CWCnnn:BMIN=[ Data] 
(BCC) 

Write / Checker / Color Window / B Gray 
Min. 

Yes  612 
615 

%PW CWCnnn:BSMAX= 
[Data](BCC) 

Write / Checker / Color Window / B Gray 
Standard Deviation Max. 

Yes  612 
615 

%PW CWCnnn:BSMIN=[Data] 
(BCC) 

Write / Checker / Color Window / B Gray 
Standard Deviation Min 

Yes  612 
615 

%PW CWCnnn:GAMAX= 
[Data](BCC) 

Write / Checker / Color Window / G Gray 
Ave. Max. 

Yes  612 
615 

%PW CWCnnn:GAMIN=[Data
タ](BCC) 

Write / Checker / Color Window / G Gray 
Ave. Min. 

Yes  612 
615 

%PW CWCnnn:GMAX=[Data] 
(BCC) 

Write / Checker / Color Window / G Gray 
Max. 

Yes  612 
615 

%PW CWCnnn:GMIN=[Data] 
(BCC) 

Write / Checker / Color Window / G Gray 
Min. 

Yes  612 
615 

%PW CWCnnn:GSMAX= 
[Data](BCC) 

Write / Checker / Color Window / G Gray 
Standard Deviation Max. 

Yes  612 
615 

%PW CWCnnn:GSMIN=[Data] 
(BCC) 

Write / Checker / Color Window / G Gray 
Standard Deviation Min. 

Yes  612 
615 

%PW CWCnnn:RAMAX= 
[Data](BCC) 

Write / Checker / Color Window / R Gray 
Ave. Max. 

Yes  612 
615 

%PW CWCnnn:RAMIN=[Data] 
(BCC) 

Write / Checker / Color Window / R Gray 
Ave. Min. 

Yes  612 
615 

%PW CWCnnn:RMAX=[Data] 
(BCC) 

Write / Checker / Color Window / R Gray 
Max. 

Yes  612 
615 

%PW CWCnnn:RMIN=[Data] 
(BCC) 

Write / Checker / Color Window / R Gray 
Min. 

Yes  612 
615 

%PW CWCnnn:RSMAX= 
[Data](BCC) 

Write / Checker / Color Window / R Gray 
Standard Deviation Max. 

Yes  612 
615 

%PW CWCnnn:RSMIN=[Data] 
(BCC) 

Write / Checker / Color Window / R Gray 
Standard Deviation Min. 

Yes  612 
615 

%PW FECnnn:MAX=[Data] 
(BCC) 

Write / Checker / Feature Extraction / OK 
Judge. Max. 

Yes  612 
614 

%PW FECnnn:MIN=[Data] 
(BCC) 

Write / Checker / Feature Extraction / OK 
Judge. Min. 

Yes  612 
614 
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%PW FWCnnn:MAX=[Data] 
(BCC) 

Write / Checker / Flaw Detection / OK 
Judge. Max. 

Yes  612 
614 

%PW FWCnnn:MIN=[Data] 
(BCC) 

Write / Checker / Flaw Detection / OK 
Judge. Min. 

Yes  612 
614 

%PW GECnnn:LVN=[Data] 
(BCC) 

Write / Checker / Gray Edge / Edge 
Threshold 

Yes  612 
613 

%PW GECnnn:MAX=[Data] 
(BCC) 

Write / Checker / Gray Edge / OK Judge. 
Max. 

Yes  612 
613 

%PW GECnnn:MIN=[Data] 
(BCC) 

Write / Checker / Gray Edge / OK Judge. 
Min. 

Yes  612 
613 

%PW GGCnnn:AMAX=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. Angle 

Yes  612 
616 

%PW GGCnnn:AMIN=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Min. Angle 

Yes  612 
616 

%PW GGCnnn:CAMAX= 
[Data](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. Intersect. Angle 

Yes  612 
616 

%PW GGCnnn:CAMIN=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Min. Intersect. Angle 

Yes  612 
616 

%PW GGCnnn:DMAX=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. Distance 

Yes  612 
616 

%PW GGCnnn:DMIN=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Min. Distance 

Yes  612 
616 

%PW GGCnnn:LAMAX=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. Major Axis 

Yes  612 
616 

%PW GGCnnn:LAMIN=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Min.. Major Axis 

Yes  612 
616 

%PW GGCnnn:RMAX=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. Radius 

Yes  612 
616 

%PW GGCnnn:RMIN=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Min. Radius 

Yes  612 
616 

%PW GGCnnn:SAMAX= 
[Data](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. Minor Axis 

Yes  612 
616 

%PW GGCnnn:SAMIN=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Min. Minor Axis 

Yes  612 
616 

%PW GGCnnn:SMAX=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. Standard Deviation 

Yes  612 
616 

%PW GGCnnn:SMIN=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Min. Standard Deviation 

Yes  612 
616 

%PW GGCnnn:XMAX=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. X 

Yes  612 
616 

%PW GGCnnn:XMIN=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Min. X 

Yes  612 
616 

%PW GGCnnn:YMAX=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. Y 

Yes  612 
616 

%PW GGCnnn:YMIN=[Data] 
(BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Min. Y 

Yes  612 
616 

%PW GWCnnn:MAX=[Data] 
(BCC) 

Write / Checker / Gray Window / OK Judge. 
Max. 

Yes  612 
613 

%PW GWCnnn:MIN=[Data] 
(BCC) 

Write / Checker / Gray Window / OK Judge. 
Min. 

Yes  612 
613 

%PW LICnnn:DMAX=[Data] 
(BCC) 

Write / Checker / Line / Max. No. of Pixels Yes  612 
613 

%PW LICnnn:DMIN=[Data] 
(BCC) 

Write / Checker / Line / Min. No. of Pixels Yes  612 
613 

%PW LICnnn:LMAX=[Data] 
(BCC) 

Write / Checker / Line / Max. No. of Objects Yes  612 
613 

%PW LICnnn:LMIN=[Data] 
(BCC) 

Write / Checker / Line / Min. No. of Objects Yes  612 
613 

%PW SECnnn:CMAX=[Data] 
(BCC) 

Write / Checker / Smart Edge(Circle) / Max. 
Circularity 

Yes  612 
615 
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%PW SECnnn:CMIN=[Data] 
(BCC) 

Write / Checker / Smart Edge(Circle) / Min. 
Circularity 

Yes  612 
615 

%PW SECnnn:LMAX=[Data] 
(BCC) 

Write / Checker / Smart Edge(Circle) / Max. 
Measurement 

Yes  612 
613 

%PW SECnnn:LMIN=[Data] 
(BCC) 

Write / Checker / Smart Edge(Circle) / Min. 
Measurement 

Yes  612 
613 

%PW SECnnn:NMAX=[Data] 
(BCC) 

Write / Checker / Smart Edge(Circle) / Max. 
Unused Edge Count 

Yes  612 
613 

%PW SECnnn:SMAX=[Data] 
(BCC) 

Write / Checker / Smart Edge(Circle) / Max. 
Standard Deviation 

Yes  612 
613 

%PW SECnnn:SMIN=[Data] 
(BCC) 

Write / Checker / Smart Edge(Circle) / Min. 
Standard Deviation 

Yes  612 
613 

%PW SELnnn:LIMAX=[Data] 
(BCC) 

Write / Checker / Smart Edge(Line) / Max. 
Linearity 

Yes  612 
615 

%PW SELnnn:LIMIN=[Data] 
(BCC) 

Write / Checker / Smart Edge(Line) / Min. 
Linearity 

Yes  612 
615 

%PW SELnnn:LMAX=[Data] 
(BCC) 

Write / Checker / Smart Edge(Line) / Max. 
Measurement 

Yes  612 
615 

%PW SELnnn:LMIN=[Data] 
(BCC) 

Write / Checker / Smart Edge(Line) / Min. 
Measurement 

Yes  612 
615 

%PW SELnnn:NMAX=[Data] 
(BCC) 

Write / Checker / Smart Edge(Line) / Max. 
Unused Edge Count 

Yes  612 
615 

%PW SELnnn:SMAX=[Data] 
(BCC) 

Write / Checker / Smart Edge(Line) / Max. 
Standard Deviation 

Yes  612 
615 

%PW SELnnn:SMIN=[Data] 
(BCC) 

Write / Checker / Smart Edge(Line) / Min. 
Standard Deviation 

Yes  612 
615 

%PW SMCnnn:CNT.?=[Data] 
(BCC) 
 ?: Sequence Step(1-6) 

Write / Checker / Smart Matching / Search 
Count 

Yes  612 
614 

%PW SMCnnn:DCNTMAX= 
[Data](BCC) 

Write / Checker / Smart Matching / Max. OK 
No. of Subtracted Objects 

Yes  612 
614 

%PW SYS:REG?=[Data] 
(BCC) 
 ?: General Register No.(0-7) 

Write / System value / General registers 0-7 Yes  612 
613 

%PW SYS_DATE=[Data] 
(BCC) 

Write / System value / Current Date Yes  612 
613 

%PW SYS_TIME=[Data] 
(BCC) 

Write / System value / Current Time Yes  612 
613 

%PW!20031 Write / Error  Yes 612 
%PW!25135 Write / Error  Yes 612 
%PW!25236 Write / Error  Yes 612 
%PW!25430 Write / Error  Yes 612 
%PW$BECnnn:MAX(BCC) Write / Checker / Binary Edge / OK Judge. 

Max. 
 Yes 612 

613 
%PW$BECnnn:MIN(BCC) Write / Checker / Binary Edge / OK Judge. 

Min. 
 Yes 612 

613 
%PW$BLVc:H?(BCC) 
c: Camera No.(0-1) 
?: Slice Level Group (A-P) 

Write / Slice Level / Max. Value  Yes 612 
616 

%PW$BLVc:L?(BCC) 
c: Camera No.(0-1) 
?: Slice Level Group (A-P) 

Write / Slice Level / Min. Value  Yes 612 
616 

%PW$BLV:H?(BCC) 
?: Slice Level Group (A-P) 

Write / Slice Level / Max. Value  Yes 612 
616 

%PW$BLV:L?(BCC) 
?: Slice Level Group (A-P) 

Write / Slice Level / Min. Value  Yes 612 
616 

%PW$BWCnnn:MAX(BCC) Write / Checker / Binary Window / OK 
Judge. Max. 

 Yes 612 
613 

%PW$BWCnnn:MIN(BCC) Write / Checker / Binary Window / OK 
Judge. Min. 

 Yes 612 
613 
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%PW$CACnnn:MAX(BCC) Write / Numerical Calculation / Judge. Max.  Yes 612 
616 

%PW$CACnnn:MIN(BCC) Write / Numerical Calculation / Judge. Min.  Yes 612 
616 

%PW$CBWnnn:CMAX(BCC) Write / Checker / Connector(Binary Window) 
/ Common Judge. Max. 

 Yes 612 
614 

%PW$CBWnnn:CMIN(BCC) Write / Checker / Connector(Binary Window) 
/ Common Judge. Min. 

 Yes 612 
614 

%PW$CBWnnn:MAX.ss(BCC) 
ss: Cell No.(00-99) 

Write / Checker / Connector(Binary Window) 
/ Individual Judge. Max. 

 Yes 612 
614 

%PW$CBWnnn:MIN.ss(BCC) 
ss: Cell No.(00-99) 

Write / Checker / Connector(Binary Window) 
/ Individual Judge. Min. 

 Yes 612 
614 

%PW$CGEnnn:PMAX(BCC) Write / Checker / Connector(Gray Edge) / 
Max. Pitch Judge. 

 Yes 612 
614 

%PW$CGEnnn:PMIN(BCC) Write / Checker / Connector(Gray Edge) / 
Min. Pitch Judge. 

 Yes 612 
614 

%PW$CGEnnn:UMAX(BCC) Write / Checker / Connector(Gray Edge) / 
Max. Distance Difference Judge. 

 Yes 612 
614 

%PW$CGEnnn:UMIN(BCC) Write / Checker / Connector(Gray Edge) / 
Min. Distance Difference Judge. 

 Yes 612 
614 

%PW$CGWnnn:CMAX(BCC) Write/ Checker / Connector(Gray Window) / 
Max. Common Judge. 

 Yes 612 
614 

%PW$CGWnnn:CMIN(BCC) Write/ Checker / Connector(Gray Window) / 
Common Judge. Min. 

 Yes 612 
614 

%PW$CGWnnn:MAX.ss(BCC) 
ss: Cell No.(00-99) 

Write/ Checker / Connector(Gray Window) / 
Common Judge. Max. 

 Yes 612 
614 

%PW$CGWnnn:MIN.ss(BCC) 
ss: Cell No.(00-99) 

Write/ Checker / Connector(Gray Window) / 
Individual Judge. Max. 

 Yes 612 
614 

%PW$CWCnnn:BAMAX(BCC) Write / Checker / Color Window / B Gray 
Ave. Max. 

 Yes 612 
615 

%PW$CWCnnn:BAMIN(BCC) Write / Checker / Color Window / B Gray 
Ave. Min. 

 Yes 612 
615 

%PW$CWCnnn:BMAX(BCC) Write / Checker / Color Window / B Gray 
Max. 

 Yes 612 
615 

%PW$CWCnnn:BMIN(BCC) Write / Checker / Color Window / B Gray 
Min. 

 Yes 612 
615 

%PW$CWCnnn:BSMAX(BCC) Write / Checker / Color Window / B Gray 
Standard Deviation Max. 

 Yes 612 
615 

%PW$CWCnnn:BSMIN(BCC) Write / Checker / Color Window / B Gray 
Standard Deviation Min 

 Yes 612 
615 

%PW$CWCnnn:GAMAX(BCC) Write / Checker / Color Window / G Gray 
Ave. Max. 

 Yes 612 
615 

%PW$CWCnnn:GAMIN(BCC) Write / Checker / Color Window / G Gray 
Ave. Min. 

 Yes 612 
615 

%PW$CWCnnn:GMAX(BCC) Write / Checker / Color Window / G Gray 
Max. 

 Yes 612 
615 

%PW$CWCnnn:GMIN(BCC) Write / Checker / Color Window / G Gray 
Min. 

 Yes 612 
615 

%PW$CWCnnn:GSMAX(BCC) Write / Checker / Color Window / G Gray 
Standard Deviation Max. 

 Yes 612 
615 

%PW$CWCnnn:GSMIN(BCC) Write / Checker / Color Window / G Gray 
Standard Deviation Min. 

 Yes 612 
615 

%PW$CWCnnn:RAMAX(BCC) Write / Checker / Color Window / R Gray 
Ave. Max. 

 Yes 612 
615 

%PW$CWCnnn:RAMIN(BCC) Write / Checker / Color Window / R Gray 
Ave. Min. 

 Yes 612 
615 

%PW$CWCnnn:RMAX(BCC) Write / Checker / Color Window / R Gray 
Max. 

 Yes 612 
615 

%PW$CWCnnn:RMIN(BCC) Write / Checker / Color Window / R Gray 
Min. 

 Yes 612 
615 
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%PW$CWCnnn:RSMAX(BCC) Write / Checker / Color Window / R Gray 
Standard Deviation Max. 

 Yes 612 
615 

%PW$CWCnnn:RSMIN(BCC) Write / Checker / Color Window / R Gray 
Standard Deviation Min. 

 Yes 612 
615 

%PW$FECnnn:MAX(BCC) Write / Checker / Feature Extraction / OK 
Judge. Max. 

 Yes 612 
614 

%PW$FECnnn:MIN(BCC) Write / Checker / Feature Extraction / OK 
Judge. Min. 

 Yes 612 
614 

%PW$FWCnnn:MAX(BCC) Write / Checker / Flaw Detection / OK 
Judge. Max. 

 Yes 612 
614 

%PW$FWCnnn:MIN(BCC) Write / Checker / Flaw Detection / OK 
Judge. Min. 

 Yes 612 
614 

%PW$GECnnn:LVN(BCC) Write / Checker / Gray Edge / Edge 
Threshold 

 Yes 612 
613 

%PW$GECnnn:MAX(BCC) Write / Checker / Gray Edge / OK Judge. 
Max. 

 Yes 612 
613 

%PW$GECnnn:MIN(BCC) Write / Checker / Gray Edge / OK Judge. 
Min. 

 Yes 612 
613 

%PW$GGCnnn:AMAX(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. Angle 

 Yes 612 
616 

%PW$GGCnnn:AMIN(BCC) Write / Geometry Calculation / Geometry 
Calculation / Min. Angle 

 Yes 612 
616 

%PW$GGCnnn:CAMAX(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. Intersect. Angle 

 Yes 612 
616 

%PW$GGCnnn:CAMIN(BCC) Write / Geometry Calculation / Geometry 
Calculation / Min. Intersect. Angle 

 Yes 612 
616 

%PW$GGCnnn:DMAX(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. Distance 

 Yes 612 
616 

%PW$GGCnnn:DMIN(BCC) Write / Geometry Calculation / Geometry 
Calculation / Min. Distance 

 Yes 612 
616 

%PW$GGCnnn:LAMAX(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. Major Axis 

 Yes 612 
616 

%PW$GGCnnn:LAMIN(BCC) Write / Geometry Calculation / Geometry 
Calculation / Min.. Major Axis 

 Yes 612 
616 

%PW$GGCnnn:RMAX(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. Radius 

 Yes 612 
616 

%PW$GGCnnn:RMIN(BCC) Write / Geometry Calculation / Geometry 
Calculation / Min. Radius 

 Yes 612 
616 

%PW$GGCnnn:SAMAX(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. Minor Axis 

 Yes 612 
616 

%PW$GGCnnn:SAMIN(BCC) Write / Geometry Calculation / Geometry 
Calculation / Min. Minor Axis 

 Yes 612 
616 

%PW$GGCnnn:SMAX(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. Standard Deviation 

 Yes 612 
616 

%PW$GGCnnn:SMIN(BCC) Write / Geometry Calculation / Geometry 
Calculation / Min. Standard Deviation 

 Yes 612 
616 

%PW$GGCnnn:XMAX(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. X 

 Yes 612 
616 

%PW$GGCnnn:XMIN(BCC) Write / Geometry Calculation / Geometry 
Calculation / Min. X 

 Yes 612 
616 

%PW$GGCnnn:YMAX(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. Y 

 Yes 612 
616 

%PW$GGCnnn:YMIN(BCC) Write / Geometry Calculation / Geometry 
Calculation / Min. Y 

 Yes 612 
616 

%PW$GWCnnn:MAX(BCC) Write / Checker / Gray Window / OK Judge. 
Max. 

 Yes 612 
613 

%PW$GWCnnn:MIN(BCC) Write / Checker / Gray Window / OK Judge. 
Min. 

 Yes 612 
613 

%PW$LICnnn:DMAX(BCC) Write / Checker / Line / Max. No. of Pixels  Yes 612 
613 
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%PW$LICnnn:DMIN(BCC) Write / Checker / Line / Min. No. of Pixels  Yes 612 
613 

%PW$LICnnn:LMAX(BCC) Write / Checker / Line / Max. No. of Objects  Yes 612 
613 

%PW$LICnnn:LMIN(BCC) Write / Checker / Line / Min. No. of Objects  Yes 612 
613 

%PW$SECnnn:CMAX(BCC) Write / Checker / Smart Edge(Circle) / Max. 
Circularity 

 Yes 612 
615 

%PW$SECnnn:CMIN(BCC) Write / Checker / Smart Edge(Circle) / Min. 
Circularity 

 Yes 612 
615 

%PW$SECnnn:LMAX(BCC) Write / Checker / Smart Edge(Circle) / Max. 
Measurement 

 Yes 612 
613 

%PW$SECnnn:LMIN(BCC) Write / Checker / Smart Edge(Circle) / Min. 
Measurement 

 Yes 612 
613 

%PW$SECnnn:NMAX(BCC) Write / Checker / Smart Edge(Circle) / Max. 
Unused Edge Count 

  612 
613 

%PW$SECnnn:SMAX(BCC) Write / Checker / Smart Edge(Circle) / Max. 
Standard Deviation 

 Yes 612 
613 

%PW$SECnnn:SMIN(BCC) Write / Checker / Smart Edge(Circle) / Min. 
Standard Deviation 

 Yes 612 
613 

%PW$SELnnn:LIMAX(BCC) Write / Checker / Smart Edge(Line) / Max. 
Linearity 

 Yes 612 
615 

%PW$SELnnn:LIMIN(BCC) Write / Checker / Smart Edge(Line) / Min. 
Linearity 

 Yes 612 
615 

%PW$SELnnn:LMAX(BCC) Write / Checker / Smart Edge(Line) / Max. 
Measurement 

 Yes 612 
615 

%PW$SELnnn:LMIN(BCC) Write / Checker / Smart Edge(Line) / Min. 
Measurement 

 Yes 612 
615 

%PW$SELnnn:NMAX(BCC) Write / Checker / Smart Edge(Line) / Max. 
Unused Edge Count 

 Yes 612 
615 

%PW$SELnnn:SMAX(BCC) Write / Checker / Smart Edge(Line) / Max. 
Standard Deviation 

 Yes 612 
615 

%PW$SELnnn:SMIN(BCC) Write / Checker / Smart Edge(Line) / Min. 
Standard Deviation 

 Yes 612 
615 

%PW$SMCnnn:CNT.?(BCC) 
?: Sequence Step(1-6) 

Write / Checker / Smart Matching / Search 
Count 

 Yes 612 
614 

%PW$SMCnnn:DCNTMAX 
(BCC) 

Write / Checker / Smart Matching / Max. OK 
No. of Subtracted Objects 

 Yes 612 
614 

%PW$SYS:REG?(BCC) 
?: General Register No.(0-7) 

Write / System value / General registers 0-7  Yes 612 
613 

%PW$SYS_DATE14 Write / System value / Current Date  Yes 612 
613 

%PW$SYS_TIME15 Write / System value / Current Time  Yes 612 
613 

%PWP BECnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Binary Edge / OK Judge. 
Max. and Min. 

Yes  612 
613 

%PWP BLVc:PAIR?=[Data1], 
[Data2](BCC) 
 c: Camera No.(0-1) 
 ?: Slice Level Group(A-P) 

Write / Slice Level / Max. and Min. Yes  612 
616 

%PWP BLV:PAIR?=[Data1], 
[Data2](BCC) 
 ?: Slice Level Group(A-P) 

Write / Slice Level / Max. and Min. Yes  612 
616 

%PWP BWCnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Binary Window / OK 
Judge. Max. and Min. 

Yes  612 
613 

%PWP CACnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Numerical Calculation / Max. and 
Min. 

Yes  612 
616 

%PWP CBWnnn:CPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Connector(Binary Window) 
/ Common Judge. Max. and Min. 

Yes  612 
614 
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%PWP CBWnnn:LPAIR.ss= 
[Data1],[Data2](BCC) 
 ss: Cell No.(00-99) 

Write / Checker / Connector(Binary Window) 
/ Individual Judge. Max. and Min. 

Yes  612 
614 

%PWP CGEnnn:PPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Connector(Gray Edge) / 
Min. and Min. Pitch Judge. 

Yes  612 
614 

%PWP CGEnnn:UPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Connector(Gray Edge) / 
Max. and Min. Distance Difference Judge. 

Yes  612 
614 

%PWP CGWnnn:CPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Connector(Gray Window) / 
Common Judge. Max. and Min. 

Yes  612 
614 

%PWP CGWnnn:LPAIR.ss= 
[Data1],[Data2](BCC) 
 ss: Cell No.(00-99) 

Write / Checker / Connector(Gray Window) / 
Individual Judge. Max. and Min. 

Yes  612 
614 

%PWP CWCnnn:BAPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Color Window / B Gray 
Ave. Max. and Min. 

Yes  612 
615 

%PWP CWCnnn:BPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Color Window / B Gray 
Max. and Min. 

Yes  612 
615 

%PWP CWCnnn:BSPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Color Window / B Gray 
Standard Deviation Max. and Min. 

Yes  612 
615 

%PWP CWCnnn:GAPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Color Window / G Gray 
Ave. Max. and Min. 

Yes  612 
615 

%PWP CWCnnn:GPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Color Window / G Gray 
Max. and Min. 

Yes  612 
615 

%PWP CWCnnn:GSPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Color Window / G Gray 
Standard Deviation Max. and Min. 

Yes  612 
615 

%PWP CWCnnn:RAPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Color Window / R Gray 
Ave. Max. and Min. 

Yes  612 
615 

%PWP CWCnnn:RPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Color Window / R Gray 
Max. and Min. 

Yes  612 
615 

%PWP CWCnnn:RSPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Color Window / R Gray 
Standard Deviation Max. and Min. 

Yes  612 
615 

%PWP FECnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Feature Extraction / OK 
Judge. Max. and Min. 

Yes  612 
614 

%PWP FWCnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Flaw Detection / OK 
Judge. Max. and Min. 

Yes  612 
614 

%PWP GECnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Gray Edge / OK Judge. 
Max. and Min. 

Yes  612 
613 

%PWP GGCnnn:APAIR= 
[Data1],[Data2](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Angle 

Yes  612 
616 

%PWP GGCnnn:CAPAIR= 
[Data1],[Data2](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Intersect. Angle 

Yes  612 
616 

%PWP GGCnnn:DPAIR= 
[Data1],[Data2](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Distance 

Yes  612 
616 

%PWP GGCnnn:LAPAIR= 
[Data1],[Data2](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Major Axis 

Yes  612 
616 

%PWP GGCnnn:RPAIR= 
[Data1],[Data2](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min.Radius 

Yes  612 
616 

%PWP GGCnnn:SAPAIR= 
[Data1],[Data2](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Minor Axis 

Yes  612 
616 

%PWP GGCnnn:SPAIR= 
[Data1],[Data2](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Standard 
Deviation 

Yes  612 
616 

%PWP GGCnnn:XPAIR= 
[Data1],[Data2](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. X 

Yes  612 
616 

%PWP GGCnnn:YPAIR= 
[Data1],[Data2](BCC) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Y 

Yes  612 
616 

%PWP GWCnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Gray Window / OK Judge. 
Max. and Min. 

Yes  612 
613 

%PWP LICnnn:DPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Line / Max. and Min. No. of 
Pixels 

Yes  612 
613 

%PWP LICnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Line / Max. and Min. No. of 
Objects 

Yes  612 
613 
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%PWP 
MRKcg_MOVE=[Data1] 
[Data2](BCC) 
 c: Camera No.(0-1) 
 g: Marker No.(0-7) 

Write / Marker / Central Coordinate Moving 
Distance Set 

Yes  612 
617 

%PWP SECnnn:CPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Smart Edge(Circle) / Max. 
and Min. Circularity 

Yes  612 
613 

%PWP SECnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Smart Edge(Circle) / Max. 
and Min. Measurement 

Yes  612 
613 

%PWP SECnnn:SPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Smart Edge(Circle) / Max. 
and Min. Standard Deviation 

Yes  612 
613 

%PWP SELnnn:LIPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Smart Edge(Line) / Max. 
and Min. Linearity 

Yes  612 
613 

%PWP SELnnn:LPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Smart Edge(Line) / Max. 
and Min. Measurement 

Yes  612 
613 

%PWP SELnnn:SPAIR= 
[Data1],[Data2](BCC) 

Write / Checker / Smart Edge(Line) / Max. 
and Min. Standard Deviation 

Yes  612 
615 

%PWP!20061 Write / Error  Yes 612 
%PWP!25165 Write / Error  Yes 612 
%PWP!25266 Write / Error  Yes 612 
%PWP!25460 Write / Error  Yes 612 
%PWP$BECnnn:LPAIR(BCC) Write / Checker / Binary Edge / OK Judge. 

Max. and Min. 
 Yes 612 

613 
%PWP$BLVc:PAIR?(BCC) 
c: Camera No.(0-1) 
?: Slice Level Group(A-P) 

Write / Slice Level / Max. and Min.  Yes 612 
616 

%PWP$BLV:PAIR?(BCC) 
?: Slice Level Group(A-P) 

Write / Slice Level / Max. and Min.  Yes 612 
616 

%PWP$BWCnnn:LPAIR(BCC) Write / Checker / Binary Window / OK 
Judge. Max. and Min. 

 Yes 612 
613 

%PWP$CACnnn:LPAIR(BCC) Write / Numerical Calculation / Max. and 
Min. 

 Yes 612 
616 

%PWP$CBWnnn:CPAIR(BCC) Write / Checker / Connector(Binary Window) 
/ Common Judge. Max. and Min. 

 Yes 612 
614 

%PWP$CBWnnn:LPAIR.ss(B
CC) 
 ss: Cell No.(00-99) 

Write / Checker / Connector(Binary Window) 
/ Individual Judge. Max. and Min. 

 Yes 612 
614 

%PWP$CGEnnn:PPAIR(BCC) Write / Checker / Connector(Gray Edge) / 
Min. and Min. Pitch Judge. 

 Yes 612 
614 

%PWP$CGEnnn:UPAIR(BCC) Write / Checker / Connector(Gray Edge) / 
Max. and Min. Distance Difference Judge. 

 Yes 612 
614 

%PWP$CGWnnn:CPAIR 
(BCC) 

Write / Checker / Connector(Gray Window) / 
Common Judge. Max. and Min. 

 Yes 612 
614 

%PWP$CGWnnn:LPAIR.ss(B
CC) 
 ss: Cell No.(00-99) 

Write / Checker / Connector(Gray Window) / 
Individual Judge. Max. and Min. 

 Yes 612 
614 

%PWP$CWCnnn:BAPAIR(BC
C) 

Write / Checker / Color Window / B Gray 
Ave. Max. and Min. 

 Yes 612 
615 

%PWP$CWCnnn:BPAIR(BCC) Write / Checker / Color Window / B Gray 
Max. and Min. 

 Yes 612 
615 

%PWP$CWCnnn:BSPAIR(BC
C) 

Write / Checker / Color Window / B Gray 
Standard Deviation Max. and Min. 

 Yes 612 
615 

%PWP$CWCnnn:GAPAIR(BC
C) 

Write / Checker / Color Window / G Gray 
Ave. Max. and Min. 

 Yes 612 
615 

%PWP$CWCnnn:GPAIR 
(BCC) 

Write / Checker / Color Window / G Gray 
Max. and Min. 

 Yes 612 
615 

%PWP$CWCnnn:GSPAIR(BC
C) 

Write / Checker / Color Window / G Gray 
Standard Deviation Max. and Min. 

 Yes 612 
615 

%PWP$CWCnnn:RAPAIR(BC
C) 

Write / Checker / Color Window / R Gray 
Ave. Max. and Min. 

 Yes 612 
615 
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%PWP$CWCnnn:RPAIR 
(BCC) 

Write / Checker / Color Window / R Gray 
Max. and Min. 

 Yes 612 
615 

%PWP$CWCnnn:RSPAIR(BC
C) 

Write / Checker / Color Window / R Gray 
Standard Deviation Max. and Min. 

 Yes 612 
615 

%PWP$FECnnn:LPAIR(BCC) Write / Checker / Feature Extraction / OK 
Judge. Max. and Min. 

 Yes 612 
614 

%PWP$FWCnnn:LPAIR(BCC) Write / Checker / Flaw Detection / OK 
Judge. Max. and Min. 

 Yes 612 
614 

%PWP$GECnnn:LPAIR(BCC) Write / Checker / Gray Edge / OK Judge. 
Max. and Min. 

 Yes 612 
613 

%PWP$GGCnnn:APAIR(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Angle 

 Yes 612 
616 

%PWP$GGCnnn:CAPAIR(BC
C) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Intersect. Angle 

 Yes 612 
616 

%PWP$GGCnnn:DPAIR(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Distance 

 Yes 612 
616 

%PWP$GGCnnn:LAPAIR(BC
C) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Major Axis 

 Yes 612 
616 

%PWP$GGCnnn:RPAIR(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. and Min.Radius 

 Yes 612 
616 

%PWP$GGCnnn:SAPAIR(BC
C) 

Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Minor Axis 

 Yes 612 
616 

%PWP$GGCnnn:SPAIR(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Standard 
Deviation 

 Yes 612 
616 

%PWP$GGCnnn:XPAIR(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. X 

 Yes 612 
616 

%PWP$GGCnnn:YPAIR(BCC) Write / Geometry Calculation / Geometry 
Calculation / Max. and Min. Y 

 Yes 612 
616 

%PWP$GWCnnn:LPAIR(BCC) Write / Checker / Gray Window / OK Judge. 
Max. and Min. 

 Yes 612 
613 

%PWP$LICnnn:DPAIR(BCC) Write / Checker / Line / Max. and Min. No. of 
Pixels 

 Yes 612 
613 

%PWP$LICnnn:LPAIR(BCC) Write / Checker / Line / Max. and Min. No. of 
Objects 

 Yes 612 
613 

%PWP$MRKcg_MOVE(BCC) 
 c: Camera No.(0-1) 
 g: Marker No.(0-7) 

Write / Marker / Central Coordinate 
Moving Distance Set 

 Yes 612 
617 

%PWP$SECnnn:CPAIR(BCC) Write / Checker / Smart Edge(Circle) / Max. 
and Min. Circularity 

 Yes 612 
613 

%PWP$SECnnn:LPAIR(BCC) Write / Checker / Smart Edge(Circle) / Max. 
and Min. Measurement 

 Yes 612 
613 

%PWP$SECnnn:SPAIR(BCC) Write / Checker / Smart Edge(Circle) / Max. 
and Min. Standard Deviation 

 Yes 612 
613 

%PWP$SELnnn:LIPAIR(BCC) Write / Checker / Smart Edge(Line) / Max. 
and Min. Linearity 

 Yes 612 
613 

%PWP$SELnnn:LPAIR(BCC) Write / Checker / Smart Edge(Line) / Max. 
and Min. Measurement 

 Yes 612 
613 

%PWP$SELnnn:SPAIR(BCC) Write / Checker / Smart Edge(Line) / Max. 
and Min. Standard Deviation 

 Yes 612 
613 

%Q!20067 Statistics Data Reset / Error  Yes 605 
%Q$50 Statistics Data Reset  Yes 605 
%Q74 Statistics Data Reset Yes  605 
%R77 Reinspect (Execution Mode is “All” or 

“Automatic Switch”) 
Yes  601 

%R!20064 Reinspect / Error  Yes 601 
%R!20165 Reinspect (Execution Mode is "User 

Defined") / Error 
 Yes 601 

%R!20266 Reinspect / Error  Yes 601 
%R!20367 Reinspect / Error  Yes 601 
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%R!20460 Reinspect / Error  Yes 601 
%R$53 Reinspect  Yes 601 
%R?(BCC) 
?: Execution Block No.(0-9) 

Reinspect (Execution Mode is "User 
Defined") 

Yes  601 

%RM!2402D Switch between Run/Stop / Error  Yes 605 
%RM$?(BCC) 
?：RUN/STOP(0-1) 

Switch between Run/Stop  Yes 605 

%RM?(BCC) 
?：RUN/STOP(0-1) 

Switch between Run/Stop Yes  605 

%S!16060 Inspection Start / Error  Yes 600 
%S!20065 Inspection Start (When using common 

trigger and Execution Mode is "All" or 
"Automatic Switch") / Error 

 Yes 600 

%S!20164 Inspection Start (When using common 
trigger and Execution Mode is "User 
Defined") / Error 

 Yes 600 

%S!20267 Inspection Start / Error  Yes 600 
%S!20366 Inspection Start / Error  Yes 600 
%S$52 Inspection start  Yes 600 
%S?(BCC) 
?: Execution Block No.(0-9) 

Inspection Start (When using common 
trigger and Execution Mode is "User 
Defined") 

Yes  600 

%S76 Inspection Start (When using common 
trigger and Execution Mode is "All" or 
"Automatic Switch") 

Yes  600 

%SR$00 Clearing the Image Memory stored in PV  Yes 604 
%SR24 Clearing the Image Memory stored in PV Yes  604 
%SS!20036 Saving Images stored in the Image Memory 

of PV into a SD memory card / Error 
 Yes 604 

%SS!26030 Saving Images stored in the Image Memory 
of PV into a SD memory card / Error 

 Yes 604 

%SS$01 Saving Images stored in the Image Memory 
of PV into a SD memory card 

 Yes 604 

%SS25 Saving Images stored in the Image Memory 
of PV into a SD memory card 

Yes  604 

%X!2006E Switching Type / error  Yes 602 

%X!2106F Switching Type / error  Yes 602 

%X$59 Switching Type  Yes 602 

%X???(BCC) 
???:Type No.(000-255) 

Switching Type Yes  602 
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A Series Compatible ............................ 437 
Account Limit (Select Menu) ............... 511 
Account Setting ................................... 456 
Accuracy First (Smart Edge Circle) ..... 243 

Accuracy First (Smart Edge Line) ....... 261 
Approximate Circle/Ellipse................... 298 
Approximate Line (Geometry  

Calculation) ...................................... 294 
Approximate Line (Smart Edge  (Circle) )

 ......................................................... 250 

Approximate Line Detect Condition ..... 260 
Area Size Adjustment .......................... 282 
Arithmetical Function ........................... 321 
Arrange layout ..................................... 417 
Arrowhead ................................... 345, 349 
ASSIGN ............................................... 551 

Asynchronous (image-output first) ...... 435 
Asynchronous (inspection first) ........... 435 
Auto Area Setting................................. 286 
Auto Set Area as Mask ........................ 293 
Automatic Switch ................................. 113 

B 

Backup Battery ...................................... 15 
Base 1 Point ........................................ 101 
Base 2 points ....................................... 104 
Base 3 points ....................................... 109 
Base Angle .................................. 244, 261 
Battery ................................................... 15 

BCC ............................................. 595, 599 
Bend Radius .......................................... 31 
Bit width ............................................... 361 
Block check code......................... 595, 599 
Branch condition .................................. 120 
byr ........................................................ 373 

C 

Cable Bend Radius................................ 31 
Calendar adjustment ........................... 455 
Calibration ............................................. 99 

Base 1 Point .................................... 101 

Base 2 points ................................... 104 
Base 3 points ................................... 109 
Global coordinate registration.. 103, 108 
Static and Dynamic operation .......... 101 

Calibration: .......................................... 104 

Camera 
Camera Type ..................................... 16 
Combination....................................... 79 
Image transfer Time ........................... 16 
Number of storable images ............. 367 

Camera gain .......................................... 83 

Camera Gain_Offset........................ 84, 86 
Camera Trigger...................................... 81 
Capture delay ........................................ 91 
Cause of turning on ERROR signal..... 556 
Cell Result (Smart Edge Circle) .......... 238 
Cell Result (Smart Edge Line) ............. 257 

Character alignment and overwrite 
permission ....................................... 388 

Character/Figure Drawing ................... 339 
Checker 

Copy ................................................ 143 
Copying Checker and Using it in 

Another Type ................................ 143 
Delete .............................................. 144 
Draw an area ..................................... 63 

CIR(Command Input Register) ............ 649 
Circle/Feature Rotation ....................... 273 
Circularity ............................................. 235 

Color Extraction ................................... 127 
COM port 

Communication condition ........ 437, 586 
Command Communication Log 

Manual Save .................................... 697 
Command Input Register ............ 632, 635 

Command Output Register .......... 632, 635 
Command Read Type.................. 590, 634 
Command start bit ............... 632, 643, 645 
Comment for Setting Data ................... 430 
Comments in Setting Data................... 383 
Common template ............................... 189 

Common trigger ..................................... 81 
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Communication test ............................. 472 
Communication with PLC 

General Communication .................. 590 

PLC Communication ........................ 590 
Read PLC Communication Command552 

Communication with PVWIN200 ......... 710 
Comparison Function .......................... 323 
Compression ....................................... 373 
Compression Rate of Image Output .... 373 

Compression Rate of Inspection Image 
Output .............................................. 373 

Connecting PV200with PC .................. 708 
Continuous inspection ......................... 432 
Continuous Inspection ......................... 432 
Contour Matching 

Cannot be registered as Template .. 194 
Create Edge .................................... 197 
Edge Extend .................................... 197 
Extract.............................................. 197 
Inspection Edge ............................... 198 
Out-Point Limit ................................. 199 

Shape .............................................. 199 
Contour Matching Performance .......... 202 
Control Register .......................... 632, 634 
Coordinate axis ................................... 100 
Coordinate Conversion Function ......... 324 
Coordinate origin ................................. 100 

Coordinates After Adjustment (Trapezoid 
Adjustment) ....................................... 96 

Coordinates Before Adjustment 
(Trapezoid Adjustment) ..................... 96 

COR(Command Output Register) ....... 649 
Create Edge ........................................ 197 

Customizing Menu ............................... 501 

D 

Data bit ................................................ 360 
Data Output Completion Notice .. 632, 633 
Data Output Register ........................... 632 
Data R/W 

Display Data R/W ............................ 390 
Registerable items ........................... 392 

Debug .................................................. 477 
Decimal digit ................................ 366, 593 
Denoising .................................... 246, 262 

Detect trigger (common)........................ 81 
Differential mode ................................. 210 
Display NG checkers only (Checker List)145 

Display NG checkers only (Pattern) .... 420 
Distance Point - Point .................. 294, 296 
Distance Point-Line ............................. 294 

E 

Edge Extend ........................................ 197 
Edge Extract ........................................ 197 

Edge ratio used ........................... 243, 261 
Error 

ERR ON Min. ................................... 436 
ERR Signal Off Timing ..................... 436 
Error Code ....................................... 556 
Reset Error signal ............ 551, 606, 651 

Error bit ........................................ 632, 643 
Error if Checker Area Outside Image ... 111 
Error Reset .......................... 551, 606, 651 
ERROR Signal 

Reset ............................................... 606 
Ethernet Interface ................................ 588 

Execute All ............................................ 113 
Execution memory ......................... 75, 381 
EXTRA ................................................ 551 

F 

FLASH Delay ......................................... 91 
FLASH signal polarity ............................ 80 

FLASH span .......................................... 91 
Float............................................. 220, 223 
FTP Server .......................................... 439 
Full Screen ............................................ 62 
Full-screen layout .................................. 42 

G 

Gap .............................................. 220, 222 
General Communication ..................... 590 
General Communication command 

Communicaion Command (General 
A Series Compatible) ..................... 437 

General Output .................................... 592 

General-purpose Communication 
Command (A Series Comaptible) 
Communication Command 
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(General-purpose 
A series Compatible) ...................... 618 

Geometric Function ............................. 322 

Geometry Calculation .......................... 294 
Gray range mode................................. 211 
Grayscale Conversion ......................... 125 
Grayscale Preprocess Filter List ......... 133 
Group Move ......................................... 149 

H 

Hard Gain ........................................ 83, 85 
Hide Patterns ....................................... 147 

I 

Ignore Dark Image ............................... 184 
Image ................................................... 373 

Output to external devices ............... 370 

Image Header ...................................... 493 
Image memory ..................................... 367 
Image memory map............................. 369 
Image Menu ................... 52, 419, 420, 426 
Image Output ............................... 334, 370 
Image transfer Time............................... 16 

Information ................................... 414, 473 
Initialize 

All Types ............................................ 78 
Environment ..................................... 449 
Splash screen .................................. 475 
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Appendix  Check pattern sheet (Trapezoid Adjustment) 

Please use as a guide when setting the Trapezoid Adjustment. 
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